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To Our Readers
Dear Friend,
Thank you on behalf of everyone at Hayden Books for choosing Microsoft Office 4.2 Survival
Guide for Macintosll to enable you to learn about the exciting new features of the Office suite
on the Macintosh. Each Office app lication has received its own treatment by an author who is
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What you think of this book is impo rtan t to our ability to serve you better in the future. If you
have any comments, no matter how great or small, we'd appreciate your taking the time to
send us email or a note by snail m ail. Of course, we'd love to hear your book ideas, too.
Sincerely yours,

/?..J~
David Rogelberg
Publisher, Hayden Books and Adobe Press

You can reach Hayden Books at the following:
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201 West 103rd Street
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(800) 428-5331 voice
(800) 448-3804 fax

email addresses:
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Internet:
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Introduction
Nearly a decade ago, the people who ran Microsoft made a mom ento us decision about
softwa re design , a radical departure from any earlier softwa re design philosophies: the
bigger th e better. Microsoft Office 4.2 for the Macintosh is a d irect prod uct of this Microsoft
philoso phy- which has produced many good res ul ts and a few that aren 't so good. This book
is called a Swv ival Guide because it's going to tell you how to ge t all the goodies Microsoft has
loaded into its software witho ut enduring the trials and d rawbacks of the program. Let me
explain.

What Goes into Software?
In the old days, programmers would try to see how m any fea tures they could cram into a
limited space. For example, the o riginal IBM PC spreads heet, Lo tus 1-2-3, was designed to fit
comfortably in 256KB of RAM. The reason fo r this desig n choice was that most IBM PC users
had only this much memory, and memory was expensive. The idea of asking software users
to buy new hardware to accomm odate a software prod uct was con sidered not to be shrewd
m arketing at all. As a result, the features that finally ended up in 1-2-3 were a compromisesome possible fea tures were left o ut because t he designers could n't fit them into 256KB.
But memory prices started to fa ll throughout the 1980s; m icroprocessor speed started doubling
every few yea rs; and disk drives kept getting bigge r. Looking at these trends, Microsoft's software design teams concluded that there were two sim ple principles for designing successful
software in this new environment: find o ut what features people want an d give 'em the
features.
The idea was to load up the programs with everything the users req uested. If this mean t that
the software was huge and somewhat slow . .. well, faste r computers with lots of RAM and
bigger hard drives would make these problems go a\·vay- even tually.
In rt!trospect, this plan certainly worked. This melhod of software des ign pretty m uch conquered the universe and left m ost of Microsoft's competito rs gasping in its wake, struggling
to keep in the swim . The programs in Microsoft Office have a huge market share in both
the Macintosh and Windows m ar ket (Excel, alone, has over 90 percent of the spreadsheet
business).
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A Nice Big Office
No one wou ld dispute that Microsoft has provided all th e fea tures that users could ever wa nt
in Microsoft Offi ce 4.2. In fact, Microsoft has provided many features th at you probably never
thought of and even more features tha t you will probably never use. Each of the th ree big
pieces of Office-Word 6, Excel 5, and PowerPo in t 4-is the biggest program of its kind th e
world has ever seen.
To install the complete version of Microsoft Office on a Power Mac, for exa mple, you need to
have 100MB of free space o n your hard d rive. After installatio n, the program reduces itself to a
mere 76MB, but this size is still pretty fo rmidable, especially if you are trying to use a Duo or
PowerBook. That's why this Sutvivnl Guirle will have lots of installation tips that indicate which
parts of Office you can throw overboa rd (to install only when you specifically need them).

Sometimes you win
One of the great strengths of Office is that it makes up its ow n substantial world, provid ing a
software solutio n for nea rly every problem that you encounter in business (hey, th at's why it's
called Office). Besides this benefi t, the individual parts work very nicely together, too. You can
make a table in Excel, fo r example, and link it into a Word document or a PowerPo int slide.
And the link is "live" so that when your Excel numbers change, they will auto matically change
in the correspo nd ing Word and PowerPoint documents. Ano ther great strength is that most
commands do exactly what you wou ld expect, whether you're using Word, Excel, PowerPoint,
or Microsoft Mail, for th at matter.

Sometimes you lose
There is, however, a big problem with big software. In the Macintosh graphica l interface, every
time you make a mouse-click, a program has to scroll through its list of all possible actions to
find out wh ich one you have selected. What this m ea ns, roughl y, is that when a program
doubl es in size, it slows down by nearly a factor of 2- unless someone does some clever
optimization. It also means that strange bugs and system problems are about twi ce as likely.
That's w hy this book not o nly has lo ts of speed tips (to help Office get its giant bulk o ut of its
own way), but it also has all sorts of advice on keeping Offi ce fro m unpleasant interaction scrashes, in fact- under Macintosh System 7.5. These crashes have bothered lo ts of pio neer
users of O ffice 4.2. Microsoft's official policy, however, is to deny that crashes can be happening. Well, they happen a lot, and this book provides th e info rmation th at you need to prevent
this problem in the first place. At Hayden Books, we take surviva l seriously.
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Getting Going in the First Place
If you are the gloomy type wh o likes to peruse the online help bulletin boards from software
vendors, you are likely to find-from America Online to CompuServe and everywhere in
between-a section called "Office Problems."

The two most important categories of problems are crashes during installation (where you
never actually get the software running) and mystery crashes during operation (where you are
tearing your hair out on a regular basis).
In this book, installation advice is found in the Appendix so that the installation section could
be as long as necessary without disrupting the page num bering of the rest of the book. Believe
me, the Appendix continued to grow rapidly during the whole preparation time of this book.
As more users got more experience with Offi ce, funn y new crash-inducing wrinkles kept
appearing.
So you may want to read this book from back to front because the Appendix may be the first
place you need to look for installation tips. Even if you thin k you have installed Office
correctly, if you are experien cing mystery crashes or freezes, you may want to re-install by
following the hard-won advice in th is book.
There are two chapters dealing with System 7.5, and, once again, if you need troubleshooting
help, you may want to look at the second of these as your introduction to this book. If you
have been using Microsoft software for some time, you can probably get a Word document
written and printed by yourself. But it's unlikely that anything in the past has prepared you
for some of the amazing glitches that can affect Word 6 under System 7.5. It just shows what
can happen when two software giants, in this case Microsoft and Apple, work with near-total
Jack of cooperation.

"Surviving" Microsoft Office
Surviving Office is sort of like surviving Manhattan. It's big; it's tough to fin d the best way to
get around; it makes tons of demands; and to get the most out of it, you need lots of special
information . But afte r you lea rn your way around and find out where th e good stu ff is, it's got
the greatest collection of services in the world. Think of this book as your Michelin Gu ide to
the facilities in Microsoft Office.
This Survival Gr.lide covers the fo llowing features:

+
+
+
+

The best features of Wo rd
The best features of Excel
The best featu res of PowerPoint
The best features of Microsoft Mail
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•

Using the applicatio ns together

•

Exchanging data

•

Modifying your installatio n for size efficiency

•

Fine-tuning O ffice fo r speed

•

Staying out of trouble with Office and System 7.5

If you are using Microsoft Office, you have already made a big in vestment in money. If you are
using it every d ay, you are also ma king a huge investment in time. This book will pay for itself
the first week you use it, even if you are making min imum wage. just getting Microsoft Wo rd
to load in one minute instead o f six m inutes every day will make everyth ing delightful, and if
you use the ti ps and t ricks in this book, you will save yourself hours o f time over the course of
a year.
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The people who design software, both at
Apple and at Microsoft, have decided in
recent years that the voice of the people
must be heard. System 7.5 and Microsoft
Office incorporate not only dozens of
user-suggested features but also bits of
clean-up shareware and utility programs
licensed from third-party developers.
The res ult of giving the people what
they want is that both System 7.5 and
Microsoft Office are very large programs,
often duplicating each other's features
and occasionally, via extension conflicts,
gettin g in each other's way. Part I of the
strategic plan for surviving Microsoft
Office focuses on the most useful new
features of System 7.5 and then on the
best techniques for avoiding subtle
conflicts that lead to mystery crashes
when System 7.5 and Office collide.

··~

Chapter 1

Exploring the New
Features in System 7.5
At any time of day or night, you can drive by Apple's main parking lot in Cupertino, CA, and
see hundreds of cars. Each o ne corresponds to one or two Apple employees toiling away. And
what are they doing? Well, a rather large number of them are thinking up cool things to throw
into the next versio n of the Macintosh System software. Every time th ere's a new revision of
the system, there's a long list of goodies in it for you. In this chapter, you're going to fi nd out
how System 7.5 can make your Mac workday more fun and productive by reading about these
points:
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Find File
The com p uter you are using these days is very likely to have at least 200MB of ha rd drive
space. Th in k abou t what th is mea ns for a m inute. The text in a 300-page computer book takes
up a bit less than a megabyte. So you could have the equivalent of 200 books on your hard
drive, bro ken u p in to ch apters and so for th . That's a lo t of info rmation, and that's a lot of fi les
to wade through to find th e one you want at an y given time.
Kno wing abou t this potential file-find ing nigh t mare, Apple has p rovided a slick new utili ty fo r
finding info rmation on your hard drive. If you d id an Easy Install of System 7.5 (see the
Appendi x)-disregard ing all t he well- mea ning advice you' ll find in this book- you will see an
item called Find File u nder the Appl e menu . If you took o u r advice, however, and performed a
minimum installation (also in the Appendix), yo u will see Find File under the Apple menu
because you put it there yourself.
But at least it's t here, o ne way o r another. Afte r you selec t Find f-ile from the Apple Me n u, you
see the dialog box shown in Figu re 1. L.

--- -

rtnd ltomsl on locnl disks

~:~~~a
-,.-. me

._.

Find Fil e

l~

.... II

contains

..,. I whose
...,. l l wor~

( More Choices)

Figure 1.1 The bas ic Find File dialog box-just t he begi nning.

'

,

::11

-----.

Find

You migh t be excused fo r interjecting at th is po in t, "So what?" After all, th is dialog box looks
mo re or less li ke t he Find dia log box from System 6. The fun begins, however, when you click
the Mo re C hoices bu tton. You can then add some specific items to the File characteristics so
that Finder ca n get the info rmation you need-and rapidly, too.
At each click on More Ch oices, another bit of search criterio n appea rs (see Figure 1.2). In
practice, some of th is info rmation is likely to be more usefu l than others for finding files. If,
fo r exa mple, you can remember a ra nge of possible dates for the file that you want to find,
that info rmation cuts down enormo usly on the numbe r of files that the Find utility has to
check to get to the o ne you wan t. If you have two yea rs' worth of fi les on your drive, and you
can narrow down your search to one week by usi ng the o pt io ns in the Date Created scroll ing
list, then your Mac h as to search t h rough only o ne percent o f the files on your ha rd d rive.
Trust me, narrow ing down t he search is imp ressively faste r than looking t h rough the whole
drive.
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Plenty of Find File choices.

When the fi le search is over, the amazing all-new Find File utility gives you all the files at once
in a convenient Items Found dialog box (see Figure 1.3). Wh at makes this dialog box special is
that the items are as live as they are on the desktop. If your search has found an applicatio n,
you just double-click it to open it. The same is true fo r files-just double-click the file as you
would with a desktop file.
Besides this active list of files, the dialog box contains the location of the selected file in the
lower half of the split dia log box. Simply select a file to see the fil e's location.
=
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Items Found
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The Items Found dialog box- it lists both files and locations .
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One use for Find File in connection with Microsoft Office is t he removal of o ld files from
applications that you are not using anymore. Often an application, when installed, d iligently
stuffs information all over the place in the System folder. You can track down leftover pa rts of
applications in the Preferences and Extensions folders by running Find File and by using the
application name and its abbreviations (such as QM fo r QuickMail) and approximate dates as
you r search criteria.

Internet Access
In System 7.5, Apple has finally added a contro l pa nel ca lled MacTCP (see Figure 1.4), wh ich is
necessary to run most Internet-access software. Used .i n co nnection with th e program lnterS UP
and provided free by InterCon Corporation, your Mac ca n use any of the software for ftp (file
transfer protocol) se rvices, fo r access to Gopher servers, or to the World-Wide Web.

Figure 1 .4

MacTCP, the gateway to the Internet.

This contro l panel is important to you not just because all t his Internet-related stu ff is the
latest computing craze but also because Microsoft and other large companies are increasingly
moving to Internet-based custom er su pport as a replacement fo r phone-based custo mer
support. For example, most of the files of tips, u pdates, and installation hin ts that Microsoft
provides can be found at the following ftp site:
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ftp.microsoft.com

And a more visual organization of information can also be found at the following World-Wide
Web site:
http: //wvm .microsoft.com/

You should know a few things about access to this info rmation bonanza . First, setting up the
access is difficult. The setup of MacTCP alone is too complicated for this book (see Figure 1.5).
Second, besides the setup of MacTCP, you need to puzzle out the details of lnterSLIP setup (see
Figure 1.6) or MacPPP setup, another Internet communications protocol application. Fortunately, you can consult the Internet Starter Kit, anoth er best-selling book published by Hayden
Books, by Adam Engst (Tanya Engst did th e Word part of this book) for advice on getting
hooked up through MacTCP. Although System 7.S's Internet connectio n through MacTCP is
too complex to cover in deta il h ere, at least you don't have to turn to strangers fo r advice!
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Figure 1.5

MacTCP setup, not a simple business.
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Figure 1.6 MacTCP and lnterSLIP , working together.

Stickies!
If you did an Easy Install or a minimum installation, you will find Stickles as an option under

the Apple menu. Because this is the second time I have mentioned installation, I want to make
this point here: you should con sider doing the installation in the way this Office book recommends in the Appendix. Believe me, I've gone through the pain of finding out which parts of
the Apple system are 100 percent compatible with Microsoft Offi ce!
Anyway, a Sticky is just a little floating note that appears on the desktop. It's the exact electronic equivalent of the ubiquitous Post-it note. A typical use of a Sticky is as a remi nder of
meetings or as a short to-do list.
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To activate Stickies, choose the Stickies command fro m the Apple m enu. You then see a screen
like the one in Figure 1.7-here you can see on e new note on the desktop. You can do all sorts
of things with Stickies, just as if they were files. Stickies even have their own menus. Under the
File menu, you can take text out of a Sticky and save it to ano ther file, o r you can import a
note that you wrote (probably in a word processor). Were you so inclined, you could actuall y
use Stickies as a primitive text database-one Sticky for phone numbers, another for business
memos, and so forth-altho ugh you will pro bably prefer big-time applicati o ns, such as
Microsoft Word and Excel, fo r more serious ch ores. At any rate, Apple never leaves thin gs in
their simplest form, so it has also endowed Stickies with the fo nt and style capabilities of a
small word processor. Simply ch oose the Text Style command from the Note menu (o r press
:;:t:-T) to get the dialog box that you see in Figure 1.8. From here, yo u can format your Stickies
to your heart's co ntent.

Figure 1. 7

Stickies-little desl<top notes to yourself.
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Figure 1..8 Stickies with style.

Extensions Manager
The reason that the control panel called Extensions Manager is included with System 7.5 is
that 7.5 itself includes an absolu te explosion of extensio ns. The Easy Install option leaves
you with more than 40 extensions, and most of the sofhvare that you use will add in more
extensio ns.
For starters, you d on't need most of these extensions. For example, Apple has provided you
with extensio ns for managing nearly every prin ter that Apple has ever man ufactured. You can
remove from th e Extensions folder the extensio ns that you know you won't be using, or you
can use Extensions Manager to turn them off. Simply select Extensions Manager from the
Apple menu and click off the extensio ns that you don't need in day-to-day practice (see Figure 1.9). Click a checked item to turn it off- click an unchecked item to turn it o n.
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Extensions Manager turns o ut to be your easy way out of a dilemma. Microsoft Office simply
does not agree wi th certain third-party (not Apple, not Microsoft) extensions (m ore on this
issue in Chapter 2). When you find o ut which extensions cause problems, you can then defi ne
a custom extensions set by turning off the offend ing extensions, pulling down the Sets menu
(see Figure 1.10), and giving your set a name with the Save Set command (see Figure 1.11).
Similarly, you can select a set of extensio ns and control panels fo r use with o nly certain
printers or certain communicatio ns software and then give the items in the set their o wn
names in Extensio ns Manager. Fro m the tim e it takes your Mac to start up, you will want a
minimal working set of extensio ns most of the time because it takes tim e to load the extensio ns o n startup.
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Picking out a custom exte nsions set.
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Figure 1.1.1. Naming a special set for Office use.

Window Shades
The Window Shade control panel solves a problem that has been bothering Mac users for ten
years: what do you do when the desktop becomes so cluttered with open windows that you
can 't find anything"! Window Shade lets you hide everything except the title of a window, thus
drastically reducing the amount of desktop real estate devoted to any single window.
The Window Shade controls (see Figure 1.12) are simplicity itself. Unless you are fascinated by
need less complication (or insist on concocting a keystroke combination), you can just select
the option for double-clicking on the title bar of the window. This option means that when
you double-click the right-hand side of the title bar, the window rolls up, leaving only the title
part of the window onscreen.
When you use Window Shade judiciously, you can reduce an unreadable mess like the on e in
Figure 1.13 to the harmony, bliss, and clarity of the screen in Figure 1.14. All you have to do is
perform the Wi ndow Shade double-clJck maneuver on the windows on the desktop until th ey
are rolled into title bars. In using Office, you may want to keep special sets of Word files, for
example, in a rolled-up Word Files window for ready reference. I've checked out Window
Shade under lots of circumstances and haven't hit any conflicts wit h Office, so use this feature
to your heart's content.
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Figure 1.12 Window Shade-the ultimate desktop clean-up device.

LJ

mtfltlo

llii

.JPEG\Iifw 3.3 (PowHPC onl\1 )

~

H~UIIt 'tl'()f'd 1ll.ts

LJ

LJ LJ
stfttr

JPEG Convtrt t .0 (PowH'PC)

Figure 1.13 Look fam iliar? A typically cluttered desktop.
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Figure 1.14 A cleaner desktop with Window Shade.

Locking
There is one slightly negative aspect of the new Window-Shade oriented desktop: it makes it
much easier to throw things into the Trash by accident. An inadvertent single click in the title
bar of a rolled-up window can select the whole window. And then if you are dragging something else to the Trash, you could find yourself dragging the window to the Trash along with
it. You need some protect ion aga inst this sort of event, and Apple has built the protection into
the Get Info dialog box (see Figure 1.15) under the Finder File m enu. The option of physically
locking whole floppy disks has always been ava ilable, but applications and folders are now
individually lockable by clicking the Locked check box in this dialog box.
Figure 1.15 shows Microsoft Wo rd's Get Info di alog box. To lock another app lication, open the
application and press ~ -I on your keyboard .
Now if you drag a locked application to the Trash and are about to empty the Trash, you not
only get the warning in Figure 1.16, but the System actually refuses to get rid of the application. Wh en you consider the time invested in installing the Office suite, it makes sense to lock
Word, Excel, a nd PowerPoint as convenient insuran ce against accidental disaster.
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Figure 1 .15 The Locking option in a Get Info dialog box.
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Figure 1.16 Oops! System 7.5 doesn't let you trash a locked application.

PC Exchange
If yo u are using Microsoft Office at work, t here's an excellen t chance that you are working
with people who are generating files under the Windows vers io n of Office. And happy people
they are, too, because Office is fast, compact, and pretty m uch trouble free o n a Windowsbased PC. (As a curiosity, most of th e problems in O ffice for the Macintosh arise from
Microsoft's insistence on using Windows programs th at have been relaundered through a
translator to produce the Mac Office programs rather than writing th em as real Mac applicatio ns using Mac developm ent too ls.) At some po int, you wi ll p robably have to use Word or
Excel files from the PC side of t he fe nce.
There are two con venient features in System 7.5 to help you with con verting files. The first is
a control panel ca lled PC Exchange (see Figure 1.1 7), wh ich was first in troduced in System 7
and lets Macintos h compu ters read PC disks in the standard SuperDrive. By clicking the Add
button in the PC Excha nge d ialog box, you can pick fi le types from t he DOS/Windows world
and the application s that ca n open them in the Mac wo rld. To help you in navigating Office,
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you should kn ow that .MCW at the end of a filename identifies it as a Microsoft Word file
from Windows, and .XLS similarly indicates an Excel file. By looking at the extensions, you
then can pick Word or Excel as the Mac application that translates and opens these files.
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Figure 1 .17 PC Exchange opens DOS disks and reads their fi les.

Macintosh Easy Open (Figure 1.18) is an extension in System 7.5 that essentially automates PC
Exchange. When Easy Open is installed, a con trol panel for setup shows the basic Easy Open
fact: after you activate Automatic document translation, all your problems are solved. Now
you can double-click a fi le on a PC disk in your Mac or a PC file on a network server, and th e
System scurries around in th e background finding the appropriate translator, ultimately
opening the fi le in the correct application. If you are interested in the mechanics of these
operations, Don Crabb's Guide to Macintosh System 7.5, also by Hayden Books, is the best
available reference.
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Figure 1.18 Macintosh Easy Open solves many translation problems.
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Memory Manager
There are many serious issues involving memory management, System 7.5, and Microsoft
Office. rigure 1.19 shows the Memory control panel, part of every System installation, and a
number of its options.
One choice you should make while running Office is to set Cache Size in the Disk Cache
option to 96K. It would be nice to have a cogent explanatio n for this setting, but the fact is
that the 96K setting is straight from the recommendations of Microsoft's customer support
and, in fact, d oes seem to speed things up a bit.
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Figure 1.19

Memory-some critical choices.

Another bit of advice fro m Microsoft suppo rt technicians is to set the Modern Memory
Manager to Off. When the setting is On, it means that the System expects to be dealing with
applications that have been design ed for a proper Macintosh 32-bit computing environment.
Apparently on a few key points, this isn't quite what happens with software prepared by
Microsoft's Windows-to-Mac conversion machinery.
The last memory issue concerns virtual memory, wh ich is the use of hard drive space to
su bstitute for RAM. If you are obliged, for example, to run Excel on a Power Mac with a mere
16MB of RAM, you need to turn on the Virtual Memory optio n because 16MB isn't enough,
and you will get strange er ror messages if you try to start Excel. The reason this setting requires
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some attention is that you are unlikely to succeed in installing Microsoft Office with the
Virtual Memory option on , so you have to switch it off during installation. If you didn' t know
that you should turn it on agai n to run the actual applications, you may easily think that the
installation failed.
This chapter has covered some special System 7.5 goodies that you will need to make Office
perform properly. In the n ext section, you will find out h ow to keep these large and complex
software objects-System 7.5 and Microsoft Office- from getting in each oth er's way. This is
not a trivial issue and is one of the reasons th at survival is part of this book's title.
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Making Office and'-----

System 7.5 Work Together
When you use Microsoft Office and System 7.5 together, you may get the impression that the
designers of these two pieces of softwa re were completely unaware of each other's efforts. As it
happens, this is pretty much the case. Therefore, System 7.5 abounds in features that can make
Office crash, and Office can easily cause the System to hang in the course of the day. In this
chapter, you're going to find a way to get through a whole week at the office without a crash
by reading about these points:
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Why Crashes Occur
The crude explanation for the crashes is that System 7.5 and Office dupli cate many of each
other's features, and they make assumptions about what bits of m emory may be ava ilable for
th ese features. The Open Doc architecture, for example, and Publish and Subscribe are Apple's
ways to make "live" links between docu ments. In Microsoft-land, OLE2 does the same thing.
Because these programs deal with communicatio n between applications, they sometimes
compete for the same memory. And when applications compete, you're the one who loses. If
two app lications want the same space in RAM, it's likely that your Mac wi ll simply crash.
Let's assume that you have installed Office-apparently successfully-bu t that every now and
then the whole thing freezes your Mac. Th is situation is especiall y true on Power Macintoshes.
If you are lucky, you can get out of the freeze by using the ~-Shift-Esc keystroke combination
and get a chance to do a proper restart. In fact, it's a good idea to keep ~-S hift- Esc in mind at
all times, not just for Office applications, because it gives you a chance at a graceful ex it from
any crashed application.
If you're not lucky, the only way out is to tu rn off your Mac, which produces th e scolding
dialog box that tells you that you should always proceed through the Shut Down comma nd
under the Special menu in the Finder. You already know the proper procedure, and it's pretty
aggravating to see that message several times a day.

Actually, it's beyond aggravating-it's lethal. Every time you do a plain turn-it-off instead of a
restart, you risk introducing li ttle gli tches in to the System software. If you have to do several
turn-it-offs a day (say, four times or so), it's a near certainty that you will see at least a question
mark icon on startup or even the dreaded Sad Mac, which call s for major repair action. If your
Mac can 't do a proper closing of files and applications, those files and applications can accumulate little bits of damage that eventually make big problems on the hard drive's directory.
And when the directory has problems, sometimes your Mac simply pretends that your hard
drive is not there at all. Uh-oh.
Preventing crashes is a big reason why you want to get a stable, noncrashing System 7.5/0ffice
installation. Besides the inconvenience of a crash, if it happen s enough , you may have to send
your Mac out for service. Maybe you have good loca l service, but prices range up to $80 an
hour with a o ne-hour minimum in most big cities.

Extension conflicts
If you have ever called Microsoft Customer Support with a complaint about System crashes,
the first thin g the support technician probably told you is that you have an extension
conflict- and probably a System 7.5 extensio n conflict, at that.

That may be true, but it's n ot very helpful. Extensions, you may recall, are the little "system
helpers" that add functions beyond the System core function set. Because many of them are
optional (extensions for different printers or extensions for communicatio ns software), th ey
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have n' t been built into th e basic core set because you may not need them. O ne type of
familiar extension is th e screen saver, and ano ther less fami liar but very impo rtant type is
the extension (s uch as Microsoft O ffice Manager) that controls communications between
applications.
There used to be o nly a ha ndful of these extensions, but over the yea rs, the extensions have
expanded their ro le in the Mac o perating system. In System 7.5, there are dozens of new
extensions, and these extensions have req uired Apple to build in the Extensions Manager, a
special System 7.5 contro l panel that can turn individual extensions o n or off.
Now as the System gets loaded with extensions, the probabil ity that th ey will all play n icely
with each other starts to shrink. The probability tha t one of Apple's 60 or so extensions in the
standard insta llation of System 7.5 wi ll not have a conflict with any third-party extension is
close to zero. And then th e probability that Microsoft extensions wo n't conflict with anyone
else's extension s is very small indeed. When you hear the term extension conflict, it does n' t
mea n a simple erro r message o nscreen, either. l t means th at yo ur Mac doesn't start up at all o r
that it starts up and th en crash es or that it crashes w hile you're in the middle of doing some
va luable work. A conflict is the poli te way of saying that th e m ouse cursor is no lo nger moving,
the Mac no longer responds to your commands, and th e on ly way to get going again is to shut
the th ing off and try to reboot.
So you have to figure out which extensio ns are causing a conflict if you are experiencing
mystery crashes wh ile running Microsoft O ffice. In principle, you can use the 7.5 Extensions
Manager to turn off extensions o ne at a time in the ho pe of debugging th e conflict with
Office, but this approach has its drawbacks. first, you will probably crash so many times before
you figure out which extensions to turn off that your hard dri ve will lose its mind and need
serio us repair. Second, you will waste endless hours perform ing thi s in vestigation. These hours
could have been spent doing o th er th ings for your business (typing a letter, mak ing up a
budget, or creating a presentati o n).
Anoth er approach is to do th e o pposite. Simply h o ld clown the Shift key while restartin g your
Mac. Th is action turns off all extensions after the restart. Then, if you are still interested, you
can use Ex tensio ns Manager to turn on yo ur extensio ns one at a time unti l you find a conflict.
The bad news is that you'll find plenty of conflicts. Many of your favo rite extensions are going
to run afoul of Office. So hang in there and read th rough this entire chapter: I'll show you how
to duck th e who le ugly issue.

Special conflicts
At this point, the next piece of advice may come too late fo r you because it concerns a conflict
so drastic that you probably couldn 't get Office installed if you have n't sidestepped it somehow. Most scree n savers not on ly cause the Offi ce Setup program to bo mb during insta llation,
but th ey also ca use va rio us Office applicatio ns to crash (a lesso n the authors learned from
bitter experience in preparing this book). Most of these same screen savers worked perfectly
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well with System 7.1 and the previous versions of Microsoft Office-but under System 7.5 and
Office 4.2, you use them at you r own risk.
Basically, the problem is that the Setup program for Microsoft Word needs the uninterrupted
attention of your Mac, and it simply freezes on most screen savers at the point when the
screen saver tries to take over the screen. Because the setup installation disks take at least 15
minutes for a minimal installation, your standard screen saver setting will likely cause an
interruption in the installation sequen ce that will be unrecoverable.

It's Okay to Trash Your Screen Saver
Here is some good news for you, however. You may be using a screen saver under the
mistaken impression that it's an absolute necessity to have one to avoid screen bum-in.
This was true in the old days of monochrome Macs, but today, It is almost Impossible to
bum the Apple menu into a color monitor because there's enough wobble In the convergence of the red, blue, and green guns in a color monitor to make bum-In a rarity. So get rid
of your screen savers if you want to cut down on the number of crashes that you experience
with Office.

Similarly, some communications programs check in from time to time to see whether you
have any mail. Some mail progra ms are death itself to Office Setup and viral pneumonia to
Office applications. (I have no idea what you have to do to get CE Software's QuickMail to
work with Office, for example, because I gave up trying after three weeks of chatting with
customer support at CE Software and Microsoft.) The problem apparently is that QuickMail
checks the clock every n ow and then to see if it's time to look for new mail, and when it
checks the clock, it causes a conflict (it's checking the System clock that makes for screen saver
problems).
The online customer support boards of ma jor vendors are full of reports of conflicts between
different email systems and Microsoft Office. I wish that there was an obvious trick or workaround to make third-party communications work, but for now, you can read the ch apter
on Microsoft Mail and call your communications software vendor and ask about Office
compatibility.

Fixing Everything: Drastic Measures
If you have persistent Office crash problems, the least time-consuming way to get things up
and running is to bite the bullet and go fo r a System 7.5 re-install. Find your Macintosh

System disks, insert Install Disk 1 in the floppy drive, and get ready for a short but merry ride
(see Figure 2.l). Just keep clicking Continue un til you get the screen in which you make the
System choices.
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Welcom e to System 7.5
~

Your Macintosh needs certain software to start up in
System 7·5 ·
The Installer places this software onto your disk In t he
System Folder.
The Installer will choose the software that Apple
recommends for your Macintosh.
Choose · custom Install' o nly If you are sure that you
want t o override those recommendati ons.
([ Continue ...

Figure 2 .1

J

A new System installation is your best bet for Office happiness.

When you origina lly installed System 7.5 for the first time (assuming that you didn't buy a
new computer with the System already installed), you probably picked Easy Install (see Figure
2.2) because it was the first ch oice presented to you when you clicked the Continue button in
the Install screens. If you are going to use well-behaved but limited software, such as Claris
Works, Easy Install is the best choice. But this insta llation option makes for a big, fat, rich
System with Jots of possibilities for conflict with Office. It installs loads of extensions with
potential conflicts with Office's own extensions, and a System with lots of extensions also
loads much slower on startu p than a leaner System. Therefore, especially when you are
working with a giant package li ke Office, a smaller System installation makes more sen se .

.. System 7.5 In st alla tion

1¥

Easy Insta ll

Help

Cliclc the Inst a ll button to updat e to System Software uer slon 7.5
on the select ed disk. This Installation will includ e o il of the
updated Sys t em Softw ar e for this Macin tosh.

- Dutinatian Disk

Ejec t Dislc

t:=::J
Moatntosh HD

Figure 2 .2

Switch Dlslc

(

Quit

n

I ns t oll

Don't choose Easy Install if you plan on using Office.
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You can see some of this fatness and richness by peeking into the Custom Install option (see
Figure 2.3), which appears under Easy Install in the scrolling list. You'll be back at this ch oice
later because you need to add some components after you do the Minimal installation (see
Figure 2.4), which seems to work best with Office. Instead of using Easy Install, which puts
virtually everything into you r System (including possible Office conflicts), you can do a
Minimal installation first and then install a few extras later by using Custom installation.
Minimal installation gives you a smaller System and a better understanding of just what got
loaded.

Help
Chock futures to be inst•ll t d

I> D System Software
I> D Printing
1>
1>
1>
1>
1>
1>

D Networking Softwore
D Utility Softwore
D Multlmedlo Softwar e
D Compatibility Softwar e
D Fonts
DApple Menu Items
S.looted sizt : uro K

DIJk sp•c• •nl lobl•: 55,395K

D~in atfon Disk ----;.::====~~

c::::J
Macintosh HD

Figure 2.3

Eject Disk

Quit

Switch Disk

Install

Custom installation, for adding System components later.

-

~~

"="' Sy st em 7.5 lnstollotlon

stom Install
.... I
IChockCuft•turu
to bo fnst•H• d

vEl
The Minimal
System option.
1>
1>

0
0

[

M•olntosh HD

Figure 2.4

(l)
i
(D i,il

m
(l)

m~

(D ,I
m~
Stltoltd stu: 1,447K

Disk sp- av•fl•blt: 55 13B1K
. -Du1fnation Disk

(
(

l

m~

Syst em Sortwore
D System for this Moclntosh only
D System for ony Macintosh
::::;: Minimal Syste m for this Macintos h only
0 Mlnimol Syste m for ony Moclntosh
D International Support
Printing
Networking Software

c=:J

llalp

Eject Disk

l

[

Quit

l

Switch Disk

l

~

l nstoll

~

Minimal inst allation: the place to start for Office.
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The problem with a standard System installation is that it often overwrites a few components,
but it's usually smart enough to check which components are already installed, and in most
cases, it doesn't touch them. The standard installation means that you can be writing a few
new components into your System while leaving possible conflicts lurking on your hard drive.
You need something better than this kind of installation fo r smooth sailing with Office.
Thus when you are looking at the dialog box in Figure 2.4, you want to use the ;l:C-Shift-K
keystroke combination . Of course, this keystroke combination is mentioned nowhere in the
standard Apple documentation, but it's the key to making the new installation solve your old
problems. Use the combination when you see Minimal Install as an option.
This keystroke combination forces what is known as a "clean install." A clean install puts your
entire old System into a folder named Previous System, which means that the new System has
only new components and no potentially damaging "leftovers." When you press the keystroke
combination, you see the choices in f-igure 2.5. Click the button for Install New System Folder
and then click the OK button.

Sys tem 7.5 Insta llation
Custom Install
Chock features

v

0

Help

System Softw are
O Syst •m fn,. thl~ Mnr.lntnJ>:ILonli
0 Syst
Select type of Installation:
0Mini
0 Upd ate EHisting System Folder
0Minl
0 lnt e
@ Install Ne w System Folder
Printinf

0
I> 0 Ne twor
1>

.,... I

to bt installod

(

Cancel

J

n

JJ

OK

Disk spao••JI====~~~;;;~~~::::;:~·~I'I~<i~u~:~%e:ro~K
,-Destination
0&~

Eject Dislc

c=:J
Macintosh HD

Figure 2.5

Switch Dlslc

l

Quit

J

In stall

Choose the Install New System Folder option.

After you click OK, you are returned to the Installation dialog box, but this time there's a
diffe rence: the Install button has been changed to one that says Clean Install (see Figure 2.6).
This ch ange in the dialog box means that you're on the right track. Click the Clean Install
button and then shuffle disks as required into the floppy drive.
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Sust em 7.5 lnstollotion ggzg
Custom I nstall

..,. I

Help

ChfCk futlru to bt inst.llfd

v El

l> 0
1>

0

System Software
0 System for this Macintosh only
0 Sy stem for any Ma cintosh
[8] Minimal Sy stem for this Macintosh only
0 Minimal System for any Macintosh
0 International Support
Printing
Networking Software
Disk sp>ot •v•il>blt : 55,354K

r-Du 11nation Disk

- - --;::=====::-l

c:::J
Macintosh fll

S.locltd sfu : 1 ,447K

Eject Disk

Quit

Switch Disk

(f Cleo n Install lJ
I

fEi

I

Note the change
in the button.

Figure 2.6 The Clean Install option.
This installation is indeed minimal, but never fea r. All your o ld ex tensions and control panels
have been stashed in the Previous System fo lder, and you can try adding back the most
essential item s later. You may find, actually, that you li ke working wi th the Minimal System
because it makes performance truly snappy. Yo u can add bac k the standard Apple contro l
panels and Apple menu item s and so fo rth either by d ragging them into the new System folder
or by fetching them from the Previous System folder created by the Clean Install.

The Two-Drive Solution
If you have an external SCSI drive in your system, o ne optio n is to install Microsoft Office and
Minimal System 7.5 on one drive and a full-blown System 7.5 with all your gooey, Officeconflicting extensio ns o n the other. You can use the control panel called Startu p Disk to pick
which System to use. When you are go ing to have a session with Office, you pick the O ffice
drive as the startup drive, and if you are using no n-O ffice software, you pick the other drive as
the startup drive. This technique is actu ally easier th an it sounds and was used as the sol utio n
to get parts of this book written!
To use the two-drive so.lution, do the following:
1. Perform the Clean Install of the Minimal System o n your in ternal drive, preferably

with the external drive either detached o r turned o ff.
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2. Start your Mac with th e externa l SCSI d rive attached a nd turn ed on. You should see
both your interna l and externa l drives rep resented o n the desktop.
3. Start with Insta ll Disk 1 and click Continu e until you get to the Easy Install option,
but perfo rm the Easy Install o n the external drive.
4. Drag the Startup Disk control panel from the Control Panels folder of the System
folder onto your interna l d isk.
Now every time you turn o n your Mac, you have the option, before shutt ing down, o f selecting the sta rtup drive with the Startup Disk control panel. If you will be working in Office in
your next session, select th e in te rnal d rive as the startup choice. If you want to use all your old
Mac software with loads o f ex tensio ns and everything else (screen savers and so forth), go to
th e Startup control and pick the external drive as the Startup Disk for th e next session . Loo k at
it this way: at th is point, a pretty good hard drive is actually cheap compa red to Office itself,
and th is is o ne o f the best general problem-solving work-arounds ava ilable.

Cleaning Up the Office
The version of System 7.5 th at you have installed by the procedure in the p receding section
is pretty much guara nteed not to be a source of conflicts. To save you eve n more time, you
should also consider perfo rmin g a minimum insta llation of Office itself and t hen adding
elements la ter (see the Appendix) for the following reasons:

+
+

The O ffice suite takes 29 floppies.

+

If you try a m inimum insta llation, your chances of success are greatly improved,
and you ca n go back to the installation set later a nd add features a few at a ti me.

If you try fo r a fu ll installation at one sitting, and it crashes several times o n d isk
21 o r 23, yo u' ll find yourself downright gru mpy by th e end of the day.

Get out Install Disk 1 for Office (see Figure 2.7), and whi le you're at it, please read the Readme
Before Insta llatio n fi le (it has some tips fo r th e disk set that you have, which may co ntain
newer versio ns o f Word o r other applicatio ns) and slavishly do an ything it tells you-th e
advice changes a bit every few mo nths. just by clicking t he Continue buttons, you get to t he
screen where you ca n select th e Minimu m insta llation (see Pigure 2.8), wh ich is just what you
wa nt to do.
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Minimum, the right pl ace to start an installation.

One argu ment in favor of th e Minim um installatio n is based on size alone. The full installatio n is an amazing chun k of code. For example, Microsoft Wo rd is 22MB alone-if someone
had written abo ut a wo rd processing program in a com puter magazine a few years ago, the
article would have been taken as an April Fool's jo ke (see Figure 2.9, taken fro m the Custo m
Installatio n dialog box). No netheless, here it is: Wo rd 6, Excel S, and Power Poin t 4 are even
bigger. But the m inimu m installation for the whole tl?ree-item Office suite altogether takes
o nly 20 MB or so, even o n a Power Mac.
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Bigger installations make for more potential conflicts.

If you've had lots of problems, the procedure is to track down the elements of your previous
Office .installation and delete them. You need to get rid of the folder called Microsoft Office
and the folder called Microsoft. After these folders are gone, you would normally have to look
in the System folder under Extensions, Control Panels, and Preferences, but because you have
insta lled a Minimal System 7.5, all that other stuff has been swept away into the Previous
System folder, to be deleted later at your leisure.
Anyway, this Minimum installation-it wou ld be n ice if software vendors could pick one,
Minimal o r Minimum, and stick with it as a convention-of Office is guaranteed to run with no

conflicts under Minimal System 7.5. You have to install Chooser and your printer d river from
the Previous System folder to get printed output from the Office applications. And you have to
add, selectively, the componen ts to get your Mac running aga in on a network. But at least you
will know, following this procedure, which software element is causing trouble if you start
crashing aga in. It will, by defin ition, be the last element you added (you want to add the
elemen ts one at a time so that you can keep track of them).

A Word About Virtual Memory
There's a funny bit of business about virtual memo ry and Office. Please recall that virtual
memory enables space on your disk drive to substitute for actual RAM, and that it has been
overhau led in System 7.5 to deal with Power Macs. Virtual memory is particularly critical on
Power Macs because Power Mac app lications tend to be 40-80 percent bigger than their 680x0
counterparts.
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The funny business ls that Microsoft Office requires virtual memory to be turned off (in most
cases) to install properly. Then Office requires virtual memory to be turned on (see Figure 2.10)
if you want to run several applications at once and you don't have mountains of RAM. Oddly,
one of the ways you find out that you need to turn on virtual memory is that Excel 5 gives you
an error message, such as Can't Find MicrosoftDialoglib.
Excel can find it all right, but lt doesn 't have enough RAM to load it. If your installation was
successful and you get one of these error messages, you need to allocate more memory by
following these steps:
1. Perform the Minimal installation of System 7.5.

2. Start th e installat ion again, select Custom, select Control Panels, and check the box
for Memory.
3. You can also drag the Memory Control Panel to the System folder from the
Previous System folder that you created with a Clean Install.
4. Restart your Mac. If you had trouble installing Office, go to the Memory control
panel and click the Off button for Virtual Memory. Reinstall Office.
5. Now go back to the Memory control panel and turn on virtual memory so that you
can actually run Office.
Memory
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Figure 2.10

Virtual memory: Off to inst all Office; On to run it.

A little experimentation w ill convince you that despite Microsoft's claims to the contrary,
your System takes a big performance h it when you resort to virtual memory. More's the pity
because a combination of demand and yen versus dollar problems has meant that memory
prices have not fall en but h ave risen sligh tly over the last few years. The 24MB of RAM that
would make Office really happy now costs much more than the software itself!
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The aim of Part I of this book is to explain some nice and useful features of System 7.5 and
then to explain how to make System 7.5 live with Microsoft Office 4.2. To a certain extent,
Apple and Microsoft started digging a tunnel at each other from opposite sides of a mountain.
They met in the middle, but the tunnels didn't match up perfectly. I strongly recommend that
you use the minimum versions of both pieces of software so that you have a clear path
through the middle of the tunnel. Don't let the terms minimum or minimal fool you: System
7.5 and Office make up one of the most feature-filled combinations you have ever seen-even
in their minimal forms.
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Microsoft Word is the biggest word
processor ever developed, at least until
now. It includes scores of new featuressome great, some merely helpful, and
some outright puzzling. As is the case
with a ll reall y large programs, the first
ve rsion was not completely debugged,
and some peculiar wrinkles have survived
in version 6.0.1, too (although 6.0.1 is a
defini te improvement on its immed iate
predecessor).
To compensate fo r the grief of the
occasional Word crash, Part II presents
ways to use Word 6's new features most
effectively so that you will come out well
ahead of the time spent o n your tasks.
Everyth in g you ever wanted in a word
processor-and many things that you
haven't even thought about-can be
found in Word 6. You will learn how
to set up, edit, for mat, and print your
documents. You will also learn how to
add p izzazz to your words with tables,
borders, and graphics. And on top of all
this, you'll learn how to do these tasks
qu ickly, too. Th ink of th is part of the
book as a very long Tip Wiza rd on paper!

Chapter 3

Getting Started
with Word
In many a Microsoft Word book for Macintosh, every third paragraph or so would warn you that
failure to follow the instructions in th e book would result in spinal injury. Fortunately, Word
doesn't really cause you spinal inj ury (unless you use it while driving or skiing), but Word can cause
all sorts of Macintosh-related plagues and problems if you don't lea rn the basics of how to use it.
Before you ca n build a house, you must know how to use hammers, screwdrivers, paint brushes,
and so on. Simila rly, you must know about toolbars, dialog boxes, and other important tools before
you can create the best documents you ca n with Word. After you read this chapter, you'll be able to
check the following items off your need-to-know checklist:

Part II

Word 6

First Things First: Starting Word
Think of starting Word in the same way that you think of switching on an appliance, such as
a food processor. If you don't tum on the food processor, you can't process food; similarly, if
you don't turn on Word, you can't process words. Technically speaking, starting a program
is known as l aunching, and there are several ways to launch Word. Two common methods
requ ire you to double-click an icon, a picture representing a file or folder stored on disk (see
Figure 3.1). Table 3.1 has the details.
Tree• l'r otcc l
109 9 HO In disk

6 Utms

f-

Double-click an
icon fo r an existing
document to launcn
Word and open that
document.

'iJ

fund s Mlln Doc

141.1 M9

~

BrOC!hurt

llim Misc. Documents l§!:i[
~

-

D A Cool<io
D Cir cus Clly
0

Q

Lt ttt r to Ktrs1tn

~11.!!1

Figure 3 .1

TM EHg Propou1
Y~o~t»n Pl.ns

,,..

'

;,, ,

~

Double-click the
Microsoft Word
program icon to
launch Word and
start a new document.

t-horoso rt W'ord

D Monlhly Rtport
D Monlhly Rtport2
D
D

Ulord 6
9 1ttms I C9.9 M9 In duk

, q~

c:

LJ

Vord Ext• nrions

eJ

Double-click to launch Word.

You can change the way icons appear by clicking on a window that has icons and then
choosing a different option from the View menu.

Table 3.1
How to Start Word
Goal

Method

Tip

To launch Word and
make a new document.

Double-click the Microsoft
Word program icon (note
that double-clicking a
folder called Microsoft Word
opens only the folder; it
does not launch Word).

In most cases, the icon is
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Goal

Method

Tip

To launch Word and
open an existing document.

Double-click the icon
representing that document.

The document can be
anywhere. If you can't
find it, try using the Find
command in the File menu.

If the Microsoft Word program icon looks dim and fuzzy, you've already launched Word; the
icon is reminding you that you can't launch Word twice. When Word finishes launching, you
may see a dialog box called Tip of the Day. Click the OK button to exit the dialog box.

After Word finishes launching, a number of items appear onscreen, including a document
window. A document window is an open space where you can start a new creation-a financial report, Jove letter, party invitation, or whatever you like. Figure 3.2 shows a document
window.
The document window that comes up when you launch Word takes on settings that most
people want to use for most documents. For example, the top margin gets set for one inch so
that if you print the document, the body text begins one inch from the top of the page. Word
doesn't randomly invent settings; instead, Word finds them in a special file called Normal.
Normal is a template, a file that stores text and formats on which other documents are based .
As you read this book, you will find that you can change most anything about Normal. The
Normal template lives in the Templates folder. If you throw away the Normal template (or put
it in a location where Word can't find it), the next time you launch Word, Word makes a new
Normal template. The formats in the n ew template are predetermined by Microsoft.
Launching Word causes important ch anges to occur in the Applications menu, which is represented by an icon in the upper right-hand corner of the screen. Specifically, note the following:

+
+

The Applications menu icon is now Word's icon-a W.
In the Applications menu, Microsoft Word has a check mark next to it, indicating
that Word is the active application.

+ The Finder is also listed in the menu (the Finder is the application in which you
doub le-clicked an icon in order to launch Word). The Finder does not have a check
mark because it is not the active progra m.

+ To switch into the Finder temporarily, choose Finder from the Applications menu.
You can also switch by clicking in part of the screen that goes with the Finder, such
as a Finder window or the desktop, the area behind all the open windows on a
Macintosh screen (see Figure 3.2). If you switch into the Finder, you can switch
back into Word by choosing Microsoft Word from the Applications menu or by
clicking in a Word document window (if you can see a document window).

+ To switch into the Finder and hide all Word windows, press Option while you
switch. When you later switch back to Word, the Word windows reappear.
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.-------------------------

-----------------------------,
The document window.

Choose Finder from the Applica tions menu .

Click in the desktop.

Figure 3.2

To switch into the Finder temporarily, click in it or choose it from the Applications menu.

Starting a New Document After
Launching Word
After you have launched Word, you can use the new docu ment window th at came up, but if
you need to start a second file, you certainly may do so. Most likely, you'll want to base the
new file on the Normal template. If you are new to com puters, note that computer people
often use the terms document and file interchangeably. You' ll notice that I use them interchangeably throughout this book.
To create a file based on the Normal template, cl ick the New button (the leftmost button) on
th e Standard toolbar or press ~-N.
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Templates
To open a new document that is based o n a template other than the Normal template, follow
these steps:
1. Go to the File men u and choose New. The New dia log box appea rs and displays a
list of templates and wizards, built-in help that simplifies the task of creating a
com plex documen t (see Figu re 3.3). The wizards all have the word Wizard in their
names. Templates do not have Wizard in their names.

2. From the Template list, select the template on which you want to base the
document.
3. In the New area at the right, select Document.
4. Click the OK button.
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Figure 3.3 Use the New dialog box to open a document based on a template.

Wizards
Technically speaking, wizards are extremely complicated templates. You can make you r own
wizards, but first you must become a WordBasic expert. (In other words, it takes a wizard to
make a wizard.)
Microsoft invented wizards to help people who need to create complicated documents but
who don't have the time or kno wledge to create them from scratch. For example, the Newsletter Wizard asks questions about how it should set up a newsletter, and it sets up a document
based on your answers. To try out a wiza rd, follow the steps fo r opening a template (look back
a paragraph or two) but open o ne of the items that has Wizard in its name.
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For example, if you open the Calendar Wiza rd, Word offers friendly dialog boxes that ask for
input o n what you want a calendar to look like (see Figure 3.4). Based o n your input, Word
creates a calendar.
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Figure 3.4 The Calendar Wizard helps you create a ca lendar.

The All-Important Open Dialog Box
The Open dialog box helps you open existing fil es, but it's not always th e easiest way to open
them. Before you worry about using th e dial og box, consider th ese alternatives:

+

Switch in to th e Finder (read back a few paragra phs to find out how) and then
double-click the icon for the file that you wan t to open. If the Mac beeps or does
not permi t yo u to switch back to the Finder, you may have a dial0g box open.
Click th e OK o r Cancel butto n to d ose the d ialog box.

+

To reopen a fi le that yo u o pened recen tly, choose it fro m the File menu. If nothing
shows, turn on Recen tly Used File List in the Ge nera l card of the Options dialog
box from th e Tools m enu. After you turn it on, files that you have opened begin to
show in the menu.

If you want to try a more sophisticated opening techniq ue, o r if you need to open a file that
came from a d iffe rent program, use th e Open d ialog box. Here are the steps:
l. If the docum ent is on a flo ppy d isk, put the floppy disk in the d isk drive. Similarly,

if th e file is o n a network vo lume (such as a fil e se rver), connect to that volume
(use the Chooser in the Apple menu).
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2. Go to the File menu and choose Open (you can also click the Open button on the
Standard toolbar or press ~-0). The Open dialog box appears (see Figure 3.5).
3. The name of a disk appears in the upper righ t-hand corner of the Open dialog box.
If the name is not correct for the file that you wa nt to open, click the Desktop
button to show available disks in the list at the left. Double-click the name of the
correct disk. The disk name should appear at the upper right and in the location
pop-up menu.

e
'

Caut ion: If you eject a floppy disk by using the Eject button in the Open
dialog box, keep t he disk around until you restart or shut down because
the Mac may want the disk back before it can continue with what you are
doing. To eject a disk properly, drag its icon to the Trash or click the
disk's icon and the n choose Put Away (~-Y) from the File menu.

e
'

4. After choosing the correct disk, work your way to the correct location on the disk.
The goal is to make the location show in the location pop-up menu. To move
down into a folder, double-click the folder name. To move up out of a folder, use
the location menu to select a location higher in the h ierarchy.
S. When the correct location shows in the pop-up menu, you should see the file that
you want to open listed below the location . If you don' t see the file, you may h ave
to scroll down in the list. To open the fil e, double-click the fi lename.
To move quickly to an item in the Ust, type the first letter in the item's name. The
Macintosh automatically selects the first file or folder whose name starts wi th that
letter.
The locatio n from which
you can open a documen t.
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ca n open a document.
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Figure 3 .5

Use the Open dialog box to open documents.
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Saving a Document
Saving is of paramount importance. Not saving your docu ments makes as much sense as
leaving ice cream in t he sun, leaving wine in t he freezer, or chalking a mural o n the sidewalk
during a rain storm.
When you type in Word or change settings (such as margins) and formats (such as italics),
all your edits and changes get sto red in random-access memory, also known as RAM. RAM
is powered by electricity, and if for any reason the steady flow of electricity to your Mac is
interrupted, you lose the information in RAM. The flow could stop due to so mething as
mundane as a power outage, as unex pected as a space alien invasion, or as un fortunate as
a frozen Mac.
To keep docum ents around permanently, you must save them to a disk, usually your hard
disk. To save a document for the first time or to save a document and change its name or
location, follow these steps:
1. With the d ocument window active, go to the File menu and choose Save As. Word
responds by displaying the Save dialog box (see Figure 3.6).

2. The Save dialog box works in much the same way as t he Open dialog box, so look
back a few paragraphs if you need mo re detailed information. The file saves to the
disk showing in the upper right-hand corner, and it saves to t he location showing
in th e location pop-up m enu.
3. Type a name for the file in the Save Current Document As box.
4. If you are saving the file as a regular Word document, leave the Save File as Type
op tion set at Word Document. If you want to save the file in a different forma t so
th at a d ifferent progra m, such as WordPerfect, can use it, choose the format from
th e Save File as Type menu.
S. Click the Save b utton . As Word saves, it shows a progress indicator below the Word
window.
To save all open documents, as well as new macros and AutoText en tries, drop down t he File
men u and choose Save All. To save the document in a folder th at d oesn't exist, click the New
button to make a new fo lder. After you have saved a fi le once, you don 't have to use the Save
As command to save it again. You can simply use the Save command. Either press U-S or click
the Save butto n on the Standard tool bar.
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In the Save dialog box, select the correct disk and location for your document.

Caution: If your work is important, don 't leave it saved on just one disk. At

e
'

the end of each day or week (depending on the importance of what you
do), copy each important document to another disk. Th at way, if one disk
goes bad, you have another copy on another disk. You can also purchase
a backup program.
Word 's maximum fi le size is about 32,000 kilobytes. Even so, if you have
a file larger than 100 kilobytes, it's large enough. The only exception is if
your document is artificially large due to a number of graphic images. At
around 100,000 characters of text, you'll be happier if you break the file
into a series of smaller documents. Smaller documents are faster to work
with and less prone to problems. Use the Copy and Paste commands to
break the document up-if you don't know about Copy and Paste, you can
find out about them in Chapter 4.

•

To give you an idea of how file size and character count translate to real life, this chapter
(without the graphics) is about 50,000 characters, and the Word file for this chapter takes up
a little more than SO kilobytes of disk space. To find out how many characters are in a document, go to the Tools men u and choose Word Count.
After you save a document once, Word may do a fast save, if you save it again. A fast save
goes faster because Word doesn't save the entire document again; instead, Word saves just
your changes. If Word is set to do fast saves, every tenth time that you save, Word saves the
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document with a full save. The full save completely rewrites the document. Fast saves tend to
create complex documents from Word's point of view because Word must keep track of the
changes. If you make a lot of changes, you create a lot of information for Word to track. Full
saves simplify the document and give Word a fresh start.

How to Avoid Losing Documents
The Backup Copy and Automatic Save (also known as autosave) features team together to
decrease the chance of disaster if a document becomes damaged or your Mac's power gets cut
off. Table 3.2 compares the two options.

Table 3.2

Differences Between Automatic Save and Backup Copy
Feature

How it works

Cautionary tip

Backup Copy

Immediately after saving a document, Word normally deletes
the preceding version. With Backup
Copy on, the preceding version sticks
aro und.

Backup Copy keeps o nly th e
most recently saved co py.
It does not keep copies of
the document fro m each
time you save and cannot be
customized in this respect.

Automatic Save

Saves after a time interval that you
specify and stores files in a temporary
holding spot on disk (an invisible folder).
If you crash, the next time you start
Word, the files automatically open
(most of the time).

You still must ma nually save
documents because Word
deletes automatica lly saved
documents when you q ui t
Wo rd.

To turn on Automatic Save or Backup Copy, open the Options dialog box from the Tools
menu and select the Save card. You should see check boxes for Always Create Backup Copy
and Automatic Save Every. If you turn on Automatic Save, you must enter how often you wan t
to autosave in the Minutes box (see Figure 3.7). To access the Save card while you are in the
Save dialog box, click the Options button.
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This check box controls whether Word keeps a backup copy.
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Use the Save card to turn on and off features related to saving.

Preventing People from Changing
a Document
A document that you can open and view, but no t chan ge, is known as a read-only document.
If you can view and change a document, then you have read-write access to the docume nt.
Word offers a feature called Write Reservation Password, which sets things up so that a document can be opened and viewed but cannot be changed unless you type the password. If you
do lock a document, the next time someone tries to open it, that person will see a dialog box
much like the o ne in Figure 3.8.
Possword
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A Write Reservat ion Password requires you to know the password in order to change a
particular document.
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Turning on the Write Reservation Password
To turn on t he password for the active docu ment, follow t hese steps:
1. Go to the Options dia log box from the Tools men u and select the Use r Info card.

2. At the top of the User Info ca rd in the Name text box, enter the name that you
want to appear when Wo rd asks for the password (see Figure 3.8).
3. Cli ck the tab for the Save ca rd.
4. At the bottom o f th e Save card, type a password in the Write Reserva tion Passwo rd
text box. As you type, bullets appear. Each b ullet represents a character in the
passwo rd. The password ca n be as short as o ne character, as long as 15 characters,
o r anywhere in between .
Caution: Passwords are case-sensitive; that is, Word considers the password

•

•

SECRETto be completely different from the password secret.

'

5. Click th e O K butto n. The Confirm Password d ialog box appears.
6. Type the same password th at you en tered in the Save ca rd and click the OK button.

Turning off the Write Reservation Password
To rem ove th e passwo rd, yo u must know the password so that yo u can open t he document
with read-write access. After you o pen the docu ment wit h read-write access, go into the Save
card and delete t he bullets from the Write Reservation Passwo rd text box.

Keeping People Out of a Document
If you want to p reven t people from accessing a documen t, you ca n password protect it.
Passwo rds keep snoopy co-wo rkers out of your resume as you search for a better job,
housemates o ut o f you r spicy love letters, and ill-meaning no-goods out of you r fi les.
Caution: If you forget a password, however, nobody can help you remember

it, including the folks at Microsoft!

•

When you attempt to open a password protected document, you get the
message shown in Figure 3.9.

'
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Figure 3.9 You must know the password in order to open a password protected document.

Adding a Protection Password works much like adding a Write Reservation Password (see
"Turning on the Write Reservation Password," a few sections back).

Closing a Document
Closing a document makes sense if you wa nt to get it out of the way. To close a document,
click the close box at the upper left-hand corner of the document window (see Figure 3.10). If
a document is not completely saved when you close it, Word asks whether you wa nt to save
the changes. Be sure to click th e Yes button if you do want to save them.
To close all open documents, press Shift while dropping down the File menu. When the Shift
key is down, the Close command changes to Close All. Choose Close All.
Thanks to Mrs. Jones

The close box.
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Figure 3.10 Click the close box to close a document's window.

Quitting Word
After you finis h using Word, go ahead and quit. To quit, go to the File menu and choose Quit
(or press ):(-Q). As Word quits, it closes any open docu ment windows. If a document is not
completely saved, Word asks whether you want to save it. It's a good idea to quit Word before
you restart or shut down.
When you quit, Word saves changes made to templates and changes made to the Word
Settings (6) file. To save those changes at any time before you quit, choose Save All from the
File menu .
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When you quit, Word releases the RAM that it was using, giving you more space in RAM to
launch other programs. Notice that after you quit, the Applicati ons menu no longer lists
Microsoft Word.

Converting Your Files
Do you need help opening documents that came from other word processors or from someone
who doesn't use Word 6 for the Macintosh? In either case, keep reading for general pointers
and a few specific tips. If you are looking for information about importing graphics, see
Chapter 8.

Opening a document that is not a Word 6 document
To open a document that is not in Word 6 for the Macintosh format, follow these steps:
1. Launch Word.

2. From the File menu, choose Open. Word displays the Open dialog box.
3. From the List Files of Type pop-up m enu, select the converter that most closely
matches the format of the file you want to open.
4. Use the controls in the Open dialog box to look at the location where the document is stored.
5. Select the document and click the Open button.
Word opens th e file. After the file opens, if you save it with the Word Document file type, the
file can convert into a regular Word 6 document.
Caution: To move a file to or from a DOS/Windows disk, you must set up

•
'

your Macintosh to read the DOS/Windows disk. Any Macintosh new
enough to run Word 6 came with software that enables you to read and
format such a disk. Newer Macintoshes come with an extension called
PC Exchange (put it in your Extensions folder. reboot, and your Mac can
automatically read and format DOS/Windows disks); older Macintoshes
came with a program called Apple File Exchange (double-click the Apple
File Exchange icon to use the program).
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Saving a document in a different format
To save a document in a format other than Macintosh Word 6, try these steps:
1. With the file open in the active window, choose Save As from the File menu. The

Save As dialog box opens.
2. In the Save As dialog box, type a different name for the document. If the document
will end up o n a DOS or Wi ndows computer, use 11 characters or fewer to name
the document.
3. From the Save File as Type pop-up menu, select the file format closest to the format
that you want. (If you are converting between Microsoft Word or MicrosoftWorksany version, any computer-and there is not a specific converter, try using the Rich
Text Forma t converter. The Rich Text Format converter also works for converting
files into WriteNow.)
4. Make sure that you are set up to save the file where you can conveniently find it
again and click the Save button.
Word saves the file in the format that you specified.

Using the Rich Text Format (RTF) in emergencies
Rich Text Format-usually called RTF for short and also known as the Interchange Formathas helped more Word documents out of bad situations than virtually any other fix-it procedure known. "RTFing" a corrupted document sometimes removes the corruption, resulting in
a normal, healthy document. A corrupted document is on e that doesn't work right-perhaps
the styles don't apply to certain paragraphs or random text shows up in the headers.
If you think you have a corrupted documen t, test it by trying to make the same problem
appear in another Word document. If you can't and you are sure you understand how to use
Word correctly with respect to the problem, you probably have a corrupted document on your
hands.
To see if RTF can fix the corruption, try these steps:
1. Go to the File menu and choose Save As.
2. In the Save As dialog box, type a different name for the file. It's important to type a
different name!
3. Select a location for the fi le (be sure to save it where you can find it again).
4. From the Save File as Type men u, choose Rich Text Format.
5. Click the Save button. Word saves a copy of the document in RTF.
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6. From the File menu, choose Close. Word closes the potentially corrupted
documen t.
7. From the File menu, choose Open.
8. Use the Open dia log box to locate and open the copy of the file that you saved in
RTF. Word converts the copy back into Word format and opens it as a new document. If you want to sou nd h ighly technical, you can now tell people that you
"RTFed" the document.
If saving the file as an RTF file has fixed the corrupti~n in the document, the problem won't
exist in the new document, which you can save and use preferential ly.

Sharing files with Macintosh Word 5 users
As a Word 6 user, you live on easy street when it comes to sharing documen ts with people
who use Word 5 (5.0, 5.0a, 5.1, and 5.1a). To open any Word 5 docu ment, you si mply doubleclick its icon. Saving a Word 6 document in Word 5 format is also easy. From the Pi le menu,
choose Save As. In the Save Document as Type pop-up menu in the Save As dia log box, choose
either Word 5.0 o r Word 5.1 for the Maci ntosh (choose Wo rd 5.0 if you aren't sure). After the
document is in Wo rd 5 format, anyone who uses Word 5 can double-click the document's
icon and open the document in Word 5.

Caution: If you have Word 5 and Word 6 installed on the same Macintosh,

•

double-clicking a Word 5 file may cause the file to open in Word 6. To
open a Word 5 file in Word 5, use the Word 5 Open dialog box .

'

Choosing the Correct Word 5 Converter

•

'

Word 5 users beware: the version of the converter that you use can make a big difference.
If you want to share a Word 5 document with someone who has Word 6 , you have no
problem because Word 6 can open any Word 5 document.
However, If you try to open a Word 6 file, you must first have the correct converter in the
correct folder. (To avoid this problem, tell your Word 6 friend to save the file as a Word 5
document!) The correct folder is called Word Commands, and the correct converter is
called Word 6 for Macintosh&Windows. For a while, Microsoft shipped a converter called
Word 6 for Macintosh/Windows, but this converter had many failings-it usually didn't
work at all. (Note that the good converter has an & in its name.)
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Word 5 users can acquire the good converter by contacting Microsoft, downloading it from
an online service, or copying it from the Microsoft folder that comes with Office. It is legal
for a Word 5 user to get a copy of the converter from the Word 6 Microsoft folder. Word 5
users can download t he converter from the Internet at the following URL address:
ftp: //ftp .microsoft. com/Softlib/MSLFILES/~ISWRD6. HQX

Finding additional converters
If a converter you need is not available via the Save and Open dialog boxes, check to see
whether the converter comes with Word but is not currently installed. To find out which
converters come with Word, follow these steps:
1. From the Help menu, choose the Search For Help On command. The online help

appears.
2. Type converters in the upper-left text box.
3. Select converters from the list of options and press Return.
You can also find the converter information on (or near) page 593 in the User's Guide that
came from Microsoft.
If you don't have a converter installed, you can install it by running Microsoft Office Setup
again . (It doesn't take nea rly as long to install just a converter!) After you reach the dialog box
where you select exactly what gets installed, look for converters under Microsoft Word in the
Converters and Filters section or under Tools in the Shared Converters section.
In the past, Microsoft has released new converters at a regular rate, and I expect it will continue to do so. Microsoft also has a history of improving the features in existing converters,
so if a converter doesn't work or appears to be m issing, it's worth asking arou nd to see if
anything has changed.
If Microsoft cannot provide the correct converter, the program that you want to convert to or
from may have one. If neither program has a useful converter, try using an intermediate format to perform the conversion. For example, if you can't export into WordPerfect 4.2 format
but you can export into WordPerfect 5.1 format, find someone who has 5.1 and use it to
save into 4.2 format. As another example, you can use Rich Text Format as an intermediary
beh-veen Word and WriteNow-Word and WriteNow can both open and save into the Rich
Text Format.
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To convert Word into HTML format as part of setting up a World-Wide Web site (a popular
method fo r providing information to the lnternet), you can use an RTF to HTML converter.
Several of them float around online, and at least one of them is posted on the TidBITS FTP site
in the Word Book directory. The URL address is
ftp://ftp.tidbits . com/ pub/tidbits/thewordbook

You sh ould also check o ut World of Words, a Web site that has an area devoted to Microsoft
Word. If Microsoft ever comes through with a Macintosh version of its Word Assistant program (which helps you create HTML documents in Word), Wo rld of Words will have info rmation about it at the following URL address:
http : /king.tidbits.com/tonya/WOW /

Finally, consider purchasing a th ird-party conversion program. Before you buy the program,
make sure that it does the conversion that you need. If you are trul y desperate and have an
obscure format to convert, try a service bureau.

Customizing a Conversion
Because different word processors have different ways of handling similar document
elements, it is virtually Impossible for programmers to create a converter with a perfect
conversion. Most t ranslators do a good job, but if you expect perfection. you will be
disappointed.
To find a wealth of excellent and detailed information about what to expect from a particular
conversion, how to customize the way a conversion works, and how to do batch conversions,
double-<:lick the Word Read Me Help file (It should be in the folder where Word is Installed).
In the contents of the Help file, click File Conversion and read as much of the help as
needed (click the underlined text to see more information).

Tool bar Tips and Trivia
Now that you understand how to convert, open, save, and close documents, you are ready to
move on to learning about Word's tools. In each document window, you see a wide array of
buttons and controls (see Figure 3.11 ) unless you have changed the defaults. Fev,• people
mem orize every button and option offered, so don't panic about knowing every little detai l.
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Fo rmatting
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toolbar.

Ho rizon tal
ruler.

Dear Mro.)ones,

Vertical
ruler.

But tons fo r swit ch ing views.

Status bar.

Figure 3 .11 Word offers a cornucopia of controls.
Word has numerous toolbars customized for your convenience so that yo u can q uickly access
tools for a particular task, such as bordering paragraphs or d rawing pictures. By defaul t, the
Standard and Formatting toolbars appea r when you launch Word (see Figure 3.12); other
toolbars may appear as needed.
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Rgure 3 .12 The Formatting and Standard toolbars.
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The toolbars contain buttons g rouped together for a particular purpose. If you move the
pointer slowly over a button, a name tag, called a ToolTip, pops down from the butto n. To
turn the To61Tip disp lay on or off, go to the View menu and choose Toolbars. In the Toolbars
dialog box, the Show ToolTips check box at the lower right controls the display ofToolTips.
To issue the command represented by a button, click the button. A few commands, such as
the Zoom Control o n the Standard toolbar, are pop-up men us, and you can either click the
triangle and choose an option from the menu or type your own option in the menu box and
then press Return.
To enlarge toolbar buttons, choose Toolbars from the View m enu. Turn on the Large Buttons
check box and click the OK button. To further customize toolbar buttons, go to the Tools
menu and use the Toolbars card in the Customize dialog box (see Chapter 9).
You can adjust toolbars in many different ways. If you adjust a toolbar, the adjustment
becom es the default until you change it again.

+

You can "dock" toolbars o n any edge of the screen by dragging th em to a different
edge, but if you dock them on one of the sides, po p-up menus (such as th e Font
menu) turn into less convenient buttons. To drag a docked toolbar, drag on the
gray area behi nd the buttons.

+ Rearrange docked toolbars (the ones at the edge of the screen) by dragging them
around in the region at the edge of the screen . People with la rger monitors will
have a larger region in which to drag.

+

If you drag a toolbar below the top of the document window, it converts into a
floating toolbar.

+
+

"Float" a toolbar by double-clicking in the gray area surrounding its buttons.

+
+

Change a floating toolbar's shape by dragging its resize box.

+

To hide o r show a toolbar by clicking a check box, choose Toolba rs from t11 e View
menu.

+

To show or h ide a toolbar rapidly, use a shortcut men u. To see the menu, press
Control and click any part of any toolbar.

Move a floating toolbar by dragging its title bar o r the gray area behind the
buttons.
Close a floating toolbar by clicking its close box or convert it into an anchored
toolbar by double-clicking in the gray area surrounding the buttons (see Figure 3.13).
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Figure 3 .13 The trick to controlling a floating toolbar is knowing where to click.

The Marks on the Status Bar
The status bar gives information about the loca tion of the insertion point, the time, and the
mode (see Figure 3.14). You can hide or show the status bar in the View card of th e Options
dialog box from the Tools menu. If you have trouble understanding the cryptic text o n the
status bar, h ere's an explanation:

+

Page and Sec tell the page and section that your insertion point is in. If you have
inserted page numbers, Page refers to the number that will print and not necessarily to the order of the pages in the document. Double-click Page to bring up the
Go To dialog box and go to a different part of the document.

+

To the rig ht of the section number, the status bar shows how many pages are in the
document, up to and including the page holding the insertion point. The bar also
shows the total number of pages in the document. For example, 4 I 8 m eans the
insertion point is on the fourth page of an eight-page document.

+

At refers to how far the text will be from the top of the page if you type at the
insertion point.

+

Ln indicates how m an y lines the insertion point is from the top of the page. It does
not include text in the header.

+

Col tells how many characters the insertion point is from the left edge of the
column. Col is a throwback from old-style word processors that could use on ly
mo nospaced fo nts, where each character h as exactly the same width as the o thers.

+

The time tells wh at time it is. You cannot rem ove the time from the status bar. To
set the time, use the Date & Time control panel (start by choosing Control Panels
from the Apple menu) .

+
+

REG is sho rt for record and com es into play if you record macros (see Chapter 9).

MRK stands for mark and changes from gray to black while you revise a document
via the Revision command.
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If EXT is black, the Extend Selectio n o ption is active (see Cha pter 4).
If OVR is black, yo u are in Overstrike mode, in w hich what you ty pe replaces text to
its right (see C hapter 4).

+

On a PowerBook, the rightmost item is a battery life ind icator, wh ich attempts to
let yo u know how much charge is left in your battery.

+

Double-click REC, MRK, EXT, or OVR to toggle in and o ut of the modes t hey
rep rese nt.

Ho w many pages the insertion
point is from fhe beginning of
the docum ent.

The page and
sectio n number
of the insertion
point locatio n.

How far the
insertion point
is fro m the to p
of the page.

Ho w ma ny
cha racters the
insertio n poin t is
from the left m argin
(or column edge).

How m any lines
of text the
insertio n point is
fro m t he to p
margin.

The
time.

Fo r
recording
macros.

Fo r OverFor Extend
Selection mode. strike mode.
Fo r setting up revision
marks.

Figure 3.14 The status bar.
The status ba r also shows ti ps. As you point to an optio n o n a toolbar o r men u, watch t he
status ba r to remind yourself of what the comma nd does.

How to Rule th e Rulers
The marks on a ruler give informat ion abo ut t he layout o f the currently selected paragraph, o r
if yo u have nothing selected, t hey give info rmatio n abo ut th e paragraph ho ld ing the insertio n
po int. If you have more than one paragraph selected, the marks refer to the first paragraph in
the selection. To hide or show the ruler, choose Ruler fro m t he View menu. In Page Layout
View, a vertical ruler shows in additio n to the ho rizontal ru ler.
The most commo n use of the ho rizontal ru ler is to change the indents, wh ich con t ro l where
the text falls in relation to t he side m argins. You can also set tab sto ps, colu mn wid ths, and
margins.
Generally speaking, when you make an adjustmen t in th e ruler, it affects selected paragraphs.
Or if yo u don't have an y text selected, it affects t he parag rap h ho lding the insertio n point. The
gray part of the ruler ind icates the margin; the white part sta rts at zero and ind icates the space
betwee n the ma rgins (see Figure 3.15).
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Figure 3.15 The gray area extends from -1.25 to 0, indicating that the left margin is at 1.25 inches.

Switching the View
Word has different views for doing different things. The buttons on th e left side of the horizontal scroll bar enable you to switch views, and because these buttons spend their entire lives
waiting to be clicked, you may as well stroke their egos by clicking them now and again (see
Figure 3.16). You can also switch views by choosing them from th e View menu.
If you switch views frequently, consider memorizing keyboard shortcuts for switching:
:~=t-O ption-N puts you in Normal View; :~=t-Opti on-P switches you into Page Layout View;
:~=t-Option-0 puts you in Outline View; and :~=t - Option -1 takes you to Print Preview.
Document I

<li!l[

Delli Mro. Jones,

Normal View.

••~1tilp.:lll;,aii,;:;•¢;.L.OI:...__ _ _ _I-l---":..._-'-------.l,;l
''~~:J.~I~'I!l

I

I

Page Layout View.

Outline View.

Agure 3.16 Click a button to switch the view.
Use Normal View for working with text, without concerning yourself with layout detalls, such
as snaking columns, correctly positioned graphics, and headers or footers. Page Layout View
works much like Normal View but offers the advan tage of showing the layout as it will print.
Page Layout View also has a vertical ruler.
Outline View is probably the most ignored view,- and it's a real shame because it enables you
to organize and reorgan ize information, create traditional o utlines, and auto matically app ly
built-in heading styles (see Chapter 5).
Master Document View extends Outline View so that you ca n work with mo re than o ne
document at once (see Chapter S).
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Print Preview enables you to see Word's best guess as to how your documen t wi ll print. Word
6 offers a new Print Preview feature called Shrink to Fit, which eliminates the last page in a
documen t if the text runs over to that page by a small amount. Cha pter 10 explains Print
Preview mo re thoroughly.

Using Keyboard Shortcuts
Keyboa rd sho rtcuts help you get things do ne quickly. Predefined keyboard shortcuts appea r in
the menus, to the right o f th eir commands. For exam ple, if you look o n the Fi le menu, you'll
notice that the Save command is followed by the sym bol ~ -S. The symbol means that you
don't have to choose Save fro m the m enu in o rder to use th e Save command; instead, you can
use the keyboa rd. In t his case, you'd press the~ key and the S key at th e same time. Table 3.3
matches comm o n sy mbols th at appea r in Word with keys o n the keyboard.

Table 3.3
Keyboard Shortcuts
Symbol

Keyboard key

Command (som etimes th e key sh o ws an apple, too)

Option
Shift
Contro l
The menus show a few keyboard sho rtcuts, but you ca n find even more by choosing Customize from the Tools menu. Afte r the C usto mize dia log box comes u p, select t he Keyboard ca rd.
A list of menu names and special options appears at the far left, and if you select an item from
the list, the commands th at go with that option appear in the Commands list. If you select a
command that has a keyboard shortcut associated with it, the shortcut shows in th e Current
Keys box (see Figure 3.1 7). Click t he Close button when you fi nish looking.
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Figure 3.17 It's easy to discover keyboard shortcuts.

Menus for Novices and Keyboard Enthusiasts
Most of the time, Word's menus work like the menus in any other program. The drop-down
menus come down from the menu bar, and a small black triangle symbolizes the presence of
a pop-up menu. For example, in the Note Options dialog box, you can customize the behavior
of footnotes or endnotes. The dialog box has two small black triangles-one for the Place At
menu and one for the Number Format menu (see Figure 3.18). To open the Note Options
dialog box, go to the Insert menu, choose Footnote, and click the Options button in the
Footnote and Endnote dialog box.
Note Options
All Footnotes
Piece At:

Number Format is an exa mple of a
pop-up menu.

1- llu mber forma t:
Stert At:

T

All Endnotes

Bottomof Page
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Figure 3.18 The Note Options dialog box has two pop-up menus.
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Using the keyboard with the drop-down menus
Normally, you use the pointer to choose menu commands, but if you activate th e menu bar,
you can choose menu commands by pressing keys o n the keyboard. The official keyboard
shortcuts for activating the menu bar are ):(-Tab and FlO. Either o ne wo rks, in theory, but you
may run into pro blems. If you have Microsoft Office Manager installed, pressing ):(-Tab will
switch you between launched applications. If you do n't have an extended keyboard, you
won't have an FlO key. So, if you use Microsoft Office Manager o r have a standard keyboard,
use th e Custo mize dialog box to ass ign a different keyboa rd shortcut. Menu Mode is the
official command name that you will need to customize.
Fo r the sake of the rest of these directions, this book tells you to press ):(-Tab to activate the
m enu bar. I decided to stick with ):(-Tab for historical reasons-Word 5 also uses ):(-Tab to
activate the menu bar.
In any event, to get started with using the keyboard to activate the menu bar and drop down
the menus, press ):(-Tab and then note that each m enu name has a smaJlunderline beneath
on e of its characters. Press that character to drop down the menu or to choose a menu item.
(for example, press T to drop down the Tools menu and then press R to start a mail merge.)
You can also use the Left- and Rlght Arrow keys to move to menus and the Up- and Do wn
Arrow keys to move within menus.
Press ~-Pe riod to deactivate the m enu bar and not choose any menu options.

Using the shortcut menus
Shortcut menus offer quick access to commands that relate t o a particular item. To display a
sh ortcut menu, press Control and click an item of interest. For example, if yo u Control-click
a field, Word reacts by displaying a menu that helps you control the field .
To see a list of all the shortcut menus, open the Menus card in the Customize dialog box from
the Tools menu. Pop up the Change What Menu and look at m enus that end with (Shortcut).

Tips for Moving in Dialog Boxes
As you have probably noticed, many co mmands lead to dialog boxes, where you can select or
type various optio ns (think of it as having a dialogue with Word). Due to the large number of
o ptio ns built into Word, Microsoft organized most dialog boxes with cards, wh ich you select
by clicking their tabs (see Figure 3.19). Different sources use slightly different terminology for
the dialog boxes, but 1 think that cards and tabs make the most sense, so I used these terms in
this book.

64

Getting Started with Word

Chapter 3

C lick a tab (such as the User
Info tab) to switch to its card.

I
Dpllons

r
r

T

Revl~loll3

y,...,

Save

r
T

T

lher Info

Gtnent
Spc\1100

T

I

Com..liblllty

l

I

[dit

Gramm5r

S1vc Options
0Atv&IJ' Create 84c: t.up Copv
0Allov ra,t Seve..s
0Prompt for Summln~ Info
0 Prompt to ~e Nor mel
0 Seve fle11ve P1eture fcrmeb Only

T

~

[
[

File Loeatio n.s
Pri nt
Autorormt~~t

OK
Cancel

Help

B

I
I

0Embed TrueTv;~e: Fonts
0 Sevt Oato Onlt.~ ror forms
C8]Au1om5t1C S~ve Evert,~:

~Minutt3

I to

fll e - S herfng Op ti ons for Documeat3
ProtteUon Pu!\o"'rd
Wnt e Rt!trvaticn Pa-sNOrd·

DRead-Only Rtcommendt\2

Figure 3 .19 The Options dialog box has many cards.
To see cards and tabs in action, check out the Options dialog box, which you access by
choosing Opti o ns from the Tools menu. The dialog box has many different cards that are
analogous to index cards in an index file (pe rhaps the most common use of index cards and
fi les is for storin g recipes). To move to a different card, such as th e Ge neral card, click the tab
at the top of the card. Press Control-Tab to switch which card shows at th e fron t of the dialog
box.
On most monitors, you can view the d ial og boxes in two different ways . By defau lt, Word
displays d ialog boxes in much th e same way that they appea r in Word for Windows. To get a
compromise between Macintosh- and Windows-like dia log boxes, turn off the check box for
3D Dialog and Display Effects. The check box is in the General card of th e Options dialog box.
Most dialog boxes show n in this book sport the non-3D look.
Many dialog boxes offer tiny triangles that you can click to increase or decrease the number in
their associated boxes. To see several examples of these triangles, choose Paragraph from the
Format menu and look at the Indents and Spacing card. If you don 't want to click the triangles, you can also type a number in the box o r, with the insertio n point in the box, press
the Up- or Down Arrow keys to increase or decrease the number.
In an y d ialog box, press the ~ key to see keyboard shortcuts that you can issue in the d ialog
box. For example, if you press ~ while in the Font card of the Font d ialog box, the i in Hidden
gets an underli ne. If you press ~-1, Word turns on or off the Hidden format.
A few d ialog boxes offer check boxes. In all cases, a clear check box m eans the option is off,
and a checked check box m eans th e option is on (by checked, I mean filled with an X). In
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some dialog boxes, such as the Font dialog box, a check box may be filled with gray. The gray
color means that only some of the text selected in the document has that ch eck box option
applied. In a few uncommon circumstances, the gray coloring means that circumstances
prohibit you from changing the option.

How Word Thinks
If you know how someon e thinks, you can often anticipate what that person is going to do
next. Word isn't nearly as complex as a real-life person, but if you have an idea of what's going
on from Word's virtual point of view, you have a much better chance of steering Word where
you want it to go.

Characters and character formats
just as atoms are in many ways the fundamental building blocks of the universe, characters
(such as w, %, and 8) are the fundamental building blocks of a Word document. A number of
the formatting options offered in Word are applied by character, and these formats are aptly
named character formats. For example, Bold is a character format, and you can emphasize any
letter that you want in a word by making it bold. See what happens when you add Bold
character formatting to the word zebra? The word visuall y takes on the striped quality of the
animal!

Paragraphs and paragraph formats
To extend the atom analogy, if characters are like atoms, then paragraphs are like molecules.
In Word's opinion, a paragraph ends every time you press Return. If you have non printing
characters showing, you'll see a paragraph mark representing the place where you pressed
Return. Nonprinting ch aracters can show onscreen but never on a printout. Some formats
(such as custom tabs, indents, and centering) apply by paragraph. For example, you can center
an entire paragraph by clicking the Center button on the Formatting toolbar, but you cannot
center just a few characters in the middle of the paragraph.
When you turn on centering, type a paragraph that takes on the centering format, and then
press Return, Word ends the paragraph and starts a new paragraph. The new paragraph will
also be centered, unless you turn off centeri ng. To turn off centering, you must firs t have the
insertion point in the new paragraph or highlight something in the new paragraph. Then you
click the Center button on the Formatting too lbar.
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Sections and section formats
Some fo rmatting (such as page numbering) d oesn't make sense to apply by character or by
paragraph. For example, yo u m ay want the first few pages of a document to have Roman
numeral page numbers and th e rest of th e pages to have regular Arabic numerals. As another
example, you may want most o f a d ocument to print in the usual portrait o rientation, but
th en you want a few pages to print sideways in the landscape orientation. Orientation refers to
how text flows from left to right on a printed page.
When you start a docum ent, it consists of one secti on (under most circumstances), and all
th e paragraphs share the same section-based formatti ng. If you decide that you don't want the
same formats to appl y to the entire document, you can insert section breaks to divide the
document into separate sections.
The status bar sh ows the number of the section containing the inse rtion point. For example,
Sec 3 means tha t the insertio n point is in section three.

Inserting and formatting section breaks
To insert a section break, click where you want the break, go to the Insert menu, and choose
Break (or press ~-Enter) . The Break dia log box appears. In th e Section Breaks area, select Next
Page to make the section break also be a page break. If you don't want the section break to be a
page break, too, select Continuous. Click th e OK button to finish inserting the section break. If
you have trouble seeing section breaks, switch to Normal View.
To change w hether a section break is continuous or acts li ke a page break, follow these steps:
l. Click in the sectio n d irectly below the section break that you want to change.

2. From the File menu, choose Document Layout.
3. When th e Document Layout dialog box appears, select the Layout card.
4. Use the Sectio n Start pop-up m enu to change th e way the sectio n begins and then
click the OK butto n.

Applying section formats
To apply a section-based fo rm at in the traditional method, first click in the section (so that th e
insertion point is in th e section) o r highlight at least a portion of the section. Then apply the
format from the appropriate dialog box, too lbar button, or keyboard sho rtcut.
In previous versions of Wo rd, many people forgot to click or highlight before applying fo rma tting. Word 6 helps you avoid this problem in the dialog boxes where you apply sectionbased for mats. The dialog boxes offer an Apply To menu where you indicate where Word
should apply the for matting.
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To see an Apply To menu, go to the File menu and choose Document Layout. Look at the
lower left of the Ma rgins card. Depending on v.•hat you select in the Apply To menu, Word
may insert section breaks for you, thus dividing the document wh ile applying the sectionbased format ting to the appropriate section only.

Deleting section breaks
To delete a section break, click directly beneath th e section break and then press Delete. After
you press Delete, the text that was above the section break takes on th e section formatting of
th e text that was below the break. (If you have troub le seeing a section break, switch to
Normal View.)

Templates
Every document you create is based on a template. The template teUs Word how you want to
start-what margins to use, which font, and so on. Most people, most of the time, don't need
to think much about templates. If you start a Word document and don't specifically select a
template for it, the document uses a template called Normal.
To base a new document on a template other than Normal, go to the File menu and choose
New. In the resu lting d ialog box, select the template that you want to use.
If you want to or need to know more about templates, keep reading. Otherwise, skip the rest
of this section and devote your brain cells to some other task, such as locating a snack.

A temp late has three main parts-examples, styles, and commands:

+

Examples are text o r graphics that appear in all documents based on th e template.
For example, a student can create a template for reports that contains the cover
page with text that he always uses, along with the correct margin, font, and page
number formats.

+

Styles are the styles that you want available in all documents based on the template. For example, in creating a report template, you can customize the built-in
heading styles so that you like the way your document looks after you set it up in
Outline View.

+

Commands are AutoText entries, macros, toolbars, drop-down menus, and keyboard shortcuts. For example, a hard-core Word user can add special keyboard
shortcuts, customized menus, AutoText entries, and a custom toolbar to a
template.
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Caution: If you think your Normal template is damaged in some way and

e
'

causing problems , you can test your theory by launching Word while
pressing the Shift key. By pressing the Shift key, you tell Word to ignore
the Norm al tem plate and use the built-in factory defaults, instead. The
next time you launch Word, if you don't press the Shift key, Word will use
the Norm al template.

Creating a new template

•

'

To create a new template, open a new document and then go to the File menu and choose
Save As. Along with giving the document a name, assign it the Document Template type (from
the Save File as Type menu), and save it in Word's Templates folder. Now that the document is
saved as a template, add examples, styles, and commands as needed.

+ Add the text, graphics, and so on that you want to appear in all documents based
on the template.

+ Change or create styles so that the styles in the tem plate match the way you want
the styles to work.

+

If you customize the toolbars, menus, or keyboard shortcuts in the Customize
dialog box, be sure to choose the name of the template from the Save Changes In
pop-up menu at the lower right. Similarly, when you create AutoText entries in the
AutoText dialog box, choose the template from the Make AutoText Entry Available
To pop-up menu. And, finally, if you create macros, be sure to store them in the
template.

To start a file based on your template, go to the File menu and choose New. If you saved the
template in the Templates folder, you should see it in the list of templates. Select the template
and click the OK button.
If you find yourself frequently using and setting up templates, be sure to check out the
Organizer d ialog box, which you open by choosing Templates from the File menu and then
clicking the Organizer button. With the Organizer dialog box, you can move macros, styles,
AutoText entries, and toolbars from templa te to template, between documents and templates,
and from document to document.

Attaching a template to an existing document (commands and styles)
If you already have a document started and realize that you want to access the styles and
commands in a different template, you can attach the template. Go to the File menu and
choose Templates. In the resulting Templates and Add-ins dialog box, click the Attach button
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and then open the template. If you turn on the Auto matically Update Document Styles check
box, the styles from the template come in and override styles currently in the document. For
example, the Normal style in the template overrides the Normal style in the document.

Attaching a template globally (commands only)
If you are working in Word and want the commands from a template available, you can attach
a template as a global template. To accomplish this, go to the File menu and choose Templates
and Add-ins. If a template that you want to use as a global template does not show in the list
of global templates, click the Add button and use the resu lting Open dialog box to open the
template.
To activa te a global template, turn o n its check box. After you finish activating global templates, click OK. The commands available in the template remain active until you quit Word.

Fields
Word loves fields. Fields are little blanks that Word gets to fill in. For example, when you insert
a page number, you insert a field, called PAGE. If the result of the PAGE field shows, you see a
page number, but if the code shows, you see something like IPAGEf. When you show the result
of a field, Word fills in the field with what Word thinks is the correct information. Sometimes,
though, Word is wrong about the correct way to fill in a field, and you must update the field
either by Control-clicking the field to display a shortcut menu o r by using the commands
shown in Table 3.4.
To make sure that all fields update before they print, go to the O ption s dialog box and use the
Print card to turn o n the Update Fields check box.
Use the View card in the Options dialog box to control the way that defa ult fields appear
o nscreen. To see results, clear the Field Codes check box. To see codes, check the Field Codes
check box. You can also change the selection in the Field Shading menu to control when fields
·
show with shading.
To lock a field so that it never updates again (unless you unlock it), select the field and then
press ~- 3. To unlock a field, select it and press ~- 4.
If you use fields frequently, you may want to memorize o r customize the commands shown in
Table 3.4. Chapter 9 explains how to make your own keyboard shortcuts and add commands
to menus and toolbars.
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Table 3.4
Field Commands for People Who Use Fields Frequently
Action

Command name

Default keyboard shortcl/1

Update selected field(s)

Upda teFields (in the All
Commands category)

F9 o r

Switch between showing a
selected fi eld's code and
result

ToggleField Display (in
th e All Commands category)

Shift-F9

Switch between showing
all codes and results

ViewFieldCodes (i n the
View category)

Option-F9

~-Optio n-Shift-U

Now that you have had a chance to get yourself accustomed to the general workings of Word 6
and its tools, you sho uld have visio ns of section breaks, shortcut men us, and status bars
dancing in your head. Un less you are feeling too d izzy to conti n ue, flip ahead to Chapter 4,
which explains how to get som ething done in Word, with a strong foc us on how to type and
how to edit.
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Whether you are new to computers, fairly comfortable with them, or a true computer wizard,
read this chapter to learn how to use many of Word's special typing and editing features . For
example, in addition to text, you can add numbers, bullets, and specia l characters to your
documents. After you write the text, you th en can make all sorts of changes to it. You'll find
o ut how to do many things in th is chapter, including the fo llowing points:
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· Adding Text
If you've used a word processor before, you know that to add text, you start typing. Text that
you type appears just left of the insertion point, a little vertical line. Text wraps when it
reaches th e end of a li ne, mea ning th at you don't have to press Return to start a new line;
Word starts a new line for you. When you reach the end of a paragraph, press Return to start
a n ew parag raph.
Caution: Don't use spaces to line up thi ngs . Fi nd out about using tabs or

•

ta bles instead (see Chapters 6 and 7, respective ly).

•
'

Numbers
Typing num bers from the row of numbers at the top of the keyboard works any time, but you
m ay have to turn o n Num Lock before you can use the numeric keypad. To tu rn on Num
Lock, press Shift-Clear-the Clear key is o n the n umeric keypad, just above the 7, and it's not
always clearly labeled. To turn off Num Lock, press Shift-Clear again.

Bu llets
Bullets are those dots that people use to emphasize points in a list. Bullets usually look like •,
although you can get fa ncy and use special characters, such as d iamonds, arrows, or hearts. To
type a bullet, press O ption-8.
If you use numbers or bullets to begin entries in a list, make Word do the numbering or bullets
automatically (see Chapter 6).

Quotation marks
The world of typography offers two m ain types of quotation marks-curly (also called smart)
quotes and pri mes (also called straigh t quotes o r hash marks). Curly quo tes look curved or
curled and are used to q uo te conversation and special terms. Primes look com pletely straigh t
or close to stra ight and are used to express units of m easurem ent (see Figure 4.1).

Sue said, "I want the the blue fabric." The shop kept the
blue fabric on the second level, about 13' off the ground.

Figure 4 .1

This quotation uses curly quotes to quote speech and primes to indicate a unit of
measurement.
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To type a curly quote, use the Prime/ Quote key to the right o f the Colo n/Sem icolo n key. By
defa ult, Word is set up to type curly q uotes, even tho ugh a prime appears on th e key. To turn
off the default, follow these steps:
1. From the Tools menu, choose AutoCorrect. The AutoCorrect dialog box appears.

2. Turn off the check box for Change 'Straight Quotes' to 'Smart Quotes.'

3. Click the O K butto n. With the Smart Quotes AutoCorrect feature off, you can type
a prime by pressing th e Prime key.
If you find yourself turn ing sm art quo tes o n and off, note that Word comes with a command
th at switches smart quo tes o n and off. You can make the command accessible through th e
Customize dialog box. To find the command in the Custo mi ze dialog box, select the All
Commands category and look fo r a command called ToolsAutoCorrectSmartQuotes.

If smart quotes are o n and you use the Replace command to search fo r primes and replace with
smart quotes, regard less of what the quotes look li ke in the Replace d ialog box, you get smart
quotes out of the Replace operation.

Hyphens an d dashes
Hyphens and dash es all look abo ut the sam e, but fro m a typographic perspective, each type of
dash and hyphen looks slightly different and serves a different purpose. Table 4.1 summarizes
different dashes and hyphens and shows how to create them.

Table 4.1
Hyphens and Dashes
Characrer

Ptupose

Examples

Hyphen

For compo und words
(such as fresh-baked) or
splitting a word over a
li ne break

fresh-baked
Hyphen
actio n-ready
high-resolution

Optional hyphen

Splits a wo rd over a li ne
break but shows o nl y if the
word happe ns to fall at the
end of a line and split

Use fora long
word (such as
in formation o r

ShorteLl/

~ - Hyphen

concentration),
where you want
to control how
the wo rd hyphena tes if it spli ts
over a line break
continues

75

Part II

Word 6

Table 4 .1 Continued
Character

Purpose

Examples

Shortcut

Nonbreaking hyphen

For a compound word so
that the word never splits
over a line break

Use for a long
word that you
always want on
the same line,
such as a phone
number

:):(-- (Tilde)

En dash

For ranges of numbers or
dates used in place of a
hyphen when half the
compound word is a
proper name

June 22-28
8:30-12:30
Monday-Friday

Option-Hyphen

Em dash

For abrupt breaks in
thought

Driving takes too
long-let's take a
plane instead.

Shift-OptionHyphen

Hyphens balance the appearance of text on a page. If the text is set ragged right so that the
exact end of each line of text varies slightly, the right edge of the text tends to have an uneven
appearance. By hyphenating the text, you allow some words to split between lines, resulting in
a more even appearance. In the case of justified text, where the right edge of each line ends in
exactly the same place, you may end up with awkward globs of white space between words or,
worse yet, with rivers of connected white globs pouring down the page. Hyphenating allows
more words to fit on a line, reduces globs of white space, and dries out those unattractive
rivers.
When it comes to making hyph ens, you can type them yourself or ask Word for hyphenation
assistance.
If you habitually type two hyphens for an em dash, use AutoCorrect to set up two hyphens as
a "mistake" and an em dash as the fix. Flip ahead a few pages to find out about AutoCorrect.
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Automatic hyphenation
To make Word insert o ptional hyphens at awkwa rd line breaks, fo llo w these steps:
l. Go to the Too ls menu and choose Hyphen atio n. The Hyp henatio n dialog box

o pens (see Figure 4.2).
Enter a hyphenation zone sizethink of it as the maximum distance
between the end of a ragged right
line and the right inden t.

Turn on this check box to have Word
hyphenate the document now and
to continue hyphenating as
you ed it the document.

Hyphenation

Indicate whether Word should hyphenate
words typed in all
ca pital letters.

Figure 4 .2

~A utomolicollv Hvph<ne te Document
'-@tlvphenete Word• 1n CAPS
Hyp hen~t1o n

Zone:

)0.25"

OK

(

Cancel

~~ MonuoL.

)No Limit I~

Limit Co n•ocutlve Hvphen• To:

I[
(

llel p

,

J

)
J

)

Clic k the Manual button to
app rove each proposed hyphen.
Enter how many lines in a
row can have hyphens.

Set up how you want to hyphenate.

2. Turn o n the Automatically Hyphenate Document check box.
3. Indicate whether you want to hyphenate words spelled with capital letters.
4. Enter a size fo r the hy phenatio n zone. For ragged right-ali gned text, a smaller zone
translates to less ragged text and more hyphens. For justified text, a smaller zone
gives fewer un sightl y w hite blotches between the words.
5. En ter a li mit for how ma ny consecutive lines can end with hyp hens.
6. Click the OK button.
Word inserts optional hyphens so that some words split from one line to th e next. Word also
continues to insert and remove hyphens. as you edit the document.
To remove hyphens fro m a pa ragraph or to exclude a paragraph from being hy phenated,
highlight the paragrap h and turn on the Don't Hyphenate check box in the Text Flow card of
the Paragraph dialog box .
If you want mo re control over the hyphens, you can click the Manual button in the Hyphenatio n dialog box to indicate exactly where each word should break.
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Miscellaneous special characters
Lots of people get stuck when it comes to typing a character that doesn't appear on the
keyboard. After you know what keyboard shortcuts to use, you can type lots of uncommon
characters, such as copyright symbols, accented characters, and mathematical symbols. For
example, the keyboard shortcut for the copyright symbol (©) is Option-G.
Each font offers slightly different characters, and which characters you can type depends on
which fonts you have installed on your Macintosh. To find out more about your fonts and
learn the keyboard shortcuts for special characters, you can use Word's Syp1bol command or
the Key Caps desk accessory that works with any Macintosh program.
If you are making a mathematical equation, consider using the Equation Editor that comes
with Word. Go to the Insert menu, choose Object, and then select Microsoft Equation 2.0.

The Symbol command works best for viewing characters in the font that you are currently
typing in or in a specialized font that doesn't contain normal alphabetic characters. To use
the command, follow these steps.
1. Drop down the Insert menu, choose Symbol, and select the Symbols card (see
Figure 4.3). For a quick reference to common special characters and keyboard
shortcuts, look on the Special Characters card in the Symbol dialog box.
Look on the Special Characters card for a quick
reference to common special characters.
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Figure 4 .3
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The Symbols card helps with inse rting uncommon characters.

2. Make sure that your font of choice shows in the Font menu. You can look at a
specialized font, such as Symbol, or you can look at an option called (normal text).
The (normal text) option shows the characters in the font and point size of the
characters currently surrounding the insertion point in your document. For
example, if the insertion point is in a paragraph formatted in Times 14-point,
(normal text) shows the characters available in Times 14-point.
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3. Click a particular character. The character enlarges so that you can see it easily; the
status bar displays t he ASCII character value; and the keyboard shortcut that you
press to type the character shows at the upper right of th e card. If you memorize
the keyboard shortcut, you can use it later to quickly type the character without
opening the Symbol dialog box.
4. If you want to insert the selected character, click the Insert button.
5. Click the Close button to exit the Symbol dialog box.
In the Symbol dialog box, if you choose anything except for (normal text) from the Fon t menu
and then insert a character from that fo nt, you' ll find that you can't change the character to a
different font. Microsoft added this feature so that the character stays correct, even if you
change the font of th e text surrounding it.

Using Key Caps
Key Caps is a desk accessory from Apple that lives in the Apple menu on most Macs.
By glancing at the keyboard displayed in Key Caps, you can view the characters available
in any installed font. To switch fonts, choose a different font from the Key Caps menu (it's
up on the menu bar). To find out how to type less common characters, watch the Key Caps
display while pressing Shift, Option, or Shift-Option (occasionally pressing the Control key
also reveals a special character or two). With Palatino chosen from the Key Caps menu, for
example, I learned that pressing Shift-Option-K results in an apple character.
When you click on characters shown in the Key Caps window or type on t he keyboard, t he
characters display in the text box rectangle at the top of the window. After the characters
show in that window, you can copy and paste to move them Into your document, or you can
memorize t he keyboard shortcut and use It later.
In Key Caps, when you press t he Option key, some keys display with thick edges. A thick
edge indicates t hat you can use the key In conjunction with the Option key to place a special mark above a character, such as the tilde (-) that goes above then in many Spanish
words. For example, to create an ri, follow these steps:
1. Press Option-N and release both keys. Nothing happens.
2. Type n. The

n appears with a tilde over it,

Similarly, to create an

n.

acharacter, try these steps:

1. Press Option-E and release both keys.
2. Type a. The

aappears with an accent above it.

Typically, these shortcuts work only to put special characters over vowels. The ii is an
exception, not the usual case.

79

Part II

Word 6

Nonprinting characters
If you press a key that doesn't insert characters but does move the insertion point (such as the
Return key), you may see a nonprinting character. Most nonprinting characters affect where
text appears, but they do not print. For example, if you press the Return key to move the insertion poi nt to the next line, you may see a paragraph mark, which indicates the end of the
paragraph.
Sometimes people confuse the Enter and Return keys. When I tell you to press Enter, it means
(as you might expect) that you press the key labeled Enter. Most keyboards have the Enter key
at the far right (on the numeric keypad). If you don't have a numeric keypad, hunt around for
the key. The Enter key on my PowerBook Duo 230 is just right of the Spacebar.
Table 4.2 shows commo n nonprinting characters.

Table 4.2
Nonprinting Characters
Symbol

~
~

Character name

What it does

Slrortcrtt

Paragraph mark

Ends a paragraph

Return o r Enter

Space mark

Acts as a space

Spaceba r

EJ

Tab mark

Creates blank space in a
line of text

Tab

~

Soft return mark

Moves text to the next line
without ending a paragraph

Shift-Return

@]

End-of-cell or
end-of-row mark

The last character in a table cell
No shortcut
or a mark to the right of a table row

Non printing characters never print, and you control whether they show onscreen through the
View card in the Options dialog box from the Tools menu (see Figure 4.4). To switch on all
non printing characters, use the Show/Hide button in the Standard toolbar. You can also assign
the switch to a keyboard shortcut; look fo r Show All under the All Commands category in the
Custo mi ze dialog box from the Tools menu.
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Use the View card to control how you see nonprinting characters onscreen.

Page breaks
When you fill a printed page wo rth of text, Word automatically inserts a soft page break. In
Normal View the page break looks like a dotted line. Page Layout View displays a document as
though it consists of white sh eets of paper on a gray desk, so you see about one-quarter inch of
gray "desk" in place of a page break. To insert your own page break (also called a hard page
break), press Shift-Enter. A hard break looks like a dotted line, punctuated in the middle with
th e~be l Page Break.
To delete a hard page break, highlight the page break (it's easier to find the page break in
Normal View). With the page break highlighted, press Delete. To delete an automatic page
break, you must fi~:,rure out wh y Word th inks the page break should be there and then change
your setup so that Word doesn't think the page break should belong.

Moving the Insertion Point in Text
The insertion point is a small vertical li ne, and text that you type always appears just left of
the insertion point. The most straightforward way of moving the insertion point is to click
where yo u wa nt it to go (you may need to scroll to the right place), but if you have a long
document, try one of these techniques to move around faster:

+
+

To move up, down, right, or left, press the appropriate arrow key.

+

To move to the end of a paragraph, press ~-Down Arrow; to move to the start of a
paragraph, press ~-Up Arrow.

To move to the next word, press ~-Righ t Arrow; to move back in a similar manner,
press ~-Le ft Arrow.
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Choose Go To from the Edit menu. The Go To dialog box appears, and you can
enter a page number for where you wan t to go. If you want to get fancier with the
dialog box, select an element from the list at the left. Follow the directions at the
right to move efficiently around, based on that element. To open the Go To dialog
box, press ):(-G, or double-click Page on the statu s bar (at the lower left).

Word has plenty more keyboard shortcuts for moving around, and to find them, you can hunt
around in the Keyboard card on the Customize dialog box from the Tools menu. In the All
Commands category, look for commands that start with Word, GoTo, Page, Para, and Char.
After you know a keyboard shortcut for moving the insertion point, you can combine that
shortcut with the Shift key to select text. For example, ):(-Right Arrow moves the insertion
point right one word, so Shift-):(-Right Arrow selects right one word.

Selecting Text
Word, like most Macintosh programs, usually wants you to select things before you change
them or do more with them. For example, to make some text bold, select the text and then
issue the Bold command (by clicking the Bold button, pressing ):(-B, or via the Font card in
the Font dialog box).
In most Macintosh programs, you drag the pointer over the text to select it, and the text
selects character by character as you drag. The text highlights as you drag over it, indicating
that you have selected it (see Figure 4.5).

""''~"d toxi-E Sue wants the blue fa6ric.

u no htghltght.
h as

--+

'''""d
text " "
hig hlight.

•

Figure 4.5 Selected text has highlighting behind it.

By default, Word is set up so that you select text character by ch aracter within one word, but
if you try to select more than one word, the selection goes word by word. If this feature gets
in your way, use the Edit card in the Options dialog box from the Tools menu to turn off
Automatic Word Selection.
Because selecting text by dragging over it is tedious for long selections, you can use a variety of
tricks to select text. Here are a few popular ones:

+
+

To select a word, double-click the word.
To select a sentence, :!=\':-click it.
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+
+

To select a paragraph, triple-click the pa ragraph.

+
+
+

To select forward, press Shift-Right Arrow repeatedly.

+
+

To select an en tire document, press ~-A.

+

To remove a selection, click an unselected spot in the document window.

To select a line, slide the pointer left of the li ne so that the pointer becomes an
u pper-right pointing arrow. Click once.
To select backward, press Shift-Left Arrow repeated ly.
To select a large block of text, click where you want the selection to begin. Scroll up
or dow n so that you can see where you want the selectio n to end. Shift-click where
you wa nt the selection to end.
Turn on Extend mode by do uble-clicking EXT on th e right side of the stahts bar.
Press an arrow key to extend a selection in that d irection. Keep pressing the key to
conti nue extend ing the selecti on . Turn off Extend mode by double-clicking EXT
aga in .

Deleting Text
To delete text in any Maci ntosh p rogram, includi ng Word, follow the three basic rules of
Macin tosh de leting:

+

Rule 1: Clicking to the right of text and t hen pressing the Delete key deletes the
text, character by character.

+

Rule 2: To delete larger amounts of text qu ickly, select the text and then press the
Delete key.

+

Rule 3: If you select text and then start typing, whatever you type replaces the
previously selected text.

Word takes advantage of a key on the extended keyboa rd called the Forward Delete key. An
extended keyboa rd has function keys (such as F2 and f9) as well as a bunch of keys that are
grouped together that include Help, End, and PageUp. The Forward Delete key is usually
directly under the Help key. It has a ''Del" label on it, and it also has an X in an arrow-like
object poi nting to the righ t. To forward delete, click to the left of w hat you want to delete
and then press the Forward Delete key.
Word extends these basic rules with two features of its own-Typing Replaces Selection and
Overtype Mode-which you turn on and off in the Ed it card of the Options dialog box from
the Tools menu.
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If you turn off Typing Replaces Selection, then Rules 2 and 3 of "Deleting Text" don't apply. If
you are unsteady with the mouse and new to the Macintosh , you might consider turning off
Typing Replaces Selection to avoid unpleasant deletion accidents. just remember to turn it
back on after you come up to speed!

With Overtype Mode on, text that you type replaces text to its right. You can quickly turn on
or off Overtype Mode by double-clicking OVR on the status bar.

Undo Typing or Formatting
Word enables you to remove changes that you've made to a document. To take back the most
recent ch ange, press ~-Z or use the Undo command on the Edit menu. If you need a more
complicated fix, use the Undo and Redo controls on the Standard toolba r (see Figure 4.6).
Click here to drop down a menu for
redoing changes that you undid.

Click to redo your
most recent change.
I

Click to undo yourmost recent chat1ge.

...,.1~ 1:"1
P631o

Two un do menu cho ices are
to be un done.

Cut -

Bordero ond Shadi"'J
lnsertToble
Tupi"'J " Ht I"

I

I

Undo 2 Actions

Figure 4 .6 The Undo menu box lets you choose exactly what you want to undo.

You can click the Undo and Redo buttons just once or repeatedly to take back or put back one
or many changes. To undo one or more changes, click the down-pointing triangle between the
Undo and Redo buttons. A menu pops down listing changes, and you can drag down over
recent changes to choose exactly how many you want to undo. If you undo more than you
intended, use the Redo button to fix things up.

Moving Text
Moving text can be as simple as dragging it about onscreen, or it can involve the slightly more
involved Cut, Copy, and Paste commands. If you need to collect and move noncontiguous bits
of text, use the spike. Keep reading to find out about each method.
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Drag and drop
To move text by dragging it, follow these steps (to copy text instead, press Option while you
drag):

1. Select th e tex t.
2. Posi tion the pointer over the text. Th e pointer should look like an arrow.
3. Press th e mouse button and wait a moment. The pointer should have a little
picture com.ing out of its tail, which l ooks like a dog-eared sheet of paper. If you
don' t see a picture coming out of the pointer, turn on Drag-and-Drop Text Editing
in the Edit card of the Options dialog box from the Tools menu.
4. Keep the mouse button down and drag the pointer about onscreen. You see a faint
dotted line coming from the point of the arrow. The line is where the text goes
after you release the mouse button. You can drag text within a document or across
the edge of the window into another Word document window.
5. When you have the pointer and its line in the right spot, release the mouse button .

Moving Your Formatting
If you drop or paste text into a second document, formatting may not move as you expect.
If the style applied to the dropped or pasted text exists in the second document, the text
formatting may change. For example, if the Normal style is Times 14-point in one document,
and you drop or paste Normal·styled text from that document into a second document where
the Normal style is Palatine 10-point, the text takes on the second document's Normal style
and ends up in Palatine 10-point.
On the other hand. if the dropped or pasted text has a style that doesn't exist in the second
document, the style copies into the second document and the formatting of the dropped or
pasted text does not change.

Cut, Copy, and Paste
The Cut, Copy, and Paste commands work for moving almost anything in a document,
including text. You ca n also use Cut, Copy, and Paste to transfer i tems between different
programs. Cut moves a selection; Copy duplica tes a selectio n.
To issue a Cut, Copy, or Paste command, choose i t from the Edit menu or click its buttons on
th e Standard toolba r (the Cut button has a scissors on it, and th e Copy and Paste buttons
appear to its right). i f you use Cut, Copy, and Paste frequently, you'll probably want to memorize their keyboard shortcuts, which show in th e Edit menu. In any event, here are th e steps
for Cut, Copy, and Paste:

85

Part II

Word 6

1. Select the text o r item you want to copy o r move.

2. Issue a Copy o r Cut command (Copy copies things; Cut moves them). The copied
or cut selectio n transfers to the Clipboard, which temporarily holds the selection so
that you ca n paste it so meplace else. To see the contents of the Clipboard, go to the
Window menu and choose Clipboard.
3. You can paste into the same document, into another Word document, or into a
document from some other program. Open the docum en t that you want to paste
into.
4. Position the insertion point where you want the selection to move and then issue
the Paste command.

Caution: The Clipboard holds only one selection at a t ime. For example, if

e
'

you copy a graphic of a banana, the banana graphic goes on the Clipboard. If you then copy a paragraph of text, the banana disappears from
the Clipboard and gets replaced by the paragraph of text. Also, note that
the content of the Clipboard exists only in RAM, so if you turn off or
re start the Macintosh, t he Clipboard content disappears.

Spiking

•

'

Spiking enables you to cut mo re than o ne selectio n from a document (or documents) and keep
the selections together in a location called a spike. At any time, you can insert the entire collection of spiked selections into a document. The selections come off the spike in the order that
you added them; tha t is, t he first selection o n the spi ke comes off first. For example, you m ay
have a list of office su pplies that your office manager distributes as a Word 6 document (see
Figure 4.7).
Ruo lloble Office Supplies
~

Available Office SuF£lies
Ball point pen (blue)
Ball point pen (red)
Bulletin board
Envelope (busine" size)
Marker (black)
Marker (red)
Paper clip pock

Pencil pack (~lar)
Pencil pack (co o"'d)
Phone
Rolodex
Stapler
Staple<l
Tape

·•m:o 1 ~1

Figure 4 . 7

~~

Thumbtack•
White board
White board era•or
White board marker
w'k
hitoout

,,,

~

t
;
~P.l

If you want to move only some list entries to a second document ...
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You can make a copy of the list and then m ove office supplies that you need from the copy to
the spike (see Figure 4.8).
Bell point pen (blad)
Disk mailer
Pencil pad (colored)
St•ples
Whlteboa.ni
White boa.ni eraser
White boa.ni marker peck

Figure 4.8

... add the list entries that you want to move to the spike ...

After adding all the entries to the spike, you can then insert the spike into a memo where you
request those supplies (see Figure 4.9).
:Ja

Memo Requesting Supplies
Please de!Jver the following office supplles to my desk. My office
number is 8124A

Iiiii

~

& 11 point pen (bl•ck)
Disk mailer
Pencil p•ck (colored)
St• ples
White board
White board eraser
White board marker peck

•m
Figure 4.9

:2

!;

!·'

~JJ•

"

:'"·'

..r

'~"

~I'll'

~

II

... and then insert the spike in the second document.

Adding to the spike
To add a selection to the spike, press :l=t-F3. If you don't have an F3 key, use the Keyboard card
in th e Customize dia log box to make a suitable keyboa rd sho rtcut. The command to customize
is under the All Commands category, and it is called Spike.

Inserting the spike
To insert the conten ts of the spike, follow these steps:
1. Positio n the insertion poin t where you want the contents to end up.

2. Type spike.
3. Press :l=t-Opti on-V.
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To insert the contents and empty the spike, position the insertion point, don't type anything,
and press :J:C-Shjft-F3 . If you do n't have an F3 key, use the Customize dialog box to set up an
alternative shortcut for the InsertSpike command. You'll find InsertSpike in the All Commands
category.
For another way to collect multiple selections in one holding spot, check out the Scrapbook, a
utility that usually lives in the Apple menu.

Deleting the spike
To delete the spike, go to the Edit menu and choose AutoText. When the AutoText dialog box
appears, select Spike from the list of AutoText entries. With Spike selected, click the Delete
button . Word regenerates the spike if you insert another selection on it.

Finding Text
To find text in a document, use the Find command, which looks fo r text based on spelling,
formatting, or a combination. Here are the steps:
1. From the Edit m enu, choose Find. The Find dialog box appears (see Figure 4.10).
-Ill

The search string
goes h ere.

Find

Find Whot:

_IEJ

Itronxendent

Choose All to have the
entire document
searched, including
headers and fo oters.
Click the No Formatting button to remove
all formats listed in the
Forma t area.

I """""'

All

1•1

• rtnd
No Formottl ng

II

It

I

f ornut : Font: Ht'tvetic», 8o1d

OMetohC.,.
181Find Whole word> On tv
0 U.e Pollern Molthln<)
0 Sounds like

J [ Formal

•

,J

I

[S pecial ....-

[
[
J

Click and drag
down to choose
formats.

Ftnd Ne>Ct

II

Cancel

J

Replooe._

l
l

llelp

If you specify
formattmg to search
for, it shows here.
Click and drag
down to search for
special opHons,
such as a tab
character or section
break.

Figure 4.10 In the Find dialog box, indicate the text and/or formatting that you want to find .

2. In the Find What box, type the text that you want to find. The text in the Find
What box is called a searcll string. To find something that you can't type, try one
of these techniques:

+

To find formatting, d rop down th e Format button menu and open the
appro priate dia log box for the form at that you want to search for. Figure
4.10 shows the Pind dialog box set up to find every instance of t-ranscendent
in Helvetica bold. If you want to find only formatting, regardless of which
text has the formatting, leave the Find What box blank.
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• To find a nonprinting d1aracter (such as a tab, page break, or paragraph
mark), choose it from the Special button menu. The character appears in
the Find What box as a code.
• To find a space, press the Spacebar. You don't get a code indicating space,
but if you watch closely, you'll see the insertion point move a tiny bit.
•

You can specify a character based on its ASCII value. For example, if you
are fixing up a file that came from a different word processor and now has
many little squares in it, you can search for the square. To find the ASCII
value of the square, switch out of the dialog box and select the square. With
the square selected, go to the Insert menu and choose Symbol. When the
Symbol dialog box comes up, look at the left side of the status bar-you
should see a character number. Memorize that number and then type it
into the Find What text box with a caret. So if the character number is 10,
type "10.

•

You can also paste text into the Find What box.

3. Set the Search menu. If you set it for Up or Down, Word searches up or down from
the insertion poin t but does not search in the header or footer. To search the complete document, set the Search menu to All.
4. Set the various check boxes appropriately:
•

Match Case finds text in which the capitalization exactly matches what you
typed in the Find What box.

•

Find Whole Word Only sets up the find so that you don't find the search
string in longer words. For example, to prevent Word from finding strawberry
when you search for berry, turn on Find Whole Words Only.

•

Use Pattern Matching is for a more complex search. Pattern Matching is
beyond the scope of this book.

• Sounds Like means Word tries to find text that sounds like the search string.
5. To find any version of your search string, regardless of the formatting, make certain
that no formats sh ow beneath your string. lf formats show and you don't want
them, click the No Formatting button.
· 6. After going through all this preparation, click the Find Next button. You can
continue clicking the Find Next button as Word continues finding your search
string in the document. Click the Cancel button when you finish.
To change the capitalization of a lot of text, use the Change Case command (in the Format
menu).
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Replacing Found Text
The Replace command helps you quickly change text and fo rmatting in a document. To use
the Replace command, follow these steps:
1. To replace only a po rtio n of a documen t, select that portion . To replace an item

throughout the entire document, don't select an y thi ng.
2. From the Edit menu, choose Replace. The Replace dialog box opens, o ffering you
areas for entering what you wa n t to fin d and what you wa nt to replace (see Figure 4. 11).
3. To find text o r replace with text, type the text in the appropriate box. (To fi nd out
about finding or replacing based on things you ca n't type, see step 2 in the "Finding Text" sectio n earli er in this chapter.) To access a recent find or replace string,
pop up the m enu at the fa r right of the Find What or Replace With text area (click
the little triangle).
4. To use the Special and Form at button menus to set up special characters o r fo rmatting, fi rst place the insertio n point in the Find What o r Replace With box and then
choose an optio n from the button m enu. To clear fo rmatting from an area, click in
the text box for that area and click the No Formatting button .
Type the text that
you want to find.

~Ill

Reploc e

Find Whet:

iEl

[Apple Haci ntooh

Type the text that
you wan t to replace
the fo und text with.

Replace With:

Choose where you
want to search.

tEl I

[Moe intosh

I

I

i
I

The label reads Replace
because the insertion poin t
is in the Replaced With box;
dick in the Find What box
to change the label to Find.

jAn

,..,..,

I
Reptece

II

f i nd Next

J

Ca ncel

J

Roptoco

)
)
)

( Reptoce All

rormtt : Bold

Seerch:

ll

Jl

For-m•t :l

OMetchC..e
0flod Wbolt Wor1ll 0111~
Ou.e Patter n Motchfl1!)
0 Sounds Li ke

l No formalti ot [ l format

[~

Chck the No
Forma tting button to
remove fo rmats from
the area ind icated by
the label.

l Spocfel

.,..j

I

I

Hel p

.,..

Chck and drag down
to choose forma ts for
t he area indicated by
the label.

Formats that you want
to find show here.

Formats t hat you wan t to
replace wit h show here.
Click and drag down to
insert special options,
such as pa ragraJ?h
marks or the Clipboa rd
contents.

Figure 4.11 Set up the Re place dialog box to s earch for one t hing and re place it with another.

5. Choose a search direction from the Search menu. Choose All to search th e entire
document, incl uding head ers and footers. If you choose Up o r Down, the search
moves fo rward or back from t he insertion point, but it does not look in headers o r
foo ters.
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6. Set the check boxes to match what you want to do:

+

With Match Case on, Word finds and replaces based on the exact capitalizatio n in the Find W hat and Replace With boxes. If you turn off Match Case,
Word finds tex t that matches the text in the Find What box, regard less of
capitalization, and Word replaces it so that the text retains its o riginal
capitalization.

+

Turn on Find W hole Words On ly to prevent Word from finding words that
con ta in the search string.

+

Turn o n Use Pat tern Matching to replace based o n a pattern. Pattern Matching is beyond the scope of this book.

+

Turn on Sounds Like to make Word try to find words that sound like the
search string.

7. To approve each replacement, click the Find Next button. Word finds the first
instance of the text and fo rmatting specified in th e Find ·what area. You can
respond in three ways:

+
+

To replace the found instance, click the Replace button.

+

To replace the found instance and all other instances in the docu ment, click
the Replace All button.

If you don' t want to replace the found instance, but you do want to move on
to the next instance, click the Find Next butto n.

8. If you want each replacement made au tomatica lly, click the Replace All button.

Correcting Your Mistakes
While you type, a feature called AutoCorrect waits for you to make mistakes. If you make a
mistake that AutoCorrect knows about, AutoCorrect automatically fixes it. For example, if you
start a new sentence with two capital letters instead of one, AutoCorrect m akes the second
letter lowercase. As another example, if you type recieve, Word substitutes the correctly spelled
receive. When you type a word that has a mistake, AutoCorrect corrects it after you finish
typ ing the complete word and any punctuation (or a Return o r Tab).
To find out exactly wh ich mistakes AutoCorrect corrects and to customize AutoCorrect, go to
the Tools menu and choose AutoCorrect. The AutoCorrect di alog box appears (see Figure 4.12) .
Caution: Word stores AutoCorrect entries in the Normal template. Be sure to

•

back up the template if you spend a lot of time customizing AutoCorrect.

'
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Rutocorrect
Use these check boxes to control how Au toCorrect
fixes punctuation.
Turn off R~l ac e Text as Yo u ·rype if vo u
d o n't want a n y
spelling mistakes
corrected.

~;···
.....
" -rt ......
Correct""""
TWo lllltlel
CAptleh

[
[
[

Cepltelfze rl rst Le tter of Sentei>Wl
Cepilelfze tlames of O.v>

OK
Cancel
ltelp

I
I
I

~.Replete Text .. Vou Type

Replece:
lec<ldently
odn
don;l
i

With: @ PluiR H.'lf.(
lecctdenten v
and

don"l

-

lncl

occurence
recieve

r

I nt lude

occurrence
receive

0

rvrtnuiV.IIl...,_(

Set up an AutoCorrect
entry by typing the
correctio n here.

I
I

-- ~
-- ----

II

Add

.J.

(

Delete

I

i"

After you enter a
mi stake and a correction for an AutoCorrect
entry, cli ck the Add
button.

Set up an AutoCorrect entry
by typing the mistake here.

Figure 4.12 AutoCorrect automatically fixes common typing mistakes.

Making an AutoCorrect entry
If you commonly make a particular spelling mistake, use the AutoCorrect dialog box to set up
an AutoCorrect entry. Here are th e steps:
1. In the Replace text box, type the mistake. The mistake must be 31 characters or
less.

2. In the With text box, type the correction, which can be 255 characters o r less. If
you highlight the correct text before opening the AutoCorrect dia log box, that text
automatica lly appea rs in the With text box.
3. Click the Add button .
4. Make sure that the Replace Text as You Type check box is on.
S. Click the OK button.
If you want the correction fo rmatted in a particu lar way, or if you want the correction to be a
graphic, follow these steps:

1. In you r document, select the correctly formatted tex t or graphic. The graphic must
be in the text layer (see Chapter 8).

2. Open the AutoCorrect dialog box by choosing AutoCorrect from the Tools menu .
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3. The selection should appear in the With text box, but don 't worry if it doesn't all
appear. Select the Formatted Text radio button.
4. Type a "mistake" in the Replace text box.
5. Click the Add button.
You can use AutoCorrect to insert commonly used phrases (such as I look foMard to your reply).
Make the phrase a fix and set up a short "mistake" to go with the phrase. If you set AutoCorrect
up in this way, you are using AutoCorrect much like AutoText o r its WordS equiva lent, the
Glossary. Table 4.3 later in this chapter compares AutoCorrect to AutoText.

Deleting an AutoCorrect entry
To delete an entry, select it from the list of entries and click the Delete button.

Turning off AutoCorrect
To turn off AutoCorrect, open the AutoCorrect dialog box. The first group of fo ur check boxes
controls punctuation; turn off these check boxes to disable them. Turn off the Replace Text as
You Type check box to d isable AutoCorrect's spelling features.

Using AutoText
AutoText stores longish chunks of text that you don't want to type repeatedly. For example, if
you always begin a business letter with one of three introductory paragraphs and end with one
of three possible closing paragraphs, you can make AutoText entries for them all and insert
them when needed.

When to use AutoText
If you have a good working knowledge of Word, you may wonder about the point of AutoText
because many features store bits of text. Historically speaking, AutoText is the Glossary that's
been around since Word 4 or probably even earlier. In earlier versions of Word, the Glossary
held dates and times. To insert dates and times now, use the Date and Time command on the
Insert menu.
New features-including templates, macros, and AutoCorrect-are squeezing AutoText out,
and in many cases, AutoText is not as useful as one of the newer features . Table 4.3 compares
the features.
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Table 4.3
Comparing Templates, Macros, AutoText, and AutoCorrect
Feawre

Pro

Con

Template

Templates store pretyped text and
formatti ng for an entire document.
A template works well for a letter you
a lways start and fin ish in exactly the
same way.

If you need to mix and match bits
of standard ized text, templates
aren't flexible enough to save you
any time.

AutoText

You can assign pretyped text to a
button or menu.

An AutoText entry can be quite
long. If you don't assign an entry
to a button or menu, it takes extra
effort to insert it.

AutoCorrect

AutoCorrect makes it easy to insert
pretyped text, making it an especially easy feature for beginners.

AutoCorrect entries are limited to
255 characters. You can't assign
an entry to a button or a menu.
Because you must memorize the
"mistake" that triggers AutoCorrect, it doesn't make sense to
use it for entries that you rarely use.

Macro

Macros offer tremendous versatility.
A macro can open a template, insert
pretyped text of most any length, and
can be assigned to a button, menu, or
keyboard shortcut.

Macros are not a great feature for
beginners due to the complex
nature of creating, naming, and
storing a macro. Macros may be
overkill for the simple action of
typi ng a paragraph or two.

Making an AutoText entry
To make an AutoText entry, follow these steps:
1. Type, format, and highlight whatever it is that you want to put in the entry.

2. Click the Insert AutoText button on the Standard toolbar or choose AutoText from
the Edit menu. The AutoText dialog box appears (see Figure 4.13).

94

Chapter 4

Typing and Editing

AutoTe HI
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Click the Add button
to add the entry.

:lclactfon

[l ha nk you again for your assistance.

I

Sincerely.

ln t ht documtnl , tvPf' tht AutoTt x1 N mt UM~ prtss Command tOptfon • Y.

Figure 4.13 To create an AutoText ent ry, enter a name and choose a template.

3. In the Na me box, type a name for the entry.
4. From the Make AutoText Entry Available To menu, select the template to which
you want to add the entry. 1f you choose All Documents (Normal), the entry adds
to the Normal template and you can access it at any time.
5. Click the Add button. Word creates an AutoText entry and closes the AutoText
dialog box.

Inserting an AutoText entry
To retrieve an AutoText entry, you can use several differen t techniques. Pick the technique
that makes sense for you.

You have memorized the entry name
Type the name of the entry and then click the AutoText button or press
inserts the entry in place of its name.

~ - O ption- V.

Word

You can't recall the entry name
If you can't remember the name of the entry, follow these steps to insert it:
1. Place the insertion poin t in the location where you want to insert the entry.

2. From the Edit menu, choose AutoText. The AutoText dialog box appears on screen .
3. In the AutoText dialog box, select the name of the entry that you want to insert.
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4. Select whether you want the entry inserted with fo rmatting. (In theory, Formatted
Text gives you fo rmatting; Plain Text does not.)

5. Click the Insert button. Word inserts the entry.

A better way over the long term
Use the Customize dia log box from the Tools menu to assign entries to keyboard shortcuts,
menus, o r buttons. In the Customize dia log box, look in the Auto Text catego ry (towa rd the
bottom of the list) to find your entries.
You can even create a toolbar consisting completely of AutoText entries. Chapter 9 explains
how to create a new toolbar. Figure 4.14 shows a toolbar, configured by using the Customize
dia log box to have buttons for a few AutoText entries.

Regular buttons.

Figure 4.14

Text buttons.

If you use AutoText a lot and have screen real est ate to spare, you can set up a
toolbar of AutoText entries.

You can also make a new menu to hold your entries, and you can assign keyboard shortcuts
to entries. A menu and keyboard shortcut combo enab les you to use the keyboard shortcuts
norma lly, but if you forget them, yo u can use the menu as a reminder. Find out more about
setting u p menus in Chapter 9.

Automatically Updating Dates
To insert the date and have the date constantly update as the days ro ll by, try these steps:
1. Go to the Insert m enu and choose Date and Time. Accordi ngly, the Date and Ti me
dialog box opens (see Figure 4. 15).
2. Select a date style.
3. Turn on the Insert as Field check box.
4. Click the OK butto n.
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:1 Dole and Tim~

Avtllhlble formeb:

Select a date style fr om th e list. -

If you wan t to be able to update the date automatica lly, turn o n
this check box.
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II
I
I
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Cancel
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1
1

0

~1 rmri 113 Fi eld

Figure 4 .15 You can insert dates as updating fields or as static text.

The date inserts as a field, so that after you insert the date, it m ay appea r as th e correct date,
or it may appear looking something like {TIME \ @II MMMM d, yyyy II}, which means that you
have field cod es showing. Whenever you update th e field, th e date automatically ad justs to
the current date. To toggle a field between its code and result, Co ntrol-click the field and
choose Toggle Field Codes from the resulting shortcut menu .

Making Word Type Information

About Your Document
Using a few of the fields that come with Word, you can make Word type informati on about a
d ocument, including the docum en t title, size, number of characte rs, and m ore. Here are t he
steps:
1. Position the inserti on point where you want the info rm ation to end up. To
position the insertion point in the head er or footer, C hoose Header and Footer
from the View menu. If necessary, click the Switch Betwee n Heade r and Footer
butto n to see the footer.

2. Go to the Inse rt menu and choose Field. The Field d ialog box appea rs, as shown
in Figure 4.16.
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Figure 4.16 Use the Document Information category to insert updating information about a
document.

3. From th e Categories list at the left, select Document Information. Word responds
by sh owing Docum ent In for mation fields in the Pield Na mes list· to th e ri ght.
4. Select a type of information from the Field Names list and click the OK button.
Th e in formation inse rts as a field, so if you see so mething like {FILENAME I*
MERGEFORMAT}, you have the fie ld code showing.

Finding Information About a Document
To find out the length of text in terms of characters, words, lines, and so on, follow th ese ste ps:
1. Highlight th e pa rt of a docume nt t hat you wan t to know about, or to find o ut
about the entire d ocume nt, d on't high light any thing.
2. r:rom t h e Tools menu, c hoose Word Count.
The Word Cou nt dial og box appears and displays various counts. If you have a lo ng document, the cou nts look fuzzy until Word finishes counting eve rything; the progress shows in
the status bar. Word Coun t n ever coun ts text in a header or footer.
To find out all sorts o f specialized information about a docum ent, use th e Customize dialog
box fro m th e Tools me nu to get at a command ca lled Docum e nt Statistics. Yo u can find
Docume nt Statistics in th e File ca tegory, and you can add it to a button, me nu, o r keyboard
shortcut. If you issue th e Docume nt Statistics comma nd, you discover the amount o f time
you've spent editing th e d ocu ment, the date you last p rinted, and so on.
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The Thesaurus
Use the Thesaurus as an online reference for identifying synonyms (words with similar
meanings) and an to n yms (words with opposite or somewhat opposite meanings).
To open the Thesaurus, go to the Tools menu and choose Thesaurus. The Thesaurus dialog box
appears (see Figure 4.17). If you selected text before opening the dia log box, the text appears at
the upper right.

Pop up the menu to go
back to a previously
looked-up word.

Thesaurus: English (US)
Looked Up:
llo•t

I

Select a meaning to see words related to that
meaning.

Fonfund (6dl.)
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t..ent

~

lnurt

J

loot Up

T

I

Cancel

I

l
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{}
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Click to look up the
meaning of the word in the
Replace with Synonym box.

j- f-- Click the Previous

l

button to go back to
the word most recently
looked up.

Cl ick a word to move it into the
Replace with Synonym box.

Figure 4.17 Use the Thesaurus to find synonyms and antonyms.

Click the Look Up button to find out m ore about the word in the box at the upper right. After
you click the Look Up button, the Thesaurus moves the word into the Looked Up menu and
shows possible meanings for the word. If you select a meaning, the Thesaurus shows words
related to that meaning. The Thesaurus may also offer Anto nyms or Related Words; if it does,
click those options to see their entries.
Double-click a word in the right-hand list to put it in the box at the upper right and then look
up meanings for it.
Click the Previous button to go back to the preceding word that you looked up, and use the
Looked Up menu to go back to any word you already looked up.

Proofing with the Spelling and
Grammar Checkers
Use the Spelling and Gramma r Checkers to double-check the spelling and grammar in you r
document. This section explains how to use the Spelling Checker but touches on ly lightly on
the Grammar Checker. The Grammar Checker consumes a tremendo us amount of disk space
(1.5 megabytes) and on the whole is far less useful than spending even a small amount of time
with a book about gra mmar, such as Strun k and Wh ite's Tl1e Eleme11ts of Style.
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Setting up the Spelling Checker
To get the most out of the Spelling Checker, take a few minutes to set it up. Typically, the
Spelling Checker compares all the words in the document to words listed in its main dictionary. If a word in the document doesn't match a word in the main dictio nary, the checker
alerts you to the problem.

Custom dictionaries
A custom dictionary supplements the main dictionary with unusual words that you use
frequently. Use the Spelling card in the Options dialog box fro m the Tools menus to set up
custom dictionaries. To activate or deactivate a dictionary, cl ick the check box to its left. You
can do any or all of the following:

+

Word comes with a dictionary called Custom Dictionary, which may show in the
list of custom dictionaries. To use this dictionary to store uncommon words that
you use freq uently, turn on the check box to its left.

+

To start a new custom dictionary, click the New button. The Save dialog box
appears. In the Save dialog box, name the diction ary, select a location, and click
the Save button.

+

To make Word aware of a custom dictionary that doesn't show in the list (such as
a custo m d ictionary from Word 5 or a user dictionary from Word 4), click the Add
button to display the Open dialog box. Locate the dictionary and click the Open
button.

+

To take a dictionary off the list (so that Word is no longer aware of it), highlight
the dictionary and click the Remove button.

Word lists a dictionary with its path (how to get to it from the main level of your hard drive).
The length of the path may make it impossible to see a dictionary's name. To see the name,
try highlighting a dictionary and then clicking the Edit button. After clicking the Edit button,
close the Options dialog box and then look at the name of the active window. The name of
the window is the name of the dictionary. Close the active window.

Miscellaneous preferences
The Spelling ca rd in the Options dialog box also offers a few check boxes that customize how
the Spelling Checker operates.
In the Suggest area, you may turn on Always Suggest to make Word offer alternatives to misspelled words. Turn on From Main Dictionary Only if you want those alternati ves to come only
from the main dictionary. If you do n't want the Spelling Checker to flag words in uppercase or
words that include numbers, turn on the appropriate check box in the Ignore area.
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Checking a second language
If you work with more than one language, consider purchasing a foreign language dictionary

that plugs into Word (of course, this works only for a language that has a Word 6 dictionary).
Unfortunately, foreign language dictionaries fro m earlier version s of Word do not work with
Word 6. To purchase a dictionary that contains words from a different language or from a
special profession, contact Alki Software at (206) 286-2600. Alki is the official distributor of
foreign language dictionaries.
If you have a foreign language dictionary, you can apply the corresponding language format to
text that you want to proof with that dictionary. To format text in a particular language, select
the text and choose Language from the Tools menu. In the Language dialog box, highlight a
different language and click the OK button (see Figure 4.18).

In the Options dialog box, you can assign a second language to a custom dictionary. Use the
Language menu at the bottom of the Spelling card.
Language

Select (no proofing) to
mark text to be ignored
permanently.

1

Select a language to mark text as belonging
to that language.

Mork Selectod Text As:
no procllnq)
Brozlllon Portuoue!e
Cotolon
Do ntoh
Dutch

~~f~~~ ~~·J;)rod)

~
.0.

~

[
[

OK
Cancel

Deroult_
Help

~l
l

Tht sptlltr .md othtr proofing tools .wtorNt'oll~ uu
dk tlonar ln of th~ u ltOlt d lanqu•g• ~ If • v•Oablt.

Figure 4.18 Use the Language dialog box to set how the Spelling Checker wil l check text.

Setting up text to be ignored permanently
If you type text in a document and want the Spelling Checker always to ignore it, no matter

what, apply the (no proofing) format. To apply the format, select th e text, go to the Tools
menu, and choose Language. In the Language dialog box, scroll to the top and select (no
proofing). Finally, click the OK button (see Figure 4.18).
If you apply (no proofing) frequently, consider setting it up as a character style (see Chapter 5).

Using the Spelling Checker
To use the Spelling Checker, try these steps:
1. To check a portion of a document, highlight that portion. Otherwise, don't

highlight anything.
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2. Click the Spelling button on the Standard toolbar or choose Spelling from the
Tools menu. The spelling check begins, and when the checker finds an error, the
Spelling dialog box appears onscreen . At the upper left of the dialog box, you
should see an error message, which is usually Not in Dictiona ry. The word that
brought on the error shows next to the error message (see Figure 4.19).

The incorrect word
shows here.
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Click the Change button to
change the current error to the
word in the Change To box.

Figure 4 .19 The Spelling dialog box offers assistance with spelli ng errors.

3. You can react to the error with a variety of responses:

+
+

To find the next error without changing anyth ing, click the Ignore button.

+

To add the "error" to a custom dictionary, choose the dictionary from the
Add Words To menu and then click the Add button.

+

To fix the error yourself, type a correction in the Change To box and click
the Change button. You can also click the Change All button to fix this and
all instances of the error at once.

+

If you commonly make the error, turn it into an AutoCorrect entry. First,
type or select the correction . Second, click the AutoCorrect button. (Flip back
several pages to find out more about AutoCorrect.)

+

To fix the error with one of the listed suggestions, double-click the suggestion. {If Word doesn' t automatically list suggestion s, click the Suggest
button.)

To skip this error and any others just like it, click the Ignore All button.
Ignore All continues to ignore the error until you quit Word. If you quit and
then launch Word again, Word forgets about ignoring the error.
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4. When you fini sh with the Spelling Checker, exit the dialog box by clicking the
Can cel button o r the close box. You can also press ~- W or ~-Peri od.

Setting up the Grammar Checker
Before running the Grammar Checker, it makes sense to personalize the Gramma r Checker so
that it checks for problems that you want to fix. Use the Gram mar card in the Options dia log
box from the Tools men u to personalize the Grammar Checker.

Using the Grammar Checker
The controls in the Grammar dialog box work m uch li ke those in the Spelli ng dia log box
(albeit more slowly). Here are the steps fo r using the Gra mmar Checker:
1. To check o nly a po rtion of a docu ment, select that portio n; to check an entire

document, don't select anything.
2. From the Tools menu, choose Gra mmar. The Gramma r dialog box appears
onscreen (see Figure 4.20).
Click in this box to ed it
the incorrect sentence.

Click the Ignore butto n
to ign ore the error.
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in th e current sentence
and check the next
sentrnce.

rt- Click
the Change button
to make the change.

Click the Ignore Rule button to
ignore the violated rule for the
rest of the grammar check.

Figure 4.20 Use the Grammar dialog box to find out what Word thinks of you r grammar.
3. The Gram mar Ch ecker works through the document and identifies possible problems. If the Grammar Checker finds a problem, yo u can respo nd in one of the
following ways:
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+

To ignore the problem but look for o th er problems in the same sentence,
click the Ignore button.

+

To igno re the problem and ski p to the next sentence, click the Next Sentence
b utton.

+

To fix the problem, edit the text in the Sentence area and then click the
C han ge butto n. The insertion point must be in the Sentence area when
you click the button.
Caution: You cannot type a curly quote in the Sentence area .

•+
'

•

i

If you like o ne of the suggested so lutions, select the suggestion and then
click the Change button to fix the problem . (If t he Change button is d im,
you must make the change yourself in the Sentence area.)

+

If Word uses a grammatical ru le that you don't want to follow, click Ignore
Ru le. Word ignores the rule fo r the rest of the grammar checking session.

+

If the Explain button is ava ilable, click it to see an explanation of the
problem.

+
+

To undo the last change, click Undo Last.
If you get tired o f using the Grammar Checker, click the Close button.

4. When Wo rd finishes proofing the document, a Readability Statistics window
appears. To find o ut what the statistics mea n, click the Help button.
5. To complete the grammar check, click the OK button.
Now that you know so met h ing about using Word for writing and ed iting, you are ready for
the next chapter, which explains how to set up docu men ts.
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In this chapter, I write about working behind the scenes in a document to set up everything
correctly. Don't try to learn all this stuff at once- you'll overload your brain and find yourself
wallowing in self-doubt. Refer to this info rmation when you need help or when you want to
expand your Word know-how. If you do learn everything here, you can check the following
items off your list:

Word 6

Setting Up a Page
xplains how to set up the look of document pages in a general way.
bout text, fonts, or paragraphs. Instead, you'll find help with setting up
numbers, and so on-formats that affect the overall look of a page.
lmple document (where each page is set up the same way as all the
thead and read about whatever it is that you want to do .
. ·ou think you'll want to set up different pages in different ways, be
aware that most of these formats apply by section. You may recall reading about sections at
the end of Chapter 3, but to be sure that you know enough about sections to understand
what's going on, here is a quick review:

+

To insert a section break, press :Fe-Enter or choose Break from the Insert menu. A
section break separates parts of a document so that you can apply different formats
(such as margins) to the different sections.

+

To apply a format to only one section, click in that section and then apply the
format.

+

To apply a format to more than one section, highlight at least part of each section
and then apply the format (to highlight an entire document, press :FC-A).

+

If you use section formatting frequently, you'll become accustomed to the Apply
To pop-up menus in many of the dialog boxes. You can also use the Apply To
menus to specify where the formatting applies. Depending on what you choose
in an Apply To menu, Word may even insert section breaks for you.

+

Toward the left side of the status bar, Word gives information about what section
the insertion point is in.

Margins
A margin makes more sense when you print a document than when you look at it onscreen.
On the printed page, the margin is the distance between the text and the edge of the page.
You can set the margin numerically or visually, whichever way works best for you.
To set different side margins for a small portion of text, consider changing the indents for that
text instead of changing the margin. To find out more, see Chapter 6.

Setting margins numerically
To enter numbers for the height and width of your margins, follow these steps:
1. Click in the section or select the sections that you want to format.
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2. From the File menu, choose Document Layout and make sure that the Margins
card shows at the front (see Figure 5.1). To switch quickly into the Document
Layout dialog box, double-click the gray part of a ruler.
Under most circumstances, set the top
and bottom margins for At Least.
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Figure 5 .1

You can set margins numerica lly in the Margins card of the Document Layout dialog box.

3. Enter the margin measurements in the appropriate boxes. As you think about what
measurements to enter, consider the following:

+

If you plan to print the document double-sided and then bind it, turn on
Mirror Margins and give the inside margin extra room for binding. The
inside margin fall s on th e left of odd-numbered pages and on the right of
even-numbered pages.

+

If you plan to print single-sided and to bind the document along the left
edge of each page, increase the left margin to accommodate the binding.
Or set a gutter measurement; Word adds the gutter to the left margin.

4. Make sure that the Apply To menu setting matches where you want to apply the
margins.
5. After you finish setting up the margins, click the OK button.
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Setting margins visually
To see the text move as you set the margins, you must be in Print Preview from the File menu
or Page Layout View from the View menu with the rulers showing. To show the rulers, choose
Ruler from th e View menu o r click the View Ruler butto n on the Print Preview toolbar.
Each ruler consists of a gray region representing the margin and a white region representing
the area between the margins. If you place the pointer d irectly over the boundary between the
two regions, the pointer changes shape and looks like a double-headed arrow (see Figure 5.2).
You may have to move th e pointer carefully within the boundary. area to make it change
shape properl y, but a little practice goes a long way. With th e double-headed arrow pointer,
drag the boundary. A dotted line extends from the pointer to help you see what you are doing.
To better see the various d imensions involved in setting the margixn, press Option while you
click the boundary.
Earlier versions of Word did not have a vertical ruler and, as a result, you could not change the
top and bottom margins by using a ruler.
The white region represents the
distance between the margins.
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Figure 5 .2

Drag the edge of the gray area to change the margins.

Orientation
Orientation controls how text shows up o n the printout. Most of the time, people prin t in the
Portrait o rientation, with the text flowing across the narrow portion of the paper. Occasionally, it make sense to rotate the tex t 90 degrees and print it in Landsca pe orientation across the
wide portion of the paper.
If you have trouble keeping track of Portrait and Landscape o ri entations, th in k about art.
Typically, portraits of people are tall and skinny because people tend to be much taller than
they are wide; th erefore, Portrait o rientation produces a page that is tall and skinny. O n the
o ther hand, landscape pain tings tend to be short and wide in o rder to fit in lots of scenery;
th erefore, Landscape o rientatio n produces a page that is short and wide to make mo re room
fo r extra lo ng lines of type.
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In this chapter, I write about worki ng behind the scenes in a document to set up everything
correctly. Don't try to learn all this stuff at once-you' ll overload your brain and find yourself
wallowing in self-doubt. Refer to this information when you need help or when you want to
expand your Word know-how. If you do learn everythi ng h ere, you can check the following
items off your list:
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Setting Up a Page
The information here explains how to set up the look of document pages in a general way.
You won't find much about text, fonts, or paragraphs. Instead, you' ll find help with setting up
margins, headers, page numbers, and so on-formats that affect the overall look of a page.
If you plan to make a simple document (where each page is set up the same way as all the
other pages), just skip ahead and read about whatever it is that you want to do.
On the other hand, if you think you'll want to set up different pages in different ways, be
aware that most of these formats apply by section. You may recall reading about sections at
the end of Chapter 3, but to be sure that you know enough about sections to understand
what's going on, here is a qu ick review:

+

To insert a section break, press ):(-Enter or choose Break from the Insert menu. A
section break separates parts of a document so that you can apply different formats
(such as margins) to the different sections.

+

To apply a format to only one section, click in that section and then apply the
format.

+

To apply a format to more than one section, highlight at least part of each section
and then apply the fo rma t (to highlight an entire document, press ):(-A).

+

If you use section formatting frequently, you'll become accustomed to the Apply
To pop-up menus in many of the dialog boxes. You can also use the Apply To
menus to specify where the formatting applies. Depending on what you choose
in an Apply To menu, Word may even insert section breaks for you.

+

Toward the left side of the status bar, Word gives information about what section
the insertion point is in.

Margins
A margin makes more sense when you print a document than when you look at it onscreen.
On the printed page, the margin is the distance between the text and the edge of the page.
You can set the margin n umerically or visually, whichever way works best for you.
To set different side margins for a small portion of text, consider changing the indents fo r that
text instead of changing the margin. To find out more, see Chapter 6.

Setting margins numerically
To enter numbers for the height and width of your margins, follow these steps:
1. Click in the section or select the sections that you want to format.
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2. From the File menu, choose Document Layout and make sure that the Margins
card shows at the front (see Figure 5. 1). To switch quickly into the Document
Layout d ialog box, double-click the gray part of a ruler.
Under most circumstances, set the top
and bottom margins for At Least.
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Figure 5.1 You can set margins numerically in the Margins card of t he Document Layout dialog box.

3. Enter the margin measurements in the appropriate boxes. As you think about what
measurements to enter, consider the following:

+

If you plan to print the document double-sided and then bind it, turn on
Mirror Margins and give the inside margi n extra room for binding. The
inside margin falls on the left of odd-numbered pages and on the right of
even-numbered pages.

+

If you plan to print single-sided and to bind the document along the left
edge of each page, increase the left margin to accommodate the binding.
Or set a gutter measurement; Word adds the gutter to the left margin.

4. Make sure that the Apply To menu setting matches where you want to apply the
margins.
S. After you finish setting up the margins, click the OK butto n .
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Setting margins visually
To see th e text move as you set th e margins, you must be in Print Preview from the File menu
o r Page Layout View from the View men u with the rulers showing. To show the rulers, choose
Ruler fro m the View menu o r click the View Ruler button o n the Print Preview toolbar.
Each ru ler consists of a gray region representing the margin and a white region representing
the area between the m argins. If you place the pointer directly over the boundary between the
two regions, the pointer changes shape and looks li ke a double-headed arrow (see Figure 5.2).
You may have to m ove the pointer carefull y within the boundary area to make it change
shape properly, but a little practice goes a long way. With the do uble-headed arrow poin ter,
drag the boundary. A dotted line extends from the pointer to help you see what you are doing.
To better see t he various dimensions involved in setting the margixn, press Option while you
click the boundary.
Earlier versio ns of Word did not have a vertical ruler and, as a result, you could not change the
top and bo tto m margins by usi ng a ruler.
The white region represents the
distance behveen the margins.
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Figure 5.2

Drag the edge of the gray area to change the margins.

Orientation
O rientatio n controls how text shows up on the printout. Most of the time, people print in the
Portrait orienta ti on, with the text flowi ng across the narrow portio n of the paper. Occasionally, it m ake sense to rotate the text 90 degrees and prin t it in La ndscape orientation across the
wide portion of the paper.
If you have trouble keeping track of Portrait and Landscape o rien tations, thi nk about art.
Typically, portraits of people are tall and skinny because people tend to be much taller than
they are wide; therefore, Portra it orientation produces a page that is tall and skinny. On the
other hand, landscape paintings tend to be sho rt and ~ id e in orde r to fit in lots of scenery;
therefore, La ndscape orientatio n prod uces a page that is sho rt and wide to make more room
fo r extra long lines of type.
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To change the orientation, follow these steps:
1. Click in the section or select the sections that you want to change. (In previous

versions of Word, you could not change the orientation for only a portion of th e
document.)
2. From the File menu, choose Page Setup to bring up the Page Setup dialog box for
your printer (each printer has a slightly different Page Setup dialog box). The Page
Setup dialog box appea rs onscreen (see Figure 5.3).
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Print...
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Set up the orientation in the Page Setup dialog box.

3. In the Page Setup dialog box, select an orientation.
4. Click the OK button.

Caution: If you have problems with Landscape pages switching to Portrait

•

when printed, turn on the Each Orientation in the Document check box in
the Print dialog box .

'

Vertical alignment

•

'

By default, text aligns to the top of a page, but you can also center text on a page or justify
it. If you center text, the spaces between the lines and paragraphs don't change, but the text
jumps to the center of the page. When you justify text, you increase the space between
paragraphs so that the paragraphs spread apart and take up a full page.
To change the vertical alignment, follow these steps:
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1. Click in a sectio n o r select the secti ons in which you want to apply t he alignment.

2. Go to t he File menu and choose Document Layout. W hen the Documen t Layout
dialog box appears, select the Layou t card .
3. In the Layout card, choose an alignment fro m the Verti cal Alig nment menu.
4. Click the OK b utton.
To see a justified or bo tto m alig nment, switch to Page Layout View fro m the View menu or
Print Preview from the File menu.

Headers and footers
Headers sit in the top margin and ho ld repeating text; footers sit in the botto m margi n and
ho ld repeating text. Each header and footer thro ughout a docu ment can be exactly t he same,
o r you ca n divide t he documen t in to secti o ns and have a dHferen t header and footer in each
sectio n . If you want to delve a little deeper, you can vary w hich header or foote r prints on
each page to an even greater d egree.
Here are the basic steps fo r maki ng a header or foote r:
1. To add the header o r foo ter to a particul ar sectio n onl y, click in that sectio n . To
add the header o r footer to mo re than o ne section, highlight the sections where
you want to add th e heade r or foo ter. To h ighligh t the enti re docum ent, press ~-A .

2. From the View menu, choose Header and Footer. In respo nse, the Header and
Foo ter too lbar appea rs, the document text grays ou t, and a header box appears at
the to p o f the page (see Figu re 5.4). If the d ocument has more t han o ne sectio n or
type of h eader, Wo rd labels the header. To view headers and foo ters q uickly while
you are in Page Layout View, do ubl e-click in the gray area that acts as a page brea k.
J3
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He.!der

,---------- ------ -- ------------ -------------------~-~
'
Header
:_----- - - -- -- --------- - ---- -- --- ---- - - ----------------- ~
area is
'
' ,
active.
jlrJ::IPI~.I
@
]!21JBII!!I1]

I

fEJ

!!JI

I r;

Swttch Bttwttn litadtr ~ Footer

1

tl

I
The regul ar text area
d ims, indica ling t hat it
is not active.

Figure 5.4

Place the pointer ove r a
button to see a TooiTip
about the button.

A number of changes occur after you choose Header and Footer from the View menu .
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3. If you want to see th e footer, switch to the footer by clicking the Switch Between
Header and Footer button. Yo u ca n switch back to the header by clicking the
button again.
4. If you want a page number, d ate, or time in the head er or footer, click the appropriate button on the Header and Footer too lbar. No te that the page number, date,
and time are fields. If you don' t wa nt a da te o r time to update, you ca n lock it, thus
preventing it fro m even t hi nking of upda ting. To lock a field, select it and press
)::C-3. To unlock a field, select it and press )::C-4.

5. Type the text that you want in the header o r footer. To center- or right-align text,
use the default tab sto ps at 3 and 6 inches. If you press Tab once, the insert ion
po int aligns under t he 3, and text that you type ce nters u nder the 3. If you press
Tab again, the insertion point moves u nder t he 6, and text that you type rightaligns from the 6 (see Figure 5.5).
6. After you finish, click the Close bu tton o n the Header and Footer toolbar to return
to the ma in part o f the docu ment.
The center tab stop centers text .
•Ill

I~
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Figure 5.5

right-aligns text. You
may have trouble
seeing the tab stop
because the righ t
indent marker gets
in the way.

Use the header's def ault tab stops to center- and right-align text.

Normally, headers and footers are o nly a few lines lo ng, and th ey sit happily in the m argins
with no special pro blems. If you type more than a few lines in a header or footer, however, it
will begin to impinge on yo ur document text. Yo u can handle this situation in several ways:

+

To m ove d ocument text down and make room for a header (or up to m ake room
for a footer), go to the File menu, choose Document Layout, and select the Margins
card. Using the Margins ca rd, choose At Least for the margin in question. (At Least
is the default.)
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+

To make document text overlap the header or footer text, use the Margins card to
set the relevant margin to Exactly. However, if you set the top margin to Exactly,
you can place a graphic or box in the header so that the graphic overlaps the text
or the box borders each page (see Chapter 8).

+

Consider moving th e header or footer closer to the edge of the page, as explained
in the next set of steps.

Changing the location of a header or footer
To move a header or footer up or down, try these steps:
1. Click in the section holding the header or footer that you want to move or-if the
header or footer spans more than one section-highlight at least a portion of each
section.

2. Go to the File menu, choose Document Layout, and bring up the Margins card.
3. In th e From Edge area, change the distance of the header from the top of the page
or the footer from the bottom of the page.
4. Click the OK button.

Caution: Many printers cannot print closer to the edge of a page than about

e

.5 inches. When printing a legal-size document, many printers can't get
closer than about .9 inches. Don't put your headers and footers so close
to the edge that they can't print! See Chapter 10 for more information.

e
'

'

To move text in the header or footer left or right, indent the text. You can find o ut about
indents in Chapter 6.

Different header and footer on the first page
If you don't wa nt the same header or footer on the first page of a document (or section), turn
on a first-page header and footer. A common use of a first-page header is to keep it blank so
that the first page appears to have no header. Here are the steps:
1. If your document has more than one section, click in the section where you want a
first-page header and foo ter.

2. Go to th e File menu, choose Document Layout, and select the Layout card.
3. In the Layout card, turn o n the Different First Page check box and click the OK
button.
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To put tex t into the first-page h eade r o r foo ter (or if you just wa nt to look at it), choose Header
and Footer from the View m enu . This time, the header shows up with a First Page Header label
(see Figure 5.6). If you don 't see the label you expected, click the Sh ow Previous or Sh ow Nex t
butto n o n th e Header a n d Footer toolbar.
If you have more than o ne section, Word labels
the header to which sectio n the header applies.

If you have a first-page header, Word
labels the header as a First Page 1-ieade r. J

I

~O~iiii~iiii~ii~P~h~llo~sio~ph~ilj~I~O~Iiiiiiiiiiiiiii~~
I

, .first POI,le Heeder - Section 1- ________ _______ _ _________ ______ __ --,

~

1-

,
''

'

'------------ -------- ---------------------------------- J

Figure 5.6

Word labels first-page headers.

Page numbers
If you read ea rlier parts of this c hapte r, it sho uld com e as n o surprise that page numbers go
by section, so if you insert a section break or two, you ca n switch the numbers o n a nd off by
section o r c hange what th ey look like by section. For example, a popular page nu mbering
approach is to use lowercase Roman num e rals for the in troductory section of a docum ent and
the n switch to regular Arabic nume rals fo r th e main part o f the d ocume nt. As lo ng as you
re member to slap in a secti o n break after the introductio n, you sho uldn' t have a n y proble m
switching the numbering.

Inserting page numbers
To insert page numbers, follow th ese steps:
1. If th e document h as more than o ne sectio n, click in the sectio n where you want
the page numbe rs to go. To pu t page numbers in more than o n e section, highlight
a t least a p o rtio n of each secti o n whe re you want the numbers.

2. From the Insert men u, choose Page Nu mbers. The Page Numbe rs dialog box
appears, a nd t h e Preview area shows wh ere Wo rd plans to insert the page numbers
(see Figure 5. 7).
3. Select a position. Notice that Wo rd puts th e number in th e header o r footer.
4. C hoose an alignm e nt.
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Choose a page number position.
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For mot _

[

llelp

l

I

Indicate whether you want the
page number to show on the fi rst
page of the document (or section).

Figure 5. 7

Choose the page
number alignment.

The Page Numbers dialog box assists you in inserting page numbers.

5. To print a page number on the first page of the document (or section) turn on
Show Num ber on First Page.
6. Click the OK button.
Word inserts a page number in the header or footer. The page number is a field, called Page. If
the number looks like jPAGEI, you have field codes showing (see Figure 5.8). Word frames the
Page field so that you can drag the frame about if you want to move it slightly, although to
change the alignment, it's better to go back into the Page Numbers dialog box.
To change the character formatting of a page number inserted through the Page Numbers
dialog box, change th e Page Number style. (See "How Styles Save Time and Hassle" later in th is
chapter.)
Crentlue Wrltlnll

r Heodor. -------- ----- ~}~!]-- --------- -- -----;
~-------------------------- ----------------~
~
•• t~
J.
.,.,,;!},. ...
7
The page number's field is fram ed. With field codes
showing, the page number's field does not look like a
number.

Figure 5 .8

A page number inserted through the Page Numbers dialog box is a framed field, and with
fie ld codes showing, it lool~s like this.
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Deleting a page number
To delete a page number, first open the header or foo ter by choosing Header and Footer from
the View menu. If the page number is in the footer, click the Switch Between Header and
Footer button at the left side of the Header and Footer toolbar. To delete the nu mber, select it
and press Delete. If the page number is framed, click the framed edge to select the frame and
then press Delete.
You may have to delete the number fro m more than one header or footer if you set up d iffe rent headers and footers for different secti o ns or if yo u have a first page header or footer. Use
the Show Next and Show Previous butto ns o n the Header and Footer toolbar to move around.

Changing the starting page number
The starting page number is the actual number that appears o n the first page of a document or
section. Most of the time, you wa nt the starti ng number to be 1, but you can change it to a
different number. Here are the steps:
1. If you are changing the number for a section , click in that section. If you are

changing the number for mu ltiple sections, select at least a portion of each section.
2. Go to the Insert menu and choose Page Numbers. The Page Numbers dialog box
appea rs.
3. Click the Format button. The Page Number f-ormat dialog box is displayed (see
Figure 5.9).
4. Type the starting page nu mber in the Start At tex t box and click the O K button.
Read step 5 befo re clicking anything else.
5. Be sure to click the Close button to close th e Page Numbers dialog box.
Choose a page numbering scheme· P~ge

Numbe r rorm111

Number Fo r mat:

If you have set up chapter
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catinclude the
chapter number
in the page
numberi ng
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I
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( period)
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To change the starting number for the
document (or sectio n), enter a number here.

Figure 5 .9

Use the Page Number Format dialog box to change the starting page number and the type
of page number.
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Changing the numbering scheme
The numbering scheme goes by secti on, and the steps for changing the scheme are much like
the steps for changing the startin g number. In the Page Number Format dialog box, select a
fo rmat from the Number Format menu.
To include the chapter number in the page n umberi ng scheme, you must set up chapter
numbers, as explain ed towa rd th e end of this chapter. With the chapter numbers set up, you
can turn on the Include Chapte r Nu mber check box. You must choose the heading style that
corresponds to your chapter ti tles, and you can also choose a separator. In Figure 5.9, th e pages
are set up to number as 1.1, 1.2, 1.3, and so on.

If you enter an Arabic numeral in the Start At box and then change the Number Fo rmat to
Roman numerals, Word changes th e Arabic numeral to its Roman numeral equiva lent.
When you finish setting up the numbering scheme, click the OK button. Click the Close
button to exit the Page Numbers d ialog box.

Eliminating the page number from the first page
The tech nique fo r removi ng the page number from the first page of a d ocument (o r section)
depends on how you o riginall y inserted the page number. To find out how you inserted th e
number, highlight it in the header or footer. If a frame appears (a thick-edged box with hatchmarks on the edge), then you put the page number in through the Page Numbers dialog box.
If a frame fails to appea r, you put the page number in via the Header and Footer toolbar (see
Figure 5.10).
A page num ber inserted from th e Header
and Footer toolbar has no frame.

A page number created through the
Page Numbers dialog box has a fram e.
Cre11t1u~
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Figure 5.10
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Although few people wi ll want to insert t wo page numbers in one header, this figure
shows both types of page numbers in the same header.

After you kn ow how you inserted th e page number, try the appropriate option:

+

If you used the Heade r and Footer toolbar to insert the page number, set up a firstpage header and footer and don't put a page number in the h eader and footer on
the first page. (Refer to th e "Different header and footer on the first page" section a
few pages back.)
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If you used the Page Numbers d ialog box to insert the page number, click in the
section with the first page tha t should not have a page number. To eliminate the
page num ber, go to the Insert menu and choose Page Numbers. In the Page
Numbers dia log box, turn off Show Number on First Page and click the OK button .

Inserting the total number of pages
To use a numbering sch eme where you indicate both the page number and the total number
of pages (so that your foo ter reads, for exam ple, page 22 of 45) use the NumPages field. To
insert the fi eld, follow these steps:
1. Click where you want the total number of pages to show. If you inserted th e page

number by using a button on the Header and Footer toolbar, click to the right of
the number. If you used the Page Number dialog box, you can't click to the right
of the number. The num ber consists of a framed field, and you n eed to look at the
field's code. If you can 't see the code, Control-click the page number to bring up
the shortcut menu and choose Toggle Field Codes. Click directly after the I and
inside the fra me border, as shown in Figure 5. 11.
DID>-

;;;J Cre atlue Writing

:· H..der. _____________ «'!'AcE'~---

:

____________ __ --,
:

~~~

Click here.

L------------------------ ------- -- -----------~

'l'

Figure 5.11

Position the insertion point by clicking j ust after the field but before the f rame border.

2. Type a space (wi th the Spacebar), the word of, and then type another space. It may
take Word several seconds to respond to your typing.
3. From the Insert menu, choose Field. The Field dialog box appears.
4. Under Categories, select Document In forma tion and then under Field Names,
select NumPages.
5. Click the OK button.
6. A NumPages field appears (see Figure 5.12). As needed, h ighlight any page number
fields, Control-click to bri ng up the shortcut menu, and choose Toggle Field Codes
to show the field resul ts.
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Figure 5 .12 After you insert the NumPages field, the page numbering setup should look like this (turn
off field codes to see the result).

How Styles Save Time and Hassle
A style holds a collection of formats that you can apply to text all at once. For example, in a
resume, you can format all your topic headings (such as Ed ucation, Experience, Special Skills,
and so o n) with a style that comes with Word called Heading 1. You can set up Headi ng 1 to
include bold, Times 14-point, and a bottom border (see Figure 5.13).
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Figure 5.13
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Each topic heading is formatted with Heading 1 ; in this example, Heading 1 includes
bold, Times 14-point, and a bottom border.

After setting up the topic h eadings with Heading 1, you can easily change the formatting of
the topic headings by simply changing the style. Changing a style takes much less time than
changing each topic heading individually. For exa mple, you can experiment by changing the
font or the border (see Figure 5.14).
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Figure 5.14 To see what the resume would look like with topic headings fo rmatted with Helvetica
14-point and a thicker border, change the Heading 1 style.

In a longer docu ment, it pays to use the bui lt-in head ing styles fo r topic headings and subheadings. The heading styles tie into Outline View to make reo rga nizing the document
super-easy (flip ahead a few pages to find out how), and they tie into the Table of Contents
com mand so th at you can m ake a table of contents with almost no effort w hatsoever. You
can also set up cross-references to topics formatted \·vi th h ead ing styles (see Chapter 7).
Another use fo r a style would be to format text with an in visible style that tells the Spelli ng
and Grammar Checkers to igno re the text permanently. r:or example, you may want the
Checkers to ig no re email addresses (such as to nya@tidbits.com). Because email addresses are
often formatted with a special font to make them stand out, the style would include th e No
Proofing character format and the special fo nt formatting. You may ru n into a similar situation with regular street addresses.
Styles may be saved in templates, so if you get fairly invo lved with styles, you can set up
different templates with different style sets. In this way, if you set up styles for the perfect
cover letter, you can make a cover letter template th at contains those styles, and whenever
you open a document based on that template, the styles will be instantly available. But wa it,
there's more! If you then decide to change th e cover letter template, you can retroactively
change cover letters that you have already m ade so th at they ta ke on the changes in the
template,

How Word th inks about styles
Styles come in two basic categories-character and paragraph. As th e names suggest, character
styles can apply to just o ne character or man y ch aracters. Pnmgmpii styl es can apply to just one
paragraph o r to gobs and gobs of paragraphs.

119

Part II

Word 6

As fa r as Word is concerned, every character always has n.vo styles applied: a paragraph style
and a character style. Most of the ti me, if you don't do anything special, the paragraph style is
Normal and the character style is Default Para graph Fon t.
If you change formatting directly by clicking a toolbar button (such as Bold) or choosing a
form at via the Fo rm at m enu (su ch as Font or Paragraph), Word considers tha t form atting
direct fo rmatting. Almost always, direct fo rmatting overrides style fo rmatting.

How to tell which style is applied
To find out wh ich paragraph style is applied, click in the paragraph of interest and look in the
Style box at the left side of the Formatting toolbar. Pa ragraph styles appear in bold; character
styles in plain text.
To print a list of styles in a doc ument, go to the File menu and ch oose Print. In the Print
dialog box, choose Styles from the Prin t men u. Finally, click the Print button .
Fo r a spiffy way of finding out mo re about the formatting, click the Help button on the
Standard toolbar and then click a character. A ca rtoon-style bubble appea rs that discusses
th e character's fo rm atting (see Figure 5.15). Press ;):(-Peri od to stop looking at the bubble.

Figure 5.15 The formatting bubble tells all about formatting applied to a character.

For a constant reminder regard ing paragraph styles, show th e styles onscreen in the left
margin. To set this up, use the View card in the Options dialog box to increase the Style Area
Width to about on e-half inch . Change the wid th to ze ro if you do n't wa nt to s.ee styles any
mo re.
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How Word applies styles for you
If you just sit back and give Word its head, Word does a lot of styli ng work fo r you. Word uses

buil t-in styles to fo rmat documen ts as you create them . For example, if you insert a page
number, the page number au tomatically gets the Page Num ber cha racter style. To see how this
works, look at Figu re 5.16 and co nsult Table 5.1.
Buil t-in styles are based on Norm al, so if you modify Normal, you get a cascading effec t
through your documen t of similarly mod ified styles.

Tab le 5.1
Common Built-In Styles
Style

What ir does

Caption

A paragraph style for labels an d caption text that
you create with t he Caption featu re.

Default Paragraph Font

By defau lt, applies to characters that have no
other character style.

Footer

Formats text typed in the footer (text at the
bo tto m o f the page in t he special footer area).

Footnote Reference

A character style fo r footnote reference n umbers
and marks.

Footnote Text

A character style for foot no te text.

Header

Fo rmats text typed in the header (text at the top
of t he page in the special header area).

Heading 1, Heading 2, ... Head ing 9

Applies automaticall y to levels in Outli ne View.
Usefu l for fo rmatting to pic headings in any
document.

Norma l

By defau lt, applies to parag raphs tha t have no
other paragraph format.

Page Number

Applies to page numbers tha t are the result of a
Page field, such as page numbers inserted through
the Page Numbe rs d ialog box o r the Page Numbers
bu tton on the Header and Fo oter toolbar.

TOC 1, TOC 2, ...TOC 9

Pa ragraph styles fo r levels in a table of contents.
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Header text
takes on
the Header
style.
This
docume nt
uses Heading
1 for main
topic titles.
This
docume nt
uses
Heading 2
for
subtopics.
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Desserts for Everyon-the Mill Creek PTA Recipe Book

Quick Cheese Cake
This recipe is greal for bri11gi11g lo pass-a..fiislr dinner.

Beat until s mooth:
8 ounce package of cream cheese (it helps to bring the cream chccsc to room tern·
perature fi rst).
14 ow 1ce can of condensed milk

Stir in:
.3 cups lemon ju ice
1 teaspoon van illa extract

Fill the sh ell:
Put the mixture in a g·· pic crust.

Chill:
Refrigerate for three hours or un til set.

The caption
takes on the
Caption style.

Garnis h:
Top with fresh frui t and cinnamon.

Heaven! Cookie Bars
M.Y /ruslm11d likes Ihis recipe, because lw ca11 mir and bake tire bars i11 rmrkr an hour.

Pre-heat the oven to 350'

Combine:
.75 c u ps brown sugar
r----------------------------------+--The footn ote
.75 cups white s ugar
I teaspoon apple brand y'
reference marks
2 sticks melted butter
get the Footnote

Standard text
paragraphs
have the
Normal style
(set for
Palatino 10).

Reference style.

Add:
2.25 cups flour
Pinch of salt
1.5 teaspoons baking soda
2 cups chocolate chips

Ba.ke:
Spoon the batter into a greased 9.5" by 6" baking pan (any pa n nbout that size works
fine).
Bake a t 350' for 25-30 minu tes or until golden brown.

.---+-- Footer text
Text in the
footnote has the
Footnote Text
style.

' If you don't have apple bran dy, substitute a different flavorin g, such as vMilla hn·
zclnut, or pepp~rmint.

Page l

takes on the
Footer style.

The page number
has the Page
Number style.

Figure 5.16 Word automatical ly formats common document elements (such as those shown here)
with built·in styles. Except for the page number and footnote reference mark, this
document has no character styles, so t ext uses the Default Paragraph Font style .
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How to apply styles yourself
To apply a paragraph style, either click in the paragraph or highlight any portion of it. To
apply a style to more than one paragraph at once, you must highlight at least a portion of each
paragrap h . To apply a character style, highlight each character to which you want to apply the
style. In ei ther case, after you click or highlight, you must indicate which style you want. Here
are a few techniques:
•

Select the style from the Style menu on the Formatting toolbar. To see additional
styles, press Shi ft while you drop the menu.

•

Go to the Format menu and choose Style. From the Styles list on the left side of the
Style dia log box, select a style and then click the Apply button. (Use the List menu
at the lower left to change what styles you can see.)

•

Use the Customize dialog box from the Tools menu to assign a style to a keyboard
shortcut, menu item, or button. (In the Categories list, scroll down to find Styles.)

•

You can automatically apply built-in heading styles by setting up your document
in Outline View (flip ahead a few pages to find out how).

Caution: Character and paragraph styles can have odd interactions when

•
'

applied to t he same text. The problem occurs if both styles include a
character format that toggles. such as bold. For example, if the character
style calls for bold , but the paragraph style does not, you get bold. But if
the character style and the paragraph style both call for bold , the bold
toggles off. In the case of nontoggling formats, such as a font or color,
t he character style overrides the paragraph style.

•

l

How to modify styles
You can change a paragraph style qu ickly, or you can go through an involved routine that
involves tunneling through several dialog boxes. The quick method lets you change a style
only for the current document; the involved method lets you ch ange the style for the current
document and for the document's template. The involved method also lets you see exactly
what you are doing and exert more control over the style.

The quick way to modify a style
To change a style quickly, follow these steps:
1. To change a paragraph style, highlight a paragraph that has the style you want to
change; to change a character style, highlight just one character that has that style.
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The style that you want to change should show in the Style menu on the Formatting toolbar.
2. Change the formats of the highlighted text so that they match how you want the
style to be set up.
3. Click once on the Style menu. The box highlights.
4. Press Return. The Reapply Style dialog box appears (see Figure 5.1 7).
5. Turn on the Redefine the Style Using the Selection as an Example radio button and
click the OK button.

ReDppl St le

The first option
changes the style.

Style: Norm•l
Do you .... nt to:
• Rodell no thuto.;lo uolnol ho selection eo on exo mple?
Roturn tho formottfn9 of tho solec~on to the •lyle?

~
~
llelp

The second option returns the
paragraph to Its former formatting.

Figure 5.17 Select the first option to change the style to match the text selected in the document.

The slow way to modify a style
The slow method of changing the formats in a style involves the Style dialog box. Here are the
steps to try:
1. From the Format menu, choose Style. The Style dialog box appears.

2. Select the style that you want to change from the list of styles at the left and click
the Modify button. The Modify Style dialog box appears (see Figure 5.18).
3. Select a Based On style. The Based On style supplies formats that you don't specify.
For example, if you don't specify the font for a character style, the character style
uses the font in the style that it is based on.
4. Indicate the style that follows a paragraph in the style undergoing changes. For
example, after typing a topic h eading in the Heading 1 style, if you press Return to
start a new paragraph, yo u probably want the new paragraph to have the Normal
style.
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The Style for Following Paragraph formats a new
paragraph in the style undergoing cha nges.
Modify Style

The style undergoing
changes.

I

tl<me:
Slqle l9Pfl.
Hr.:H,--ea7dtll9----:-t-------,IIPmi'"'P~
Stvta for Fo11wlll9 Por~roph:
l:":"jNo_r_m--;o!--- - - - - . : : 1..,.
"'1 Normol
Ba•ed On:

I I
..,.

~[;;;;;;;;;~O~K~~ll
'-(___;C
:.:•=.:
••..:..:
•t--'J

....+-

Prcvicv

l

Format .,...

Hel p
EdYcal ion
~
)o

;:;:.:::::
::
a' « •r<O"·l

+ -Drag down

[ Shortcut Keg_ J

"'·!:::::·~ ~·:::::: ~-: :~::~:.. :"'::.:::::::

"P••••

De:sc rt ption

Normal + F'ont : Hf'IVt tie.a. 14 pt~ Bold, SpiOt e t rort 12 pt. Kttp ..,.llh NtliCt'
Bordtr : l?ottorn(Sit'IC} It , 2 1/ 4 pl Urw \t'idth)

I

from the
Format
bullon

menu to
add or
rem ove
formats
from the
style.

EjJMd to Template

I

Turn on Add to Tem plate to add the changed style to the document's
templa te (usually th is makes the style available in futu re documents).

Figure 5.1.8

Use the Modify Style dialog box as the control center for changing a style's formats.

S. Drag down the Format button menu to access dialog boxes for additional formats.
If you modify a character style, a number of the options in the Format button
menu appear grayed out. The grayed out options are for paragraph styles only. If
you go into a dialog box and ma ke changes that you want to add to the style, click
the OK button to exit that dialog box.
Use Language to format text for a specific language or to format text so that the
spelling and grammar checker ignore it (No Proofing sets text up to be ignored).
6. Turn on t he Add to Template check box to add style modification to the template
on which the document is based. Style ch anges apply to the active document and
to new documents based on the template.

To make an old document retroactively take on the changes, open the old document. With the old document active, go to the f-ile menu and choose Templates.
Turn on the check box labeled Au tomaticall y Update Document Styles and click
the OK button.
7. To exit the Modify Style dialog box and keep the changes that you made to the
style, click the OK button.
8. Back in the Style dialog box, click the Close button.
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How to create a new style
Making a new style works in much the same way as modifying a style. You can make a new
style the quick way through the Style box on the Formatting toolbar, o r you can make a new
style the slow way through the Style dialog box. Unfortunately, the quick Style box method
does not work for character styles, so if you want to make a character style, you must use the
Style dialog box. The Style dialog box also lets you add a new style to a template and gives you
access to some of the m ore esoteric styling options (although Microsoft didn't manage to add
the styling gel and color treatment options).

The quick way to create a new style
To create a paragraph style quickly, follow these steps:
1. Format som e of the text in your document with the fo rmats that you want in the
paragraph style.

2. Highlight some of the forma tted text or place th e insertio n point within the
formatted text.
3. Click once o n the Style menu. The box highlights.
4. Type a nam e for the new style and press Return.
Word auto matically creates a new paragraph style with th e name that you typed in the Style
box.

The slow way to create a new style
The slow meth od wo rks a lmost exactly like the slow method for modifying a style, and you
can find detailed steps if you flip back a page or two. In brief, to create a new style, you open
the Style dialog box and click the New button. \No rd responds by opening a New Style dialog
box, and your missio n is to enter a n ame for the new style {in the Name text box) and choose
the formats for the new style.

How to delete and move styles
To delete a style from a document, go to the Format menu and choose Style. In the Style
dialog box, select the style that you wa nt to delete and then click the Delete button. The style
disappears from your documen t, and you never see it again unless the style is also saved in a
template.
To delete a style from a template, use the Styles card in the Organizer dialog box. Open the
Organizer dialog box by opening the Styles dialog box and then clicking the Organizer button.
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After you delete a style fro m a tem plate, the style no longer shows u p in new docu ments based
on the template. To delete a lot of styles, just select a bunch of them at o nce. To select a
noncontiguous list of styles, press :J:C wh ile you click them.
You ca n also use th e Organizer dialog box to move styles from one document to another
d ocum en t, between a docu ment and a template, or from o ne temp late to another temp late.

Making an Outline
Outlining o ffers a powerful and helpfu l way to set up documents. Here are just a few of the
tasks it helps wit h :
•

Organizing topics in a document

•

Creating a formal outline

•

Automatica ll y app lying built-i n heading styles to the topic headings as you set
them up-which helps wit h a number of tasks, such as generat ing a table of
contents

To switch into Outline View, choose Outline from the View menu, press ;):{;-Option-0, o r click
th e Outli ne button (one o f the buttons o n the left side o f the h orizon ta l scroll bar). Outli ne
View has a special toolba r (see Figure 5.19).
These buttons change the
level of a se lection.

This button
turns selected
topic headings
in to body text.

These buttons move a selection
up or down in the document.
These buttons expa nd and collapse
selected topic headings.
Click to switch into
Master Document View.

1

These bu ttons control how
many levels you can see.

Figure 5.1.9

Thi s button controls how
much body tex t shows.

The Outlining toolbar appears when you switch into Out line View.

How Outline View corresponds to other views
Outline View revolves arou nd levels of importance, with up to nine levels of importance for
people having in tricate ideas. Outline View indents levels of lesser impo rtance so tha t you can
easily see the relationshi ps. Figure 5.20 shows a document-in-progress that uses three levels of
heads and has body text.
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Quick and E a~.u Desserts

"Quick and Easy-1-o Quick and Easy Dcssons
Desserts" is a level
~ · ?"~,~
...~A-_,,,,."".""'"""""·
one topic
o ""' _,,• .,,. ,
•
• •~·u r•U.p dn•:'l'uhnttj•t lul,.loiri.nt:thea.M~

. ;~:;::=:-;,~~~t " .
o HeovenlvCooldo&rn
• ~j,.~~!";::£WnGf¥ilw''~Jn~,..vnnJJ~nu# w,

"Quick Cheese Cake"

and "Heavenly Cookie

Bars" are level
two topics.

:;
• .,..

~~~~·~~'-'••..:..••-'-'"'""
' '-'-";..;.0 ·-------!l.f-- "Combine" is a
• ·"""''''"":' ...'
level three topic.
1_, 111

Rgure 5 .20 Thi s outline has three levels.

Topic headings in each level automatically end up in a built-in heading style. Word conveniently has nine buil t-in heading styles so that each heading style maps to a topic heading
level. For example, a level two heading takes on the style called Heading 2. If you don't like
the looks of the heading styles, go ahead and change them. Flip back a few pages to find out
how.
If you don't work much in Outline View, but you format your headings with the heading

styles, when you switch into Outline View, paragrap hs formatted with a heading style become
topic headings in the outl ine. For example, if you write a report with eight main topics and
assign each topic heading the style called Heading 1, Outline View shows each topic heading
as a level one heading. Figure 5.21 shows the text from the preceding figure in Normal View.
Quiet a nd [Dill Oeuerh

II

Level o ne topics take on - -aulckandEasyDosscns
the Heading 1 sty le.
-

Quick Choom cru...
TAiir«.~!"'J~pNII.vlv!ipyt"JM.~-J,~;s-Nn.

Level two topics takeon the Heading 2 style.

""'"""'' moolh: -- - - - - - -----t-i-Level three topics
80UK~:~.t::rcb ...-(i l holpJ to\mc lll.tUMIIIChUMtO t~
take on the
"""'"""'''.......,."""'
Heading 3 style.

.
-

Hea....Jy Cooldo 8aJII
.,,

0
Iii

Rgure 5.21 The headi ng levels in t he outline correspond to the heading styles in the document.

If you need to make a table of contents based on topics formatted with h eading styles, Outli ne
View becomes even more useful. In just a few clicks, you can generate a table of contents based
on tex t formatted in heading styles. Figu re 5.22 shows the headings from the preceding figure,
fleshed out a bit and transformed into a table of contents. You can also make cross-references
to paragraphs formatted with heading styles (see Chapter 7).
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Reci pe Book

s'[;l~tt~!~~~-l;~~i~B~- -:~~:~=.~~
1 style.

.... ........... .... ...... ....... .. ......

2

Ht..-.niyCoolci. e.,, ..............................................................................................4

JoU. Solad ...............................................................................................................5
Gordon's Ama::.n~ Chocolatafu ............................. .. ,, .............. ,, ,,,,,,,,,.,.. ,, .. ,,,,,,,,,,,6

Rlubllb c,;,p .........................................................................................................7

f- Dessats f« KIds
c.,dySJ.prrrnes .......... ........................................... .. .................. ............................8

Text in the Heading 2 stvle- f-M.Utt. hi""'•" ......................................................................................................9
takes on the TOC 2 st};le.
... ....
... .. ..... ... . . .. ...
. . .... ... .. ....9
•ID II» ql[i

4-

~ID

Figure 5.22 The t able of contents was made after t he document was more complete, and it includes
two levels-paragraphs formatted with Heading 1 or Heading 2.

How to set up headings and body text
When you first enter text in Outline View, Word assigns it to a level one heading. If you want
the text to be a lower-level heading, click in it and then click the Demote button. To make a
heading into body text (text that is not a heading), click the Demote to Body Text button. To
promote a heading or body text to a higher level, place the insertion point within its text and
click the Promote butto n.
You can easily identi fy topic headings because they always have a plus or minus sign at their
left. A plus sign means the heading has subheadings or body text that goes with it. A minus
sign means the head ing has no subheadings or body text. Body text has a box instead of a plus
or minus sign.
If a heading has re lated sub headings or body text, you can select them all by clicking th e plus
sign. With the enti re topic selected, you can promote and demote the heading, and the entire
selection changes levels accordingly.

How to move headings around
Editing techniques that work in other views also work in Outline View, so you can use Cut,
Copy, and Paste as well as Drag an d Drop. To move a heading to a different location, select the
heading and drag it to a different spot. To move a heading alon g with its subheads and body
text, select the heading by clicking its plus sign.

How to view the outline selectively
To make text temporarily disappear and then reappear, try these tech niques:

+

To see one less level than you see now, click the Collapse button. Click the Expand
button to see one more level than you see now.
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+

To see headings of a certain level and higher, click the corresponding Show
Heading button (the buttons labeled 1 through 8). After clicking the button, you
won't be able to see body text. Click the All button to see all levels and body text.

+

To shrink a particular heading down so that you can't see its body text or subheadings, double-click its plus sign. Double-click its plus sign again to show the subheadings and body text again.

+

To show only the first line of all body text paragraphs, click the Show First Line
Only button. Click it again to show all body text paragraphs completely.

A gray line indicates that you have hidden some of the text that goes with that topic.

How to control outline formatting
The idea behind Outline View is that you are mostly interested in the text and how topics
relate to each other. To help you achieve this state, Outline View ignores paragraph formatting
assigned to the text. In add ition, you can personally control whether character formatting
(such as bold or underline) shows by clicking the Show Formatting button.
Levels in Outline View indent to the default tab stops; if the default tab stop is set for one
inch, each level indents one inch farther than the preceding level. To change the default tab
stop so that the levels indent to a different amount, follow these steps:
1. Switch to Normal or Page Layout View.

2. Press ~-A to select the entire docum en t.
3. Go to the Format menu and choose Tabs. The Tabs dialog box appears onscreen.
4. Enter a measurement in the Default Tab Stops box.
S. Click the OK button.

How to number an outline
To n umber headings, use the Heading Numbering feature, a complete no-brainer if everything
goes right and you don't need anything complicated . Here are the steps:
1. From the Format menu, choose Heading Numbering.

2. Double-dick the button (those big boxes are buttons) that shows the numbering
that you want. Word numbers your outline and continues numbering it appropriately as you edit the outline.
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To change th e numbering style, go back to t he Heading Numbering d ialo g box and d oubleclick a different butto n. Yo u can also click the Remove butto n in t he dialog box to remove all
the numbers.
To find o ut how to include chapter num bers in the numbering scheme, see "Setting Up
C hapter Numbering" later in this chapter.

How to print an outline
To print from Outline View, go to th e Pile menu and choo se Print, just as you would to print
from any other view. When Word pri nts from Outlin e View, it matches the onscreen o utline
in a few important wa ys:

+

Wo rd prints with a 6-inch wide expa nse fo r tex t (regardless of how you set the
marg ins).

+

Word prints only the headings and bod y text currently showing so that you can
expand th e entire outline and print it all, o r you can selectively expand and
collapse it so th at o nly certain parts print.

+

The plus, minus, and box signs in the left margin do n' t print.

Using a Master Document
Use a m aster document to join documents togeth er in o rd er to wo rk with them as a group. Each
document that you bring into a master document is ca lled a subdowment. Subdocuments exist
as independent fi les on your hard d isk, but you edit th em within the context of the master
document, either in the master docum ent's window o r in their own windows.
By combining subdocum ents into a master docum ent, you ca n make a table of contents o r
index fo r the entire group. You can crea te cross-references betwee n different documents in the
group, use the rind and Replace commands across all documents at o nce, and so on. Fo r
example, a book autho r can put each chapter in a separate fi le and th en join the files in a
master document.
You can create and edit a master document just as you would an y other d ocument, except that
if you look at the master d ocument in Master Docum ent View, you ca n add, organize, and
remove subdocum ents.
Caution: To avoid problems, never move or rename subdocuments unless

•

you do so through the master document. Remember to make frequent
and complete backups because the master document enables you to
make sweeping changes very quickly.

'
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Starting a master document
Before you can successfully start a master docu ment, you must be comfortable with Outline
View and the built-in heading styles; these directio ns assume that you understand how to use
them.
To start a m aster documen t, go to th e View menu an d choose Master Document. Word
switches to Outline View and displays the Master Document toolbar (see Figure 5.23).
You can lock subdocuments
so that other authors
cannot change them.

Use these buttons to move text in
and out of subdocuments.

~~~00

Use this button to turn
an existing document
into a subdocument.

'

Use these buttons to join and
separa te subdocuments.

Figure 5.23 Use the Master Document toolbar to set up a master document.

Each subdocument must begin with text formatted in the same heading style. You can create
subdocuments from scratch or by add ing an existing document (see Figure 5.24):

+

To convert text typed in the master document into a subdocument, select the text
and click the Crea te Subdocument button. W hen you save the master docum ent,
Word autom atically names any new subdocum ents and saves them in the location
holding the m aster document.

+

To turn an existin g docum ent into a subdocument, first make sure that the
document uses heading styles to organize its topics and that it begins with a
paragraph formatted in the appropriate head ing style. Second, in the master
document, create a blank paragrap h and positio n the inse rtion point in that
paragraph. Click the Insert Subdocument button. Word displays an Open dialog
box, where you can locate and open the existing document.

After you set up a master document with subdocuments, you can rea rrange the master
document in Outline View without paying any atten tio n to which text goes in which
subdocument. You can also switch in to any of the o ther views and work with the document
just as you would work with any other document. If you want to edit a subdocument in a
separate window, double-click the subdocument's icon in Master Document View.
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Body text is cu rrently
hidden, so the dim line
represents body text-in
th is case, the table of
contents.
The table of contents
is in the master
document; the "Quick
and Easy Desserts"
chapter is a
subdocument.

-

Recipe Book

I

0
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Thin gray lines box
the subdocument.

Quick and Easv Desserts
0

Qtgck O..eese Cake

0 Beet udil :.mP.Qi h•
0 Hea '"'lily Coolde Bo.n
0
PriHI <II! lho ......,,. 350"
0

I
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I
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0 Jcllo ~
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·~~~-~F I

The subdocument
has an icon.

Figure 5.24 To use a master document to manage the book about desserts shown in Figures 5.205.22, you can set up different subdocuments for each chapter.

Caution: Whenever you make any sort of change that you want to affect the

•

entire master document and its subdocuments, be sure to work in the
master document's window .

'

Organizing subdocuments

•

'

After you have set u p a master document, you ca n rearran ge the subdocuments in a va riety of
ways:

+

To move a copy of the text of a subdocumen t into the master docum ent, click
the subdocument's icon in Master Document View and then click the Remove
Subdocumen t button.

+

To free a subdocument from the master document, click the subdocument's icon
and press Delete. The document now exists only as an independent file.

+

To split a subdocument in to two subdocuments, select t he paragraph that you
wa nt the split to be above. Click the Split Subdocument butto n .

+

To change the n ame or disk location of a subd ocum ent, double-click the
document's icon to open t he document in a separate window. With t he separate
wi ndow act ive, go to the File menu and choose Save As. In the Save As d ialog box,
you ca n save the file with a different name and location .
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Caution: When working with master documents, watch out for three limitations: you cannot have more than 80 subdocuments; the size of the
master document subdocuments cannot exceed 32 megabytes; and you
must have enough extra disk space to back up the master document and
subdocuments regularly. You need to be able to revert to any of t he lastsaved versions, just in case something goes wrong.

Setting Up Chapter Numbering

•

'

If you set up chapter numbering, you can include the chapter number in page numbers, list
numbering schemes, and caption numbers. Word can also automatically number chapter titles
and chapter subheads.
Chapter numbering works with the built-in heading styles, so you must format each chapter
title with a specific heading style, such as Heading 1 or Heading 2. If you want to number
subheads, you must also format them with appropriate heading styles.
To turn on chapter numbering, follow these steps:
1. From the Form at menu, choose Heading Numbering. The Heading Numbering
dialog box appears.

2. The Heading Numbering dialog box offers six possible numbering options. For
example, the upper-left option numbers each Heading 1 paragraph with an
uppercase Roman numeral, each Heading 2 paragraph with an uppercase letter,
and each Heading 3 paragraph with an Arabic numeral. In contrast, the lower-left
option adds "Chapter One" to the beginning of all Heading 1 paragraphs. If one of
the six numbering options looks like what you want, select the option, click the
OK button, and skip the rest of these steps. If none of the options looks righ t, click
the Modify button.
3. The Modify Heading Numbering dialog box enables you to customize how Word
numbers each level (see Figure 5.25). To customize a level, first display the level in
the scrolling list at the right. After displaying the level, consider the following:

+

Use the Number Format options to set exactly how Word numbers a level.
r:igure 5.25 shows level one entries set up to begin with the text "Chapter
On e," "Chapter Two," "Chapter Three," and so on.

+

Click the Font button to select character formatting for th e number as well
as the text befo re and after.

+

If you don't want a level's numbering to begin at 1, enter a different
number in the Start At box. Note that you can set the numbering for each
section back to the Start At number by turn ing on the Restart Numbering at
Each New Section check box.
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Change the alignment of the nu mber with respect to each other.

•

To create a hanging indent, turn on the Hanging Indent check box. A
hnnging indent occurs when the first line in a paragraph begins left of the
rest of the paragraph.

4. Click the OK bu tton after you finish customizing the heading numbering.
Don't worry if the Preview at the lower right of the dialog box doesn't reflect reality. It's not
something that you d id- it's a problem with Word.
Type text that shou ld appear
right of the number.

Choose a numberi ng
scheme

I

Modify Hea lng Numbering

Type text that shoufd appear left
of the number.
Enter a starting nu mber.

Indicate whether you want a
hangmg indent.
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Agure 5.25 Customize chapter numbering by selecting a level and then selecting options for the
level.

If you mastered all the information in this chapter, consider you rself an official Word wizard.
If you just browsed in this chapter to find useful tips and tricks, consider yourself a normal
Wo rd user. Either way, get ready fo r the next chapter, which discusses how to make some
interesting changes in the look of the words in your document.
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Formatting Your
Words and Paragraphs
Word documents are filled with words·and paragraphs, and if you don't format them in a
creative way, your documen ts may look dull, drab, and downright unattractive. To liven up a
document, consider applying an interesting format or two. The information in this chapter
explains how to apply basic ch aracter and paragraph formats and how to create special effects.
Here's what's covered:
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Character Formatting Basics
Character formats (such as bold and blue) can apply to one character at a time or to many
characters at once. Here is a Jist of tips and techniques to add to your personal forma tting
repertoire:

+

To format text, highlight the text and use a toolbar button, keyboard shortcut, or
the Font dialog box to apply the format.

+

If you apply a format with nothing highlighted and then type without moving the
insertion point, the text that you type has the applied format.

+

To copy formatting from one area to another, highlight text that has the formatting. With the text highlighted, click the Format Painter button on the Standard
toolbar. Highlight the text to which you want to copy the formatting and watch
the formats from the first selection "paint" onto the second selection. (To paint
the copied format more than once, double-click the Format Painter button. You
can then paint formatting over and over again. Click the button again to turn off
format painting.)

+

Click the Help button on the Standard toolbar and then click a character to see a
formatting bubble, which tells exactly what formats are applied. Press :J:C-Period to
dismiss the bubble.

+

If you consistently apply the same formatting, consider setting up a character style
(see Chapter 5).

Removing formatting
Remove formatting by turning it off. For example, if you made text bold by clicking the Bold
button on the Formatting toolbar, you can remove the formatting by selecting the text and
clicking the Bold button again. You can also press :J:C-B to toggle Bold off, or you can go to the
Format menu, choose Font, and (on the Font card) select a different font style.
To remove all directly applied character formatting (not applied through a character style),
highlight the text and press :J:C-Spacebar to issue th e ResetChar command.

The Formatting tool bar
The Formatting toolbar has buttons for bold, italic, and underline. CHcking the buttons turns
the fo rmats on and off. The tool bar also has pop-up menus for style, font, and point size. To
choose an option from a toolbar men u, click once in the menu box to highlight the box. Then
type the option that you want to use and press Return. This technique works especially well
for changing the font size, and you can type in sizes that don't show in the menu.
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You can make a toolbar button fo r an y character format. Use the Too lbars card in the Customize dialog box fro m th e Tools m enu.
The Font pop-up menu has two lists. The top list shows rece n tly used fonts (th ey are at the top
so that you can choose them quickly). The bottom list shows an alphabetical list of all fo nts
insta lled (see Figure 6. 1).

Recently used
fo nts show at
the top.
The rest of thefon ts show at
the bottom.

Chicooo
Geneva
Helveltco
Monec:o
Pelelt no
Sym bol
Times

Figure 6 .1 The Font menu on t he Formatting toolbar has two lists.

The Style pop-up menu does n o t show all available styles. To see them all, press Shift as you
po p up the menu. Character styles show in plain tex t; pa ragraph styles show in bo ld.

Keyboard shortcuts
Many fo rmats come with predefined keyboard sho rtcu ts, and Ta ble 6. 1 sho ws the most common shortcuts. You can also use the Keyboa rd ca rd in the C usto mize dial og box fro m the
Tools menu to reassign a keyboard shortcu t.

Table 6.1
Character Formatting Keyboard Shortcuts
Command

Shortcut

Bo ld on/off

;}:(-B

Hidden Text o n /o ff

;}:(-S hift-H

Italic on/off

:J:(-1

Point Size down o ne po int

;):(- [

Point Size up o ne point

:J:(-1

Re move all character fo rmats

;):(-Spacebar

Small Caps o n/off

:J:(-Shift-K
continues
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Table 6.1 Continued
Command

Shorrcut

Subscript on/off

~-=

Superscript o n /off

;}:(-Shift-=

Switch to Symbol fo nt for th e n ex t typed ch a racter

;}:C-Shift-Q

Unde rline o n/off

;}:C-U

Font dialog box
Th e Font dia log box o ffers o ne-sto p sh opping fo r ch aracte r forma ts, with a complete selectio n
in only two cards. To ope n the di alog box, go to t he rorm at me nu a nd c hoose Fo nt.
Each ca rd in the Font dialog box has a Defa ul t bu tton, a nd clicking this button ma kes the
fo rma tting setup o n tha t card a defau lt fo r the c urrent template. In most cases, the active template is the Normal templa te. If the active te m pla te is the Normal templa te, the change will
a utomatically show up in new docume nts.
To ma ke the cha n ge affect a n o ld docume nt (as lo n g as the o ld document is based on the
Norm al te mplate), open th e o ld docum ent, go to th e f.il e menu, and choose Templates. In
the Te mplates dialog box, turn o n Auto matically Update Document Styles and click the O K
butto n. This technique wo rks fo r a ny templa te-if you ch a nge the style in a template called
My Mo nthly Repo rts, fo r examp le, you ca n open a n o ld re po rt a nd retroactively import style
c ha nges in th e te mplate.
So if Normal is the active templa te and you wa nt to ma ke Times 14-poin t the defaul t fo r text
tha t you typ e in the current document and in new docume n ts, select Times 14-point and then
click the Default bu tto n (see Figure 6.2). After you click the Default butto n, Wo rd tells you
what the active template is a nd asks wh eth er you wa n t to save the change.
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Font
f ont

font:
]Tim..
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font St ~le:
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Effects
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O s uperoc rlpt
0 Suboc rlpt
0 Shedo"

Size:
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Color:
Auto
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00ut1 1ne

[~

~

II
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[
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l)
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llelp

H
Times

~I

The Font card is
currently active. Click
the Character Spacing
tab to activate the
Ch aracter Spacing card.

1

To make Times
14-point the default,
select Times 14-point
and then click the
Default bu tton.

Rgure 6 .2 You ca n set up default font formatting in the Font dialog box.

How to Change Case
The Change Case command switches text between upper- and lowercase. Change Case doesn't
format text; instead, it changes the characters. To use the Ch ange Case command, select the
text that you want to change, go to the Format menu, and choose Change Case. Word displays
the Change Case dialog box (see Figure 6.3). In the Change Case dialog box, select an option
and click the OK button.
Caution: Title Case capitalizes the first letter in every word, so if you want a

•

proper title, make sure that you go back and lowercase the first letter in
such words as in, the, and at.

'

CMn e Coso
@Sentence co>e.
Q to.... rcose
Q UPPERCASE
0 T•IIeCe3e
QtOGGLE cASE

•

'

llolp

Rgure 6.3 Select a case option.

In contrast to the Change Case comma nd, the Font card (in the Fo nt di alog box) offers check
boxes for All Caps and Small Caps. All Caps and Sma ll Caps do not change the case of characters but, instead, change the appearance of the characters. All Caps makes letters look like
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uppercase letters; Small Caps makes letters look capitalized and increases the size of the letters
that are truly uppercase (see Figure 6.4).

Regular 18-point--

type.

Special Events
SPECIAL EvENTS - - - t - - The same IS-point

The same 1~-point type,- r-formatted wtth All Caps.

SPECIAL EVENTS

type, form atted with
Small Caps.

Figure 6 .4 All Caps and Small Caps change the appearance of text.

Special Effects
If you want to format type in a special way, you may need special know-how about how a
feature works or about how to combine several seemingly unrelated features.

Hidden text
You should format text as hidden if you want the text to be in the document only occasionally. For example, if you prepare a handout for a presentation, you can add speaking notes
to the handout but format the notes in hidden text. When you print the hando uts for the
audience, you can print with hidden text not showing, but when you print your own copy,
you can print with hidden text showing so that the speaking notes are interspersed throughout the handout.
If hidden text appears in a document, it appears with a dotted line beneath it (see Figure 6.5),
but if hidden text prints, it prints normally without the dotted line.
(1lil
t-

Moy 20 Presentation

W.!).J~.9m~

The dotted - [1- w.~!~!?m~.P.~P.!.~ .!!?..IJ!~J~~!!l]d!Y..!~..~!.~,~.•.~.!!!I.m.~.!\~.!'!Y.!!.~.9.f).t ~E!:
lines indicate
that the text is
Overview
hidden.
Thl• letture I!lview• our flnond al reGU!to for the put year. and gives the
Fln•nco Commltteo•s recommendations forfului!I directions &.nd growth.
~~.\!.~.IJ!I.~.t~1.\4.;?,
•mn~

Figure 6.5

~

!-=~

1":'

17

¢~

Hidden text appears onscreen with a dotted line beneath it.
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To format a selection as hidden text, either press ~ -S hi ft-H or turn on the Hidden check box
on the Font card (in the Font dialog box). To remove the Hidden format, reverse the process
by selecting the text and then pressing ~-Sh i ft-H, or by turning off the Hidden check box.
To control whether you see h idden text onscreen, use the View card in the Options dialog box
from the Tools menu. The Nonprin ting Characters area has a check box fo r hidden text. You
can also use the Options dialog box to control wh ether hidden text prints, but the check box
is on the Print card. Of course, if you show hidden text onscreen but do not print hidden text,
page breaks that show onscreen in Normal and Page Layout View may not be in the same
place in Print Preview or when you print.
Caution: If you use the hidden format, pay attention to hard page breaks that

·,

you insert. It 's easy to format them accidentally as hidden text .

•
'

Character spacing and kerning
If you want to move characters horizo ntally so that they end up closer together or farther
apart, use either the Character Spacing card in the Font dialog box or the Tracking option in
WordArt (flip ahead a few pages to find out about WordArt). For example, in the word Word,
if you use a large type size, the Wand the o may have an ungainly amount of space between
them. Word would look better with the o slightly closer to the W.
Character spacing works for any font, and it adjusts the spadng in a uniform way.
Kerning works for proportional fonts, fo n ts where some letters (such as an i) are skinnier than
oth ers (such as a w). Use kerning to make a consistent amount of whi te space between characters, particularly between characters in large point sizes. Wh y bother? Because uneven blobs of
wh ite space between characters create an unbalanced feeling an d distract people fro m reading
your message.
Caution: Word enables you to turn on kerning for text that is more than a

•

certain point size, but yo u don't get to decide how to kern individual
character pairs. If you want to decide how t he text is kerned, try working
in WordArt or consider using a different program.

•

l

'

Drop cap
A drop cap can introd uce a new topic and add visual interest to an otherwise boring stretch
of text.
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To insert a drop cap, follow th ese steps:
1. Click the paragraph in wh ich you want th e drop cap.

2. From the Form at m enu, choose Drop Cap. The Drop Cap dialog box appears (see
Figure 6.6).
3. Select a position for the drop cap.
4. Choose a font for the drop cap.
5. Indicate the drop cap height in the Lines to Drop box.
6. Enter the distance that the drop cap should be fro m the text.
7. Finally, click the OK button . Word uses a frame to position th e character as a
drop cap.
8. To further adjust the distance of the drop cap from th e text, select the cap, go to
th e Form at menu, and choose Frame. In the Horizontal area of the Frame dialog
box, adjust th e Distance from Text and then click the OK butto n.
To remove drop cap forma tting, select the drop cap, go to the Format menu, and choose Drop
Cap. When the Drop Cap dialog box appears, select None (a t the upper left) and click the OK
button.
Drop Cap
P03ftlon

[i] ~ ~
tlono

Choose the font
fo r the drop cap.

Dropped

In Mor ot n

a
[
[

OK
Cancel

Help

~

)
)

Click one of these
buttons to select the
drop cap position.

Font:

]EJ

l&lellno
Lin., to Drop:
Dlotence from Text:

14
I D. I"

llel
I~

I

Enter the drop cap
heigh t.

Enter how far the drop cap
will be from its paragraph .

Figure 6.6

Use the Drop Cap dialog box to set up a drop cap.
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White type on a black background
You can create a paragra ph of w hite text on a black background by formatting the type with
the colo r white and then applying black paragraph shading. Here are the steps:
1. Highlight the paragraph that you want to change.
2. From the Format menu, choose Font. After Word displays the Font dia log box,
select the Fo nt card (see Figure 6. 7).
3. In the Fon t card, choose White from the Color menu .
4. To make the white text easier to see on a black background, select Bold fro m th e
Font Style menu.
5. Click the OK butto n. The Font dialog box closes, and the text disappears behind its
highlighting (you can 't see the text because it is white).
6. Go to the Format menu and choose Borders and Shading. Select the Shading card
(see Figure 6.8).
7. Select Solid (100%) shading.
8. Cli ck the OK button to return to the document.
9. To see th e white text on the black background, click elsewhere in the document to
remove the highlighting.
Font
Font
font:
\Time>
Helvetlce
i"'Jneco
Potot1 no
Sym bol

T

-().

Uooerli ne:

[<none)
Ostr l~et hroUQh

O superscrl pt
0 Sub>cript
0 Shad"'

Figure 6. 7
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Make the charact ers white and bold.

145

Size:
I t4

IQ

9
I0

n
!

It

lo

12
14

-().

OK

n
1
1

[

Cancel

[

De fault ...

I

llelp

l

1... 1

-il

To make the text
stand out mo re, select
Bold.

Choose White fro m
the Colo r me nu .

Part II

Word 6

Border$
Fill
O llone

OK
Conccl

@Cu5tom:
Shodtno·

[ Shov Tool bar

D

I
I

llel p

forroround·
Bockorourol·

Figure 6.8

I• Auto
ID Auto

1...1
1... 1

Select Solid (100%) for the shading.

Rotating, twisting, bending-WordArt
Wo rdArt ca n twist text in all sorts of \·vays to create all sorts o f unusual fo rmats. Use Wo rd Art
to crea te headlines and highly stylized bits o f text. When you use WordArt, yo u create objects
(think of them as li tt le pictu res) that insert into th e tex t laye r. More tech nically speaking, the
objects "embed " into t he text layer. To move a Wo rd Art ob ject into a d rawing layer, cut the
o bject and paste it in to a text box, as ex plained in Chapter 8 .
In any event, to call u p Wo rdArt and make an ob ject, fo llo w th ese steps:
1. Go to t he Insert menu and choose Object.

2. W hen the Object d ialog box appears, select Microsoft WordArt and cl ick t he OK
b utto n . A WordArt window appea rs (see Figure 6.9).
3. Type some text in th e En ter Your Text Here box and then click the Update Preview
b utton . The text sho uld appear in the Preview window at the lower righ t.
4. Turn o n the Resize Frame check box if you wa n t the ed ge o f the Word Art ob ject to
ex pand o r shrink au to matically in o rder to be just large eno ugh to ho ld the text in
the Preview. The Resize Fra me check box applies to th e framelike box t hat surro und s all WordArt objects, and it also applies if you decide to frame t he WordArt
objec t.
5. Experi ment wit h the available fo rmats to app ly all sorts o f weird and wo nderful
effects. Click the App ly bu tton to see what th e Wo rdA rt object looks like in the
d ocum ent or click the OK b ut ton to close Wo rdArt and retu rn to t he docu ment.
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Figure 6.9 The WordArt dialog box is t he control center for twisting and styling text.

Indenting a Paragraph from the Margin
Now that you know all about character formatting and how to create special typographical
effects, you can add visual interest (or even excitement) to documents with special paragraph
formatting.
To move a paragraph left or right, or make it wider o r skinnier, you should ad just the paragraph indents. Wo rd has three indents that work together to control where each line in a
paragraph begins and ends (see Figure 6.10).

+

Th e left indent controls where every line in a paragraph starts, except for the first
line. If yo u set a left indent at zero, the lines begin at the left margin.

+
+

The first-line indent controls where the first line in a paragraph starts.
The right indent controls the end of each line in a paragraph. If you set a right
indent at zero, each line ends at the right margin.
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The first-line indent marker is at .25,
making the first line start a quarter-inch
from the left margi n.
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The right margin begins a t 5 (the
margins for this document are a little
large, leaving only fi ve inches fo r text).
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mea n ing that a ll lines en d at or
before tile 5.

Figure 6.10 Each paragraph has th ree indents: first-line, left, and right.

To ad just a paragraph's indents visually, click in the paragraph and then move the appropriate
indent m arker on the ruler. If you drag the little box below the left indent marker, the first-line
and left inden t markers move together.
If you have the Pormatting toolbar showing, use the Decrease and Increase Indent buttons to
change the indent.

To numerically ad just indents, click in the paragraph that you want to adjust, go to the Format
menu, choose Paragraph , and bring up the Indents and Spacing card. The card has boxes fo r
entering the left and right indents, but to change the first-line indent, use the Special area .
Here's ho w it works:

+
+
+

None ma kes the fi rst-line indent li ne up with the left indent.
First Line makes the first line of the paragraph start to the right of the rest of th e
paragraph . Use First Line instead of typing blan k spaces o r a tab at the start of a
paragraph (over time, you'll save hundreds of keystro kes).
Hanging sets up a hanging indent, where the fi rst li ne starts left of the rest of the
paragraph. To make a hanging inden t fo r a nu mbered o r bulleted list, let Word do
the inden ting, numbering, and bulleting fo r you (see "Forma ttin g a List" later in
this chapter).

When you set a hanging indent, you can let text flow smooth ly alo ng the first line, o r you can
type a small am ount of text at th e upper left and then press Tab to insert a tab character. After
you press Tab, the insertion point jumps in the first line to the left indent (see Figure 6. 11).
If Word does no t mo ve the inserti on point to the left indent, open the Optio ns dialog box

fro m the Tools menu, select the Compatibility card, choose Microsoft Word 6 from the
Recomm ended Options For menu, and then turn off the Don' t Add Automatic Tab Sto p for
Hangi ng Inden t check box.
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The first-line inden t makes the
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Figure 6 .:1:1 Use a tab character with a hanging indent to make text line up in a particular way.

Aligning a Paragraph
You can align a paragraph in relation to the indents, and you get three choices for how the
text aligns (see Figure 6.12):

+

Align Left makes a paragraph flu sh left, meaning that it lines up with the first-line
and left indents. Most paragraphs in conventional reading material are set flush
left.

+

Center centers each line of text in a paragraph between the left and right indents,
with the exception of the first line in a paragraph, .which centers between the firstline and right indents. If you center text, consider breaking the lines unevenly. An
uneven break adds visual interest and makes it crystal clear that you in tended to
center the text.

+

Align Right makes a paragraph flush right, meaning that it lines up evenly at the
right indent.

+

justify makes each line in a paragraph line up evenly with the left (and first-line)
indent and with the right indent. Consider hyphenating justified text to reduce
unsightly white gaps between words (see Chapter 4). The last line in a paragraph
does not justify, and under most circumstances, you wouldn' t want it to. If you
want the last line in a paragraph to justify, end the last line with a soft return
character (press Shift-Return).
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This paragraph is left - 1-- Warning! The computer room will be dosed from Friday a1
noon un 111 Monday a1 noon so thai wo can lns1o.ll now
align ed, with a
compulen.
ragged right edge.
This pa ragraph is
centered .

Warning! The rompuler room will be closed
from Frid•ya1noon un1U Monday a1 n oon so that we can install
new computer..
Wa.m ingl The computer room will be dosed from Friday at noon unt!l Mondoya1 noon so that we can instoll n ew

J.

1-- This paragraph is righ t align ed,

with a ragged left edge.

compuler5.

Warning! Tbe computer room will bo dosed from Friday otnoon unUl Monday a1 noon "" tbot we can ins1oll new
computers.

•m

~l This paragraph is

l'i> eJ

:I J~L

fu lly justified.

Figure 6.12 You can horizontally align paragraphs in four different ways.
If you have the Formatting toolbar showing, use th e Align ment butto ns to apply different
alignments. You can also change alignment by clicking in the paragraph, choosing Paragraph
hom the Format menu, selecting the Indents and Spacing card, and choosing an alignment
from the menu at the lower right.

Adjusting White Space Between Paragraphs
White space betwee n paragraphs helps to separate them visually. You can put different
amounts of space between pa ragraphs to help readers understand the flow of your ideas. For
example, you can put more space before a main topic head ing than before a regular body tex t
paragraph.
You can always press Return a few extra times to make blank lines, but in the long run, it's
easier to have the paragraphs do the spacing on their own . If you ed it the documen t and th e
page breaks sh ift, blank lines may end up awkward ly placed at the top o r botto m of a page. To
change paragraph spacing, follow these steps:
1. Click in the paragraph.

2. From the Format menu, choose Paragraph, or double-click in the white area of the
ruler. In the Paragraph d ialog box, select the Indents and Spacing Card.
3. En ter amounts for the spaci ng before and afte r. Word expects the amoun ts to be in
points (there are 72 points in one inch).
4. Click the OK button.
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Paragraph Spacing
In a few special cases, Word ignores paragraph spacing. If you add spacing before a paragrC1ph, you don't get the spacing if the paragraph is the first paragraph in a document or if a
hard page break immediately precedes it. Also, if you add spacing after a paragraph and the
paragraph falls at the bottom of a page, the extra space disappears into the bottom margin.
The way paragraph spacing happens near a page break can change, depending on how
the Compatibility Options are set. If you have problems with paragraph spacing and page
breaks, experiment with two check boxes: Suppress Extra Line Spacing at Top of Page and
Suppress Extra Line Spacing at Top of Page Like Mac Word 5.x. To access these options,
go to the Compatibility card in the Options dialog box. Look in the list of options for
Microsoft Word 6.0.

Changing White Space Between Lines
The white space between the lines has a profound effect o n th e readability and flow of a
docu ment. Word automatically looks at the size of the largest character on a line and sets the
spacing a little bit larger than the size of that character. To override the way Word sizes lines of
type, follow these steps:
1. Click in the paragraph that you want to change, or highlight a group of

paragraphs.
2. From the Format menu, choose Paragraph and select the Inden ts and Spacing card
(see Figure 6.13).
3. In the Indents and Spacing card, choose a line spacing option. For line spacing,
Word uses points as its defau lt measurement unit. There are 72 poin ts in one inch.
To en ter a measu rement using inches, type in after the number. For example, to
enter o ne-half inch, type .5 in. The best option depends on what you want to
accomplish:

+

Si ngle spacing sets each line a tiny bit larger than the size of the largest
character o n that line.

+

1.5 Lines spacing and Double spacing increase single spacing by 150 and
200 percent, respectively.

+

At Least spacing sets each line at least as large as the measurement you
enter. If a li ne contain s a big character o r g raphic, the line expands to be
"at least" big enough to accommodate it.
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+

Exactly spacing se ts each line to the exact heig ht you specify. A big graphic
o r cha racter will be cut o ff if it does n't fit.

+

Multiple spacing sets each line to the norma l Single setting, mul tiplied by
t h e numbe r in th e At box. For exa mple, to increase the spacing to llO
p ercent of Single, enter 1.1 in th e At box.

4. After setting up the li ne spacing, click th e OK button .
If appro priate, enter a number to
go with t he line spacing o ptio n
Paragraph

Choose a
line spacing
option.

lnde ah e nd Speclng

~
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Figure 6.13 Adjust line spacing in the Paragraph dialog box.

Creating White Space with Tabs
If you need to adjust type horizo ntall y with in a line, a tab may be just the ti cket. Keep in
mind, however, that tabs a re som ew ha t outdated. Often, setting u p a table or snaking columns
makes mo re sen se than setting up tabs (see Chapter 7).
Tabs have two impo rta nt parts (it takes two to ta n go):

+
+

The tab stop in the rul er
The tab c h aracte r typed in the li ne of tex t

The tab stop tells tex t (typed after t he tab c haracter) w h ere to sta rt. Word comes with d efault
left tab stops set at every h alf inch. If you h ave kee n eyesigh t, you can see them as subtle
marks a t the bottom o f the ruler. If you press Tab while typi n g, a tab cha racter inserts in the
text, and the insertion poin t jumps a head to the next tab stop. Text that you type after the tab
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character continues from the tab stop (see Figure 6.14). If the tab stop is a default stop or a left
tab stop, the left edge of the con tinuing text lines up under the stop.
Tab characters may show onscreen, but they never print. You ca n control whether tab characters show onscreen in the View card of the Options di alog box from the Tools menu.
To insert a tab character within an existing table cell, press Option-Tab.
The default tab stop is a le ft ta b stop, so the
left edge of 267 lines up with the tab sto p.

The default tab stop stops the insertio n
point when you press Tab.

I

r.

..

Monlhl Report
• • • I • •

• I • • •

I • •,

2 • • •

S..J.. Figures:
Tobles oold>*267•m~<o

I • • •

3 • • •

I • • •

~

-i

(.29l

I

A tab character appears when you press Tab
(if you have tab cha racters showing).

Figure 6.1.4 A default tab stop lines up text based on the left edge of the text.

Adjusting default tab stops
You can move the default tab stops fo r any paragraph, so if you prefer stops once every inch
for some paragraphs and every two inches for others, Word can arrange that. You can also
change the default tab stop for an entire document. To change the default, try these steps:
1. Click in the paragraph that you want to change or highlight all the paragra phs you

want to change.
2. Go to the Format menu and choose Tabs. The Tabs d ialog box appears.
3. In the Default Tab Stops text box, en te r the distance that you want.
4. Click the OK bu tton .

Creating a custom tab stop
A custom tab stop deletes all default tab stops to its left. For example, if you have default tab
stops every half inch and you put a custom tab stop at 1.1 inches, the half-inch and one-inch
tab stops disappear. If you remove the custom tab stop at 1.1 inches, the default tab stops
come back.
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To make a custom tab stop, follow these steps:
1. Click the paragraph in which you want the stop to apply. You can also highlight a
gro up of paragraphs and t hus apply the stop to the entire grou p.

2. If the ruler is not showing, go to the View m enu and choose Ruler.
3. Select a stop by clicking the Tab Alignment button (on the left side of the ruler).
Each ti me you click you get a different stop until you cycle back to the beginning.
Table 6.2 explains what each stop looks like and what it does.
4. Click the ruler in the loca ti on where you want the tab stop located. For example, if
you wa nt the stop 1.5 inches in from the left margin, click at 1.5 on the ru ler.
5. That's it! If you are typing along in one of the paragraphs that you highlighted in
step 1, you can press Tab to make th e insertion point jump to the 1.5-inch mark
(see Figure 6.15) .

Figure 6.15 A decimal tab stop at the 1.5-inch mark causes text after the tab character to line up
based on the decimal point or where the deci mal point would be if you did type it.

Tab le 6.2
Tab Stop Symbols and Alignments
Symbol

Name

What it does

Kl

Left

Lines up the left edge of text with the tab stop

Center

Centers text under the tab stop

Decimal

Aligns the decimal point (usually a period) under
the tab

Right

Lines up the right edge of text with the tab stop

~
~

~
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Moving a custom tab stop
To move a tab stop, click in the paragraph that the stop goes with (or highlight a bunch of
paragraphs that the stop goes with) and then drag the stop to a new position on the ruler.
Press Option while you click and drag a tab stop to see precise measuremen ts.

Changing a tab stop's alignment
To change the way text lines up ben eath a custom tab stop, highlight the paragraphs that you
want to change and then choose Tabs fro m the Format menu. In the Tabs dialog box, select
the tab stop that you want to chan ge from the Tab Stop Position list, select a new alignmen t,
and click the OK button (see Figure 6.16).
Select an alignment.
Tnbs
Tab Stop Position:

Select the tab stop that you want to change.

1.5"

r-s·

~~

OofeultTe bStops:

IS"
Q

:"llonmenlQun
Qeonter

0

l eaderQ1 ~lono
0 2 .......
[

0

®RiQht
OOottmel
Qe.r

3 .......

®
•4-

Tab Stops to Be Cl.. red:

Cancel
Sel

)

[

Clea r

J

[

Clear hit

)

(

Help

)

Select a leader.

Figure 6 .16 Use the Tabs dialog box to customize tab stops.

Adding a tab leader
Most of the time, you want the space taken up by the tab character to be blank. But you can
put little dots or a solid underline in that spot, if you wa nt, by adding a leader to the tab stop.
To add a leader, open the Tabs dialog box and select the stop that you wa nt to change. Select a
leader from the Leader area and click the OK button (see Figure 6.16).

Removing custom tab stops
To remove just one tab stop, click in the paragraph that it goes with or select all the paragraphs that it goes with. Then drag the stop about an inch down from the ruler. The stop
disappears, and text re-aligns based on the defaul t tab stop. To completely remove the tab,
delete the tab character in the text.
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Yo u can also clear ta bs fo r selected text while you are in th e Tabs dialog box. If you want to
remove all custom tab stops from a document, press :1=t-A to highlight the document, open th e
Tabs dialog box, click th e Clear All button, and then click the OK button.

Formatting a List
A list ty pica lly consists of a string of short, related paragraphs, such as addresses, suggestions,
events, and so forth (see Figure 6.17). If your list is more of a tabular arrangement with rows of
related info rmation, see Chapter 7 fo r mo re info rmation abo ut tables.
Plnnt Core

] liJ

Da lly Watering Reminder

i'Jo

Give the S~ruce trees one bu<ket of water each.
Split e buc e t of water between the Holly tree and the Empret:S tree.
Split e bucket of watero.mongtbe four tamato plants.
SpAy the mushroom patch (under the Willow tree) until the bark chips look
ooeked.
Give each v ine (the on eo growing by the front steps) one bucket of wa ter.
Water the cane plant (on my desk ln tho kitchen) until waterjuot begins to
run out the bottom.
Water the mean cactus (by the front door) until the soll loob demp.
•m:u¢'

Figure 6.17

Ill!!

~

~P.l

A basic. list without any special formatting ...

To make a list easier to read, you can apply va rio us fo rmats (see Figure 6. 18).

Plnnt Cnre

J:J
Dally Watering Reminder

til(

i'Jo

1.
2.
3.
4.

Give the Spruce trees one bucket of woter each.
Split a bucket of water between the Holly tree and the Empres• tree.
Split a bucket ofwateramong the four tomato plants.
SpAy tbe mushroom patch (under the Willow tree) until the bark chips
look soaked.
5. Give each vine (the ones growing by the front steps) one bucket of water.
6. Weterthecane plant (on my desk in the kitchen) until water lust begins to
run out the bottom.
()•mli¢JI.t
·i~l!l

Figure 6.18

...can be dramatically improved by adding extra space after each entry, as well as by
adding numbers and a hanging indent.

Yo u can even display the list in snaking columns (see Figure 6.19). For mo re informatio n
abo ut snaking co lumns, see Ch apter 7.
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Plnnt Cor e

i

Dally W a te ring R e minde r
I. Give the Spruce trees one
bucket of water Ollcb.
2. Split a bucket of water between
the Holly tree and the Empress
tree.
3. Split a bucket of wateamong
the four tomato plant~ .
4. Spray the mus hroom patch

5. Give each vine (the ontc
growing by the front steps) one
bucket of water.
b. Water the cane plant (on my
d.,k In the kitchen) unUl wate r
tuft begins to ru.n o ut the
ot1om.

7. Water the mea':' cectuo

oiJ.
~

.\br the
tc;

•m:a t<:ot

;
Q]

Figure 6.19 The list, from the preceding two figures, shown in snaking columns.

Special formatting with bullets and numbers
To make a list mo re readable, consider beginning each entry with a number, bullet, o r any
special character. Although you can type bullets and numbers by hand, you can speed up the
process by using the Bullets and Numbering paragra ph fo rma ts. To get the most o ut of using
bullets and numbering, keep two points in m ind:

+
+

You can make bullets or numbering part of a style.
As you type a list formatted with bullets or numbers, each new paragraph automatically starts with a bullet o r with the next number in the sequence.

To apply bullets, highlight the list entries and click the Bullets button on the fo rmatti ng
too lbar. Numbering wo rks in a similar manner-first highlight the entries and then click the
Numbering butto n.
Yo u can also apply Bullets and Numbering forma ts by selecting list entries and choosing
Bullets and Numbering from the Format menu. In the Bullets and Numbering d ialog box,
switch to the appropriate card (Bulleted fo r bullets; Numbered fo r numbers). In the card, click
o ne of the big example butto ns fo r a style of numbers o r bullets and then click the OK button.

Removing and skipping bullets and numbers
To rem ove bullets, high lig ht the fo rmatted entries and click the Bullets butto n. Similarly, to
remove numbering, highlight the entries and click the Numbering button. The Bulleted and
Numbered cards also offer Remo ve buttons; click them to remo ve bullets or numbering from
selected list entries.
If the inserti on point is in an entry that sho uld not have a bullet o r number, you can temporarily turn off the formatting by issuing th e Skip Numbering command o n the sho rtcut men u.
Simply contro l-click th e bullet or nu m ber in the text to bring up the shortcut m enu. If you
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issue Skip Numbering, th e numbering (or bullets) sho uld con tinue in the next paragraph. (The
Skip Nu mbering command skips bo th numbers and bullets.)
To stop the bullets o r numbering fo r good, either click the Numbering (o r Bullets) bu tton o n
the Formatting toolbar or choose Stop Numbering fro m th e shortcut m enu (Contro l-click the
bullet o r number w here you want to stop). The Stop Numbering command sto ps both numbers and bullets.
If you use the Customize dialog box fro m the Tools menu to assign keyboa rd sho rtcuts to
the bullets and numbering options, note t hat the command for t urning bullets o n and off
is called FormatBulletDefault. Similarl y, the command for turn ing numbers o n and off is
FormatNumberDefault.

Customizing the appearance of bullets
To change a bullet's size, colo r, o r character, follow th ese steps:
1. Select the bulleted entries that you want to change.

2. From t he Format menu, choose Bullets and Nu mbering. Select the Bulleted card.
3. In the Bulleted ca rd, if o ne of the six big buttons shows t he bullet that you want,
click th e button, click the OK button, an d skip the rest of th ese steps. Otherwise,
click the Modify butto n . Word displays the Modify Bul leted List d ialog box (see
Figure 6.20).

Select a bullet.

If you do n' t wa nt th e bullet to take o n the
co lor of the list ent ry, choose a color.

I
Modl_fy ouueted list

Du11et Cb•nc:ter

If you don't
want the
b ullet to be
the size o f the
list e n t ry,
enter a
d ifferent size.

DDDDc:J8
I

Point Size:
l~uto

Color:

eel 1• Auto

1.. -1 [ Oullot..•

Oullot Pooltlon

Dl>tonce rrom Indent to To><l

!Len
1o.2s·

Dl>tence from Bullet to To><t.

lo·

Alignment of lfsl Text:

,....,

~~
t
Provle.,

OK
CaDceJ

llolp

r
I

Cl ick the Bullet
bu t ton to select a
di fferent bullet
ch aracter.

~

tl

OH•nou"llrdonl

Figure 6.20 Use the Modify Bulleted List dialog box to set up special bullet formats.
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4. To change the bullet size, enter the size. If you leave the point size at Auto, the
bullet will be the same size as the text, or more technically speaking, the bullet
takes on the point size applied to the paragraph mark at the end of the list entry.
S. To make the bullet a different color, choose a color. Leave the color set to Auto to
make the bullet the same color as the text (actually the paragraph mark at the end
of the entry).
6. To change the bullet character, click the Bullet button. The Symbol dialog box
opens. In the Symbol dialog box, select the character that you prefer to use. You
can switch between a few of your installed fonts by choosing a font from the
Symbols From menu. Click the OK butto n after selecting a character.
7. After you finish modi fying the bullet, click the OK button.

Customizing number formatting
To change the numbering scheme in a wide variety of ways, try these steps:
1. Select the numbered entries that you want to change.

2. Select the Numbered card in the Bullets and Numbering dialog box.
3. In the Numbered card, click the Modify button. Word displays the Modify Numbered List dialog box (see Figure 6.21).
4. You can customize the numbering in many ways:

+

Choose a numbering scheme from the Number menu.

+
+

Use the Start At box to indicate with which number the list should begin.

+

To put text before the numbers, type the text in the Text Before box. In
most cases, type a space after the text so that the text doesn't run right into
the number. For example, you can type Action Item or Query (note the
extra space after the words). You ca n also customi ze text that appears after a
number, such as a colon or a right parenthesis.
To change the character format of the number and the text that goes before
and after the number, click the Font button .

S. After you finish customi zing the numbering, click the OK button.
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Figure 6.21 Set up the formatting for list numbers.

Special formatting for list entries longer than one line
If your list entries take up more than one line of text, you can make the list look more attractive by setting up a special indent, adding extra space between entries, and making sure that
list entries do n 't separate awkward ly over page or colu mn breaks.

Setting up space before and after
If your list entries take up more than one line, add a little m ore space between entries to help
readers see the entries as separate elements. To change the space between entries, you can
change the space after a paragraph o r the space before (you can also change both options).
Here are the steps:
1. Highlight entries that you wan t to format.

2. Go to the Format menu and ch oose Paragraph . Select the Indents and Spacing card.
~-

Enter measurem ents in th e Before and After boxes. The default unit of measure-

ment is the point, so you should try a number between 4 and 24 points first and
then work from there.
4. Click the OK button .
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Making a special indent
If you applied Bullets or Numbering formatting to your list, don't set up the indent by using

these directions; instead, turn on the Hanging Indent check box in the Modify Bulleted List
or Modify Numbered List dialog box. If you aren't using Bullets or Numbering formatting,
however, set up a special indent by following these steps:
1. Highlight the entries that you want to indent.

2. From the Format menu, choose Paragraph and select the Indents and Spacing card .
3. From the Special pop-up menu, choose an indent:

+

A hanging indent makes the first line of an entry start left of the rest of the
lines.

+

A first-line indent makes the first line of an entry start right of the rest of
th e lines.

4. Figure out how far left or right you want the first line to begin in relation to the
rest of the lines and enter the distance in the By box. (If the Preview in the Indents
and Spacing card is sufficiently clear, use it to fine-tune the distance.)
S. Click the OK button.

Preventing awkward page (or column) breaks
Use the Keep Lines Together paragraph for mat to keep all the lines in each entry together on
the same page or column. If you apply Keep Lines together and an entry doesn't fit completely
on on e page or column, the entire entry jumps to the top of the n ext page or column. Here are
the steps for applying the Keep Lines Together format:
1. Highlight the entries.

2. Go to the Format menu and ch oose Paragraph. Word displays the Paragraph dialog
box. Select the Text Flow card.
3. Turn on the Keep Lines Together check box.
4. Click the OK button.

Formatting mult ilevel li sts
A multilevel list uses indents to indicate the importance of entries in the list. The entries in
each level can have separate numbering schemes, and as such, you can create a standardlooking outline or set up a wide va riety of bullets and numbering schemes (see Figure 6.22).
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The first level uses Roman
numerals followed by periods.
l'l!J

The second level
uses uppercase
letters followed
by periods.
The third
level uses
bullets.

-

] Presentation Outline [
l. Flrct quarter rerults
A. Flowers
Rooes
lhlfoc:llls
Cam atlon5
B. House plants
Spider plants
• Jade plant•
ll. Se<ond quarter results
A. Flowen

..
.
.
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Figure 6 .22 This multilevel list has three levels, and each leve l uses a different bullets or numbering
scheme.

Caution: You cannot use text formatted with built-in heading styles in a

•

•

multilevel list. To number text formatted with Heading styles, use the
Heading Numbering command on the Format menu .

'

To set up multilevel list formatt ing, follow th ese steps:
1. Select the entry or entries that you want to format. (If you haven't started th e list

yet, just place the insertion point where you want the list to begin.)
2. Go to the Format m enu, choose Bullets and Numbering, and select the Multilevel
card.
3. Click o ne of the six list-numbering o ptio ns. If you don't wan t to customize the
option, click the OK butto n and skip the rest of these steps. If you do wan t to
custom ize the o ption, click the Modi fy butto n to o pen the Modi fy Multilevel List
dialog box.
4. Each level in the list can have its own forma tting, so to format a particular level,
select it fro m the scrolling list at the right.
5. After selecting a level, you can apply fo rmats to it.
6. After you finish form atting the entries, click the OK button.
Now that you have set up the list, you can move entries from level to level by clicking the
Decrease or Increase Indent button on the Formatting toolbar. Yo u can also use the keyboard:
press Option-Shift-Left Arrow or Option-Shift-Right Arrow. As you move an entry, it takes o n
the bullets or numbering for its level.
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Caution: If you format an existing list , Word figures that everything with a left

e

indent of less than .5 inches from t he left margin is of level one importance. Everything between .5 inches and 1 inch is of level two importance,
and so on, wit h the level of importance changing every half inch.

e
'

'

Sorting a List
Word can sort paragraph s into alphanumeric, numeric, or temporal order, based on the first
letter, num ber, ti me, or date in the paragraph. Alphanumeric order means that numbers sort
fi rst in numeric order and then characters sort in alphabetic order. When sorting, Word
ign ores bullets or numbers attached to a paragraph through the Bullets and Numbering
commands. (To find out how to sort a table, see Chapter 7.)

Basic sorting
To sort a list, such as the list in Figure 6.23, follow these steps:
] Llt

Before sorting. -

After sorting
based on
text.

llil!

i roods

Ta<os 200 2/24/94
Pizze. 343 1/!0!94
Eggroll• 23 3/16!94
Post•6 1/V/94
Se.lod 321 3/12/94

Posta 6 1/V/94
Eggro Us 23 3/16/94
Taro::200 2/24!94
Se.lad 321 3/12/94
Pl«o 343 1/ 10!94

EggroU• 23 3/16!94
1/27!94
-Pizza 343 1/10/94
Salad 321 3/12!94
Tacos 2lXl 2/24/94

Pi-.a343 1/ 10/'14
Pasla 6 1/27!94
Taros 200 2/24!94
So1ad 321 3/1 2/94
Eggro!ls 23 3/ 16/94

r ..,. 6

<t

1 ·~1
~
.;
~

••:u¢

After sorting
based on
number.
After
sortin g
based on
da te.

n• 81

Figure 6.23 You ca n sort a list in several different ways.

1. Select th e list.
2. Choose Sort Text from the Table menu. The Sort Text dialog box appears (see
r:igure 6.24).
3. Select Pa ragraphs in the Sort By menu.
4. From the Type menu, select what you wa nt to sort by.
5. If you selected Text in the preceding step, click the Options button and use the
Case Sensitive check box to cont rol whether upper- and lowercase versions of th e
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same character always sort together. Turn on the check box to make them sort
together; turn it off if you don't care whether they sort together or intermingle.
Click the OK button.
6. Indicate whether you want to sort in ascending or descending order.
7. Click the OK button.

Leave Sort By set
to Paragraphs.
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I
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Select Ascending to sort
numbers first and then
alphabetically, from A-Z.
I

Choose Text to sort
alphanumerically.

I~
I'
1

Select Descending to
sort in reverse order.

Option•
(
Help

Click the Options button
to open the Sort Options
dialog box.

Sort Options
So pornte field• M @Tab'

Oc.m,..
QOther;

[Sort Optlono
0 S..1 f:.I "IIV' Ontu
c~c.,. s.nstttve

EJ

1

~ c.::. r
(

Help

)

Turn on Case Sensitive to make
upper- and lowercase versions of the
same character always sort together.

Figure 6.24 Use the Sort dialog boxes to set up sorting a simple list.

•

Caution: If you plan to create a long list and sort it later, set up a sample list
first to make sure that the sort will work .

'

•

'

Now that you know how to format words and paragraphs to make a more interesting document, look for detailed instructions in the next chapter about add ing even more interesting
elements, such as tables, footnotes, TOCs, and so on.
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In this chapter, I discuss stuff that most people don't do every day. Even people who use Word
for ho urs and hours a day don't use aH these features. Even so, if you need one of these features, it wouldn't do to leave you up the figurative creek with no instructions. The instructions
here help you figure out the following:

Part II

Word 6

Starting and Formatting a Table
A table, one of Word's best features, provides a grid for lining thlngs up in colurims and rows.
Tables work wonders for organizing numbers, comparing ideas, writing scripts, and so on. You
can even do simple math inside a table.

•

Caution: Use section-based, snaking columns when you want to type all the
way down a page in one column and then start typing in the next column.
Flip ahead a few pages to find out how .

'

•

'

Word offers three main ways to start a table, and I recommend using the way that looks most
convenient to you.
•

If you like using dialog boxes, start a table by choosing Insert Table from the Table
menu.

•

If you like using wizards, go to the Table menu, choose Insert Table, and then click
the Wizard button.

•

If you have the Standard toolbar showing, figure out how many rows and columns
you want to begin with and then drag them down from the Insert Table button on
the Standard toolbar (see Figure 7.1).

llr

4 x 3 Tobie

Figure 7.1 To start a table, drag it out from the Insert Table button.

A table's raw-and-column structure forms a grid, where each box is called a cell. If you have
nonprinting characters showing, you'll see an end-of-cell mark in each cell and an end-of-row
mark at the end of each row. Typically, a table shows onscreen with gridlines around each cell.
If you can't see grid lines in your table, choose Gridlines from the bottom of the Table menu.
Each cell works like its own little page, with the sides of the cell acting like margins. If you
type more than one line into a cell, the text wraps down to the next line and the entire row
gets taller to make room for the second line of text (see Figure 7.2). In earlier versions of Word,
an enormous number of people ran head-on into a problem where a table row couldn't get
taller than a page. Microsoft finally fixed this problem in Word 6.
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If you type more than one line of
text in a cell, the text wraps to
make another line.

An end-of-cell mark appears after the
last character typed in each cell.
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Figure 7.2

!i

A table has co lumns and rows.

Caution: Gridlines don't print, but if you apply borders, the borders will

'
•

print. To apply borders quickly, click inside the tab le an d choose Table
AutoFormat from the Table menu. Or to make your own borders, see
Chapter 8 .

•

'

If you click in a cell and then look at the ruler, you see that the cell has its own set of indent
markers. You can drag the indent markers to ad just how text wraps within the cell. (See
Chapter 6 to learn more abo ut indents.) A table automatically has a little space between
columns so that text in different columns stays separate. That space shows on the ruler, and in
that space sit column m arkers, which you drag to ad just the column widths (see Figu re 7.3).
Drag an indent marker (such as this first indent
marker) to ad just how text wraps within a cell.

Drag a colu mn marker to
move the edge of a column.
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In this colu mn, the indents are ad justed so that
the text indents from the co lumn sides.

Figure 7.3

The ru ler for a table shows indent and column markers.
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Selecting inside a table
To change the appearance of a table, you must know how to select cells, rows, and columns.

+

To select a cell, place the pointer over the middle of the cell (don't dick, just place).
Th e pointer should look like an 1-beam. Slide the pointer toward the left edge of
the cell and stop sliding when the pointer changes into a single arrow. With the
pointer looking like a single arrow, click once.

+

To select a row, place the pointer over the middle of a cell in the row (don't click).
The pointer sh ould look like an 1-beam. Slide the pointer toward the left edge of
the cell and stop sliding when the pointer changes into a single arrow. Doubleclick. (To select more than one row, keep the button down on the downstroke of
the second click and drag up or down to select additional rows.)

+

To select a column, press Option and click once in the column. (To select multiple
columns, press Option and click down. Before releasing the button, drag over the
columns that you want to select.)

+

To select the entire table, press Option and double-click the table.

Adjusting column and cell widths
Word offers two methods for changing the width of a column-dragging the column edge or
dragging a column marker in the ru ler. In either case, as the width changes, columns to the
right resize proportionately so that the table stays the same width.
If you don't highlight anything when you change the width of a column, you change the
width throughout the table. If you o nly want to adjust widths in part of the table, h ighlight
that part of the table and then drag a column edge or column marker.
Here are a few tricks for changing cell and colu mn widths in special ways:

+

To change the width of the two columns bounded by the edge that you drag and to
keep the table the same size, press Shift while dragging.

+

To change the width of the column left of the edge that you drag and change the
size of the table, press ):(-Shift wh ile dragging.

+

Even out the widths of columns by pressing ):C and dragging the edge of a column.
Word evens out all columns to the right of the edge that you drag.

Controlling row height
Rows automatically expand to accommodate any text and graphics inside. To make a row
taller than its automatic size or to impose a minimum or maximum height, follow these steps:
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1. Highlight the row or rows that you want to format.

2. Go to the Table menu and choose Cell Height and Width (or double-click a
column marker). When the dialog box opens, select the Row card.
3. In the Row card, use the Height of Rows menu to set the row height (see
Figure 7 .4).

+

To make the row an exact height, select Exactly and enter the height in the
At box. By default, Word measures row height in points (there are 72 points
in one inch).

+

To make a row a certain height and allow it to expand further if it overflows, select At Least and enter a height in the At box.

+

To make the row high enough to hold the con tents of the row, select Auto.

4. Click the OK button.
Cell llolgh t ond Width

T
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Choose a row height option.
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You can set the height of a row in three main ways: Auto, At Least , or Exactly.

Adding and removing columns and rows
If a table has the wrong number of columns or rows, Word offers several methods for remedying the situation.

Deleting columns and rows
To delete columns o r rows, high light the columns o r rows in question and choose Delete Rows
(or Delete Colu mns) from the Table menu .

Adding rows
Adding a row takes two steps. First, click in the row beneath the spot where you would like to
place the new row. Second, choose Insert Rows from the Table menu. To add several rows at
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once, h ighligh t several rows below where you wa nt the new rows to go and then choose Insert
Rows. Wo rd inserts the number of rows that you selected. To add a row at the bottom of a
table, click in th e lower-right cell and press Tab.

Adding columns
The steps fo r adding columns work much Uke the steps fo r adding rows. Begin by h ighlig hting
the column to the ri ght of where you wa nt to ad c! the column. Finish by choosing Insert
Columns fro m the Ta ble menu.
To add several columns at o nce, highlight several columns (to the right of wh ere you wan t
the new co lumns) and choose Insert Columns. Wo rd adds the number of columns that you
selected.
To add a colu mn to the fa r righ t of the table, press Optio n and click once just to the right of
the table. A thin column to the right of the table should be highlighted. With the thin column
highlighted, choose Insert Columns fro m the Table m enu.
You can click th e Insert Table button (on the Standard toolbar) instead of choosing Insert
Rows (or Columns) from the Table menu. Because you have a ro w or column selected, the
button's TooiTip calls it th e Insert Rows (or Columns) button .

Moving the insertion point inside a table
If you use tables a lot, it's worth your time to use keyboard sho rtcuts for moving the insertion
point in a table. Table 7.llists commands and keyboard shortcuts. For the sh ortcuts that
require an extended keyboard, use the Customize dialog box from the Tools menu to customize them (if you don't have an extended keyboard).

Table 7.1

Commands and Keyboard Shortcuts for Moving Around in a Table
Where you can move

Command name

Dejar1lt keyboard shortcut

Ahead one column

NextCell

Tab

Back o ne column

PrevCell

Shift-Tab

Last cell in a row

EndOfRow

O ption-End

First cell of a row

StartOfRow

Option-Home

Bottom of a column

EndofColumn

Option- Page Down

To p of a column

StartofCol umn

Option- Page Up
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Doing math inside a tab le
If you want to do serious math, you definitely need to use Excel. If you want just a little math,
you can place a special formula field inside a table and instruct that field to do calculations
based on the contents of the table. To insert such a field, follow these steps:
1. Go to the Table menu and choose Formula. The Formula dia log box appears (see

Figure 7.5).
The range goes in parentheses and
sets wnat cells the fun ction uses.

The function sets the calculation that the formu la will do

I

Formula

A formula starts with an equal sign.
To add a function to the
formu la, choose it from the
Paste Function menu.

Figure 7.5
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Choose a
number format.

Use the Formula dialog box to do calculations on numbers entered in a table.

2. Enter a formu la. Word may guess a formu la, and if Word guesses, you can use the
guess or enter your own formu la. A basic formu la has two parts: a function and a
range. The function sets the type of calculation and the range sets what cells to do
the calculation o n. Table 7.2 shows samples of how ranges work in formulas. To see
the available functions, look in the Paste Function list. If you choose a function
from the list, it adds to the formula.

3. Choose a number format.
4. Click the OK button.

The field appears in the document.

Table 7.2
Examples of Ranges in Formula Fields
Fomwla

What it does

=SUM(ABOVE)

Adds the numbers in all cells directly above the cell holding the
formula until it gets to the top of the table, a blank cell, or a cell that
contains text. You can also use the ranges (BELOW), (LEFT), and
(RIGHT).
continues
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Table 7.2 Continued
Formula

What it does

=SUM(Al:B2)

Adds the numbers in a box defined by cell Al (the upper-left cell)
and B2 (second column, second cell). Notice that a letter indicates
the column, and a number indicates the row.

=AVERAGE(2:2)

Averages all numbers in the second row.

=AVERAGE(C:C)

Averages all numbers in the third column from the left.

=PRODUCT(Al, C3)

Multiplies cells Aland C3.

Sorting text in a table
In addition to sorting paragraphs (see Chapter 6), Word can also sort tables into alphanumeric,
numeric, or temporal order, based on the first letter, number, time, or date in the paragraph.
(Alphanumeric order means that numbers sort first in numeric order and then characters sort
in alphabetic order.) In a table, you can sort based on the contents of one (or more) columns
(see Figure 7.6).
Caut ion: If you plan to create a long list and sort it later, set up a sample list

•

·,

and make sure that the sort will work .

'

The table
before sorting.
The table after
sorting.
Word then sorted---.,
the table by the
First Name column.

Figure 7.6

You can sort a table based on the contents of more than one column.

lf you are sorting in a table, you click in or select the table, choose Sort from the Table menu,
and use the Sor t dialog box to set up the sort.

•

If the first table row has generic headings that you don't want sorted, select the
Header Row radio button at the bo ttom of the dialog box; if you want the first row
included in the sort, select the No Header Row radio button.
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+

Set up the Sort By and Then By areas, as needed. If you want to sort based on one
column only, you need to set up only the Sort By area.

+

Note that Column 1 mean s the leftmost column, Column 2 the second from left
column, and so on.

The sort from Figure 7.6 was set up in the Sort dialog box, as shown in Figure 7.7.
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Figure 7. 7

Use the Sort By and Then By areas to set up a two-column sort.

Table tips and tricks
When setting up a table, you can run into an assortment of special problems and less common
situations.

Special considerations for tall cells
If you type a lot of text in one cell, the cell may interact awkwardly with a page break. To

change whether a page break can occur within a row, highlight the row and bring up the Cell
Height and Width dialog box (double-click a column marker in the ru ler or go to the Table
menu and choose Cell Height and Width). Look in the Row card.
A check box called Allow Row to Break Across Pages controls whether page breaks occur in
the middle of cells or whether a cell pops to the n ext page if it doesn't fi t completely on its
original page.

Moving the table down from the top of the document
If you have a table stuck at the top of the document, click with the !-beam pointer in the

upper left of the upper-left cell. The insertion point should appear at the upper left of the
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table. (If you have trouble keeping the pointer looking like an 1-beam, click near the top left of
the cell and then use the arrow keys t o move the insertio n point to the upper left.) With the
insertion point at the upper left, press Return. Word inserts a blank paragraph above the table.

Splitting and merging cells
You can split and join cells that are in the same row. Highlight the cells and choose Split Cells
from the Table menu. In the Split Cells dialog box, enter the number of columns into which
you want each highlighted cell to split. For example, if you select two cells and then enter 2
for the number of columns that you want, you end up with fou r cells: two cells for each cell
that you highlighted originally.
To merge cells, highlight them and choose Merge Cells from the Table menu.

Splitting and merging tables
To split one table into two tables, click in the first row that you want in the second table and
then choose Split Table from the Table menu. To merge two tables into one, remove all the
text between them. If only a paragraph mark separates th em, highlight the paragraph mark
and cut it out.

Page breaks
If you insert a page break within a table, the table splits into two. To create a page break
without splitting the table, follow these steps:
1. Click at the top of the row below where you want the break.

2. From the Format menu, choose Paragraph. In the Paragraph dialog box, bring
forward the Text Flow card.
3. In the Text Flow card, turn on the Page Break Before check box and then click the
OK button.

Tab characters
To type a tab character, press Option-Tab. If you use a decimal tab stop, you don't have to type
a tab character into a cell; Word automatically inserts an invisible tab character.

Setting up a table row at the top of each page
If the first row in a table contains column headings and the table extends through more than

one page, you can make the column headings repeat at the top of each page. Before you do
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this, ma ke sure that you have at least two rows in the table-the top row that has headings
and at least one other row, which does not have headings.
Highlight the row holding the headings and choose Headings from the Table menu. After you
set up table headings, if you change anything in the heading row, the changes show on all
pages (in Page Layout View and Print Preview).
Caution: Headings repeat only after a soft page break. They do not repeat ,·

•

after a hard page break .

'

Changing the space between columns
By defau lt, Word inserts .15 inches of blank space between columns, adding .075 inches of
blank space to each side of each column . To ad just the space between columns, follow these
steps:
1. To adjust the entire table, click a nywhere in the table. To adjust only a few rows in

a table, specifically select those rows.
2. From the Table menu, choose Cell Height and Width (or double-click a column
marker on the ruler) and then choose the Column card.
3. In the Column ca rd, enter a measurement in the Space Between Columns box and
then cl ick the OK button.

Positioning the left edge of a row or table
You can position the left edge by dragging the appropriate column marker in the ruler, but the
Cell Height and Width dialog box offers better control. To use the dialog box, follow these
steps:
l. Highlight the row or rows that you want to adjust.

2. From the Table menu, choose Cell Height and Width (or double-click a column
marker). When the dia log box opens, select the Row card.
3. In the Row card, select an Alignment radio button or enter a measurement in the
Indent From Left box. For example, to move the selection one-half inch into the
left ma rgin, enter -.5.
4. Click the OK button.
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Copying or cutting text from a cell
Be careful when you copy or cut text and then paste it in another cell. If you include the
end-of-cell mark with the copied or cut text and then paste the text into a different cell, the
pasted-in text replaces anything that was in the cell before. This problem also occurs with
Drag and Drop.
To prevent th is problem from happening, do not Include the end-of-cell mark with the·text
that you copy or cut. Then when you paste the text Into another cell, the cell will contain its
preceding contents and the pasted contents.
----------------------------------~

Setting Up Snaking Columns
Because snaking columns go by section, you can also call them section-based columns. A
snaking column usually consists of text that reads all the way down one column on a page and

then continues at the top of the next column on the page.
If you feel a little fuzzy abou t how to work with sections, look for information about sections
towa rd the end of Chapter 1. Otherwise, here are the steps for setting up snaking columns:
1. Select o r click in the appropriate spot.

2. From the Format menu, choose Columns. The Columns dialog box appears (see
Figure 7.8).
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e nter a number of columns.
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3. Set how many columns you wa nt. Enter a number or select a Presets option.
Instead of opening the Columns dialog box, you can drag out the number of
columns that you want from the Columns button on the Standard toolbar.
4. If you want to customize a column width or the space between two columns, note
that you must turn off Equal Column Width fi rst. ff you type numbers, the Preview
doesn't update; to see the update, press the arrow keys on the keyboard or click the
little up- and down triangles in the dialog box.
S. To place a vertical line between each column, turn on Line Between.
6. If Start New Column is on, turn it off.
7. Click the OK button .
Word formats your document and gives you columns. Now that you have columns, here are a
few tips for making them do what you expect them to do:

+

In Normal View, you see only one column at the left side of the page. Switch to
Page Layout View or Print Preview to see the column layout.

+

To line up columns evenly at the bottom, make sure that they have a section break
after them and format the break with the Continuous option. (If they still don't
line up evenly, open the Options dialog box, select the Compatibility card, look
at the options for Microsoft Word 6, and turn off the Don't Balance Columns for
Continuous Section Starts check box. You can make this a default by clicking the
Default button.)

+

If columns begin at the top of a new page and you don't want them to do so,

format the section break before the columns as Continuous.

+

On the ruler, notice that each column has its own white area. If you click in a
particular column, you get indent markers for that column. You can change
column widths by dragging the boundaries between the gray and white areas.

+

To change anything about the column layout, go back to the Columns dialog box
(with the appropriate text selected) and make the change. To open the Columns
dialog box, double-click on the ruler in the gray area between two columns.

Making Text Wrap Around
a Paragraph or Graphic
To separate a bit of text (or a grap hic) so that the rest of the text flows around it, use a paragraph format called framing. Framing takes place in the text layer. For example, you may want
to center a statement in the middle of a page to make it stand out more.
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Here are the steps fo r setting up a frame:
1. Make sure that whatever you want to frame is in a separate paragraph from

anything else. Framing is a paragraph format, so it's important to work with
paragraphs.

•
'

Caution: If you plan to frame text, it's usually easier to format the text before
you frame it.

•

'

2. Make sure that you are in Page Layout View and then select what you want to
frame.
3. Choose Frame from the Insert menu. Word responds, as shown in Figure 7.9, by
placing a frame around the selection, bordering the selection, inserting an extra
paragraph mark, and anchoring the frame to that extra paragraph mark. Use the
Zoom menu on the Standard toolbar or choose Zoom from the View menu to
zoom to a size that shows how a frame looks on the page.

;a

Creetlue Writing

If you click on the

frame, selection
handles show on
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anchor.
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paragraph
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Figure 7.9
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Word adds a frame, border, anchor, and paragraph mark after you frame something.

4. The next step depends on what you want to do with your frame. Here are a few
possibilities:

+

If you leave th e frame alone, it remains aligned with the left margin, and

the text wraps around it with a small gap between the frame and the text.
If you add or delete text above the frame, the frame moves up or down

correspondingly in the document.

+

To change the frame's size, select the frame, click the frame itself, and drag a
selection handle in the appropriate direction (see Figure 7.9). Text inside a
frame behaves as though the edges of the frame are its margin. If you
change the width of the frame, the text moves accordingly.

+

If you like the idea of the frame moving up or down as you add or delete
text, but you want the frame to start in a different spot, select the fram e and
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position the pointer over the frame so that a four-way arrow sticks out of
the bottom of the pointer. With the fo ur-way arrow pointer, drag the frame
to a different location.

+

Ad just the indents for text within a frame to move the text closer to or
farther from the edge of the fram e.

5. If the possibilities in step 4 aren't enough, use the Frame dia log box to further
manipulate your frame (see Figure 7. 10). To access the dialog box, select the fra me
(after selecting the frame, you should see selection handles), go to the Format
menu, and choose Frame. Or for a shortcut, double-click a frame (right on the
edge) to open the Frame dialog box. I won' t pretend that complex framing is easy
to do-be prepared to experiment with differe nt settings.
Set a position for the
distance of the frame
from the left edge.
Indicate whether
you want text to
wrap around the
sides of the frame.
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and bottom of the
frame and th e text.

Figure 7.10 The Frame dialog box helps you control the location of a frame.

If you know that you eventually want to put a graphic in your document but you just wa nt
to insert a placeholder for now, you can insert an empty frame and use the frame as a placeholder. To insert an em pty frame, click in an empty paragraph and then choose Frame from
the Insert menu. The pointer turns into a crosshair. Use the crosshair pointer to drag out the
shape of the frame.

Making Things Overlap
To make items overlap, take adva ntage of Word's three layers. The layer that text usually goes
in is aptly named the text layer. Anything in the front drawing layer overlaps the text layer,
and th e text layer overlaps anything in the back drawing layer.
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Any item created by using the Drawing toolbar goes in to the fro nt drawing layer (and can
easily be moved into the back layer). So one way to make an item overlap the text layer is to
make it by using the Drawing toolbar (see Chapter 8). For example, you can create a special
effect by making a big gray oval and then move the oval into the back drawing layer so that
the text overlaps the oval.
If you have an item in the text layer (text, graphics, OLE objects, and so on), you can move the

item into either drawing layer and have it overlap other text. Here are the steps:
1. Select what you want to put in the drawing layer.

2. Cut or copy the selection.
3. Bring up the Drawing toolbar either by clicking the Picture button on th e Stan da rd
toolbar or by using the Toolbars command in the View menu.
4 . Click the Text Box button (on the Drawing toolbar). If you are not in Page Layout

View, Word reminds you to switch. The pointer should look like a crosshair.
5. With the crossh air pointer, drag out a text box. Make the box a good size for
holding the selection fro m step 1 (see Figure 7.11).
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Figure 7.11 Create a text box in a drawing layer so that text or graphics can overlap the text layer.
6. Paste the selection in to the text box.
7. You may need to adjust the text box before everything overlaps in the way you
want it to (see Chapter 8).

Creating a Table of Contents
To make a table of contents, you first mark text in yo ur documen t, and then you generate the
table of contents. The table of contents is based on the text that you mark in the documen t.
You can mark text for inclusion in the table of contents by applying a particular style or by
inserting a special field, called the TC field .
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Word automatically applies special styles to en tries in a table of contents, and the styles are
called TOC 1, TOC 2, TOC 3, and so on . The TOC styles correspond to levels of importance.
For example, the table of contents in Figure 7.12 shows two chapter titles, and those titles are
of level one importance. Because they are of level one importance, they are formatted with
TOC 1. Figure 7.12 also shows items of level two importance that are formatted with TOC 2. A
table of contents needs only one level of importance, and if that's all you have, don't worry
too much about levels.
Recipe oook
ulck and Easy OesS<rts

Main headings in
the table of contents
are formatted with
the TOC 1 style.

Quid< Ch..,• Cab oooooooooooooooo oooooooooooooooooooooooooooooooooooooooooooooooo oooooooooooooooooooooooooooooooooo2
HuwnJy Coolcie 8w oooooooooooooooo00oooooooooooooooooooooooooooo oooo oooooooooooooooooooooooooooooooooooooooooooo 4

J<U. Soled

00 00 00 0000 00000000 0000 00 00 00 00 00 00 00 00 00 00 00 0000 00 00 0000000000 00 00 00 00 00 00 00 00000000 00 00 00 00000000 0000 00 00 0000 0 5
G-ordon't Am~W=ill!. Chocolate PM ,,,,,,,, ............................................. ,................ ....... 6
Rlubub C•up .. oooo oooooooooooooooo ...... oo .. oooo .... oo .......... oooooo oooooooooooooooo . . . . oooo oooooooooo oooooo . . . . . . . ?

Cmdy!i.apunnH ,,,,,,,,,,, .. ,,,,,,,,,,,,,,,,,.,, .... ...,..... ,,,,,,,,,,,,,,,,,,,,,,, ............. ,,,,,,,,,,, ........ 8
b!Wiin ldednou oo oooooooooooooooooooooooooooooooooooooooo oo oooooooooooooooooooooooooooooooo oooooooooo oo . . . . . . . . oooo . .9

Second-level
headings are
formatted with
the TOC 2 style.

Figure 7.12 A table of contents can have levels, and Word uses a TOC style to format each level.

Marking entries
Word understands three different techniques for ma rking text for a table of contents. You can
mix and match methods, or you can use the same technique for the entire document. The
easiest technique is to use the heading styles built into Word, but you can also use your own
paragraph styles or insert a TC field. If you use styles, you end up putting complete paragraphs
(usually topic headings) into the table of contents, so if you need to mark less than a paragraph, use a TC field.

Marking entries with st yles
To mark an entry by using a style, click in the paragraph that you want to mark as an entry
and then apply the sty le. Use the same style for all entries that go with the same level of
importance. In ge neral, use the built-in heading styles-format level one text with Heading 1,
level two text with Heading 2, and so on (see Figure 7.13). If a style (such as Heading 1) isn't
available from the Style menu on the Formatting toolbar, press Shift while popping up the
menu.
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Main h eadings in the document are
fo rmatted with Heading 1; they map to
TOC 1-formatted table of contents entries.
•r
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Figure 7.13 The table of contents in Figure 7.12 came from text formatted with built-in heading
styles.

Marking entries with TC fields
To set up a TC field, follow these steps.
1. Highlight the text that you want to mark.

2. Press ~ - Sh i ft-Option-0 (that's an "oh ," not a zero). The Mark Table of Contents
Entry dialog box appears (see Figure 7.14).
Mork Tobie or Con Ients Enlry
Entry: !pollution

In most cases,
leave the
identifier set at C.
Enter a level
for the entry.

Tobie ldo ntffior·

c:=E

level:

~

.

+

Mart

(
[

Cancel

llolp

I
)
)

..
E.colo!l~ Report
Iii[
Now·that wa·havo examlned·tho·problem ofpopu tion ·derulty, we·move on - ~
to dis<USS pollution.'II
Bl
!!11':9

I

Highligh t the text
that you wan t in the
table of contents.

The highlighted text
should show here;
ch ange it if you want
the table of contents
entry to be different
from the text in the
document.

Click the Mark
button to insert
the TC field.

Figure 7.14 To make a table of contents entry without using a paragraph style, use the Mark Table
of Contents Entry dialog box.

3. If necessary, change the entry level.
4. In most cases, leave the identifier set at C. (C stands for "contents" in table of
contents.)
S. Click the Mark button. The dialog box remains open and a TC field appears in the
document (see Figure 7.15).
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6. If you want to insert more TC fields, leave the dialog box open and continue
selecting text and marking it.
7. After you finish, click the Close button.
The result of a TC field may display as nothing at all. If you want to see the TC field as a code,
note that the code displays in hidden text.
\I "1" means the entry
goes with level one.

The field
name is

TC.~~~~~~~~~~§j~~~~~~~~~~~~
Plil
Ecology Rqporl
1111
Now·thot·we have exopuned the problem,P,f·populatJon denolty, we move on· !jt
to dlscuss·pollutlon(.T.I;;..~ p.~!).\f!.!~~:.:\f<';..~L:.1.:.J. q
li

_miJ

-0 1 ~ 1~1 ·

I
The table of
contents entry is
"poll ution."

I
\f C mea ns the entry will go in the table
of contents (not in some other table,
such as a table of figures).

Rgure 7.15 The result of a TC field shows coded information about the field.

Generating a table of contents
You can generate a table of contents at any time, so feel free to try an experimental table of
contents after marking only a few entries. Here are the steps:
1. Position the insertio n point where you want the table of contents to appear.

2. From the Insert menu, choose Index and Tables and then select the Table of
Contents card.
3. If you used the built-in heading styles to mark all the table of contents entries, skip
ahead to step 7. Otherwise, click the Options button to open the Table of Contents
Options dialog box (see Figure 7.16).

Fi ll in the TOC Level
for styles used to
mark entries.

Tcbl e of Contents Options
Bu1td Tobie of Content• f rom:
18]Styles
AYotloblo Stylos:
C.pllon
•
•

If you used TC fields to mark entries, turn
on the Table Entry
Fields check box.

Rgure 7.16

n

~

HeodlnQ 1
HeodiOQ z
HeodiOQ 3

~
r- r[
1

TOC Lovtl:
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z

R..et

I

Help

I

-

HeodlnQ 4

~

HoediOQ 5

ll:iJ Toblo Entry Field>

Indicate how Word shou ld look for table of contents entries.
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4. If you used styles to mark table of contents entries, turn on the Styles check box
and use the scroll bar to find the styles that you used . For each style that you used,
type a number to indicate the level it should map to.
5. If you used any TC fields to mark entries, turn on the Table Entry Fields check box.
6. Click the OK button to retu rn to the Table of Contents card (see Figure 7.17).
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should appear in the table of
conten ts and whether they should
right align .

Figure 7.17
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If the table of contents has rightaligned page numbers, choose a
leader to separate entries from page
numbers.

Use the Table of Contents card to format and preview a table of contents.

7. To make page numbers appear in the table of contents, turn o n the Show Page
Numbers check box. To righ t align the page numbers, turn on Right Align Page
Numbers. Finally, choose a tab leader.
8. Indicate how many levels you want in the table of contents. For example, if you
used Heading styles 1-5 for your document, but you want only the first two levels
to appear in the table of contents, enter 2 in the Show Levels box.
9. Pick a format. If you don 't li ke the suggested formats, select Custom Style and then
click the Modify button. If you click the Modify button, Word switches you into a
special version of the Style dialog box, where you can m odify any of the TOC styles
(see Chapter 5).
10. Click the OK butto n .
Wo rd churns through the document, finds the marked entries, and creates a TOC field. If you
have the resul t showing for the field, you see a table of contents.

184

Chapter 7

Adding Different Elements

Updating a table of contents
To update the table of contents, update the TOC field. Updating the TOC field works much
like updating any field-you click in the field and then press F9 (or Control-click to use the
shortcut menu). Most fields update without asking you any question s, but the TOC field puts
up a dialog box asking what exactly it should update (see Figure 7.18). Just update the page
numbers if you haven 't added or removed any entries.
Updote Tobie of Contents
Word I• updati ng the toble or content>. Select one
orthe follovlllQ option•·
@Updale PoQe Humber> Onl ~
QUpclala Entire Tabla

Figure 7.1.8

~
~
llelp

A dialog box appears when you update the TOC field.

Making Footnotes and Endnotes
Word takes a lot of the pain out of making footnotes and endnotes by handling the numbering and positioning for you. Word thinks of footnotes and endnotes as separate entities.
Footnotes appear on the page you reference them on, but endnotes appear at the end of the
document or at the end of each section . You can use only footnotes, only endnotes, or both.

Inserting a footnote or endnote
To create a footnote or an endnote, follow these steps:
1. Position the insertion point where you wa nt the reference mark to appear in the
text. If you know that the options in the Footnote and Endnote dialog box are

correct, you can insert a footnote by pressing :l:C-Option-F. To insert an endnote,
press :l:C-Option-E.
2. From the Insert menu, choose Footnote. The Footnote and Endnote dialog box
appears (see Figure 7.19).
3. Indicate wh ether you wan t to insert a foo tnote or endnote.
4. The position in which the n ote will insert shows on the right side of the Insert
area . To change the position, click the Options button to open the Note Options
dialog box and select a card (All Footnotes for footnotes; All Endnotes for
endnotes). In the card, choose a position from the Place At menu and click the
OK button (see Figu re 7.20).
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Word sh ows where the footnote
or endn ote will be placed.
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Figure 7 .1.9
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Figure 7.20

Use the Note Options dialog box to customize footnotes and endnotes.

5. Select how you want the foo tnote o r endno te to be numbered:

+

If yo u want Word to handle the numbering an d renumbering, select
AutoN umber. You can custom ize the way AutoNumber wo rks by clicking
the Options butto n, which brings up the Note Optio ns dialog box (see
Figure 7.20).

+

1f you select Custom Mark, you must handle the numbering yourself, so
select Custom Mark at your own risk. The AutoNumber choices include
alphabetic ch aracters and special m arks, such as the asterisk, dagger, doubledagger, and so o n. If yo u select Custo m Mark, enter the mark you want to
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use. If you h ave trouble typing the mark, click the Symbol button to jump
into the Symbol dialog box. In the Symbol dialog box, double-click the
character that you want to use.
6. Click the OK button . Word shows a split window with two panes. In the lower
pane, you should see the insertion point flashing directly after a new reference
mark (see Figure 7.21). (If Word does not show a split screen, it's okay. You aren' t
seeing a split because you are in Page Layout View.) In the split window view of the
notes, use the menu at the top of the note pane to switch between viewing footnotes and endnotes.
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document text and one
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Enter the text of a note in the note pane.

7. Type the note text.
8. If you have a Close button, click it. (If you are in Page Layout View, you won't
have a Close button; instead, just scroll up or down to continue worki ng on the
document.)
To make two reference marks in the main text of the document correspond to one reference
note, set up one reference mark and note normally and th t!n use the Cross-reference command
to set up the second mark (flip ahead a few pages to find out how).

Deleting a note
To delete a note, highlight the reference mark as it appears in the regular document text and
cut the mark. After you cut the mark, the entire note disappears.
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Formatting reference marks and notes
You can format reference marks and text just like any other bits of text, but to globally change
them, modify the appropriate character style-Endnote Reference o r Footnote Reference.
Similarly, note text has th e following character styles-Endnote Text o r Footnote Text. See
Chapter 5 for help with styles.

Editing an existing note
In Page Layout View, you can edit notes directly on the page. The notes don't show in Normal
View, but you can split the window and show the notes at the bottom by choosing Footnotes
fro m the View menu. If you become involved in editing notes, try these tips:
• To switch to the text of a note, do uble-click the reference mark in the main part of
the document.
• To move the insertio n point to the spot after a reference mark in the main part of
the document, double-click the corresponding reference mark in the note area.

Numbering Figures, Tables, and So On
Word comes with a captioning fea ture that helps you number a series of items (such as tables,
drawings, or equations) thro ugho ut a document (see Figure 7.22).

Figure 7.22

Word makes captions for special document elements, such as tables.

Word helps with making captions in three main ways:
•

Word keeps track of captio n numbering so that you do not need to go back and
redo numbers by hand, even if you insert items nonsequentially.

•

The AutoCaptio n feature can automatically insert captions.

•

Word can number more than o ne series of items in a document. For example, you
can number tables as o ne series and figures as a separate seri es. Different labels
(such as Table and Figure) distinguish each series.

188

Chapter 7

Adding Different Elements

Inserting a caption by hand
To insert a caption, follow these steps:
1. Select the item that you want to caption.

2. From the Insert menu, choose Caption. The Caption dialog box appears (see Figure
7.23) and shows a proposed caption at the upper left. The proposed caption has a
label and a number.
You can make a
caption more l
descriptive by typing
after the number.
Select a label.
Click the Numbering
button to change the
numbering scneme.

Figure 7.23
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Use the Caption dialog box to set up a label and numbering scheme for a series
of captions.

3. To change the proposed label, select a label or create your own label by clicking the
New Label button.
4. To change the numbering, click the Numbering butto n. In the Caption Nu mbering
dialog box, select a scheme fro m the Format menu. If you decide to include the
chapter number, you must have the chapter number set up with the Heading
Numbering command (see ChapterS fo r more informatio n). When you finish the
nu mbering setup, click the OK button.
S. In the Caption d ialog box, click the OK button to insert th e caption.
The caption shou ld appear. If you have field codes showing, the caption appears as an SEQ
field.

Making Word autom atically insert captions
To make Word do mo re of the captio ning work, use AutoCaptio n. AutoCaption doesn't
retroactively put captions in a document, but it does add captions as you insert new items.
Here are the steps for setting it up:
1. From the Insert menu, choose Caption. The Caption dia log box appears.

2. Click the AutoCaptio n button to bring up the AutoCaption d ialog box (see
Figure 7.24).
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Third, select the itemsthat you want labeled.

Add C.ptlon When l...rtl"'l:
E>c<tl Worbheel
Mlcrooon [qu.llon 2.0
Mlcr""'n Greph s.oChert
Mlcr""'n Movie
Mlcr""'n Voice Annotation
Mlcroson Word 6.0 Oocument

~

Position:

1

[

~:~~=~ ~:~ :~~~~~re

Options
u,.Lebel :

SlE
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Hel p

~
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)Table
)Belov Item

)

First, choose a
label.

)

Second, choose a
position for the label.

Figure 7.24

Use the AutoCaption dialog box to set up Word to insert captions automatically.

3. Select a label and a position for the caption. For example, to caption each table in
a document, you can select Table as the label and Above Item as the position.
4. Select the item (or items) that go with the label and position. For example, to
number tables, select the Microsoft Word 6.0 Table check box.
5. Click the OK button. In the future, after you insert an item that you selected in
step 4, Word inserts a caption with the correct label and number.
Word formats all ca ptions in the Caption paragraph style. If you don't like the formats in the
style, change them. Chapter 5 explains how.

Changing a used caption label
What if a document has a whole series of ca ptions, but the label or the numbering scheme (or
both) is wrong? If a set of captions all have the same label, you can change all the captions by
changi ng just one. Here are the steps:
1. In the document, highlight one of the captions that you need to change.

2. Go to the Insert menu and choose Caption. The Caption dialog box appears.
3. Correct the problem. It's okay to change the label and the numbering scheme.
4. Click the OK button. Word fixes all the caption s that have the same label as the
caption you clicked in step 1.
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Making Cross-References
Word has a handy cross-referencing feature that makes it easy to refer to topic h eadings,
captions, footnotes, and more. After you set up a cross-reference, Word h elps keep the crossreference up-to-date. Here are the steps:
1. Position the insertion point where you wa nt the cross-reference to begin.

2. From the Insert menu, choose Cross-reference. The Cross-reference dialog box
opens (see Figure 7.25).
Cross-re ference
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Select the basic type of
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rtgure 2: Nitrogen Somole•
rtguro 3: Argon Somp e>
rtouro 4: carbon Dioxide...

I asert

Cancel

101 (

llolp

f or Which caption:

::
0

Figure 7.25

I

jQI [

ll
l

l

IQj

lol

Select a specific
reference.
Word lists every elemen t
that matches the selected
reference type.

Use the Cross-reference dialog box to set up cross-references.

3. Select a reference type. Table 7.3 explains more about each reference type.
4. After you select a reference type, Word looks th rough the document for all instances of the chosen reference type and lists them at the lower right. Choose the
instance to which you want to r~ake a cross-referen ce.
5. From the Insert Reference To list, select the informa tion that you want to reference.
(You can come back right away and insert another piece of information, so don't
worry if you want to insert more than one piece.)
6. Click the Insert button. The cross-reference appea rs in the document, but the
dialog box stays open (in case you want to adjust the position of the insertion
point and then insert another cross-reference).
7. Click the Close button after you finjsh using the dialog box.
Be aware that cross-references are actually fields. If the fields cross-reference incorrectly or look
extremely strange, use techniques for working wi th fields to make them behave. Keep in mind
that cross-references update when you switch into Print Preview o r when you print.
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Table 7.3
Items That You Can Cross-Reference
Item in the Reference Type list

Information

Heading

A heading is any paragraph fo rmatted with one of the
built-in heading styles.

Bookmark

A bookmark refers to a chu nk of text that you have
marked and given a name.

Footnote and Endnote

Footnotes and endno tes are references set u p through the
Footnote command o n the Insert menu.

Equation, Figure, Table

These items refer to labels used in captio ns. You can find
o ut more about them a little earlier in this chapter.

Other

Anything else listed in the Reference Type list is a custom
label that you set up in th e Captio n dialog box.

Setting Up Hypertext Links
Hypertext links may sound like they are from th e moon (or perhaps an ivory tower), but you
can set up links within d ocuments that make it easy to jump from one location to another. For
example, if people will be reading your Word document online, you may want to put in a few
li nks that let readers jump directly from the table of contents to the ma in topic headings.
Recently, hypertext links have received a lot of press-they are the way people move around
on the World-Wide Web, an extremely popular way to use the Internet. If you are reading this
section because you want to know how Word can help you make documents for displaying on
the Web (such as a home page), flip to the section on conversions in Chapter 1.
Hypertext links can use two different fields:

+

The GoToButton field lets you jump to any bookmark, a mark that helps you move
quickly to a desired location.

+

The MacroButton field lets you ru n any macro. You can set up macros to jump to
m any different document elements.

The GoToButton is easier to set up if you aren't particularly comfortable with macros, but the
MacroButton gives you m o re power and flexibility, and the macro isn't particularly difficult to
record.
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Setting up a GoToButton field
To create a GoToButto n field, follow these steps:
1. Insert a bookmark for the destination. To create a bookmark, select the text, go to

the Edit menu, and choose Bookmark. In the Bookmark dialog box, type a name
for the bookmark and then click the Add button.
2. Position the insertion point where you wa nt the hypertext link.
3. Go to the Insert menu and choose Field.
4. In the Field dia log box, select the Documen t Automation category and then select
the GoToButton field name.

5. Click the Options button. The Field Options dialog box opens (see Figure 7.26).
Fie ld Options
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Figure 7 .26
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I

I

Add a bookmark and type the display text.

6. From the Bookmark Name list, select the bookmark to which you want to link.
7. Click the Add to Field button. The bookmark name ap pears in the text box toward
the bottom of the dia log box.
8. After the bookmark name, type U1e name that you want to appear on the butto n.
The name, called the "display text," will be the text that shows in the document.
9. Click the OK button to return to the Field dialog box and then click the OK button
to return to the document.
When the GoToB utton field displays its results, all you will see is the display text. Double-click
the display text to move to the bookmark.
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You can format the display text much as you wou ld format any other text in the document.
For exam ple, if the field is in a paragraph by itself, you can make it look mo re like a button by
putting a paragraph border around it (see Chapter 8 to find out about borders).

Setting up a MacroButton field
The steps for making a MacroButton field are virtually identica l to those for making a
GoToButton field. In the Fields d ialog box, select MacroButto n . In t he Field Options dialog
box, you may have to do a bit of scrolling to find your m acro.

Making an Index
To create an index, you must complete two main steps-first, marking the entries; and second,
generating the index. The entries get marked with a field called XE, and the index is a field
called INDEX. Table 7.4 shows the main possibilities for what entries can look like in the
actual index.

Table 7.4
Common Index Entries Used In Indexes
Entry

Comments

Apple, 4, 255

A basic entry in a run-in or inden ted index

Page Setup, 308

A basic entry with a bold page number

PowerBooks, 42-56

A basic index entry using a bookmark to set a page range

Dogcow. See Page Setup

A basic index entry with a cross-reference

Apple, 1-4, 5-255

A basic index entry that includes the chap ter number and the
page number

Apple
PowerBooks
Duo 230,44

A th ree-level entry in an indented index

Apple: PowerBooks;
Duo 230, 44

A th ree-level entry in a run-in index
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Marking index entries
Entries tell Word which info rmatio n and page numbers are put in the index. You can set them
up one at a time with no automatio n; o ne at a time but with a li ttle automation; or via a
concordance table, which lists all the information that you want Word to use.

Marking entries one at a time
To mark an entry, follow these steps:
1. Click on the page to which the entry corresponds o r select th e actual text that will

make up the entry.
2. From the Insert m enu, choose Index and Tables. In the resulting dialog box, click
the Mark Entry button or press ):(-Shi ft-Option-X to o pen the Mark Index Entry
dialog box (see Figure 7.27).
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t

tndtx tntriu:.

Select Page Range to
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a range of pages.

)
If you selected Page

Range, choose the
bool<mark that marks
the range.
Turn on Bold or
Ita lic as needed.

Mark text for inclusion in the index and indicate exactly what the index entry should
look like.

3. If you selected text in step 1, it shows in the Main Entry box. You can edit the
main entry text or type additional text.
4. To make a two-level entry, enter the second level in the subentry box. In the
unlikely circumstance that you need a third-level entry, type a colon after the
second-level entry a nd then type the third level.
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5. Select a reference optio n:

+

Cross-reference gives you a reference as shown in the fourth example in
Table 7.4 (the Dogcow). Type the text for the cross-reference in the Crossreferen ce box.

+

Current Page gives you a page number. The index uses the same numbering
scheme as the page numbers. (Chapter 5 explains how to change the page
numbering scheme.)

+

Page Range gives you a range of pages, such as the range shown in the fifth
example in Table 7.4. To indicate the correct page range, set up a bookmark
that spans the correct range. To create a bookmark, select the text, go to the
Edit menu, and choose Bookmark. In the Bookmark dialog box, type a name
for the bookmark and then click the Add butto n . After you have th e bookmark set up, you can choose it fro m the Bookmark menu in the Mark Index
Entry dialog box.

6. If you want the page number (or page range) to be in bold or italic, turn on the
corresponding check box at the bottom of the dialog box.
7. You are now read y to m ark the entry. You can mark o nly one entry (at the location
of the selection o r the insertion point) by clickin g the Mark button, or you can
mark all identical entries by clicking the Mark All butto n . If you choose to mark all
identical entries, Word marks the first identical entry in each paragraph .
8. The dialog box does not close (in case you want to mark more entries). Afte r you
finish marking entries, click the Close butto n.

Marking entries with a concordance file
If you have a lot of entries to mark, and if you want them to appear in the index with plain
text page numbers, you can type all the words in one document (called a concordance file) and
then use the AutoMark feature to mark all the entries.
To set up the concordance file, follow these steps:
1. Press j:C-N to start a new document based o n the Normal template.

2. In the first line of the document, type the fi rst word o r phrase that you want to
index. Word matches this word or phrase exactly to the text in the documents that
you mark, so be extra careful with spelling and punctuation.
3. Under normal circumstances, when Word processes the concordance file you are
creating, Word takes the text that you typed in step 2, marks it in the document,
and includes it in the index. If you don't want the exact sam e text to end up in the
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index, press Tab, and then type the text that you want in the index. For example,
you may want chocolate and Chocolate to be indexed as Chocolate.
4. Press Return.
5. Continue steps 2 through 4 until you have entered all the text. You don't need to
press Return after entering the last line of text.
6. Save the fil e just as you would save any other file.
To use the concordance file for marking tex t, follow these steps:
1. In the document that you want to index, go to the Insert menu, choose Index and

Tables, and then select the Index card.
2. On the right side of the Index card, click the AutoMark button. The Open dialog
box appears.
3. Locate and open the concordance file. Word searches the document for text that
matches the entries in the concordance file and marks the text that it finds as
index entries. If the same entry occurs more than once in the same paragraph,
Word marks only the first entry.

Viewing index entries
An index entry is actually an XE field, and it has two peculiarities:

+

Its code is the same as its result, so showing or hiding a code doesn't change its
appearance.

+

Word formats an XE field as hidden text, so you can't see it if you have the check
box for viewing hidden text turned off. (The check box is located in the View card
of the Options dialog box from the Tools menu.) The light gray underline beneath
the XE field is your clue that the field is formatted as hidden text.

Generating an index
If you have a few index entries marked, you can make an index. Here are the steps:
1. Position the insertion point at the spot where you want the index to begin.

2. Go to the Insert menu, choose Index and Tables, and select the Index card (see
Figure 7.28).
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Figure 7.28 Set up the basic formatting for the index.
3. Select an index type. For an inden ted index, you can right align the page numbers,
and if you right align the numbers, you can choose a tab leader for the page
numbers. Note that as you select different options, the Preview area shows what
they will look like in the index.
4. Select an index form at. If you do n't like any of the formats, select Custom Style
from the Formats Jist and click the Modify butto n. If you click the Modify button,
Word switches into the Style dialog box and lists the nine index styles. Index 1
corresponds to index entries that have no subentry. If you have subentries, and
you make an indented index, Index 1 corresponds to main entries, Index 2 to
second-level subentries, Index 3 to third level subentries, and so on.
5. Select the number of columns that you want the index to have. If the index is
supposed to have more than one column, you must be in Page Layout View or
Print Preview to see the multiple columns.
6. Click the OK button. Word churns through the document, looking for index
entries and incorporating them into the index.
The index appears as an INDEX field, and if you have the field result showing, you' ll see an
index. To update the index, click in the index and then press F9 (or Control-click the index
and choose Update Field from the shortcut menu).
You should now have a good understanding of how to insert special document elements such
as regular tables, tables of conten ts, cross-references, and captions. The next chapter explains
how to import and create graphics.
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Using Graphics
and Borders
This chapter fills you in on how to work with graphics and how to make borders. By graphics,
I mean pictures that you bring into Word o r create with the Drawing toolbar; by borders, I
mean straight lines that run along the edges of paragraphs. These two elements can really
add to the overall visual impact of your documents. Look for these topics to be covered in
this chapter:
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How Word Thinks About Graphics
How Word treats a graphic depends on which layer the graphic is in. Word has three layers: a
front d rawing layer, a text layer, and a back drawing layer. Think of the layers as three sheets
of clear plastic:

+
+
+

Items on the front drawing layer block items o n the other layers.
Items o n the text layer (such as text t~at you type) block items on the back layer.
Items on the back drawing layer fa ll behind items on the other layers.

For a graphic to overlap (or underlap) text, the graphic must be o n one of the drawing layers
(see Figure 8.1). For text to flow around the graphic, th e graphic must be on the text layer,
where you can frame it.
Headers and Footers also have layers, so you can create a watermark-a light-colored picture
that sits beneath the text of a document-by placing a graphic or a stylized bit of text in the
back drawing layer of the header or footer.

The black circle in
the front drawing
layer overlaps all
other layers.

-t--op-ntn~pnr~!-llldo~

:::.~~=~::~=~::::JI~~~~;t- The gray oval in the
back drawing layer
falls behind all
other layers.

Figure 8.1 Word has three layers-the front drawing layer, the text layer, and the back drawing layer.

The drawing layers
If you create a graphic by using Word's drawing tools, the graphic appears in the fron t draw-

ing layer, but you can move it to the text layer or to the back drawing layer. In Normal View,
shapes from the drawing layers don't appear. Switch to Page Layout View to see the shapes.
If you temporarily don't wa nt to see the shapes in Page Layout View, turn off the Drawings
check box on the View card in the Options dialog box fro m the Tools m enu.
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The text layer
Everything you create in Word fa lls on the text layer, except for graphics that you make by
using the Drawing toolbar. If you import a graphic, it imports into th e text layer. You can
leave it in the text layer o r switch it into a drawing layer.
The text layer treats graphics like big characters. For example, a 3-inch high graphic sits in the
regular text stream of a document just as a W wou ld if you formatted it to be 3 inches tall.
Whether you import graphics or create your own, you'll find them easier to work with if you
know a few basic techniques for handling graphics in the text layer:

+

If a graphic cuts off at th e top, you may have line spacing set too low. To change
the li ne spacing for a paragraph, select the paragraph and then choose Paragraph
from the Format menu. In the Paragraph dialog box, select the Indents and Spacing
card and choose Auto from the Line Spacing menu.

+

If a graphic appears as an empty box, you have Picture Placeholders turned on in
the View card of the Options dia log box. With Picture Placeholders on, imported
graphics and graphics in the text layer show as boxes. When graphics show as
boxes, scro lling past them should go faster.

+

To resize a graphic in the text layer, click an edge of the graphic. Clicking an edge
selects the graphic, and you should see selection hand les on the edges of the
graphic. To change the size o f the graph ic, drag one of the selection handles (see
Figure 8.2). To crop the graphic, Shift-drag a handle. To undo any cropping and
scaling, ~ -doubl e-cli ck on the graphic.

+

To more precisely crop or scale a graphic, select the graphic, go to the format
menu, and choose Picture.
Drag the top handle to
change the height.
Creotlue Wrltln

Drag a corner handle to
resize proportionally.'

Figure 8.2

'lou.and t a.nd Swalked dO'I'YI'I to t..ht •h tt to bur the sil M'It JO&Jof thewavu
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Use the selection handles to resize a graphic in the text layer.
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+

To position a graphic in a specific location in the text layer, set up a table or a
frame. If you set up a table, you can put the graphic in one cell and then place
related text in a different cell.

+

To edit a graphic in the text layer, you must double-click the graphic. A Picture
window opens, and the graphic appears with a boundary line around it (see Figure
8.3). Use the Drawing toolbar to edit the graphic (look ahead a few pages to learn
more about the Drawing toolbar). When you are ready to return to the text layer,
click th e Reset Picture Boundary button and then the Close Picture button (both
butto ns are on the Picture toolbar).

~~~~~g~~~~========t- Use the Picture toolbar
to reset the boundary
and to close the Picture
window.
Use the Drawing toolbar
to modify the graphic.

The boundary.

Figure 8.3

If you double-click a graphic in the text layer, a Picture window opens for editing the
graphic.

Importing Graphics
Wo rd has two techniques for bringing in graphics made in other programs-pasting and
converting. If you convert, you can completely convert the graphic, or .you can link to it so
that the graphic exists as a separate file and does not substantially increase the size of the
Word document.

•

Caution: Use linking with care until you are certain that it works well on your
Macintosh because linking requires a good deal of cooperation among
programs .

'
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Pasting
Because virtually every Macintosh graphics program supports the Cut, Copy, and Paste
commands, the trad itional method of moving graphics around is to cut, copy, and paste them.
In transferring the graphic through the Clipboard (which you must do in order to paste), the
graphic may lose a substantial portion of its quality. However, if you paste graphics from
PostScript-oriented programs (such as FreeHand or Illustrator), you can use a special trick to
preserve the quality. Here are the steps for pasting a graphic into Word:
1. Open the graphics file in an appropriate program (such as MacDraw, Super Paint,

Illustrator, o r Freehand).
2. Select the graphic.
3. From the Edit m enu, choose Copy (or press :l=C-C). If you are in a PostScript-based
program and want to include the underlying PostScript code with the screen
picture (so that you don 't lose an y quality in bringing the picture into Word), press
:l=C-Optio n-C to copy the graphic.
4. Open th e Wo rd document in which you want to paste the graphic and position the
insertio n point where you want the graphic to go.
5. From the Edit menu, choose Paste. You can also press :l=C-V o r click the Paste button
on the Standard too lbar.
The graphic appears in the text layer.

Converting
Word comes with gra phics that you can import fo r your own use. The clip art is in the fo lder,
called ClipArt, in which you installed Word. Word also comes with translators that can
convert EPS, TIFF, PICT, WPG, and PAINT fil es into the text layer of a Word document. To
convert a file, follow these steps:
1. Place the insertion point in the location where you want the graphic to appear.

2. From the Insert menu, choose Picture. A special Open dialog box appears (see
Figure 8.4).
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Figure 8 .4

The dialog box for converting a picture has a few special options.

3. To link to the graphic so that when the o riginal copy of the graphic changes, the
copy in the Word document changes as well, turn o n the Link to File check box.
Otherwise, turn off the check box.
4. If you link to the graphic, you don't have to store a copy of the graphic in the
Word document. By not storing the copy, you keep the file size of the document
more reasonable, but you slow things down because Word must access the original
file to show the graphic. (If Word can't find the g raphic file, it shows the last
known version of the graphic, and the graphic may not look that great when it
prints.)
5. Locate and open 'the graphic.
Word wi ll take a few mo m ents (or even minutes) to convert the graphic.
To bring a PostScript text file into Word, open it just as you would open any text file. After
you open the fi le and view the Pos tScript commands, if you wa nt to send the commands to a

PostScript printer and have the printer interpret them, you must put the commands in a Print
field (see Chapter 10).

Creating Your Own Graph ics
To create graphics in Word, use the buttons on the Drawing toolbar (see Figure 8.5) . The
buttons ena ble you to create shapes, and the shapes get placed in the fro nt drawing layer,
unless you are working in the Picture window.
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Word offers many methods for displaying the Drawing toolbar, so feel free to use whichever
method is easiest for you. Here are a few possibilities:

+

Click the Drawing button on the Standard toolbar (it looks like a collection of
shapes).

+
+

Control-click a toolbar to bring up the Toolbar shortcut menu and choose Drawing.
from the View menu, choose Toolbars. Turn on the Drawing check box and click
the OK button.

Make lines, boxes,
ovals, ci rcles, and arcs.
Draw text boxes and type
text in to them.
Make a nd format callout boxes.
Fill shapes and lines with shades
of gray or other colors.
Format lines.

Click here to turn the pointer
into the selection arrow.

Move shapes between the
front and back layers.
Move shapes behind and
in front of each other.
join separate shapes into one
grouped shape or split a grouped
shape into its separate parts.

Flip shapes.

Rotate shapes in 90-degree increments.

Modify a freeform shape.

Click here to set up the grid.

Align shapes with respect to a
grid, the page, or each other.
Move selected shapes into the text layer.

Move selected shapes into the text
layer and place a frame around them.

Figure 8 .5

The Drawing toolbar helps with creating graphics in the drawing layers or the Picture
window.

The Drawing toolbar offers tools for making basic shapes, wh ich you can color and combine to
create images. You can type text by creating a text box or a callout box and then typing inside
the box.
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To create a shape, click the corresponding button. Click where you want the shape to begin
and then drag out the shape. To make a regular shape, press Shift while you drag o ut
the shape. For example, to draw a circle, click the Ellipse button and then press Sh ift while
dragging.
If you double-click a shape button, you can draw more than one instance of the shape without

clicking the button again.
If you select the Freeform button and then start dragging, you can draw any shape. Dragging
works much like d rawing with a pencil. When you finish drawing the shape, double-click. To
make a freeform shape with straight edges (such as a star), click where you wa nt one edge to
start and then click where you want the edge to end. Continue clicking until you h ave drawn
all the edges. Double-dick to stop drawing the shape. You can also make a freeform shape
(such as an ice cream cone shape) with some edges straight and some drawn by hand.
After making a shape, you can change its appearance by selecting the shape and then doing
something to it.
Use the selection pointer to select a shape. The pointer looks like an arrow when it isn't over
a shape or a toolbar. To make sure that you have a selection pointer, click the Select Drawing
Object button. With the selection pointer, click on the shape. If you have trouble selecting a
shape, click on the edge of the shape. To select multiple shapes at once, press Shift while you
click on the shapes or drag out a selection box around the shapes. The selection box has a
dashed outline, sometimes referred to as "marching ants."
To format the edge or color of a shape, select the shape, go to the Format menu, and choose
Drawing Object. To open the Drawing Object dia log box, Control-click on a shape and choose
Format Drawing Object from the resul ting shortcut menu. The Fill and Line cards offer many
options for formatting shapes (sec Figure 8.6). If you open the Drawing Object dialog box
without selecting anything, any changes that you make become defaults for new shapes.

fill

Color:

'--~.:::.;=====i~~~~f- Click the Line tab to
view the Line card
and select fo rmats for
the edge of the shape.
1 - --

Select a color.

Figure 8 .6

---tfl-- Set up a pattern.

You can change the appearance of a shape in the Drawing Object dialog box.

206

Chapter 8

Graphics and Borders

Moving Text Between Layers
To move text from the text layer into one of the drawing layers, first h ighlight and cut the
text. Second, using the Drawing toolbar, insert a text box or a ca llout box. The box automatically goes into the front drawing layer. Finally, paste th e text into the box.
To move text from a drawing layer into the text layer, h ighligh t the text within its box, cut the
text, place the insertion point where you want the text to go, and then paste the text in place.

Moving Graphics Between Layers
To move a graph ic (such as an imported graph ic, a chart, o r a WordArt object) into a d rawing
layer, try these steps:
1. In the text laye r, select and cut the graph ic.

2. On the Drawing toolbar, click the Text Box butto n.
3. Drag out a text box. The inserti o n point should be inside the text box at the upper
left.
4. Paste the graphic into the text box. If necessary, resize the box to make the graphic
fit nicely (d rag a selection handle).
5. The text box (a nd hence the graphic) is in the front layer. If you want it in the back
layer, select the text box and cl ick the Send Behind Text button .
To move a graphic from a drawing layer into the text layer, select the g raphic and click the
Create Picture button o n the Drawing toolbar.

Aligning Shapes
To make the edges or centers of a few shapes line up (see Figure 8.7), use the Align Drawing
Objects button. Select the shapes and then click the button. In the resultin g Align dialog box,
select the appropriate options and click the OK butto n.
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Non•Ugn•d docl" . - -

Figure 8 . 7

@ 0

- --+- The same circles,
aligned to the center
horizontally and
vertica lly, with
respect to each other.

Use the Align dialog box to set up concentric circles.

How Word Moves Shapes for You
If you select a shape and have non printing characters showing, you should see an ancho r.
The ancho r does not mean that the shape has nautical yearnings; instead, it indicates that
the shape is attached to a particular paragraph (see Figure 8.8). If you move the paragraph
in the course of editing the docu ment, the shape moves along, as weH.

Theanchor.

Figure 8.8

J,

Each shape has an anchor.

Moving Shapes Within the Drawing Layer
You can move shapes visually by dragging them, or you can m ove them numerically by
entering measurements in the appropriate dialog box.
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Moving shapes by dragging
To move a shape, place the selection pointer (click the Select Drawing Objects button to get a
selection pointer) over the edge of the shape (but not over a selection handle) and then drag
the shape. Press Shift while moving a shape to move it only horizontally or vertically. If the
shape has a color or pattern filling it, you can also place the pointer over the shape's interior.
As you move shapes, the grid may affect the movement. The grid is an invisible cross-hatching
of lines (much like a window screen), which you can modify by clicking the Snap to Grid
button. In the Snap to Grid dialog box, you can set the spacing between the gridlines, and you
can activate the Snap to Grid option (see Figure 8.9).
Snop to Grid

Turn on Snap to Grid if
you want shapes to align
automatically to gridlines.
Set the space between
horizontal gridlines.

Figure 8.9

I

1sJsnop to Grid
Hor1zonte1Spect 1'1\1 =

OK

11

lor

Vcr l1ca1 SpoctnQ:

~~

Hortzontol Orlqt n:

10"

Vertlcol OriQin:

IO"

ltelp

f-----lt-'

~

Set the space between
vertical gridlines.
If you set both origins to
zero, the origin is at the
upper-left corner of the
page.

You can adjust how the grid works in the Snap to Grid dialog box.

With Snap to Grid on, shapes automatically line up with the gridlines. If you set the gridlines
farther apart than the defau lt (.1 inch) and move shapes with Snap to Grid on, you feel the
invisible gridlines attracting the shapes. To toggle Snap to Grid off or on while you move a
shape, press ~ while dragging the shape.
To "nudge" a shape over a small amount (approximately one point), press Option- arrow key.
The arrow key that you press determines the direction of the nudge. Or to move an object to
the next gridline in a particu lar direction, select the object and then press one of the arrow
keys.

Movi ng shapes numerically
To move a shape numerically, select the shape, go to the Format menu, and choose Drawing
Object. In the Drawing Object dialog box, select the Size and Position card. To quickly bring
up the Size and Position card, double-click the shape's anchor. Even though the shape is on
the drawing layer, you can position the shape with respect to items in the text layer. If you
enter a measurement for the horizon tal or vertical position, Word measures over from the top
or left edge of the item in the text layer that you choose in the From menu.
Each shape has an anchor, and if you turn on the Lock Anchor check box, the shape locks to
its paragraph and always stays on the same page as the paragraph.
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Creating Borders
The Drawing toolbar enables you to create boxes around paragraphs and to place lines on a
page. You can even use the Size and Position card in the Drawing Object dialog box to position a box or line with respect to a paragraph and to lock the box or line in place.
Word comes with a Borders and Shading dia log box and a Borders toolbar, which enable you
to make boxes and lines, called borders. Borders apply as a paragraph format, and can be
added to styles. Table 8.1 points out the key differences between using the Drawing toolbar
and using a border or some other m ethod for creating boxes and lines.

Table 8.1

Borders and Shading Versus the Drawing Toolbar
What you can do

Borders

Drawing too/bar

Box a word within
a longer paragraph.

Not possible.

Use a text box with a custom
line. If you want the word in
the text layer, turn the word
into a picture.

Box a paragraph.

Easy to do, easy to control.

Easy to do, not as easy to
control as you edit the
document.

Box pages.

You can box all the
paragraphs on a page,
but if you edit the page
so that the page breaks
move, you have to redo
the boxing.

Put a big box in one of the
drawing layers in the header.
Because the box is in the
header, it repeats on every
page.

Make vertical lines.

Border lines must be the
height of a paragraph
because a border-based
line is a paragraph format.
To make vertical lines
between snaking columns,
turn on the Line Between
check box in the Columns
dailog box.

Easy to make a line of any
height. Lines can be anywhere
on the page, and you can
customize them more fully.

Make horizontal lines.

Border lines go above or below
paragraphs. To underline a
blank that someone will write

Lines can be in any location .
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Whar you can do

Borders

Drawing too/bar

on later, set a tab with a line
leader. To underline text, highligh t the text and then apply
Underline th rough the Fon ts
dialog box or the Formatti ng
toolbar. You can also press :l=t:-U.
Add lines that run
along gridlines in a
table.

Easy.

Possible, but not nearly as
easy as using the borders and
shading m ethod.

Add boxing or
lines to a style.

Easy.

Not possible.

You can apply borders from the Paragrap h Borders and Sh ading d ialog box or from the Borders toolbar. To bring up the dia log box, choose Borders and Shading from the Format menu.
Common methods fo r bringing up the toolbar include clicking the Borders button on the far
right of the Formatting toolbar and choosing Borders from the Toolbar shortcut menu.
Figure 8.10 shows the Borders toolbar. To make your Borders toolbar look like the one in this
figure, make the toolbar buttons run horizontally across the scre~n, not vertically. See Chapter
3 fo r tips about positioning too lbars.
Choose a style
for a line or box.
1

Click to apply
inside borderl

11' :;;·~:"·' ,..,,

tll£i~(lifi,ldll 1t~",;~ "' '"'"'" "'~

Click these buttons to
apply top, bottom, left,
or right borders.

Figure 8.10

Click to remove
all bordersj

Click to
make a box.

Choose shading that
will go behind a
paragraph or table cell.

Use the Borders toolbar to make lines and boxes that work as paragraph formats or that
run along gridlines in a table.

Making horizontal lines between paragraphs
You can set up three different types of horizontal borders (see Figure 8.11).

+

An inside border goes between paragraphs that are both fo rmatted to have an
inside border.
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+

A top border sits above a group of paragraphs that are all formatted to have a top
border (or above one paragraph that is formatted to have a top border).

+

A bottom border goes below a group of paragraphs that are all formatted to have a
bottom border (or below just one paragraph that is formatted to have a bottom
border).
Plonl Core

JC

Jill

Dally Watering Reminder

..
..
.[lil

<(}-

Give the Spruce trees one bucket of wa ter each .
Split a bucket of water between the Holly tree and the Empress tree.
Spilt a bucltet of water among tho four tomato plants .
S~ra;t: the muobroom E tch with tho b""e until tho bo.rk chiEslook •~ked .

- It-- This list has a top border

] t:J

Ql!j

Plonl Care

Iii![

Dally Walerlng Reminder

.

Figure 8 .11.

and a bottom border.
~

f."§ ¢ 1[i]

..
..

p

~

~

Give the Spruce trees one bucket of water each.

f!r-- This list has inside borders

SpUt a bucket of water between the Holly tree o.nd the Em pre., tree.

between paragraphs.

Spilt a bucltet of water o.mong tbo four tomato plants.
Spray tbe muobroom patch with the booo until tho bo.rk chips look soaked.

~

QQ)

,m -:o <:>t '

Top, bottom, and inside borders behave differently.

Inside borders
In earlier versions of Word, paragraphs had to have the same indents for inside borders (also
called middle borders) to work out. In Word 6, you can have any indents that you want, but
each inside border will be the width of the paragraph beneath it. To make an inside border,
follow these steps:
1. Highlight the paragraphs that you want to border. You must highlight at least a

portion of each paragraph.
2. Display the Borders toolbar (as explained a page or so earlier).
2. On the Borders toolbar, first choose a border style (such as 3/4 pt) and then click
the Inside Border button.
3. To apply additional formatting (such as a color) to the border, choose Borders and
Shading from the Format menu and select the Borders card. You should see two
triangles pointing into the space between two greeked paragraphs-filler text that is
holding the place for real text-and a border separating the paragraphs. The triangles indicate that the inside border line is selected (see Figure 8.12).
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Porogroph Borders ond Shodlnll
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Click None to remove
the selected border.
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that the inside border
is selected.
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Click here to apply
an inside border.
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f rom Text:

r
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Hairline
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•

Auto

I

1

- - ---

-- -----

-

I
(

DK
Cancel

~

Sho"' Tool bor_-jllelp

1

! - If

you'd rather work with
the Borders toolbar, click
the Show Tool bar button.
Format the selected
border by selecting a line
style.

-----------

,....,

Enter how far the
selected border should
be from the text.

Figure 8.12

,

If you choose a color
from the menu, it applies
to the selected border.

Click between the greeked paragraphs to apply an inside border.

4. Because t h e inside border is selected, you ca n select formats, and they will apply to
the inside border.
5. Click the OK button after you fi nish setting up the border.
If yo u later want to ch a nge the style of the border, first select the paragraph s that t h e border
goes with. Second, ch oose a n ew style from t he pop-up menu on the Borders toolbar, and
fi n ally, click the Inside Borders button. If you need to c h ange the fo rmatting in a more
complicated way, you have to select the pa ragraphs a nd re-open t he Borders and Shading
dialog box.

Top and bottom borders
Making a top o r bottom border works much like making an inside border. Select the paragraph
or paragraphs in question and then choose a border style from the pop-up m enu on the Border
tool bar. After choosing a style, click the appropriate button on the Borders toolbar. You ca n
also use the Borders and Shading d ialog box to apply or cust omize top and bottom borders.
Top a nd bottom borders stretch between a paragraph's left and right indents. If you border an
empty paragraph, you can adj u st its indents without c h anging the width of any text-filled
paragraphs.
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Border Wisdom
A top or bottom border appJies to a group of paragraphs formatted to have such a border.
Watch out for inadvertently applying a top or bottom border to more paragraphs than you
originally intended because it can cause problems If you try to make more borders In the
document. Remember. if you are typing In a paragraph that has border formatting and
you press Return to make a new paragraph, the border formatting continues to the new
paragraph.
Just because a border is above the top or bottom of a paragraph does not make the border
a top or bottom border. It could be an inside border.

Making vertical lines next to paragraphs
To border th e side of a paragraph, use a vertical border. Creating vertical borders works m uch
like creating horizontal borders. First, select the paragraph (or paragraphs) that you want to
border. Second, choose a style from the menu on the Borders toolbar. Finally, click the Left or
Right Border button on the Borders toolbar. You can also use the Borders and Shading dialog
box to set up a vertical border.
To apply a vertical border in the Borders and Shading dialog box, click to the left or right of
the greeked text (see Figure 8.13). After you apply the border, triangles appear and point at the
border. The triangles indicate that the border is selected; if you select any of the border formats
in the dialog box, the formats apply to the selected border.
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Click here to apply a left border.

Figure 8.13

Click to the left of the greeked text to apply a left bord er.

214

Chapter 8

Graphics and Borders

Boxing paragraph edges
To put a box around a paragraph or a group of paragraphs, follow these steps:
1. Hig hlight the paragraph or paragraphs that you wa nt to box.

2. If you have the Borders tool bar showing, choose a border style from the pop-up
menu (such as 3/4 pt) and click the Outside Border button. To color the box or
add a shadow, choose Borders and Shad ing from the Format men u and select the
Borders card (see Figure 8.14).
Porogroph Bord ers and Shading
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norden

Select Box or Shadow.

~ ~~
None

Box

Shollw
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Border

The triangles in the Border
area indicate that all fou r
lines are selected.
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Enter how far the selected li nes
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Cancel

I
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If you'd rather work with
the Borders toolbar, click
the Show Tool bar
button.

Select a style to apply
to the selected lines.

---

Color:

Ill ~uto

If you choose a color from
the menu, it applies to the
selected lines.

Figure 8 .14 Select a box type f rom the Presets area and then format the box.
3. In the Presets area at the upper left, select Box or Shadow. A box appea rs around
the greeked text in the Border area. Triangles point to the four lines that make up
th e box, indicating that all four lines are selected.
4. Because all four Jines are selected, you can change their formatting by selecting any
of the different formats offered.
S. Click the OK butto n after you fi nish formatting the box.

Caution: When boxing a group of paragraphs, each paragraph in t he group

•

must have the same margins and indents. If they don't, you may end up
with more than one box or with three-sided boxes .

'
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Removi ng vertical and horizontal borders
To remove all borders from a paragraph, select the bordered paragraph and th en click the No
Border button on the Borders toolbar. If you don' t want to use the toolbar, choose Borders and
Shading from th e Format menu. Word displays the Paragraph Borders and Shading dialog box.
Select the Borders card and click None at the upper left in the Presets area. Finally, click the OK
button.
To remove some, but not all borders from a selected paragraph, display the Borders card in the
Paragraph Borders and Shading dialog box. Select the border that you wa nt to remove (so that
the selection triangles point to the border) and then select the None rad io button in the Line
area. Click the OK button after you finish.

Putting a sol id box behind a paragraph
To make a colored box behind a paragraph, you apply a Shading format. To shade a paragraph,
select the paragraph and choose a shading option fro m the Borders toolbar. If you don't want
to use the toolbar, or if you want to make a colored box, apply shading by choosing Borders
and Sh ading from the Format menu and selecting the Shading card (see Figure 8.15).
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fill
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remove shading.
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Figure 8.15
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Choose colors for
the foreground and
background.

Select a shading percentage and the colors to use for t he foreground and background.

In the Shad ing card, select the Custom option and then select a foregroun d percentage. If
necessary, change the colors used in the foreground and background. After you fin ish, click
the OK button.
To remove shading from a selected paragraph, go back to the Shading card, select the None
option at the upper left, and click th e OK button.
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Bordering and shading tables
When you apply borders and shading to tables, you can apply the formatting to any or all of
the following:

+
+
+

A paragraph within a table cell
An entire table cell
An entire table

Figure 8.16 shows how a table looks when formatted in different ways with a box border.
Paragraph borders stretch between left and
right indents; the ruler shows the indents for
the bordered paragraphj
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Figure 8 .16

The paragraph has a
box border.

o.
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Format only a paragraph, only a table cell, or only a table to achieve different effects.

The basic steps for applying borders and shading to table cells are almost exactly the same as
those for applying borders and shading to paragraphs, so flip back a few pages to find the
steps. When you app ly a border or shad ing within a table, it's impo rtant to high light only the
part of the table th at you wa nt to format. To display end-of-cell m arkers so that the selecting
process is easier, click the Show/Hide button on the Standard toolbar or turn on all nonprinting characters in the View card of the Options dialog box.

+

To fo rmat on ly a paragraph, select the entire paragraph, but do not select the entire
cell. Do not select the end-of-cell marker.

+

To format only a cell, select the entire cell, including the end-of-cell marker. You
can also select a group of cells and format them as a group.

+

To format the entire table, highlight the entire table (to highlight a table, press
Option and double-click the table).
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To apply complex bordering to a table, select the table and then choose Table AutoFormat
from the Table menu. If you aren't sure how to select inside a table, look for h elp in Chapter 7.
This concludes the information about Word that explains how to format documents, so
consider yourself over a big hurdle if you've absorbed the details offered in the past several
chapters. The next chapter explains how to personalize Word, an extremely worthwhile way to
spend a rainy friday afternoon .
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Customizing
Word
The information in this chapter explains how to personalize Word by using the Customize
dialog box and by creating shortcuts for yourself with macros. Because many of Word's
command assignments are essentially from Mars, it's well worth your time to use the Customize dialog box or to create macros to set up shortcuts for commands that you use often. You
can also customize the way that you change the fo nt, apply styles, run macros, and insert
AutoText entries. Specifically, here's what's covered :

Word 6

Part II

Customizing Keyboard Shortcuts
Custom keyboard shortcuts are a fantastic way to speed up the way yo u work with Word. A
little thought and creativity go a long way in setting up keyboard sh ortcuts, and the more
shortcuts that you set up, the mo re likely you'll be to use them to your advantage. If you thin k
that you may have trouble remembering your shortcuts, remember that the shortcuts also
show on menus. You can add commands to menus and use the menus as quick references.
To create a printout of all currently assigned keyboard shortcuts, go to the File menu and
choose Print. From the Print pop-up menu at the left, choose Key Assignments and then click
the Print button .
Caution: If you make more than a few customizing changes, be sure to back

•

up the template that stores the changes. If you want t o back up the
Normal template, you can find it in Word's Templates folder.

'

Adding a keyboard shortcut

•

'

Word has a special trick fo r assigning a keyboa rd sh ortcut to any command on a drop-down
menu. First, press :rt:-Option-+ (the plus sign on the numeric keypad). Second, with the pointer
that looks like the ~ symbol, choose the menu item. Word switches to the Keyboard card in
the Customize dialog box, where you can type the shortcut a nd click the Assign button.
In previous versions of Word, the ;):(-Option-= (equal sign) trick also enabled you to add
keyboard shortcuts to many items in dialog boxes; unfortuna tely Microsoft removed this
capability from Word 6.
To assign a keyboard shortcut to any command, use the Customize dialog box. Here are the
steps:
1. From the Tools menu, ch oose Customize. In the Customize dialog box, select the

Keyboard card (see Figure 9.1).
2. Select a category fro m the Categories list and then select a specific item to assign a
keyboard sh ortcut to. If you are assigning a shortcut to a style, note that the style
doesn't appear in the Styles list unless you have used the style to fo rmat text in
your document.
3. If the command h as a colon as its last character (such as the Color command in the
Format category), select a more refined version of the command from the menu
that appears at the lower right.
4. At the lower right, choose the template in which you wa nt to store the shortcut.
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5. Click in the Press New Shortcut Key text box.
6. Type the shortcut that you want to use. The shortcut should begin with Shift,
Command, Option, or Control, and it must include Command, Option, or Control. For example, Control-S and Control-Sh ift-S work as keyboard shortcuts, but
Shift-S does not. If the shortcut is already in use by a different command, Word
displays the command beneath the text box.
7. Click the Assign button.
Select a command.
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Use the Keyboard card to set up custom keyboard shortcuts.

Doubling Up Your Shortcut
You can set up double keyboard shortcuts by typing the shortcuts one after another in the
Press New Shortcut Key text box. For example, if you use the keyboard to change the font,
you can start every keyboard shortcut for changing the font wit h Controi-F and then double
the shortcut by adding the first character in the font's name. So the shortcut for Helvetica
would be Controi-F,H and the shortcut for Bookman would be Controi-F,B.
To enter t he Helvetica shortcut in the Press New Shortcut Key text box or to use it for real,
press Control-F. release all keys on the keyboard, and finally press H. The second part of
t he shortcut can be just a character or it can be Shift and a character.
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Removing a keyboard shortcut
To remove a keyboard shortcut from a particular command, you can, of course, just assign the
shortcut to some other command. But if that process doesn't work, select the command from
the Commands Jist in the Keyboard card and then click the Remove button. To go back to
Word's defaults for every keyboard shortcut (on the Keyboard card), click the Reset All button.

Personalizing Drop-Down Menus
Drop-down menus drop down from the menu bar, and you can customize the menus in many
ways. You can make your own menus, delete menus, add commands to menus, remove
commands from menus, and so on. You can also add special commands, such as fonts and
AutoText entries.
If you don't know the name of a command, but you do know its keyboard shortcut, lise the
Keyboard card to find the command name. Click in the Press New Shortcut Key text box and
then type the shortcut. The command name appears below the text box.

Add ing a command or option to a menu
To add a command or option to a men u, try these steps:
1. From the Tools menu, choose Customize and then select the Menus card (see
Figure 9.2).
Select a command.
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Figure 9.2

You can add a command, macro, font, style, or AutoText entry to a menu.
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2. Select a category from the Categories list and then select the option that you want
to add to a menu.
3. If the command has a colon as its final character (such as the FontSize command in
the Format category), choose a more specific command from the menu that
appears at the lower right.
4. At the lower right, choose the template where you want to store the menu change.
S. Choose !"he menu. The menus ending with (No Document) are versions of the File
and Help menus t hat display only when no document windows are open . The
menus ending with (S hortcut) are the shortcut menus that appear when you
Control-click something. The ampersands (&) have nothing to do with adding
commands to menus. They indicate which key gets underlined if you press :t:e-Tab
in order to access the menus via the keyboard.
6. Choose a menu position. Auto means that Word puts the command in the location
that Word thinks is best.
7. Click the Add (or Add Below) button .

Removing a command or option from a menu
If a menu seems too cluttered with commands that you don 't use, or if you add commands to
a menu and then decide that you don't want them any more, you can remove them with a
keyboard shortcut or in the Customize dialog box.

The keyboard shortcut
To remove an item from a menu, press :t:e-Option-Hyphen. The pointer turns into a fat minus
sign. With the minus sign pointer, choose the menu item that you want to remove. If you
decide that you don't want to remove anything, press :t:e-Period to get rid of the minus sign
pointer.

The Customize dialog box
If you happen to be in the Customize dialog box, follow these steps to remove menu items:

1. Switch to the Menus card (see Figure 9.3).

2. Choose the menu that you wa nt to change.
3. Choose the menu item that you want to remove.
4. Click the Remove button.
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you want to remove.
Cu ~toml zo

I

Toolbors
Cotegorieo:

Choose the menu
from which you
wan t to remove
an item.

File

Edit

lvtw
ln,.rt
For mot
Tooh
Toblo

~

I-"

-&

t1enu1

Co mm•mb:
------ Se.,.retor ---- - fll eCl ooe
flleClo•tAII
FlleClo,.OrClo,.AII
FlloCon rl r mCo!Mirstons
rtl ollocumontlouout

(
(

!-""

Clo"'

ttol p

n Add Del oY

~

l

jr&or mot

1... 1

Position on Menu:

jstyle &Goller ~ ...

1... 1

Hamo on Menu:

j&Document Stotlstlco...

Dltpb1Js th• shtlstlcr of tht 10Hvt document

Ko~boord

l(!o

ChOOQOWhet Menu:

[? " crfption

Figure 9.3

T

I
I
II
Click the Remove
button to remove the
chosen menu item .

Remove

(Reset Ml •. )
(Menu Oor ... )

I
Seve Cho119e> 1n:
jHormol

j-..j

Use t he Menus card to remove an item from a menu.

Adding, renam ing, or removing a menu
In trying to win the award for the most flexible word processor ever, Word's designers added
the capability for add ing, ren aming, and removing menus. Use this capability with a wee bit
of caution-and practical jokers please be prepared to fix the menus that you customize. In
any event, to add, rename, or remove a menu, switch to the Menus card, click the Menu Bar
button, and then do the following:

+

To make a new menu, type its name in the Name on Menu Bar box. The menu
will appear to the right of the existing menu that you choose from the Position
on Menu Bar list. Finally, click the Add After button . If you select the Help menu,
Word adds the menu to the right of the Window menu.

+

To rename a menu, select the menu that you want to renam e and then type a
name for it. Click the Rename button.

+

To remove a menu, select it from the list of menus and then click Remove. You
cannot remove the Help menu. The Help menu is the question mark in a bubble
n ear the right edge of the menu bar.

Changes made to the men us don 't take effect until you close the Menu Bar and Customize
dialog boxes.
To change the complete menu setup back to the default, click the Reset All button in the
Menus card of the Customize dialog box.
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Customizing Toolbars
If you have a 16-inch screen, you may not care a lot about customizing your toolbars, but
people on PowerBooks and smaller screens probably have room for only on e or two toolbars at
a time, so it is important that the toolbars contain useful buttons. For example, a PowerBook
user can take the most useful buttons from the Formatting and Standard toolbars to make one
especially useful toolbar. Of course, different people have different ideas about what constitutes a useful toolbar, but Figure 9.4 shows one possibility.

Ii!JZH-J@J

INonnol

Figure 9.4 You can easily create a custom toolbar.

Word doesn' t come with a Font menu on the menu bar, but you can add one with the help of
a special (and easy!) macro. From the File menu, choose Open. In the Open dialog box, switch
to the Macros folder and then open a document called 5.1 Upgrade. Follow the directions in
the document to view the 5.1 Upgrade toolbar and then click the Add Font menu button.

Making a new tool bar
To make a new toolbar, press Option while you drag a button off an existing toolbar, or follow
these steps:
1. From the View menu, choose Toolbars. Word open s the Toolbars dialog box.

2. In the Toolbars dialog box, click the New button. The New Toolbar dialog box
appears (see Figure 9.5).
New Toolbnr
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nts:....:(.:...:
Noc..:
rm:.:.:
• l:..:..)_
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Figure 9.5 Type a name for the new toolbar.

3. Enter a name for the new toolbar.
4. Choose the template that you want the toolba r to go with. (Choose Normal to
make the toolbar available in all documents.)
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5. Click the OK button. The Customize dialog box opens with the Toolbars card
showing.
6. You can drag any button to the new toolbar, either from the dialog box or by
dragging the button from another toolbar. As long as you keep the Customize
dialog box open, you can just drag the button, but if you close the Customize
dialog box, you must ~-drag buttons. To find out more about dragging buttons
from the dia log box, read the next set of steps.

Moving buttons
To move buttons within a toolbar or from one toolbar to another, press ~and drag the
buttons about. To copy a button instead of moving it, press Option while you drag it. To move
buttons that are not on a toolbar or to make a button for a style, font, macro, or AutoText
entry, follow these steps:
1. Choose Customize from the Tools menu and select the Toolbars card.

2. Select a category. For example, to make a button for a style, select the Styles
category. Or to make a button that adds the numbers in a table row or column,
select the Table category (see Figure 9.6).
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Figure 9.6 Select t he button that you want to move.

3. Select the button or command that you want to move or to make a button for.
4. Drag the button or command to the location of your choice on a toolbar.
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5. If the command (such as a style) doesn' t already have an associated button, Word
opens the Custom Button dialog box (see Figure 9.7).
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Figure 9. 7 Select a graphic button or type a label for a text button.
6. Select a button or click the Edit button:

+
+

To make a text button, enter a na me fo r the button and click the Assign button.

+

To chan ge one of the predrawn buttons, select the button.an cl click the
Edit button.

+

To create your own button from scratch, don' t select any predrawn buttons.
Click the Edit button. (To deselect any selected predrawn button, click the
Text Button button.)

To use one of the predrawn buttons, select the button and click the
Assign button.

7. If you clicked th e Assign button, you should see the button on the toolbar, and
you can skip the rest of these steps. If you clicked the Edit button, a box appears
onscreen where you can edit the toolbar picture (see Figure 9.8).

+

To change the butto n, click a color that you wan t to use. Then click on
boxes in the Picture area. The boxes should take on the color that you
clicked. You can click on blank or colored boxes.

+

To erase boxes, turn the pointer into an erasing tool by clicking the Erase
box. You can also click the Clear button to delete everything in the picture
and start again .

+

The arrow button s in the Move area enable you to move the en tire image in
a particular d irection . If an arrow is dim, you can 't move the image in that
di rection .

8. After you fin ish changing the picture, click the OK button .
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Select a color to draw in that color.
Picture

Click a box in the
Picture area to draw
with the selected color.

leoo·o o

o•••
••••
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Preview doesn't quite
work- it's not you.

A dim arrow means that -H"-t-ir:U~
you can't move the
picture in that direction.

Click an arrow to move the
entire picture in that direction.

Figure 9.8 Click in the Picture area to change the button pictu re.

Modifying buttons
To change the appeara nce of an existing button, yo u must h ave the button and the Toolbars
card in the Customize dia log box showing. With both of them showing, Control-click the
button that you want to change to get a special shortcut menu (see Figure 9.9). What to do
next depends on what you want to do:
• To change the button's image to one that you create, choose Edit Button Image.
Read the preceding section to find out how to edit the button's picture.
•

To change the button's image to a different premade picture, select the Choose
Button Image command. Word responds by displaying the Custom Button dialog
box. Select a button and then click the Assign button.
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Control-click the button that you want to change.

Removing a button
To remove a button from a toolbar, press :Fe while dragging the button over a document
window. If you have the Toolbars card on the Customize dialog box open, you need not
press :l=e-just drag the button off the toolbar.
Caution: If you delete a custom button, you can't get it back. To keep the

'
•

button around, move it to a cu stom toolbar or a tool bar that you use
infrequently.

Renaming a custom toolbar

•

'

To rename a custom toolbar, open the Organizer dialog box. To get to this dialog box, choose
Templates from the File menu and then click the Organizer button. In the Organizer dialog
box, select the Toolbars card and then select the custom toolbar fro m the list on the left. Click
the Rename button. A thi rd dialog box, the Rename dialog box, appears (see Figure 9.10). Type
a new name for the toolbar and click the OK button. Click the Close button to exit the
Orga ni zer dialog box.
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Figure 9.10 Type a new name for the custom toolbar.

Removing a custom toolbar
To remove a custom toolbar, go to the View menu and choose Toolbars. In the resulting
Too lbars dial og box, select the toolbar that you want to delete and then click the Delete
button.

Returning a built-in tool bar to its default setup
To return a built-in too lbar to its standard button arrangement, go to the View menu and
choose Toolbars. The Toolbars dialog box should appear onscreen . In the dialog box, select
the toolbar that you want to reset and then click th e Reset button.
Word brings up the Reset Tool bar dialog box, asking for which template you want to make the
change. To make the change apply in all documents, select All Documents (Normal). Click the
OK button to exit the d ialog box.

What's a Macro?
Macros are commands that you create yourself, and they make using Word more efficient by
combining a sequence of commands into one.
A few examples of when to use macros include the following:

+

If you frequently receive d ocuments from other people, and you use the Replace

dialog box to search for and fix commo n erro rs, you can chai n together a series of
Replace o perations in a macro instead. If you then assign the macro to a toolbar
button, you can just click the butto n and go have an espresso wh ile Word does the
work.

+

If you freq uently show and hide toolbars, you can make macros that do the showing and h iding and assign a keyboard shortcut to them. For example, you can make
Control-F show the Formatting toolbar and Controi-Shift-F hide it.

+

If you have a favorite custo m border that you create over and over in different
documents, use a macro instead. You can assign the m acro a keyboard shortcut
(such as Control-B) and then press Control-B to apply the border.
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How Word Thinks About Macros
From Word's point of view, a macro is a script, a series of programming commands that tells
Word what to do. For example, the script for adding a thick, blue border to the top of a
selection looks like this in Word:

Sub MAIN
FormatBordersAndShading
.ApplyTo = 0,
. Shadow = 0,
.TopBorder = 6,
. LeftBorder = 0,
. Bo t tomBorder = 0,
. RightBorder = 0,
.HorizBorder = 0,
.VertBorder = 0,
.TopColor = 2,
. LeftColor = 0,
. BottomColor = 0,
.RightColor = 0,
.HorizColor = 0,
. VertColor = 0,
.FromText = "6 pt",
.Shading = 0,
.Foreground 0,
.Background = 0,
. Tab = "0 ",
.FineShading = - 1
End Sub
You can make this script by telling Word to record it while you open the Borders dialog box
and select options for the border (it's easy, and you find out how to do this later in the
chapter). You can give the script a name (such as BigBorder) and stick it on a menu, give it a
keyboard shortcut, or put it on a toolbar button. After you make a macro, the macro acts just
like any other command.
Although most people will never go further with macros than recording simple ones, you can
go much, much further. You don't have to record a macro; instead, you can type it by hand
(or you can partially reco rd a macro and partially type it). If you type macros, you can use
programming constructs, such as loops, and you can even create your own dialog boxes.
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Recording a Macro
To record a macro, you must first tell Word that you have begun recording and then do
whatever task you want Word to mimic later.
A particularly useful set of macros that you can record would be a set that automates turning
on and off fractional widths. Text onscreen tends to look a little blurry with fractional widths
turned on, but printed text tends to look especially well spaced when printed with fractional
widths on. (If you are curious, look in Chapter 10 to find out more about fractional widths.)
Use the following steps as a general example of how recording a macro works and as a specific
example for making a macro to turn on fractional widths. (These steps assume that you currently have fractional widths turned off; to check, look on the Print card in the Options dialog
box from the Tools menu.)
1. From the Tools menu, choose Macro. The Macro dialog box appears. Or as a
shortcut to begin recording a macro, double-click REC on the status bar (doubleclick REC again to stop recording).
2. Click the Record button. Word displays the Record Macro dialog box (see Figure
9.11).
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1.,.1
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I

Click to assign a keyboard
shortcut to the macro.
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on a drop-down menu.

- Choose the template that
will store the new macro.

Figure 9 .1.1 Type a name for the macro and select whether you want to run it by using a toolbar
button, a drop-down menu, or a keyboard shortcut.

3. Type a name for the macro. In this case, call it "FractionaiWidthsO n."
4. Select the template that will store the macro. To make the macro available in all
documents, select All Documents (Normal).
S. Although it's not necessary, you can type a short description of the macro in the
Description box. Press Shift-Enter to move to a new line in the Description box.
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6. Click the appropriate button to assign the macro to a toolbar, menu, or keyboard
shortcut. Word switches you into the Customize dialog box. Follow the directions
in the Customize dialog box to set up the toolbar button, menu option, or keyboard shortcut. Click the Close button after you finish.
7. Word displays a two-button toolbar called the Macro Record Toolbar (see Figure
9.12). Word is watching you and recording your every action.

To temporarily stop recording a macro, click the Pause button on the Macro Record
toolbar. Click the button again to resume recording. To select text while recording,
use the keyboard.
Click the Stop-c==;=~:t__ Click the Pause
button to stop
button to pause
recording a macro.
recording a macro.

Figure 9.12 Use the Macro Record tool bar to pause and stop macro recording.

8. Go to the Tools menu and choose Options. When the Options dialog box opens,
click the General tab.
9. Turn on the Fractional Widths check box.
10. Click the OK button.
11. On the Macro Record toolbar, click the Stop button.

Turn off fractiona l widths and try running the macro. Text onscreen should look fuzzier with
fractional widths on; the Helvetica font shows this problem especially well. Of course, you can
also make a macro to turn off fractional widths.
If you open the Macro dialog box again, you see the new macro in the list of macros. If you
select the new macro and click the Edit button, you can see the WordBasic script that Word
wrote for you.

Deleting a Macro
If you have a macro that doesn't work or that you never use, you can delete it. Macros get

stored in individual documents or in templates, so if you just don't want a macro in a document, delete it from the document. If you want the macro out of a template so that it doesn't
show up again in future documents, you must delete it from the template. Here are some steps
to try:
1. To delete a macro from a document, open the document in question and then go

to the Tools menu and choose Macro.
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2. In the resul ting Macro dialog box, select the macro that you want to remove and
then click the Delete button.
3. When Word checks to be sure that you want to delete the macro, click the Yes
button. The macro disappears from you r document, but it is most likely still stored
in a template.
4. If you don't want to remove the macro from the template, click the Close button.
You are finished! If you want to remove your macro from a template, however, stay
in the Macro dialog box and click the Organizer button.
S. The Organizer dialog box has two menus labeled Macros Available In. It doesn't
matter which men u you use, but do use one of them to choose the template tha t
holds your macro.
6. After you choose a template, Word lists the macros in that template. (Look in the
list above the Macros Available In menu.) Select the macro that you want to delete
and then click the Delete button.
7. When Word asks whether you really want to delete the macro, click the Yes
button.
8. finally, click the Close button to exit the Organizer dialog box. You have removed
the macro from the template, and it won't show up again in new documents based
on that template.

Sharing a Macro
To share a macro with a friend or co-worker, use the Organizer dialog box to move the macro
to a special template. You can move the template to your friend's machi ne and then show
your friend how to use the Orga nizer dialog box to move the macro to her Norma l template.

Making a template
If you don't already have a template to use for transferri ng the macro, follow these steps to
make a template:
1. From the File menu, choose New. The New dialog box appears.

2. In the New area (at the righ t), select Template.
3. Click the OK button, and a new template opens.
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Moving the macro
To move the macro to the transfer template, try these steps:
1. Choose Macro from the Tools menu.

2. Click the Organizer button. The Organizer dialog box appears, with the Macros
card in front (see Figure 9.13).
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IDescrtption
[

Click the Copy
button to copy the
macro .

bo•.

Ci ne

[

He I P
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macro.

Copy the macro to the transfer template.

3. Make one of the lists show the template that currently contains the macro that you
want to share. If you saved the macro in the Normal template, you may see the
macro on one of the lists, but if not, click the Close File button and then the Open
File button. A dialog box appears where you can open the template containing the
macro.
4. After you have the template containing the macro showing in o ne list, make the
other list display the transfe r template. If the transfer template isn 't showing, click
the Close File button and then click the Open File button. From the resulting Open
File dialog box, open the transfer template.
5. Select the macro.
6. Click the Copy butto n .
7. At the lower right, click the Close button.
8. If Word displays an alert message asking whether you want to save the changes to
the transfer template, click the Yes butto n (see Figure 9.14).
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Ji\ Do you vent to :.ave change.s to Macro Tren:sfer
i l l Template?
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y..,
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No

1(

Cancel
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Hcl p

Figure 9 .14 Click the Yes button to save the macro in the transfer template.

Now that the macro is in the transfer template, you can transfer the template to a different
Macintosh and then use the Organizer dialog box to move the macro to the Normal template
on that machine. You can also attach the transfer template so that it is available only some of
the time.
I hope that you have tried you r hand at setting up a few personalizations and macros so that
you have a good idea of how flexible Word can be. Now let's completely change the subject for
the next chapter, which explains how to create form letters and mailing labels and how to
merge documents.
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Letters for Mail Merges
If you need to make form letters or send a mass mailing with mass-produced envelopes or
labels, don't even think about doing it all by hand. After you figure out how to use mail
merge, you can save hours and hours of time. Then you can send 200 of your favorite friends
and family members that glorious holiday letter that they all look forward to receiving every
December-and you can even personalize it! As you can guess, the information here explains
the following:
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How to Set Up Form Letters
A mail merge enables you to make form letters and personalize each letter for its recipient. For
example, you can make those annoying letters that start out saying, "Dear Ms. Woosterberry:
Take our word for it-you cannot afford to m iss this offer for a free vacation to Hawaii. Please
give us a call and have your credit card number handy." (Of course, I don't suggest that you
create such a form Jetter-I'm just pointing out that you have the technology.)
When you make form letters, you set up two documents: the main document and the data
document. The main document has the form letter text that everyone receives. To indicate
where the custom information goes in each form letter, you insert a special kind of field, called
a MergeField, which acts as a placeholder. If you have field codes showing, the Mergefields
appear, as shown in l;igure 10.1.

.

Mil M11ln Document
Dear ( MERGEFIELO FintNome ) ( MERGEFIHLD wtNome }.

-o-

Ju•t • quick note to th"!r;u for your ~cent contribution to Citizeno for o
Better Plonet. The encl
new•letler outllnes our plans for future
expenditures and c:ommunlty profedo.
Sincerely,

( rF ( MERGEFIELD Donated } >• 50 "PS. Thonk you ogoln for your gen erous
c:ontrlbutlon." "PS. We opprecloteyourdonotlon. Every dollar h elps." )

•m r:tl<:>ln"

0.

l'i>l!l

Figure :1.0.:1. MergeFields in the main document act as placeholders for custom information.

Th e second document, the data document or data source, contains the specific information
that customizes each form letter. The data document has specific organizational rules, which
usually result in the data being arranged in a table of columns and rows (see Figure 10.2). After
you complete the main and data documents, you merge the two documents together to create
form letters.
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. it!l rJI ¢ "'

Figure :1.0.2 The data document usually is organized in a table with structured rows and co lumns.
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If you have already typed information into the computer and you want to use it for a merge,
you probably can. Her~ are a few common situations where you can use an existing document
as a data document:

+ Data documents created in Word 6 and originally used for a different merge
+ Tables originally created for a different purpose
+ Data documents and tables from other versions of Word, including Word 4 and 5
for Macintosh and Word 2 and 6 for Windows

+

Excel 3, 4, and 5 documents (Although you can use the Excel worksheet directly,
depending on how well the converter works in a real-life situation, you may want
to save the Excel worksheet as a tab-delimited text file and use the text file instead.)

+ Tab-delimited and comma-delimited text files
Tab-Delimited Text Flies
A tab-delimited text file consists of many bits of information. The information bits are separated by specific nonprinting characters so that the computer can easily work with them.
In a tab-delimited file, each paragraph contains a group of related information (such as a
person's name and address). Within each paragraph, tabs separate specific bits of information (such as the person's name, street address, city, state, and zip code). Most, if not all,
databases can export information as a tab-delimited text file.

In all cases, the first row or paragiaph in a data document must contain category names, such
as FirstName, LastName, Title, and Company. In a tab-delimited text file, the first paragraph
must contain the category names (separated from each other by tabs). Similarly, in an Excel
spreadsheet or Word table, the category names must fill the first row, as shown in Figure 10.2.
You can also look at and work with the data document through a special data viewer, called
the Data Form, which helps you enter and find information (see Figure 10.3).
!
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Rgure 10.3 The Data Form simplifies entering and locating information in the data document.
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Starting the main document
The first step involves establishing the main document-the document that holds generic text
for each form letter. Launch Word and open t he document that you want to use. You can
open an old document or start a new document. You don't have to complete the text of the
document now, but it m ay help to save the document with an appropri ate name, such as My
Main Document or Main Letter.
Go to the Tools menu and choose Mail Merge. Word responds by displayi ng the Mail Merge
Helper, a window that walks you tho ugh the process of pulling together a merge. Drop down
the Create button menu and select Form Letters. A dialog box appears, asking which document
you want to use. Because your main documen t is open, click the Active Window button (see
Figure 10.4).

To creole the form letters, uou con U3e the active
doc ument vlndov My Mol n Oocamenl oro new document
vtndov.

n Active Window
Ca ncel

] (Nov Moln Document

I(

I

HelJ•

Figure 10.4 Ind icate that t he active window document will be the main document.

After you click the Active Window butto n, the type of merge (Form Letters) and the name of
th e main document appear beneath the Create button menu in the Mail Merge Helper. Keep
the Mail Merge Helper open while you move on to the next section.

Starting the data document
Now that you have the main document established, you need to set up the data document.

The data document already exists
If you have the information typed into the computer in a format that Word can use (see the
bulleted points earlier in the chapter), select Open Data Source from the Get Data button
menu. An Open dia log box appears, where you can open the document. After you click the
Open butto n, Word presents you with a message, inquiring if you want to edit the main
documen t (see Figure 10.5).
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Word found no me r ge field :t i n uour mai n doc ument .
Choose I he Edll Ma i n Docu me nt bullon lo l no e rl me rg e

field' i nlo yo ur main document.
llel p

1 [

Ce nce l

1HEd ll Main Docu ment

8

Figure 10.5 This message appears after you open the data document.
If you need to change data in the data documen t before you merge, click th e Cancel button

and skip ahead to the section called "Finishing the data document. " Alternatively, if the data
document is completely ready, click the Edit Main Document button and continue with
"Finalizing the main documen t."

The data document does not exist
If you haven 't started the data document, choose Create Data Source from the Get Data butt on

menu. The Create Data Source dialog box appears, and in th is dialog box, you can indicate the
categories of information, called field names, t hat you plan to use to personalize the fo rm letter
(see Figure 10.6).
Caution: A field usually refers to a code that tells Wo rd to do something

•
'

special. For exampl e, Word fill s in the name of the document in a
FileName field. In a data document, howeve r, a field name is for informat ion t hat you fill in. For example, you may have a field name, called
"address ," to fill in the individual address fields for each person who will
receive t he letter. In contrast, a field in a main document has a code and
a result, just like any other regular field.
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The Create Data Source dialog box automates setting up a dat a document .
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The dialog box lists common field names, but you can customize the list so that it matches
what you want to do:

+ To delete a field name, select the name fro m the list and click the Remove Field
Name button.

+

To add a field name, type th e name in the Field Name text box and then click the
Add Field Name button. Field names canno t contain spaces.

+

The listed fields appear in th e order that you will fill them in later. You can move
a field up or down by selecting it and then clicking the up- or down arrow.

Caution: Make sure that your fields are specific enough for what you plan to

e
'

do. For example, you may need to keep salutations, first names, and last

e

names separate for sorting purposes (so that you can sort based on the
last name) or so that you use the correct greeting. (You may want Dear
Ms. Tasha Kat or Dear Ms. Kat or Dear Tasha.)

'

After you finish customizing, click the OK button. The Save dialog box appears, and your next
move is to save the data document. Choose an appropriate folder, type a name for the file, and
click the Save button . In response to yo ur saving the da ta document, a dialog box appears,
inquiring whether you wan t to work in the data document or the main document. You can
click either button, but to continue with the flow of this chapter, click the Edit Data Source
button.

Finishing the data document
If you followed the procedure outllned in "Starting the data document," you should have the
Data Form window showing (see Figure 10.7).
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Figure 10.7 The Data Form window provides a form-li ke way to look at the data document.

The Data Form window provides a special way of looking at the data document. The form has
blanks for one record's worth of information-a record is all the information for one recipient
of the form letter. If you need to look at the data document or enter information into the data
document, you can do so right in the Data Form window. Here are a few pointers:

+

To move between fields, press Tab (or click in the field to which you want to
move).

+ To open a blank record, click the Add New button. If the insertion point is in the
last field, press Return to open a blank record.

+
+
+
+

To delete the currently showing record, click the Delete button.
To reset the curren tly showing record to the way it was, click the Restore button.
To locate a record based on its contents, click the Find button.
To add more fields or edit the data document in its table-based form at, click the
View Source button. See Chapter 7 for more details about editing in tables.

+ To move to a different record, use the controls in the Record area at the lower left.
You can jump to the preceding, next, first, or last record . Or type a specific record
number into the number box and press Return.

+

To save the data that you enter, click the View Source button. The data document
appears. Go to the File menu and choose Save. To return to the Data Form dialog
box, use the Window menu to switch back to the main document. Click the Edit
Data Source button (it's on the right side of the Mail Merge toolbar).
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•

Caution: Save the information that you enter in Data Form! Data Form is a

•

way of viewing the data document, and you save the information by saving
the data docu ment.

'

Finalizing the main document
Before you merge, the main document must be ready. In the main document, you should see
the Mail Merge toolbar, which helps you prepare the document and preview what the form
letters will look like (see Figure 10.8).

Click and drag
down to insert a
Merge Field.

Click to check for merge errors.

Click the View Merged Data
button to toggle in and out
of seeing what a record fro m
the data documen t will look
like when it merges.

Click to see the
Mail Merge Helper.

Click to do the entire mer~e
and combine the results m
one big documen t.

l1il.l'll!t'711-1--

ick and drag down to
set up special mergi ng
situa tions, such as IF
fields.

Click to do the entire
merge an d send the
results to the printer.
When the View
Merged Data button
is dark, use these
controls to view
d ifferent reco rds.

Click to
view the
Data Form.

lick to
search for a
record based
on the
conten ts of a
particular field.

Click to merge and
customize a few
aspects of the merge.

Figure 10.8 The Mail Merge tool bar has buttons for setting up a main document and merging.

Type the text that every copy of the form letter will have, but when you reach a place where
the form letter should have personalized information, insert a MergeField. To insert a
MergeField, make sure that the insertion point is located wh ere you want the field to go. Then
go up to the Mail Merge toolbar, click the Insert Merge Field button, and choose the appropriate field name.
After you choose a field name, it appears in your document as a MergeField, although its exact
appearance changes depending on whether field codes are showing (see Figure 10.9). If you
don't have field codes showing, the fields may disappear, or they may appear surrounded by
special characters called chevrons (chevrons look like « and »).
Although you cou ld type merge chevrons by hand in previous versions of Word, you cannot
type them by hand in Word 6.
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Figure 10.9 MergeFields look different when they are inserted, depending on whether you have field
codes showing.

To customize text that appea rs in a letter, use an IF field. For example, a charitable organization may want to add a special note of thanks to people don ating over a certain amount of
money. To insert an IF field, follow these steps:
1. Position the insertion point where you wa nt the customization to begin.

2. On the Mail Merge toolbar, click the Insert Word Field button and choose IF...
TH EN .. . ELSE. The In sert Word Field: IF dialog box appears (see Figure 10.10).
Set up a condition.
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Figure 10.10 You can personalize form letters based on t he contents of a particular field.

3. From the Field Name menu, select the fi eld that will trigger the customization.
4. Select a comparison from the Comparison menu. For exam ple, to customize the
letter based on how much money the recipient donated, you can select the Field
Name "Donated" and then choose Greater than or Equal from the Comparison
menu. If you pick th e Is Blank or Is Not Blank options from th e Comparison menu,
don't enter anythin g in the Compare To box.
5. If necessary, type a n umber or letter in the Com pare To text box.
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6. Enter the appropriate text into the Insert t his Text box and the Otherwise Insert
th is Text box. For example, Figure 10.10 shows that people will receive different
messages, depending on how much money they donated.
7. Click the OK button.
Word inserts the IF field in t he document, but you may not see it if you are showing field
results.

Limiti ng who gets the form letter
If you want to use o nly certain data document records for a particular form letter, use a
technique called filtering to block some records fro m merging. To filter records, set up "rules"
for Word to follow. Here are the steps:
1. Open the Mail Merge Helper by clicking the Mail Merge Helper button o r by
choosing Mail Merge Helper from the Tools m enu.

2. In the Mail Merge Helper window, click the Query Options button and select the
Filter Records ca rd (see Figure 10.11).
Set up a comparison.
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filter Record•

Choose a fi.eld
to filter.
To make a
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And or Or and
set up another
rule.
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I
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Cleer 1\11
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Help
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Figure 1 0.11 You can set up rules that limit which records end up in the merge.

3. In th e Field column, from the top menu, choose the field name that will trigger
wh ich records get used in the merge.
4. In the Comparison column, from th e top m enu, choose a compariso n. For example, if you want to send letters on ly to people who live in California, you can set
the Field menu to State and the Compa rison menu to Equal to. Or to send letters

246

Chapter 10

Creating Form Letters

only to people who own products with serial numbers greater than 700, set the
Field menu to SerialNumber and the Comparison men u to Greater than.
5. In the Compare To column, type the text or number that you want to use as a
comparison. If you want to send a letter only to people in California, you can type
CA to set a rule telling Word to include records where the State field is equal to CA.
6. If you need to get fancy with filtering, you can set more than one rule. Use the And
and Or options in the far left column to combine rules. For example, you can
merge all records for people who live in California and have a product with a serial
number greater than 700.
7. Click the OK button after you finish setting rules.

Sorting Records
You can sort records through the Mail Merge Helper. To sort records, click the Query Options
button and select the Sort Records card. In the Sort records card, you can sort records
based on the contents of up to three fields. For example, to sort items based on the last
name ahd then by state, choose the last name field from the Sort By menu and choose the
state field from the Then By menu.

Previewing the form letter
Previewing the form Jetter is not strictly necessary, but it can be a good way to find problems
before you waste a lot of time and paper.
To preview a Jetter, click the View Merged Data button (the button that shows chevrons and
ABC). With the button activated, you can view and print merged form letters. On the Mail
Merge toolbar, just right of the View Merged Data button, you'll find the controls for seeing
form letters personalized onscreen. In using the controls, note the following:

+

To see the preceding or next record, click the corresponding left- or right-pointing
triangle (the Previous Record button or Next Record button).

+ To see a specific record, type the record's number in the Go to Record box and
press Return.

+ To see the first or last record, click the corresponding triangle that points to a line
(the First Record button or Last Record button).

+ To print the form letter showing onscreen, go to the File menu and choose Print.
Print the document just as you would print any other document.

+ To switch back into the mode where you saw either chevrons or field codes, click
the View Merged Data button again.
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Merging and printing form letters
After you set up the main and data documents, it's time to run the merge and to make form
letters.
Make sure that you are in the main document and then click the Mail Merge Helper button
on the Mail Merge toolbar. The Mail Merge Helper dialog box appears, and you should see the
main document listed in the Main Document area and the data document listed in the Data
Source area (see Figure 10.12). If the main document's name doesn't show under the Create
button menu, refer back to "Starting the main document," earlier in the chapter. If your data
document doesn't show under the Get Data button menu, refer back to "Starting the data
document."
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Figure 10.12

If Mail Merge Helper displays tile names of the main and data documents, and if you
have completed the documents, you are ready to merge.

fn the Mail Merge Helper, follow these steps to complete the merge and to create form letters:
1. Click the Merge button. The Merge dialog box appears onscreen (see Figure 10.13).

2. From the Merge To pop-up menu, choose Printer.
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Figure 10.13 The Merge dialog box offers a few final controls for creating form letters.

3. If you don't wa nt to merge all the records, set the starting and ending number for
a range of records. For example, to merge the first 20 records only, en ter 1 in the
From box and 20 in the To box.
4. Generally speaking, keep the Don't Print Blank Lines When Data Fields Are Empty
radio button switched on. With this option on, you eli minate blank lines that may
otherwise appear in a mailing add ress.
S. Click the Merge button. Wo rd responds by o peni ng the Prin t d ialog box.
6. Click the Print button.

How to Set Up Labels
To merge to labels, you tell Word wh ich type of labels to use, and Word sets up a main document that looks li ke a page worth of labels and contains all the correct fields. To merge to
labels, follow these steps:
1. In a new document, choose Mail Merge from the Tools menu.

2. In the Mail Merge Helper dialog box, cl ick the Create button menu and choose
Mailing Labels. Word responds by asking where you want to create the main
document.
3. Click the Active Window button.
4. Back in the Mail Merge Helper dialog box, use the Get Data button menu to set the
data document. "Starting the data document" exp lains exactly how to handle th is
step. When you finish, reo pen the Ma il Merge Helper dialog box.
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5. In the Mail Merge Helper dialog box, click the Setup button. Word displays the
Label Options dialog box, where you can indicate exactly what sort of labels to
merge to. If you need more information about this dialog box, go to Chapter 11
and look in the section about labels. Click the OK button after you finish (see
Figure 10.14).
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Figure 10.14 Choose a label sheet.
6. Word displays the Create Labels dialog box (see Figure 10.15). Choose fields from
the Insert Merge Field button menu to add them to the label. Be sure to put each
field in an appropriate location and (if necessary) to add your own spaces and text.
After you finish setting up the label, click the OK button .
Creole Lobels
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Figure 10.15 Use the Create Labels dialog box to set up what each label should look like.

7. Word returns to the Mail Merge Helper dialog box, which should look like the box
in Figure 10.16. If you wan t to limit which records in the data document turn into
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labels, click the Query Options button. To find out more, see "Limiting who gets
the form letter" earlier in this chapter.
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Figure 10.16 This Mail Merge Helper dialog box is completely ready to merge data onto labels.

8. In the Mail Merge Helper dialog box, click the Merge button. Word opens the
Merge dialog box.
9. In the Merge dialog box, choose where you want the merge to go, tell Word to
merge all records or to merge a range, and turn on the Don't Print Blank Lines
When Data Fields Are Empty radio button . After you fin ish, click the Merge button.
If you have trouble with these steps, review the more detailed steps for creating a form letterthe basics of creating a form letter also appl y to making labels.

How to Merge to Envelopes
Merging to envelopes works almost exactly li ke merging to labels (as explained in the preceding section). The difference is that you choose Envelopes from the Create button menu, and
the Setup button lets you choose an envelope type and set it up. If you need help with the
dialog boxes for choosing the envelope type, consult the envelope section in Chapter 11. After
you finish setting up a merge to envelopes, the Mail Merge Helper dialog box should look like
the one shown in Figure 10.17.
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Figure 10.17 Thi s Mail Merge Helper dialog box is completely ready to merge data onto labels.

This chapter covers merging-the process of taking many instances of specific information
(such as addresses) and using each instance to customize a generic item (such as a form letter
or envelope). In the final Word chapter, you learn about printing all kinds of documents.
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To find out how to print a simple document, read the first few pages of this chapter. To
discover many juicy details about printing features, plunge in and read the entire chapter.
{This section of the book does not cover features and capabilities offered by QuickD raw GX,
optional software that comes with System 7.5 or later.) The information here enables you to
check these items off your need-to-know list:
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Previewing a Printout
Print Preview shows how Word plans to print a document. To switch in to Print Preview,
choose Print Preview from the File menu, click the Print Preview button on the Standard
toolbar, or press ):C-Option-I. After Print Preview opens, it always displays the page containing
the insertio n point, although it may display other pages, as well.
Figure 11.1 shows Print Preview displaying four pages. You can change the number of pages
showing by dragging down from the Multiple Pages button on the Print Preview toolbar.

Click to show or
hide the rulers.

Click to use the Shrink
to Fit feature.

Click to turn
the magnifier
pointer on
and off.

Click and
drag down to
choose how
many pages
you want to
v1ew at once.

------------

--·--

·- -----·.. -·
---·--

----·-----

~===

_:_-.:: ===:::;::.

···---------':'·--:":'--:.:..-==---=-=

-

Click to show or hide
the scroll bars and
status bar.

Click to
switch back
to the
preceding
view.

·------------···--------- -------

=.:::---=== =-=::"
·-·---

Click these
buttons to
move forward
and backward
in the
document.

buttons switch
you into other views.

Figure 11.1. Print Preview offers an assortment of controls.

While in Print Preview, you can edit text and use many of t he regular commands offered in
Word's menus, although the point of Print Preview is to see if the printout is goi ng to look
right and to adjust the document if it needs ad justing.
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For example, if the last page of the document has only a few lines of text, click the Shrink to
Fit button. Word tries to shrink the document so that the last few lines do n't end awkwardly
at the top of an extra page.

Printing a Document
To print a document, you must o pen the Print dialog box. To open the dialog box, click the
Print button on the Print Preview or th e Standard toolbar, choose Print from the File menu,
or press :l:C-P.
To print, Word works with software called the printer driver, which h elps your Mac send
information to your printer. (Different printers use different printer drivers.) At the top of the
Print dialog box, you should see the name and version of the printer driver (see Figure 11.2).
The printer driver name.

r7.2 l

loserWriter i " LoserWrlte r Se lect 360"

0 From:

D

Poge s: ® All

·- - - - - - - - - - - - - - -]
From: I Cosse tte
.,.I

0 Firs t

I
This check box shows whether the
document has
more than one
orientation.

1.,.1

(Options

0 PostScript® File

Inil Po~es In Aon~e 1-..1
(

0 Print Selection Only
181 Collate Copies

I

Runge ...

(Word Options )

) (

Word ltelp

--,

S~ow

The printer
driver
version.

•I

R~mol nlng frorn:l f.Ds~ett~

Des tlnotlon: ® Printer
Print:
Document

Print ~

D (Cancel 1

coples:EJ
~ Popcr Source -

® Rll

To:

It

I

- Word added
these extra
options.

o seporoto Print dialog for:

~ Eoch Orientation In the Document

-

Figure 11.2 The Print dialog box is the control center for printing.
The appearance of the Print dia log box depends partly on Word and partly on the printer
driver, so don't worry if your dialog box doesn' t m atch those shown in this book. To print a
document from the Print di alog box, enter how many copies you want in the Copies box and
click the Print button. Keep the following tips in mind to print successfully:

+

If you print more than one copy to a PostScript printer, use the Collate Copies
check box to indicate whether you want the documents collated o r not.
QuickOraw printers always collate copies.

+

To print on the fron t and back of each page (if your printer does not have a
duplexing feature), first print the odd pages and then print the even pages (it takes
a little experimenting to figure out exactly how to do this with any given printer).
Choose Odd Pages o r Even Pages from the pop-up menu above the Range button .
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Using fractional widths
By default, fractional widths is off in new documents. The printout will look better if you turn
it on because turning on fractional widths causes the printer to take advantage of its higher
resolution (usually 300 or 600 dots per inch) for a better look. Unfortunately, with fractional
widths on, the document may look fuzzy or have overlapping characters onscreen. This
happens because the monitor can only display text at about 72 dots per inch.
If you keep fractional widths off, the printer imitates the lower resolution monitor and does
not do the best job it could possibly do. If you use the Print card in the Options dialog box

from the Tools menu to turn on fractional widths, the printer optimizes character shapes and
widths. The monitor can't display the document exactly as it will print with fractional width s
on, and the display tends to look fuzzy with characters slightly overlapping. Some fonts don' t
look particularly different, but Helvetica changes fairly distinctly.
To turn fractional widths on by default, open up the Normal template (you should find it in
Word's Templates folder). With the Normal template open as the active document, go to the
Tools menu, choose Options, and select the Print card. Turn on the Fractional Widths check
box and click the OK button. Save and close the Normal template.
If you find yourself frequently switching fractional widths on and off, set up macros that turn

them on and off. Chapter 9 gives the exact steps for setting up one of these macros.

Substituting Fonts
With fractional widths on, Word blocks a Page Setup dialog box option called Font Substitution (or sometimes, Substitute Fonts). If your printer has built-In fonts (any PostScript printer
has built-in fonts), when you print with font substitution on, the printer prints Times instead
of New York, Helvetica instead of Geneva, and Courier Instead of Monaco.

Printing parts of a document
The Print dialog box offers many different options for printing only part of a document. fn
some cases, you have to position your insertion point in a particular spot or select particular
text before you open the dialog box. In other cases, it helps to know exactly which pages you
want to print. If you have trouble relating what you see on screen to which pages you want to
print, remember that the left side of the status bar displays the section and page containing
the insertion point. In any event, here's a list of options for printing only part of a document:

+ To print only the page containing the insertion point, click the Range button and
then select Current Page. Click the OK button to return to the Print dialog box and
then click the Print button.
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+ To print a selection of text, select the text and then open the Print dialog box. Turn
on the Print Selection Only check box and click the Print button.

+ To print a range of pages from a document that has continuous page numbering
throughout the document, type the beginning and ending page numbers in the
From and To boxes.

+ To print a range of pages from a document that has noncontinuous page numbers, click t he Range button. Enter the range by specifying the section and page
number. For example, if the document has two sections, and each section restarts
numbering at page one, to print the first section and the first two pages of the
second section, enter s1p1-s2p2 (see Figure 11.3).
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Figure 11.3

Use the Range dialog box to set a page range.

+ To print a noncontiguous set of pages, click the Range button. In the Range dialog
box, type the page numbers for the pages that you want to print. Specify a break
in continuity with a comma. For example, to print page one and then pages six
through ten , enter 1,6-10.
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Printing a reduced (or scaled) document
When Word reduces a document, it shrinks the margins, graphics, and text to the percentage
that you indicate. Because of the extra space between margins and the reduced text and
graphics size, more information fits on a page than it could without the reduction. Onscreen,
the indents spread farther apart to accommodate more text per line.
To set up a reduction, go to the File menu and choose Page Setup. The reduction controls
differ depending on your printer, so look for a pop-up menu, a box where you can type a
reduction, or some other device (see Figure 11.4 fo r one example).

[ Morglns ... J
Appl y Size and Orlentotlon To:

[

ISelected TeHt

[ Word llelp ]

1..-1

Print...

]

[ Oefoult... ]

Figure 11.4 The StyleWriter II version 1.2 printer driver lets you choose or enter reductions.

How to print to disk-making PostScript and EPS files
When you print with a PostScript printer driver, the driver converts the document into a series
of PostScript programming commands and sends the commands to the printer. If you don't
want to print right away, you can tell the driver to send those PostScript commands to a fil e.
You can then take the file to a typesetter who can print the file at a high resolution, or you can
take it to a computer that is not running Word 6 but is attached to a PostScript laser printer.
To print the file, you must use a program that can print PostScript code. Apple's LaserWriter
Utility (it comes with Apple's printers) works well .
To print to disk, in the Print dialog box for a PostScript printer, set the Destination to
PostScript or to Disk (different printer drivers offer different possibilities). After you change
the destination, the Print button changes into a Save button. Click the Save button. After
you click the Save button, a dialog box appears asking you to save the file.
If you use version 8 or later of a printer driver, the Save dialog box should offer options for
saving as PostScript text or as an EPS file. When you save as EPS, the first page of the document saves as an EPS fi le. To make a PostScript file, choose a PostScript text option.
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If you use LaserWriter, PSPrinter, or Laserjet 8.0 or newer, turn on Balloo n Help in the dialog
box for saving the PostScript file. The Balloon Help has a lo t of useful info rmation.

EPS Files
EPS stands for Encapsulated PostScript. An EPS file has two parts: an image that shows
onscreen and the underlying PostScript code. The code doesn't show onscreen, but when
the image prints, the code tells a PostScript printer what to do. If you print an EPS file to a
QuickDraw printer, only the screen image prints because the printer doesn't understand
PostScript. The QuickDraw printout probably won't look all that amazing.
You can open EPS files in Word and see the picture onscreen, but you cannot edit an EPS
file In Word.

Printing PostScript code
If you have a bit of PostScript code that you wa nt to add to a Word document, and if you wa nt
a PostScript printer to interpret the code and print the coded image, you must place the code
in a Print field . Here are the steps:
1. From the Insert menu, choose Field. Word opens the Field dialog box.

2. From the Categories list, select All.
3. In the Field Names list, select Print.
4. Turn off the check box for Preserve Formatting During Updates.
S. Click the Options button. The Field Options di alog box appears (see Figure 11.5).
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Set up the Print field so that it can hold PostScript instructions .
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6. From th e list of switches, select the switch that makes the most sense for your
PostScript code. If you know much about PostScript code, note that the switch
dictates t he location of the origin (0,0). If you don't know much about PostScript
code or aren' t sure wh ich switch to select, try \ p page or \ p para. \p page typically
works for PostScript code that is based on a page, such as a box border or a waterma rk. \ p para typically goes with code that applies to the paragraph containing th e
Print field.
7. Click the Add to Field button. Word adds the switch with the correct syntax to the
field.
8. Click the OK button. Word closes the Field Options dialog box and puts you back
in the Field dialog box.
9. In the Field dialog box, click the OK button.
10. The result o f the I?ri nt field is no thing, so you must show field codes to see the
field. Edit the field so that it looks like this: {PRINT \p para "code "}. In place
of code, paste in your own PostScript code. The code should be enclosed in quotes
(see Figure 11.6).
J3

lnulte
(PRINT \ p pagto '% Page Border - Landscape
5 setlinew1dth
3636 moveto
0540rlinelo
7200 rlineto
0-540 rlineto
closepath
stroke' I

r.m

:J I ¢

.

'

'()>

~

~1'!1

Figure 11.6 This Print field is properly set up with PostScript code for boxing a landscape page with
a border.

To fi nd technical info rmation about the Print field and PostScript, click the Help button in the
Field Optio ns d ialog box.

Using Background Printing
Use background printing to queue up more th an one document to print at a time or to use
your computer wh ile you print. For most people, a program called Print Monitor handles
background printing. You'll find Print Monitor in the Extension s folder inside the System
Folder. Double-click the Print Mo nitor icon to laun ch Print Moni tor. If you go to the File
menu and choose Preferences, you ge t a Preferences d ialog box where you ca n configure
Print Mon itor.
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dio buttons, you must select the printer driver.

Printing an Envelope
If all goes well, printing an envelope works like a charm. Here are the steps to try:

1. If the delivery address is already typed in the document, highlight the address.

2. Choose Envelopes and Labels from the Tools menu. Select the Envelopes card. The
Envelopes card has boxes for typing the delivery and mailing addresses as well as
the extremely important Feed button at the lower right (see Figure 11.8).
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Figure 11.8 Set up the appearance and feeding method for the envelope.

3. Make any needed chan ges to the delivery and return addresses. If you have a
default return address set and don't want to use it, turn on the Omit check box.
Word figures out the defaul t return address by looking at the User Info card in the
Options dialog box from the Tools menu.
4. Click the Options button to open the Envelope Options dialog box. Select the
Envelope Options card.
S. Choose an envelope size. If none of the sizes is right, choose Custom Size and enter
your own dimensions.
6. Use the Delivery and Return Address areas to customize the format ting and
position of each address. For best results, try the Auto positions first.
7. Select the Printing Options tab.
8. In t he Printing Options card, indicate how the printer expects you to insert the
envelope and then click the OK button. Word returns to the Envelopes and Labels
dialog box.
9. To add the envelope to a separate section at the top of the document and print it
later with the document, click Add to Documen t. Or to print the envelope, click
the Print button.
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Caution: If you add the envelope to the top of a document, when you print

•
'

the document, you may want to turn on the Each Orientation in the
Document check box in the Print dialog box. If you do, Word prints the
envelope from the selected paper source (such as the manual feed tray).
After printing the envelope, Word brings up the Print dialog box again so
that you can choose a different source (such as the paper cassette).

e

'

10. If you changed the return address, Word asks whether you want to save it as the
default return address. Click Yes if you wa nt to save it, No if you don't.
11. If you clicked the Print button in step 9, the Print dialog box appears. If necessary,
indicate that you are printing from the manual feed tray or an envelope feeder.
Click the Print button.

What to do if an envelope prints wrong
Word has a poor track record with printing envelopes correctly, so if you are certain that you
selected the correct envelope setting for your printer, consider the following possibilities if the
envelope doesn't print correctly:

+

If the addresses printed upside down, rotate the envelope 180 degrees on the paper

tray and try again . This problem often occurs with printers designed for Windows
and Macintosh users because the graphic on the printer that shows how to print
envelopes is incorrect for the Macintosh.

+

If the addresses printed far from where they should have (or if they didn't print on
the envelope at all), try a few different envelope positions in the Printing Options
card. Word's logic about envelope positions may have no relationship to your
logic.

+ Use the Envelope Options dialog box to tweak the exact location of the delivery
and return addresses. A little experimentation h ere may go a long way.

Printing on Labels
Word has a card in the Envelopes and Labels dialog box that helps enormously with printing
to labels. Using the card, you can print a page of identical labels or print just one label. You
can also set up a page specially fo rmatted for typing up a page of nonidentical labels.
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Setting up a label sheet
To open the card, choose Envelo pes and Labels fro m the Tools men u an d select the Labels card
(see Figure 11.9).
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Agure 11.9 The Labels card helps you print out to a sheet of labels.
In the Labels card, the first step is to select the type of labels that you plan to use. The lowerright corner shows the curren tly selected label, and you can click the Options button (or click
on the label) to open the Label Optio ns d ialog box (see Figure 11.10).
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Figure 11.10 Select the label sheet closest to what you plan to use.
In the Label Optio ns dialog box, select your printer type and label brand. Then select the
actua l label type from the Product Number list. (If noth ing in the Product Number list matches
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you r labels, select a close match and click the Details butto n . Use the resul ting dialog box to
further customize the setup.) After selecting the proper label options, click the OK button .

Printing just one label
To print just one label o n a sh eet, fo llow these steps:
1. Type the label informatio n in the Address box. To fo rmat text in the Address box,

use keyboard shortcuts o r Control-click on highlighted text to bring up a shortcut
menu . You can access the Fo nt and Paragraph dialog boxes fro m the menu.
To print the default return address instead, tu rn o n Use Return Address. The default
return address comes from the inform ation o n the User Info card in the Options
dialog box.
2. Select the Single Label radio button and enter th e row and column of the label that
you want to use. In genera l, print to the bo ttom free row so that you can feed the
label sheet thro ug h th e printer again . If you print to th e top row and then peel the
label off, the sheet is like!}' to jam if you feed it into the prin ter again.
3. Click th e Print button.

Printing a page of identical labels
To print a page of labels, try these steps:
l. Type the info rmation for one label in the Address box.

2. Select the Full Page of the Same Label radio button.
3. Click the Print button.

Making a page of different labels
If you don't want th e same address on each label, you must bring the label layout into a
regu lar Word document and th en type the individual addresses. Here are the steps:
1. If you want any text to repeat in each label, such as To: o r a zip code, type the text

in the Address box.
2. Select Full Page of the Same Label.
3. Click the New Docum ent button. Word creates a new docu m ent and puts a table in
th e document. The rows and columns in the table match the rows and columns on
the label sheet.
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4. Type the t ext for each labe l. To move from one label to the next, press Tab. If you
fill one page and want to create another page of labels, click in the lower-right table
cell and press Tab.
5. After you finish filling in each label, print the document just as you would print
any other document.

Caution: If you plan to create many unique labels, consider using a mail

•

merge to place the information on the labels. If you merge the informa·
tion , you can use it again to make form letters, envelopes, and so on .

'

Printing Close to the Edge

•

'

A problem with life is that if you get too close to the edge of anything, you fall off. In the case
of printing, it's not so much that you fall off, but if you try to print too close to the edge, the
text that's over the limit fails to print. For letter-sized paper, you may find that you can't print
closer to the edge than .5 inches, and for legal-sized paper, you often can't print closer than
.9 inches. Each printer has its own limitation, so consult your printer manual or run some tests
to discover your printer's limits.
Word tries to alert you if it anticipates a problem with text cutting off around the edges, but
the alert doesn't always work. Here are a few tips:
• To get the maximu m printing area, go to the File menu and choose Page Setup. In
the Page Setup dialog box, click the Options button. In the resu lting dialog box,
turn on the Larger Print Area ch eck box. Click the OK button and then click the
OK button again to return to the documen t. (If you don't have an Options button
in Page Setup, you can't take advantage of this suggestion.)
• Ad just your margins. Click in or highlight the appropriate sections and then
choose Document Layout from the File menu. Select the Margins card, change
the margi ns, and click the OK button.
•

If a header or footer is cutting off, move it farther fro m the edge. To move a header
or footer, click in the correct section and then choose Document Layout from the
File menu. Select the Ma rgins card, ad just the appropriate From Edge setting, and
click the OK button.

•

If a page number cuts off, adjust the position of the header or footer containing
the number. If the page number is completely missing, make sure that it is in the
expected header or footer. For example, you may have the page number set to n ot
print on the first page of a document (or section).
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If a table row hangs down into the bottom margin and then cuts off, click in the

row and ch oose Cell Height and Width from the Table menu. On the Row card,
turn on the Allow Row to Break Across Page check box.
•

Increase the margins so that the text does appear on the printed page and then
set up a reduction (try a 90 percent reduction, which reduces the document by
10 percent). Flip back a few pages to find out how.

Now that you know all about printing, you are ready to amaze your friends and co-workers
with the asto nishing depth of your knowledge.
If you read a reasonable portion of all the chapters on Word, you are now officially
started with Word 6 and are probably an expert at using more than a few of the features.
Congratulations!
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Excel sh ows what Microsoft can do when
it gets everything right. Although Excel 5
is big, and not exactly a speed demon
compared to smaller products, all the new
features in this application are justified in
a business setting as true "power user"
tools. Although the first release of Excel 5
had an assortment of bugs, the version
that shipped with Office 4.2.1 was stable
and trouble free.
The graphics are better; macros are better
(you can actu ally read the macros created
in the English-syntax-like Visual Basic);
and the Excel workbook is a great
information-handling device. The Pivot
Table function and analysis tools put
Excel in a class by itself as softwa re for
organizing and understanding a business
or for just tinkering with home budgets.
Part III covers all these aspects of Excel 5,
an d on top of all this, you will also find
real-world examples of how to set up and
interpret all sorts of data fo r predicting
the fu ture and analyzing trends. Excel 5
is software you can enjoy rather than
merely survive.

Chapter 12

Getting Started
with Excel
It helps to th ink of a spreadsheet as just a piece of paper. This piece of paper has two magical
qualities. First, you can write and erase numbers over and over again without wrecking the
paper. Second, w hen you w rite an arithmetic problem o n th is paper, you can make it solve
itself.
Excel 5 is loaded with features th at no o ne dreamed about back in the days of VisiCalc, the
first spreadsheet program, but yo u can sta rt working with Excel right away by using only a
smaller feature set at first and mastering mo re features later. In this chapter, you start using
Excel so that you can get real-world results today. You'll find these topics covered:
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A First Look
Excel 5 is the biggest, most feature-packed spreadsheet any software company has produced.
Paradoxically, it's also the easiest to use because the features have been arranged in layers. At
one level, you can learn a handful of commands and solve all sorts of real-world problems. At
successively higher levels, you can make flashy business graphics, do statistics and engineering
studies, and design elaborate what-if investigations.
The good news is tha t you and I can get working in this fabulous new version of Excel in a
matter of minutes. This sectio n of the book is going to be a complete reference, but the
features of Excel are going to be described in order o~ usefulness, at increasing levels of detail
as the chapters progress. I have seen an Excel book for W indows PCs, for example, in which
the delicate subject of add ing numbers is first broach ed on page 223! That's not the approach
h ere-I want you in fifth gear on your second lap around the track.
Look at the screen in Figure 12.1. It presents a fai rly bewildering array of little tool buttons in
two rows at the top. In the upper right-hand corner there are two odd little icons (the light
bulb and the questio n mark in Figure 12.2) that you won't need right now, but which will
become old friends in a few days. The light bulb is a new feature in Excel S that gives you
context-dependent tips. The question mark, when double-clicked, calls up Excel's gigantic help
machinery, the equivalent of th ree medium-sized books.
•
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Figure 12.1 Excel 5 opening screen .
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Figure 12.2 Two new little friends.

What else does Excel give you when you double-dick the Microsoft Excel icon? There's a grid
of little rectangles where the actual work takes place, a set of labels for rows (numbers) and
columns (letters) along the sides, and the large collection of buttons that correspond to
individual menu commands (that is, everything you do with buttons you can do by pulling
down a menu). At the bottom of the screen you see tabs (looking like file folder tabs) called
Sheet 1, Sheet 2, and so fo rth up to Sheet 16. What you're looking at in Sheet 1 is the top sheet
of a whole set linked together in a workbook. For big problems, Excel workbooks are great, but
for a quick introduction on small problems, they're just a complication, so you'll work only in
this top sheet now.

Entering numbers and text
If you move the mouse around n ow (see Sheet 1 of the workbook Untitled1, which Excel 5

presents on startup), you see that the mouse cursor turns into an arrow when it's over the little
buttons and at the edges of the worksheet, and into a little Swiss-flag-type cross when it's out
over the grid.
To get started, move the cross to cell B3 (that's column B, row 3) and click the mouse. Notice
that the name box at the upper left shows your choice of active cell. Clicking the cell selects it.
That gets you into the cell so that you can start entering some data.
Besides the mouse, you can also use the arrow keys to move around in the worksheet. Another
navigation method is to type a cell name in the name box in the upper left-hand corner and
then press Enter. And under the Edit menu, there's a Go To command that does the same
thing.
just to have a bit of practice at Excel, try this opening sequence:

+

Type Monthly Expense Report into the cell 83. If you make a typing mistake,
you can correct it by using the arrow keys and Delete or by picking your way
between characters with th e mouse. Note that you can do the editing in the cell
itself or in the area, called the form ula bar, wh ere you see your typing reflected.
After you're done typing, either press Enter (or press Return), move out of the cell
by using an arrow key, or move the mouse cursor away to another cell and click.
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+

The words that you typed extend past the edge of the cell B3 box. To make the cell
big enough for the words, click in cell B3 and then move the cursor up to the edge
of the righ t-hand side of the box containing the letter Bat the top of the column.
The cursor changes to a little vertical bar. Hold down the mouse button and move
the mouse to the right- this expands the column width. Move the column boundary until you have enough space for your words.

+

As long as you're at it, you may as well make the words into a proper heading.
Click in cell B3 again to select it and then click on the button with a capital B in
the Formatting toolbar. That helps high light the words. Then find the fon t size
scrolli ng list on the toolbar and set this cell to 14 points (see Figure 12.3). You see
that you now need to adj ust the cell width again.

Quick buttons for bold, italic, and underline.

I"~

:s %f13

iillu•l•l;aiWII.ol.%1 ,J ;,J.'lllQEIISlB

~I

Change fonts and font size with these.

Figure 12.3 Quick formatting from the toolbar.

+

Type in the categories of expenses in th e cells shown in column A and ad just the
size of the cell (see Figure 12.4).

+

Now enter the numbers, as shown in Figure 12.4. Nothing to it- just click the first
number-entry cell, type in the number, and press the Down Arrow key to get to the
next cell. Press Enter after the last entry.

+

just to make this look professional, click the first number cell, hold down the
mouse button, and drag down to select the set of number cells. Then click on the
dollar-sign button. Presto, the cells are formatted as money.

What do you do now? You save your work, that's what you do. Pull down the File menu, pick
Save As, and name the worksheet (something like Ol.expenses). As a rule of thumb, save your
work every time you have typed something that you don't want to type again, which means

save your work constantly.

Caution: Excel 5 is a big application with lots of complicated interactions

e
'

with System 7 .5, and you should anticipate that it may just freeze on you
from time to time, especially if you don't have lots of extra memory to
spare. Rather than face the agony of rebuilding a large model after a
crash, start remembering to press :l=C-S as a nervous habit. If you're just
looking at the screen and thinking about what to do next, press :l=C-S.
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--f-- ---!---+----+--- ---1-----ir+- A few simple
data en tries.

Figure 12.4 Setting up some information.

Like all other Microsoft products, Excel has an Undo function under the Edit menu. If Undo
doesn't do what you want (sometimes things get truly messed up), you may need to press the
Escape key and start over in a cell. There's also an Undo button on the Standard toolbar-it's
the little backward-curling arrow. (Redo is the forward arrow to the right of Undo.)

A first formu la
So far, of course, you haven't done anything that couldn't be done in a word processor. You've
just been typing into cells as if they were tiny pages. In fact, most of the same formatting tricks
now apply in all Microsoft products-Excel uses the same little buttons as Microsoft Word 6
and Microsoft PowerPoint 4.
But the point of a spreadsh eet is to set up some calculation s underneath the numbers. So no w

it's time to do a little calculation, namely adding up the numbers in the expenses column.
Type Total into cell AlO so that you have a label. Then click on cell BlO to select it. There are
three ways to put a formula in this cell in order to get a total for expenses:

+

You can type in the expression =B5+B6+B7+B8. This just tells Excel to add the
numbers in those cells. By the way, when you type a formula like this into a cell,
don't bother using uppercase. Excel sees b7 as B7 in a formula.
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+

You can use the function SUM. One way is to type the expression =SUM(B5:B8)
directly into the cell. The notation BS:B8 mean s to add that whole range of cells.
You can also enter the SUM function from the Function Wizard (see Figure 12.5).
Just click the Function Wizard button, select the function SUM (usually hiding
under Math&Trig), and enter the range of cells. It actually takes a few more key
strokes this way, but in the long run, it saves you work because you can't mistype
function names.

+

Finally, because adding up columns of numbers is probably the most common use
of Excel, there's a special AutoSum function (see Figure 12.5). Select the cell below
the bottom of the column and click the AutoSum function; then click the top
number cell, hold down the mouse button, and drag down to select the other
numbers, which will fill in automatica lly. Press Enter to have the actual total
appear in cell BIO.
The AutoSum button

The functio n Wizard.
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Figure 12.5 Qu ick clicks for formul as.
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More about formulas
Now Excel 5 has dozen s and dozens of function s, as you may have noticed in the Function
Wizard dialog box. Some of them are used all the time (the fo ur main arithmetic functions
+, -, *, I and SUM), and som e of them are notably less popular (hyperbolic trigono metric
functions, for example). As a quick reference, I have set up Figure 12.6 for the four basics.
Don' t worry about the other fun ctions n ow-there will be plenty of advanced material in the
later chapters.
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Basic Excel functions.

It's time to discuss a bit of spreadsheet jargon. When you use a cell location li ke B4 in a formula, that's ca lled a cell reference. In particular, this on e is called a relative cell reference. A
relative cell reference means that you can copy the formula, paste it into another location, and
th e cell reference will move along with it (see Figure 12.7). If you don't want the cell reference
to move, you have to make an absolute reference. For histori cal reaso ns (the earliest spreadsheets used this notation, so you're stuck with it), th e way you indicate an absolute reference is
with dollar signs, such as $8$4. If you name a cell that way in a form ul a, the formula always
takes the contents of that cell, wherever you move the formula.
If you want to define a set of constants in a worksheet, you usually want to use absolute cell
references. If, for exam pie, yo u have a list of sales entries for a store and you want to multiply
all the entries by a number for sales tax, your best bet is to enter the sales tax number in a cell
somewhere near the top of the worksh eet and then use an absolute cell reference when you
refer to sales tax in formulas.
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Figure 12.7 Abso lute and relative cell references.

A Budget Example
Here's a slightly more ambitious example. It just uses the same commands already covered, but
it uses them over and over. just to keep your spirits up as you leaf through the thousand pages
of the Excel manual, you should remind yourself that you could have a perfectly plausible
career as a spreadsheet hotshot if you knew about ten percent of the features in Excel 5. As
proof of this, consider that Lotus 1-2-3 version lA-the program that made spreadsheets a
permanent fixture of the American business landscape-had only about ten percent of the
features now present in Excel, and plen ty of people made careers out of Lotus. If you can enter
numbers and use formulas, you have the essence of the whole show. Beyond that, most of the
work you do in Excel is "beautification" with fo rmatting and charting effects.

Step-by-step bus iness
Figure 12.8 shows a sample budget that is typical of the day-to-day use of Excel. Sometimes
you're going to use Excel for fancy presentation effects, but Microsoft studies show that
humble little tables like this one are actually about 90 percent of Excel use. To make a table
like the one in Figure 12.8, fo llow these steps:
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1. Select the whole set of rows 1 through 16 by dragging the mou se across th e gray

row-number buttons at the left-hand edge of the workspace. Selecting whole
batches of rows or columns is much quicker than fo rmatting individual cells.
2. With the area selected, pick New York for a font, 12 points for the fo nt size, and
bold for a format. Then make the title and column headings 14 points for the font
size.
3. Notice the date reference in the formula bar. Type in Sept. 94, and Excel will
interpret the date as 9/1/94.
4 . Enter th e budget numbers and use AutoSum to make the total and grand total for

this somewhat expensive organization.
5. Select the whole central area with numbers and click the money format button.
6. Just for fun, select the Grand total text cell and the total cell next to it and pick the
solid border by clicking the Borders button.

Total with
AutoSum.
Grand total
with
AutoSum.

Excel's date format con version.

Figure 12.8 A formatted budget .
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Wh at do you do with a document li ke th is? Well, for starters, the individual expen se numbers
were con cocted in reference to the original expense worksheet. As a manager, you may want to
plug in the consequences of parking the field staff at cheaper hotels when they're not meeting
clients and, for that matter, having lu nch at Burger King when they're on the road. The point
of a spreadsheet is that you can prepare a whole folio of expense options like this to study.
Later, in Chapter 14, I' ll show you how to make a sheet like this in which each entry is the
summary cell of its own little worksheet. This way you can do an infinite amount of tinkering
to meet budget goals or to decide how much revenue you'll need.

Getting into print
Sooner or later, by trying out different numbers, you' ll have a budget that you want to present.
Typically, that means that you need to print your work (unless you work for a company that
has a Macintosh-based overhead projector). When you print in Excel, there are a few things to
consider.
The fifth button from the left in the Standard toolbar (th e one at the top) shows a little page
with a magnifying glass. Jt's the button for Print Preview. You may be familiar with Print
Preview from Microsoft Word, but please be awa re that it's absol utely critical in Excel.
In Word, you can usually make a good guess about the printed output because a word processor is designed to represent sheets of paper in a standard page setup. In Excel, the "sheet of
paper" in the computer is, in principle, nearly infinite in extent. The screen in Figure 12.8
turns into the two Print Preview pages shown in Figures 12.9 and 12.10.

Caution: Never, never, never print an Excel worksheet without checking it in

•

Print Preview . What you see on the standard screen is not what you get on
paper. You almost always have to do some fine-tuning .

'

•

'

What kind of fine-tuning? In this case, you have a couple of ch oices. After you click the Setup
button at the top of the Print Preview display, you see the screen in Figure 12.11. You can scale
the output until it fits on a single page. At 80 percent of normal size, it fits, but it prints on a
page that's mostly white space (see Figu re 12.12). A better choice, because this worksheet is
wider than it is tall, is simply to print in Landscape mode (Figure 12.13), which is a better fit
with the world of 8 1/2 x 11-inch paper.
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Most, but
not all, of
the budget
worksheet.

Figure 12.9 The budget sheet , page 1.

The total
column is
prin ted on
a separate
page.

Figure 12.10 The budget sheet, page 2.
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Portrait
versus
Landscape
prin t mode.

Scale
worksheet
to fi t
print area .

Figure 12.1i Page Setup in Print Preview.

Figure 12.12 Scaling to fit.
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Sheet at 100
percent
scale, but
sideways.

Figure 12.13 A better print format (Landscape).

This chapter is a beginner's guide to the most useful Excel operations. Each subsequent chapter
will provide more depth on every topic covered h ere. Nonetheless, if you know only how to
enter data, formulas, and get printed output, you can still use Excel 5 effectively at work. The
next chapter tells you how to format your worksheets.
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Excel 5 has seriously overhauled Excel formatting capabilities. In part, this overhaul was ca used
by Microsoft's desire to make formatting techniques the sam e across all Microsoft applications
and because some new features were long overdue. This chapter shows you the various formatting options and how to use them faster with simple tricks. If you're in a hurry, it's one of the
most impo rtant ch apters of the book. This chapter includes the followi ng topics:
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Formatting with the Standard Toolbar
Excel gives you th e facilities for making tables of data look any way you want. You can make
wretched little high-density, small-point size tables with tons of hard-to-read data-hey,
sometimes you may want the data to be hard to read. You can also make data presentations
so lovely that you could use them in ad vertising.
All sorts of possibilities lurk under the Excel 5 fo rmat menu. However, the most useful formatting commands are right o n top of your Excel worksheet. As part of its duties as a good
corporate citizen and as-yet-unconvict ed software monopolist, Excel has done two interesting
tests on its own products. First, it has established a usability lab in which it monitors patterns
of use with its software. Second, it has sent out special versions of programs that record which
keystrokes typical users employ to do common tasks. Armed with this information, Microsoft
selects the contents of its wizards (the interactive tip system) and the toolbars. Those little
buttons didn't volunteer to appear on the toolbar-they were drafted!

Column and row size
Before you format any number or text, you need to have someplace to put it, so it's time to
discuss changing the sizes of the little cells in the worksheet. Figure 13.1 shows a single word
("this'') in a single cell. Type the word in the cell at the defau lt font size and then select 24
from the font size scrolling list. In Excel 5, the row height adjusts automatically when you do
this. If you copy this cell and paste it somewhere else, that row adjusts itself, too.
Can you reformat columns in the same way? Going back to this cell and typing in some more
words (see Figure 13.2), you can see that the column doesn't readjust. But there's another
o ption fo r co lumn width-under the Format menu, the Column choice gives you AutoFit
Selection as an other option (see Figure 13.3). It works like a charm . The only catch is that it
applies only to a single selection. If you want this function to work all the time, drag-select
across all the columns you're li kely to use and then select AutoFit.
For every task that you want to accomplish in Excel, there are about a half dozen ways to do
it. You can take each column in your worksheet, one at a time, and format each column by
choosing Column and Width under the Format menu and then specifying the number of
characters. That's the hard way. Or you can perform a width adjustment by clicking the head
of each column and then adjusting the width with the little bar cursor that you see when you
move the pointer cursor to the edge of the column.
That's easier, and it's sort of fun and interactive. But you bought this book to get some advice,
so here it is: the easiest way to format column widths is to type your entries into the spreadsheet without paying any attention to widths. Then select the whole set of colu mns that
you're using and fo rmat the widths all at once by using AutoFit. That's o ne grand drag-select
with the mouse and a single command versus dozens of little adjustments in the other techniques. Unless there's a compelling reason (you need to see more of your worksheet onscreen
at o nce, for example), AutoFit for columns is the fastest and easiest way to get proper columnwidth adjustment.
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Change fo nt size he re.
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Figure 13.1 Text size formatting.
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Figure 13.2 Big text exceeds the column width.
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This command automatically
ad justs column widths.

Cells...
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~

Shoo t

~

nutoFormot...
Style...

111do
Unllldo
Stnndord Width ...
0

Figure 13.3 AutoFit solves all problems.
One rather annoying aspect of the implementation of AutoFit is that it doesn't remember that
columns were AutoFitted. Suppose that you have used AutoFit to adjust your columns, and
every column is as aesthetically perfect as the columns of the Parthenon-which, as you may
know, actually have a subtle curvature to make them appear straight. If you then edit a cell
and increase the font size, for example, the row height changes, but the text now slo ps over
disgracefully into the next cell. You have to select AutoFit again to restore calm and order to
your work. If you've changed fonts all over the place, you m ay find that selecting all the ro w
headings in your worksheet and then choosing the AutoFit under Row in Format command
will save you some valuable space.

Fonts and sizes
Rows adj ust their own row heights automatically, and for columns there's an AutoFit option.
That suggests that ch anging fonts and font sizes in Excel S is going to be pretty simple.
It is. If you have the TipWizard turned o n (click the lightbulb button if the Tip Wizard isn't
displayed), move the cursor to the left-hand side of the Formatting toolbar. The last two
elements are not only the toolbar scro ll boxes for fo nts and font size, but with the TipWizard
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turned on, they actually announce themselves as such. "Land sakes, child," as my grandmother used to say, "if they were dogs, they'd jump up and bite you" (see Figure 13.4).
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Selecting fonts.

Figure 13.4

Toolbar font formatting.

These two elements are by far the fastest way to make font changes in a worksheet because
they don't require you to find what you want in a m ultilevel menu. And although you may
not realize it, you have already absorbed a huge assortment of rules for font usage in a
worksheet. All your life, you have seen layouts of tables of numbers in newspapers, magazines,
and books, and even if you haven't recognized the rules, your opinion of what looks good and
what doesn 't is governed by those rules.

Alignment
Four more buttons on the Formatting toolbar (see Figure 13.5) control positioning of text and
n umbers inside cells. The commands do exactly what their appea ra nce suggests: align contents
to the left, center contents, align contents to the right, and center contents across a set of
columns. Figure 13.6 shows four cells to which the buttons have been applied in sequence.

Figure 13.5

Toolbar alignment formatting.
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Figure 13.6 Text alignment in cells.

Numbers
Fast n umber fo rmatt ing with th e toolbar uses five buttons toward the right side. You ca n't
miss 'em-they're th e set that starts with the dollar sign and ends with little zeros.

+

After you select a cell and click the dollar-sign butto n, the selected cell is formatted
as currency (starts with a dollar sign, no comma, rounded to two decima l places) .

+

If you do the sam e with the percent button, your number is formatted as a simple
rounded-off percent: 0.613 becomes 61%.

+

The comma button lets you introduce commas into numbers to mark off
thousa nds.

+

The butto ns with li ttle arrows and zeros modify th e number of places d isplayed. If
yo u click the button with the right-pointing direction arrow, the decimal point in
your number heads for the right edge of the cell; the left-pointing arrow button
sends the decimal point in the opposite direction.

A little design
Late r in thi s chapter, I show you a ll th e g lo rio us formats available in Excel t hro ug h the

AutoFormat command, but you should get a little feeling for worksheet aesthetics on your
own before you start taki ng Microsoft's word for it. In general, here are some considerations
for worksheet design :

+

Indicate levels of head ing impo rtance with fo nt size, but don't use a large range of
sizes. A difference of two between the largest and sma llest text in a worksheet looks
good.
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You're accusto med to seeing head lines in sans-seri f fo n ts a nd text with seri fs. If it's
good enough fo r magazines and newspapers, it's good eno ugh fo r you (see Figure
13. 7). Put head lines and big text in sans-serif and small tex t in serif fo n ts.
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Figure 13.7 Standard headline conventions.

+

A well-design ed worksheet lo o ks eve n better in print with the grid lines turned off
(see Figu re 13.8).
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Use drawing elements sparingly.
One or two range borders are plen ty on a single page.

Options, the Hidden Formatter
I just suggested that you look at your worksheet with the gridlines turned off. But I didn't tell
you h ow to do it. That's because I want to highlight one of the major pieces of weirdness in
Excel 5: the absolute junkyard of commands stashed under the Tools menu in the Options
dialog box.
For example, you may assume that the way you format o r view the whole worksheet can be
fou nd in the commands und er the Format or View menus. Wrong-it doesn't work that way
in t he Microsoft world-and they're the ones in charge. If you pull down the Format menu
and choose Sheet, you find that your formatting optio n basically consists of hiding your work.
Instead, after you choose Options from .the Tools menu (see Figure 13.9), you get the Mother
Of All Tabbed Dialog Boxes-Excel Control Central (see Figure 13.10).

CD 'IIi

WlndoiU

Scenor los •..

c
Record Mncro •
n sslgn Mocro •.•
0J)IIons ...

Figure 13.9 The all-important Options command.
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-.::..;::.:..:..:=:;...-----,---+---,--------,+-1-H- Gridline
control.

r&1 Ro'W & Column 11eoder'
r&1 Outline svmbol'
r&1 Zero Vel u~
r&1 Horlzontel Scro11 Ber
181 VertfC81 Scroll Bllr
r&1 Sheet Teb3

Agure 13.10 The View tab in the Options dialog box.
In this giant grab bag of leftover formats, there are really three tabs that concern formats.
The View tab, shown in Figure 13.10, controls most aspects of screen appearance, including
gridlines, page breaks, and the regions (sheet tabs, scroll bars) at the edges of the worksheet.
The Color tab (see Figure 13.11) controls the default colors for charts and text.
The General tab enables you to set the number of sheets in a workbook and to set the defa ult
font and size (see Figure 13.12). If you like to work in 12-point Times Roman instead of 10point Geneva (and you ma ke better-looking worksheets if you do), you can make the default
changes here and have it done with once and for all.
Finally, I should point out that almost everything I have to write about in this chapter depends on the Edit options being set to the standard defaults shown in Figure 13.13. For
example, editing directly in cells (instead of editing only in the formula bar) depends on
the check box for cell editing being checked as shown.
As a shortcut, if you know that you will always be working with money calculations rather
than as a rocket scientist, you can set the check box in the Edit tab for two decimal places. It
doesn't affect the accuracy of calculations, and it means that you don' t have to keep setting
the decimal places in your worksheets.
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Standard Colora:

Othet Colon:

ng Modify gets you
to a custom color palette.

Figure 13.1.1. A gray view of the color tab.

User Name:

IUnkno'Wn User
Set fonts and sizes here.

Figure 13.12 The General tab in the Options dialog box.
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Figure 13.13 The Edit tab in the Options dialog box.

Cell Formatting
Excel 5 has taken the approach that all reall y complex functions should be d irected from a
tabbed dialog box, and formatting is no exception. If you need more formatting than what is
available from the Formatting toolbar, use the Format Cells command. Either find Cells under
the Format menu, or press ):C-1 (when using a PowerBook, it's often easier to use a key command instead of the delicate little trackball).

Number
Let's look at the tabs in the Format Cells dialog box one at a time. The Number tab contains
interesting information about n umber formatting (see Figu re 13.14).
At fi rst, this collection of formats can seem somewhat bewildering because of the odd for mat
notation left over from earlier spreadsheets. Here's an illustration of what happens to the
number 1234.567 under different formats:
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Format Cells
Number
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Figure 13.14 The whole range of number formats.

Format

Effect

Comments

0

1235

Rounds off to integer

0.00

1234.57

Rounds to h undredth

#,##0

1,235

Rou nds, adds comma

#,##0.00

1,234.57

Ro unds to hundred th, with comma

#,##0_)

1,235

Negatives in parentheses

#,##0.00_)

1,234.5 7

Nega ti ves in parentheses

For each of these formats, there's also a version with a dollar sign. By the way, if you look in
the notorious Options dialog box from the Tools menu, th e Module General tabs lets you
change dollar signs to English poun ds (£), if necessary.
Here are a few more useful observations about number formats:

+

The Custom format contains a variety of fixed decimal point formats, often of
doubtfu l utility. If you have data for which the custom format 0.000000% is
appropriate, I'd like to know what it is. Write me at Hayden Books!

+

The Accounting format is just li ke th e general number formats except t hat negative
numbers appea r in parentheses. This is generally a better choice tha n putting
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·n egative number in red because sooner or later most financial data is printed in
black and wh ite an yway.

+

The Date fo rmat uses 111111111 to indicate three-letter abbreviations of the names of
mo nths. This is somewhat confusing because the Microsoft convention fo r m inutes
in the Time format is 111111.

+

The Percentage format repea ts most of the percentage fo rmats that also appear
under Custom. In practi ce, it's faster to define percentages fro m the f-o rmatting
toolbar and move the decimal point with the decimal button.

+

f-ractio ns are a problem. If you type 1/ 4 in a cell, Excel thinks you mean j anua ry 4,
and it helpfully adds the current year. You can't go back and reformat the cell with
this dia log box either. To enter a fraction, either enter it as 0 1/ 4 in the first place
o r format the blank cells where th e fractions wil l go by using the Num ber dialog
box and Fractions from th e scrolling list. Then enter the fraction s in the preformatted range of cells.

Alignment
Using the butto ns in th e toolbar, you can slosh text to th e right, to the left, o r pin it in the
middle of a cell. In the Alignment tab of th e Format Cells dia log box (see Figure 13 .1 5), you
can do a miniature page layout inside cells. Here are a few key points:

+

In the O rientation area, you have choices for making text run up and down rather
than sideways. It's tricky to find an approp ria te use for this capabi lity-a lo ng title,
for example, really displaces cells when it's printed ve rtically.

+

The too lbar fo rm atting buttons fo r alignmen t contro l right-to-left movement of
text. Here you have Vertical o ptio ns for when you wa nt to move text around in a
large box to keep it close to releva nt numbers in ad jacent cells.

+

The justify choice, in either the Hori zontal o r Vertical areas, means that text is
fitted inside the cell- it's a so rt of automatic word wrap.

+

The Wrap Text check box g ives you a cell th at behaves m uch like a page in a word
processor. If you type a long piece of text into a cell and fo rmat it for word wrap,
after you enter the text, you should double-click o n the bottom of the row heading
to fit the cell's vertical size to display aU the text (see Figure 13.16). If you adjust
the cell's width, you have to read just the height.

The way to use space efficiently in a worksheet is to use Wrap Text for every title lo nger than a
few words. A long ti tle im poses a w ho le colum n of white space o n yo ur worksheet and makes
it difficult to keep important data o n a single page.
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Figure 13.16 Word wrapping in action.

Font
Font formatting is one of the functions best represented on the Formatting toolbar. As a result,
you probably won't find yourself very often in the Font card of the Format Cells dialog box
(see Figu re 13.17). Here are some practical uses for these options:

+

In Excel S, you can apply many styles to individu al words and characters inside a
cell (see Figu re 13.18). Double-click in side the cell to get an insertion-point cursor
(vertica l bar) in the cell, or edit the cell contents in the formula bar.

+

You can use the Font tab to change text color, although my usual whining caveats
about color and printing still apply.

+

Shadow and outline text are seldom seen in annual reports or accounting documents, but you can find them h ere.
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•

If you use subscript and superscript often, as in scientific work, you may want to
make a little library of fo rmatted cells somewhere in your worksheet so that you
can copy these formats and then apply them with the Paste Special command.

•

In the underline options, the single- and double-accounting underlines look cooler
than the standard underlines.
Format Cells
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Figure 13.17 The options available in the Font card.
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Figure 13.18 Every character in a cell can be form atted separately.
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Four border styles in one cell.
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Figure 13.19 Options for cel l borders.

Borders
There's really not much to the border business except that th e level of control in the Border
tab of the Format Cells dialog box enables you to construct some ludicrous special effects (see
Figure 13.19) . You can specify a different border style and color for each side of a cell.

Patterns
In my opinion, if there were a Federal law passed against the use of the Patterns tab (see Figure
13.20), no one would suffer very much. Generally, colors superimposed on black-and-white
cells just make the numbers harder to read and create d ifficu lties in printing. Patterns are a bit
more useful. You can pick a ligh t pattern to set off a block of cells (see Figure 13.21), an d this
kind of pattern even prints correctly.

Protection
Using the Protection command under the Tools menu, you can protect individual worksh eets
or a whole workbook. Using the Protection tab in the Format Cells dialog box enables you to
hide and lock cells (see Figure 13.22) in protected worksheets. But here's the confusing part:
you can protect a worksheet without selecting a password, meaning that anyone can open
the sheet. To do this doesn't really offer protection, but it does let you use the hide and lock
options.
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can do color grids!

Figure 13.20 The Patterns t ab, where you can choose a background pattern for you r cells.
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AutoFormat
Earlier in this chapter, I remarked that all of us have lots of conditioning about table aesthetics
fro m years and yea rs of seeing tables presented in books, magazines, and newspapers. You
could, in principle, reconstruct tables li ke these by working with the Format Cells dia log box.
But table fo rmatting is a wheel that's been reinvented doze ns of times before, and your own
contributions to this effo rt are not exactly necessary. Microsoft has bui lt in a gallery of common, reasonably good-looking table formats and has stashed them under the AutoFormat
command in the Format men u. The table in Figu re 13.21 is a good starting poin t for display·
ing some of the formats. I selected the range Al to G7 in Figure 13.23 and then applied a
variety of formats to d isplay in Figure 13.24.
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Figure 13.23 A simple t able.
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Figure 13.24c Classic 2.

Figure 13.24d Colorful1.
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There are a total o f 17 AutoFormats fo r tables. You can apply an AutoFormat, m odify it, and
then save the format so that you ca n apply it with the Copy/Paste Special sequence. Some
fo rmats introduce lo ts o f space into a table by employing wide columns-these fo rmats call
for an inspectio n in Print Preview before printing because they probably need to be printed
in Landscape (sideways) mode. In general, tho ugh, a little Print Preview inspectio n is the
only precaution that applies to AutoFo rmat.
If you want a spread sheet that looks really professional, but you have only 90 seconds to
d evote to fo rmatting, just use AutoFormat. Microso ft has do ne an excellent jo b o f selecting
useful fo rmats here.

Drawing Tools
Often the simplest way to highlight some feature of a worksheet is to use Excel's built-in
drawing tools. If you want to pick ou t a pa rticular elemen t, fo rmatting a whole table wit h
AutoFormat isn' t much help-you're better off using a po inter or color coding a region .
If you don't have the Drawing toolba r showing onscreen, you can select it in the Toolbars
dialog box fro m the View m enu (see Figure 13.25). The Drawing toolbar provides a complete
set of drawing tools (see Figure 13.26), including tools for grouping and ungrouping Draw
objects. In real-life spreadsheet practice, the most useful elem ents from this toolbar are the
arrow pointer and the filled-shape o ptio ns (see Figure 13.27). While in principle there may
be worksheet applicatio ns fo r the sq uiggle-draw tool and fo r placing different types of shaded
blocks on a sheet, I've n ever seen Drawing elements make a big differen ce in a business
presentation to venture capitalists.
Now you know about formatting cells wi th Excel. Let's look at how you ca n format them
quickly!
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Figure 13.26 The Drawing toolbar as it appears in a worksheet.
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Figure 13.27 Highlighting cells with the Drawing tools.

Filling In Cell Ranges
There's an easier way of doing all this formatting, right? Yes, there is. It's almost a defining
characteristic of Excel that there are six different ways to do any common task. You can use it
as an all-keyboard program, or you can use it as totally mouse-centric. You can go through the
menus, or you can use toolbar b uttons for most tasks. There are loads of hidden keyboard
shortcuts for common tasks, a nd there are some sim ple ways to organize your work and your
worksheets to make things go fas ter.
After you've been using Excel 5 fo r some time, you'll probably settle down to using a fairly
small repertoire of shortcuts, mainly because it's impossible to remember them all.
Caution: Using an early version of Excel 5 for the Power Macintosh, I found

e
'

that all the tricks in this chapter work correctly, but in some cases, they
are actually slower than simply using commands from the menus. It's not
clear why this is true, and it's not clear if it will be true in later, more
optimized Power versions of Excel 5. But for now, the suggestions in t he
rest of this chapter are for convenience rather than speed.

•

'

Suppose that you are facing the blank worksheet in Figure 13.28. You made it to this
wor ksheet by starting up Excel-either by double-clicking o n the Excel icon or by selecting
New from the File m enu. Now it's time to make so mething happen, and the goal here is to
make it happen with a minimum of typing.
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Figure 13.28 A clean slate.

Excel 5 has considerable, but quirky, intelligence built into it for filling ranges. Here are just a
few examples:

+

The simplest action for filling a range of cells is to repeat its contents. To do this,
you can select a cell, choose Copy from the Edit menu, select another group of
cells, and choose Paste fro m the Edit menu. However, there is an easier way. Every
time you select a cell in Excel 5, the cell displays a fill handle in the lower righthand corner. If you select a cell with data in it (see Figure 13.29) and then point to
the handle, the fill handle turns into a plus sign . Click the mo use button, hold it
down, and drag down, sideways, or diagonally to copy the conten ts to as many
cells as you like (see Figure 13.30). This action loads the cells faster than the Copy/
Paste routine, and as a technique in Excel, it's called A utoFi/1.

+

Another way to fill a whole cell range with the same contents is to select the range
by dragging the mouse across it, type the contents, hold down the Control key,
and then press Return.
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Figure 13.29 Selecting a cell to repeat.

Excel fi lls in -

-FiiR-----::---=--==-----r

the rest of
the range.

Agure 13.30 AutoRIIing the same values.
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+

What happens if yo u have two cells with different contents? In Figure 13.31, the
cells with 1 and 2 typed in are selected, and then the fill handle for the selection is
dragged down. As yo u can see, Excel tries to figure out a pattern from the selected
cells and continues the pattern throughout the larger range.

+

In Figure 13.32, I'm having a little fun with Excel by seeing how accurately it can
guess d iffe rent patterns in data. Again, it's just a matter of dragging the fill handle
over the range that you want to fill.

+

Excel figures o ut your abbreviati o ns. If you type Mon and Tue in your first two
cells, Excel continues with Wed and Thur; typing Monday and Tuesday in the
"starter" cells gives you Wednesday and Thursday. Note that Excel interprets many
kinds of numbers as dates. In this case, I actually typed 1/94 and 2/94 in the starter
cells for one of the date ranges and Excel LTanslated them into month names.

After you -1~:1----t======:=:n
select'the
cells that
contain 1
and 2, Excel
fills in the
rest of the
ra nge.

Figure 13.31 Excel f igures out a fill patte rn .
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Five variations on AutoFill.

Figure 13.32 Excel figures out AutoFilling for dates, days, and numbers.

Custom Filling
If you hold down the Control key while you drag the plus sign cursor through a range, the
pop-up menu in Figure 13.33 appears. This menu gives you many options, including the Series
option, which gives you almost complete control over the arithmetic series that fill in the
range with the first cell as a starting value. It can figure out that you want 1, 3, 5, 7 and so on
as a series or 5, 10, 15 an d so on, or n early any other series. (If you used algebra class in high
school to take naps after lunch, you should know that the teacher was discussing number
series much of the time that you were asleep.)
Unless Excel is consistently m isguessing your intentions, or unless you need something
fancy-a logarithmic or exponential series fill, for example-using this pop-up menu and the
Series option takes more keystrokes than taking two starter cells and AutoFilling them by using
the cross-drag method.
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Figure 13.33 The pop-up menu for filling contents into cell ranges.
Internally, Excel is really handling two different kind s o f objects in AutoFill . It has number
lists, upo n which it performs small computa tions-that's how it can figure out tha t the next
number in a range will probably be 3 if the fi rst numbers are 1 and 2. And it has text lists, wit h
the most common lists (days and mo nths and so fo rth) preloaded.
As it happens, Excel stands ready to deal with any text list as an AutoFill subject. In r:igure
13.34, I have entered a seri es o f expense categories that journa lists typ ically track fo r tax
deductio ns (when I recently started keeping decen t records, I found that I was spending nearly
20 percent of my disposable income o n books!). From the Optio ns choice under the Tools
menu, I have selected the C usto m Lists tab (the tabs look like the little "ears" o n manila fi le
folders), where you can see the sh ort list o f Auto Fill text lists that Excel has pre!oaded. To get
my own list included, all I do is click the Impo rt button, and my entries now have the same
status as t he days of the week (see Figu re 13.35).
To use this slick option, just ty pe the first word ("Books") of the list into a cell, selec t it, and
drag the plus sign cursor. If I type an u ppercase starter word, Excel adjusts the rema inder o f th e
list to be uppercase, too. The po int o f all these shenani ga ns is that if you have a job that lasts
for at least a mo nth, you're likely to make up mu lti ple worksheets with the same row and
bo rder labels. Rather than lo ck this info rmation into whole worksheet templa tes, you ca n sto re
these labels in Custom Lists for efficiency.
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This selected
list will become
an AutoFill
option.
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Figure 13.34 The Custom Li sts t ab in the Options dialog box f rom t he Tools menu.

Figure 13.35 Adding a custom AutoFill list.
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Fast Worksheet Navigation
You now have befo re you a vast ocean of cells, a sea of little rectangles so large that scrolling
around by using just the scroll bars is a serious inconvenience.
The first worthwhile navigation trick is to assign names to cells that you visi t frequently. The
fact is, most worksheets consist of different rectangular p atches of numbers with a few labels
along the edges. You can, of course, keep track of the "action areas" in your worksheet-use
the Go To command under the Edit menu to zip to the place in which you're headed. Bu t it's
much easier to name a cell in the upper-right corner of each important rectangle in your
worksheet.
Here's what you do. Just type a label in a cell (see Figure 13.36), pull down the Insert menu to
the Name choice, and pick Define. You see that the cell name now appea rs to the left of the
formula bar area (near the top of the wo rksheet). When you click the li ttle triangle next to the
cell name, you get a scrolling list of the cell names (see Figure 13.37) that have been defined
for that worksheet.
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Shortcuts for Selection
This section is a little collection of shortcuts fo r selecting ranges. There are probably 40
possible tips, but most of them are rarely used. Here's an assortment of tips that you are likely
to use. Some of these keyboard methods, by the way, have the helpful effect of reducing your
dependence o n mouse/menu methods, which some physical therapists believe are a large
component of common stress injuries.

+

To select a whole row, select any cell in the row and press Sh ift-Spacebar. You
can also click on the row number, which is found on the left-hand edge of the
worksheet.

+

To select a whole column, select any cell in the column and press ControlSpacebar. You can also click on the Jetter (or letters) of the column heading.

+

By selecting a row with Shift-Space bar and then pressing Control-Spacebar, the
whole worksheet is selected (see Figure 13.38).

+

After you have an area selected, you can erase the contents (but not the fo rmatting)
by pressing ~-B.

Figure 1 3.38 Selecting the entire document.
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Style Tips
There are really two kinds of tips for rapid formatting that make practical sense: using Format
Painter and using defined Styles.
Format Painter is represented by the little paintbrush button found under the word Format on
the menu bar. Here's what you do:
1. First format a range of cells to your satisfaction.
2. Select the range by using the mouse.
3. Click on the Format Painter button.
4. The cursor now turns into a plus sign with a paintbrush (see Figure 13.39). You can
drag-select a new range of cells with this special cursor, and it will transfer all the
formatting attributes of the original range to the new range.
Because workbooks have a whole folio of worksheets, you may want to reserve one worksheet
to be a repository of fancy formats for transferring to other worksheets.

Click this
button ...

Figure 13.39 Format Painter's special cursor.
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Another way to do special formats for ranges of cells is to name your own styles and apply
them . If you've spent more than five minutes or so developing a complicated forma t (or a
fancy format fo r a table), you owe it to yourself to save it (so that you can use it aga in).
In the software business, th ere's an ongoi ng debate abou t reinventing the wheel, called "The
quest fo r software component reusability," which just means that you shouldn't have to do
the same coding over and over aga in. When you format, you're really writing a little program,
so when you save your formatting instructions, you're doing so mething programmers wish
they could do at Microsoft and Apple o n bigger projects. Congratulations!
Simply format cells the way you want them and fi nd the Style command under the Format
menu. In the Style Name box, invent a name for t his style (see Figure 13.40) and click the Add
button. Whenever you want to use this combination of for mats (a particular fo nt, size, color,
number format, or font style), yo u ca n apply it by selecting it fro m the standard Style list in
the Style dialog box. Just remember to give your style a name that's self-ex planatory because
you may find yourself scrolling thro ugh the style list weeks later wondering wha t it was!
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Figure 13.40 A user-defined Excel style.
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Useful Keyboard Hints
There are hundreds of strange little keyboard combinations buried in Excel 5. Of these, a
handful are worth remembering. Table 3.1 lists the important combinations. You may want
to photocopy this table and keep it near your Mac for Excel work.

Table 3.1
Keyboard Operations
Key combination

Result

~ -H ome

Move to cell Al

~ -A

Select all cells

Contro l-Shift-$

Format as $0.00

~ - Op ti o n-0

Apply border to selection

K PageUp

Move to preceding sheet

:J::e-PageDown

Move to next sheet

:Joe-L

Display Define Cell Nam e

:Joe-Shift-S

Display Save As dialog box

:J::e-Z

Undo

:J::e-T

Repeat last actio n

Speed
Most of the time, you'll want all the formatting help you can get when setting up a worksheet.
The Tool bars dialog box, reached from the View menu, shows the profusion of toolbars that
you can use as o nscreen guides (see Figure 13.41). You can ask for larger butto ns (see Figure
13.42); you can ask to see TooiTips (little balloon-style explanatio ns of the buttons); and you
can apply bo th of these optio ns to any toolbars that you care to leave o n your worksheet.
After you have a worksheet formatted to your satisfaction, and you find yourself worki ng
exclusively with numbers, it's time to go back to the Toolbars dialog box and hide everything by
turni ng off the check boxes (see Figure 13.43). A worksheet with all the au xiliary gunk hidden
runs much faster. The same is true of graphics, a subject wh ich will arise shortly. [f you leave
lots of colo r graphs lying arou nd your worksheet, you take a grueso me performance hit every
time you do a recalculatio n.
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OK

~

Cancel

- He-..,
Rent
Customize ...

ij

Help

gj s how Toollips-

Figure 13.41. The nearly unimaginable profusion of tool bars.

This is not a small consideration. Excel S has plenty of cool features, but in many cases they
have been added at the expense of speed. If you have a worksheet formatted to your satisfaction, and you are working mostly with the numbers in it, go ahead and hide all the formatting
stuff. You can always call it back by using the View menu.
This chapter shows you several ways to format the plain, quick-and-dirty works heets of
Chapter 12 and how to do this with a minimum number of keystrokes or mouse movements.
In the next ch apter, you learn how to organize your worksheets into workbooks.
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Figure 13.42 Big buttons are easier to see.
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Suppressing the toolbars.
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A big problem in day-to-day wo rks heet use is keeping track of all the worksheets generated fo r
different purposes. Excel 5 goes a long way toward solving this problem (you still have to think
up filenames yourself!) with its new multisheet workbooks. Now wh en you open a single
workbook file, you open the whole series of related worksheets that you have stasl~ed together.
Because a workbook is a collection of worksh eets, Excel 5 h as 3-D worksh eet capabilities that
enable you to perform operations on ranges of cells through whole collections of cells. This
chapter includes the following information:
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Summaries
Excel S is a big program, and this chapter shows some of what it's do ing with all that memory
it hogs. On e example is the Find File operatio n, which is now tr uly powerful but has the
complexity of a full search program th at would take 200K to code as a stand-alone program .
Because all th is interesting stuff is built into Excel S, and you can't unload any of it to get a
sma ller, faster program, you m ay as well enj oy the luxury touches.
In the o ld days, a filename was the only informatio n you could use to identify a file (actually,
in the o ldest o ld days, the filename had to be eight letters o r less!). But Microsoft designed the
new Excel to meet the growing needs of corporate Am erica-in fact, today you can literally run
a modest Wall Street bro kerage wi th Excel S on a Macintosh 840AV (with an array of hard
drives).
With Excel S, your worksheet files can have mo re identification li nes than your own passport.
Consider the little worksheet in Figure 14.1. All it contains is a little table of numbers and a
few wo rds. After fo rmulati ng a little bit of work li ke th is, th e odds that l wo uld remember its
exact name a few months later are approxim ately zilch to 3000. Wo rking with Excel day after
day, you're li kely to have dozens of files, and you'll probably start to have trouble findin g your
earlier work.

w File

Ed it

Ulew

Insert

ooto Window

Forma t Tool s

IID]~IIiii i~(}.II~J IJl, 1~]81~1 1~)[no] ll: lfi,

I~

0 14

I
0

~

II

c

D

~
1-

~~-- -~ --

2,

-

-1

- T

r!-

~
...!..!..
~

...!.!

-

-

--

~I

4

-1-

6

-

HJ\Shcetl

Shcet2

i

Shcet3

i

H

I

Shcet4

--

-

-

·+--1---

l ~i

~

1

'-

-- _J__

c

1'

Footno.!_eJ.:. !:!_o lme s ne ver octuoll y ~!lid thi s

~
IS

•M

["

r--..----I
-..
-

El em entory, My Deor Wots on

~
s

II

_I- _] - ::_ ~- - _,

1_

.....!_

_!.!!.

li!l

Element ary
A

...!...

1191£m)

oo\11

II ) You can oove a rtlc under a ncy nemo by prosol ng COHMAHD +SHI FT+S.

II

~

Jllm.IJ llj;II!OO]I~

119 rEJ IB •I I I~u]I"I•I~Jml l dlll%11 · 11:6l!]lsi@JEI&1J8rtia
~ [g][9lj

jGono""

IQ

(;l.J . .
11

i

SheetS

i

911ttl6 ~ ~ •

Reedy

Figure 14.1 A basic worksheet .
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That's why Microsoft added a fo rm to Excel that records all sorts of info rmation about your
workbook fi le (see Figure 14.2). When you start a new workbook and save it for the first time,
Microsoft shows you the Summary Info dia log box. Each field in this dialog box (Title, Subject,
Author, Keywords, and Comments) is searchable by Excel's built-in file searching functions.
If you put a li ttle thought into the Keywords and Subject fields in particular, you'll find it
relatively easy to retrieve files-even after you've forgotten what the files are named. Note that
you can also ca ll up this dialog box (from th e Edit menu) as Summary Info any time you
choose.
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Figure 1.4.2 The Summary Information dialog box is your friend.

To make the search more efficient, put different kinds of in formation into each Summary
Info field. That is, if you have a workbook called 1995 Budget, don 't just put budget into the
Keywords and Subject fields; instead, think of some other information to identify the workbook (expenses? tax? payroll?).
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Find File
Having written a nice description of your workbook, you can practically forget about it and
rely on Microsoft to retrieve it for you. You .can do this from anywhere in Excel. Pick the Find
File comma nd from th e File menu (see Figure 14.3).

Th ree

blllu

different file

P"lH

( Command••)

views.

Figure 14.3 The beginning of Find File fun.

First-level searching
How do you actually find something? The simplest level depends on the Search button, wh ich
will get you to a dialog box (see Figure 14.4) that expects you to know the name of the file that
you want. Note that t h is d ialog box has a built-in provision for saving search results to a list. If
you search, for example, for the word budget in the r:ile Name text box, the p rogram finds nil
your fi les with budget in the fi lename. This can actually be useful because Excel can keep t h e
search resu lts ava ilable in the Saved Search es pull-down menu. Eventually, if you have used
some discret io n in you r c h oice of filenames, you'll develop a library of related files that ca n be
fo und rapidly by using this d ialog box.
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Rgure 14.4 This is t he first search leve l in Excel's Find File system.

Advanced searches
After you click on the Advanced Search button in the Search dialog box, you can retrieve files
based on Keywords and Subject (see Figure 14.5). You can speed up the search by narrowing
down the search space. If you know your file is hiding on a particular hard drive, you can
specify that drive in the Location tab of the Advanced Search dialog box. Then Excel doesn't
waste your time churning through the wro ng drive. I don't know why, but I've had better luck
searching for Keywords (you can use multiple keywords if you separate them with commas);
the search process just seems to go faster.
The Advanced Search dialog box has a little beehive of options in its three tabs. If you want to
search for text in a workbook, there are options (Special, Use Pattern Matching) that allow you
to be stunningly, delightfully vague and still produce usefu l search results (see Figure 14.6).
You can, for example, search all workbooks for one that doesn't contain the letter Z.
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Search on
these bits
of file
description.

Figure 1.4 .5 Advanced searching.

Special options
for text
searching.
Expression
No t
Num Occurrences
Pre ~lou s I or More
0 or ~lore Cherecl ers

Figure 1.4.6

Advanced Search options.
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Reviewing search results
After Excel finds a file that meets yo ur criteria (j ust type the criteria in the Summary tab of the
Adva nced Search dia log box and click the OK button), you have a number of ways to look at it
as well as a number of file processing o ptio ns. Figure 14.7 sho ws the Preview view of m y
humble little file. Preview is, of course, helpful fo r m aki ng sure that the search procedure
actually fo und the file that you wa nt.

A thumbnai l
v iew of your
fi le.

Figure 14.7

The Preview view of a search resu lts in Find File.

Figure 14.8 shows ano ther view of the search results, this time a listing of the informatio n in
the Sum mary dialog box. It's ano the r way to make sure that a search o n a few words found the
fi le that you want. Figure 14.9 shows the simplest view optio n, the File Info view, which is
usefu l most ly for scanning multiple files.

An Old-Fashioned Idea That Works!
Okay, l know t hat you' re not always going to want to use this technique in the heat of
worksheet creation, but here' s a good way to keep track of your work. When you fill out a
Summary dialog box, capture the screen with the Summary informat ion (use :J:C-Shift-3). Then
continues

329

Part Ill

Exce l 5

file (called Screen 0 or a higher number on your hard drive) by using the System
utility and print 1t. Take a standard three-hole punch to the printed copy and keep
The ring-binder technology may seem old-fashioned, but it enables you to keep
~J<e~fiWcros for when your memory finally goes completely to, urn, ruin.
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Summary view lets you check subject and keywords.

More file tricks
After you find a set of files in Find File, use the Commands button (see Figure 14.10) to see a
few more interesting options. At the simplest level, you can open the file in Read Only mode,
which may be necessary if the little Preview view doesn't show you enough to recognize the
workbook. (Actually, the Preview is a corner of the firs t worksheet in a workbook, so unless
you put something distinctive there, you may need to use Read Only.) You can also delete a
workbook that you find in Find File.
The. other Commands choices are a bit fancier. You can copy from this dialog box (see Figure
14.10). The Copy command calls up a slightly different dialog box (see Figure 14.11).
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Check
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size.

Figure 14.9

The File Info view.

These
commands
are the basics.

Figure 14.10 Commands for search-list files.
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Figure 14.11 Copying fi les from the Find File system.
If you search on a fairly vague criterion and find a lo ng list of fi les, you ca n also sort th em in a
specific o rder (Excel lists them in the o rder in which it finds them). After you choose Sort from
the main Find File dia log box, you are presented with the Options dialog box shown in Figure
14.12. Note that you can see the fo lders where the workbooks are located, ano ther guide to
identifying the actual file you are trying to find.

Moving and Copying
Now that you know how to find any file that you ever made, you need to know only a bit
about copying and moving worksheets to make your fi le-management life complete.
Microsoft, in its ceaseless efforts to anticipate your every need, has put a special option called
Move or Copy Sheet in th e Edit menu . Can't get mu ch simpler than that, can you? When you
select this option, the whole worksheet that's currently active is ready fo r shi pping (see Figure
14.13). Either check the tin y box for creating a copy o r tra nsfer (Move) the whole worksheet
(the equivalent of cutting and pasting the worksheet) in to another workbook. At th is poi nt,
please note that you don 't have th e fu ll standard range of Macintosh file optio ns open (you
can o nly access workbooks in th e folder you' re currently using), but you can ask to crea te a
new untitled workbook for a destination of the Copy o r Move operation.
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Figure 14.12 Make sense of Find File lists wit h the Sort options.
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After you move o r copy a worksheet to ano ther workbook, you may want to give it a name
with a bit of content (all these sheets labeled Sheet 1, Sheet 2, and so on get confusing). just
positio n the mouse cursor over the tab at the bottom of the sheet, double-click, and you get a
dialog box that lets you name the worksheet. This is a vast info rmatio nal improvement over
the names that Excel provides fo r you at the end of a copy o peratio n.

Keeping Track with Text Boxes
Sorry to keep harping o n the theme of the frailty of human m emo ry, but I think that every
advantage in documentation o r retrieval by keyword will redound to your credit later. In
Chapter 16 in the auditing section, you see me preaching on this theme again.
Text boxes (see Figure 14.14) are a great help in worksheet documentation problems. The Text
Box button is second from the right on the Standard toolbar (it's the little rectangle with lines
in it). Click this butto n and drag a zone on the worksheet. You see a plain box with an insertio n point (blinking line) cursor. Type in any comments you like-explain your formulas, tell
the world what you a re trying to accomplish in your worksheet, and include some hints for its
use.
I-I ere's the Text
Box button .
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Figure 14.14 The text box is a great worksheet documentation aid.
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A text box is an object, so when you pull down the Form~ t menu to modify the tiny, hard-toread Geneva text (which is the Excel default), you see Object as the first command. The Format
Object dialog box has a collection of tabs for all purposes. I formatted the text box in Figure
14.14 by using the Font tab to produce the lovely New York 14-point text. Other formatting
option choices include Properties and Protection (see Figures 4.15 and 4.16). The Properties tab
deals mostly with positioning, while the Protection tab keeps others from modifying your text
notes. Unless you select a text box and hide it, it floats eternally in a tranquil plane over your
worksheet, always ready to be consulted. If you like, you can also select and print a text box
separately.
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Formatting text boxes with the Properties tab.

Cell Notes
As an additional documentati on aid, you can attach cell notes that also explain what you had
in mind when you tucked a formula into a given cell. Unlike text boxes, which are invoked
from the toolbar, you simply add a note by using the Insert menu's Note command after you
select a cell (see Figure 14.17).
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Figure 14.17 The Cell Note dialog box.
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Also, unlike text boxes, these cell notes aren't in you r face all the time-you must tell Excel
that you want to see t he note's co n tents. Excel let's you know that there's a note in a cell
because it displays a miniature dot in the corner of the cell (it's red on a color monitor). The
simplest way to review the contents of cell notes is to display the Auditing toolbar (choose
Toolbars from the View menu and click the Aud iting check box), select th e cell with the note,
and click the Information (i in a circle) b utton (see Figure 14.18). You then get a view of the
cell no te's contents (see Figure 14.19), and you can close the window to hi de the contents
again.
In my opinion , every time you write an Excel formula that isn't painfull y obvio us, you shou ld
tag the cell with a little n o te. Excel 5 files have plen ty of overhead a nyway (this little file in the
figures with a mere nine numbers and a few words takes more tl1an 8K}, so you may as well
Get With The System and load your worksheets with documentation. Hey, lightning could
strike you tomorrow, and you r poor co-workers would have to puzzle out your worksheets
from scratch if you don't leave a few notes. Be a pal.
These little blips indicate the
presence of cell notes.
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Linking Worksheets
In one view of th e Excel workbook, it's just a collection of independent sheets, just like sheets
in a notebook. But there's a big d iffe rence between worksheets and sheets of paper: Excel
sheets can be li nked, which means that information fro m one sheet can be connected to
another sheet. The info rmation is "Hve," in that a change on the original sheet automatically
prod uces changes in the linked sheet.
There are two ways to li n k data: li nking between sheets in the same workbook and linking
between sheets in d iffe rent workbooks. For many purposes, the simplest way to form a link is
to use the Paste Special dialog box (see Figure 14.20). This d ialog box includes a Paste Link
button that directs the Paste operation to maintain Jive li nks to the data in the originating
worksheet.
Li n king with Paste Special is a sort of tutoria l in li nking techno logy. Figure 14.21 shows the
li nki ng fo rmu la that places the little table in Sheet 1 of the Elementa ry workbook into Sheet 2
of the same workbook. Look at the expression in the fo rmula bar:
= (Shcctl!$B$6:$D$8}
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Figure 14.20 Paste Special is the simplest linki ng too l.
•

File

Edit

Ulew

Insert

For m o t

Tools

Data

Window

11:07 PM

I! DI!Sir&nHei]111.1 ~H~ l~ltm1?1EE]ILITt:] [illll) lus;lllll41ll too~~>

18 ITO El lo lri l lil l!:l•

iGenev•

IJ!l ~ 5
18 ~

lf!lwll $1%l , l~o8]i~I!EiE) ~ ~
This formula
gives the
name of the
cells on the
other
worksheet.

B3

lflOR I

Figure 14.21 Linking inside a worl(book.

339

I

Part Ill

Excel 5

This says that the range planted into Sheet 2 originates in Sheet 1 (note the ! sign) in a rectangle of cells with its upper left-hand corner in B6 on Sheet 1 and lower right-hand corner in
D8. If l had put formulas into this range.on Sh eet 1, the Paste Link command wouldn't have
worked because this trick is for linking data, and Excel gets confused if you're trying to link a
range full of formulas. Lf you like, within a workbook you can write form ulas (on other
worksheets) that access data in a reference sheet. You just need to use the cell addresses of the
sheet within the workbook-that is, SheetS! $(cells) or whatever sheet is appropriate.
Now look at Figure 14.22. Here I have made anoth er workbook, Copy2 of Elementary. Pastelinking the table of numbers into this new workbook shows the following formula:

{=[Elementary] Sheetl!$B$6:SD$8J
This formula tells you that you can make up a formula that draws on any cells in any Excel
worksheet. The format requires only that you specify the workbook name in square brackets(Elementary]-the sb eet name followed by an exclamation point, and tbe cells in absolute
reference notation (the $ signs).

'*

File

Edi t

Ulew

Insert

Formnt Tools Dol o

-- - .f - -

Window

-~

:

c

~

3

~·

9
-

Figure 14.22 Linking between workbooks.
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Locking It Up: Protection
One last bit of workbook management concerns protection. The Tools m en u has a Protection
option (see Figure 14.23) that lets you lock individual sheets or a whole workbook.
When you decide to protect your workbook (perhaps you will be distributing it on a network,
for example, and you don't want other users tinkering with your numbers), you should usually
use a password (see Figure 14 .24) that you fa ithfully inscribe in your Excel User's Guide (so that
you can find it aga in). The other place from which protection ca n be invoked is the Options
button in the Save As dialog box from the File menu. The Options button brings up the Save
Options dia log box shown in Figure 14.25. If you give a password to the Write Reservation
field, other users are able to overwrite your worksheet, but they cannot save their changes
under the original worksheet name. This is actually very usefu l if you want to distribute a
template for calculations. Users ca n plug in their own numbers a nd then save their work under
their own workbook names, leaving your original template model unchanged.
This chapter discusses handling worksheets and workbooks. The next chapter gives you all
sorts of helpful information about incorporating charts into your worksheets.

Figure 14.23 Two protection options.
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Through Excel
The problem \Vith tables of numbers, even superbly formatted and appropriately highlighted
tables of numbers, is that they a ll have a strong family similarity. If you have a story that can
be summarized in a picture, most audi.e nces prefer to see th e picture rather than the numerical
tables. So this chapter explains how to get numbers into ch art pictures and to format these
numbers by using the vast assortment of charts built into Excel. It also ex plains how to use
charts to change the appearance of data reality without actually cheating-in o ther words,
how to cash in on th e secrets of using charts. The topics in this chapter include the fo llowing:
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Off to See the Wizard
In previous versions of Excel, you often spent considerable amounts of time puzzling over
your charting choices. Excel 5, in contrast, has the most high ly evolved version of
ChartWizard, an online baby-sitter that requires only that you be able to point to the style
of chart that you want. It's actually fairly entertaining to use ChartWizard, but it does impose
a certain way of doing things. You and ChartWizard will, however, get along just fine after I
explain a simple repertoire of reformatting tricks.
First, I'll set up some data, and then I'll get down to the business of charting. Here are the first
steps:

+

Set up a table by entering data and by putting appropriate labels along the columns
and rows (see Figure 15.1). You can add labels on your charts later, but the Excel
charting system anticipates that rows and columns will be labeled, so you save
yourself trouble by labeling in your table.
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Charting Your Way

+

Select a range of cells containing the data that you want to cha rt (see Figure 15.2).
If the data isn't in a connected block (a contig11o11s block, as they say downtown),
you ca n drag-select the first data range (for exa mple, th e part containin g labels)
and then ho ld down the ~ key and drag-select the second range, whi ch can exist
anywhere on your worksheet.

+

To get a chart, just click the ChartWizard icon (see Figure 15.3). Now when you
move the cursor back into the worksheet area, you have the mag ical chart creation
cu rsor. Find a place where you would like to put you r chart, click t he mouse, and
drag out a chart area.

+

That doesn't produce a chart just yet because Excel doesn't have enough info rmation. Instead of a chart, you get t he first panel o f th e C hartWizard sequence (see
f-igure 15.4).

Avg. Price
To t a l
$ 225.00 $
1,800.00
$
35.00 $
350.00
$
90.00 $
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$
145.00 $
435.00
$
60.00 $
2 40.00

t

L . . , _ - - - - - - - - - - - - - - - - - - - : - - - + -1-- Drag-select
this range
wi th the
mouse.

Figure 15.2

Selecting a range to chart.
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Figure 15.3

Excel 5

The Chart Wizard icon.
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Sheet2

The first Wizard step asks for t he data range.

Wizard options
If everything is working correctly, th e data range shown in Step 1 of the ChartWiza rd is the
data range selected with the mouse. If it isn 't, or if you've changed your mind about which
data you want to ch art, you can enter a different range in this dialog box. To make a split
(noncontiguous) range in a dialog box, enter a first range (for exam ple, $AS3:$A$8), followed
by a comma, followed by the next data range. Recall that the dollar signs mea n absolute cell
reference, which mean s that after you fire up the ChartWizard, it regards all the locations for
the data you've en tered as fixed fo r the du ration of the charting events.

So fa r, th is hasn' t been too exciting. But when you press the Next button in this Wizard, you
finally see some charting choices (see Figure 15.5) rendered in the Microsoft Imperial colors of
mauve, lavender, and pale yellow (the gray-scale representation here doesn't do th em justice).
Several of the charts are old standbys that are probably familiar to you just from reading
newspapers: pie, bar, li ne, and column charts appear every day in explanations of budgets,
exchange rates, and unemployment. Their 3-D equivalents are also available in this selection,
although their use req ui res some special consideration .
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ChartWizard - Step 2 of 5
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The Exce l 5 chart gallery.

Some other ch arts are fairly self-explanatory: XY scatter charts are really the same as line ch arts
without the lines connecting the data points, and combination charts just overlay two kinds
of chart types. Area charts are a way of stacking line charts to emphasize totals rather than
individual lines. 3-D surface charts are actually a sort of smoothed combination of a 3-D line
and a 3-D column.
The unusual charts in Excel 5 are radar and doughnut charts. j apan has a long tradition of
designing its own data graphics, so these are two exam ples that are used more in japan than
in the United States. A radar chart is used to display the com position of several aggregate
substances in the same ch art, an d a doughnut chart basically lets you present multiple pie
ch arts on top of each other (the second and th ird pies appear in the doughnut hole).

And more options
After you pick a chart type, you get to pick among variations on the chart. Some of these types
(see Figure 15.6) are just appearan ce variations that look slightly better in print, while others
are designed to reflect changes in trends rather than in absolute numbers. Let's pick the
plainest-va nilla ch art in the pack, press Next, and get to the next step in the Wizard sequence
(see Figure 15.7).
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Some standard column charts.
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In Step 4, you finally te!J Excel how the data in your worksheet relates to the chart. You specify
whether the data for charting is in rows or columns (remember, you can specify whole rectangular blocks, and Excel doesn 't kn ow the orientation in the blocks un ti l you specify it). Using
the first li ttle scrolling box, you can tell Excel to pick up the data in the first colum n and use it
as the label set along the x-axis.
Remember, the x-axis is horizontal, and th ey-axis is vertical. For historical reasons, Excel calls
x the category ax is and y th e value axis. Almost no one else follows this nomenclature. In rea l
math, x is called the abscissa an d y is the ordinate.
Although it doesn't apply to this particular chart and data set, you can use the next scrolling
box to identify the data legend (a legend is the name of the data series).
Now wh en you click Next, you get a chance to do relabeling of the x- and y-axes if you want
(see Figure 15.8). Also, there's an opportunity to give the chart an overall title. Having done
this, you need only to click the Finish button to get a lovely ch art, as in Figure 15.9. I could
have thought of an imaginative name for this data series for th e legend (Critter quan tities?
Pet population?) but I've left it as a pedestrian Seriesl.

ChortWizord - Step 5 of 5
Semple Chert
Add e legend?
® Y~
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Rgure 15.8

Add a title in this step.
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Chart Variety
Now that the ChartWizard has given you your chart, you might ask how you make little
changes. Excel 5 has built in all sorts of delicate controls that you access, for the most part,
simply by double-clicking on the chart element that you want to change.
Suppose that you want to change the typeface of the labels along the x-ax.is because in early
childhood, you were frightened by a headline in 24-point Geneva and have been allergic to
that font ever since. Just double-click inside the chart to activate chart editing- you kn ow it's
activated because the chart shows a hatched bou ndary, as in Figu re 15.10.
Now double-click directly on the x- (horizontal) axis. Excel responds by showing you one of its
new tabbed dialog boxes, a compact way of presenting you with nearly a hundred formatti ng
ch oices. One of the tabs is for font ch anges, so you can select it and change the font to th e less
traumatic Times (see Figure 15.11). All newer Microso.ft programs also provide you with a little
Preview box so that you can see the effect of your formatting changes before you apply them.
Figure 15.12 sh ows the formatting changes incorporated into the origin al chart.
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Figure 15.12

Times instead of Geneva on the x-axis.

Formatting: Not Just How, but Why
If you want to show your charts to other people In a presentation, you need to becomlf
intensely familiar with the Format Axis dialog box. The reason is that Excel 5's default
settings are very good at making attractive screen displays but are less appropriate for
making slides or printed output. If you take the default settings for axis labeling (~polnt
Geneva) and make slides from the output, your audience will be squinting at the scredl\
Microsoft Itself implicitly acknowledges this situation In PowerPolnt, its presentatl~
graphics program, which has an entirely different set of charting default settings from
Similarly, for printed output that looks good In a report, you have to collect your own gallery
of charts on paper from printed sources for comparison. Just take a plain manila fOider,,;.:.y
label it "Charts," and clip out charts that you find particularly striking. After you've coOecw.a;;
a few, you'll notice that the axis labels are generally much larg~r than the dEifault labells (If
Excel. Another thing you'll find is that the most impressive charts tend to contaln fewet
numbers of elements. And because most publications don't do full-color charts, they
to rely on cross-hatching and methods other than color to differentiate bars, cotum""' an~
pie segments.

ha\ff

Switching chart types
Besides tin keri ng wi th axes and fonts and labels, you may find that you want to change the
chart type after you've set it up. Either you can go back through the sequence of Ch artWizard
steps again, or you can double-click the chart to activate it and find Chart Type under the
f-ormat menu (see Figure 15.13).
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Figure 15.13

Switching chart types.

This command takes you to a dialog box that looks somewhat like Step 2 of the ChartWizard
sequence (see Figure 15.14), except that the 2-D and 3-D chart types have been separated, and
you can switch between them by using a radio button. For an illustration of changing chart
types, I picked a pie chart (see Figure 15.15) as the next chart type.
If you remember charting with ChartWizard a few pages back, you know that after you select
a basic chart type, you are given a choice of variations. That's true h ere in the reformatting
business, too. After you double-click in the modified chart, you select AutoFormat from the
Format menu. You then see a set of choices (different choices for each chart type) that look
like those in Figure 15.16.
Pie charts can be confusing-th e first pie chart in the dialog box requires you to look up pie
segments in a legend box. Although the most informative pie type here is actually type 7,
which lists the segments and their percentages right on the pie, it's a little cluttered for a pie
with more than four data elements (see Figure 15.1 7) . Nonetheless, it's the top choice if you
are printing your charts on a black-and-white printer because all the shading distinctions on
the color Mac screen disappear when you print. At least with type 7, someone looking at your
chart can tell exactly what's going on, even if the pie segments are forced by the printer to be
nearly identical grays. In the interest of simplicity, you can also select the legend and then
select Clear from the Edit menu because all the information is now included in the main chart
element.
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A name and number for each segment.

Before you print a set of charts to a black-and-white printer, take a look at them by using Print
Preview. In Print Preview, the Setu p button leads you to a tabbed dialog box, and on the Chart
tab is a check box (see Figure 15.1 8) called Print in Black and White. If you check this, you will
see which grays Excel will be selecting for color chart areas.
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Figure 15.18

Print Preview in black and white.

Finally, grouping charts according to pastry, I would be remiss in my obligations if I didn't
sho w you a doughnut chart (see Figure 15.19). Th is particular chart (made by double-clicking
the pie chart, selecting AutoFo rmat from the Format menu, and picking Doughnut from the
scrolling list) is quite obviously just a pie with a hole in it. The fancier type of doughnut
incorpo rates more than one data range so that you get rings within rings (see Figure 15.20). If
you have sm all sets of shifts between two sets of data (for example, market share for products
changing by a few percent per year), this type of ch art is fairl y usefu l. The problem is that
Excel doesn't do a very good job of displaying and labeling these charts, so you get an unfamiliar, slightly confusing, poorly drawn chart. You m ay want to stick to the basics. These same
comments also apply to radar charts, in which Excel has similar labeli ng problems.

Using li ne charts
Alth ough all the chart types are grouped together by the ChartWiza rd in a grand tableau of
opportun ities, the chart types have distinctly different applicatio ns. For showing data that
represents quanti ties measured at a particular time, pies and bars and columns are fine. For
scientific data, the most common chart is the XY scatter plot.

356

Charting Your Way

Chapter 15

For numbers that are changing in time, the line chart is usually the clearest representation.
Referring to the ridiculous pet store example of Figure 15.1, suppose that I need to follow the
course of the pet inventory over several months. Figure 15.21 shows a typical table of monthly
stocks of critters over four months-it's the kind of data that occurs over and over in more
serious business examples.

Pet Inventory
aPuppie•
•Snak,.

c Kittiu
clguanas

f-----+-----+9r-This white
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•Magpit•
only new
data
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compared
to a pie.

Figure 15.19

Unfrosted, old-fashioned doughnut.

Excel's labels -F-='4---- - - - --l
on multi-ring
doughnuts are
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Figure 15.20

Double doughnut fun.
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Figure 15.21 An inventory example.
To follo w the ups and downs of the critters, select the whole rectangular range from cell A3 in
the up per-left corn er to cell E8 at the lower rig ht. Click the ChartWizard icon, select the Line
chart in Step 2, and pick format 4 in Step 3 (see Figure 15.22). Note that Excel offers some
fairly exotic fo rmats for line ch arts. Format 6 in this figure has a logarith mic y-axis scale; this
is useful mostly for scientists and engineers. Format 8 is a stock market style high/low/close
chart; fo rmat 7 plots ranges with in categories; and format 9 is a statistical plot that often
appears in quali ty con trol studies.
The line chart that results from this choice of format is shown in Figure 15.23. It's reasonably
clear on a colo r Mac screen, but it has some problems in other contexts, such as slides or a
printed report. First, th e lines in the chart are too thin. Second, the legend box is too small.
Finally, if the chart is printed, all the li nes will be black, making them quite difficult to
distinguish.
So o nce aga in, it's time to do some reformatting work-fixing these problems one at a time. As
always, to reformat a chart element, give it a double-click with the mouse. When you doublecl ick o n a line in this chart, you get a tabbed dialog box that lets you tinker wi.th individua l
chart elements (see Figure 15.24).

358

Chapter 15

Charting Your Way

Select e forl118t for the line chert:
3

••• •

• • • •••
•

•

Figure 15.22

ChartWizard's line chart options .

•
llD)~I[;J l&t.fllJ~ l.!li~I~!I~J l~nlrJ I
File Edit

Ule w

(g

Insert

Formot

Too ls

!f

D

II

,,

Workbook ! &;
0
E

t

~ ----

Pup_pi es
Snakes
~ Kitti es
..!..., l guanas
Magpi es_
~
-t.r
IT
#

12

_!_

-rr
14

w
16'

-·

't7
1if
i9
it
if'

'Z2
R

-

:w

-!r

;;::

.-- -u

10

Sheoll

G

B

~

6

;:.

:~
Ju)j

Juno

Puppits

-Sn.lll<ts
Kt\tlts
l;u1nu
M"'lp!ts

Sheol 3 J Sheol4 J SheetS

"

$=

QE

- -_
-

A1J9ust

mon t h

Shool 2

tlliilt

-- '---

0
Mill

~
II

t'
- t- -- ~

1-----

nr4 ~ I ~1\

Figure 15.23

-

~~ ~

Pet St ocks By Mon t h

...!..
~

WliU111.tEiJlil]

~1 1 1 oo~

r=:JEJ li !Ji r]I JZ] I~•I~JmiLm l[%11! ll~d81=~JiiElBWBili13

-[i)

"

1: l~t-1

en ..

Window

Do l o

Shoot6j ~ ~

A standard Exce l 5 line chart.

359

;;

J~

Thin lines.

Tiny
legend.

Part Ill

Excel 5

style:

st~le:

ln:--c~

...1

COlon

For1:9round:

I

EJ

Line style --H-Hif-----1--------------choices.

Background:

F

Help

I~

·-·--·
Figure 15.24 Changing chart appearance with Format Data Series.

On the Patterns tab, there's a style option that l~ts you pick different dotted and dashed lines
for your line chart, and it also lets you select color and line thickness. After careful consideration of an appropriate line style for each animal, you can produce a chart like the one in
Figure 15.25, formatting the lines one at a time. Checking the work to see if it will print
properly (use Print Preview), you can see that at least now the lines are actually distinguishable
(see Figure 15.26), even in the legend. Please note that the chart, as it will print, is subtly
different from the one you see onscreen. That's going to be the case, typically, and it's the
main reason I keep insisting that you preview every chart before you print it. The big difference is that a chart is scaled to a given size onscreen, while Excel sizes documents to fit the
page on which it is printed (if you' re printing the chart on its own page). Essentially, the
screen version has been cropped and scaled (by you), but Excel is working with its own
internal version that fits best to the available paper.
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Oops! Cahrt Spellngl
I think I've probably seen more misspelled words In charts than anywhere else. To a certain
extent, it's like a sign painter's problem-when you're putting up 3-foot-hlgh letters, you
tend to concentrate more on the letters than the order. If you get absorbed in formatting
lines, you don't notice that Sales has become S/aes. Chart misspellings are great fun at
meetings, too. You put up a slide, everyone starts to Inspect It, a slight chuckle ripples
through the audience, and then some helpfu l ch.-:racter asks you, MOo you really mean
'bunsiness' or should that be 'business'?"
Fortunately, under the Tools menu, Excel 5 has a Spelling Checker, which goes into your
legends and titles and axis labels and spell checks them for you. As you accumulate
entries in your own dictionary (it's just like the Spelling Checker in Microsoft Word), this
process will speed up considerably. And then you don't have to worry about misspelling
your own company's name in a chart in your annual report (I've seen this happen-twice).

As a convenience, so that you do n 't spend your whole life pulling down menus, Excel 5 has a
feature for accessing formatting optio ns quickly. Hold down the ~ key and click in your chart.
Up pops a li ttle menu (see Figure 15.27) with the most frequently used editing commands.
You'll end up using this trick a lot, I pro mise you.
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Saving Formats
Now you may expect that doing all this reformatting can be fairly time-consuming. It is.
Double-click on a line, pick a line dot style, go back to the chart, pick another line, pick
another dot style .. . you probably wouldn't want to do this all afternoon for a set of 40 charts.
Here's what you do. Format a single chart just the way that you want it. When you have all
the elements arranged and adjusted to your satisfaction, double-click the chart. Then select
AutoFormat from the Format m enu, and instead of picking a canned format, select the button
for User Defined in the Formats Used section of the AutoFormat dialog box (see Figure 15.28).
You get the User-Defined AutoFormat dialog box. Click the button for Add because you will
be adding your own format. Excel 5 asks you for a format name and a description (the description is just for your own ben efit so that you can remember later what you did).

Click User- -l!!ffllli!--~
Defined to
save your
chart
fo rmatting
in an
AutoFormat.

Figure 15.28

The AutoFormat dialog box.

The next time you format a cha rt, you have all your formatting details available with a single
command under the AutoFormat selections. Because most business monthly reports tend to be
reporting on the same things, for example, there will be the same number of data elements
and the same preferred type of display. Some users find that in their first month or so with
Excel, they can set up a repertoire of chart formats, store them in AutoFormat, and just apply
these over and over, never again toiling away in the depths of the tabbed dialog boxes.
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If you have a group of charts under development at the same time, you can also format one,
select it, and pick Copy from the Edit menu. Then use the Edit menu's Paste Special Formats
optio n to apply the formatting to the other charts.
So far, this chapter has covered the basic use of Excel's ChartWizard for the quick creation and
formatting of simple charts. Now you're ready to see how you can use charts to make your
data more meaningful.

Line Chart Secrets
Sometimes your data is not all that you want it to be. Perhaps you represent the worstperforming sales region in your company, and you have to give a presentation with graphs
this Friday. You may need help.
I'm going to show you how to use the tricks available in the Excel 5 graphing system to make
yourself look better. These graphs will all be different pictorial ways of looking at the same
numbers. There are many subtle effects based on the facts of vision. From the ano nymous
artists who did perspective wall paintings in Pompeii to Picasso's Guernica, it's been the
hallmark of professionalism to employ these facts in a representation. When you put the best
face on miserable data, you're just being a professional.
If you open up a scientific journal, you see lots of plain line charts. In a science article, the
whole idea is to display a collection of data in such a way that the chart accurately reflects the
data. In a reputable business journal (my favorites for charting examples are The Economist and
Business Week), however, you see line charts and an assortment of bar charts.
And then, as you proceed down the editorial food chain to journals with more axes to grind,
you start to see more pie charts and pictographs (little stacks of oil barrels and such). By the
time you get to USA Today, most traditional chart types have been replaced with colorful
equivalents that make it fairly difficu lt to extract the original numbers.

Truth in charting
The most comprehensive discussion of charting available for general reading is probably
Edward Tufte's great work Tl7e Visual Display of Quantitative Information (Graphics Press, 1983).
Dr. Tufte, a professor of several subjects at Yale, explains not o nly the tricks of perspective and
areas in different kinds of charts, but he also explains the elements of superior charting.
Basically, Dr. Tufte wants to increase your charting and graphing sophisticatio n.
Unfortunately, almost none of Dr. Tufte's extremely valuable advice was used in producing the
charting functions of sp~eadsheet programs. Spreadsheets have, in fact, brought about a whole
new Bronze Age of crappy gra.phics. Most programs have a difficult time making charts that are
as aesthetically pleasing and representationally accurate as those in the works of Victorian
sociologists. Sad but true.

364

Chapter 15

Charting Your Way

So Dr. Tufte wants to show you how to make charts that accurately and faithfully mirror your
data. That's okay for him- he has tenure at Yale and his own publishing company. You, on
the other hand, may find yourself some day in a darkened conference room presenting dismal
fo urth-quarter sa les numbers to your grumpy supervisors, and you will n eed to make things
look reasonable. That's what the rest of tills ch apter is all about-l'm going to stand highquality graphing advice on its ear to show you how to make declines look mild and slight
increases look giga ntic. Don't tell anyone you saw it here, but in a pinch, it easily justifies the
price of this book.
The basic principle in all the cases here is fairly simple. The type of standard optical illusion
shown in Figure 15.29 contains the essence of the tricks. After you have a diagram with a few
slanted lines and after you have a ch art with some 3-D perspective, your ability to judge
elements quantitatively by eye just about disappears. You and I are sim ply going to play on
that theme a bit.

Figure 15.29

Which center line is longer?

Using line charts
Figure 15.30 shows a very simple Excel worksheet containing some sales data and a plot of the
data using the line chart option with a partial grid (grid lines running in one direction instead
of both).
There are a few key points you should understand about line charts:

+

A line chart is the easiest path back from a chart to the underlying num bers. In
other words, it's the easiest to read.

+
+

Gridl ines make it easy to extract quan titative data.
"Honest" line chart axes start with zero.
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Step back a minute and consider the story in the data. For this example, sales in the Atlan ta
area are booming. Sales in Boston aren't terrible, but they're down a bit, and things seem
to have peaked in Miami. Situations like this occur all the time. As the great statistician
W. Edwards Deming patiently explained to a whole generation of U. S. business leaders who
simply didn't "get it," there's a certain random compon ent to sales and market data. Sales can
be up in some areas and down in others, even with every member of a company's staff working equally hard. It works that way just because a given company is on ly a tiny fragment of
the whole economy, which follows its own rules. That's why this graphi ng example isn't just
an example, it's the example for the American business offi ce.

----+--'--"'----'"'"'--"------'-'-~t--

Axes run
fro m zero to
maximum
values.

Figure 15.30

Grid lines
make it easy
to compare
values.

When the facts are on your side, try an honest line chart.

You can draw those sales conclusions fairly quickly from the data in a table, but you can see
them even faster in the ch art. Now suppose th at the data is to be p resented at a meeting, and
the Atlanta area sales rep is in ch arge of the presentation. Wha t else can you do with this line
chart?
Well, there are two simple and effective ways to modify th is chart. The first and simplest
method is to change line colors. After you double-click on a line in the chart, one of the first
options you see is the option for changin g line colors. lf you h ave a story to tell, put your story
in red (or choose a thicker line) and leave th e rest of the data in drab little thin lines. The
quantitative sto ry is the sa me, but the impact has changed.
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The second, and slightly more fraudu lent, way to emphasize data in a line chart is to modify
the axes. If you have a line that slants up, you can make it look like it's headed up even faster
by shrinking the chart along the x-axis (x is horizontal, andy is vertical). Just click on the
right-hand chart border and drag it to the left-it's the same data, but the visual slope looks
greater. This principle is used constantly in financial pages of newspapers, where (partly
because of space limitations in columns) all sorts of gentle ch anges in company earnings are
made to appear either as runaway increases or near collapse.
Changing they-axis scale is a more serious dodge. Double-click anywhere in a line chart to
activate it. The Format menu gives you an Axis option, and it has a tabbed dialog box for Scale
(see Figure 15.31) that you can use to set arbitrary starting and ending points on your chart
axes. For this example, I'm going to reset the low end of t he scale to 400 units instead of the
standard zero. This action makes the rise of sales in Atlanta look much more dramatic and
makes sales in the other cities look correspondingly more miserable (see Figure 15.32). By
changing the axis, I have effectively changed the representation to highlight differences
between cities rather than the fairly large quantity of sales they have in common.

Note -~Q=:::::::,:.::,.::j.._::.::-=._
change of
starting
point for
scale.

Figure 15.31

Changing an axis scale for emphasis.
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Figure 15.32

Atlanta takes off!

This chan ge of axis trick is behind most of the misleading charts that you see in newspapers
and elsewhere. It's used to make relatively tiny changes in an index seem gigantic. Suppose
that you are comparing students' scores on a test and the values are 96 percent, 97 percent,
97.2 percent, and 98.5 percent. lf you plot these on a scale from 0 to 100, they look n early
identical, as they should. If you reset they-axis to run from 95 to 100, then 96 percent looks,
quite unfairly, like a disaster compared to 98.5 percent.
The old district attorney in my county had a 91 percent conviction rate in cri minal cases, and
the new district attorney got 92.5 percent. This difference resulted in campaign literature in
which they-axis scale for conviction ran from 90 percent to 95 percent. The trivial increase in
conviction rate (not a real increase, actually, just a random fluctuation) looked like a gigantic
improvement. So whenever you see a business chart in a publication, make sure th at you look
at they-axis scale carefully to see if something strange is happe ning.

Area Chart Secrets
If you were a sales rep for one of the other cities in this imaginary organization, the compara-

tive numbers for Atlanta would be pretty discouraging. But because you're becoming an Excel
5 ch arting expert, there's no n eed to worry-just pick a chart that distorts the data in a
favora ble way.
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Standard area
Because the chart types a.re listed in alphabetical order, the a.rea chart is the first in the
ChartWizard chart lineup (see Figure 15.33). For our data selected in the original worksheet
order (Boston first, Miami last), selecting the default area chart gives us the chart in Figure
15.34.
Here's what's happening. In an area chart, the quantities in the line chart are piled on top of
each other. That means that if the first data series is a rapidly increasing set of numbers, the
other series are plotted with the equivalent of a slanted x-axis. Instead of all data points on a
line being measured from zero, the top border of each area segment in the chart is computed
from the sum of data points of the sections below it. It looks like a line in a line chart, but it
isn't measured from zero, so it's very different. In Figure 15.34, the top of the Miami area
section doesn't have much to do with Miami but is, instead, just the sum of sales for all cities
for each year.

Figure 15.33

Area chart: the Wizard's first option.
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Looking better in smaller markets.

If you are the Boston sales rep in this scenario and are determined to hide last year's downturn, a good way to do it would be to ch ange the plot order (just interchange the Boston and
Atlanta rows). Look at the area chart Ln Figure 15.35-it's the same data replotted with the
Atlanta data series as the first row in the data range.
Can you spot the change in Boston sales from 1993 to 1994 compared to the change in the
original line chart back in Figure 15.30 or even Figure 15.34? If so, you must have exceptional
powers of discrimination . For all practical purposes, the decline is buried in the general
upward slope provided by the Atlanta data series. You can spot the decline only with a
superior ability to discriminate small changes in angles.
just keep in mind that if you wa nt a good look at the big picture while hiding details, area
charts are just fine. If you wa nt to bring out details in a data set, use line charts instead.
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~;;;<""i!-----i=~J--. Putting

Atlanta as the
first data
series obscures
things even
more.

Figure 15.35

Boston data concealed by Atlanta.

Area percent charts
Area percent charts, another a rea ch art option in the ChartWizard, have perfectly legitimate
uses. If you want to show the changing contribution of different sales areas to the total sales,
for example, an area percent ch art is perfect. The area percent chart for our example takes data
from several cities (sales data for different years) and scales the data to show the percent contribution of each city for each year (see Figure 15.36). In the process, the actual sales numbers
disappear into the total.
That's a valid use. You can also use area percent charts to conceal changes in sales over a series
of points in time. Because a percent chart scales the relative contributions (in this example,
from cities) rather than showing absolute size, this kind of chart makes it harder to see real
changes over time.
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Real data disguised by an area percent chart.

Pies for Obscurity
Area charts are a good way to show relative relation ships but a bad way to show absolute
numbers. It f1\USt be admitted, however, that someone could still take a ruler to the chart in
Figure 15.36 and reconstruct the actual data. If you really want to cover your tracks, use a pie
chart (which is just a specialized type of area chart) to represent data that's changing in time.
In Figure 15.37, I picked the data for" 1991 and 1994 and plotted it as two separate pie charts
(just select the data as you normally would and find the pies in the Ch artWiza rd menu). These
n-vo pie charts do a pretty good job of obscuring the actual sales history while purporting to
show important changes in sales between the two years.
Even this representation, however, shows more than you may want to show. While your visual
system has a hard time seeing the difference in the angle of the Miami pie slice, it can easily
see the difference between the Atlanta segments in the two examples. Note that pie charts also
give you the option of labeling the segments with percent labels, but putting in percentages
would be giving the viewer a way to undo your concealment.
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can't see
this change
easi ly.

r--------lf-----+------,------1--_;__--~-You

Figure 15.37 A rampant abuse of pie charts.

If your pie charts are revealing too much, try a 3-D chart, the best place to hide information. A
good general rule of chart perversion is the following: if you still have something to hide in
your 2-D charts, get yourself another dimension. Look at the 3-D pie chart in Figure 15.38. It's
still possible to see that Atla nta has grown at the expense of the other two cities, but the 3-D
presentation flattens out the pie-segment angle.
If you can gauge these angles correctly by eye, you're ready to do celestial navigation with only
a pair of crossed sticks. These two charts make it appear that not much has really happened
over the three years; in fact, the whole business has changed seriously.
One more pie trick should be mentioned here because I've seen it in several presentations. (I
do a certain amount of venture capital consulting every year, so I've seen every way known to
man to fudge numbers in a chart-these kids play for keeps). Between 1991 and 1994, total
sales in this example are up by 84 percent. So in comparing the two years, why not expand the
1994 chart in size by th at same 84 percent? Do this by dragging the little handles on the sides
of the charts (click the chart so that the handles appear).
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Because the pie size reflects total sales and because the relative contributions o f the cities to
sales are obscured in a 3-0 pie, it looks like sales in Boston and Miami are exploding right
along with Atlan ta (see Figure 15.39). If you were the Miami rep, would you rather see this
3-0 chart or the line chart back in Figure 15.32?

r + - - + - - - - - - - - - - --t--4-!rt--- Can you see this

change in angle?
Miami decline
masked by
Atlanta data.

Figure 15.38

3-D: one more dimension where you can hide information .

And yet, these representatio ns come from the sam e set of data. It happens that t he designers of
charting programs agoni ze over the chart types they include w ith their products because they
know perfectly well how they can be used. For years, Computer Associates' Cricket Graph
declined to offer 3-D charts, knowing that they were often misused-purposely or by accident.
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.......·----···········'······-·············-..., .......................f>,__-___,,----..,-<:-----........,....---b=c.fiii-Drag here
to scale
the pie.
Figure 15.39

Scaling pies to match total sales.

3-D Charts: Innovation or Prestidigitation?
The fact that 3-D pie charts obscure some already foggy details in 2-D pie charts is just a
preview of the magnificent effects you can produce with 3-D charts. A complaint about
previous Excel programs was that they had a limited array of charts and no 3-D charts, but
that's all history with the new Excel 5. Although there are certainly ways to make accurate
and dramatic presentations by using 3-D charts, one of the main effects of 3-D charting is the
introduction of perspective-scaling effects, which make it hard to reconstruct the original data
from a chart view.
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Columns
In a standard 2-D column chart, you always have a way to translate individual points along
the column into accurate numbers. In a 3-D column chart, you could, in principle, perform
the same conversion. The problem is that you have to guess the height of a column, and the
column is displayed agai nst a background th at's been adjusted for fake 3-D perspective,
making the guess tough er.
As always, in this ch art deception minicourse, I propose never to give a sucker an even break.
In practical terms, this means that you make quantitative estimates more difficult. Do this by
picking typeS when you reach Step 3 of the ChartWizard dialog box. The type S option gives
you a chart in which grids have been suppressed (see Figure 15.40) so that people viewing the
chart don't even have an on-cha rt scale fo r comparison.

chart has
some quantitative scale fo r
comparison.

~~=:._:.;;;===tW--This

L---~~--~----~~·Tofoolyou r

audience, pick
this one
instead.

Figure 15.40

The gallery of 3-D co lumns.

I've selected the data again and followed the ChartWizard steps to produce 3-D columns,
which means

+
+

Selecting the data range
Clicking Chart Wiza rd
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Picking a 3-D chart type (in this case, columns)
Typing in a label in Step 4 of the ChartWizard
Pressing Finish

A first plot of the data with standard settings shows one of the possible 3-D problems-you
can't even see some of the data because it's blocked by other columns (see Figure 15.41).
Clearly, this chart has to be rotated, and the perspective has to be changed to get all the data
points, however distorted, into view. Under the Format menu, the choice to Format 3-D View
gives you a way to change several aspects of the view at the same time (see Figure 15.42).

--1'~~=.;.=-~~litf--

Miami is lost

in this
"downtown"

of skyscraper
columns.

Figure 15.41

Note that this 3-D view hides some data.

A little tinkering (rotating the view wi th the controls in the Format 3-D View dialog box)
produces the view shown in Figure 15.43. This view makes the data for Boston look okay, the
data for Atlanta look great, and the data for Miami look relatively miserable. If you rotate the
chart so that you're looking at the columns dead sideways instead of from a bird's-eye perspective, it becomes almost impossible to detect changes measured from the early yea rs.
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the chart by using these co ntrols.

· Figure 15.42

3-D View cont ro l let s you pick the perspective.

Every 3-D chart deserves some experi mentation with rotation and perspective, either to bring
out the truth o r to concea l features of the data.
If yo u have many data sets to present, and they all have roughly the same story, you can store
any rotating- and perspective-shi ft work that you do by saving it as a custom AutoFo rmat (see
"Saving Formats," earlier in this chapter). After you 've defined your own Autoformat, you can
apply it to data any time you like- it's the equivalen t of a style sheet in Microsoft Word.

Figu re 15.44 shows how da ta is m ade somewhat murkier by "adva nced" 3-D charts. This
is a 3-D li ne chart (th is type is called a 3-D ribbon chart by everyone in the world except
Microsoft) of the ori ginal data set. Do you think it's easier to see accurately what's going on
in this chart or in the sim ple 2-D line ch arts?
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Viewing --liT~;;.:;_;;;;....~+-----
from the top
suppresses
some
differences.

Figure 15.43 One 3-D view out of many.

Figure 15.44

Data in an "advanced" 3-D chart.
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Of course it's easier in the 2-D case. But for reasons that aren't clear, business presentations
always look more impressive if there is more 3-D charti ng. If you pick a viewpoint on the righthand side of this chart frame and look straight across, you ca n see Atlanta stand ing out from
the other two towns. But because the years on the chart are running back to front in this view,
it still isn't clear to the casual observer that Atlanta has taken over the market and that the
other two cities are in decline.
This chapter covers the basic use of Excel's ChartWizard for quick creation of simple charts,
and it also explains hO\·V to use some charting fea tures to paint a visual pictu re that modifies
the impact of the underlying numerical data. The next chapter deals with Excel's functio ns.
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Understanding
Functions
You can perform virtually any numerical math calculation in an Excel worksheet by using
only the fo ur basic functions (add, subtract, mu ltiply, and d ivide). Of course, because thousands of clever people before you have faced the same set of calculation tasks, all these sets of
steps have already been coded into little bits of mathematical machinery called functions. In
this chapter, you learn the basics of the main fun ctions, some practical applications fo r more
advanced functions, and how to set up your worksheet so that finding errors in the way you
have entered data is easier to do. This chapter contains the following points:
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Getting Friendly with Functions
I'll tell you a li ttle bit about functions, just in case you didn't absorb everythin g the teachers
were trying to tell you in high school math.
Most functions in high school were presented to you in the fo rm
y = f(x)

A typical function wou ld be

y

= f(x)

= x2

This is a ru le that describes a curve called a parabola, and you get the plot of the curve by
picking different values for x, sq uaring them, and then p lotting the points (x =3, y = 9 and
x = 4, y = 16, and so forth).
While Excel includes basic functions from high school math, a func tion in Excel can be much
more powerful than h igh school functions because an Excel function is really a li ttle computer
program in its own righ t. To use a functio n, you tell the function program what numbers (or
text or logical values) to use as program input, and the func tion grinds away and produces a
result. The function is really like a little numeri cal m achine or a specia lly programmed key on
a fancy calculator. The reason these machines are important in Excel is th at they do all th e
work needed for even the m ost complex calculations-someone else has set them up for you,
and all you have to do is use them.

A first function: COUNT
Consider the worksheet in Figure 16.1. I have put a border around the cells C1 to C10-that's
where the data goes for th is little experiment. The worksheet also contains a label identifying
the experiment and labels indicating where the number average and the nu mber count go.
Notice that in Figure 16.2, some numbers have been put into the ten available spaces from Cl
to C10. How wou ld you ca lculate the average of the four numbers shown? You can just add
them up by using the Sum function and divide by four. But this isn't a very general solution .
If you put five numbers in the boxed area, you'd have to add them and then divide by five.
That's not wonderful- if you have to change the basis of the calculation every time you
change a number in the space, you m igh t as well use a calculato r.
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So following the belief that every time there's a problem, Excel has a canned answer in its
function library, it's time to look in the function list for a function that counts how ma ny
numbers have been entered in a range. Click the button that is labeled fx on the toolbar.
Sure eno ugh, in Figure 16.3 there's a function called COUNT in the Function Na me list. If the
function does not appear when you have the Most Recently Used function category highlighted, you can find COUNT under the list of Statistical functions. After you click COUNT in
the list, Function Wizard gives you the lowdown on using COUNT (see Figure 16.4). Briefly,
you can put numbers directly into COUNT if you like and find, for example, that

COUNT(l, 5, 9, 2.3) = 4
This is a fa irly idiotic use of COUNT because you type four numbers in as arguments (one of the
inputs of a function) and Excel tells you that you typed in fo ur numbers. Well, "Duh!!!" as my
niece says.

AVERAGE
If
MAX
MIN
PMT
~UNO

UM

~~Mif
LOOKUP
~

ll

Figure 16.3

All the functions you could want.
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Function Wizard explains COUNT.

A better use of COUNT is this: enter the range Cl:ClO (remember the: for specifying a range)
as the only argument of the function COUNT. This tells COUNT to look in the range a nd see
how many numbers it finds. Note that zero is a number, so it registers with COUNT, while a
blank space isn't counted . Look at Figure 16.5, and you see COUNT churning away at its
somewhat boring little task. If you think about what's involved in making Excel count nu mbers just by using arithmetic function s, you can really appreciate COUNT. It can be don e, but
it involves some extreme cleverness.
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AVERAGE
Having automated the counting procedure, it's clear that th ere must also be a way to automa te
form ing an average of the numbers. As a first pass at this, you can try using the combinatio n
of the functions SUM and COUNT, as shown in Figure 16.6. Add the numbers by using SUM
and divide the tota l by COUNT.
Even this pitiful effort, however, is mo re work than you should have to do perso nally to take
an average. After all, you shelled o ut real money for this giant product, and you have a right to
expect that Excel 5 has everything you could want. After you click the Function Wizard button
to see what's available, AVERAGE appears under Statistical functio ns and usually under Most
Recently Used (see Figure 16.7).
The AVERAGE function is more sophisticated than COUNT because it no t only adds a collection of numbers, but it also counts them and then performs the division. There is, therefore,
some justification for using AVERAGE in a mode in which you type in numbers directly as
arguments (see Figure 16.8) rath er than specifying a range. Usuall y, though, you'll be
AVERAGing numbers already entered in a worksheet cell range.
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Findi ng AVERAGE.
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just for fun, I have entered more numbers in the "averaging zon e" of this worksheet with the
resu lts shown in Figure 16.9. COUNT, of course, reports who le numbers, so there's not much
cho ice of number format; AVERAGE simply makes up its own mer ry mind abo ut format unless
you specifically ove rride it by selecting a forma t from the Format menu.
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Filling in ten numbers for averaging.

More Function Fun: MAX, MIN, and RAND
There are a few more function s that you may want to meet, partly because they are useful in
assessing business situations. Like COUNT and AVERAGE, the first two of these fu nctions
usually have a cell range as arguments.
MAX picks out the biggest number in its argument range, and you can find it, like the earlier
fu n ctions, in the Statistical function category. MIN, on the other hand, picks out the smallest
n umber in th e range. (You can also type in a set of num bers di rectly to be the function
argu men ts, although there's not much point in this.) Figure 16.10 shows MA X and MIN
wo rking together on a simp le exam ple.
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MAX and MIN look through the numbers.

Using these two functions may n ot seem to be a particularly dramatic use of functions, but if
you have a situation in which you' re tracking a number with a random compo nent (such as
month-to-month or week-to-week sales), AVERAGE, MAX, and MIN are actually better functio ns for characterizing the number than some other statistical functions that may appear
more sophisticated. Because MAX works like COUNT, you can tell for yourself just by looking
at the worksheet whether your calculations are working properly. You may not always be able
to tell whether you're getting the right results from the statistical function for standard
deviation, but you can tell whether MAX is doing what you want just by looking at the
numbers.
Some functions don't actually require that you specify function arguments yourself. RAND,
the random number generator in Excel 5, is an example of a function that doesn't need any
sort of inputs as arguments. When RAND is placed in a worksheet cell, it puts a random
number between 0 and 1 into the cell. For Figure 16.11, I have copied column C and pasted it
into column F, put =lO*RAND() into cell Fl, and then copied this cell from F1 and pasted it
into cells F2 through FlO.
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AVERAGE and other functions are applied to random numbers.

Because RAND gives you random numbers between 0 and 1, the average fo r this fun ction over
lo ts of samples sho uld be one-half. Because I've multiplied RAND by 10, the averages should
be ten times one-half, which is 5. If you look at the figure, you will see that t he average is
4.94593, pretty close to 5 by anyone's standards. RAND, by the way, is a sort of self-operating
function-every time you open a worksheet that has RAND in it, the random functio n generates a new set of numbers.

Higher Functions
If you click the Function Wizard button and begin scrolling around in the lists, you are likely
to find all sorts of functions, many of them quite unfamiliar unless you took a va riety of math
courses in college. For example, if you took physics o r statistics, you are li kely to know a
number of applications fo r the functjon SUMSQ, the sum of the squares of the numbers in a
selected cell ra nge (see Figure 16.1 2). This function won't, however, mean much to you if you
were an English literature o r even a business m ajor. The list in the figure shows other fun ctions (h yperbo lic tangent, sum of products of elements of two vectors-try to guess which
ones they are!) that you m ay not recognize as old friends unless you have some technical
background, but you may take all this as reassurance that when you have to calculate something, Excel 5 has the function you need.
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Agure 16.12 A long list of math functions.

Almost Programming: The IF Function
Figure 16.13 shows a setup to demonstrate an especially powerful function in Excel, the IF
function. IF can select choices for a calculation based on input (that is, argument) conditions.
The case under investigation mimics a real-life business case. In Massach usetts, there's no sales
tax on clothi ng purc hases below a certain price per item, but there is a sales tax o n clothes tha t
are perceived by the state legislature to be luxuries. The worksheet here is a biza rre hybrid of
California and Massachusetts practice, incorporating Cali fo rnia's ferocious 8 percent sales tax
with a $200 luxury cutoff. In other words, I'm looking for a way to charge 8 percent sales tax
in this worksheet on purch ases of items that cost more than $200.
Because there is a sales tax ch arge if the purchase is more than $200, it ma kes sense to look
at the functio n IF, fo und under the Logical function category. This fu nction- unlike RAND,
wh ich is perfectly capable of looking after itself-needs three well-designed argu ments to
produce any results (see Figu re 16.14).
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Here's how you use IF:

+

The first argument, "logical_test," is supposed to be an expression that will return
either TRUE o r FALSE as a value. The little underscore mark (_)con necting the
words logical and test is necessary for programming purposes to make t he who le
expression seem li ke one word to the program. In our case here, the test is
F2>199.99. That means the answer is TRUE if the number in cell F2 is 200 o r more
and FALSE if it's less th an this value. That will decide which of the two values the
func tion wi ll p lug in to its cell.

Besides entering the IF test d irectly in this cell, you can write your test in som e
o ther cell and put the cell reference (by name or cell num ber) into this pa rt of the
argumen t. If you're going to change the test often, it's less work to modify the test
outside of the actual functio n definition .

+

The next argument, "value_if_t rue," is t he expression that you wa nt evaluated if
the conditio n is true. In this case, the expression to evaluate is about 8 percent
sales tax, so the expression is 0.08 times the contents of cell F2 if F2 is larger than
199.99 (see Figure 16.15).

+

The last argumen t, "value_if_fa lse," is pretty sim ple in this case. If the value in F2 is
less than 200, there isn't any sales tax, so the value is 0. In other cases, you can put
some sort of form ula as this argument, bu t here it's not necessary.

What happens when you fire up all this complexity? Let's find o ut. In Figure 16.16, I t ry the
number 125 in cell F2. The functio n returns zero for the sales tax, ind icated by a little dash (- )
instead of a the number 0 in th e cell. With the number 248 in cell F2, the funct io n decides
that the value of th e test is TRUE and calculates the 8 percent sales tax (see Figure 16.17).
It's possible by connecting IF statements to develop ways of looking up the right calculation
for all sorts of complicated cases-you can have t11e result of one IF functio n appear in the
logica l test of a second or thi rd IF functio n . Another way to d eal with complicated cases is to
use lookup tables, which will make a modest debut in Chapter 19.
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Because cell F2 contains a value of less than 200, there is no sales tax.
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The NOW Function
Another useful function is NOW. Like RAND, NOW can take care of itself-you don't have to
specify argumen ts because this function reads its own arguments taken from the Macintosh
System clock (see Figure 16.18). When you put NOW in a cell, it looks up the date and time
from your Mac and plugs them into the cell (see Figure 16.19). It looks up, of course, whatever
these numbers are on your System, so if you have the wrong date, it faithfully reports the
wrong date.
It's a good idea to invoke NOW when you make changes to a worksheet, preferably with some
notation that documents the changes. When you have a worksheet that can be accessed by
other people on a network, this minimal effort at documentation and version identification
will save everyone lots of trouble.
Almost every fancy calculation that has practical value has already been encapsulated in a
function that's available in ExcelS. The Function Wizard helps you fill in function arguments
(inputs) and explains the use of various functi ons. But there are functions, and there are
functions. Now you need to see how you can use Excel's functions for the everyday calculations that you need in the rea l world.
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PMT, the Starting Point
It was once remarked by a famous person with a bad reputatio n as an economic predator that
compound interest is the Eighth Wonder Of The World. In the United States-in which timepayment plans fo r nearly everything are a way of life-compound interest is nearly the
dominant feature of society. The country as a whole is busy paying off the largest debt in the
history of the planet (wi th interest on the debt ticking away, compounding, making an eventual pay-do wn completely implausible.) And individual fam ilies are typically enmeshed in
monthly payments for everything fro m their houses to the smallest purchases.
You may think that it should be easy to do a payment calculatio n directly. After all, in the
typical situatio n, you sign up to make monthly payments on a certain sum. Can't you just
apply the interest rate per month to the balance and then add th is to some fraction of the
balance? Well, briefly, no-it doesn't work that way. The standard payment scheme is organized so that the first payments are always biased toward interest, and the later payments
apply more to the balance.
The principle is that you always owe as much mo ney as possible, consistent with eventually
getting the loan paid back. On cred it cards, for example, the m inimum monthly payment pays
off your purchases incredibly slowly. The fact is, if you have a department store credit card
that charges 20 percent interest, the departm ent store is in no hurry to see the balance paid off
as long as you keep up payments-the store probably doesn't have any other investments that
pay as good a return as you do.
This scenario has consequences, and as a result, I' ll be doing some fervent preaching at various
points in the rest of this cha pter. You can probably survive by using do tted borders rather than
solid borders around cells, and it won' t ru in your life if you pick Palatine as you r default font.
But the game of time paym ents in modern America produces a well-defined set of win ners and
losers, and you had better learn its quite unforgiving ru les. This part of the chapter is hard-core
important stuff.

PMT and its arguments
The only difficult pa rt of using PMT is getting used to its aq,rum ents and the convention for
entering interest values. Take a look at Figu re 16.20.
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The payment fu nctio n, PMT, appears in the middle of Excel's ge nero us Financ ial function
category. It takes the following five argumen ts:

+

The fi rst argument, "rate," is the interest rate per period for the loan. If you have
an 8 percent car loan with monthly payments, the n umber you enter here isn't 8
or even .08 (.08 means 8%). The correct n umber to enter in th is case would be .08
d ivided by 12. That's the in terest rate per period because the period is a month. In
the next few figu res, I'm going to put in incorrect values fo r the arguments on
purpose so th at I ca n highlight this issue wi th figure ca llouts (see f-igu re 16.21).
If yo u' re do ing mo nth ly payments, enter the in te rest rate by specifying it as =8o/o/
12 (or whatever rate o ther than 8% you need). This gives Excel the correct number,
and it gives you a format that makes it obvious when you select the cell.

+

The next argument, "nper," is a little more straightforwa rd because it stands for the
number of periods for the loan payback. For examp le, it's 5 x 12 = 60 for a 5-year
car loan, o r 30 x 12 = 360 fo r a 30-yea r mo rtgage.

+

The th ird argu ment, "pv," stands fo r principal va lue. It's the amount you're
borrowing now (see Figure 16.22). In PMT termin o logy, the situatio n is upside
down fro m consumer finance-Excel is really figurin g o ut how m uch you should
pay each mo nth to have a certain total. Note in this fi gure that entering the wrong
interest value gives you a mon th ly payment bigger than the principa l value. This
can happen with certain unsavory sports bets to underworld characters, but as yet,
it's sti ll a dayd ream fo r consumer credit compan ies.

+

The fo urth argum ent, "fv," stands for future value and is the total of all your
payments and interest o n the payments. Because yo u' re paying off a loan, however,
the future va lue of yo ur payments is zero. You do n' t have to enter a zero here
because if you just don 't give a future value, Excel assumes it's zero. This assumptio n forces this function to be payments on a loan rather tha n an annuity (a type
of inves tment).

+

The last argument, "type," can be either 0 or 1. If payments are due at the end of a
period, enter 0 (the usual case, so that if you don't en ter anything, it's assumed to
be 0). In some payment plans, it states explicitly that paym ents are d ue at the
beginning of a period, so you put in 1 as an argume nt.
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Nper and pv, the other loan arguments.

PMT at work
In Figure 16.23, Excel 5 gives you the monthly payments for a loan of $1,000 at 16 percent
annual interest. The standard format for results from PMT is that numbers are reported in red
and in parentheses for negative values (meaning.that each payment is a negative in your
checking account).
That's the payment per month-$90.73. In Figure 16.24, I've popped open another cell in
which I multiply the monthly paym ent by 12 to get the total.

'
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Figure 16.23

Exce l 5

PMT results for a one-year loan.
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Other payment aspects
Astute readers may inquire, "Hey, what's going on here?" At an interest rate of 16 percent, you
may think that a one-year $1,000 loan would call for $160 worth of interest rather than the
$88.77 shown here (again, Excel reports the total as negative because you pay it). But keep in
mind that the principal on the loan is being paid down continuously, so for most of the
duration of the loan, you don't owe the whole $1,000 and would be paying interest on the
smaller balance.
Also notice that the total amount paid back seems about right. The loan was short term (one
year), the amount was $1,000, and the amount paid back was $1,088.77. Generally, if you
enter an argument such as interest incorrectly, you get a result that's way out of line.
The effective interest rate is a more subtle matter (see Figure 16.25). The annual rate quoted
was 16 percent. For the purposes of a loan calculation, this rate is divided by 12 into a
monthly rate. If this rate were left to compound every month, with no payments, the total
on the loan would be
Total= $1000 x (1+16%/12) x (1+16%/12) ... (12 times)

That total would be $117.20. The effective interest rate, called the A.P.R. (annualized percentage rate) in consumer-loan jargon, is thus 17.2 percent. It's just one of the little wrinkles of life
in the United States that the law allows lenders to put the annual rate in big print but insists
that the A.P.R.-for all practical purposes the real rate- be put in fine print (a nd/or buried)
somewhere in the ad. Car leasing ads are an especially rich source of calculational amusement
in this regard.
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Real-Life Payments
To give you some practice in using PMT, I'll run a few examples drawn from everyday loan
situations. After you see how easy it is to plug in the arguments, you'll be old friends with PMT
in no time.

Financing a computer
Because you've bought this Office book for the Mac, you are presumably familiar with Apple's
pricing po licies and perhaps its financia l plans. North America has millions of people faithfu lly
making payments to Apple credit every month, often with tears in their eyes. The tears arise
because it's easy to find yourself paying off a $2,400 balance on a computer with a current
street price of $800-Apple's policy of introducing new models at a furious clip and then
dumping prices on th e old models has often left the Macintosh faithfu l holding the bag, so to
speak. I got hundreds of pieces of hate mail when the Mac Ilvx appeared because I gave it a
glowing review in Macworld, and then Apple dumped the pri ce about five weeks later. For the
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record, I got sandbagged right along with the readers because Apple isn't particularly forthcoming to the press (people who work fo r Mac magazines have to buy t heir Macs in stores just
like everyone else).
So check out the exam ple in Figure 16.26. This is your basic llvx story, by the numbers. It
includes $3,000 for the system (with a nice monitor and a printer), Apple's stiff consumer
interest rate of 20 percent per year, and a three-year payment schedule. Notice that because of
the fai rly high interest rate, the $3,000 turns into more than $4,000 in paymen ts over th ree
years.
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Consume r credit from Apple.

Financing a house
Home-loan calculation proceeds along the same lines, except that there's a ton of money
involved, instead of a mere sack, and the long-term nature of home financing produces special
sensitivity to interest ra tes. Although I live in California, where the current price of an abandoned dog kennel with roof problems is half a million dollars, I've modestly chosen a mortgage case with numbers more in li ne with Kansas City.
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The shocker here is the payment total over the years (see Figure 16.27). Looking at it briefly
from the bank's point of view, the bank is giving you $130,000 that it could instead be
investing elsewhere. If it invested the money at 6 percent or so, it could expect that money to
double in about 15 years. It needs that kind of investment performance from its investment in
you. In this case, please note that if you can find an interest rate of 7.9 percent instead of 8
percent, the lower rate saves you about $3,000 over the loan term. That's because 30 years is a
long time for loan interest to be compounding.
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A nice mid-American home loan, circa 1985.

Very few people in America in the 1990s can expect to make it to the last payment on a 30year mortgage. Thus it's a subject of considerable curiosity to determine how much of a loan
has actually been paid back after a certain number of years. Excel 5 has some built-in functions
to answer th is question (see Figure 16.28): PPMT gives you payments on principal, and IPMT
gives the interest amount in payments. These functions use the same function arguments as
PMT, except that you need to specify which payment you want split into interest/principaL
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Rate (reqlllred)
fs tho~ tnter..t r ete per pertod.

Figure 16.28

Use PPMT to determine how much you've already paid on your principal.

What you see in Figure 16.29 is that at the beginning of a 30-year loan, most of your payments
are going to go to interest service. By the time you're making the last payment on a mortgage,
you're paying off nearly pure principal, but at t he beginning, that's not the case. If you buy
a house, shell out nearly $1,000 a month for two years, and then sell it, you find that the
$20,000 you have paid on the loan has made a dent of only about $2,000 in the loan
principal.
That last little observation isn't particularly encouraging, unless you're a stable citizen who
wants to settle down, buy a house at age 32, make payments for 30 years, retire, and get buried
in the basement by your grieving but equity-rich descendants. Using PMT, you can find ways
around this.
Figure 16.30 shows the same amount financed for 15 rather than 30 years. Changing the time
scale of the loan by a factor of 2 doesn't double the payments- it increases them by about 30
percent. And look at the loan total for payments. If you can find another $290 a month, in
this example, you can save $120,000 in total payments (not to mention that you own the
house after 15 years, when you're still spry enough to water-ski or break your collarbone on
a dirt bike).
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The shocking truth.

Figure 16.29

Home loan: the impact of 30 years.

Notice, comparing Figures 16.29 and 16.30, that the difference between the monthly payments in the two examples is the difference in the amount paid on principal. If you go for the
shorter-term mortgage, you get back all the "extra" part of the monthly payments (that's the
extra compared to the 30-year standard) if you sell the house after a few years. Also, practically all home loans these days have a provision for sending in extra principal payments along
with your standard Jl)Onthly payment. Thi s opportunity works out nicely if you don't feel
that you can commit to a regular higher payment schedule. The main point is that you
should do everything possible to avoid owing large sums of money for 30 years with interest
compounding in the background.
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More on Financial Functions
Microsoft has seen fit to include a stunning array of fin ancial functions, from special functions
fo r comparing T-Bill yields to standard bonds through depreciation, to different interna l-rateof-return functions. (This is probab ly because Microsoft employees themselves need these
functio ns. Hundreds of th em became veritable plutocrats when the company made a public
stock offering. )
To pick your way through the list, just click the Help button in the Function Wizard. The
gigantic machinery (the Help system in Excel is bigger than the sum total of Mac software
from the Mac's first two years) of Microsoft Help grinds into place. For financia l functions,
there's really a point to seeking o ut Help (see Figure 16.31) because it provides detailed
examples for using all the functions. Click the Financia l Functions topic in the Help window
and just scroll through the list, looking for functions that you may need (see Figure 16.32). If
Microsoft thought to include functio ns for converting decimal dollars back and fo rth fro m
fractions (usefu l for stock m arket prices li ke 13 1/8), yo u can expect that nearly every useful
business fun ctio n has been put o n the list.
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Now that you have a familiarity with functions and how to use them for practical day-by-day
living, it's time to see how you can set up some protection for all the formulas and functions
that you have created. In case something is wrong in your worksheets, you want to be able to
find and correct the problem easily. The rest of the chapter tells you how to protect your
worksheets.

What's in a Cell Name?
In the old days, a cell in a worksheet was called something like RSC3, standing for row 5
column 3, or CS, standing for exactly the sa me location.
Now just think about creating a nice big worksheet, perhaps a hundred rows by a hundred
columns, full of financial functi on s that depend on the results of previous calculations. You
take it and show it to a co-worker, who comes back the next day to state that the computed
cash flows don't match up with the actual receipts and invoices for the time period in question. Uh-oh. Now what?
If the formulas have arguments in terms of AB83 and so fo rth (see Figure 16.33), you have
your work cut out for the next couple of days. If, on the other hand, you used Excel's cell
name function (see Figure 16.34), you have the advantage that your formulas will be readable.
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Defining cell names .

There are man y different ways to implement a cell name plan. I'll show you my way, which I
think makes for faster auditing, and Microsoft's way, w hich makes for more thorough documentation. After you see these exa mples, you'll probably be inclined to make up a cell name
convention of your own. Your choice just depends on the naming style that you are most
likely to use and remember.
I like to name cells for the argument n ames that th ey ta ke in functions (see Figure 16.35) . That
is, if a financia l function takes a rate argument, I find the cell that has the number fo r rate and
name it "rate." Dazzlingly o riginal, eh ? The big advantage of this naming convention is that
when you high light a cell with a function in it and then click the Function Wizard button,
you can look at the list of arguments and tell right away if the correct cells have been assigned
(see Figure 16.36).
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Figure 16.35

Create cell names and then apply them.

Retur"' tt>e•nttr..t povment for en lnvootrnent for • qlvon perfod.
Rate (r~alred)
b t ht lnttr.,t rete per period.

Figure 16.36

Matching cell names with argument names.
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What's In the Name Audlfl
It'-s really toO bad that such a vseful function as auditing has such a repellent name. Per·
sonally, I assocl'tlbfthe word eudlt either with taking classes for no credit or with scrounging
up mountains of recelptS for presentation to the IRS. From pointless to painful, audit covers
It all.
However, worksheet auditing-setting up a worksheet so that you can easily find errors and
navl~ate around It-Is absolutely necessary If you're going to be using Excel as more than a
simple desktop calcolatar.. Auditing helps you decide how to document your own work, and If
done correctly, lets yoU:.reetfother people's worksheets. After you start making worksheets
In which results ofsome functions are used as arguments for other functions, your choices
aJe to use. prOper auditing methods or to create a hopeless uninterpretabte mess.

With a big worksheet, you need to do variations. You may have several different interest rates
that apply to different financial calculations. In this case, you can name cells "rate-loan 1" and
"rate-loan2." The main point is that if you keep the first part of the cell name the same as the
argument name, you can look through all your functions for error argu ments just by reviewing
them with the Function Wizard.
Microsoft takes a slightly different approach to cell names. Microsoft prefers to spell out whole
words (see Figure 16.37), such as "Total_payments." When you do names with multiple words
like this, it's preferable to use an underscore character ( _) rather than a blank space between
the words. This underscore business is a convention both of the programming language C and
Microsoft's operating system Windows. Although the Macintosh itself can support blanks in
names of files and folders-this is an unprecedented innovation in computers, even at this
advanced stage of the computing game-it is best to keep with a naming tradition that can be
exchanged with other programs.

Cell Naming
The cell naming convention I& just a way to make a worksheet readable. It's a notorious
problem In programming that a program you wrote even a few days ago becomes very hard
to understand unless you document every line by writing little explanations to yourself about
what you were tlying to do. And reading someone else's program is like deciphering
Etruscan. (As a piece of cultural background, you should know that archaeologists have
Etruscan dice from 700 a.c. with the words for one through six on the sides, and they still
can't be sure what the numbers are.)
When you set up a worksheet, you're writing a program whether you know it or not. If you're
working on your own, It will save you time to do decent documentation; if you're working
Inside a company, doing a good job of documenting your work will keep co-workers from
cursing your name for eternity. So name those cells, okay? And attach a note to a cell every
time you do something even moderately tricky.
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Figure 16.37

A Microsoft-styl e cell name.

The Auditing Toolbar
Figure 16.38 shows Excel S's Auditing toolbar, which you can put o nscreen by checking its
box in the Toolbars dialog box from the View menu. In this example, I've checked the Large
Buttons option in the dialog box so that the toolbar is big enough for you to see the contents
easily in a standard figure, and I have also turned off the Standard and Fo rmatting toolbars.
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Figure 16.38

The large button version of t11e Auditing too lbar.

Arrows to everywhere
As you will see, most of the buttons on the Auditing toolbar feature arrows. Excel keeps track
of con nections between cells, and when you want to see the connections, you can click th ese
buttons. You can also call down Auditing options from the Tools menu, but frankl y, the
toolbar is faste r and more fun.
Here's the simplest possible application, or cell reference traci ng, based on a worksheet
supplied by Microsoft as a sample. I've selected the cell with a calculated payment and clicked
th e first button o n the toolbar, which is the Trace Preceden ts button (see Figure 16.39).
Precedents are the cells that send values to the cell that you've selected . In some cases, a
precedent can be just a cell that's used in an arithmetic calculation to give the answer in a
selected cell, or a precedent can be a cell containing a function argument.
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Figure 16.39 Tracing the arguments of a PMT function.

Notice that the arrow to this cell has a bunch of little bumps on the arrow line. Every bump
indicates a cell precedent. It probably would have been clearer if Microsoft had chosen to use
sets of arrows of different colors, but as things stand now, you just have to look for the bumps.
There are two ways to remove the arrows, which start cluttering up the screen after a while.
The second button from the left on the Auditing toolbar removes the precedent arrows to a
particular selected cell. The fifth button from the left is supposed to indicate an eraser, and it
removes all arrows on the worksheet.
If you're a cell, then you're either an independent cell, a precedent cell, or a dependent cell.

When you select a cell and click the Trace Dependents button, the arrows show you all the
cells that use the information in the cell that you selected (see Figure 16.40). This is a pretty
powerful trick-when you find that your numbers have gone unaccountably strange, start
clicking cells near the top of your worksheet and begin tracing dependents. It's usually the
fastest way to find which number was entered incorrectly, on purpose or not.
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for cell
dependents.

Figure 16.40

Tracing ce lls that depend on a selected ce ll.

Adding and checking information
The Audi ting toolbar has two more useful buttons. One is simply the Note button (second
from the right) fo r attachi ng cell notes. A big argument for leaving the Auditing toolbar
onscreen all the time is tha t it e ncourages you to use notes. Having this button present mean s
that you're just a single click away from practicin g a good habit. Hey, how often does that
happen?
The last button on the right, the little i button, gets you the Show Info Window, as shown in
Figure 16.41. Show Info gives you the note's contents, the formu la in the cell, and the cell
name (if the cell has an assigned name). If you have the trace arrows turned on, and you are
looking at the conten ts of the Info window at the same time, you have about all the information that Excel ca n give you. As a rule of thumb, if you see a whole collection of arrows when
you trace dependents (see Figure 16.42), it means that you ought to take a deep breath and fill
out a cell note.
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This situation call s for a note.
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Error alert!
If you get an error message after you enter a formula, th e Auditing toolbar is ready to help you,
sort of. I say sort of because the information isn't really going to provide you with a detailed
diagnostic (see Figure 16.43). In this figure, for example, I've typed the wrong cell n ame for
one of the function arguments and clicked the Trace Error button. But Excel doesn't actually
give me a message, such as wrong cell name or the equivalent. It draws arrows to the cell
precedents, but it's up to me to figure out the mistake in the function argument that has been
entered incorrectly. In fact, because the argum ent is incorrect, th ere isn't even an arrow to a
cell. I have to inspect the arguments one by one to see which of them is missing an arrow.
Still, this situation is an improvemen t on the early days of Excel, when you were obliged to
construct you r own auditing strategies by yourself.

Finding the reason
for an error message.
Figure 16.43

The Auditi rg toolbar's Trace Error button in action.

Because it has so many useful features and because you should use it, the Auditing toolbar h as
a special place in Toolbar Land. It's the only toolbar that you can call up with its own command, instead of using the Toolbars dialog box. Under the Tools menu, choose the Auditing
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command, which, i n turn, displays several choices, including Show Auditing Tool bar (see
r:igure 16.44). In h onor of this special status, here's some advice so signi fican t that I made i t
into a caution.

Trnce Pr ecedents
Tr uce Dependent s
Tr uce Err or
ne moue Rll nrr ow s
v'Show nu dltlng Toolbor

(S20,020.

llida;.J l?tlFf~ ~J¥101]
______j_

Figure 16.44

The Show Audit ing Toolbar command in the main Auditing menu.

Caution: As you use Exce l, you will discover many occasions when you are

•
'

glad that you attached a cell note to a cell so that you can see later what
you were trying to do when you set up a worksheet. On the other hand,
there will never be an occasion when you regret adding a ce ll note. Cell
notes don't take up much space, they"re convenient, and they're more
efficient t han scattering text boxes all throughout a worksheet. Think of
cell notes as a trail of crumbs, and you 're either Hansel or Gretel trying to
get home.

42L

e

j

Part Ill

Excel 5

Looking at Formulas
Buried down in the Tools menu, under Options, on the View tab, is a little check box that's
also useful when you're trying to interpret a wo rksheet. The Formulas check box, in the
Window Options area (see Figure 16.45), makes the cells in your worksheet display formulas
instead of results (see Figure 16.46). Amo ng other things, you can use this display to check
whether you've done yo ur homework in assigning helpful and consistent cell names.
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Using the View tab for auditing.
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Worksheet showing formulas, not results.

In the rest of the Excel section of the boo k, I discuss features and expect that you'll use them
because they're necessary. The aud iting features are also necessary, but they tend to be
underused fo r the same reason that bills get paid late and m otor oil doesn't get changed every
3,000 m iles. The sim plest way to remind yourself to document your work is to keep the
Auditing toolbar open as yo ur standard worksheet default display. If you document your
wo rksheets on ly out of guilt, the toolba r will at least be a little n agging grandmotherly reminder to put some cell notes in place.
Whew! You have just covered l ots of information in th is chapter. Yo u h ave learned about
functions and how to enter them in your worksheets. You have looked at how to figu re out
interest and principal payments by using special fun ctio ns. And you have learned how to label
your functio ns so that you can find erro rs if you have made some in your worksheets.
If you want to take a break, I do n't blame you. But co me back soon so that you can explo re
databases in all their wonderful fo rms in Excel.
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Manipulating
Databases
The Excel 5 features for database management are am o ng the strongest arguments for
upgrading. Unless yo':l're runn ing the billing system for General Motors' network of
suppliers, an Excel 5 database has enough power to do the job. A great variety of tasks
that used to call for a stand-alone database can now be accomplish ed effectively in
Excel. As you'll see, quick manipulation even of large databases is possible with just the
training you get in this chapter. You're going to learn about the following points:
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Important Terms
Databases are surrounded w ith a certain mystique. People who have n o problem w ith word
processors or spreadsheets can sudden ly feel a surge o f terror at the mention of the word
database. For this reason, there are thousands of " database consul tants" who work with
businesses to set up databases. Have you ever heard o f a word processin g consultant?
I 'm going to make this simple. There are only two key con cepts that you need to understand
about Excel databases: record and field.
Your name an d address make up a typica l database record. If you add your phon e number, i t's
in your record. If you add your favorite color and every thing you bought from Sears l ast yea r,
th is information st ill gets entered in your record. A database is just a collection of these records.
In the records I 'm describing, however, your first n am e is an example of a field. Your phone
number is another fiel d. All the catalog numbers of your stuff from Sears are other fields. just
as a database is a collecti on of records, a record is a collections of fiel ds.

Excel versus other Databases
The reason databases are thought of as confusing is that most serious commercial databases are relational databases, which include their own programming language. The
database in Excel is a simple list, although if you want, you can do some fairly fancy
programming with Excel macros (see Chapter 18).
The big difference is a matter of design. Back in the late 1970s and early 1980s, computer memory was a terribly scarce resource. Database designers decided that it was a
waste of memory to have lots of redundant fields and records, so t hey designed relational
databases as a way around this shortage of memory. In a relational database, instead of
keeping all the information in one big list, the database consists of many little databases
that are linked. For example, a relational database may use social security numbers as
a link. It may have a name and address list and then a separate list of your Sears pur·
chases, all linked by a social security number field in each list. The database can be
expanded to include any other sort of information (credit card data, finance history) in
separate lists, again linked by social security number. When you look up a particular item
In a relational database, the program uses the link Information to find what you need.
Each piece of information is stored In only one place, and a well-designed program can
use all sorts of memory management tricks to speed up searching.
The catch in this arrangement is that relational databases are harder to set up and harder
to modify. If you take the brute-force approach of keeping absolutely everything in a simple
list (this is called a flat-file database, as opposed to a relational one), the database is
simple to set up and child's play to modify. In principle, this flat·flle approach lacks some
of the possible speed tricks of relational databases and results In bigger files, but memory
Is now cheap and Macs get faster every year, so it's not much of a problem in practice.
The database In Excel Isn't as fast as, say, Panorama or RleMaker Pro, but it's refreshIngly straightforward.
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Setting Up
All you have to do to set up a database in Excel 5 is to pick a set of fields and enter them into
the first row of a new workbook (see Figure 17.1). And- here's some good news-you don't
even have to get the fields correct the first time. You can change the field order and add or
delete fields any time you like by using standard spreadsheet methods.
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Figure 17.1 Defining an Excel database record.
When you fill in data under this first row, Excel 5 understands that th is worksheet is a database (see Figure 17.2). In earlier versions of Excel, you had to define a range of cells as a
database by using a command from the Data menu. Excel 5 has enough built-in intelligence to
spot a database. In Excel's internal terminology, this data structure is usually just called a list,
probably because Microsoft sells the much grander product FoxBase Pro for heavy-duty
database work.
Filling in some sample fictitious data (note the required-by-law nonfunctional 555 phone
numbers), I have constructed a small but usable example database (see Figure 17.3). There
really is a Bob Bughunter at Microsoft, but he's too busy to answer his mail or the phone.
(Microsoft claims to have put nearly a million man-hours into debugging Windows 4.0 and
six mon ths in beta-testing Excel 5.) Okay, I made that up about Bob.
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Using a Form View
After you construct a bigger list than this pitiful little thing, you may find it easier to look at
your work with a Form view. After you pick the Form command from the Data menu (see
Figure 17 .4), you get a window with a view of one record at a time (you need to have at least
one cell selected inside the database range for this techn ique to work). Th is screen shows the
first record because I haven't given any other instructio ns. You can step through the records
one at a time by clicking the Find Next button, or you can do something a little more ambitious by clicking the Criteria button (see Figure 17.5).
To look for a record with an address in New York, type NY as the entry fo r State in this
window and click the Find Next button. This action produces the screen shown in Figure 17.6.
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Here are a few points to keep in mind when yo u search with the Form window:

+

Sometimes when you click Find Next, Excel beeps at you. This may just mean that
the record you're trying to find is ahead of the current record in the list. In that
case, you may have to re-enter the Criteria dialog box and choose Find Previous. If
you get beeped again, there may not be a record that corresponds to your search
cri teria.

+

The search may find multiple records. To see the records, step through them with
the Find Next button.

+

If you find a record and start to make a change in it, you can change your mind
and retrieve the original field contents by clicking the Restore button. This doesn't
work if you make a change and press Enter or Return-in that case the change is
accepted by the database.

Sorting
Under the Data menu is Sort, another useful option (see Figure 17.7) . The Sort dialog box is
self-explanatory, but it's worth thinking about Sort as an alternative to searching. In the
preceding example, I was searching for records with different State fields. Another way to do
this-a faster way, for that matter-is simply to sort Lhe whole list on the State fidtl. You
simply select the whole list, choose Sort, watch Excel rearrange the original list, and then look
through the records grouped by state.
For further efficiency, you could have Excel perform several sorts at the same time. If you pick
Sort By State and also choose Then By Zip, you will have a list in which the entries in the State
field are internally organized by the Zip field.
For optimal use of Sorting, it helps to have some way to get a list back to its original order. You
can create a new column (select the first column and press Cmd-1), name it Index, and fill in
this column with the numbers 1, 2, 3, and so on just by typing 1 and 2 as the first two column
entries and then dragging the cross cursor (the trick from Chapter 13). You can sort to your
heart's content and then get back to the original order by sorting on Index.
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Figure 17.7 The Sort dialog box with many options.

List Filtering
Searching by using a Form view really works best if you expect to turn up only a few related
records. If your search criteria will eventually find 50 records out of 2,000, it's a pretty tedious
business to click through them all with the Find Next button. For big search jobs, try filtering
instead. Under the Data menu (see Figure 17.8), there are two snappy new Filter choices:
AutoFilter and Advanced Filter.

Auto Filter
If you pick AutoFilter, a world of convenience awaits you. As shown in Figure 17.9, Excel
attaches little scrolling-list arrows to every field in your first row (the row that defines the
fields). You may need to rearrange some column widths because Excel puts the arrows right
over the column headings.
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But the list attach ed to each arrow has plenty of power because it's a list of all possible choices
for filtering. If you pick CA from the State list (see Figu re 17 .10), Excel gives you a list containing only the California entries (see Figu re 17.11). This procedure is also stunn ingly fast-I've
tried it on lists with several thousand data records, a!1d it's nearly instant. To get back to the
original unfiltered list, just pick th e Filter command again and you see that Show All is now an
active option. Choose Show All to get the whole list back.

Advanced Filter
You may want to find all kinds of specific information in a large list. l say large here because
AutoFilter can find anything you want, at warp speed, from severa l thousand records or more.
If you filter on two or three fields, it can certainly get the data that you want onto the 20
records or so that can be displayed easily o nscreen .
For bigger jobs, you may prefer the Adva nced Filter option. To use Advanced Filter, you have
to set up a separate range with field names and the criteria that you want to use for fi ltering. In
Figure 17.12, r have picked Zip as one fi eld and Title as another, although you can incl ude as
many fields as you like. The Zip criterion is >90000, meaning that I want to find records with a
Zip greater than 90000, and the Title criterion is entered as ="Mr." Please note that Excel
displays th is field as "Mr." in the cell onscreen, but the equal sign and quotation marks are
necessa ry to make the filter pick out the right text selections.
After yo u have your cri teria properly set up in a range, you can invoke the Advanced Filter
option. Advanced Fil ter (see Figure 17.13) asks you for the range of the list, the range of th e
criteria, and a range where it should put the resulting filtered list. This last option is actually
pretty convenient because it means that you can keep the o rigi nat list intact in its o riginal
location while t he filtered list is given its own range. You can keep tinkering with criteria
without having to restore the basic list between experiments.
The results of th is filtering operatio n appear in Figure 17.14. It's no t clear why this o ption is
called Advanced Fil ter, except that it's not very clearly explai ned in either the Help system or
the Excel manual, so perhaps it's intended for advanced users only. As a bit of design philosophy, you may consider making small er lists where some preso rting is bullt into the organization. For example, given that Excel keeps all this data in workbooks wi th multi ple worksheets,
you may want to associate single worksheets with individual states if you have thousands and
thousands of records. At first glance this may seem cumbersome, but it's an improvement over
scro lli ng through huge lists on a single worksheet.
Advanced Filter is a sophisticated type of search facility, but you may find that separating data
into different worksheets according to common criteri a and searching with Autofilter is faster
and more flexi ble in practice.
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Subtotals
If you have a relatively well-o rganized list, th ere's a command called Subtotals in the Data
menu that can do wonderful things for you. The Subto tal dialog box (see Figure 17.15) is
mostly useful, of course, if you have some numerical data, so I have added a field called Orders
to our little list and filled in some sales numbers.
First you should sort your data list o n the field you want for the Subtotals command. If you
want a list subtota led according to state, sort on State (see Figure 17.16) because Subtotals
notices each change as it reads down the list. Although Subtotals typically uses SUM as the
function of interest, yo u can also select a va riety of statistical functions. Subtotals can pick out
maximum o r minimum values fro m a subgro up in the list, for exa mple.
On a sorted list, Subtotals not only delivers subtotals and grand totals (see Figure 17.17), but it
imposes outline structure on the origin al worksheet. Because Excel 5 has a worksheets-withinworkbook structure, you m ay wan t to copy a result of thi s kind to its own worksheet. (After
the subtotal operation, the new structure is imposed o n the original worksheet-a more severe
modification than sortin g o r filtering.) If you find outline structure objectionable, go to the
Group and Outline co mmand under the Data menu and pick Clear Outline to get rid of all the
organizational spaghetti at the left of your wo rksheet.
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Figure 17.15 Many possibilities in the Subtotal dialog box.
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For producing a compact report, however, the outline format is the greatest advance since
6-point Helvetica. After you cl ick the little 2 button in the outline column, the wo rksheet
collapses to the bare subtotal presentation in Figure 17.18. "Just the facts, Ma'am," as Sgt.
] oe Friday used to say. If you're trying to make sense of large amounts of business data, the
automatic provision of an outline with each subtotal screen will start to look like one of
Excel S's best features.
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Remote Possibilities
Excel 5 has a large assortment of facilities for getting data from a remote database into a
worksheet. In the Add-Ins dia log box, you can find options for using Apple's Data Access
Language for connecting to remote database servers (Data Access Macro) and fo r Microsoft
Q uery.
Most Data Access Language (DAL)-capable applications give you a specific Excel add-in to add
to your menu-in general yo u do n't have to puzzle out DAL connections if you' re wo rking in
an office that has a DAL server program. Microsoft Query is ready to handle q ueries to remote
databases that use Paradox, dBASE, Microsoft Access, and FoxPro. On ly the last of these has a
Macintosh version. Generally, if you're supposed to be downloading data into your own
worksheet from a dBASE or Paradox database, it means that you' re working in a com pany
where It's someone else's responsibili ty to tell yo u how to do it. That's why I don't cover
remote data access h ere-your network ad ministrator is supposed to streamline this function
for you.
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The data managemen t fea tures of Excel 5 are one of the biggest areas of improvem ent over
earlier versio ns. Unless you're handli ng hu ndreds of thousa nds of records- in which case you
may need a real relatio nal database-Excel's flexibil ity makes it a first ch oice for database work.
ln the next chapter, you learn how to customize Excel by creating your own macros and
toolbars.
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Customizing
Excel
Excel S offers you customization opportunities beyond any other spreadsheet ever developed.
If you diligently apply yourself to man ufacturing your own toolbars, buttons, and macros, you

can produce your personal version of Excel. The drawback to extensive customization, of
course, is that you eventua lly h ave a piece of software that's difficult, if not impossible, for
other people to use.
You'll look at the customization tricks tha t are the most practical, easiest to remem ber, and
most li kely to save you some time. The key points of worksheet cake decoration are as follows:
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Using Macros to Speed Up Your Work
Excel has always offered a macro system that lets you record keystrokes and play them back
later. In Excel 5, Microsoft has taken macros to the gym and fed them steroids for a year. Even
as you read this, platoons of dil igent nerds-buzzed to the eyebrows o n Jolt Cola-are writing
Excel Visual Basic macro libraries for every conceivable business application.
The old macros produced long strings of funny little commands and were difficult to use for
high-end chores. The new macros record your keystrokes and translate them into Visual Basic,
a powerful application language that's as good at rea l programm ing as it is at taking notes o n
your work. While it's possible to write long programs in Visual Basic, you can get lots of use
out of Visual Basic macros with no programming at all. After you get accustomed to macros,
you'll wonder how you ever got along without them.
Excel's early advantage over o ther spreadsheets in the Mac market was based largely on its
macro system, and Excel 5 widens this advantage (actually, there are no competitors leftCiaris and Lotus having dropped o ut of the race).
When you start Excel, you may be surprised to see that the File menu gives you the option of
recording a macro or opening an existing macro file (see Figure 18.1). That's because Excel
macros, besides working inside worksheets, can direct all sorts of file management operations
(for example, you can use them to open particu lar sets of files and groups of files at startup).
For now, let's concentrate on using macros inside worksheets (a nd workbooks).

Figure 18.1

Macros with no worksheets?
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Getting started
In a way, you've already seen some of the mechanics of macros back in Chapter 13. When you
define a Custom AutoFill, you are setting up automati c playback of some text into cells.
Macros let you do this and more.
Let's step through a simple example:

+ The Macro options are hiding under the Tools menu. To record a macro, choose
Record Macro, which produces its own submenu, and then select the Record New
Macro command (see Figure 18.2).

+

Excel gives you a dialog box asking you to name the macro (see Figure 18.3). Pick a
nam e you're li kely to remember! There are some restrictio ns on names: you can't
use hyphens, for example, but you can use unders!=ores fo r multiple words, as in
MY_MERRY_MACRO.

+

After you press OK in the dialog box, you're returned to the worksheet. Excel gives
you a Stop butto n to click after you've recorded your m acro. As you can see in
Figure 18.4, I've recorded a shameless plug for The Don Crabb Macintosh Library
(a high-quality series from Hayden Books).

+

After you click the Stop button, all your typing is saved in the macro that you have
nam ed . If you now call down the Macro command from the Tools menu, you see
your own macro as an option to run or to edit (see Figure 18.5).

More macro action
Basically, the preceding section just established that you can set the macro system to record
your keystrokes and save them under a macro name for playback later. Of course, there are
many other uses for macros besides this passive recording example. For instance, probably the
most useful application is to use a macro to save yourself from retyping the same stuff over
·
and over.
Although I used the first macro in this chapter to record a text-typing example, you can record
anything. Macros can hold formulas, formatting information, statistical analysis and graphing,
and drawings. Anything you can do in a worksheet that you think you may need to do again,
you can save in a macro.
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Because macros are useful and impo rtant, they merit their own tool bar. It's called the Visual
Basic toolbar (see Figure 18.6), and you can find it as an option to check under the Toolbars
command in the View menu. The toolbar contains buttons for the basic macro operations and
also buttons fo r fancier programm ing (browse objects, set breakpoints, step-th ro ugh procedures) that you may not n eed at first. If you learn just to use th e buttons for Run, Stop, and
Record, you can automate all sorts of operations and look like a genius at work.

Run.

Stop. Record.

Figure 18.6 The Visual Bas ic toolbar for macros.
The macros themselves are sto red with your workbook, and you can open them for editing as
one of the o ptions in the Macro command in the Tools menu . After you open the text macro
for editing, you can see the text clearly printed o ut inside quotation ma rks, along with other
statements that tell you wh ere the text should be placed (see Figure 18.7).
I'm going to try somethin g a little more am bitio us than advertising a series of books. I'll click
the Record button o n the Visual Basic toolbar, name the macro Half_year (see Figure 18.8), and
then type in column headings for the months from January to June, along with the numbers
from 1 through 12 as row labels. 1 could have put border formats or other decoration s on the
worksheet, too, but I wasn't feeling ambitious. Keep your own macros sim ple because it's easier
to break tasks into two or three independent macros than to rework longer macros.
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Macros on the menu
The Macro dialog box has a button called Option s, which produces the Macro Options dialog
box. The Macro Options dialog box enables you to attach a description to the macro, which
becomes important after you have more than three or four macros in a worksheet. Notice in
Figure 18.9 that the default description produced by Excel has me listed as "Unknown User." I
can't be sure, but I believe this is because Microsoft plans to build a mo nument to me personally, as The Unknown User, n ear its corporate offices, to compensate for my sufferings with
early beta versions of Excel 5.
The important parts of Figure 18.9 are the check boxes for Menu Item and Keyboard Shortcut.
Frankly, I think keyboard shortcuts are hard to remember, and a fairly large fraction of Option:l:t key shortcuts have already been taken . So I usually attach m y n ew macros to the Tools
menu, where they appear as menu items. Notice also that you can type some advice to yourself
into the Status Bar Text text box, and advanced users can make up Help system entries for
their own macros.

Assign a macro--i'~l===!j...:!t.!ll11111
to a keystroke
combination.

Figure 18.9 Macro options let you build your macros into Excel commands.

Assigning a macro is as easy as checking the correct box and filling in a macro name (see
Figure 18.10). After you follow these steps, you see your macro appear as a custom command
at the bottom of the Tools menu (see Figure 18.11). This is the easiest menu customization
that you're likely to find in any piece of software yet produced.

450

Customizing Excel

Chapter 18

-'-

File

Edit

Ulew

Insert

form a t

Tools

IJJii

Window

Dolo

ID I GiJ!il)leJ[];I~jr.lt]l~l,ftl~lnl noHilt.,JEillUJI~II~ I~IItooli& 18~
~novo
liE UI:J 18 ~tB lr! l[l.l)l!: I•J!II)ml I$J(.%JI I:.sj ..~lliEIEJ 1:@8 [iJ8
I

II 'Q
rF
3

~EJ[@

5) To perform the some action on nonadj ace nt ranges, sel ect the first rang e, end then
· hold dovn COMMAND ..,htle uou sel ect the other r ongeo.
A4
~
I
mocro_ tlm e
ft"
Mocro Options
Mocro Mome:
Half-~jtir

4
5

-----~ ---

Oeoerlptron:
IMocr o reeordtd 8/25/94 by Unknwn User

~
7

Ffo

-

r+!-

-

~

-

ctt

~~euboe rd Shortcut:

-

15

f;!f - - ~
TB

Help lllfor matln
Status Bor Tul:

~

11o1Pi:on1e>cl ID for lhla Macro:

·-

r¥.21

2Z"

---;---

r---

F.

I

Hel p

I

:1:!12U -

I

i~~Mr l)eflned

!=-

3

~

e:

9

,It

Riling in menu data.

File

Edit

Ulew

Insert

Formot

II ,-., 5 ) To perform t ho oamo action on oonod
II ·' rf hold da..,n COMMAND ..,hno IJOU oel oct tt
IF"'"

(7J l i

Window

~ I~J;!,IIIJt-iJi t ooli&

18 m!]

%l .11~~~~1mm~

Goal Seek...
Scenarios ...
Solu er...

n r ot

rongo, ond tbon

_Ia a~

~

Bt S

~

l

It

0

~

•=--

0

lllm1JI Dall1
I DIFFIJilllg9j!:8lrtl lr~1~1•1l\<!J ~~::~:~~..
~

Cucel

Hil p Ftlt Homo

i l l4
For Hsij on d

Figure 18.10

OK

(

I

Funetlon Cotewrv·

·•-uiJ\S•••

t
~
Opllon+Crnd+

H

-+--

I

-=nan to
Menu lltm In 'Tools' Menu;
I HALF_VEAR

li!l[
If

A

B

-----_ ·-_

ll

~~dfebruarv=--.t\

Protection
Hdd- l ns...

~

Mocro •. ,

lr

f

Mev

G

t une

~.;:,.

H

-

\)'

-

1c-;~"-'~+=----i10!--=-=_-_--+::_~~~===~~~~~:~~~~.~ ~M~~:~cr:~~·~~-~-~-~-~-~4~-~-=~ =~- - ~~- ~+~

F}f
P.t

1-f.f

-

-

-~

..

-

- -

- -~ - - -- c~r----- , , r -- - -

l ~ l -~-

"'21
i-ff

-

141 r41n~I\Shee t1

_

HALF YEAH

L__
-

- -

=-=

--

1

I

J - -f----~t-1

1-

, .• t ..

,

,

- - -1

I

•.,.

,,

•

~

~t

'" • -

-;,;.;,

,

[t!l~-[•l,,'i ni!:>K71~~
·-

-- ·

3Jteit2 /Shttl3

Sbeet4 /SheetS /Sheet6
Chen~e various categories oTNfcrosor . Exc:e opt ons

Figure 18.11 Putting a macro on the Tools menu.

451

1~1<'

i

i
--,--

~
l~l lll

The new
menu item.

Part Ill

Excel 5

Macro sophistication
But wait, that's not all! Suppose that you don't wa nt to park your macros under the Tools
menu. That's just fine with Excel 5, which is wi lling to put your macros on the same footing
as all the com mands the whiz kids at Microsoft have labored o n for yea rs.
If you click the second button from the left on the Visual Basic tool bar, you' re handed to the
Menu Editor (see Figure 18.12). In the Menu Editor, it's possible to put th e macro command
anywhere on any existing menu o r in the Menu bar itself.

There are, however, two strong arguments in favor of accepting Excel's standard placement
of menu macros under the Tools menu. First, it keeps the appearance of yo ur worksheet in
confo rmance with the Excel manuals, and for that matter, with this book. Therefore, other
users don't get confused if you send them a copy of your work. Second, if you start packing the
m enus with your own macro commands, you can start losing track of them. At least if th ey
always appear und er the Tools menu, you know exactly where to find them.
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Figure 18.12 The Menu Editor, available with a click on th e Visual Basic toolbar.
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So far, th e two macros in these examples were fixed to absolute locations. That means that
when I started typing the hymn to Don Crabb in cell Al, the macro system thought it should
type the text into cell Al every time the macro was run. If you want the text to start filling in
from any cell that you have selected, you need to choose the Use Relative References option
for the Record Macro command in th e Tools menu (see Figure 18.13). When you run a
relative-reference macro, it looks for the currently active cell in the worksheet and starts
running the macro from that point.
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Figure 18.13 Relative references for macros .
Having checked Use Relative Refere nces, I then wrote a macro to put the words Winken,
Blinken, and AndNod into three cells next to each other, and I named the macro WTNKEN. I
then called up Macro from the Too ls menu, selected W INKEN from the list of macros, and
chose Edit. In Figure 18.14, you can see that one of the first steps in the macro is to select the
currently active cell in the works heet as th e starting point for the macro. Another point to
observe about this macro is th at it's called Module 1 (look at the bo ttom of the figure). This
name indicates where the macros are stored in the workbook. lf you look above the words
WINKEN Macro, you can see th e last commands from our o ld friend Half_year.
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Module 1 is a macro editing worksheet.

M od u le 1 is a text d ocume n t, and you ca n ed it it by using n o rmal Macinto sh methods.
Because the li tt le bits o f text insid e q uotation m arks a re just Mac in tosh docume nt text, yo u
ca n edit th ese bits d irectly. just as a whimsical expe ri ment, I've re placed Winke11 with STINKEN
a nd A11dNod with A11d...Nod (see Figure 18.15), w ith the resu lts in Figure 18. 16 . Th is is un likely
to be your first cho ice of a macro, bu t I wan t you to n ote tha t if you type in a long macro and
m isspell some wo rd s, you do n ' t have to go back a nd type in t he wh ole p ro ject again. You ca n
fix individ ual word s and com ma nds in th is editing window. If I were feeling really frisky, I
coul d ch a nge th e n umbe rs in ActiveCell.Offset a nd move the o t h er words all over the
worksh eet.
Macros a re not th e o n ly way to custo mize your Excel p rogram . Th e n ext sectio n of this chapter
dea ls with other ways to change Excel to meet your needs.
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Toolbar-0-Rama
Microsoft Excel has lots of toolbars. Just in case you can't find all of them in the ludicrous
complexity of Figure 18.1 7-there are even too many to fit in the Toolbars dialog box without
scrolling (see Figure 18.1 8)-the toolbars include the following:

•
•
•
•
•
•
•
•
•
•
•
•
•

Standard
Fo rm atting
Query and Pivot
Chart
Drawing
TipWizard
Fo rms
Stop Recording
Visual Basic
Auditing
Wo rkgro up
Microsoft
Full Screen

I'm not listing these because I like to type, but ra ther to make a point. It's possible in Excel
to customize a huge assortment of toolbars and buttons. You sho uld ask yourself carefully
just how much customization you wafjt to do before you set out o n this task. As it stands,
using Excel 5 m eans mastering a few hundred little symbols. Some of them are pretty selfexplanatory, as in the underline butto n deno ted by II. So me of them are quite cryptic-my
own favorites for o bscurity are the symbol fo r Microsoft Project o n the Microsoft toolbar and
the eraser with three litt le arrows on the Auditing toolbar.
The point is, you could get a fourth-grade-level readin g knowledge of japanese with the
amount of effort yo u have to put into mastery of the standard Excel buttons, much less new
butto ns you m ake up yourself. There's an argument to be made for using a few standard
toolbars and then using the men us and commands fo r operations that you don't do everyday.
If you see the name of a co mmand o n a m enu, for example, you can look it up in the manual
o r the Help system. You can do this with a butto n, too, but you h ave to identify it first.
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Customizing existing toolbars
All this being said, there are advantages to making toolbars look the way you want them to
look for your own convenience. You can get rid of buttons that you don't use often or move
buttons around from tool bar to toolbar to fit your needs.
If you look closely at Figure 18. 18, you notice an inviting button called Customize in the
Toolbars dialog box. After you click it, you see a screen like the one in Figure 18.19. Using this
window, you can customize toolbars to your heart's content.
You can pull off buttons that you don' t use often from an existing toolbar. For example, the
Spelling button on the Standard tool bar is not particularly useful because Spelling is the first
option under the Tools menu (you ca n reach the command as fas t as you can reach the
button). So with the Customize window open, click the Spelling button on the Standard
toolbar and drag it in to the gray space in the Buttons field of the dialog box. If you need the
Spell ing button back o n the Standard toolbar, highlight the Utility category in the Customize
window, click the Spelling button that appears in the Buttons area, and drag it back to the
Standard toolbar in whatever position you want it to be in.
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You can also put your favorite buttons on the existing toolbars. In Figure 18.20, I have dragged
my own favorite-the XY (Scatter) Chart AutoFormat button from the Charting category in
the Customize window-out to the Formatting toolbar.
Note that the distribution of buttons in the Categories list of the Customize window is often
odd. You sometimes have to hunt for unfamiliar buttons-the double underline in Figure
18.21, fo r example-in several categories before you find them, while you can find familiar
buttons-the Function Wizard, for example-in several places (in the Formula, Macro, and
Utility categories).
Also, if you have one of the floating toolbars onscreen (floating means a tool bar other than the
Standard and Formatting toolbars), you can drag buttons to it from any of the button palettes.
Figure 18.22 shows the Chart toolbar, loaded with extra buttons on an impish whim.
Here's the new button.
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Creating your own toolbar
If customizing an existing toolbar does not meet your needs, you can create your own

toolbars. All you have to do is click a butto n and drag it out into free space som ewhere o n the
worksheet. Excel au tomatically assigns the name Toolbar 1 to the first toolbar you produce this
way and then num bers any others you create, as well. As with other floating toolbars, you can
keep adding as many buttons as you li ke (see Figure 18.23) .
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Figure 18.23 Dragging buttons onto the worksheet to create a new toolbar.

Here's a toolbar strategy fo r you, based o n Microsoft's own design. Microsoft supposedly
designed all its toolbars by tracking the way people used the prod uct in testing labs. It didn't,
however, have the opportunity to track the way you work. But you can do this yourself. Keep a
log of the butto ns you actually use fo r about a week (just keep a file card taped next to your
computer). Then make up a custom floating toolbar with your own favo rite button s- Excel
arranges them in a n ice two-row fo rm at if you collect eno ugh of them. And make sure that
you save the workbook with this custom toolbar! No point going to all this trouble and then
losing your work in a System crash.
Then for your own custo m versio n of a worksheet, just close the Standard and Fo rmatting
toolbars and use your own. There are several reasons fo r using your own toolbar:
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Your toolbar is probably simpler th an Microsoft's and faster to display.
By putting all your customiza tion on your own toolbar, you leave the rest of your
copy of Excel intact as standard Excel so that other people can work with it and
you can still recogni ze your worksheet when you look in the manual.
You can create numerous toolbars for special purposes (math, charting and drawing, common fo rmats), aga in witho ut messing up the toolbars Microsoft has
prepared.

Customizing Help
The next custo mizing trick worth learning is the use of bookmarks in Help.
The Microsoft Help system is no thing if n ot generous. It goes on fo r m egabytes and megabytes,
providing info rmation on the nearly uncountable number of features in Excel 5-if you do n' t
mind starting with a n explanati on of the error m essage # DIV /0! every time o r scrolling
through the topics index at a fairl y leisurely pace.
My bet is that you will want help on a relatively small number of topics on a regular basis and
that you will have mastered th e in formation that the $ button o n the Formatting too lbar
means "format as m oney" sometime around 8:1 5A.M . o n your first day with Excel. For the
topics you need, place boo km arks to cut down your search time.
Here's what you do. Get into the Help system by doub le-clicking the Help button. You get a
new top-level m enu bar that con tains a menu item called Bookmark. First, by using the Search
button, select the to pic that you want to be able to access quickly. After you get the to pic
explanation on screen , choose th e Define command under the Bookm ark menu (see Figure
18.24). When the Define Bookmark dialog box opens (see Figure 18.25), it assumes that you're
defining a bookmark for the Help topic that yo u located with Search . (You can change the
entry here if you like, but it's easier to locate the to pic first-you do n't necessarily know the
exact name of the to pic to enter here, and Excel wants the exact name.)
The next time you call up the Help system, you ca n proceed directly to the Bookmark m enu
and find th e to pic that you have marked as one of the cho ices (see Figure 18.26). The name
of the selectio n is gen erated auto matically. Note th at the origin al name, "Changing general
Microsoft Excel settings," is now listed as "Changing settings, " and it's ass igned its own
keyboard shortcut.
That's pretty slick. Fo r example, suppose that you are working o n financial calculations most
of the time. Yo u can set up the Help system to call up Help files for PMT as :l:t-1, IRR as :l:t-2,
and so fo rth. Th en if you get fired from your jo b as an analyst and decide to design Grateful
Dead T-shirts for a living, you can delete all these entries and set up new Help bookmarks fo r
databases (of customers) and draw ing tools.
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Creating Buttons for Macros
The last tru ly worthwhile customization techniq ue involves putting macro access right on
your worksheet. You can make a custom butto n fo r any macro that you write and attach it to
one of the existing too lbars or to a new toolbar of your own.
This, by the way, is a significa n tly more dramatic and sophisticated type of custom ization than
anything I discussed earl ier. Rather than simply rearranging access to Excel's canned commands, you're really writing your own version of spreadsheet tools.
Let's take th is o ne step at a time. First, open a worksheet where you have saved some macros.
In Figure 18.27, 1 have pulled up a set of macros with the Macro command from the Tools
menu and dragged a few buttons out to a custom toolbar.
Next, pick a button th at you want to customize. The reason that you're going to customize a
button for your macro is that there will be no other way to remember it otherwise. You can
attach your macro to an existing button, but then you have a weird situation in which you
have changed the definitio n of a stan dard button. If you do th is ten times, I promise you that
you will lose track of everything and start m uttering to you rself constant ly. As your co-workers
notice your strange behavior and disheveled appearance, your supervisor suggests a counseling
program, and ... you can see where th is is leading, okay?
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Macros and buttons, a great combin ation.

So, suitably motivated to customize buttons, pick a button on your own toolbar, hold down
Control, and then click the mouse right on the toolbar button. You get a pop-up menu with a
short set of choices (see Figure 18.28). You wan t to choose Edit Button Image.
The Button Editor screen lets you define a new button pixel by pixel. Actually, this has loads of
entertainment value-you can make happy face buttons, pictures of your dog, cute little logos
... anything! In this case (see Figure 18.29), J have chosen a noble armorial crest reflecting the
existence of Don Crabb (remember him?).
Finally, after you have your own button (finish clicking the pixels and then click the OK
button), you can assign a macro. Press Control-click on the new button and find the Assign
Macro command (see Figure 18.30). When you select this command, Excel gives you your
choice of macros (see Figure 18.31). Pick the one that you want and press the OK button. Now
you have a button that runs the macro any time you click it. After I click the D/C button on
my own little toolbar, the macro prints the Don Crabb blurb right into my worksheet (see
Figure 18.32).
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This is a visio n of a rea lly practical type of customization. It's a bit of work, but you can make
your own toolbar with six o r seven custom buttons to run some of these chunks of boilerplate
text that you use frequently. It's not any more effort to have an array of fou r or five custom
toolbars like this to handle a big array of tasks (combining functions, formatting, and other
chores). And then you can edit these m acros directly to modify the contents! That, dear reader,
is the customization big leagues. Th anks to these new features in Excel, it's not very hard to do
this, either.
Excel has dozens of admirable customiza tion features. In practice, a fairl y small number of
customization tricks will make your day-to-day work easier, while rea lly extensive customization may well just confuse you. Think this stuff is fu turistic? Wait till you see what
awaits you in Chapter 19.
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Predicting
the Future
Excel delights in m aki ng fo recasts to ana lyze data, and it has at least six different ways to do
forecasts. Excel has more com putational machinery for prod ucing forecasts than any other
product ever released into the general software consumer ma rket .
.So . . . you' re going to take a to ur of the fo recasting methods buil t into Excel. Included in the
tour are actual applications of several fo recasting techn iq ues, the times when you slwuldn 't try
forecasting, and a look at an alysis tools in detail. These are the main points:
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Trends from Good Numbers
Forecasting software is a tool. A mu lching power mower is a tool, also, and you can use it to
mulch you r foot if you're not carefu l. You can, similarly, use forecasting software to convince
yourself that your own common sense is wrong and, in the process, ruin your business and
rain down shame upon your head.
In the o ld days of the data processing trade, the saying was, "Garbage in, ga rbage out." The
equivalent expression, in Sumerian, was probably inscribed on clay tablets around 3000 B.c., as
the first accountant found out that a mistaken head count of cattle could produce notable
grief.
Let's get down to cases. Figure 19.1 shows part of a data set on cars-I've just picked out two
columns that I th ink may have some connection. The first column shows the weight in
thousands of pounds for a particular car, and the second column shows the ho rsepower for
that car.
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Correlation
Now righ t away yo u're in the midd le of a decision-making process. Out of the 40 columns of
data in the original table, I picked these two because there's a good underlying reason to think
that there may be some so rt of tren d. No manufacturer is going to sell a 4,000-po und car with
a 35 horsepower engine. And no matter what the hyperactive youth of this great n atio n may
wa nt, there aren 't going to be 1,200-pound cars with 900 ho rsepower engines, at least no t on
the street. (That would be, like, whoa! Totally Awesome! Excuse me.)
What I' m getti ng at is that there' s a reason to expect heavier cars to have more powerful
engines. It m akes sense that there would be some correlation, as they say in statistics classes,
between weight and ho rsepower. There's probably also a correlatio n between length and
weight because, in technical terms, cars are m ade o ut of stuff-so lo nger cars are going to
weigh mo re. If you think abo ut it a bit, you see that you can think of other likely correlations.
Weight versus miles per gallo n is a probab le example of a negative correlatio n (more weight
sinks your MPG), as is MPG versus horsepower.
By the way, as a bonus fo r read ing this fa r in the book, I may as well give you som e practical
info rmatio n. The data in Figu re 19.1 is taken from a table o n car safety prepared by the
American Statistical Associatio n . The most important correlatio n in the table is the correlation
betwee n veh icle weight and crash survival. In crashes, the heavier vehicle always "wins,"
showing serious crash survival advantages fro m a few hundred po unds! Once again, you can
make a physical argument that there should be some correlation (consider a bicycle versus a
freight train as a lim iting case), and sure eno ugh, there is.

Graphing and trendlines
If two columns of data have a perfect, 100 percen t correlation, you can plot the data in the
two columns as pairs of points and get a lovely straigh t li ne. That is, if there's a rigorous
underlying rule connecting the data in the two columns, it means that you can just compute
the points in colum n B from the data in column A. For most real-world data, however, you get
correlations of less than 100 percent, ra nging all the way down to 0 percent correlation
(meaning that there's no underlying connection between th e two data sets).

Let's look at a plot of the data in Figure 19.1. Using a scatter plot, the preferred chart type for
investigating correlations, we get the chart in Figure 19.2. The points are m ore like a stretchedo ut cloud than a straight line, but there's clearly a correlatio n because the points are clustered
along a line.
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Again, thinking about the da ta, th ere are some reasons yo u ca n ex pect these points n ot to lie
along a perfectly stra ight line:
•

The cars in the data p oints are from several differe nt countries, and different
countries have different standards in accelera ti on. German cars, for example,
would probably p lot as a separate little group.

•

Some man ufacturers inside the United States just sell different ca tegories of car s,
from family seda ns to so-called sp orts cars (the only true sports car made in t h e
United States is th e j eep, according to Gra nd Prix c h ampion Stirling Moss).

+

Automatic-transmission cars also for m a d ifferen t group fro m manual 5-speed cars.

In each of these cases, there's an underlying reason why some cars do n 't have exactly the same
horsepower/weight relationship as oth ers. Nonetheless, you ca n tell that there's some relationshi p, so it's time to call up Excel's trend analysis system, as fo llows:
1. Select the data points in th e ch art sim p ly by clicking them (see Figure 19.3).

2. Find the Tre n d line com mand under th e Insert me nu (see Figure 19.4), which
produces the Trendline dia log box.
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3. In the Type tab, pick the Li near trend, the simplest trend, which tries a lin ear fi t.
This means that Excel will compute the straight line that makes the best fi t to the
data (see Figure 19.5).
4. From the Options tab, pick some points to forecast, if you like (see Figure 19.6).
Forecast means that Excel looks at the formu la it has generated (the calculated
straight line) and computes some new predicted points.
5. just to make this official, check the two check boxes that display both the equation
and the R-squared value on the chart (Figure 19.7).
6. After you click OK, you get a lovely trendline right through your points on the
chart (see Figure 19.8).
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What does this all mean? In this case, it means plenty. Excel draws a line through any points
that you give it, whether there's a correlatio n that's meaningful or not. Looking at the
trendline output on the chart in Figure 19.8, note tha t the correlation statistic R-squared is
0.7966, which you can round up to 0.80 without distortion. This number is a key indicator in
finding real trends. Here's a quick and very approximate guide:

+

R-squared = 1.0. Congratulation s! You have discovered a law of nature. Your scatter
plot points are perfectl y correlated.

+

R-squared = 0.8. This is still a very strong correlation. If you su spected some
connection in your data points, this statistic confirms it.

+

R-squared = 0. 5 or less. Things are getting considerably cloudier. A forecast based
on this sort o f correlation is not reliable.

+

R-squared = 0. Your data should look like buckshot blasted against the chart. In
fact, it's very rare to see data so perfectly uncorreiated that this statistic is actually
zero. If you just draw points on a chart, taking your best shot at making the
distributio n random, you're likely to get a value like 0.12.
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As a last bit of de m onstration, consid er the chart in Figure 19.9. Here I've gone back to the
Trend line dialog box and p icked the Po ly nomia l tre nd rather th a n the Linear trend. That
means t hat Excel ca n t ry to fi nd a function with some curvature instead o f a straig ht line and
the n evalua te the fi t to this c urve. The result, as it happens, is a fa intly be tte r fit to the data,
with an R-squa red statistic of 0. 7974. Because this more co mplicated trend function is on ly a
ma rgi nally better fit to the data, the straigh t line is a bette r·prac ti cal m o del.
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Figure 19.9 A polynomial fit of the weight/horsepower data.

Other Trend Functions
Excel offers a luxu rious pro fusio n o f ways to d o a pproxima tely th e sa me kind of fo recast. Th e
function TREND (Funct ion Wiza rd keeps it with the sta tistical fun ct io ns) is one exa mpl e.
TREN D (see Figure 19.1.0) asks for two data series in cell ranges, com p utes a straight line by
taking th e da ta in pairs, a n d re turn s a straigh t-li ne set of va lues. In t his case yo u would take
the cell ran ge o f h o rsepowers as th e set o f ''known_y's" in th e TREND dia log box, the ra nge o f
weights as th e set o f "known _x's," a nd set u p a n othe r range for th e computed " ncw_x's."
Probably the best way to see th e resul ts of a TREND is to compare a plo t of th e o ri ginal data
w ith a p lot of the " new_x's" (see Figure 19. 11 ).
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You may have noticed that this function is a bit more trouble to use than the Trendline
command, but it does give you back actual points in your works heet. If you have a statistical
background, you can use these points for fu rther calculation. A related function is FORECAST
(see Figure 19.12), which takes the set of x andy points and com putes a single new x. Yet
another function is LINEST, for linear estimation, which returns the correlation statistics, but
not the new computed data points (see Figure 19.13). All these individual pieces of the
Trendline package are more useful for people programming templates than for individual users
just looking for a little data analysis.
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Trends with Business Data
Readers with a literary bent, keenly attuned to the supreme importance of parallelism in
narrative structure, have probably observed that the first section in this chapter is called
"Trends with Good Numbers," while this section is called "Trends with Business Data." This
was deliberate, and is of course meant to suggest that data on physical quantities is often a
more productive field for trend analysis than, for example, sales data. This, of course, is tragic
because predicting sales is a matter of desperate interest, if not actual hysteria.
I would like to present a real-world business data set with some features modified so that the
last representatives of the compan y that pursued the criminally idiotic course of betting the
company's future on a trend analysis of sales data do n' t recognize themselves here and sue me
(or, heaven forfend, Hayden Books) . Let me just state, for the record, that the real case was
worse than the one I present here.
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Sales data
Scaled for credibility, the sales of Com pany X for its fabulous tal king toy bear are shown in
Figure 19.14. As presented, the story is an unqualified success. Sales keep going up, yea r after
year. The big questions are how many people should the company hire, what production
facilities will be needed, what sort of distribution is best, an d how do we cash in big time while
we've got a winner??!! Take a look at the data as charted in Figure 19.15. If you had been the
marketing manager of this com pany, you wouldn't have gotten one night's sleep any time in
December because you would've been so busy.
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Sales data from a roaring success.

What actually happened in this case is that the company perfo rmed a trend analysis (see
Figu re 19.1 6) and believed the worksheet when it said that there was nowhere to go but up. It
hired people like crazy, expanded production-and blew out in one of the most spectacular
meltdowns in recent American co rporate history. It happened that the appetite of the toyconsuming public could be saturated after all, and the products of this firm are now quite
surely rotting in closets na tionwide, right next to a motley assortment of Cabbage Patch Kids.
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Sales data forecasts
I now would like you to perform the fo llowing "visualiza tion exercise," as they say in d ifferent
psychol ogical practices. You're speaking at the front o f a conference room, and you're showing
a slide of a nice straight trendline thro ugh a set of sales data. Suddenly, t he lights come on, the
door to the roo m comes crash ing thro ug h in splinters, and Arno ld Schwarzenegger, in full
camo battle dress, strides to the front of the room and pins you against a blackboa rd. "I tot I
tole you nevah to ana lise Zales Datuh dis vay!!" he screams in your face.
The principle is this: there is no underlying reason for a correlation between you r sales data and
cal endar dates per se. There could, on a more positive note, be a correlation between

+

Sales and advertising volume. Yo u could try to correlate sa les with
Thousa ndsOfPeople reach ed in an ad ca mpaign.

+

Sales and number of retail outlets. When you correlate th ese two, you get to see if
sales per o utlet have started to drop.

+

Sales and populatio n. If you own the only dry-clean ing shop in a growing town,
you could project your per-ca pita numbers. If you own the Water Company, this is
a scientific-quality correlatio n.

+

Sales and number of salespeople. When sa les per salesperson start to drop, it's a
telltale sign o f a problem develo ping.

+

Sales and your com petitor's es timated sales. You ca n use this information to see if
you're actually fa ll ing behind, even as your sales increase.

Even in the hazy world of sales data, some co rrelatio ns are better than others. In the b usiness
case of the toy bea rs, there were two problems that no o ne seemed to notice. first, by the
second yea r of operation, there was a distinct post-Christmas slum p-this caused unmanageable cash flow problems during an even bigger post-Christmas slump in the third year. Second,
sa les were going up, but sales-per-o utlet were leveling off or headed down, a sure sign that
someone's "genius status" is soo n to be revoked.
There are plen ty of valid applications of trend analysis in business data. If you can formu late a
solid, fundamenta l reason, based on the d etails of a business, of wh y sa les should correlate
with some other business va riable, Excel ca n help you quantitate the trend. But Excel has no
pro blem whatsoever in find ing a trend in a mirage.
Ru le One of trend analysis: First think t h rough a stro ng argumen t fo r expecting one set of
business numbers to be connected to another. Then see if Excel confirms your argument.
Consider, as a last irony, that an exponential increase in sa les (see Figure 19.1 7) is an even
better fit to the reported data of toy sales than a strai ght li ne. A carefu l study of this pro jectio n
says that by the yea r 1997, eve ry do llar in circul atio n o n th e globe wou ld be spe nt on ta lking
stuffed toy bea rs. It should come as no su rprise to you that this isn 't what happened because
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yo u ha d at least eno ugh money left over to buy this book. Soph isticated mathematics is no
substitute for u nderstand ing t he real d ynamics of a business. If yo u need to justify a mass ive
salary increase fo r yourself based o n a trend pro jection, please be my guest, but you sho uld be
awa re o f the d ifference between a valid anaJ ysis and sleigh t of ha nd.
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Figure 1 9.1 7 An exponential trendline fit to the bear facts.

Excel S has p ut fo rwa rd the best trend analysis facil ities ever inco rporated in a wo rksheet. The
people at Microsoft' d id a wonderful jo b, and incorpora tin g trend li nes into charting was a tru ly
insightful move. No net heless, it behooves you to u nderstand that trend analysis doesn't tell
you an yth ing if you don 't have so me un ders tand ing o f t he d ynam ics underlying yo ur data.
Excel can draw lines through your d ata points, but you have to decide whether th e li nes mean
anyth ing.

What-If Analysis: A Fish Story
In t he previous chapters, I write about entering num bers, graphing them, and do ing some
calculations. Realistically, you coul d clo most o f this wo rk on a calculato r an d make yo ur own
charts on graph paper.
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Now I want to do something fancier, something th at will actually put som e of ExcelS's po wer
to work. The idea here is to do this task simply eno ugh so that you actually have som e confidence in Excel's automated what-if methods. I know from teaching Excel classes that users
often see a demonstration, nod agreeably all the way thro ugh, and then go back to doing
everything by hand because there was some detail of the analysis that seemed a little hazy.
After you understand how to use what-if techniques in Excel, you'll want to put them to work.
You already know how to analyze some basic situatio ns by replacing a value in an Excel
formula with different values one at a time. Fo r example, you can poke around in a home-loan
formula, trying out different amounts for the principal value to see what the resulting payments will be. The ana lysis tools in Excel 5 essentially let you do this same kind of investigation, but they provide a way to check out batches of test values rather than doing numbers
one at a time.
The whole subject of what-if analysis is easier to explain with a concrete example. And by this,
I don't mean one of those little case studies involving "widgets" o r Product A versus Product B.
If I may be allowed a bit of editorial fulmination, it's probably o ne of the greatest handicaps of
American business that large chunks of it are managed by people who spent years getting their
M.B.A.s by calculating widget examples.
Widgets never have defective parts o r packaging, and there's no way to make a better widget
by improving quality control o r assembly, so in the widget trade, all business maneuvers
consist of fin ancial juggling and reducing overhead by laying off em ployees. During the 1970s
and 1980s, American auto executi ves with advanced quantitative training thoug ht they could
sell cars with defective paint jobs and oil-leaking engines by managing inventories and credit
financing plans better. The consequences of this approach to business school training have
been pretty clear.
So, forget widgets . . . let's ta lk fish. I' m going to make a li ttle model of a fishing business in
Fort Bragg, CA, on the Mendocino Coun ty coast. It's a de lightfu l community, except for the
harsh economics of the fishing business. It's also th e communi ty that you see in most movies
or TV programs about New England (better weather fo r shootin g).
Figure 19.18 shows the elem ents of th e model. Remember, the easiest way to get multiline cell
entries like those in row 3 and row 6 is to select the whole row, choose Cell from the Format
m enu, and select the Wrap Text option from the Alignment tab. Here are the fishy facts
behind the model:
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+

There are no salmon here, sorry to say. They're just about gone, like the increasingly elusive cod fish on the East Coast.

+

Squid were bait 20 years ago. Then they were relabeled calamari and became Purina
Yuppie Chow all over California.

+
+

Rock cod is just a good o ld standard fish that is fortunately still abundant.
Of course you can't eat sea urchins. You eat sea urchin eggs, called uni in sushi
bars. It's a sort of an orangish paste that tastes just like you'd expect something
from a spiny beach haza rd to taste. You'll like the salmon and broiled eel in a sushi
bar right away; uni, however, is an acquired taste. Uni from California goes mostly
to the high-priced markets of japan.

llt;!::t::::=::::::::==:j::=::-:

Figure 19.18 Labor and equipment costs for fishing.

The model here is a crude approximation of two facts of life: urchins are picked off the ocean
floor by divers, while squid are simply netted from a boat. Figure 19.19 shows a little imaginary ana lysis of the profits for a single small load of each delectable seafood product. Profit in
this model is just cost (labor plus boat time) subtracted from the market price. This game, by
the way, is being played very seriously in the market I'm modeling h ere because fishing
operations struggle to exist in a tough market and an increasingly empty ocean.
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Figure 19.19 Profits from the sea.

Automating Replacement
There are many elem ents in this m odel that can be changed, and the changes will affect
profits. Prices of seafood items can change, of course-uni prices, for example, are headed
th ro ugh the roof as the dollar sinks below 100 ye n to the buck. I'm going to concentrate o n
changing productio n costs, instead, mainly to illustrate the way that Excel can change inputs
to elaborate functions.
The cost factors are the per-hour labor rate, pegged at $12 per ho ur in the simple model, and at
a rate of $150 per hour fo r fish ing boat time (this is a composite of depreciation, abysmal perhour fuel usage, and o ther costs). The for mula in the Cost cells (colu mn E) is simply
Cost

= Man-hours * pay + BoatTimc *

BoatPcrHourRate

I want to exam ine fi rst what happens if the numbers fo r boat time change-th is happens often
as a d irect consequence of changes in fuel prices.
Yo u could just swa p one number after ano ther into cell 04 of this wo rksh eet, but fo r mo re
than two o r three swaps, this gets to be tedious. There must be a better way, and there is. Excel
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has a device called a one-input table that handles automated swapping of values, producing a
table of outputs that corresponds to the different conditions you want to test.
Now the one-input table is useful, bu t it's a fussy little item, requiring you to do everything
perfectly. You must follow these instructions exactly, or you'll create an unsightly blob of grid
on your worksheet.
Here's what you do, as shown in Figure 19.20.

Th is cell is --1~Y.::.::::;;:::;;..::;..;J;:;.::;~;:....__:::;:::.:::;:;;...:.,
the corner
of the
data-tab le
::f-1---+-- - - 1- - - - t - - ---HI±H-- The values you
rectangle.
want to try.

Figure 19.20 Setting up a one-input table.

1. Find a clean rectangular area to place the table. On e cell (leave it blank) will be the
upper-left corner that anchors the table.

2. Underneath the anch or cell (ahoy, mates), you can list the different values that you
want to try in the model. Those are the boat-time numbers from 100 to 250 in
Figure 19.20.
3. Then across the top, next to the anchor cell, type in the "result cells" that you
want to inspect. Here I made the connection between profits and boat time by
putting =G7 into El 2, =G8 into Fl 2, and =G9 into G12.
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4. Unless you have th e wo rld's grea test me mo ry, l sugges t p utting li ttle text labe ls at
t he sides o f the table. Th at's wh at th e boat~ a n d (-p rofits tags a re doing the re.

5. Now use the mouse to select the a rea fo r th e table (see Figure 19.2 1). Pull down the
Data m enu a n d c h oose Tab le. You see a d ia log box tha t asks fo r some inputs.
6 . In m y ta ble, I' m ch a nging the da ta in a column to be va riatio n s o n th e input in cell
D4, so l clic k the Colum n Input Cell box and click D4, a nd that cell is e nte red as a
Column Input Cell.
7. C lic k OK. Presto ! Excel gives you a wh ole se t o f profit da ta.

On a practica l basis, th e on e-input da ta ta ble becom es m o re useful if you h ave a lo nger li st of
possible inputs.
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Figure 1.9.21. Excel tries a list of input values in your model.

Don 't try to edit cells in the d a ta table. They're pro tected, so yo u can't do it. It's possible to get
ca ugh t in a sh ockin g m ess whe re your o nl y h o pe is to p ress Escape, clear t h e wh ole table, a nd
sta rt ove r aga in .
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So what do you see in t h e table? The first thing you see is th at if the boat costs do ubl e, it's not
worth getting up in th e morning a nd heading o ut to sea. If boat costs drop a lo t, it's time to go
sq uid fishing. It would be pretty simple to estimate a per-load cost that makes it worthwhile to
go fishing and thus turn this exam ple into a break-even case study.
This sort of analysis h appen s all the time in othe r businesses. Th e re are always trade-offs
between prod uction costs, ma te rials costs, shippi ng costs, the contributi on of different items
to overh ead, and so fo rth . Here I just modeled a li ttl e o pera t-ion with two kinds of costs and
three products. The rea l value of automating data substitut io n with a on e-input table appea rs
when you have more com plications, such as six cost fac tors and nine products. If you try to
so lve that kind o f prob lem by one-item-a t-a-tim e substituti o n, it's pretty tedious. If you try to
so lve it in your h ead, the odds are you 'll get it wro ng.

More Automation
As long as I' m putting Excel to work, I might as well get a little more out of it. There's a
va riation o n th is last operation, ca lled a two-inpu t table, th at le ts me change two inputs at
once while generating a table of outpu ts corresponding to a single quantity. Again, l 'm going
to pick a clean rectangular area, take the cell in the upper-left corner as a n a nchor, a nd start
fi lli ng in values (see Figure 19.22). This time, however, I' ll p ick one quantity to mo n itor a nd
give th e table two kinds of inputs.
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3
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6
3
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Figure 19.22

Excel tries two lists of input values in the model.

490

)

320

111~·~1 ----~~-~~=---~--- -

-- ~~

n

T he row list
of inputs.

Predicting the Future

Chapter 19

Here are the steps for a two-input table:
1. In put a set of pay levels in a row across the top of the rectangle.

2. List the boat-time data in a colu mn, as before.
3. In the anchor cell, put =G9, corresponding to squid-catch profits. (Oooh! Isn't this
better than widgets? Gives ya something to p icture in your mind.)
4. Select Table from the Data menu.

5. The dialog box now needs both a row (" pay" in C4) and a column ("boat" in 04)
entry.
6. Wh en you click OK in the Table dia log box, you get the informative vista displayed
in Figure 19.23.

,..:<,,..-=

" ----"-'"'+-- - - - ' " " " ' - - - - - ' - - - -+--+rlf-

This cell refers
to a single
output quantity.

Figure 19.23 This two-input table is a definitive analysis of the squid market.

The little tab le shown in the figure is the quantitative ex pression th at labor costs are not the
big problem with squi d. If a good loca l area gets fished out so th at the boat trip doubles (going
to the next area), there won't be much calamari with ginger-li me dip in the finer establishments on shore. What's actually happened in West Coast fishing reali ty, just so you know, is
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that sea urchin market prices are currently going berserk. At t he most recen t projections (using
the TREND function discussed ea rlier in this chapter), the last sea urchin will sell for 200
million yen at an auction in the Tokyo Central Fish Market in the year 2017. I'm partially
kiddi ng.
When do you use a two-way table versus a one-way table? In my humble opinion, most
business situations actua lly call for a two-way table, and the one-way table is just a simple
explanatory device used in books li ke this to introduce the subject. The all-time ki ller table
shows Sales alo ng one side of th e table, Payroll along the other side, with Profit as the quan tity
being investigated. That's pretty much the table all America wants to see at business meetings.
If growing businesses used this kind of table consistently and used realistic esti mates of sales
rather than som ething computed by regressio n, they could avoid the ghastly destructive cycle
in which they hire people and then lay them off three months later. It's an ironic problem
that fast g rowth is statistically as dangero us to businesses as gentle decline.

Scenario Manager
Personally, I like using two-way tables for analysis, but I use another Excel fea ture, Scenario
Manager, for presentations. The problem with tables is that they typically present more
information than people can conveniently absorb from a slide in a 40-minute fast-ta lking
pitch. It's easier to encapsulate a few high points in Scenario Ma nager and then disp lay a few
cases. This doesn't matter much in the fis h trade, where reality catches you sooner or later, but
in financial realms, a good pitch usually is th e product. Frankly, if your argument is shaky, but
your job depends on the presentatio n, Excel's Scenario Manager is your best com puter friend
(along with the short course in graph ing tricks in Chapter 15).
After that build-up, I should probably show you how to use th is feature. For our piscatory
computational interlude, it goes something like th is:
1. After you choose Scenarios under the Tools menu, the Scenario Manager pops up.
Old Excel hands, please note that Scen ario Manager is now part of the show, not
an add-in.
2. Click Add to bring up the Add Scenario dia log box, name a Scenario, and click on
the input cells t\lat will change in the model (see Figure 19.24).
3. I'm going to define a good case and a bad case, so I click Add again, getting the
screen shown in Figure 19.25.
4. To enter the data for the scenario, click on the scenario and then en ter the data fo r
the case directly in the worksheet.
5. Good fish ing means cheap labo r and cheap boats, bad fi shing means expensive
help and expensive equipment. After I enter tpe data (see Figure 19.26), Scenario
Manager remembers it.
6. I can add more Scenarios to this worksheet any time I like.
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Enter a
name.
Identi fy the
scenario
in put cells.

Figure 19.24 Pick a scenario name and t he input cells that you want to change.

Figure 19.25 The Scenario Manager records several sets of inputs.
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These
profits ...
... correspond
to these costs
in the "good"
scenario.

Figure 19.26 The low-cost fi shing scenario.

f-or a presentation, call up the Scenario Manager, park it som ewhere at the side of your
worksheet (so it's not in the way of the numbers), and click on the scenarios one at a time.
Because the numbers change faster th an anyone in the room can calculate, you have a real
"dazzle" advantage if you whip through a high case and a low case and then present the
aud ience with your own version of a "most likely" scenario.
ror a Scenario Manager presentation, I also recommend putting a chart of the key result
quantity o n the worksheet (see Figure 19.27). Not only does it draw attention away from the
raw numbers, but it also gives you a chance to use all the tricks I discussed in Chapter 15. The
chart changes automatically every time you click on a different scenario in the Scenario
Manager window.
Please understand that neither I, nor Hayden Books, nor Macmillan, nor Simon & Schuster,
nor our corporate parent Viacom would advocate fraud of any kind. I'm talking about designing a presentation for a circumstance in which "your glass can be seen as half empty or half
full." In Scenario Manager, you can pick the state that you want to present and al~o show what
a full glass would look like.
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Figure 19.27 Charts beat tables, for truth or fiction.

Looking Back with Goal Seek
Now for your own investigation, th ere's a nother handy tool to employ. It's called Goal Seek,
a nd you ca n find it in the Tools me nu (above Scenario) .
Using Goal Seek in the fishing example, I tell Excel h ow much p rofit I wa n t, a nd it te lls m e t he
co ndi tions that will yield that m uc h pro fit. In other wo rds, I p ic k an o utput that I wa n t, and
Goa l Seek juggles in put va lues un til the o utput is rig ht.
It's easy to use, and h e re's h ow you d o it:
1. C lick the outp ut cell for your expe riment. I'm p il:king sea urc hi n profi ts in G7, just

to go fo r th e gusto .
2. Select Goa l Seek fro m the Tools me nu. Whe n the Goa l Seek di alog box o pe ns, you
see tha t it has put your selec ted ce ll in the Set Cell tex t box.
3. Pu t a goa l va lue in th e To Va lue text box and clic k o n th e va ria ble in put cell, in
this case t he labor-cost cell in C4 (see Figure 19 .28) . Click OK.
4. Goal Seek grinds a bit. Afte r it 's finished, the Goal Seek Status dialog box and the
numbe rs in the worksh eet h ave cha n ged (see Figure 19.29).
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What did this command tell me? Well, at current boat costs and market prices for urchins, I'd
have to find a diver who would work for $2.50 an hour if I want to make $500-per-load p rofits.
That's not going to happen. If I want to make more money, things are even less promising. To
make S610 a load on urchins, I have to find divers who will pay me $3.00 an hour to have
th em muck around in the freezing cold and dark water. That's highly unlikely.
Nonet heless, Goal Seek is a worthwhi le day-to-day business tool. If you have, for example, a
rea listic model of your company's transaction costs, you can use it to find the minimum order
you should process. You can use it to decide wheth er you should switch jobs, comparing
sa laries before and after and the costs of switch ing. And it's very effective in loan payment
co mputations, solving for either loa n amounts or target payments.
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Figure 19.29

Below minimum wage in cell C4!!

Looking Everywhere with Solver
Goa l Seek essentially runs thro ugh a set of input values and then reports the result to you
when it has reached the desired outcome. It's fast and very usefu l-even for complicated
models- because it's a o ne-dimensio nal optimi zatio n, changing o n ly o ne number at a ti me.
What happens if you want to pick a goal- profit, fo r example-and find the particular combinatio n of inputs that will get you to that goal? Use an add- in called Solver (Microsoft buys the
Solver code fro m a third party-that's why it's sti ll an add-in). In som e cases, Solver is very
useful, but it has d rawbacks that you shoul d un derstand. Microsoft, realizing tha t Solver is not
for everyone, doesn't include it in the standard installatio n. Yo u h ave to select th e com plete
installation during setup, o r you have to go back into the setu p procedure and add it. Here are
some Solver considerations:

+

Multidimensional goal-seeking is a slow process. It's hund reds of times slower than
one-dimens iona l seeking, not just two or three ti mes slower.

+

Solver can decide that it has met your goal, when, in fact, it has stopped in some
weird area of input-va ria ble space. Altho ugh it's o kay for simple kinds of relationshi ps between input and o utput, for complex relatio nships it can get "stuck."
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For a Solver result to be meaningful, it must be based on an accurate business
model. Solver is hap py to give you nonsense results if you don 't know how to
specify correct ranges of input values.

The bottom line from all these precautions is that Solver is probably a better tool for engineering problems (adjusting three ingredients in a mi x) than for business problems. Nonetheless,
here's how it works in the two-input fisheries case.
After you select Solver from the Tools menu, you see the screen in Figure 19.30. This dialog
box wants you to specify a target cell and the cells that you want the program to vary. In this
case, I specify squid profits in G9. I also wan t this quan tity maximized, so I click the Max radio
button (Solver can solve for a minimum or a specific value, also) . In the By Changing Cells
text box, I h ave specified C4 (pay rate) and 04 (per-hour rate fo r the boat).
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Figure 19.30 Starting up Solver.

Be aware that Solver will try values in the changing cells, so you have to specify constraints
(that is, limits) to keep the values realistic. Click the Add button in the Solver Parameters
dialog box to bring up the Add Constraint dialog box in Figure 19.31. Constraints are usually
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inequalities, giving a range of possible values for Solver to use. For this example, 1 decided to
let the pay rate run fro m $8 to $18 and the per-ho ur rate for the boat run fro m $85 to $200,
giving the values in Figure 19.32.

Rdd Constraint
Constra1 nt:

II

I!
Scrolling list
of choices for
in-equalities.

Add

Figure 19.31 Constraints are us ually inequalities.
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Just before the model is run (by clicking the Solve button), you may be saying, "Hey, Mr.
Excel-Au tho r, sir, this exam ple is idiotic. If this model works, Solver is going to jam righ t away
to the lo west pay rate and lowest boat charges because it's calculating m aximum profit, and the
o nly way to survive here is to lower costs." You' re right. I congratulate you for noticing th is.
That's what's going to happen . The model is so simple that you can predict th e outcome. I did
this on purpose. If I had made a m odel with several quadratic or cubic equations, with complex constraints, Solver would still find an answer, but it would be much tougher to tell
whether t he answer was right. In general, you're better off starting with a simple, even un realistic model, and then adding more details, tracking the changes in results as th e model
evolves.
If you build a fa ncy model fo r Solver (fancy in this context means that the target cell has a
com plicated for mula), you may want to tin ker with Solver O ptions (see Figure 19.33). Un less
you are using adva nced math hmctions in th e target fo rmula, the defau lt settings fo r Estimates, Deriva tives, and Search are fi ne, but you may want to speed up Solver by reducing the
nu mbe r of iteratio ns and reducing the precision.
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When Solver is finished, it reports with a little dialog box (see Figure 19.34) that lets you
accept the new values into your worksheet or revert to the original values. Solver adds a
new worksheet with its compu ted results (the Answer Report in Figu re 19.35) to the front of
the tabbed stack of sheets in your workbook. As you develop a series of increasingly realistic
models, you can save all the report sheets to see which feat ures of the models are most
important.
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SOlver (ouOd e sol ution. All
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Cancel
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Figure 19.34 Solver tells you when it's finished.
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Tre nd ana lysis and what-if analysis ca n be wonderful tools if you 1111derstand your data and
wh ic h direction you want your d ata to take you in the business world . . ow that you have
explored the world of future possibilities, let's get back o n dry land in the last chapter of
the Excel sectio n so th at you ca n learn how to a nalyze all the data that you have at your
disposal11ow.
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Analyzing Data
If you have piles and piles of business data-and most well-run operations do-someday you'll

need to make sense of it all. The defining problem of the modern computer-oriented business
environment is not a lack of in formation, but the presence of so much information that you
can't begin to find what you need, much less interpret it. You need to identify the main trends
in your business, and by trend I don't mean a bunch of points that you can fit to a straight
line. I mean a significan t shift, a warni ng signal, a sign that something is happening that's not
business as usual. To help you make sense of all that data, this chapter explores category
analysis and statistical analysis and shows you h ow to use Excel to define some trends in this
da ta. The chapter includes the following information:
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The Pivot Story
Pivot tables, the central worksheet feature of category ana lysis, enable you to define many
different ways to look at the same data in a table. You have to do some exploration yourself,
but what you'll find is that after a bit of experimentatio n, you' ll be manipulating pivot tables
like a cham p. Category analysis is a bit abstract as a topic, so I'll discuss it in terms of a concrete (well, a stuffed-animal) example.
Microsoft could tell that pivo t tables were important because several other firm s were doing a
li vely business marketing pivo t table add-ins and accessories. Microsoft religiously adheres to
the Godzilla versus Bambi Principle of Marketing, based o n the short cartoon of the same
name. According to the principle, Godzilla waits until Bambi emerges from the forest, and
then sto mps o n Bambi and eats him. Microsoft typicall y lets small fi rms test the waters for
new spreadsheet features and then adds the features to Excel a yea r or two later. That's one of
the reasons Excel keeps growing, and the list of third-party vendo rs for Excel keeps shrinking.
In the case of pivot tables, building pivots into Excel itself has a certain compelling logic:
people will be more likely to use pivots, wh ich are really valuable, and people will come to
appreciate the convenience of having the data and the feature in the same applicatio n .

Multidimensional?
What's the mea ning of multidimensional data, given that all this data is entered into a
standard two-dimensio nal worksheet? It's easier to understand this concept in an example
than by defin ing terms.
Here's your example. You've been appointed as the American sales manager of the Australian
firm, Ma rsupial Madness. The original sales manager, a native Australian based in San Francisco, was so humiliated by the box office and criti cal fai lure of Lightning Jack, Paui "Crocodile
Dundee" Hogan 's 1994 film , that he couldn't face his friends in San Francisco anymore and
moved back to Alice Springs. He insisted on an unlisted phone number.
In the humble office on Market Street, behind a stack of cases of Foster's lager and stuffed animals
in various states of disrepair, you find a Quadra 610 that has the Excel 5 worksheet in Figure 20.1.
Let's look at this closely. You have a single year, two halves in the year, three products, three
product types, 1 and finally the sales data. In modeling lingo, product type can be considered a
category and also one dimension of the sales data. The number 150, fourth down in the sales
data column, could be characterized as
sales = 150 (1994, 2nd, Kurt Koala, Plush)
1

Disclaimer: Please note that "real-fur" in th e product type ca tegory refers to products made with the fur of rabbits that
have died of extreme old age in natural bunny habitats, surrounded by fa mily and friends after long and product ive
rabbit lives. No animals were injured during the production of this book, despite the fact that Roger the cat persistently wa lked across my Mac keyboard at crucial moments.
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In other words, the number 150 is an individual data item whose location in the "space" of
all the data is given by the "address" (1994, 2nd, Kurt Koa la, Plush). Because the address has
multiple elements, it's a piece of multidimensional data.
~
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Many dimensions from two?

Categories
And because the elements of the address are categories, you have a data table with multiple
categories. In pivot table analysis, you make a new table with some categories along the top
edge and some categories along the left side. This way you can make a table, for example, that
compares different prod uct types for different years, diffe rent products by type, o r any combination of categories.
The idea here is to find (by switching the "wha t-by-what" in the table) categories that highlight the biggest influences on the data in the table. In other kinds of data, you may find out
that sales region is a more important factor in sales than product differentiation o r that all
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regions a re h aving a bad q uarter together or t ha t on e product alone is do ing well a nd the rest
are withering across time a nd region. Actually, t h ere's a whole techniq ue called factor analysis
in sta tistics t ha t performs this so rt of study semi-auto maticall y, bu t the pivot table approach
h as the advantage of requi ring n o ma th or sta tistics backgro und at all.

Let's Pivot
Unto every complex task, Microsoft hat h created a wizard. Pivot tables are n o exceptio n. Under
the Data m enu, there's a Pi votTable comman d, which takes you to t h e dialog box shown in
Figure 20.2.

The PlvotToblo Wtrord but Ills en lntorocttw table Ihit
t ummtnzn date from Mtcr010n Excel or onoxurnel dote
aourco.

Croeto PlvotTeblt from deta in.

Th e usu al
choice.

--------+---. Microsoft Dccel List or OotoQ: External Data Source
0 Hultl ple Consolldttlon Ronoet
. ron ·
1 obi

Ttp Tolearn more about PlvotTe blet, eHok the Help button.

Figure 20.2

Pivotlable Wizard, Step 1.

Notice that th ere are a few ch o ices in this wizard step tha t I'm not going to pu rsue. If you like,
you ca n explo re Multiple Con solidatio n Ran ges o n your own. Th is c ho ice enables you to use
data stored in several worksh eets, as lo ng as th e categories in all th e worksheets a re th e sam e.
If you ch oose Exte rnal Data Sou rce, Excel makes p ivo t ta bles from data stored elsewhere. Th e
on ly p roblem w ith this cho ice is t ha t Excel's au to ma tic co nnections all lead to PC-sid e da tabases. If the da ta resid es in a FoxPro o r Mic rosoft Access or standard dBASE da tabase, you ca n
impo rt it auto ma tically into an Excel pi vot table. In a mixed-platform o ffice, t hese d a tabases
a re o ften fo und, b ut they do n 't have much presence o n th e Macin tosh sid e. Believe it or no t,
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if you want to find o ut how to use PC-based externa l data sources, your best bet is to read the
Excel manual because it was written from a Windows point of view with only modest concessions to the existence of the Macintosh.

Setting up the table
So you're just going to take data from a standard worksheet instead of an exotic, remote source
(see Figure 20.3). There's enough intelligence built into Excel 5 to interpret categorical dataall you have to do is arrange the data as shown in Figure 20.1.

==='1:====-1-t-Specify the data
range by
selecting the
cells in the
worksheet.

Figure 20.3

Picking data for a pivot table.

After these sim ple preliminaries, the PivotTable Wizard shows your choices for column
categories, row categories, and data (see Figure 20.4) . If you have a big table that you want to
divide into separate pages, there's a page category, as well.
To fo rm ulate th e table, you just click and d rag the little category boxes to their positions.
Dragging "sales" to the DATA zone makes Excel pop up the element "Sum of sales" (see Figure
20.5) because Excel is not just going to partitio n the data but provide subtotals and totals, as
well. Besides sums, you can make different kinds of da ta analysis by double-clicking the
butto ns for data elements (prod uct, type, and so forth), which gives you other statistical
options (see figure 20 .6), such as Max and Min.
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Figure 20.5

Organizing the table.
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Figure 20.6

Other types of pivot statistics.

I'm going to use "year" as a page ide ntifier and analyze products by type in my first setu p (see
Figu re 20. 7). It's easy to change row and column categories later-that's the whole point of
this feature-so that you can change your mind later and do some exploring. After you have
the categories assigned to your satisfaction (you do n' t have to assign everything because
partial tables are perfectly o kay), you can click the Next button , leading you to the last wizard
step (see Figu re 20.8). You may as well click all the option check boxes, too, so that you can
see right away all the wonderfu l pivoting things Excel wan ts to do for you.

Analysis at last
After this fu rious bout o f wiza rd-stepping, let's finally see what the wiza rd has produced (see
Figure 20.9). Excel has gen erated and formatted and subtotaled this magnificent analysis of the
Australian marsupial toy business. You should know that any little block in gray in this figu re
can be selected with the mouse and moved (from side to top or top to side) to generate a new
table with new totals and subtotals.
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I

product4
tue 1

"'"

Arranging
categories.

c Dec~

Figure 20.7

Deciding what-by-what in the table.

Figure 20.8

Check all the boxes! Information is free!
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just for excitement, I have popped up the Query and Pivot toolbar by checking it on the
Toolbars dialog box from the View menu. The first button gets you back into PivotTable
Wizard; the next button gives you an options dialog box if you have selected a data element;
the arrow buttons group and ungroup categories; and the next two buttons hide details and
show details (the pivot table is rea lly a sort of outline, after all). The button with little sheets
lets you view different pages, and the exclamation point button refreshes data-if you make
changes in the original plain table, click here to get the new data entered into the pivot table.
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Finally, a pivot table.

But you might reasonably inquire, "What's been accomplished here?" Let's take a look:

+

The bottom line shows clearly that the plush versions of these critters aren't
moving very well, at least not compared to the bunny fur and carved (from a
nonendangered, nonrainforest tree with a funny name) versions.

+

Second half sales are down compared to first half, except for that standout marsupial Kurt Koala.

+

If you combine these pieces of information, you would conclude that a fur version
of Kurt could be th is year's hot ticket. A look at the fur, second half, and Kurt
numbers shows this to be the case.

+

The wombats ain't working.
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All these bits of in fo rmation are present in the original big data table, but it would be hard
work to isolate them. The point of a pivot table is that it lets you spo t significant data easily.
Back on the last step of the PivotTable Wizard, l selected the check box fo r AutoFormat, which
has produced th is sm allish tab le. Figure 20.10 shows some modest efforts at reform atting the
resu lts by hand so that the n umbers are easier to see in a repo rt. Also note that Excel has put
the table underneath the original data. That's what it does unless you advise otherwise o n the
last wizard step. Because the data exists in a multisheet workbook, you may want to park your
individ ual pivot tables on d ifferent wo rksheets for clarity.
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A bigger picture with bolder numbers.

Variations on a pivot theme
What happens if yo u select categories and switch them around? Figure 20.11 shows the result
of "pivoting" the product and type categories. Down in the extreme lower-right corner, you
still see the same Grand Total, bu t in this view of th ings, there's a sligh tly differen t emphasis.
In this view, you can see t hat th ere's no t a huge d ifferen ce between the first and second halves
in 1994. But that's because the koalas have been ca rrying this whole show on t heir narrow
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furry sho ulders. The koalas, bless their eucalyptus-munching little selves, account for the
entire im provem ent in sa les from the first half to the second. (A friend of mine who works for
the San Diego Zoo o nce told me that wo rking with koalas means being subjected to an endless
gentle drizzle from above that smells like co ugh syrup.) This document clearly indicates a
public slowly drifting away fro m interest in wallabies and wombats. Is the letter W falling out
of fashio n, or are these animals just no t cute eno ugh? That will be your decision to make fo r
Marsupial Madness, but at least you have the data.
Switch ing ca tegories.
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Making the table pivot.

If yo u are uncomfortable with dragging categories, o r if you want to do a fancier analysis (such
as changing the statistics from simple totals to something else), just double-click any data
element in a gray box (see Figure 20.12), and you can switch the element from a row to a
column label and pick a subto ta l type.
You can also change the time base of th e ta ble by dragging the elem ent "half" up to the PAGE
area where "year" is posted . Clicking on "half" th en pops up ch oices fo r seeing either first half
data, second ha lf data, o r the whole year-still a small table, but o ne in which data has been
summed fo r the whole year (see r:igure 20.13).
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Yet there's no reason to stop here. Let's pull the category half around to the top of the table
and put type and product on the left side of it. We get the table shown in Figure 20.14, which
displays the critters stacked right on top of each other, so a direct product-to-product situation
is emphasized. Once again, two principles stand out: koalas rule, and the furrier the better.
Perhaps the conclusion from this pivoting is that the next product should be a stuffed koala
so furry that you can barely make out its li ttle black nose. This is just the kind of information
that you're supposed to derive from category-based analysis-it's supposed to lead you to
conclusions rather than mere numbers.
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Pictures from pivots
Pivot tables make it easy to see wllat's really going on in your data. At least, they make it as
easy as it's going to be in a plain table fu ll of numbers. For more impact, you have to turn to
charts. In Figure 20.15, I was in terested in product types, so I selected the three Total ranges on
product type across th e first-and second halves of 1994. (Remember, hold down the :l:C key to
select ranges that aren't contiguous.)
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Selecting ranges to chart.

The resulting chart (see Figure 20.16) shows the sales by product type, grouped into two
batches (for first half and second half). Another grouping, shown in Figure 20. 17, isolates each
product type an d contrasts the first and second halves of t he year. After you have selected the
data, you toggle back and forth between these two chart views by selecting category (x axis)
labels in Step 2 of the ChartWiza rd. The chart in Figure 20.17 clearly shows the fur boom in
the second half of 1994, which means that an additional source of geriatric rabbits looks like
a winning resource for Marsupial Madness.
Pivot tables are a Real Big Deal. They're easy to set up, easy to use, and encourage you to
explore your data until the actua l mea nin g of the data becomes apparen t. By allowing arrangement of d ata by d ifferent categories (Sales by State, Brand by Region, New Customers by Year),
pivot tables enable you to find a way to h ighlight th e con nectio n among diffe rent categories
and your actual data. These tables are the most im portant fundamentally new business tool in
Excel 5.
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Simple Descriptive Stats
The analysis tools, in many cases, appear to duplicate functions already found in the Trendline
dialog box from th e Insert menu. But the tools here are classic tabulated statistics, and they
offer insights that aren 't always clear from simpler graphical m ethods.
A basic starting point in ana lys is is the applica tion of descriptive statistics. Let's start with a
simple set of numbers-our old friend the car data set from Chapter 19 (see Figure 20.18).
Because I review statistics programs several times a year, I have about 500 textbook sample
data sets o n my hard drive, but I think it's actually more educational to show different tests
applied to the sam e data set than to introduce lo ts of variety into the numbers.
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In my version of Excel, Data Analysis (see Figure 20. 19) appears under the Tools menu because
I've picked it out as a permanent add itio n by using the Add-Ins manager. If you selected a
minimal installation when you first installed Excel, you h ave to go back to your setup disks
and add the Add-Ins by following the steps fo r modifying an existing installation. You then
need to pick Add-Ins from the Tools menu and select the Data Analysis option. (Because the
setup routines just transfer the Add-In material fro m the installation disks to your hard drive,
you stil l have to build Data Ana lysis into Excel by specifically adding it with the Add-Ins
Manager.)
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My own customized Tools menu has Data Analysis at the bottom.

When you select Data Analysis, you are greeted with a dialog box that contains most of the
tests used in a basic one-year statistics course (see Figure 20.20). Here we sail into uncharted
waters with Excel-if you never had a statistics course, this section of the program contains
more unfamiliar elements. There's not much problem figuring out bold text formatting,
number formats, or even macros, but this isn't the right place for your first exposure to twofactor ANOVA. So I'm going to stick to explaining th e functio ns here in terms of a procedure
you already know: fitting a straight line through a clo ud of data points.
just for fun, let's choose Descriptive Statistics from the Analysis Tools scrolling list in the Data
Analysis dialog box (see Figure 20.21) and see what we get. Usually, this operation applies to a
single column or row, although Excel can hand le multiple data sets. I'm going to specify that
the output table should appear on th e same worksheet, although you can direct it to another
worksheet in the same workbook o r to another workboo k altogether. This dialog box is typical
in asking whether the data is labeled in the First Row- it is, and labeling rows and keeping
data in columns make you r Data Anal ysis life in Excel easier. Also, I've checked the Summary
Statistics check box because summaries are a key part of descriptive statistics.
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In Figu re 20.22, I p ut the most impo rtan t calculated results in bold just to m ake them stand
ou t a bit because Excel d elivers a plain table. The mean is t he n umerical average, wh ich for the
cars in cells A2 to A25 turns o ut to be 3,149.75 po unds. The standard deviation (a measure of
the wid th of the dist rib ution of nu mbers), calculated to a precisio n t hat is not su pported by
the data (we have four-digit weights, so this ten -d igit number is inappropriate overkill), is
abo ut 71 8 pounds. This means that two-thirds o f the cars in t his sample are within 3,150
pounds, plus or m in us 720 poun ds in weight (ro und ing off the n u mbers a bit).
fina lly, the lig htes t car in the ra nge is repo rted as 1,915 poun d s, the heav iest is 4,360, and

(you could figure th is yourself) the range between these two figu res is 2,445 po u nds. The name

descriptive statistics means just w hat it says-it cha racterizes the d istribution of the numbers in
your data set, but it d oesn't do much beyond t his.

•

f ile Edit

Ulew

Insert

form at

Tool s Dot e

\1) 5

Window

~ ~~~1teh11 EE)~[illl!JIT$1 IIDl~J I 1 00~

IEJ ~

IDl@lilllet][}.lti l

18 [ 0 B

IGon<vo
G24

L~

LB J[r Uzll!i=l• lsalmlli m
l %lGlL
£Slb1] IJEEJ R!fS ~

I
Workbook2

~

WeJ gh!_ln t hou oondo lloroepover
4.36 ' - - - I SS
3"
4.0S4 r -1<12

+. _

+-

~ ==--

q_ - -

+ --· -

** ---~II

% ---

* --~ - ..- -

:tt -~
~
~

\6~~

2.1SS, _ _ _ 68
2.S61
9S

2~; .

~~

2.83
3.14
2.79S
3.41

_ _103
125
_l iS
133

~:~~- --~~
3.62,

110'

~::! --: ~g.
3.725

--- 3:.:;

2.585
~ - --2.91
Z4
_1 .9_7 S
01~ ~I HI\ S hoot 1 I SheetZ

Figure 20.22

: ~~

=- :

129.

~~

88
109
6S[
Sheet3 i Sheot4

,,.

~r1ptlve Stat~ti~IMeon
,s toooerd Error

_

..

-

3. 1 49~-~

=· t -

!l.146599218,

SOm~1e Yortence

KurtO>IS
Ske""'' "

R••g•

·\Mini mu m
Moxi mum

·.

I
Sheol6

QJ{

-

-

-

i

-

_ _ ..!
_,

_
_

-~-_ L_
The most

1

-- 2. 44~f __-__-__ .·,'.-_- _
- ·-

-- -

1

1"

1.9 15

4.36
- -75.594
24
-0~0326 31 74j

s um
icoUrlt
Confidence l evel( 95

T

~:~~

0.7 101 0 65 ~
O.SlS79 193S
- 1. 1OS428289
:O.i239So l o6f

Standar d Devlotio

SheetS

i -=--=--

lt~fghl ,., f/Jt!us.tnds

1

r

important
fi gures are bo ld .

--,---:-

- -:C: ~

!..
,,

JI!H
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Sometimes it helps to think abou t the numbers in a spreadsheet because t he spreadsheet can
carry ou t arit h metic to meaningless precisio n . This exa mp le deals with cars and their weigh t. If
you th row a six-pack of Diet Coke into the trun k of the car, th e weight changes by a couple of
pounds. If yo u sit in it, it changes mo re t han that! The car d ata p robably needs to be correct
only to the nearest h undred pounds. What's the approp riate level of accuracy of t he figures for
horsepower, if you don' t know whether the spark plugs are new?
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ANOVA and Correlation
In ANOVA-analysis of vari ance-you begin to look fo r statistical connections, not just
description (see Figure 20.23). ANOVA, from the Data Analysis list, is on e statistical procedure
for finding out how much variatio n in o ne data set (car weight) can acco unt for variation in
another (horsepower). The idea h ere is to determine whether the two columns of data are
independent, meaning that the numbers in one column can va ry all over the map witho ut a
corresponding variation in the o ther column.
The other possibility is that the data in column B (horsepower, for example) is dependent o n
the data in column A (weight, fo r example). For most situations, th ere should be a parameter
that describes how dependent or not the two data columns are, ranging from zero (no connection at all) to 1 (you can predict the number in one column exactly if you know the number in
the other column).
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The output from the ANOVA routine concentrates on a number called the F ratio (see Figu re
20.24). F measures whether (in our terms) the variatio n of the numbers inside a column is
greater than the variation across two columns. The crude interp retation of ANOVA results is
that big F numbers mean there's a sign ificant connectio n between the two columns. Fo r the
data here, this analysis repo rts a critical value for F of 4.05 and a computed value of 421.95 .
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That means there's a virtual certainty (421.95 is huge compared to 4.05) that weight and
horsepower are connected. Although this example isn't too overwhelming, it's often worth
running this test just to make sure that you have a connection worth pursuing. If you don't
find an F much bigger than the critical val ue ("Fcrit" in this table), there's no connection
worth pursuing.
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Figure 20.24

ANOVA results-keep your eye on the Fs.

ANOVA doesn' t, however, give us a nice zero-to-one index of the connection between the data
columns. For that, try Correlation (see Figure 20.25) from the Data Analysis li st. Correlation
gives you a little table with only three entries. It shows that the weight/weight correlation and
the horsepower/horsepower correlation coefficients are 1 because, let's face it, they're the same
columns of numbers (see Figure 20.26). The interesting number is 0.91909076, the correlation
coefficient between the weight data and the horsepower data. The ANOVA results promise that
these numbers are connected, and the Correlation analysis gives th is convenient index.
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The reason these topics are prese nted in this peculiar order is that when you use statistics on
your data, it's a good .idea to use a test for a valid statistical co nnecti o n before you call up the
index of "connectedness." The literature o n statisti cs is fu ll o f tricky examples that give a
respectable correlation coefficien t but have some subtle problem s t hat are revealed either by
charting or ANOVA.

More Description-Histograms
Revisiting the area of d escri ptive statistics and moving down the list of possible Data Analysis
optio ns, Histogram (see figu re 20.27) is an attractive cho ice. There's qu ite a bit of intelligence
built into Histogram, which groups the data into bins for analysis (see figure 20.28). Right in
the midd le, you can see a bin centered on the weight value 3,137.5-compare this to th e mean
weight of 3, 150 in t he standard statistics. Basically, a histogram of this type gives you a quick
and di rty visual descriptive statistics summ ary. In d escriptive statistics, you saw that the
standard deviation was 720 pounds, and I said that two-thirds of all the data en tries wou ld
be found in the range [mean plus/minus standard deviation]. Here, graphicall y, you have a
central bin (th e third o ut of five) centered at 3, 140 (I' m round ing aga in), within 1 percen t of
the real ari th metic mea n; and the next two bins, together with t he central bin, represent 71
percent of the whole d istribution, not very far from the 67 percent of the standard deviation
statistics.

4.36
4.054
3.605
3.94i
2.155 '
2.561
2.3
2.23
2.63
3.14
2.795[
3.41
3.38
3.07
3.62
3.41
3.84
3.725

Figure 20.27

I$A$ 1:$A$25

Specifying a graphic version of descriptive statistics.
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Histogram's graphic output.

Regression
Having revisited descriptive statistics, let's take a backward glance at correlations and such,
available' as Regression under Data Analysis. The Regressio n dialog box calls for most of the
same information (see Figure 20.29) as the o thers in th is area, except it gives you the opportunity to choose a ch eck box called Residua ls.
The Regression output tells you everything you ever wa nted to know, and more (see Figure
20.30). One of the first things to notice is the correlation coefficient, here called "Multi ple R,"
at 0.91909076 (proving the accuracy of Excel statistics). The value in the output table for "R
Square" wou ld be exactly the same as the quant ity called "r-squared" in the trendline analysis
back in Chapter 19, except that here I have picked a sligh tly larger chunk of car data (24 cases
instead of 20), wh ich has pushed the number a tiny bit closer to 1.
In Figure 20.30, the interpretation of res.iduals goes something like this: if the residuals bounce
around with no particular pattern, and the nu mber for "Multiple R" is larger than 0.75 o r so,
you have identified a real data correlation. Residua ls are the tip-off that something strange
may be happening-if the first half of the set is negative numbers and the second half is
positive, you better take a look at the numbers befo re drawing any conclusio ns.
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In this case, everything is fine because you can plot predicted numbers against the original data (this is
why you should have chosen the Line Fit Plots check box in the Regression dialog box in Rgure 20.29).
The differences between the real and predicted numbers (that's what the residuals are-the
differences) are clea rly random (see Rgure 20.31). This means that the variations don't conceal any
sort of systematic pattern other than the on e line computed here .
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Figure 20.31 Comparing the point spreads: predicted versus actual.

One Last Test: t
Nea r the bottom of the list of Data Analysis tests is an assortment oft-tests. Just so that you
know, these are usually called "Student's t" tests, a name that has nothing to do with students.
Student was the publishing name of a very clever fellow named Gossett, who worked for
Guin ness (the brewery) in Dublin and who was obliged thereby to publish statistical papers
under a pseudonym .
The Paired Two Sample for Mea ns test gives output (see Figure 20.32) that includes some
numbers th at are not entirely unexpected. ff you take the square root of the number for
"Variance" in the table, you get the same standard deviation that we have seen earlier. The
correlation coefficient of earlier figures appears here as "Pearson Correlation," with the same
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numerical value. All this may seem to be belaboring a point, but the general theme here is that
in looking for statistical connections between two columns of data, slight variations on the
same analyses appear again and again, producing the same parameters.
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A specific t-test as another approach to correlation.

There are engineering functions built into Excel, but you would be better advised to use
another package (Mathematica, Ma tlab, Ma thCad) for Fourier transforms and such. The
statistics functions available as a Data Analysis add-in, however, are competitive with a lowend, stand-alone program.
Well, there you have it. Excel in a nutshell. I ho pe you have picked up some tips about how to
enter data, format data, graph data, correlate data, predict data, and analyze data. Data-eel out?
I hope not-because as you delve even deeper into Excel, you' ll discover more of its secrets and
become an Excel junkie for sure.
-~ ;1.-
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A few short years ago, PowerPoint was a
distinct also-ran compared to such Mac
heavyv.•eighls as Aldus Persua~ iun .
PowerPoint 4, however, is making itself felt
as the new presentation software leader. It
includes a huge assortment of already
formatted prese ntations and a varie ty of
ways to get existin g informat·lo n fro m Word
and Excel into a visuall y compell ing slide
show. If you need to make a professionallooking presentatio n in a hurry (unfortunately, that's a typical situatio n), PowerPoint
is your best software friend.
In a way, PowerPoint is the part of Office
that you use to show yourself to the world.
Nothing looks worse these days than a
boring black-and-white text presentation.
Nothing h elps a ca reer more than an
impressive presentation that uses color and
graph ics to make a point! It's worth mastering PowerPoint (a nd it's easy!) fo r the sheer
oomph it gives you r ideas when you present
them to coll eagues. In Part IV, you wi ll lea rn
how to create an outline for your presentation and how to turn it into a visually
exciting slide show. You will also lea rn how
to su rvive the "butterflies" of getting in
front of a group of people.

Chapter 21

Getting Started
with PowerPoint
This ch apter gives you an overview o f what PowerPoint does, explains some of the program 's
features and advantages, and introduces yo u to the PowerPoint process by taking yo u through
the steps fo r creating a sample presentatio n. This chapter also pro vides examples of how you
can use PowerPoint as a valuable com m unicatio n tool.
By the end of this ch apter, you should be able to create a simple presentatio n and have a basic
grasp of the following informatio n :

Writing outlines ano

Part IV

PowerPoint 4

What Is a Presentation Program?
PowerPo int is a comprehensive presentation package t hat featu res a sophisticated Help system ,
powerful graphic tools, an OLE (object linking and embedding) that alJows full integration
with Microsoft Word and Excel, text-editing tools, full grap hing and charting capabilities,
animated transitiona l and tex t-building effects, customizable toolbars, and a player that allows
you to run presentations on workstations that don't have PowerPoint. PowerPoint is easy fo r
the novi ce but is not limiting to the expert.
Keep in mind, however, that Powe rPoint 4 weighs in at an elephantine 33MB when full y
insta lled. And OLE currently runs at the speedy pace o f a herd of slugs stampeding through a
field of molasses. Don't even try to run Microsoft Office or PowerPoint wi th less than 8MB o f
RAM.
Although PowerPoint may lag behind some o ther presentation programs in its animation
and mu ltimedia support capabilities, industry publications and users ali ke p raise the new
PowerPoint for its impressive ease of use and solid features.
Such presentatio n programs as PowerPoint assist you in giving presentations that are accompanied by visual elements. The programs are designed primarily fo r creating slides and transparencies for overhead projectors. Most people begin to work o n thei r presentations by outlining
their ideas o n paper before sitting down at the computer.
The process of planning a presentation involves many co mponents. First you should keep in
mind the purpose of your presen tation, how much time you have, and who your audience is.
Then you shou ld thin k about what points you want to convey to the audience and orga ni ze
the points in a concise, logical progression. Taking these facto rs into account, you write a
script that is designed to come across effectively in a frame-by-frame fo rmat. You th en decide
how you want to display the presentation, and you crea te an overall look that integrates visual
elements with text. Finally, you p lan how to set up the presentation.
Power Point goes a lo ng way towa rd making the planning process easier. With PowerPo in t, you
can easily create ou tlines, format text into slides, add visual graphics, and rehearse and time
your presentation.
PowerPoint assists you with developing presentations in the following ways:

+

Helps organize outlines into slides: PowerPo int automatically assigns o ne slide
per main topic and gives you tools for assigning levels to your text. You then flesh
out the outline with main topics, subhead s, and bulleted lists and enter the text
within the presentation package.

+

Makes it easy to create an appropriate look for your slides: PowerPo int offers an
array of templates, automatic layouts, and graphics for crea ting a vibrant look. The
program also comes w ith powerful grap hi c tools for adding and editing visual
elements.
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+

Allows flexibility: PowerPoint allows flexibility so that you can easily make
changes and edits, print out supporting materials, and choose an appropriate
output device.

+

Helps you time your presentation: PowerPoint has a rehearsal featu re so that you
can actually time your presentation on a slide-by-slide basis. This featu re helps you
control the amount of time spent on each slide and ensures that you have sufficient time to get your points across.

Compared to other presentation programs, PowerPoint is the best choice for novice presenters
because it is the easiest to learn and the most comprehensive of the presentation programs.

Getting Around the PowerPoint Screen
Before you get started, it is important to get an overview of the PowerPoint process. After you
understand how PowerPoint works in general, you will have a launching point from which to
explore topics that are relevant to the types of presentations that you want to create.
PowerPoint is easy to .learn if yotl know how to find your way around the PowerPoint screen,
how to use the menus, and"how to work in the differelit.vrews. For those who Jearn better by
doing, you can now go through the basic steps of creating a sample slide show.

Using PowerPoint's menus and navigation al tool s
You can activate PowerPoint's commands through the drop-down menus at the top of your
screen or by clicking toolbar buttons. The various toolbars are located at the top and to the left
o f your screen, depending on which toolbars you currently have displayed. If the TooiTips
option is activated, the name of each tool appears onscreen when you pass the cursor over the
button. You can choose which toolbars to display and whether to display TooiTips by accessing the Toolbars command on the View menu.
PowerPoint has many navigational options. You can use your scroll bars to move up, down,
and across each slide. The Next/Previous Slide buttons for moving from slide to slide are
located on the vertical scroll bar on the right. The adjustable Zoom Control is located to the
right of the Standard toolbar. By clicking the button with the downwa rd- pointing arrow, next
to the percentage indicator, you can ad just the viewing percen tage.

Using PowerPoint's Vi ew tools
When developing your presentation, you will spend most of your time working with either
text or visual elements. Therefore, PowerPoint gives you five ways to view your work: individual slides, a running slide show, an outline, a storyboard, and speaker's notes. You can
access these views by selecting the buttons on the lower-left corner of your screen. Figu re 21.1
shows the View buttons.
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Slide Sorter View.
Outline View.

Notes Pages View.

Figure 21.1 The View buttons.

The two views you will use the most for creating your presentation are the Slide view and th e
Outline view. The Slide view lets you see how each slide appears and allows you to manipulate
text and graph ics. The left side of your screen features the Drawing toolbar for changing the
appearance of text, drawing shapes and boxes, and rotating text and visual elements. You can
also access the Slide view from the View men u or by using the ;):1;-0ption-N key combination .
The Outline view enables you to see and work o n your presentatio n as a text outline without
the visual elements. In Outline view, the left side of your screen now features an Outlining
toolbar for assigning levels to lines of text, changing the order in which text appears, and
collapsing or expanding the outline. When you work with text in the Outline view, your
screen will look sim ilar to the example in Figure 21.2. You can also access the Outli ne view
from the View m enu or by using the :l:i:-Option-0 key combination.

~

The Outline View
• Work with Text
• Collapse/EKpand
• PromotelDemote

• Script your show
• tviove Paragraphs
Figure 21.2 Text in the Outline view.

Setting Up a Presentation
To start up PowerPoint, either double-click the PowerPoint application icon o r select
PowerPoint through the Microsoft Office d rop-down men u button, which appears in the
upper-right corner of you r desktop.
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A Tip of the Day appears, which gives you helpful hints. Every time you start up PowerPoint, a
daily tip appears o nscreen and gives you interesting hints for working with PowerPoint.
To create a Pm"•erPoint slide show from within the application, choose the New command
fro m the File men u or use the J:e-N key combination. In the first dialog box that appears,
PowerPoint gives you the following options for setting up a presentation (see Chapter 22 for
more information):

+

AutoContent Wizard: This option helps you set up an outline for yo ur presentation by prompting you for information.

+

Pick a Look Wizard: This option helps you select a template and prompts you on
details that you may not have thought of, such as t he printing parameters for you r
handouts.

+

Templates: This option enables you to create a certain look for your slides by
selecting from PowerPoint's large collection of templates.

+

Blank Presentation: This option literally leaves you in the Slide view with a blank
title slide- an intimidating sight. Although you will choose this option fo r the
purpose of creating a sam ple presentation in this chapter, a beginner usually does
not start with th is option.

+

Current Presentation Format: This option works onl y if you are already working
on a presentation, and you want to begin a new one.

+

Open an Existing Presentation: This option appears instead of the Current
Presentation Format option if no other presentations are open but you have some
other files saved.

Creating a Slide Show
This sample presentation takes you through the basic process of creating you r own slide show,
which will help introduce you to PowerPoint's features and capabilities while giving you a
basic idea of how PowerPoint works.
To set up a slide show, do the following:
1. Activate the New Presentation menu by launching the PowerPoint app lication, by
selecting New from the Fi le menu (if you are already in PowerPoint), or by using
the ~- N key combination.
2. Open a new presentation by selecting the Blank Presentation option and clicking
OK. The AutoLayout m en u appears.
3. Select the title slide layout in the upper-left corner by double-clicking it. A blank
slide with two text boxes appears (see Figure 21.3).

537

Part IV

PowerPoint 4

r··-..... --····...--·-. -------·----·-·-···.-dick to add 1itle

!

:--- --· ·ai~i~-~dd;;t;iiil~---- --:
I

o

l_ ----··--·-· · · · · ·--··--·-· -· · ·- - ...!
Figure 21.3 A blank title s lide with text boxes.
4. Select the Text tool by clicking its button. The Text tool is identified w it h a letter A
and is located on the Drawing toolbar to the left of the screen.
5. Enter the title of the slide by placing the cursor in the upper text box and typing
Presentations with PowerPoint.
6. Enter your name in the text box located underneath the title box. Figure 21.4
shows the title slide with text entered.

Presentations with PowerPoint

Figure 21.4 Title s lide with text entered.
Congratulations! You have just launched your fi rst PowerPoint presentation. You will return to
this sample presenta tion th ro ughout this chapter. In th e following exercises, you learn how to
add new slides by writing an o u tline. But first you need to lea rn more abou t how to add n ew
slides and how to work in Outline view.
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Adding new slides
You can add new slides to your presentation in several ways. You can use the Ou tline feature
because every time you create an outline title, PowerPoint starts a new slide. You can also
click the Insert New Slide button on the Standard toolbar, click the New Slide shortcut button on the lower-right corner of the screen, select New Slide from the Insert menu, or use the
~ -Shift-M keyboard combination.

Working in Outline view
The easiest way to make sure that you have enough slides fo r what you want to say is to work
in the Outline view. To switch to the Outline view, choose the Outline command from the
View menu, click the Outline View button in the lower-left corner of you r screen, or press
~ -Option-0. Every time you enter a new main topic, PowerPoint automatically adds a slide.
The Outline view also provides you with tool s. For now, the most important tools are located
on the right side of the Formatting toolbar, the one below the Standard toolbar at the top of
your screen. Figure 21.5 shows the Promote, Demote, and Bullet On/Off buttons.

Promote (Indent less) button.
Demote (Indent more) button.

Bullet On /Off button.

Figure 21.5

The Promote, Demote, and Bullet On/Off buttons.

You will use these three Outline tool s in the following ways:

+

The Promote tool: It moves a line of text one tab to the left so that the text takes
on a higher level in the outline. By using the Promote tool, you can make a regular
heading become a slide title or a subheading become a regular head ing.

+

The Demote tool: It moves a line of text one tab to the right so that the text takes
on a lower level in the outline. By using the Demote tool, you can turn a slide title
into a heading or a heading into a subheading. You can also demote by pressing
the Tab key.

+

The Bullet On/Off tool: PowerPoint automatically bullets headings and subheadings. You can o mit bullets on lines by selecting the lines and clicking the button.
Bullets can be added in the sa me way.
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Starting an Outline
Now you can create an outline for your presentation by using th e Outli ne view. The Outline
view automatically creates bulleted lists and makes it easy fo r you to fi t text into slides.
To sta rt an outline, do the followi ng:
1. Switch from the Slide view to the Outline view by clicking the Outline View button

in the lower-left corner of your screen, by selecting the Outline command on the
View menu, or by using the ~- Op tion- 0 keyboard combination.
2. To create a new slide, place the cursor after your name on slide 1, press the Return
key, and click the Promote button once. Now you r cursor is on slide 2. Slide
numbers are indicated by small numbers to the left of the slide titles.
3. Type in the followin g main topic on slide 2 and then press Return: Write an
Outline. Notice that you are now on slide 3.
4. Type the words Organize your ideas. This sentence is now the mai n topic for
slide 3.
5. To demote slide 3's main top ic and make it a subhead of slide 2, click the Demote
tool or use the Option-Shift-Right Arrow key combina tion. Then press the Return
key. Now the words "Organize your ideas" appear as a heading for slide 2.
6. Add to your bulleted list of subheads by ly ping the following and then pressing
Return: This is a bu lleted h ead . Notice th at pressing the Return key aga in automatically places your cursor at the same head ing level as the text above it.
Now you have some idea of how entering text in the Outline view works. Usi ng the Return key
automatically places text o n th e same outline level as the line above it. In the next exercise,
you' ll get more practice in using the Outline tools to adjust the levels in your outline.

Using the Outline Tools
To adjust levels for lines of text, you can use the Pro mo te and Demote tools. The Promote tool
moves lines up o ne level, and the Demote tool moves lines down one level.
This exercise reviews how these tools can help you organize your o utl ine. After you get a feel
for how t hese tools work, you can easily set up and make ad justments to your outline.
To adjust the levels of your o utli ne and to experiment with bullets, do the following:
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1. Type This' is· a subneading and make it a subheading by clicking the Demo te
button, pressing the' Tab key, or using the Optio·n-Shift-Rig ht Arrow key combinatio n . Press Return.
2. Type Use the outline tools and promo te it by clicking the Prom ote button or by
using the Optio n-Shift-Left Arrow key combination. Press Return .
3. To demonstrate how you can turn your bullets on and off, type Bullets, click the
Demote butto n, and press Return. Then type No bullets, click the Bullet On /Off
button while your curso r is still o n this line, and press Return. No tice th at the li ne
that says "Bullets" has a bullet next to it, but the line that you just typed does not.
4. To reactivate your bullets fo r the next line, press the Return key and click the Bullet
On/ Off button. Th e next line aga in has a bullet nex t to it.
5. Promote the line that you now have your cursor o n by clicking the Promote button
and then ty ping the word Promote. Notice that the word "Promote" appears as a
heading rath er th an a su bheading, unlike the li ne above it. Press Return.
6. Create a demoted subheading by pressing the Return key an d clicking the Demote
tool or by pressing the Tab key. Then type the wo rd Demote. Your outline should
look like the one sho wn in Figure 21.6.
You have used the Promote, Dem o te, 'and Bullet On/Off tools to organize the text on slide 2.
Th e next exercise lets you practice what you have learned in th e previous tu torials by creating
two more slides without a step-by-step approach. Go for it!

• Oraanlze yourldeae
• Tille IB a bullemd head
- Thia: is u utll:mdir..R
• Use the outline~
- B~t.l
l'lo bullel5
- DtltiOt.l!

.:~ I

Figure 21..6

The slide 2 outline.
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Adding More Slides
To complete the look fo r your slide show, create two more slides. Remember to use the
Demote and Promote tools when necessary. Good luck.
For slide 3, type the following information into the designated categories:
Title:

Create a Look

First Header:

Use Slide view

Subhead:

3Smm slides

Subhead:

Color overheads

Subhead:

B&W overheads

Second Header: AutoLayouts
Subhead:

Clip Art Gallery

Subhead:

Graphs & Charts

Your outline for slide 3 should now look like the one in Figure 21.7 .

• OqalltJOU'J(• 'HEtn-...ltlll

• t101SWt VInJ

...

.· ,U-oU4u

,_,.~

· Nfl,_....,
• Aln.C•• nc
• lUI)

a.tc.n.,

. . .tli•U•u

Figure 21.7 The sample presentation outline with slide 3.

For slide 4, type the following information into the designated categories:
Title:

Illustrate Points

First Header:

Clip Art
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Second Heade r: Graphs/Charts
Third Header:

Tiff, EPS, Pict

Figure 2 1.8 shows what your outline fo r slide 4 should look like.

• Oti,.IUOI,KJ'IJKW
• JU. tn.l.tJIIttU..t
-nuo.,.,.\J.ooU.,.
• u. lll n.tiuluh

........

• Pl.cMU

• U•SIJ• \ \rv

_.,_,_

-C.&...o-t...&.

-···~

- .u~n•

-C "'rMa.u..r
-4111)JII A O W H

Figure 21.8

The sample presentation outline with slide 4.

Now that you have fin ished yo ur first o utlin e, you are ready to g ive your slide show an
exciting look, so keep your outline o nscreen. The next section gives you a sampling o f what
you ca n do to spice up your slides.

Adding Visual Elements to Your Presentation
PowerPoint offers many easy-to-use but powerful graphic tools that enable you to develo p
polished presentations that create visual impact. You can add, manipulate, and create visual
elements in the Slide view. PowerPo int lets you set up your slides with an assortment of
templates. You can then work o n individual slides by using the Auto Layout featu re. Powe rPo inl
incl udes drawing and text tools, full graphing and charting functions, and a vast Cli p Art
Gallery (see Chapter 24 fo r m o re information).
PowerPoint's graphic features ca n be summ arized as fo llows:

+

Templates: Templates help you crea te an overall look for your presentatio n.
Because templates exist fo r the purpose of cohesiveness, you can use only o ne
template per presentatio n.

+

AutoLayouts: AutoLayouts arrange elements o n your slide fo r a profess iona l,
balanced look in a pred esigned for mat.
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+

Clip Art Gallery: PowerPoin t incl udes an exte nsive Cli p Art Gallery that is conveniently o rga nized by category.

+

Graphs: PowerPoin t has a full y functio nal graphi ng program that enables you to
enter d ata and choose graph types.

+

Ch a rts: PowerPoin l also has a charting fu nction that makes creating o rganizational
charts easy. The chart helps you assign hierarchical levels and add o r delete boxes,
while auto mati call y moving the o ther boxes ove r p roportionally to accommodate
yo ur cha nges.

Picking a Look for Your Slides
Now you're ready to add a template, Autolayouts, and visua l elements to your presentatio n . In
your outlin e, switch fro m t he Outli ne view to th e Slide view by clicki ng the Slide View butto n.
To pick a look fo r your presentati on, do the following:
1. To select a tem plate fo r your slides, first choose th e Presenta tion Tem plate command from the f ormat menu or click the Tem plate sho rtcut button. A finder dialog
box ap pea rs. Three template categories are located in the Po werPo int template
fold er. The three template folders con tain temp lates fo r the following media: blackand-whi te transpa ren t overheads, color transparent overh eads, and 3S mm slides.
2. Open t he 3S mm slide folder by do uble-clicki ng it and scro ll down the Hie Nam e box
to highlight the SPARKLES .PPT template. You can see a preview of how the template
looks in a box on the left side o f the d ialog box. Click the Apply button. Your slides
now have a blue backgrou nd look with a starburst to the left of the ti tle of each slide.
3. Go to slide 3 so that you ca n ad d an illustration to it. Click t he Layout sho rtcut
button o r choose t he Slide Layout command fro m the Fo rmat menu. The Slide
Layout di alog box ap pea rs with nine sample sl ide layouts with placeho lders fo r
arranging text, clip art, graphs, and charts. Notice th at the placeho lders co ntain
larger versio ns o f th e toolbar buttons for adding clip art, graphs, and charts.
4. Selec t th e layo ut in the lower-l eft corner (the layo ut w ith the picture of a face o n
it). Then click Appl y o r do uble-click th e sample layo ut. Yo ur slide now con fo rms to
the layou t and has a place ho lder fo r clip art (see Figu re 21.9).
5. To access the Cli p Art Ga llery, double-click the cl ip art placeholder on slide 3. The
Cli p Art Ga llery d ialog box now appears.
6. First choose the Academic category fro m the list o f choices at the top o f the d ialog
box and th en click the mug with the penci ls tha t is previewed in o ne of the boxes
below th e categories. The categories make it easy for you to find approp ri ate clip
art, and t he clip art p reviews enable you to select the clip art while viewing it.
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Figure 21..9 A clip art placeholder.

7. Click OK. The selected clip art automatically appears in the placeholder on your
slide. Congratulations! You have just created a snazzy layout in no time flat.
8. To add a graph to slide 4, move to the slide by pressing the Page Down key twice
and click the Insert Graph button on the Standard toolbar. A graph placeholder
automatically appea rs on your slide. Unlike the AutoLayout placeholder, however,
the grap h placeholder is not automatically sized to fit in with the text already
placed on the slide.
9. To select your graph (or any other object), click it with the pointer fro m the
floating tool palette to the left of your screen. You will notice that when a
PowerPoint object is selected, a box appears around it. Now you can do the following to resize or move your graph:

+

To resize your graph proportionally, hold down the Option key, click any
corner of the selection box, and drag it diagonally inward to reduce it or
diagonally outward to enlarge it. In this case, you want to move the graph
away from the text and toward the right.

+

To move your graph, click anywhere in the middle of the object, hold down
your mouse key, and drag the graph to where you want to place it.

10. To save your presentation, select Save from the File menu or use the ~-S key
combination. Type the filename DEMOl in the d ialog box, save it as a PowerPoint
presentation, and then select OK.
See how easy creating a presentation can be? Power Point helps you learn wh ile you create
your presentations so that you can get up and running fast while you increase your level of
PowerPoint presentation expertise.
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Viewing Your Slide Show
You can view PowerPoint presentations right on the computer screen by using the Slide Show
view. The Slide Show feature turns your computer workstation into a presentation display
device. You can also rehearse and preview your presentations.
To view your slide show, do the following:
1. Press the Page Up key to return to slide 1 in your sample presentation. Your

presentation begins running from wha tever slide you have selected.
2. Select the Slide Show view by clicking the Slide Show View button at the lower-left
corner of your screen or by choosing the Slide Show command from the View
menu. Your title slide now fi lls the en tire screen.
3. To advance to the next slide, click your pointer anywhere onscreen.
4. When your presentation is finished, PowerPo int returns you to the view you were
previously working on.
Now you have an idea of what a PowerPoint presentation looks like when being shown. Displaying slide shows on your computer screen is the best way to use PowerPoint's full range of options.
To see all your slides at once, which gives you an immediate overview' of your entire presentation, click the Slide Sorter View button. Your slides appear o nscreen in the order you created
them. Hopefully, your slides look like the ones in Figure 21.10.

Figure 21.10 A presentation in the Slide Sorter view.
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This chapter is designed to give you an overview of the PowerPoint process. After reading t his
chapter, you should have an idea of what to look for and how Power Point's features can help
you create presentations of your own. Chapter 22 goes into more d etail about setting up you r
presentations.
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In this chapter, you get to know the basics of PowerPoint 4 by navigating the screen and
getting an overview of the menus and too lbars. Because Power Point is a Microsoft application,
the main screen, menus, and buttons should look familiar to you. You should still take the
time to glance over this section, however, because PowerPoint 4 has many unique, exciting
featu res that you may not recogni ze or know how to access. This chapter tells you about the
following:
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Choosing a Presentation Option
You can access the New Presentation dialog box by creating a n ew presentation from within
PowerPoint or by launching the application, in which case the dialog box automatically
appears.
To create a new presentation, activate the New command from the File menu or click the first
button on the Standard toolbar (the one that looks like a dog-eared page). This action brings
up the New Presentation dialog box, which contains the following options for creating your
presentation (see Figure 22.1}:
New Presentotlan
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Figure 22.1 The New Presentation dialog box.

+

AutoContent Wizar d: AutoContent Wizard prompts you for info rmation about
your presentation. rt enables you to ch oose from an assortment of commonly used
outline topics and then places you in the Outline view so that you can fill in the
precreated outline with your ovm information. You can follow the instructions in
the AutoContent windows, which automatically appear, to finish your presentation (see Figure 22.2}. The AutoContent Wizard feature is extremely useful in
helping the novice get started.

+

Pick a Look Wiz ard: The Pick a Look Wiza rd offers you a choice in for mat selection, type of output, printing options and more. Like the AutoContent Wizard, the
Pick a Look Wizard places windows onscreen to help you (see Figure 22.3). The Pick
a Look Wizard is n ot as helpful as the AutoContent Wizard in getting you started
on your presentation, however, because most professionals begin the presentation
process by composing an outline.

+

Templates: This option enables you to create a con sistent look fo r your presentation by offering you over I SO templates to choose from. A template gives you a
background design , color scheme, and basic layout to make creating presentations
easier for beginners.
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A Pick a Look Wizard window.

+

Blank Presentation: As you gain mo re ex perience with PowerPoint, you may
wish to ex periment with a blank slate. The Blank Presentation option lets you
develop your presentatio n slide by slide. After you choose the Blank Presentatio n
option, a New Slide dialog box appears, where you can choose from nine different
Autolayouts. The AutoLayout feature helps you make design decisions by offering
slide layouts that effectively integrate graphics and text.

+

Current Presentation Format: This PowerPoint optio n becomes useful when you
want to create a group of presentations that are similar. By selecting the Current
Presentation Format from the New Presentatio n dialog box, you can duplicate a
recentl y designed presentation layout.

PowerPoint offers many options for creating new presentations. As you become more proficient, you will discover whi ch m ethod works best for you.
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Working with Existing Documents
PowerPoint lets you open, close, and save documents the sam e way you do with o ther
Microsoft Office applications. Unifo rm commands help you work faster because you don't
have to relearn commands for different applications. PowerPoint enables you to copy formats
from previously created slide shows, which gives you an integrated set of presentations, and
ena bles you to save presentations under different names. This fea ture permits you to change
an existing presentation without elim inating the o riginal. The following list explains the
options for working with existing presentations:

+

Opening a presentation: To open an existing presentation, select one of the
following options: choose the Open command from the File menu; click the
second button-the o ne that looks li ke an open folder-on the Standard toolbar;
use the ):(-0 key combination. In the Open dialog box, double-click the filename of
the presentation that you want to open. You now have th e presentation onscreen.
To narrow down your search for presentations, you can keep non-PowerPoint
documents from appearing in the window. At the bottom of the Open dialog box,
select Presentations from the List Files of Type pop-up menu.

+

Closing a presen tation: To close a PowerPoint presentation without exiting the
application, select the Close command from the File menu or use the ':J:f.-W key
combinatio n. To close your presentation and simultaneously exit th e application,
choose the Quit com mand fro m the File menu or use the ':J:f.-Q key combination.
PowerPoint automatically asks whether you want to save the changes that you
have made to your presentation.

+

Saving a file: To save a sli de show that you' re working on, select the Save command from the File menu or click the third button from the left (the one that looks
like a computer disk) on the Standard too lbar. Or you can use the :l:C-S key combination. Any changes you made are then saved to disk.
To save a separate copy of your document under a diffe rent name, select the Save
As command from th e File menu. When the Save As dialog box appears, enter the
new document name.

Formatting and Outputting Your PowerPoint
Presentation
PowerPoint offers many options for printing and presenting your slide show. With
PowerPoint, you have the flexibili ty to output your presentation in vi rtually any forma t,
includi ng 35mm slides, video, transparent overheads, and onscreen demonstrations.
PowerPoint also has automatic settings for printing o ut transparent overheads, slides, audience
handouts, and speaker's no tes (see Chapte r 26 for more information).
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Setting up your slides
To set up you r slides, use PowerPoint's templates, which are already correc tly proportioned fo r
th e type of slides you want, or choose Slide Setup from the File menu (see Figure 22.4). The
Slide Setup dia log box appears and offers options for setting o r changing the parameters of
your slides, including onscreen shows, 35mm slides, letter paper, o r A4 paper (used for transparent overheads). You can also customi ze the size o f you r slides by using the Width, Height,
and Orientation optio ns.

Slide Setup
Slides Slzetl ror:

I

OrloaloHon.,..-,=====

On-se,..n Sllov

CE':J
( Cancel )

Width:

IU•WIJJtoochos
ltelohl:

17.5

iiJJ toches

Number Slides F ro•:

"
Figure 22.4

llil

The Slide Setup dialog box.

In addition to the default On-screen Show setting, PowerPoint enables you to choose the
35mm Slides setting-which has an aspect ratio of 3:2. You can also design you r slides to be
used as transpa rent overheads by choosing the A4 Paper setting. Transparent overheads have
an aspect ratio of 5:4 or 4:5, depending on whether the prese ntation is horizontall y or vertically oriented. Not ice the subtle size difference in the two slides, as shown in Figure 22.5.
The term aspect ratio refers to the height and width pro portio ns req ui red for displaying a
presentation in a given medium. After setting up your slides, make sure that your frames are
proportioned correctly for your o u tpu t device. (For mo re information on aspect ratios, see
Chapter 26.)

Setting up your pages
Just as the Slide Setup command enables you to set parameters for how th e presentation is
d isplayed, the Page Setup command enables you to decide how you want your presentation to
appea r after it is printed out. To format printed pages, select th e Page Setup command from
the File menu.
A d ialog box appears (see Figu re 22.6) and prompts you to select th e paper size, num ber of
frames per page (up to four), percentage of reduction or enlargement, and orientation. You can
also choose va ri o us visual effects and printer opti ons by clicking the Options button.
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The 35mm slide template compared to the t ransparent overhead template.
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The Page Setup dialog box.

Printing with PowerPoint
PowerPoint makes it easy for you to print transparent overheads and other materials directly
from your printer. To print, select the Print command fro m the File m enu, click the button
that looks li ke a printer o n the Standard toolbar, or use the ~ - P key combination.
When the Print dialog box appears onscreen (see Figure 22.7), you can choose from several
options to prin t in the Print What menu box. The options include slides, notes pages, handouts, and outlines. (For more information o n printing, see Chapter 26.)
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The following list describes PowerPoint's printing options:

+

Slides: This option lets you print out your presentation at one frame per page. You
can also print transparent overheads directly fro m your printer, but make sure that
the transparencies you use a re compatible with your printer. Otherwise, they m ay
get overheated or smudged.

+

Notes pages: This option gives you a print of your slide on the top half of the page
accompanied by your speaker's notes o n the bottom half of the page. This option
makes it easier for you to kee p your presentation organized.

+

Handouts: You can enha nce your presentation by giving handouts to your audience. Handouts enable audience members to take notes so that it is easier for the
people to reta in the information that you are discussing. Handouts can be printed
at two, three, o r six slides to a page.

+

Outlines: By choosing the O utline option, you can print a text-only version of
your presentation in outline form. This option helps you make presentation
changes and corrections before you actually make the presentation.

PowerPoint's many printing options give you more flexibi li ty in planning your presentations.
The ability to easily create an integrated set of materials to support your presentation also gives
you an additional edge.
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Navigating Your Screen
PowerPoint ma kes it easy for yo u to find your way aro und the screen . For the most part, the
menus, toolbars, scroll bars, and general work area look similar to other standard applications
you have already worked with (see Figure 22.11). In this section, you learn how to navigate
your screen easily.
When you create a new document in Power Point with any option but the AutoContent
Wizard, the screen defaults to the Slide view when you are ready to start entering in fo rmation
in your slides. (If you start your new document with the AutoContent Wizard, your screen
defaults to the Outline view instead.) The Slide view contains the main working area for
composing each frame of your presentation .

Arrow box.

Vertical scroll
bar with
navigational
buttons.

Ho rizontal scroll bar with
navigational buttons.

Figure 22.8

A blanl< PowerPoint screen.
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+

Zoom: You can view slides at different percentages of their o riginal size by activating the Zoom Control. The Zoom Control on the Standard toolbar displays a
percentage number and has a down-arrow button on its right. Clicking the arrow
accesses a drop-down menu with percentages ranging from 25 to 400 percent. To
zoom in o n a specific object, select the object before activating the Zoom feature.

+

Scrolling down and across: Scroll bars enable you to move you r view up, down,
or across the screen . The vertical scroll bar is on your far ri ght, and the horizontal
scroll bar is at the bottom of the screen, just above th e status bar and sho rtcut
buttons.

+

Arrow boxes: Use th e arrow boxes to scroll incrementally. The arrow boxes are
located at the extreme ends of your scroll bars. Find the arrow poi nting in the
directio n you want to move and either click it or hold it down with your mouse.

+

Scroll bars: To move around in your document more quickly, use the horizontal
and vertical scroll bars. Each scroll bar has a naviga tio nal button whose position
indicates your position in relation to the entire document. You can click the
navigational button and drag it in the direction you want to view, or you can click
any place o n the scroll bars to move incrementally.

+

Next/Previous buttons: These buttons aie located at the bottom of the vertical
scroll bar. They look like the keys you would find on your VCR and are activated
when you click them. The button with two triangles pointing up brings you to the
preceding slide. The button with two triangles pointing down brings you to the
next slide.

+

Resize box: To adj ust the size of your PowerPoint work area, click and drag o n the
resize box. Adj usting the size of the screen can be useful when you are working in
multi ple applications and you want to keep your presen tation open or if you need
to view two presentatio ns simultaneously. The resize box is located at th e lower
righ t of your docume nt window, where the vertica l and horizontal scroll bars
intersect.

+

Grow box: To restore your work area's window to its preceding size, click the grow
box, located at the top of your vertical scroll bar. It looks like a small square inside
a large square.

+

Close box: To close the presentation you are working o n, click the close box. It is
located o n the left side of your title bar and looks like a little square.

Viewer control is highly important when you are working with a graphically oriented program, such as PowerPoint. By using PowerPoint's navigational tools, you can view your
presentation fro m all necessary angles. Fo r example, you can go to the preceding slide by
pressing the Page Up key; you ca n go to th e next slide by pressing the Page Down key.
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Deciphering the status areas
Status areas are onscreen areas that provide information about where you are in your presentation. Unlike menus, which provide dialog boxes for you to choose optio ns, you cannot
interact with status areas. PowerPoint has two status areas: title bar and status bar.
PowerPoint's title bar is located just above the working area of your slide. The title bar tells you
the name of the document you are working on or informs you if it is untitled. When you
double-click the title bar, the screen behaves as if you clicked the grow box. In oth er words, if
the screen has ever been another size, double-clicking the title bar returns the screen to that
preceding size.
Your status bar is located on th e lower-left corner of the screen. If you look closely, you will
notice that messages appear while you're working. These m essages tell you what you are doing
and ad vise you what to do next.
Use your status areas to get information about your document and to learn more about
PowerPoint.

Using rulers , guides, and the grid
Rulers, guides, and grids help you maintain uniformity throughout the presentations that you
create. PowerPoint's ruler enables you to measure objects and distances, and the guides and
grid help you align objects o n your slides.

+

Rulers: To measure an object, select the Ruler command on the View menu. Rulers
appear at the top and left sides of the screen, as they do in Figure 22.9.

+

Guides: PowerPoin t provides you with guides-on e vertical and one horizon talthat function as straight edges against which you can align objects. Objects moved
near a guide automatically snap to the guide. To turn your guides on and off, use
the Guides command in the View menu as a toggle switch. To move a guide, select
it with your pointer and drag it.

+

Grid: When you try to move an object and notice that it doesn't quite go where
you want it to, you have experienced PowerPolnt's grid. The grid ~onsists of evenly
spaced, invisible lines that crisscross the slide. Unless you turn off the Snap to Grid
command in the Draw menu, objects align themselves to the Jines on th e grid . You
temporarily can override PowerPoint's Snap to Grid defau lt by holding down the
:1:1: key while dragging the ob ject that you are moving or sizing.
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Lorem Ipsum
• Delor sit amet consectetuer adipiscing elit
sed diam
- Nonu!Tll"t¥ nibh eui!rnOd
, Tincidunt ut
» Laoreal do lorn

- Magna aliquam

• Exerci tation ullamcorper suscipit lobortis
nisi ut aliquip ex ea com

Figure 22.9

A PowerPoint slide with rulers.

Activating PowerPoint's Commands
PowerPo int o ffe rs you t he cho ice o f activa ting its feat ures by using the menu bar, by using key
combinatio ns, o r by clicking the butto ns distributed along the va rious too lbars. The ma in
menu and the Standa rd and Fo rmatting toolbars are located at t he to p of the screen, where
you ca n fin d th em easil y. PowerPoint also d isplays the Drawing too lbar, located o n the left
side of your working area; an d sho rtcu t buttons, located at t he bottom of your screen.

Using the menu bar
The menu ba r at the very top of your screen has all of PowerPoin t's functions o rganized in to
categories. Each menu item contains a d rop-down menu. Some items in the d rop-down menu
indicate a single command. Others require further in pu t entries w ith a d ialog box to complete
a process; these commands are marked with an ellipses( ... ).
Altho ugh th e menu bar ma kes it simpler for the beginner to fin d and activate commands,
pulling d own all these menus is ti me-co nsuming. You can activa te PowerPo int's com mands
mo re easily by getting to kn ow your toolbar b utton s and your key combinations.
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PowerPoint makes it easy for you to learn you r toolbar and key combinations. After you pass
your cursor over the toolbar buttons, ToolTips pop up and tell you what the name of the tool
is. After you pull down your men us, key combinations appear to the right of the commands.

Using the Standard and Formatting toolbars
The people who designed PowerPoint know that you use some commands more frequently. To
save you the inconvenience of droppi ng down your menus or remembering keyboard commands, they created a Standard toolbar (the one right below the menu bar). The buttons on
the toolbars represent common ly performed functions, such as printing, inserting objects and
saving. You can activate them with a simple click.
The lower row of tools at the top of the screen is the Formatting toolbar, which includes all
sorts of tools for text formatting. With this toolbar, you can indicate which font and point size
you wa nt for your text. Simply drop down the menus with the arrow buttons and scroll
through the available options.

Using other tool bars
In addition to the Standard and Formatting toolbars, PowerPoint features several other
toolbars for drawing shapes, displaying Microsoft information, providing outlining services,
and more. The Drawing too lbar is usually displayed to the left of the screen, although you can
move it to whatever location you find th e most convenient by clicking the toolbar and
dragging it with your mouse. To display the toolbars, access the Toolbars command on the
View menu and put a check mark by all the toolbars that you want displayed onscreen. Here is
a list of the other toolbars that you will use most often:

+

Drawing toolbar: When you work in Slide view, this toolbar displays graphic tools
for composing individua l elements in each slide. Options include moving and
rotating objects, selecting or add ing text, activating fills and lines, and drawing
shapes (see Figure 22.10).

+

Draw+ toolbar: The Draw+ toolbar gives you more specialized tools for modifying
your visual elements.

+

Outlining toolbar: When you work in Outline view, this toolbar takes the place of
the Drawing toolbar that is present in Slide view. The Outlining toolbar displays
text tools for editing and moving text and for ad justing priorities and headings in
your outline. This toolbar offers a fuller range of options for outlining than the
Formatting toolbar at the top of the screen (see Chapter 23 for more information).
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Selection Tool.
Text Tool.
Line Tool.
Rectangle Tool.
Ellipse Tool.
Arc Too l.
Preeform Tool.
Free Rotate Tool.
mAutoShapes.
Pill On/Off.
Line On/Off.
Shadow On/Off.

Figure 22.10

The Drawing toolbar in Slide view.

PowerPoint gives you all the tools that you need for creating professional presentations and
arranges the toolbars in a way that saves screen real estate.

Customizing your toolbars
As you get more familiar with PowerPoint, you may find that you use some tools more than
others. You can hide the tools that you don't use or add more command buttons by customizing your toolbar. Customizing can help you make the most of your screen space and
PowerPoint work area.

+

To hide tool buttons: Choose Custom ize from the Tools menu. A dialog box with
a list of command categories and a tool button storage area appears, as shown in
Figure 22. 11. To remove a button from a toolbar, first display the toolbar on screen;
then click the button that you no longer want o n the toolbar and drag it to the
gray storage area of the dialog box.
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+

To add tool buttons: The tool button storage area has buttons for additional
functions, such as the Find File button in the File category. To add a button to a
toolbar, display the toolbar onscreen, find the button that you want from the
various categories, and drag the button from the storage area to the toolbar in the
position that you wa nt it to be in.

+

Moving toolbars: PowerPoint's toolbars are actually floating palettes, which mean s
that you can move them wherever you wan t onscreen. just click your pointer on
any part of the toolbar that doesn't involve selecting a particular tool and drag the
toolbar to another location onscreen.
Customize Tool bars
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Figure 22.11 The Customize Toolbars dialog box.
If you move a toolbar from the top or side of your screen into the work area, it changes

proportionally from a long rectangle into a square. Also notice that all the buttons on your
toolbar move proportionally in response to your hiding or adding tools.
You can also drag toolbar buttons to a new position on a toolbar or to a diffe rent toolbar by
holding down the j:C key while you drag the button to a new location. To copy toolbar icons,
use the j:C-Option key combination.

Selecting Views
The View menu controls what you see onscreen . Through this menu, you can work on presentations in the Slide, Outline, Slide Sorter, Notes Pages, and Slide Show views. Views can be
accessed by selecting t hem th rough t he View menu or by clicking the View icons on the lowerleft side of the screen, just above the status bar.
PowerPoint's views are listed and briefly described as follows:
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+

Slide view: The Slide view is your main working area. This view enables you to
work with text, graphics, and special effects on individual slides. Un less you use the
AutoContent Wizard, PowerPoint defaults to this view.

+

Outline view: The Outli ne view looks like a screen for a word processing document
and helps you work with text. In Outline view, you can edit, move, and prioritize
items in your outline.

+

Slide Sorter view: The Slide Sorter view enables you to see your presentation in
storyboard form. You ca n change the order of slides by selecting a slide and
dragging it to its new place. You can also set and adjust special effects by using the
Transition command from the Tools menu. Small slide icons with little arrows
appea r below each slide that has a transition effect. If you click these icons, you
can view the transition effects in the storyboard. (For more information on
transitions, see Chapter 25.) You can search through your slide show for all slides
referring to a particular topic in the Slide Sorter view. Simply choose the Find
command from the Edit menu and write in the desired topic name.

+

Notes Pages view: Notes Pages view enables you to develop your presentation
beyond the outli ne that appea rs on the slide. Simply jo t down what you want to
say in the space below your slide. These notes do not appear on the slides during
your presentation, but you can print them out as supporting materials for your
own notes during the presentation.

+

Slide Show view: The Slide Show view enables you to rehearse and show your
presentation right on your computer screen. You can either set the slide show to
run automatically, or you can change slides manually by clicking the pointer on
any part of the screen.
In this view, you can highlight your points with PowerPoint's Electronic Chalk
feature. Simply click the pencil button in the lower-right corner of your screen (see
Figure 22. 12). The pointer turns into a pencil that draws lines onscreen to help you
emphasize points. To deactivate, click the button again. The pencil markings
disappear automaticall y when you finish your presentation. Keep one thing in
mind as you use this feature: you need a steady hand!

Ill
Figure 22.12

The Electronic Chalk button.

PowerPoint views enable you to work on your slide show in all phases of the presentation
process. This ensures continuity as you move fluidly from stage to stage in the creation of your
presentation.
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Getting Help
You can get up and running quickly because PowerPoint's user-friendly interface makes it easy
to learn as you go along. The highly sophisticated Help system offers assistance at all levels
so that you can maximize your p roductivity. Alt hough there are many ways to get help in
PowerPoint, you can access the main Help features through the Help menu. The Help button
appears as a question mark on th e right side of the Standard toolbar.
PowerPoint's array of Help menu options include the following:

+

Balloon Help: This feature shows a "balloon" with explanations while your pointer
is positioned on a particular feature. PowerPoint is integrated with Balloon Help, a
standard System 7.5 feature. You can choose to show or hide balloons. After you
pass your pointer over PowerPoint's m enu and tools, balloons appear to explain
what each tool does.

+

Contents: This feature searches for help from a topics list. The Con tents command
brings up a screen that allows yo u to access Help via the following broad categories:
Using PowerPoint (step-by-step instructions), Reference Information (updates and
tips), and Technical Support (see Figure 22.13). To select a category, click the
accompanying icon on the left o r click the green text o n the right. To select topics
within the category, double-click one of the categories.

PowerPoint Help Contents
To l earn how to use Hel p, press Fl (Windows) or Help ( Macintosh).
Uei ng Fbw;rFbin t

S tep-by~ste p instructions 1o help you complete
your m:&r.s
Reference In formation
Late-b:re~

new.;, tip;. guides to terminology,

8J'ld the k.e:yboa:rd

Ted1ni oa SURP-ort

Availeble support options so that you can get the
most fro:m your Microsoft product

Figure 22.13 The Help Contents screen.
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Search: This feature allows you to search for help by topic. The ini tia l screen has a
dialog box and a list of topics (see Figure 22. 14). To access a topic, type in the word
o r select it from th e list. After you have made a topic selectio n, click the Sh ow
Topics button and select o ne of the topics shown. Click the Go To button on th e
lower-right side of the box.

Typo n word. or select from the
liSt . Th en CIIOO SO S h OW IOpiCS.

li5HU!iii!Di

tShow Topics ll
•

•

( Conccl )
'0-

occont colors
odd crt
odd background
odd bullet
od d chert
odd ell crt
Sel ect n tuple. Ill en choose Go To.

Figure 22.14

The Search Help screen.

+

Index: This feature searches for help by an index (see Figure 22.15). Index d isplays
a keyboa rd so that you can search for your topic by clicking, or tabbing to, the first
letter of the topic. Topics appea r in alphabetic o rder with subheadings grou ped
beneath them. To access your topic or subh eading, just click it.

+

Quick Preview: This featu re gives you an overview of PowerPoint's capabilities and
features. Quick Preview is a self-ru nning, sam ple presentatio n that runs thro ugh
automa ticall y after you first install PowerPoint. This preview is quite helpful for
your initial in troduction to PowerPoint and can be accessed later for reviewing
from the Help menu.

+

T ip of the Day: This feature appears on your startup screen with handy hints for
maximizing PowerPoi nt's potential. To view the Tip of the Day fro m within th e
applicatio n, select it from the Help men u. Yo u ca n disa ble th e Tip of the Day
feature so that it does not appea r every time you open PowerPo int by turning off
the check box in the Tip of the Day d ialog box. You can also view Tip of the Day
topics by clicking the More Tips button.
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Figure 22.15 The Index Help screen.

+

Cue Cards: Cue Cards functio n as step-by-step guides that assist you in putting
together your presen tatio n. Activate them through the Help m en u or by workin g
with wizards. The Cue Cards stay onscreen w hile you work, ask what you want to
do next, and offe r a checklist of topics to choose from. Simply follow the Cue
Cards' instructions as you learn PowerPoint. To end your Cue Card session, click
the li ttle box o n th e u pper-left corner of the Cue Card window.

+

Technical Support: This feature provides contact informatio n fo r the following
areas of tech nical su pport: electronic services, sta ndard su pport, priority support,
text telephone, and train ing and consultation . Standard PowerPoint support for
Mac users is available at no charge Monday through Friday, betvveen 6:00 A.M. and
6:00 P.M. Pacific time, by calling (206) 635-7145 . In case of emergencies, you can
call priority suppo rt 24 hours a day, 7 days a week, at (900) 555-2000 fo r $2.00 per
minute (U.S.). O r you can call (800) 936-5700 and bill the call to your VISA,
MasterCard, o r American Express card.

PowerPoin t's built-in Help fea tures make it easier for yo u to find o ut how to perform difficult
tasks witho ut having to leave you r desk.
PowerPo int also supports you with helpful add-ons that guide you wh ile you use the program .
These are not specifically listed in the Help men u. Additional Help fea tures include the
following:
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+

TooiTips: This feature identifies each toolbar button with small balloons as you
pass the pointer ove r the button. You can disable this feature in the Toolbars
dialog box from the View menu. Don 't confuse TooiTips with System 7.5 Balloon
Help, which offers larger balloons with more detailed information.

+

Help button: Use the Help button on the Standard toolbar (the one with a question mark) when you have a question about a specific task or tool function. Simply
click the button once and then select the object that you have a question about. A
full discussion of the obj ect-in-question appears onscreen.

+

Status bar: This feature briefly tells you how to use a tool after you select it. The
status bar is located at the bottom of the screen with the status text on the left side
of the bar.

These additional Help features increase your productivity by teaching you about PowerPoint
while you are working.
It's easier to learn something new when you know what to look for and how to get help. After
reading this chapter, you should be able to find your way around PowerPoint without too
much difficul ty. The next chapter tells you how to work with text and the Outline feature .
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Setting Up an
Outline
PowerPoint is designed to help you integrate text and graphics with appealing layouts to
present your message effectively. Many people regard text and visual elements to be entirely
separate entities: words provide info rm ~t ion; whereas, illustration s are meant to be looked at.
This dichotomy does not exist in the world of presentations, where both elements must
convey information and create visual im pact simultaneously.
Despite PowerPoint's strong editing features, it is primarily a graphics program designed to
structure text in outline form. This should be kept in mind when working with text. This
chapter covers the following topics:
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Working in Outli ne View
PowerPoint's Outline view helps you write your script. A slide icon appears to the left of each
title to indicate a new frame in your presentation. The titles appear in bold print, and the
other paragraphs appear in outline form beneath. When you' re working on a lengthy presentation, the Outline view gives you an overview of the entire presentation and lets you quickly
rearrange the order of text and slides. The Outline format makes it easier to focus on the main
points in your presentation.
The Outline view displays o n ly text entered as part of your outline. Graphic elements and text
entered directly on slides do no t appear after you switch to the Outli ne view, although they
still exist in your presentatio n. (Fo r more information on graphic elements, see Chapter 24.)

The Outlining toolbar
The Outline view comes with its own Outlining toolbar, located on the left side of your screen
(see Figure 23.1). These tools are provided to help you assign levels to paragraphs, move slides
and paragraphs back and forth, and keep your script organized.
Promote (Indent less).
Demote (Indent more).
Move Up.
Move Down.
Collapse Selection.
Expand Selection.

Show All.
Show f-ormatting.

Figure 23.1

The

Outlining toolbar.

The function of the Outli ning tools is listed as follows:

+

Promote/Demote: These top two buttons promote and demote outline levels. To
demote text (indent t he text more), select the text and then click on the second
button or press the Tab key. To promote text (indent the text less), select th e text
and then click on the first button or press Shift-Tab.
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+

Move text blocks: The up- and down arrows enable you to move blocks of text
forward and backwa rd within your presentation. Select the text and then click the
tool that indicates the direction you want the text to move. The up arrow moves
text backward and the down arrow moves text forward.

+

Collapse selected slides: Select the slide(s) that you want collapsed by placing the
cursor anywhere in the slide's text. Click the Collapse Selection button, the one
that looks like a minus sign. Collapsing a slide means to display only the main
point of the slide, usually the title.

+

Expand selected slides: Select the slide(s) that you want expanded and then click
the Expand Selection button, the one that looks li ke a plus sign. Expanding a slide
redisplays all the levels on the slide.

+

Collapse entire outline: To display only the titles of the en tire outline, click the
Show Titles button . A screen of collapsed slides looks like the one shown in Figure
23.2. This feature comes in handy when your outline is too long to view onscreen
all at once. When you are ready, you can expand the outline again.

Figure 23.2 Collapsed slides.

+

Expand en tire outline: To display titles and all body text for all the slides in your
outline, click the Show All button. An expanded slide looks like the one shown in
Figure 23 .3.
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Figure 23.3
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An expanded slide.

Show/Hide Formatting: The last button, with the A's on it, enables you to decide
whether you want to see the text for matting or not. Viewing the text fo rmatting
lets you see which lines appear at a larger or smaller point size and what fonts and
styles you have used.

PowerPoint's Outlining toolbar helps make formatting text fo r slides easy.

Launching Presentations with
AutoContent Wizard
PowerPoint's AutoContent Wi zard helps you with the hardest part of developing a
presentation-gettin g started with an outline. The AutoCon ten t Wizard takes you
through a series of steps that prompt you on how to set up you r outline. When you are
finished, AutoContent Wi za rd leaves you in the Outline view with a PowerPoint Cue Card
that prompts you o n what to do next.
To activate AutoContent Wizard, select it through the New Presentation dialog box (see
Chapter 22). To demonstrate th e usefulness of AutoContent Wiza rd, try your hand at a sample
presentation. If you follow alo ng, you ca n get the feel fo r the ease of using the AutoContent
Wizard to create o utlines.
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The scenario: launching a coffee cafe
You and your partners have run restaurants and clubs successfu lly in your city for the past 20
years. You have noticed a recent trend towards coffee cafes, and you know of people who have
launched ancl run them with success in other cities. You and your partners decide to start up
Cafe Ole. You have everything you need: a strong management team, steady patrons at your
other establishments, and a good relationship in the community where you want to open your
new cafe.

Selling your idea
Now you need to persuade someone to provide venture capital. CoffeeCo, a mul timillion
dollar international conglomerate, seems like a good target. After all, it is a related business,
and you have been buying coffee for your restaurants through its distributor for years. Also, a
member of its board seems interested in starting up a coffee cafe as a test marketing tool to
soften CoffeeCo's corporate image.

Setting up the presentation
Now you have your first opportunity to pitch your ideas thro ugh a professional presentation.
You n eed to consider the overall purpose of your presentation (sell ing your idea), the points
you want to make (why CoffeeCo would find it adva ntageous to back you), who your audience
is, and what tone you should adopt. You also want to use PowerPoint to put your best foot
forward. The AutoContent Wiza rd assists you in the in itial phase of writing you r script.
To launch a presentation with AutoContent Wiza rd, follow these steps:
1. Create a new presentation by selecting the New command on the File menu,

clicking the New button on the Standard toolbar, or using the ;R;-N key combination. A New Presentation dialog box appears, as shown in Figure 23.4.
New Presentollon
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The New Presentation dialog box.
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2. Select AutoContent Wizard from the options offered and click the OK button. The
first of four AutoContent Wiza rd windows appears, as shown in Figure 23.5.
Rutotonten t Wlzerd - st e 1 or 4
Wot .... to PIWrl'elot Wllorla, IM
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Figure 23.5 The first AutoContent Wizard window.
3. Click the Next butto n to move on to Step 2, which produces a window like the one
in Figure 23.6.
Caution: Don't click the Finish button until you have completed all four steps.

•
'

•

AutoContent Wizard needs to finish these steps in order to help launch
your presentation .

AutoContent Wizard - Slo 2 of 4
Wo'll olort bl 111ttnw o Tlllo """·
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Figure 23.6

Step 2 of AutoContent Wizard.

4. Create your title slide by filling in the information as shown in Figure 23.7. The
text entered in the Other fnformation text box will not be part of the ou tline. This
information is visible in the Slide view, but you do not see it in Outline view.
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RutoContent Wiz a rd - Step 2 of 4
We'll alorl bt 011tlnt 1 Tille !llldo.
r,,. I• IIIIo fnrarD~atbh pu va1t .

w u t oro vo• '"'"' to 111 t oiMol?
Jove Jol tl

Ol"r torormolloo ooo'd It to to
tnch<io7
The coffee e.xpa rfenca

l!=ucotl

Figure 23.7
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Filling in the information for the title slide.

5. Click the Next button to get to the third window. Select the second option, Selling
a Product, Service or Idea, to set up a skeleton outline (see Figure 23.8). On the left
side of the dialog box, AutoContent Wizard displays a preview of your outline.
AuloContent Wiz ard - Step 3 of 4
• Objective
•

Customrr
Requlrornul5

+

FcaC~

•

Cornpeli~

StreJ11tlts

• KcyBeKefiJs

Setect tho type or pr ne•tatfan
to• •n QOIIt l t give.
Q Rocom!Dol<iinl o Sinton

<i·Sellloo 1 Prodocl, Service or Ideo
Trafalnt
G Roporll"'J Prooro»
0 Comasanlcolloo 014 N"""
Gononl

• Next Stq>s

leoncoll I c Boct lllo><t

Figure 23.8
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The third AutoContent Wizard window.

6. Let the AutoConten t Wizard assemble your presentation by following the instructions in the last window (see Figure 23.9). Click the Finish button.
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Figure 23.9

The last AutoContent Wizard window.

AutoContent Wizard ends your session by assuming that you wan t to develop your outline
first, so it places you in the Outline view. A skeleton outline fo r selling a service or idea appears
on screen, along with a PowerPoint Cue Card. If the Cue Ca rd does not appear, you can access
PowerPoint Cue Cards through t he Help menu.
The Cue Card asks you what you want to do next and simplifies your search for help by listing
a range of options, as shown in Figure 23.10. After you click one of the buttons to tell Cue
Cards what you want to learn, the Cue Card pops a dialog box onscreen with instructions.
Iii[ ] PowerPolnt Cue Car d s [

-Menu

lf" SBII ell

6 DDIC

Tlpo f or Vor kllot Ia Powori'olat
YOU" prtstnt.tlorn ts rtl1'tl W\ CNtlftt vtN.
You oan c.cn~ to edit in thf:l v5tY <If' 00 to
Sltd"t vWw to41dd othtr objtcts Juoh u t.tbltt,
wac>M. oltp r t .tndpiott.rts

StltOt tht ttKt vou w~nt to rtpiKt.

r

.....,_

1 Stltct ... ''"' vau ....t •• rtpl....
2 Tvpt ~~~ c.vn t rxt.

To ;o to 91fdt vttv:

f

Dotm,_.;lfok on tht leon nt>rl to lilt sl!dt
hUt vou want to wori:" h .

:t

i

• ""'•t

do vou w"'t to do?
0vor~<tn011tllntvl<w

I}) Vorl< In Slldnlt..0

a.- ll)OifJtr look r... tilt pmtn..llon

0

0o to tht M•VI CU. CirdJ Mti\U

181 Silo-.. ..,._,. ..-ith o\lltoContont vi<..-d.
Figure 23 .10

A Cue Card.
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Filling in your outline
The AutoContent Wizard has provided you with everything you need to write your outline. By
loosely following the skeleton outline, you can develop your own outline fairl y qu ickly. Type
the following information into the designated onscreen categories:
Objective:

Launch A Coffee Cafe
Raise capital
Set up downtown
Start hiring
Start advertising
Create an atmosphere

*
*
*
*
*

Customer Requirements:

The Time is Right
Coffee craze taking off
Coffee consumption up SO% since 1985
Alcohol. consumption down 30%
Soundbites Corp.'s profits doubled
last year
Liberty Cafe's profits tripled over
the past five years

Meeting the Needs:

Enjoy the Experience
Cozy, cafe setting
Coffee, drinks & snacks
* Take a break
* Relax with friends
Evening entertainment

*
*
*

*
*
*

Cost Analysis:

The Bottom Line
Will pay within year
Distribute your products
Test market your products

*
*

*
Our Strengths:

Cafe Ole's Strengths
A strong management team
12 years restaurant experience
Access to employee market
Proven successes
Club Grunge, 1990-present
The Macrobiotic Cafe, 1973- 1980
Yup's Bar & Grill, 1981-1989
We work hard for.you!

*
*

*
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See a Little Go a Lo n g Way!
Re turn on investme nt
Soften your corporate image
Capture youth m a rke t
Fo rge ties with the community

*

*
*
*

Next Steps:

join Ou r Tea m
Wo rk with us!
An initial investme nt of $400,000 from
CoffeeCo
Adve rtising & promotional expenses

*
*
*

Now save your outline as DEM02. You wi ll return to it, learn how to create a differen t loo k,
a nd add gra phics in Chapter 24.
Crea ting a n o utlin e is a n importan t first step in the presenta tion process. You n ow kno w h ow
to use the AutoContent Wi zard to launch your prese ntatio n and h ow to use text-ou tlining
tools to give your presentatio n a we ll-o rga n ized fo undatio n.

Working with Text in the Slide View
Po werPoint o ffe rs many of t he sa m e tex t editi ng a nd fo rma tting fea tures t hat you find in
Microsoft Word and other word processing progra ms. In the Slide v iew, you ca n ad just fonts
and point sizes, cut and paste, c hange styles and colo rs, add bulle ts, ch oose bullet styles, and
even use the Spelli ng Ch ecke r o n you r text. The Drawing toolbar appears to t he left of t he
screen to o ffer tex t form atting op ti o ns.

Typing text on slides
With Powe rPoint, you can add t ext to slides e ither as part of your o utline o r as sepa ra te text
blocks. Text added as separa te text b locks, suc h as ca ption s fo r graphs or illustrations, shows
up on the slides but does not appea r in the Outlin e v iew.

+

To enter text on slides: To enter text whi le you a re wo rking in Slide view, cl ick the
Text too l (the on e w ith th e letter A) o n the Draw ing toolbar to t he left o f your
screen. Yo ur pointer c hanges into a curso r. In sert the curso r in one of th e text
placeho lde rs and begin typing.

+

To create a tex t box: To c reate your own text box, h old down the mouse key a nd
drag the cursor across th e screen d iagon all y u n til the box is the desired size.

+

Typing text within sh a p es: You can fit text in to PowerPoint's AutoSh apes. To do
this, draw a shape, select the Text tool, a nd sta rt typing . Yo ur text is now autom atically centered with in the object, as sho wn in Figure 23 .11. (Fo r more information
on drawing AutoSh apes, see Chapter 24 .)
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Figure 23.1l. Text in an AutoShape.

•

Setting the tex t anchor point: Th e text's anchor point determines how text fits
into a shape and what the direction is for text growth. To set the anchor point,
select the Text Anchor command from the Format menu. A dialog box appears.
Make sure that the Ad just Object Size to Pit Text check box is turned off. This
prevents text from running off the edges.

•

Adding captions: Select the Text tool, click the area where you want to type the
caption, and begin typing. Notice that as you continue typing, the text box
automatically expands horizontally.

•

Wrapping text: If you want your text to wrap automatically within a particular
width, size your text box before typing. To size a text box that constrains text to a
particular width, select the Text tool, click at the point where you want your text
to begin, and then drag your cursor diagona lly to where you want the text box to
end. This technique is useful for creating captions and for other situations where
text is centered beneath ob jects. Figure 23.1 2 shows a text box ready for a caption.

Figure 23.12

•

A text box sized for entering text.

Adding borders to text: PowerPoint automatically formats text into a text box.
You can add a border by clicking the Line On/Off button (the one with the paint
brush).

Se lecting and ed iting text
Selecting and editing text in PowerPoint is done the same way as you would with any Mac- or
Windows-based word processing program. To select and edit text, you highlight the block of
text that you want to change and then type the new text.
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The basic editing commands are listed as follows:

+

To select all elements onscreen: Choose the Select All command from the Edit
menu or use the key combination ):(-A.
You can select a word by double-clicking it. You can select a senten ce by holding
down the Option key and clicking the sentence. You can select an entire paragraph
by triple-clicking any word in the paragraph.
PowerPoint defaults to select an entire word as you drag across it. To select text one
letter at a time, choose Options from the Tools menu. Clear the Automatic Word
Selection ch eck box.

+

To cut text: Ch oose the Cut command from the Edit menu, click the Cut button
(the one that looks like a scissors) on the Standard toolbar, or use the key combination :l={:-X.

+

To copy text: Choose the Copy command fro m the Edit menu, click the Copy
button (the on e that looks like two pieces of paper) on the Standard toolbar, or use
the key combination ):(-C.

+

To paste text from the Clipboard: Choose the Paste command from the Edit
men u, click the Copy button (the one that looks like a clipboard) on the Standard
toolbar, or use the key combination :l=(:-V.

+

To Undo actions: Choose the Undo command from the Edit menu, click the Undo
button (the one that looks like a curved arrow pointing backward) on the Standard
toolbar, or use the key combination ):(-Z.

Using the Clipboard
As in most Macintosh applicatio ns, PowerPoint's Clipboard enables you to select and place
objects on the Clipboard through the Cut and Copy commands and then paste them into
other places in your slide show. In addition, PowerPoint shares its Clipboard with other
Microsoft Office applications.
If you have already created an outline in Microsoft Word, you can copy it, open your
PowerPoint presentation, and paste your text into the Outline view. In this way, you can
easily reformat your slides. You can also do the same with graphs from Excel. In PowerPoint,
th ese documents remain fu lly editable.

Formatting text
You can add visual excitement to your words with PowerPoint's variety of text effects. With
PowerPoint, you can change fonts, increase or decrease point size, and change the colors of
letters; you can add bold, underline, italics and shadows to text (see Figure 23.13); you can
align paragraphs to the left, center, or right; and you can use bullets.
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In the Format menu, you have access to the Align ment and Font commands. You can align
text through the Alignmen t submen u, and you can set and change type specifications th rough
the Font dialog box, as shown in Figure 23.14.

Bold Text
Italic Text
Underlined Text

Shadowed Text
Figure 23.13 Text style examples.

Figure 23.14 The Font dialog box.

Text formatting commands and tools are listed as follows:

+

To bold text : Select the Bold option in the Font dialog box from the Format menu,
click the Bold button (the one that looks like a B) on the Formatting toolbar, or use
the key combination :l:I:-B.

+

To italicize text: Select the Italic option in the Fon t dialog box from th e Format
men u, click the Ita lic button (the one that looks like an T) on the Formatting
toolbar, or use the key combination :A:-I.

+

To u nderline text: Select the Underline option in the Font the dialog box from the
Forma t menu , click the Underline button (the one that looks like an underlined U)
from the Formatti ng toolbar, or use the key combin ation :A:-U.

+

To emboss text: Select the Emboss option in the Fon t d ialog box from the Format
men u to add an elegant look to your presentation .
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+

To return to pla in text: Select the Plain Text option in the Font dialog box from
the Format menu or use the key combination ~-Sh i ft-Z.

+

To enlarge text: Select a point size in the Font dialog box from the Format menu,
click the Font Size down-arrow button on th e Formatting toolbar, or increase your
type size incrementally with the key combination ~ -Shift-Per iod.

+

To reduce text: Select a point size in the Font dialog box from the Format menu,
click the Font Size down-arrow button on the Formatting toolbar, or decrease your
type size incrementally with th e key combin ation ~-Shift- Comma.

+

To left-align text: Select the Left option in the Alignment submenu from the
Format menu, click the Left Alignment button on the Forma tting toolbar, or use
the key combination ~-L.

+

To right-align text: Select the Right option in the Alignmen t submenu from the
Format menu or use the key combination ~ - R.

+

To center text: Select the Center option in the Align ment submenu from the
Format menu, click the Center Alignment button on the Formatting toolbar, or
use the key combination ~-E.

By using your text formatting options, you can draw attention to specific points or crea te a
whole new look for your slide show.

Using bullets
Notice that PowerPoint automatically delineates each text grouping or paragraph with bullets.
Professional presenters generally use bulleted lists because they add visual impact, draw
attention to each point, and add subtle accents to your presentations.
You ca n rearrange bullets on your slides by clicking the bullet and dragging it where you want
the bullet to appear.
You can change the way your bullets look or remove them entirely. If you don't want bullets
before every paragraph, simply click the Bullet On/Off button (the one th at has three dots and
three lines) on the Formatting toolbar. To replace the bullets, click this button again- it
functions as a toggle switch.
If you wan t to customize your bullets, choose Bullet from the Format menu. The Bullet dialog

box offers a fu ll palette of different looks, as shown in Figure 23.15.
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The Bullet dialog box.

Effec tive presentations begin with good outlines. PowerPoint offers an array of tools and
features fo r creating outli nes and wo rking with text. The next chapter sho ws you how to
enhance your presentation s by add ing graphic elements.
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PowerPoint provides a variety of powerful graphic tools right at you r fingertips. This versatile
program also has an extensive Clip Art Gallery, fully functional graphi ng and charting abilities, a palette of drawing tools, adjustable color schemes, and support for inserting visual
elements created in other applications. In this chapter, you wi ll learn the basics of creating
your own original look for your presentations. The topics covered in this chapter include
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Designing a Presentation with
Pick a Look Wizard
By using PowerPoin t's ready-made graphic elem ents, the novice can produce slides with a
polished look; a more experienced presenter has the flexibility to experiment with customized
slide designs.
PowerPoint's Pick a Look Wizard works the same way as the AutoContent Wizard. You can
activate Pick a Look Wizard by choosing it in the New Presentation dialog box, by clicking the
Pick a Look Wiza rd button (the one that looks like a magic wand) on the Standard toolbar, o r
by selecting it from the Format men u. Pick a Look Wizard takes you through a set of prompts
for setting up the appea rance of your slides and for printing supporting materials, such as
handouts, outli nes, and speaker's notes.
Alas, this option is not as useful as the AutoContent Wizard, although Pick a Look Wizard
does narrow down your choice of templates, thereby making the selection process less
overwhelming.
Now it's t ime to expand the presentation that you began in Chapter 23. You have decided that
you wan t to present a slick, professional look to your potential backers at CoffeeCo, so you
decide to see what Pick a Look Wizard can do. Pick a Look Wizard can be activated at any time
while developing your presentat ion.
To use Pick a Look Wizard, follow these steps:
1. Open DEM02 and go into the Slide view. Notice that the slides are blank except for
your outline.

2. Activate the Pick a Look Wizard by clicking the Pick a Look Wizard button or by
going through the Format menu. The first Pick a Look Wizard window appears, as
shown in Figure 24. 1.
3. Click the Next button. The second window appears (see Figure 24.2). The Pick a
Look Wizard prompts you to make your first selection . Select 35mm Slides as your
presentation form at choice.
4. Click the Next button and, in the third window, select the template with the blue
diagona l line. After you select a template, a preview appea rs in the window, as
shown in Figure 24.3.
5. After you click the Next button, the fourth window appears. Activate all the check
boxes. You have just asked PowerPoint to print your presentation with slides,
speaker's notes, audience handouts, and outline pages when you are ready to print .
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The first Pick a Look Wizard window.
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Figure 24.3 The third Pick a Look Wizard window, where you choose a template.
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6. Click the Next button. In the next three windows-Slide Options, Notes Options,
and Handout Options-you have the option of adding a name, the date, and a
page number to any of the four printing categories. For this exercise, you can leave
these boxes blank. You can activate Pick a Look Wizard at any time if you change
your mind about a page number or a date.
7. You should now be in the last window, Step 9 (see Figure 24.4) . Click the Finish
button so that Pick a Look Wizard can assemble your presentation.
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Figure 24.4

The final Pick a Look Wizard window.

Congratulations! Your title slide shou ld now look like the one shown in Figure 24.5.

Figure 24.5 The title slide, made with the Pick a Look Wizard.
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Selecting a Template
Using PowerPoint's extensive collection of templates provides the easiest way to create a
uniformly designed look. PowerPoint has over 100 templates in a choice of three formats:
3Smm slide show/screen display, color transparent overheads, and black-and-white transparent overheads. The same basic design options are offered within each category, but the
templates are adjusted to accommodate the output resolution and size ratio. For instance,
the black-and-white overhead templates use shades of gray rather than different colors for
contrast.
These templates were created with visual impact in mind. The backgrounds, text, bullets, and
colors used in PowerPoint graphs automatically use your template settings. The color schemes
provided in the templates have already been proven successful in terms of audience readability
and design attractiveness.
After looking at your slides, you decide that you want a more festive look to show how much
fun people will have at Cafe Ole! The original template design of your presentation can easily
be changed by choosing the Template command.
To select a new template, do the following:
1. Access PowerPoint's Template command either by choosing the Presentation

Template command from the Format menu or by clicking the Template shortcut
button at the lower-right of your screen on the status bar. The Presentation
Templates dialog box appears, as shown in Figure 24.6.
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Figure 24.6 The Presentation Templates dialog box.

2. Select the Templates folder located in the PowerPoint 4 folder. Next, open the
On Screen & 3Smm Slides folder-found in the Templates folder, as shown in
Figure 24.7.
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Figure 24.7 The Templates folde r.

3. Highlight th e tem plate called Confetti (CONFETIS.PPT). After you highlight a
template, you get a preview of it to the left of the dialog box, as shown in Figure
24.8.
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Figure 24.8 The Confetti t emplate in the Preview window of the Templates dialog box.
4 . Select the Confetti template by clicking the Apply bu tton in the dialog box.

If you view your slides, notice that the template has done more than set up a background for
you. You now have a basic layout, consistent color scheme, and type and bullet styles for your
text.

Creating Autolayouts
Unless you are an experienced graphic designer o r slide show producer, figuri ng out how to
arrange text and visual elements o n the slides can be difficult. Power Point's Autolayouts let
you spend mo re time making yo ur point and less time figuring out where to put things.
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You can use AutoLayouts by selecting the Slide Layout command from the Format menu or by
clicking the Layout shortcut button on the status bar. This menu also appears automatically
after you add a new slide. Selecting a layout affects only the particular slide you are working
on, not the entire presentation. PowerPoint offers nine different possible layouts for your
slides, as shown in Figure 24.9.
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Figure 24.9 PowerPoint's Autolayouts.

PowerPoint's AutoLayout options include layou ts for the following:

+
+
+
+

Text with clip art
Text with graphs
Text with charts
Text slides with no visual elements

These predesigned slides position text and visual elements so that they complement each
other and fit together well on the slide. To select an AutoLayout from the dialog box, click the
layout that you want to use.
Placeholders automatically reserve space on the slide for text and visual elements. Placeholders
show you where text and graphics will appear and h elp you make design decisions based on
simple logic. For instance, if the slide you're working on has more than two or three lines of
text, and you want to add a graph, you wouldn't choose the layout featuring the larger,
horizontally oriented graph.
Caution: Selecting an Auto l ayout with two columns of text wi ll result in

e
'

frustration. Although PowerPoint will create a second column placeholder
for more text, t he text on your slide does not automatically format into two
columns. You can, however, cut and paste text into the second column
placeholder or enter text manually.
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You and your Cafe Ole partners basically li ke the way your presentation looks, but it still lacks
oom ph. You would li ke slide 2, "Launch A Coffee Cafe," to include a visual element that
conveys the natu re of your endeavor. You decide to use the AutoLayout comma nd to help you
accomplish this goal.
To use the AutoLayout command to lay out a slide with extra room for clip art, follow these
steps:
1. Ch oose Slide Layout from the Format menu or click the Layout shortcut button.

The Slide Layout dialog box appears.
2. Select the layout with the clip art placeholder (the one with the man's head) and
then select the Apply button .
3. AutoLayout tran sfers the layout to your slide. Slide 2 sh ould now look like Figure
24 .10.

Figure 24.10 A clip art placeholder added to t he slide.

Congratulations, you have just set up a slide layout that leaves space fo r inserting cli p art. You
will learn how to select and insert clip art in the placeholder later in this chapter.
Now you will create a slide layout that includes a placeholder fo r a graph by following these
steps:
1. Go to slide 4, "Enjoy the Experience," by pressing the Page Down key.

2. Select Layout with the shortcut button on the status bar or through the Format
menu .
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3. After the Slide Layout dialog box appears, click on the vertical graph AutoLayout
(the second one in the second row) to select it and then click Apply. Slide 4 should
now look like Figure 24.11.

Figure 24.1l. Slide 4 with a graph placeholder.

Changing Your Color Schemes
Color schemes con sist of sets of eight colors that make up the text color, background color,
and fill colors. You can change the color scheme by selecting the Slide Color Scheme command from the Format menu. The Slide Color Scheme d ialog box appears and shows you how
colors are applied (see Figu re 24.12).
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Figure 24.12 The Slide Color Scheme dialog box.
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Caut ion: Changing color schemes is not recommended for t he design novice.

•
'

PowerPoint's built-in color schemes are combinations in accordance with
establis hed design principles fo r legibility and visual impact. However, as
you grow more experienced in the design of slides, you may want to
experiment with cus tomizing your presentations.

•

Some guidelines for ch anging color schemes are as fo llows:

+

Alth ough you canno t change tem plates in mid-presentatio n, PowerPo lnt does let
you alter t he colo r schemes fro m slide to slid e. You can alter the color in Slide view
fro m within the ind ividual slide that you wa nt to change. Colo rs for gra phs and
clip art, however, m ust be changed indi vid ually.

+

For those o f you with access to a colo r printer, you ca n also apply separate color
schemes to your han dou ts and notes pages. Simply select Handou ts Master o r
Notes Master fro m the Master Command on the V iew men u. Changing these color
schemes does no t alter you r p resen tation.

+

As mentioned in the templates sectio n ea rlier in th e chapter, templates come with
their own colo r schemes. You ca n change one o r several of the colo r defau lts
thro ugh t he Slide Colo r Scheme dia log box fro m the Format menu.

In the Color Schemes dialog box, you ca n assign colors to specific categories of objects that
appea r on slides. PowerPoin t's colo r schemes are programmed to ensure that t he colors of text,
background i tems, bullets, and fi lled and lined o bjec ts do not clash with each other while
en suring sufficient contrast for legibili ty.
Colo r schemes assign colo rs to th e following elements:

+

Background color: Background color applies to the color of the slid e as it appears
before an y elem en ts are added to it.

+

Shadows colo r: Shadows color is app lied when you shadow an object. This colo r is
generally a shade darker t han the Fills color.

+

Fills color: Fills color is applied when you fill an object. Fills color is designed to
contrast with the slide's backgroun d, lines, and text colors. When you create
graphs, the predominant colors used in the graph default to the Fills color.

+

Accent color: PowerPoin t gives you t hree optio ns for Accent color. Th ese optio ns
are used fo r secondary fea tures an d add itio nal colors o n graphs.

+

Tit le Tex t co lor: Title Text color is used fo r slide titles and is designed to co nt rast
with the Backgro und colo r.

+

Text & Lines co lor: Tex t & Lines colo r is used fo r text, Jines, and bo rders on slides
and is designed to contrast with th e Background color.
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By creating or mod ifying co lo r schemes, yo u can custo mize presentations fo r a variety of
purposes, such as ad justing a template when you li ke the overall design but no t the colo rs,
using colors tha t comp lement your com pa ny's logo, o r changing the co lo r schemes on a single
slide so that the info rmation presented in that fram e stands out.
You can apply separate colo r schemes to individual slides or gro ups of slides. To apply separate
colo r schemes to slides, select them either in th e Slide view o r in the Slide Sorter view and then
select the Slide Color Scheme command in the Format menu. To select m ul tiple slides in the
Slide Sorter view, hold down th e Shift key and click the desired slides with your pointer.
To create and change your slide co lor scheme, do the fo llowing:
1. Select th e Slide Co lo r Schem e command from th e Format menu.

2. After the Slide Color Scheme d ialog box appears, cl ick the Choose Scheme butto n.
3. Adjust your colo r schem e after the Choose Scheme d ialog box appears, as shown in

Figu re 24.13.
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Fig ure 24 .13 The Choose Scheme dialog box.
4. Click th e OK butto n . After you return to your slide, yo u can see th at you r colo r
scheme changes have been made.
Your customized colo r scheme is based o n the colo rs that you choose in the Background Colo r
and Tex t & Line Colo r areas of t he Choose Scheme d ialog box. The preview boxes in the di alog
box show yo u how your other co lors will appear.

Changing individual colors in a color sch eme
Yo u can change ind ivid ual colors with in yo ur colo r schem es . This o ptio n is usefu l in situatio ns
where you like the overall colo r scheme, but you need to custom ize a single color element in
your presen tati on .
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To change the color of an indiv idua l element in your color scheme, do the following:
1. Select the element(s) that you want changed and then choose the Slide Color
Scheme command from the Format menu.

2. After the Choose Scheme dialog box appears, select the color element that you
want to change in the Change Scheme Colors area and click the Change Color
button.
3. After the appropriate color palette dia log box appears, as shown in Figure 24.14,
click the desired color.
4. After your new color appears in the preview area, click the OK button. When you
return to your slide, the new color appea rs on the element(s) that you selected.

OK

I

Caecal

Figure 24.1.4 The color palette dialog box for t he Background Color option.

Copying color schemes to other slides
PowerPoint also lets you copy color schemes from one slide to another. To pick up and apply a
color scheme to another slide, do the following:
1. Go into the Slide Sorter view by selecting the Slide Sorter command from the View
menu or by clicking the Slide Sorter View butto n on the lower-left corner of the
status bar.

2. Select the slide with the color scheme you want to copy.
3. Click the Format Painter button (the paint brush) on the Standard toolbar.
4. Select the slide or drag a marquee around multiple slides to which you want to
apply the color scheme.
5. The color scheme now appears on the selected slides.
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If you want to undo your colo r schem e change, select the Undo command from the Edit menu

o r use the ;J:C-Z key combination.

Using Slide Master
Slide Master lets you include an y informatio n, text att ributes, and visual elements that you
want to appear on each slide of your presentation, such as a company logo, a date, and a slide
number. Slide Master is accessed by choosing the Master command from the View menu. The
Slide Master inserts placeho lders fo r text, with sample text for formatting within the placeholders (see Figure 24.15). The text show n in the placeholders does not appear on the actual
presentation slides. To make tex t appear o n th e slides, create a new text box with the text tool
and enter the text. You can use the Slide Master to set fo nts, point sizes, and bullets for slide
titles and supporting tex t. You can also change the color schemes fo r all your slides at once.

Figure 24.15 The Slide Master view.

To edit the fo rmat of all you r slides, sim ply select the text show n in the placeholders as you
normally would and make any ad justmen ts to the font, color, o r type size, as described in
Chapter 23.
Caution: All changes that you make in Slide Master view will apply to the text

•

attributes on all your slides .

'
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Adding background items to your slides
You can use Slide Master to add a decorative border to your slides; insert the date, time, or
slide numbers; or place your company logo in the slides. Inserting graphics from other applications is discussed later in th is chapter. Background items can be removed fro m individual
slides as you work on your presentation.
The following list contains useful information that you can easily apply to your slides with the
Slide Master (do not type the final period):

+

Dat e: To make today's date automatically appear on every slide, select th e Date
option from t he Insert menu or type the characters I/.

+

Time: To make the time of your presentation appear on every slide, select the Time
option from the Insert menu or type the characters ...

+

Page Nu mber: To make the Page number automatically appear on every slide,
select the Page command from the Insert menu or type the characters##.

While working in Slide view, the Slide Master characters for date, time, and page (slide number) appear as you typed them(//, .. ,##). These characters appear as the current date, time,
and slide number only while you are in Slide Show view.
Slide Master helps you maintain consistency in your presentation without having to apply the
inform ation to each slide manua lly.

Using Slide Master in your presentation
In your sample presentation, let's suppose that you want to insert the company name and
slide number on each slide for easy reference. In order for th is information to remain unobtrusive and not interfere with your individual slide layouts, you can place this information in
smaller type at the lower right of your slides. To add this information to your p resentation, do
the following:
1. Return to your DEM02 presentation and select the Slide Master command from
the Master com mand on the View menu. Your screen should look like the one in
Figure 24. 15.

2. Create a text box in the lower-right border of the Slide Master, as shown in Figure
24.1 6. To create this text box, click the Text tool (the one with the A) on the
Drawing toolbar at the left of your screen. Then click the lower-right corner of your
slide, hold down the mouse button, and d rag diagonally left and u pward to the
right border of the slide so that the text box is approximately 1/z-inch high .
3. Type the words Cafe Ole, followed by a comma.
4. Hold down the Shift and Option keys while entering t he letter P, or type##. ShiftOption-P is the command fo r automatic slide numbering.
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Figure 24.16 Inserting a text box into the Slide Master.

S. Highligh t the text and change the font size to 18 points by clicking the Fon t Size
down-pointing arrow o n the Formatting toolbar and scro lling down to select
18-point type.
When you run through your presentatio n in the Slide Show view {the o nly view that automatically inserts the actual slide numbers), each slide displays the name of your company and
the slide number (see Figure 24.1 7).
To return to Slide view after you have made the changes that you wan t with the Slide Master,
choose the Slides command from the View men u o r click o n the Slide View butto n at the
lower-left corner of the status bar.

The com pany date
and slide number.

Figure 24.17 A slide displayed in Slide Show view, displaying slide identification added by Slide
Master.
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Adding Visual Elements with the
Drawing Toolbar
PowerPoint acts like most other graphic packages regarding images and text. You ca n resize,
rotate, and move images; ad just t he colors, draw, shade, a nd colo r shapes; add shadows and
borders; and group and un group objects. You can do all these things with the tools on the
Drawing toolbar on the left side of your screen (see Figu re 24. 18).

Selection Tool.
Text Tool.
Line Tool.
Rectangle Tool.
Ellipse Tool.

r:reeform Tool.
Free Rotate Tool.
AutoShapes.

Li ne On/Off.
Shadow On/Off.

Figure 24.18 The Drawing toolbar.
Here's an explanation of the Drawing too lbar's tools:

+

Selection tool: Use the Selection tool to select and edit text and to move and resize
objects that you have added to your slides. To edit text, click the text th at you
want to change and watch as a selection box appears around the text. Now you can
edit as you normally wou ld. To remove th e box, click anywhere in the slide outside
of the box. To move the text block, click o n the selection box, hold down the
mouse button, and d rag th e box to where you want it to go.
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To move an o bject that you have added to a slide, select a point anywhere in the
middle of the object, hold down your mo use button, and d rag the object to the
location where you want to place it.
To move an object in small increments, select the object and press the arrow key
that points in the directio n that you wa nt to move your object. For sma ller increments, you can turn off the Snap to Grid default temporarily by holding down the
Option key wh ile using the arrow key.
To resize an o bject, click it. A selection box appears. Click yo ur pointer on a resize
handle o n th e selection box and drag th e handle toward th e center to red uce the
object and away from the center to enlarge th e object. The resize handles look like
little sq uares that appea r o n the selectio n box. To keep the original proportions of
an object you are resizing, press the Shift key while dragging a corner resize handle.
Another way to reduce or enlarge an object proportio nally is to select the object
and th en choose the Scale command fro m the Draw menu. When the Scale d ialog
box appears, enter the percentage by wh ich you wou ld li ke the object to be reduced
o r enlarged.

+

Text tool: Use the Text tool to add text to slides. To add text, click the Text Tool
button, create a text box, and begin typing. (For mo re info rmation on how to
create a text box, see "Adding background items to your slides," earlier in the
chapter.)

+

Line tool: Use the Line tool to create straig ht and d iagona l lines on your slides.
To draw a line, click the Line Tool button, click the place where you want your
starting po in t to be, ho ld down your mo use button, and drag the tool to where you
want your end poin t to be.

+

Rectangle tool: Use th e Rectangle too l to draw rectangles and squares. This tool is
useful for crea ting bo rders fo r your slides.
To d raw a rectangle, click the Rectangle Tool button, click where you wa nt your
starting point to be, ho ld down the mouse button, and drag the tool diagonally to
where you want your end point to be. To d raw a square, perform the same proced ure wh ile ho lding down the Shift key. To draw the object from the center o utwa rd, hold down the Option key while you drag the tool.

+

Ellipse tool: Use the Elli pse tool to d raw ovals and circles. To draw an oval, click
the Elli pse Tool button, click where you wa nt your sta rting point to be, hold down
the mouse button, and drag the tool diago na ll y to where you want your end poi nt
to be. To d raw a circle, perfo rm the same procedure wh ile ho lding down the Shift
key. To draw the object from the center o utward, hold down th e Option key while
you drag the tool.

+

Arc tool: To d raw an arc, cl ick the Arc Tool button, click w here you wa nt your
starti ng point to be, ho ld down your mouse button, and drag the tool d iagona lly to
where you want your end po int to be. To draw a quarter circle, hold dow n the Shift
key wh ile d rawing an arc.

60 1

Part IV

+

PowerPoint 4

Freeform tool: To draw abstract and freeform shapes, click the Freeform Tool
butto n, click at your starting point, hold down the mo use button, and draw your
shape as if you were drawi ng o n paper, as shown in Figure 24.19.

Figure 24.19 Afreeform shape .

+

Free Rotate tool: Use the Free Rotate tool to tilt objects and text blocks. To rotate
an object, select the object that you want to rotate, click the Free Rotate Tool
button, and drag a handle in the directio n you want to tilt the object, as shown in
Figure 24.20. If you have attached text to your shape, it tilts along with it.
To autom atically fli p an ob ject or text box 90 degrees to the left, right, up, or
down, select the object and choose the Rotate/Flip co mmand from the Draw m enu.

Figure 24.20 Using the Free Rotate tool to tilt an obj ect.
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AutoShapes tool: After you click the AutoS hapes tool, a pop-up menu appears
with a selectio n of commo nly used shapes, including arrows and starbursts. Use
AutoShapes to add visual impact to your slides. To draw an AutoShape, select the
desired shape from the pop-up menu and add it to your slide by clicking at your
starting point, holding down your mouse button, and d ragging the tool diagonally
to your end point.
You can change any AutoShape into ano ther AutoShape by selecting the shape and
then selecting the Change AutoShape command on the Draw menu.

+

Fill On /Off tool: Use the Fill On/Off tool to add or remove fills from objects. (For
adjusting fills and lines, see the next sectio n in this chapter, "Adjusting lines and
fills. ") To fi ll an object with a color, select the object and then click the Fill On/O ff
button. To remove a fill , select the object and then click the Fill On/Off button.

+

Line On/ Off tool: Use the Line On/O ff tool to add or remove borders from objects.
To add a bo rder to an o bject, select the object and then click the Line On/Off
button. To remove a border fro m an o bject, select the object and then click the
Line O n/Off button.

+

Shadow On/ Off tool: Use th e Shadow On/Off tool to add or remove shadows from
objects. To add a shadow to an object, select th e object and then click the Shadow
On/O ff button. To remove a shadow fro m an object, select the object and then
click the Shad ow On/Off button.

After you learn how to use PowerPo int's graphic tools, you ca n create graphic objects to
emphasize your points and add interest to your presentatio ns.
Caution: Use drawn lines, borders, and s hapes s paringly. Too many objects

•

can clutte r up your slides and distract from the info rmation that you want
to convey .

'

Adju sting lines and fill s

•

'

PowerPoint automatically sets line and fill attributes. To change the color of your fill or the
style of your lines, select the object and then choose the Colors and Lines command from the
Format menu. The Colo rs and Li nes dialog box appears (see Figure 24.21).
Each slide color scheme consists of eight colo rs. Po werPo int displays these colors after you
click th e Pill or Line arrow in the Colors and Lines d ialog box. If you want a color other than
the defa ult color fo r your selected o b ject, select a new colo r from th e palette.
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Figure 24.21 The Colors and Lines dialog box.
for increased graphic functions at your fingertips, you can display the Drawing+ toolbar (see
Figure 24.22) by selecting it in the Toolbars dialog box from the View men u.

Shadow Color.

Dashed Lines.

Group.
Ungroup.
Rotate Left.

Rotate Righ t.
Flip Horizon tal.
Flip Vertical.

Figure 24.22 The Drawing+ toolbar.
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Stacking objects
Stacking objects, also referred to as layering objects, gives you more flexibility in creating your
layouts by enabling you to bring an object to the front, send it to the back, or place it one
layer fo rward or back. Stacking is useful in cases where you wan t to hide objects or where you
want to partially cover on e object with another one.
To move an object backwa rd or forward, select the object and then choose one of the following commands from the Draw menu.

+
+
+
+

Bring to Front: Brings an object to the front layer.
Send to Back: Sends an object to the back laye r.
Bring Forward: Brings an object forward one level.
Send Backward: Sends an object back one level.

figure 24.23 shows how an object moves one level forward after activating the Send Forward
command .
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Figure 24.23 Activating the Send Forward command.

Grouping and ungrouping objects
The Group command from the Draw men u enables you to select two or more ob jects and
group them so that they can be sized and moved as one unit. This is convenient in instances
where you use several elements to compose a single image or when two or more visual elements are designed to appear together.
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To group two or more objects, d o the following:
1. Select the objects either by hold ing down the Shi ft key and clickin g each object

or by d rawing a selection box around them by dragging your pointer d iagonally
across them as if you were drawing a square to enclose them, as shown in Figure
24.24.

r-----------------------------~

I
I
I
I

I

I

I'--------------------------------·+I
Figure 24.24 Drawing a selection box to group objects.
2. Choose the Group command hom the Draw menu or use th e ~-Shift-G key
combination.
To ungroup objects, select the group and choose the Ungroup command from the Draw menu
o r use the ~ -S hift-H key combination .

Inserting Illustrations from the
Clip Art Gallery
PowerPoint's Cli p Art Gallery contains an array of images organized by comm only used
categories so that yo u can 'risuil lly enhance your presentations. You can access the Clip Art
Gallery through the Insert menu, by clicking the Insert Clip Art button o n the Standard
toolbar, or by creating a clip art AutoLayout.
The Clip Art Gallery features a d ialog box with a scro ll-down menu for selecting a category and
previews of the images. To select an image, double-click the previewed clip art item that you
want to add to your slide.
As you already kn ow, using Auto Layouts makes inserting visual elem ents easy. Go to slide 2 in
DEM02, the on e to which you applied the clip art Auto Layout earlier in this chapter (refer to
Figure 24.10).
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You finall y get to add a n actu al graphic to this placeholder by following these steps:
1. Double-click the clip art placeholder in the slide. The C lip Art Gallery dialog box
appea rs.

2. Scro ll down the list of categories and select t h e Ho me Items category. A preview of
th e clip a rt within this ca tegory appea rs in the a rea b elow. Yo u ca n scro ll down
with the downward-pointing arrow to see more.
3. Select th e squa re th at conta ins th e coffee cup and th e n click th e Apply butto n.
Slide 2 now has a picture o f a coffee cup, which a uto matically fits w ithin th e
placeholde r. Thi s feature means never h avi n g to worry about the image ove rrunning th e text. Your slide should n ow look like Figure 24.25.

Figure 24.25 Slide 2 afte r add ing clip art through an Autol ayout.

Caution: To add clip a rt by using the Insert Clip Art button on the Sta ndard

•

toolbar, follow the same proced ure as you would for inserting clip a rt with
an Autol ayout. When you use the button, however, it does not automatically size the placeho lder to fit the text on your s lide.

'

Creating and Editing Graphs

•

'

PowerPoint's ex ten sive gra phing abilities include 14 types o f ch a rts a nd a data sheet so th at
yo u can crea te and edit graphs witho ut leaving PowerPo in t. You ca n also save yo ur graph as
a sepa ra te file to insert in othe r presentations that you create. As part of the Microsoft Office
suite, PowerPoin t also su ppo rts graph s created in Excel.
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You can do the following things with graphs:

+

To insert a PowerPoint graph: You can create a graph by selecting it through
the Object command on the Insert menu. In the Insert Object dialog box, select
Microsoft Gra ph 5.0 in the Object Type menu (you may have to scroll down the
list to find it) . After you click OK, a graph and datasheet appear on the slide, as
shown in Figure 24.26. You can also insert a graph by clicking the Insert Graph
button on the Standard toolbar or by choosing the graph AutoLayout.

1st

2nd

3rd

4th

Figure 24.26 A graph and data sheet.

+

To enter data: After your graph appears, select the Datasheet window and enter
your data as you would with an Excel graph. When you are in the Graph mode, a
special menu and toolbar appear.

+

To edit your graph: To edit a graph that you have already created, double-click it.
The graphing menu and toolbar appear. You can now begin making changes to
your graph .

+

Changing graph types: How you want your graph to appear depends on the type
of data that you are presenting. To change your graph type, use the AutoFormat
command on the Format menu or click the downward-pointing arrow next to the
Chart Type button on the specia l toolbar. A drop-down toolbar appears, as shown
in Figure 24.27. Select your new graph type by clicking the button representing the
graph type that you want.
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3-D Area C hart.

Area C hari.

3 -D Bar Chart.

Bar Chart.
Column Chart.

3-D Column Chart.

Li ne C hart.

Ribbo n C ha rt.

Pie C hart.

3-D Pie C hart.
Su rfacc C hart.

Do ug h n ut Chart.

Radar Chart.

Figure 24.27 The Chart Type drop-down t oolbar.

Changing your graph's color scheme
You can change t he colors o n your g raph by first selecting th e element that you want changed
and then clicking the do wnward-pointing arrow nex t to th e Color b utton on the toolbar. You
can also ungroup th e graph and use the Colors and Lines d ialog box accessed through the
Fo rmat menu. (Fo r more info rmatio n o n color schemes, see th e sectio n o n "Changing Your
Color Schemes" earlier in th is chapter.)

Entering equations
PowerPoint's graphing fun ctio n also includes an Equatio n Editor for entering mathematical
symbols, fractions, subsc ripts, and more. To insert an equ ati o n, choose Object from the Insert
menu. In the Insert Object d ialog box, select Equatio n from the Ob ject Type list. If you enter
equations often, you may want to ad d the Insert Equati o n butto n to your toolbar. (For more
info rmati o n o n custo mizing you r toolba rs, see Chapter 22.)

Adding a graph to your presentation
Nothing co n veys credibili ty better than using numbers a nd graphs. You want to impress
CoffeeCo by showing th em th at fewer people are drinkin g alcohol in bars, and more people
are sipping coffee in cafes li ke yo urs. Yo u also want to show your potential backers that similar
endeavors have prove n successful.
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In slide 3 of DEM02, you have wri tten that since 1985, coffee consumption has gon e u p SO
percent, alcohol consumption has gone down 30 percent, and two other similar coffee cafes
have increased their profits. There is no room on this slide for a graph, but it still makes sense
to reinforce this information with a graph on slide 4.
1. Go to slide 4, the one that is ho lding the graph placeholder (refer to Figure 24.11).

2. To enter your own data into the graph, double-click the placeholder. The graph
appears in the placeho lder with a datasheet fo r you to fill in (refer to Figure 24.26).
3. Replace "East" with Coffee Drin king; replace "West" with Alcohol Drinking; and
replace "North" with Cafe$ . These cells represent what becomes the graph's color
key.
4. Replace "1st Qtr" with 1985 in column A an d replace "2nd Qtr" with 1995 in
colu mn B. These cells represent your time line on the horizontal axis of the grap h.
5. To deactivate columns C and D, select them and click the Cut button on the
toolbar or use the ~ -X key combinatio n.
6. Enter the following information:
In cell Al, enter 20%.
In cell A2, enter 40%.
In cell A3, enter 10% profits.
In Cell Bl , enter 40%.
In cell 8 2, enter 30%.
In cell 83, enter 30% profits.
7. Exit the dialog box by clickjng in any place o n your slide. Your slide should now
appear as shown in f-igure 24.28.
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Figure 24.28 Slide 4 with graph data entered .

Creating Organization Charts
PowerPoint makes it easy for you to create organizatio n charts. To insert an organization chart,
choose the Object command from th e Insert menu. In the Insert Object dialog box, select the
Microsoft Organization Chart 1.0 from the Object Type Jist. Or you can choose the organization chart AutoLayout or click the Insert Org Chart button on the Standard toolbar. The
Organization Chart window appea rs, as shown in Figure 24.29.

Figure 24.29 The Organization Chart window.
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To build your organization chart, do the following:

+

To enter text: Click inside the box in which you want to enter text, such as names
and positions, and type the information. Use the Tab key to go from point to point
in each box.

+

To add boxes and assign levels: Click on the button of the level you want to
add and then click the existing box to wh ich you want to attach the new box.
Power Point automatically places the box where it sh ould go. It also automatically
moves the other boxes proportionally so that the chart stays centered.

+

To change text and box attributes: You ca n edit the size, color, and format of text
and boxes by using the menu bar in t his window. This menu bar gives you flexibility and allows you to create borders and change the chart's colors for added
impact.

Creating Special Text Effects
with WordArt
PowerPoint also includes an exciting p rogram called WordA rt. WordArt can be opened only
from within OLE-supported application s. WordArt lets you hend, twist, and curve text to
create special effects.
To insert WordArt, do the following:
1. Select the Object command from the Insert menu. In the Insert Object d ialog box,
select Microsoft Word Art 1.0 or 2.0 from the Object Type list.
2. After the Microsoft WordArt dialog box appears, as shown in Figure 24.30, enter
your text in the text entry box.
3. Select the Update Preview option to view your text as it wou ld appear on your
slide.
4. Choose your text effects from the dialog box.
5. To return to your prese ntation, click anywhere o n your PowerPoint slide.
This chapter covers how PowerPo int's graphic features work together to help you create
attractive, professional-looking slides. In Chapter 25, you wi ll learn how to add the final
touches to your presentation.
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Figure 24.30 The Microsoft WordArt dialog box.
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Adding the
Final Touches
After you develop a presentation, it is time to review, edit, and add the final touches.
PowerPoint's text editing features and transitio nal effects help you ensure a well-organized
presentation. You can also use th e Slide Sorter, Notes Pages, and Rehearse Timing features to
rehearse, revise, and prepare fo r you r talk. This chapter covers the following points:
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Using the Spelling Checker
PowerPoint is unique amon g graphics programs because it offers a fully functional spellchecking feature. This feature makes it easy for you to avo id potentially embarrassing spelling
errors. PowerPo int's Spelling Checker works the sam e way it does in Microsoft Word and o ther
word processing applicatio ns.
The Spellin g Checker searches yo ur slides for words that are not in its dictio nary, inform s you
when it finds an unfa miliar word, and gives you the option of correcting the spelling, adding
the word to your dictio nary, or ignoring the word and moving o n.
To check your spelling, click the Spelling button (th e one with ABC) o n the Standard toolbar
or choose the Spelling command fro m the Tools menu. A Spelling d ialog box appears, as
shov.rn in Figure 25.1.
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Figure 25.1. The Spelling dialog box.

When the Spelling Checker finds a word it does not recognize, the word appears in the Not in
Dictionary box. Yo u can tell the Speller to ign ore the word, add it to your dictionary, ignore all
future occurrences of that word, or change the wo rd and all future occurrences of that word.
To change a word tha t appears in the Not in Dictionary box, type the correct spelling in the
Change To text box or scroll down the list of suggested words and highlight the correct one.
The Speller tells you when it is finished checking your presentatio n. Click the OK button to
return to your presentati on. If you wa nt to leave the Spelling Checker before it is finished
checking your presentatio n, click the Close button.

Caution: When you run the Spelling Checker in Slide view, it checks all your

•

text for you. When you ru n the Spelling Checker in Outline view, it checks
only the text in you r outline .

'

•

i

To q uickly verify the spelling of a single word, highlight it with your cursor an d either click
th e Spelling button o r press the F7 key. You can make the Speller run faster by tu rning off the
Always Suggest option. To turn off the Always Suggest option, ch oose the Options command
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fro m the Tools menu. The Spelling function is one of the ma ny features that makes
PowerPoint a flexible, comprehensive package.

Fi nding and Replacing Text
PowerPoint enables you to find and replace text the same way yo u would in Microsoft Word.
The ability to locate words o r q ui ckly replace dates, com pany names, and other info rmation
helps you customize presentatio ns easily and efficiently. Yo u can activate the Find or Replace
commands through th e Edit men u.
Use the Find command when you are looking for a specific part of a lengthy presentation, and
you remember a particular word that serves as a reference. To use the Find command, do the
fo llowing:
1. Choose the Find command from the Edit menu o r use the :FC-F key combination.
The Find dialog box appears.

2. In the Find What text box, type the wo rd o r group of words th at you wan t to
search fo r.
3. Click the Find Next button, and the Find feature searches fo r your text.
The Find command also lets you search fo r graphics, paragraph fo rma ts, and special characters
within the Format and Specia l pop-u p men us. You ca n choose fro m o ption s, such as m atching
the case of words or find ing com plete words o nly.
You can repeat your last search with the Find command by pressing the ;):C-F4 key
combinatio n .
Use the Replace command when you need to replace a word o r group of words that appears
frequently througho ut a se ries of slides. To use the Replace command, do the following:
1. Choose the Replace comm and from the Edit men u o r use the :FC-H key combination. The Replace d ialog box appears, as shown in Figure 25.2.

I

"=========='ttl l
.-----------,ttl _I

rtn4 HIIXt

I

Cl ooo

I

Roploce

(l!oploco IITI
llolp

Figure 25.2

The Repl ace dialog box.
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2. In the Find What text box, type in the word or group of words that you are
searching for.
3. In the Replace With text box, type the word or group of words with which you
want to replace the Find What text.
4. When your word is found, click the Find Next, Replace, or Replace All options.
The Find Next button moves you to the next occurrence of the word being
searched without m aking changes. The Replace button replaces the word and
moves on to the next occurrence of the word. The Replace All button replaces all
occurrences of the word being searched.
5. After the dialog box informs you that all occurrences of the word have been
checked, click OK.

Caution: Be very careful when you choose the Replace All button because

e
'

you may make some changes that you don't rea lly want to make. For
example, if you tell the Replace command to replace all instances of me
with you, the program changes remember to reyoumber in addition to
making the changes that you want. To prevent this problem from occurring, select the Find Who le Words Only option and take the time to view all
Replace commands individually.

•

'

You can edit a presentation while in Find or Replace modes. Simply click in the presentation
window and change your text. The Find or Replace dialog box remains onscreen. To continue
searching, click in the Find or Replace dialog box and select an option. The Find and Replace
commands are useful when you need to find or replace recurrent words and phrases in large
presentations.

Using Speaker's Notes
Speaker's notes can be invaluable to help you develop your presentation. To create speaker's
notes, choose the Notes Pages command from the View menu or click the Notes Pages View
button on the lower-left corner of your presentation's window.
The Notes Pages view displays as an 8 1/2 x 11-inch piece of paper, so that you can print your
notes, as shown in Figure 25.3. For easy reference, there is a picture of the slide you have
selected at the top of the page. The bottom of the page has room fo r you to type in your notes,
which help jog your m emory with facts and figures, prepare for questions that people may ask
you, or jot down ideas that you want to remember about orchestrating your presentation.
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Figure 25.3 The Notes Pages view.

You want to remind yourself of important points while making your presentation to CoffeeCo,
so you want to create some speaker's notes in your sample presentation. Open the DEM02
presentation and follow these steps:
1. Select slide 1 and go into the Notes Pages view by clicking the Notes Pages View

button.
2. In the text placeholder, type the following:
Thank you all for coming today. We greatly appreciate CoffeeCo's inte rest in
our proposal. We look forward to the possibility of working with you a nd
making Cafe Ole a success.
In the Notes Pages view, you can ad just your text to any size that you want, but
you can't change any elemen ts on the slide.
3. To print your notes, select Print fro m the File menu and then select Notes Pages
fro m the Print What pop-up menu. (For mo re informa tion about printing, see
Chapter 26.) Be sure to print out your notes because you will use them for an
exercise later in this chapter.
To create a separate color scheme for your speaker's notes, go into the Notes Pages view and
choose the Notes Color Scheme command fro m the Format men u. (For more information on
creating color schemes, see Chapter 24.)
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Arranging Slides in the Slide Sorter View
The Slide Sorter view enables you to see minjature versio ns of up to twelve slides at o nce, in
the order that they appear in your presentation. You ca n move slides around, test transitional
and text-building effects, and delete slides from th e presentatio n. You can also add tran sitio ns
and builds, hide slides, or use the Rehearse Timings butto n (the o ne with the stopwatch) on
the new Slide Sorter toolbar to see h ow long you r presentatio n takes. To access the Slide Sorter
view, click the Slide Sorter View button in the lower-left corner of your screen.
You can use the Slide Sorter view to do the followi ng:

+ Rearrange slides: To move a slide or group of slides to a different part of your
presentation, click the slide that you wan t to move and drag it to the place in your
presentation where yo u wa nt it to appear.

+

Delete slides: To remove slides from you r presentation, select the slide or group of
slides that you wa nt to remove and then choose the Delete Slide com ma nd from
the Edit m enu. You can also press the Delete key.

+

Hide slides: To exclude a slide from your presentatio n, select the slide and then
choose the Hide Slide command from the Tools menu or (in th e Slide Sorter view
only) click the Hide Slide butto n (the o ne with line through a slide) on th e Slide
Sorter toolbar.

+

Create text builds and tran sitional effects: To create text builds and transitional
effects in the Slide Sorter or Slide view, choose the Build or Transition commands
from the Tools men u.

+

Rehearse timings: To rehearse your presentatio n and time how lo ng you spend o n
each slide, click the Rehearse Timi ngs button on the Slide Sorter toolbar. You can
then rehearse your presen tation while PowerPoint ti mes how lo ng you spend on
each slide.

You can do uble-click a slide minia tu re in Slide Sorter view to go directly to that slide in the
Slide view.
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Adding Transitional and Text-Build Effects
PowerPoint supports addin g transitional and text building effects to slides. Transitions are
an imated effects that happen when o ne slide changes in to the next. This effect creates a sense
of m ovement during electronic slide shows. Text builds, also referred to as progressive disclosures, display bulleted points one at tim e on a slide.

Adding transitions to your slides
You can access the Transition command from the Tools menu in either Slide view or Slide
Sorter view. The Transition d ialog box appea rs, as shown in Figure 25.4, with three options:
Effect, Speed, and Advance. Yo u can view your transition s before applying them to you r slides
in the Transition preview box on the right of the dia log box.
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Figure 25.4 The Transition dialog box.

You have decided that your presentation on Cafe Ole wo uld look more professional if you
incorporated transitions. To add transitions to yo ur slides, follow these steps:
1. Select the Slide Sorter view. The Slide Sorter view is the ideal format in which to
add and test you r transitions because you can see all your slides at one time, and
you can select them either o ne at a time or all at once.
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2. Select all your slides by drawing a selection box around them with your pointer,
by using the ~-A key combination, or by clicking all of them individually while
holding down the Shift key. PowerPoint also lets you apply transitions to only one
pair of slides.
3. Choose the Transition command from the Tools menu.
4. Select the Blinds Vertical effect from the scroll-down list and watch what happens
in the preview box. Notice that the preview box looks like vertical blinds just
closed and opened on the image in the window. The preview box lets you test out
your effects before app lying them to your slides.
S. The Speed options enable you to select how long it takes to go from one slide to
the next. Experiment with the options by clicking the radio buttons and watching
the speed changes in the Preview window. Select the Slow button for your Speed
option.
6. The Advance options enable you to decide whether the transition should take
effect after a preset amount of time during the presentation or when you click the
slide. This option enables you to pace out a self-running presentation. Select the
Only on Mouse Click option.
7. Click the OK button to apply the transition to your slides. Notice the tran sition
icons underneath each slide miniature.
8. Click the transition icon s to watch the effect you have added to your slides. Notice
that the transitional effect always takes place before the transitioned slide appears
onscreen, not after.

Caution: The insertion of too many transitional effects can cause the pre-

•

•

sentation to appear cluttered and confusing. Stick to one type of effect
per presentation-or two at the most .

'

Transitional effects help ease the flow of your presentation from slide to slide and enable you
to add interest to your slides in the form of motion . Transitional effects can also be used to
signi fy a change in the section or topic of your presentation.

Adding text builds to slides
Text-build slides progressively add text to the slide so that each bulleted point is added to a
slide in sequence. To create a text-build slide, select the slide or slides on which you want this
effect and then choose the Build command from the Tools menu. The Build dialog box enables
you to decide how each bulleted point will be displayed and whether you want the nonbulleted text to dim when a new bulleted point is introduced.
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To create a text-build slide, do the following:
1. Select a slide or group of slides and then choose the Build command from the Tools
menu. The Build dialog box appears, as shown in Figure 25.5.
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Figure 25.5 The Build dialog box.

2. Select the Build Body Text check box for a simple text build.
3. If you want each point to dim and become a different color as the next point
appears, select the Dim Previous Points check box. Then select a color from the
pop-up color menu.
4. For additional opti.on s, click the Effect box and browse the pop-up menu for the
selection of visual effects.
Text builds help draw the audience's attention to important points and allows time for the
people to absorb th e presented information. Tex t builds can liven up even the most text-heavy
slide shows and can be especially useful when summarizing sections or whole presentations.

Creati ng a Self-Running Slide Presentation
Because you now know that a self-runn ing presentation has the advan tage of looking as if
more preparation has gone into it, yo u may want to make your presentation to CoffeeCo selfrunning. Additionally, you can gain more freedom for interaction with the audience.
To make your presentation self-running, do the following:
1. In the DEM02 presentation, select all your slides in the Slide Sorter view, as

explained in the "Adding transitions to your slides" section earlier in this chapter.
2. Choose the Transition command from the Tools menu. When the dialog box
appears, it should display the transition that you selected previously in this
chapter.
3. In the Advance section, click on the Automaticall y After radio button and enter a S
in the Seconds text box. This option enables you to en ter the number of seconds
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that you want the slide to stay onscreen before going on to the next slide. You
have just entered five seconds per slide. In most situations, a presenter would allow
at least two or three minutes per slide.
4. Click the OK button to return to your slides. Notice that the amoun t of time per

slide now appears in the Slide Sorter view.

Running the timed show
You are now ready to run your timed slide show. A timed slide show offers you the option
of displaying your slide show as self-running. To view your self-running slide show, do the
following:
1. Select slide 1 and then choose the Slide Show command from the View menu. A

dialog box appears and asks what type of presentation you would like to run, as
shown in Figure 25.6.
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Figure 25.6 The Slide Show dialog box.

2. Select the Use Slide Timin gs option from the Advance area.
3. Click the Show button.
Notice that the slide show runs in accordance wi th your settings. Each slide remains onscreen
for five seconds and then transitions into the next slide with the vertical blinds effect. After
the slide show is finished, you are returned to the Slide Sorter view.
To complete your presentation smoothly, add a blank, black slide to the end of your presentation so that you can finish your speech without the use of slide graphics. If you are running an
onscreen presentation, select the slide and set the Automatically After option in the Transition
dialog box to 120 seconds, or two minutes.
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You can alternate between a self-running series of slides and m anually activated slide tra nsitio ns. This allows you to create excitem ent with a dazzling array of graphic image slides and
graph slides that fade into each other, while alternately allowing you to pause you r show to
interact with your audience.

Using the Rehearse Timings command
After setting your timed transitio ns in Slide Sorter view, you can use the Rehearse Timings
command to rehearse your presentatio n o ut loud. By using this technique, you can see how
lo ng you actually need to spend on each slide and then reset the timed transitions where
necessary. You can activa te the Reh earse Timings command by clicking the Rehea rse Timings
button (the one with the stopwatch) o n the Slide Sorter toolbar.
The Rehearse Timings m ode looks and acts li ke th e Slide Show view in ma ny ways, but with
o ne major difference. Even if you have set auto m atic advances, the next slide doesn't appear
until you click the m ouse. Th is actio n resets the amount of time each slide appea rs o nscreen to
match how long you spend discussing that slide. Also notice that a timer appears o n the lowerleft corner of your screen . The timer allows you to plan your presentatio n to the exact second.
To rehearse the timing of your presen ta tion, do the following:
1. Use the speaker's no tes that you printed earlier in this chapter.

2. Go into the Slide Sorter view, select slide 1, and click th e Rehearse Timings butto n .
3. Start reading the sho rt speech you typed onto th e speaker's notes page of slide 1.
Read the way you no rmally wo uld and feel free to ad-lib o r leave time to introduce
Cafe Ole's staff. Remember, the timer is running!
4 . Move to the nex t slide by clicking the mouse after you are finished. Ordina rily,
you would repeat th is procedure fo r the en tire presentatio n. For now, let the other
slides ru n for five seconds and continue clicking them until an alert box appears,
as shown in Figu re 25.7.
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Figure 25.7 The Set Timings dialog box.
5. Click the Yes butto n to retain your new slide times.
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After you return to the Slide Sorter view, notice that the new timings you set for each slide are
indicated beneath the slides.
When using the rehearsal feature, do n' t spend too lo ng o n a si ngle slide. A good pace for a
presentation ranges betw·een SO seconds to 3 minutes per slide frame, depending o n th e
medium and the information being presented.

Hiding Slides
PowerPoint's Hide Slide feature enables you to exclude a slide from your presentatio n without
removing it. This feature provides you with g reater flexibility during your presentati o ns.
Hidden slides help you sti ck to an extremely concise slide show by unhiding additional slides
and allowing you to add ress these new topics in grea ter detail when a situation ca lls fo r it.
Slides can be hidden while you are in the Outline, Slide, or Slide Sorter views before a slide
show, and they can be reactivated during th e shows. You can hide multiple slides in the Slide
Sorter and Outline views.
To hide a slide, do the following:
1. Select the slide or group of slides that you wa nt to hide.

2. Select the Hide Slide command from the Tools men u. Or if you are in Slide Sorter
view, click the Hide Slide button on the Slide Sorter toolbar.
The slide appears in Slide Sorter View as it normally would; however, the slide number is
enclosed in a box with a line through it, as show n in Figure 25.8. During slide shows, the
presence of a hidden slide is indicated by an icon in the lower-right corner of th e slide preceding the hidden one.

~ Notice how t he number
appears for a hidden sl ide.

Figure 25.8 A hidden slide.
To display a hidden slide during a slide show, do the fo llowing:
1. When you see the hidden slide ico n o n your slide during an electronic presenta-

tion, click th e icon o r type H.
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2. To access t h e hidden slide from anywh e re in your p rese nta ti o n, type the slide
number a nd press the Retu rn key.
Hidde n slides ca n be revealed so that you can elaborate o n infor m ati o n presen ted in th e
previous slides.
In th is ch apter, you 've learned how to use PowerPoi n t to o rga ni ze a nd fine-tune you r presen tatio n fro m start to finish . In th e next chapter, you wi ll lea rn more about prin ti ng and d isplaying your options in a presentation.
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PowerPoint gives you th e flexibility that you need for printing your presentation . You can
print supporting materials, slides and ou tlines, o r transparent overheads. The equipment you
choose for printing your presentation depends on your needs, your budget, and the equipment that is already available to you. Your options for displaying your presentation are
virtually endless, including transparent overheads, self-running kiosk displays, 3Smm slides,
or videotape. This chapter covers the following information:
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Printing with PowerPoint
Throughout most of the PowerPoint section of th is book, the im portance of using PowerPoint
to make an immediate impact on you r audience with visually exciting slides, clearly written
text, and eye-popping graphics has been emphas ized. But you cannot underestimate the
importance of printed materials.
Printed materials make it easier to digest and memo rize information-both for you and for
your audience. Handouts enable your audience to concentrate on what you are saying rather
than having to take notes. Hard copies can also be fil ed away fo r easy review later because you
do not need any electronic equipment to view th em.
To give the "paperless office" enthusiasts in your aud ience something to take home with
them, simply copy your presentatio n onto a disk and give them the PowerPoint Viewer disk.
You can find the PowerPoint Viewer on the last Office installation disk. It is a separate installation and is designed to be given to people who do not have PowerPoint so that they can
peruse your presentation at home on their own monitors.
Although PowerPoint was primarily created to format slides, no presentation system would be
complete without the ability to create supporting materials. With PowerPoint, you can print
overheads, slides, audience handouts, notes pages, and outlines.
To print a PowerPoint presentation, do the following:
1. Choose the Print command from the File menu, click the Print button on the
Standard toolbar, or use the J:C-P key combination. A dialog box appears, similar
to the one shown in Figure 26.1.
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A Print dialog box.

2. Select the type of document that you want to print from the Print What pop-up
menu.
3. Enter the number of copies that you want in the Copies box.
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4. Select the All radio button as your Slide Range option.
5. Click the Print button or press the Return key.
Details about the types of documents PowerPoint enables you to print are described as follows:

+

Slides: You can print your slides on ordinary paper or as overhead transparenciesone image per page. PowerPoint automatically defaults to printing slides in tlte
landscape format because slides are generally hori zon tally oriented.
When you select the Slides option from the Print dialog box, your slide automatically fits the page, as shown in Figure 26.2. You can use a Slide view print as a
transparency, for proofreading, or to file away for later reference.
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Figure 26.2 A print in the horizontal Slide view.

+

Slides (with builds/with out builds): This option is available only if your presentation includes text-build slides (see Chapter 25), in which bulleted points appea r
onscreen one at a time, with each added bullet point as a separate slide.
If you choose the Without Builds option, PowerPoint prints the last slide in the
build sequence- th e one that contains al l the bulleted points. If you choose the
With Builds option, PowerPoint prints each text-build slide as a separate slide. lf
you print a slide with text builds, the end product should look like the ones in
Figure 26.3. Each print contains a representation of the same slide with an additional bulleted point appearing progressively on each slide.

+

Notes Pages: PowerPoint prints speaker's notes for the slide numbers that you
request. PowerPoint automatically defaults to printing notes pages in a portrait
format . (For more on speaker's notes, see Chapter 25.)
Your onscreen speaker's notes should look li ke Figu re 26.4. Hard to read, aren't
they? They print out much clearer. Speaker's notes let you enter text underneath a
picture of the slide that you are discussing so that you can keep additional information organized.
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Figure 26.3 A print of a slide with text bu ilds .
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+

How speaker's notes look onscreen.

Handouts: Handouts print as miniatu re version s of your slide presentation to help
your audience remember you r presentation and to let the audience easily take
notes. You can print handouts at two slides per page to create the most readable
images, three slides per page to leave o ne side of the page open for note-taking, or
six slides per page to save paper (see Figure 26.5). PowerPoin t's handouts o ptions
enable yo'.l to tailor supporting materials to your needs.
When printing hando uts, you can use the Optio ns button in the Print dialog box
to reverse the images that you are printi ng out. Th is can be helpful with a blackand-white printer. Most slide templates use light-colored text on dark backgrounds.
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Altho ugh this combination is easier to read when being displayed, printed materials are easier to read with dark-colored text on light backgrounds. (The reverse
option may no t be avai lable o n all printers.)

Figure 26.5 An aud ience handout with two , three, and s ix s lides per page.

+

Outline View: Use this option to prin t your outline as it appears in the Outline
view. By making adjustments within the Outline view, you can collapse, expand,
and format the o utline's text. (For more infor matio n o n working in the Outli ne
view, see Chapter 23.) The size of the type is determ ined by what view scale you are
working in.
The Outline view's text-o nly format makes it easier fo r you to edit your presentation's conten t. You can also use the printed o utline as a hand out, which
gives your aud ience an idea of wha t informatio n will be covered.

Using Your Print Options
In addition to types of output, PowerPo int offers various option s so that you can customize
your handouts to your presentation needs. The Print dia log box offers basic printing selections, but by clicking the Optio ns button in the Print dialog box, you can bring up the Print
Options dialog box, where you can choose other options fo r your printing process.

Selecting options in the Print dialog box
The Print dialog box appears o nscreen as soo n as you select th e Print command. The Print
dialog box lets you make basic choices regarding yo ur handouts, such as number of copies,
number of pages, and choice of material.
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You can select the fo llowing functions through the Pri nt dialog box:

+

Number of Copies and Page Range: lndicate the number of copies that yo u wan t
and then click the All button or enter the page numbers that you want to prin t in
the page range boxes. When you select a page range fro m the Print dialog box,
your page range must consist of consecutive pages.

+

Paper Source: If your printer has multiple trays, you can change the default so that
your materials print fro m different paper trays. This can be useful if you have o ne
tray co ntaining plain paper for rough drafts and one tray full of nicer paper for
final versions of documents.

+

Print What: This option enables you to choose among printing slides, handouts,
speaker's no tes, and outlines.

+

Print Hidden Slides: This o ptio n enables you to print h idden slides if they exist in
your presentation. PowerPoint o therwise defaults to leaving out the hidden slides.
(Fo r mo re informatio n o n hidden slides, see Chapter 25.)

+

Scale to Fit Paper: This optio n enables you to size slides to fit on the paper you
already have in your printer. This can be useful in cases where, for some reaso n,
your presentation has been custo m sized. PowerPoint automatically fits your
printed m aterial to the pa per size specified.

+

Destination: This optio n enables you to select a printer or a PostScript file as your
print output.

+

Pure Black & White: This o ption helps you make aud ience handouts and speaker's
notes mo re readable, alth ough the handouts look markedly Jess attractive. It renders all co lor fills to white, all text and lines to b lack, adds outlines and bo rders to
all filled objects, and uses halftones for pictures.

+

Black & White: This optio n renders q uick black-and-white draft copies and turns
all fi lls to white or black. Un bordered objects with no text are ind icated with a
thin, black frame.

Selecting options in the Print Options dialog box
The Print Optio ns d ialog box is accessed through the Prin t d ialog box by selecting the Options
button. The Print Options dialog box offers you further choices, as shown in Figure 26.6. Here
you can enter add iti on al informatio n about your prin ter an d the way your presentation prin ts.
The Optio ns dialog box may pro mpt you fo r the fo llowing information (this information will
va ry with th e type of printer you choose to print with):
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•

Cover Page: You can decide whether to have a cover page and whether you want
it to appear before or after the document. A cover page is useful when printing
materials to be used as a complete set.

•

Print: PowerPoint is asking fo r more information abou t how you wa nt your doc-

ument to print. The most usefu l choice here is Colo r/G rayscale. This option
enables you to print in color on a color printer or with grayscale images o n a blackand-white printer.
•

PostScript Er rors: This option asks you whether you want PowerPoint to pri nt a
report on any PostScript errors that are present in your presentation. If you are
sendi ng your presentation to a service bureau o r you are using it across Mac and PC
platforms, you should run these reports. PostScript errors affect your presentation
output, even when the presentatio n looks fine o n your computer screen. Serious
PostScript errors can prevent you from obtain ing output from a PostScript device.

•

Econo m ode/Duplex/Resol ution Enhancement: These option s all let you select
new setti ngs for your printer's output. In general, however, PowerPoint defaults
these settings in accorda nce with your Printer dest ination, so using these settings
can prove unnecessary.

Prin t Options

1.1.1

Couer Pnge:@ Nono

0

Do l ore

Prtnt:l Color/GrntiSCnle •

0

nner Docume nt

I

PostScrtpt~ Errors: I No Spoclnl neportlng •I

£conoModo:l Printer'• Curra nt Setting •
Du plan:)

Prin t or's Current Se tti ng •

I

I

Resolution £nhnncornont:l Printer's current so tttnc1•

I

Figure 26.6 The Print Options dialog box.

Saving your presentation as a PostScript file
Destination options are also located in the Print dialog box. When you select the Printer radio
button, the document is printed to the printer that is currently chosen. When you click the
File radio button, PowerPoin t allows you to save your presentation in a PostScript file format.
When sending a presentation to be outputted by a service bureau, it is essential that you save
the presentation as a PostScript file so that the service bureau's software can read your file. To
save your presentation as a PostScript file, click the File radio button in the Destination area of
the Print dialog box. Then select th e Options button. The dia log box shown in Figure 26.7
appears.
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Figure 26.7 Saving a presentation as a PostScript file.

Con·sidering a Color Printer
No matter how well designed your audience handouts o r transparen t overheads are, nothing
grabs attention like a strategically placed splash of color. There are many ways to add color to
your PowerPoint presentatio n materials. Colo r printers are becoming increasingly affordable,
and many of the Jess expen sive inkjet printers can hold their own. Despite low-end inkjet
printers' reputations for bleeding images around the edges, their quality has risen markedly.
If you prepare presentations freq uently, investing in a color printer can easily pay for itself.
Al though color printers are more expensive and print more slowly than black-and-white
printers because of the increased informaUon they must process, the prices of color printers
h ave co me down considerab ly in the past few years. You can purchase a decent color printer
for less than $800 and one of extremely high quality for Jess than $10,000.

When looking for a printer, you should take a va riety of factors into consideration, including
the resolu tion, speed, volume, and paper stocks the machine can handle. You sho uld also
con sider the types of images you generally use. Some printers handle text better than artwork,
and some handle photographic images better than simple line art and text.
Many of these factors are determined not only by the quality of the printer but also by the
implem ented printing process. For example, dye sublimatio n printers use a continuo us tone
method fo r distributing colors. This means that prints of scanned photographs look wonderful, but line art illustratio ns lose their crisp detail. Make sure that you research and test printers
thoroughly before buying o ne.
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Understanding how printers work
Color printers use cyan, magenta, and yellow pigments. When mixed in different combinations, these three pigments can create a full range of colors. Printers process your materials as
one color plate at a time, and they layer pigments to create various shades and mi xes of colors.
Consequently, color images take longer to print than black-and-white images. The printing
head has to pass over the area being printed on e time for each pigment used.
Most, but not all, color printers also use a black pigment. Whether your printer uses a black
pigment is especially important if you frequently print large quantities of text. Because cyan,
magenta and yellow are all required to create black, your printing head has to pass over the
text on your page three times.
Resolution is also of prime importance. Printers represent images as the presence and absence
of dots. The more dots per square inch that the printer can render, the more crisp and detailed
your image is. The size, shape, and accuracy of t he dots printed also determine the overall feel
of your images. Processes that slightly blur dots can result in a smooth er finish; processes that
featu re a greater accuracy of dot placement may result in a grainier finish.
When looking for a printer, you should look for an output of at least 300 dpi (dots per inch).
Most offices use 300-360 dpi printers. Graphic professionals gen erally use 600 dpi printers.
However, because color printing-especially dye sublimation printers that use continuous tone
imaging-can trick the eye into perceiving a high er quality, a 300 dpi printer can be adequate
for many business uses.
If you use glossy or coated paper, you can significantly increase the quality of your color
prints. The clay coating keeps colors fro m soaking into the paper, thus losing their intensity.
Glossy paper also reflects light, which makes colors appear more highl y saturated.

Choosing which color printer is correct for you
Knowing the difference between laser, dye sublimation, thermal wax transfer, solid inkjet, and
liquid inkjet printers can help you determine which type of printer best meets your needs. The
types of color printers described in th is section differ in two ways: the types of pigments used
and the method of application to your paper. Different printing technologies meet some needs
better than others.
The price ranges included here represent what these products generally cost. Don't get discouraged if the price range listed next to your dream printer appears to be over your budget-costs
are dropping almost as fast as you' re reading this. Table 26.1 shows a basic comparison of color
printer types.
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Table 26.1
Color Printer Types
Primer type

Price range

Strengths

Weaknesses

Laser

$9,000-$20,000

300-600 dpi resolutio n,
photo-quality, handles line
art and tex t well, works with
most paper stocks

High maintenance, does
not reproduce photos as
well as d ye sublimation
printers

Dye
sublimation

$8,000-$20,000

Continuous tone im ages,
photo quality, ideal
for pre-press

168-300 dpi resolution,
doesn't handle line art
and text as well as
graph ics

Thermal wax $6,000-$10,000

Highly saturated colors,
large array of output options,
speed, colors resist fad ing

May get a cartoo n ish
appearance to object fills
because of the high ly
saturated colors

Solid inkjet

High-quality output for
the price

Handles transparencies
poorly

Inexpensive, quality steadily
increasing

Quality varies,
tendency to blur

$6,000-$10,000

Liquid inkjet $300-$1,000

Let's look at these printers in more detail:

+

Laser: Color laser printers produce vivid colors and can handle transparencies and
most paper stocks. Nothing match es laser printers for fast output and high quali ty.
However, the accompanying apparatus and four toner cartridges are expensive,
requiring considerable maintenance.
QMS has recently produced the first color laser prin ter that costs less than $10,000.
The ColorScript Laser 1000 retails for $9,999 and can handle regular photocopier
bond paper rather than the more expensive laser bond paper. A recent review in
Macworld rated the QMS 1000 poorly in terms of image quality, but it does produce
documents, graphs, and presentation ma terials well with vivid colors.

+

Dye sublimation: Dye sublimation printers produce smoothly finished, photographic quality prints without the tiny dots th at you see with o ther printers. The
process of sublimation involves using transparent inks that are converted from
a solid substance into gas. The pigment gets abso rbed by polyester resin-coated
paper. To ensure a continuous tone, dye sublimation printers generally print at a
168 dpi resolution and allow the dots to bleed slightly.
Tektronix's Phaser 480 offers speed, photo-realistic images, and high text quality.
The Phaser 480 costs $14,995, but adding enough memory to pri nt with a full-color
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ribbon brings the price up to $18,880. 3M's Rainbow d igital color proofer is also a
good choice for a d ye sublimati on printer. The Rainbow costs about $20,000. Both
models handle tabl o id-size paper and are idea l for pre-press and high-end publishing purposes.
Letter-size dye sublimation printers cost less. Su perMac's Proof Positive lists at
$7,999, and Tektroni x's Phaser IISDX lists for $9,995, while others in the PC
market have dropped below $1,600.

+

Thermal wax: Many businesses choose these printers beca use they combine good
quality, highly saturated colors, and a fas t speed. Altho ugh thermal wax printers do
require a smooth surface, they o therwise accommodate most paper stocks. Thermal
wax printers can also print o nto a variety of materials other than paper; for example, they are used for making iron-on fa bric transfers.
Thermal wax printers have print heads that press sm all electrical heaters against
the colo red in k ro lls. The rolls transfer dots of wax, one colo r plate at a time, to a
sheet of paper. Due to this process, thermal wax printers ge nerate crisp, highly
saturated colo rs, but they also have a tendency to impart a cartoonish appearance
to objects with solid-colored fills.
Thermal wax printers offer high quality for a reasonable price. Seiko Instruments'
Personal ColorPoint PSE sells for $2,999, and Tektroni x offers its Phaser 200e fo r
$2,995.
Increasing numbers of manufacturers are offering printers that combine the
advantages of multiple printing tech nologies. Tektroni x offers a th ermal wax and
laser printer that produces vivid colo rs and crisply rendered line art images and
text. The Phaser 220i has a 600x300 dpi resolutio n and costs about $6,000.

+

Liquid inkjet: Liquid inkjet printers are good fo r bold, simple graphics and color
accents. Tiny nozzles sq uirt colors onto th e paper as the printing cartridge passes
back and forth over the page.
If you have ever painted in watercolors, you know that applying liquid to paper
deteriorates the paper slig htly, which occasiona.lly makes the colors bleed. Yet new,
quick-drying inks and recent technologies h ave improved the quality of liquid
inkjet printers cons iderabl y. Although liquid inkjet printers perform more slowly
than other types of printers, if you print o nly small q uan tities, you may not notice
the difference.

Some liquid inkjet printers can produce a level of quality that is barely distinguishable from their more expensive cousins. Epson America, Inc. currently offers the
Epson Stylus Colo r Inkjet with a resolutio n of 720 dpi for about $520. HewlettPackard also offers high-quali ty, low-end inkjet printers, such as the DeskWriter
560C, for about $719.
With prices coming down and th e variety of printing technologies available, color printers are
definitely worth the investment.
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WYSIWYG and Color Printers
WYS is not necessarily WYG. Although many color monitors have come close to the
WYS!WVG (What You See Is What You Get) standard, your onsoreen colors may not always
maU;h In print. Your monitor displays colors that use combinations of red, green, and blue
(R<aB) pigments; printing processes use combinations of cyan, magenta, yellow, and black
(CivWK) pigments.
ltyour professional needs include color precision, you should obtain a good color matching
system to match the colors on your screen to the colors printed on your printer. The most
commonly available color matching systems are Trumatch, Focaltone, and Pantone.

Adding Color Without a Color Printer
If a color printer remains beyond your budget, you can use your creativity to add color
manually with ink, press-an type, and clip art. Or you can use transparencies or papers that
already have color elements printed onto them-many companies sell these predesigned
materials. Or you can have your local printer or graphic service bureau create a customized
look.
The following techniques include just a smattering of ideas for adding color to transparent
overheads and audience handouts without a color printer:

+

Design your own: Think of this option as designing company stationery for your
handouts or transparent overheads. A simple, appealing graphic-such as a logo or
even a single horizontal or vertical line-printed in a striking color can jazz up
those black-and-white prints. You can then have multiple copies made by a lowvolume specialist printer.

+

Obtain specialty papers: You can obtain predesigned papers and transparencies
from vendors, sud1 as Paper Direct, Quill, and Premier Papers. Distinctive paper
stocks with exciting designs can add pizzazz to your handouts.

+

Use preprinted graphics judiciously: Ma ke sure that all preprinted graphics are
positioned so that they don't get printed over. To accomplish this, you may have
to adjust your overheads and commit to a specific handout form that leaves space
for the existing graphic. After all, when writing a memo, you wouldn't print over
your company's letterhead, right? Look at the preprinted graphic in the lower-right
corner of Figure 26.8. So that you don't cover up the graphic, you have to position
your slides to the left of the page.
Likewise, choose yo ur colors appropriately: burgundy and cobalt blue create visual
impact but project a reasonably conservative image. Bright, saturated colors, such
as red and yellow, create a more vibrant, youthful image. Or you may choose to
stick with your company's colors.
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Preprinted papers are avai lable in most office supply and stationery stores and can
also be ordered from office supply catalogs.

*

Figure 26.8 An audience handout with a preprinted graphic.

+

Add color manually: Remember coloring books? You can fi ll in your transparent
overheads with colo red permanent markers. Or you can use colored pencils on
handouts so that the color doesn't bleed through the paper. You ca n also eliminate
bullets and ma in titles in your presentation or leave space for graphic elem ents and
then use colored press-an type and clip art.
Make sure that th e press-an type or clip art is translucen t when dealing with color
overh eads because opaque elements appear black. Color press-an type and clip art
are available from most art supply stores. Letraset offers an extensive catalog of
press-an type and clip art.

Help! I Need Color Now!
If there is no printer or graphic service bureau near you, and you are not a creative genius with your own color ideas, don't worry. With a simple phone call, lmageDirect or
Genlgraphics can handle your presentation needs quickly. If you need handouts for your
upcoming presentation, lmageDirect specializes in fulfilling your short-run, color printing
needs. And the company can have your materials delivered to you In a few days. To contact
lmageDirect, call 800-A·Papers.
Genigraphics is a graphic service bureau that can convert your presentation from a disk
into 35mm slides, digital color overheads, large display prints, or posters. To contact
Genigraphics, ca ll 800.638-7348. You can send your flies by modem 24 hours a day and
receive the printed materials overnight. The company also can deliver your materials In a
cost-effective, timely manner.

continues
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PowerPoint makes it convenient for you to work with Genigraphics by including a
Genigraphics Driver and Graphicslink. To install the Genigraphics Driver and Graphicslink
(if you didn't Install them with the original installation), do the following:

1. Run the Microsoft Office setup program.
2. Click the Add/Remove button in the first Setup dialog box.
3. After the Maintenance Mode dialog box appears, select the Tools check box from
the Components Not Yet Installed list on the left.
4. Click the Continue button.
5. After the Install Disk dialog box appears, insert the disk number that is asked for.
6. When the Installation Complete dialog box appears. click the OK button to finish
the installation.

Displaying Presentations from Your Monitor
PowerPoint gives you flexibility in displaying your presentation. Your presentation o utput is
primarily determined by your presentation setting and the equipment available to you.
Important factors to consider are the lighting, the size of the room, and the number of people
in your audience.
The graphics and text on your slides should be clearly visible even to those in the back row.
The last row of your audience should be no farther away than eight times the height of the
projection screen. The front ro w of your audience should be no fa rther away than two times
the height of the projection screen, as shown in Figure 26.9.

Front row=
2 x screen height

I

v(- - - -x·- - - ->%
Figure 26.9 Projection screen/ front row distance ratio .

You also must consider which equipment can be easily obtained. Most companies have
overhead projection and slide equipment available on the premises. Increasing numbers of
businesses also use televisions and VCRs on a regular basis. Overhead projection, slide eq uipment, televisions, and VCRs can also be inexpensively rented.
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Displaying PowerPoint on a computer monitor requires nothing more than a workstation that
meets PowerPoint's specifications, the PowerPoint Viewer, and a disk with your presentation
on it. The PowerPoint Viewer also lets you show your presentations as read-only documents on
other workstations, even if they don't have PowerPoint. This saves you from having to reload
any software. The PowerPoint Viewer exists on its own disk, so you can take it anywhere.
To run a slide show on your computer monitor in the PowerPoint program, simply click the
Slide Show View button or select Slide Show from the View menu. To display a self-running or
repeating display, select Slide Show from the View menu and then follow the instructions in
the dialog box, as shown in Figure 26.10. (For more information on self-running presentations,
see Chapter 25.)

Slide Show
Shov

D

Concol

Figure 26.10 The Slide Show dialog box.

In the following list, I've explained a few ~f the advantages and disadvantages of running your
presentations as screen displays on your monitor:

+

Advantages of displaying on your monitor: This is the simplest presentation
method to implem ent, and you can incorporate animated effects and QuickTime
videos for added excitement. You also don't have to turn off the lights to ensure
visibility, and familiarity with this medium enables you to build audience
interactivity into your presentations.

+

Disadvantages of displaying on your monitor: Th e text and graphics look ragged
along the edges because the computer screen displays them as 72 dpi bitmapped
images. Also, the size an d resolution of even the most high -end computer monitor
limits you to small audiences.

If your company often hosts presentations, you may want to consider investing in a larger
monitor to display presentations more effectively. High-performance monitors are created
especially for graphics and presentation professionals. These professional monitors offer larger
screens, higher resolution, good visual quality, more adjustment controls, and (sometimes)
reasonable prices.
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You can obtain a decen t 20-inch monitor for $1,000-$3,000. NEC offers the 21-inch MultiSync
6Fgp for just under $2,000. Radius also has a good reputation for its display monitors. Of
course, larger monitors are not portable. They often weigh hundreds of pounds.
There are also many less expensive 14-inch monitors that perform well for their smaller size
and cost less than $1,000. Macintosh offers its 14-inch Color Display for $599, and the Sony
CPD-1400 is priced at a couple hundred dollars more. The NEC 4FGE and Nanao FlexScan
F340i also fall within thi s price range.
For those of you who produce large-scale presentations, you may want to consider looking
into monitor banks (sometimes called video walls). Monitor banks consist of a collection of
monitors that are synchron ized with each other for the purpose of multiple displays of a single
presentation. Monitor banks are frequently found at trade shows. Although they require a
costly investment, monitor banks are a highly effective medium for displaying presentations.
When looking for a color monitor, you should take the following factors into consideration:

+

Screen focus: How sharp is the display of images on your screen?

+

Color saturation: How well does your monitor display a wide range of colors?

+

Color bala nce: Are colors displayed uniformly across the screen? Look out for
irregularities and inconsist encies in your color display.

+

Convergence: How closely do the red, green, and blue electron beams come to
the same pixel on your screen? The closer these beams converge, the sharper your
image is. Look for a convergence measurement of 0.45 millimeters or less.

+
+

Distortion: Look for a monitor with minimal d istortion.
Gray linearity: How accurately does your monitor display shades of colors and
grays?

+

Brightness: How high can you adjust the brightness on your screen without seeing
scan Jines? Do not purchase a monitor that outputs less than 20 footlamberts- a
unit of measurement for luminance.

+

Contrast: Look for a high contrast ratio.

Footlambert, Anyone?
A footlambert Is a unit of luminance equal to one candela (a unit of luminous 1ntenslty equal
to 1/6th the intensity of the light emitting from a candte) per square foot or to the uniform
luminance of a perfectly diffusing surface emitting or refleCting light at the rate of one lumen
per square foot. Lumens measure incident light and footlamb&rts measure emitted or
reflected light.
For optimal viewing conditions, the number of lumens per square foOt should equal the
number of lamberts. This ratio ensures a screen that does not absorb ambient light. Got
that?
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Runn ing presentatio ns o n your com puter screen can prove to be the most cost-effective
d isplay m ethod. To run your presentatio n as a com puter mo nito r display, you need the
fo llowing ite ms:

+
+
+
+

A Macintosh workstatio n that meets m ini mum system requirements
A large color monitor
PowerPoint Viewer on d isk
Your presentation o n d isk

Displaying 35mm Slides
To convert your prese nta tio n into 35mm slides, save it onto a d isk as a PostScript file by
selecti ng the PostScript Destinatio n o ptio n o n the Print d ialog box and sending the fi le to your
local graphic services burea u. (For more information about PostScript files, refer to "Saving
your presen tation as a PostScript fi le," earlier in this chapter.) When you wa nt to use 35 m m
slides, be su re that they are set u p with a 3:2 aspect ratio. (For more infor m atio n about aspect
ratios, see Chapter 22.)
To avo id potential problems, ask the service burea u how long it takes to process slides and
whether it has an y slide-formatti ng req uirem ents tha t yo u sho uld be awa re of. Although using
a service bureau does sound expensive, prices are genera lly reaso nable. Unless you develo p
enormo us amo unts of slides, service bureaus cost much less than purchasing your own
expensive conversion equipment.
The advantages and d isadvantages of 3Smm slides are as follows:

+

3Smm slide advantages: Slide shows generall y impress audiences because visually,
3Smm slides d isplay an un pa ralleled crispness and richness of color. Yo u can show
slides to large aud iences, depending o n the size of the projectio n screen. By
plann ing your material well, you can even reuse man y of your slides (such as a
picture of the chairman of the board givi ng an address) fo r yea rs befo re their colors
begin to fade. Slides have the advantage of easy storage-th ey do n 't hog up disk or
closet space and are easy to o rga nize and ca rry around . In add itio n, most conference sites are equipped with slide projectors and screen s, o r th e eq uipm ent can
easily be ren ted.

+

35mm slide disadvantages: Using 3Smm slides does require advance planni ng
and preparatio n . They do not allow for the sense of motio n and interactivi ty
inherent in other presentatio n for mats. And in order to display slide shows, the
room must be dark, w hich means that you canno t interact extensively with your
audience, no r ca n they fo llow along with yo ur presentatio n handouts or take
notes.
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Displaying slides takes considerable preparation but provides worthwhile results. To run your
presentation as a 3Smm slide show, you need the followi ng items:

+
+

Slide carousel and projector
Slide projection screen
for screen size, remember this rule of thumb: the distance between the last row and
the screen should be no more than eight times the screen's height, and the distance between the front row and the screen should be no less than twice the height
of the screen .

+
+
+

Extra bulb
Extension cords
Darkened room

Displaying Transparent Overheads
To display your presentation as transparent overheads, simply use the color or black-and-white
transparent overhead templates. (For more on templates, see Chapter 24.) PowerPoint automatically sets up transparencies to fit the size of standard overhead projectors, approximately
10 x 7 1/2 inches, which reflects a 5:4 aspect ratio.
To produce transparent overheads from your printer, load your printing tray with transparent
sheets, select the Print command from the File menu, and then select Slides from the Print
What pop-up menu in the Print dialog box. If you want to print color overheads, but you have
only a black-and-white printer, save your presentation as a PostScript file and send it to a
service bureau for color printing.
Caution: When printing transparencies, make sure that the clear sheets you

•

•

use are compatible with your printer. If they are not, don't use them- they
will jam in your printer and melt down .

'

The advantages and disadva ntages of transparent overheads are as follows:

+

Advantages of using transparent overheads: Transparent overhead presentations
are oldies but goodies. This format has proven effective with both large and small
groups. This display method allows you flexibility and enables you to interact
readily with your audience. Transparent overheads are inexpensive and simple
to produce. In addition, transparent overhead projection equipment is easy to
obtain-most companies have this equipment on the premises.

+

Disadvantages of using transparent overheads: Transparent overheads do not
deliver the sense of professionalism nor the visual impact of a slide presentation.
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The overhead projector and the transparencies them selves can be cumbersome to
haul around. An hour-long presentation at two-minutes-per-frame's worth of
transparencies can fill an entire briefcase.
Using transparent overheads as your output format is a simple, low-tech m ethod for creating
effective presentations. In situations where you can't count o n the darkened room (required
fo r 3Smm slide shO\·vs), or the aud ience is too large for displaying your presentation o n a
computer monitor, transpa ren t overheads can save the day.
A presenter often must h1ss with transparent overheads to get them properly aligned and keep
them properly ordered. To minimize this problem, o rganize them into trays-a "to be shown"
tray on o ne side of the pro jector and a "has been shown" tray o n the other side of the pro jector. This little bit of organization ensures greater fluidi ty in your presentatio n .
Transpa rent overh eads may no t be as slick as more technologically adva nced presentatio n
methods, but their adva ntages sometimes outweigh modern technology. To run a presen tation
with transparent overheads, you need the following items:

+
+
+
+
+
+

Clear transparent sheets that are compatible with your prin ter
Transpa rent overhead projector
A screen or light-colo red wall
Extra bulbs
Ex tensio n cord
Po in ter (never use your finger!)

PowerPoint on Television:
Displaying with Video
Many presenters use video as a fo rmat for displaying thei r presentations o n an ordinary
television screen. You can either have a service bureau convert your slide show from disk to
videotape, or you can hook your com puter up to a television screen. If you choose to display
in th is format, however, please keep the following in mind: the aspect ratio for di~p l aying
presentations on a television screen is 4:3.
Keep the following in mind as a rule of thumb: when discussing aspect ratios and measurements, the first nu mber always refers to the horizo ntal measurement .
Because of this particular aspect ratio, the televisio n screen cuts off the edges of your frames
when displaying your presentation by video. Th is may prove adva n tageous in some situations
(like watching the news on TV) because it also increases the size of images; however, it can
prove ann oying when it cuts off part of the titles and bulleted points in you r presentation.
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The television screen also does not offer the higher resolution available on your computer
monitor. In addition, the television displays images as alternating scan lines (rather than
colored dots), which magnify the horizontal linear elements on your Macintosh screen and
cause them to flicker annoyingly. This problem can be minimized by using PowerBooks for
your video source, whose monitors have a liquid crystal display rather than the usual cathode
ray tube display.

+

Advantages of presenting on video: Video easily incorporates motion and special
effects and offers the flexibility of producing interactive presentations by outputting VCR tapes from your computer. Video allows more portability than onscreen
presentations because the necessary equipment is widely available, as opposed to
lugging around a huge monitor. Video equipment is also cheaper to rent or buy
than many of the computer-generated options.

+

Disadvantages of presenting on video: The video format limits your graphic
capabilities. Converting your presentation to videotape so that you can present on
an ordinary television screen and then dish·ibute copies requires a higher turnaround time. You also lose the flexibility of interacting with and customizing your
presentation. Generating video presentations from your computer requires a
certain amount of technical expertise to ensure that all the conversion, output
elements, and colors are compatible to the video format.

Caution: Do not attempt to do interactive presentations by using videotape.

•

•

Stopping, starting, and pausing your videotape on a co nstant basis
quickly damages t he videotape and the VCR-and bores your audience .

'

Designing PowerPoint video slides
When designing your frames for video in PowerPoint, you should customize your slide setup
to reflect a 4:3 aspect ratio. Your templates automatically ad just. When activated, the
AutoLayout feature al so takes the customized sizing into account; however, you may have to
adjust the layouts that you have already created in another aspect ratio.
Use bold, sans-serif typefaces for your text; simple, high-contrast images for your graphics; and
uncomplicated color schemes for your templates. (For more on graphics, see Chapter 24.)
When preparing for a presentation in video format, you can use PowerPoint's templates for
color transparent overheads to ensure a bold and sim ple design and color scheme throughout
the video slide presentation.
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Hooking up the television to your Mac
To generate a video presentation, you can send your presentatio n to a service bureau fo r
conversion to a VCR tape. Then you can use any ordinary TV/VCR hook-up . Or you can
generate interactive presentatio ns by directly hooking up your computer to a television . To
hook up your computer to a televisio n, yo u need the co rrect jack on your TV and a computerto-TV converter box. Converters let you connect either standard TVs and VCRs o r the higher
quality S-Video TVs and VCRs.
When loo king fo r a conversion unit, there are several concerns that you need to consider. If
yo u often present in foreign countries, m ake sure that your converter unit is compatible with
the European televisio n standard (PAL). Make sure that th e unit you buy is compatible with
your Mac- many of these converters are gea red more toward PC users, and their jacks don' t
plug into Mac-style monitors, which m eans that you have to figure the price of a jack into
your budget. You also need to take brigh tness and contrast adjustment capabili ties into
consideration, along with features that co mpen sate for televisio n's tendency to cut offor overscan- the edges of your image.
There are many computer-to-TV converters available, and the prices ran ge from $200-$450.
The MediNet Encoder sells for a mere $159 and has adeq uate features. Focus Enhancement's
L-TV goes fo r $299 with a Mac monitor jack. The L-TV offers technical support, compactness,
brightness controls, compatibility with the European television standard, and a Sq ueeze
system extension to make up for TV's overscan problem.
To convert your PowerPoint slides to a video fo rmat and show them o n televisio n, you sho uld
have the following items:

+
+
+
+

Televisio n with a round RCA input jack or an S-Video jack
Conversio n unit
jack hookup that accommodates a Mac-style mo nitor
Adj ustments for brightness, contrast, and overscan

Displaying with Liquid Crystal Display (LCD)
Pane ls and Projectors
LCD prod ucts are ideal fo r the presenter who travels a lo t. LCD panels and pro jecto rs display
clear images that rival slides in quality and portability while also allowing th e speaker to
in teract with the presentatio n. Many also come with sound and m icrophone capabilities.
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Liquid crystal display devices are currently the only commercially available flat panel technology that displays full color. They reflect light rather than emit it, as the more commonly used
cathode ray tube (CRT) technology in your computer monitor does. LCD technology eliminates the problems of flickering lines, which plague presenters who use electronic display
methods. However, anyone who uses a PowerBook with the LCD monitor can tell you that
these display devices tend to reflect images and light, which can be distracting to the viewer.
LCD products for medium-sized conference rooms with a 6- to 10-foot screen (measured
diagonally) cost $3,900-$9,000. For around $1,000 more, you can buy an LCD for larger
projections geared toward audiences of up to 200 people.
LCD panels and LCD projectors are compared and contrasted as follows :

+

•

LCD Panel: An LCD panel is about the size and weight of a PowerBook, which
makes it easy to carry around. To run your PowerPoint slide show, hook the panel
up to the video port on your hard drive and then place the panel on an overhead
projector. This setup requires a transmissive overhead projector, which illuminates
your panel from below. Boxlight offers a decent LCD panel, the ProColor 1500, for
just under $4,000. A recent review in Macworld also gave a high rating to View's
ZllS . The Zl15 is available for $5,495.
Caution: LCD panels tend to overheat, which can resu lt in presentation
disasters. To avoid overheating, use metal·halide bulbs instead of
incandescent ones in the overhead projector. Also, be sure to rehearse
your presentation to ensure t hat the LCD panel holds up for the duration.

•

'

+

LCD Projectors: An LCD projector works the same way as an LCD panel; however,
you don't need an overhead projector. Having one less item to worry about may be
worth paying more. LCD projectors are also portable. Although they weigh more
than the panels, they weigh less than the combined weight of a panel and overhead projector. The Proxima projector is easy to set up, delivers good image
quality, and offers a cordless pointer system called Cyclops. The Proxima retails
for $10,795 .

When ru nning your PowerPoint presentation with an LCD panel or projector, darken th e
room to minimize ambient light (LCD images fade even more than 35mm slides when the
room isn't dark enough). Make sure that the room is well ventilated because LCD products are
susceptible to overheating. Also, keep your text and graphics as close to the center of your
frames as possible. LCD displays tend to dim along the edges, especially in the upper corners.
Also note that LCD panels and projectors that enable you to make your presentations without
bringing your computer along, such as InFocus's Lite Show, are currently available. That
sounds wonderful; however, you have to print your slide show to the appropriate printer
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driver and save it onto a DOS-formatted disk. Not only do the words DOS-formatted disk make
most Mac users cringe, but you Jose your ability to control and interact with your presentation. This being the case, you might as well present on video because it costs less.
The wave of the future for computerless presentations may be Sharp Electronics' QA-1500
panel, wh ich can run presentations on Type III PCMCIA cards. Mac drivers for these cards will
be widely available by the end of 1995.
To use an LCD panel o r projector, you need the following items:

+
+
+
+

LCD panel and transmissive overhead projector, or an LCD projector

+

A beaded projection screen, if possible, which displays the clearest images with
LCD projectors and panels

Your computer
A video card and port
An adapter that lets you con nect with video and sound sources directly (Most LCD
panels and projectors come with this kind of adapter, but some need an adapter
that can cost up to $1,600.)

LCD products still ha ve a way to go before they can match the high display quality of slides.
However, LCD panels and projectors combine the advantages of large screen projection and
computer display interactivity. For the presenter who travels often and addresses medium to
large audiences, LCD panels and projectors can prove invaluable.

Deciding Which Presentation Format to Use
Deciding which presentation format to use can be more overwhelming than creating the
presentation itself. When making decisions about presentation technology, you should
consider the size of your audience, where you will be giving most of your presentations, what
eq uipment you already have ava ilable, the purpose of your presentations, and your budget.
Factors in deciding which presentation equipment to purchase include the following:

+

Audience size: Remember that your presentation must be visible to people in the
back of the room. If you regularly present to large audiences of 100 or more, a slide
projector would be your best bet. If interactivity is a must, then consider th e
higher-end LCD panel or projectors that display images large enough for audiences
of 200 people.
·
With medium-sized aud iences of 50-100 people, slide and transparent overhead
projectors or standard LCD panels and projectors are ideal. With sma ll audiences,
your options increase. Video and computer screen displays let you contro l your
presentation and add special effects, and the equipment required is less expensive
than LCD panels and projectors.
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Audience makeup: What audiences do you usually present to? Gatherings of
colleagues or long-time clients are generally less formal. Less formal presentations
don't need high levels of technology, but they should allow you and the group to
interact with your presentation. Computer screen presentations and transparent
overheads perform well in these situations.
If you are presenting to students or trainees, your presentation should project m ore
authority yet allow for audience note-taking and questioning. These conditions
rule out slides and LCDs, which require a dark room . With formal presentations,
slides and LCDs give a professional impression. But if the presentation site does
not provide accommoda tions for darkening the room, videos, computer monitor
displays, or even transparen t overheads can convey a sense of polish.

+

Budget: Computer screen and transparent overheads are the least expensive ways
to output PowerPoint presentations. Slides can also be produced and shown
relatively inexpensively-especia lly because many companies and presentation
sites already have the equipment available.
Investing in video output equipment costs a bit more but can pay for itself if being
able to copy and distribute your presentations easily is advantageous. LCD panels
and projectors require the greatest investment, but their portability makes them
indispensable to the presenter who frequently travels.

+

Location: Where will you be presenting yo ur material? Computer screen displays
are also ideal for trade shows-motion and special effects catch the attention of
passersby. After you gain their attention, they can then peruse the presentation at
their leisure, or they can allow you to sh ow them slides as they ask questions.
Will there be light in the room? If so, LCD panels and slides are out of the
question-you are better off using transparent overheads for midsized audiences or
video and computer screen displays for smaller audiences. Does the location offer
the facilities you need for setting up your equipment? Electrical outlets, available
equipment, and other such detalls must be checked out as you make your presen tation decisions.

+

On-site or off-site: Do you generally give presentations at other companies, or do
you give your presentations on-site? If your company often hosts presentations,
then investing in a larger display monitor for computer-generated presentations
would be worthwhile. If you travel frequently, then LCD panels and projectors
with PowerBooks offer ideal presentation solutions.
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When selecting presentation eq uipment, do your ho m ework. Make a list of features that are
important to you. Read product reviews in trade magazines and ask other presenters what they
use. Ask a lot of questio ns and test out you r eq uipment before you buy it. Purchase the highest
qua lity eq uipment your budget allows. You will have to use this equipment frequently and in
situations that are often less than ideal, so make su re that you are comfortable with the
equipment.
You should now be familiar w ith basic presentation output. If you at least know how to print
supporting materials and choose the pro per venue for your presentation, you can make it
through your fi rst simple presentation. Wh at about multimedia possibilities? The next chapter
takes you one fina l step in ex ploring the possibilities that are avai lable to you in making you r
p resentations state of the art.
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In addition to offering an ail-in-one package for organizing, scripting, designing, and laying
out slide show presentations, PowerPoint also offers multimedia capabilities. With PowerPoint,
you can create added interest in you r presentations by adding QuickTime videos, sound, CDROM clip art, and digitized photographs. In this chapter, you get an overview of how you can
use PowerPoint with multimedia for presentations that will be the talk of the town. This
chapter covers the following topics:
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What Is Multimedia?
This chapter is designed to give you a broad overview of how PowerPoint's suppo rt fo r multimedia can enhance your presentations. If you want to learn about using multimedia in greater
detail, a good place to start is with the Multimedia Starter Kit for Macintosh, by Michael D.
Murie, also published by Hayden Books.
Multimedia is like that o ld tale about the emperor's new clo thes: the entire kingdom was abuzz
about the emperor's wonderful new o utfit, but no one-for fear of appearing unfashionable or
ignorant-would admit that the emperor was parading around naked. Nowadays, multimedia is
the emperor. Everyone keeps talking abo ut it, and you keep seeing the word mentioned in the
publications you read, but no o ne seems to know exactly what it means!
But don't get intimidated by a m ere buzzword. Multi, as you know, is a prefix that means
"many," and the word media sim ply refers to the m aterials that are used to create works or the
means used fo r communicating these works to others. For example, Leonardo da Vinci used oil
paint as his medium for creating the Mona Lisa (see Figure 27.1) and canvas as his medium for
enabling o thers to view it. Today, I have used ink and paper as the media for communicating
this image to you (ironic, isn't it?). Television, radio, film, and publications are referred to as
"the media" because they represent the means by which images, music, art, wo rds, and ideas
are conveyed to others.

Figure 27.1 The Mona Lisa in ink and paper.
The art wo rld bega n using the term multimedia as 20th century artists began creating no ntraditional works that mixed materials that weren't supposed to be mixed together. Some confused
curato r or perplexed art reviewer was probably frustrated at not being able to describe a work
of art simply as "the o il painting" or "the marble sculpture." And dada! The term m11ltimedia
was born (darn th ose Dada-ists). Multimedia is likewise used by arts writers when describing
performances that mix so many elements that they canno t be pigeonholed into such set
categories as a play, a dance piece, or a film .
Now you not only know what mu ltimedia m eans, but you will also be creating it yourself. And
your med ia will consist of your Macintosh, PowerPoint slides, sound effects, and QuickTime
videos.
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Why Use Multimedia?
PowerPoint's multimed ia capabilities enable you to add sound and motion to your presentations. Nowadays, people are barraged with so much in fo rmatio n that it is difficu lt to remember anyth ing. So how do you make your aud ience rem ember your presentation? QuickTime
video clips, sound effects, and exciting images help yo u grab yo ur audience's attentio n and
keep it riveted to your scree n.
People will remember the information that you are commun icating if you present it attractively and dynamically and if you can make your points personally relevant. A strategically
placed burst of motio n o r sound in an otherwise still series of slides will make a las ting
impressio n on your audi ence. W ith the proper image o r sound reco rd ing devices, you can even
reco rd and add perso nalized footage to your presentations right o n the presentatio n site.
You can put PowerPoint's mu ltimedia capabilities towa rd the fo llowing uses:

+

Trai ning: Many corporat ions are beginning to use mu ltimed ia presentatio ns for
employee training purposes. The employees find that being able to learn an d
review info rmation at their own pace increases m em o ry retention. In the mea ntime, employers find that after the initial investment required, using multimedia
presentations is cost effective.

+

Demonstrating ideas a nd processes: Communi cating com plex information has
always been d ifficu lt to do with words. Now, instead of using several slides to
explain an involved process, you can add a Qui ckTime video clip that actually
shows people how a process works.

+

Perso n a lizing presen tation s: People are always more receptive to information
that d irectly relates to th em. With the p roper recordin g devices, you can insert
QuickTim e video clips containi ng o n-site footage. Fo r example, foo tage of your
host's own receptionist getting swamped with pho ne ca lls can go a long way
toward convincing your host to try o ut your company's voice mail system .

+

Grabbing atten tion : Even if you lack record ing equipm en t, you can use exci ting
soun d and visual effects to grab attention . A CD-ROM d rive also gives you access to
a wide range of images that take up too much disk space to store ordinarily o n your
ha rd d rive.

+ Letting p eople explore your presen ta tio n : You can use m ultimedia effects to
create convincing presentations that viewers can peruse at their leisure. This gives
people o ppo rtu nities to explo re your prod uct or ideas. In teractive presenta tions can
be used fo r ki osk displays, o r for an initial investment, they can be stored on CDROM discs and sent to potential clients.

+

Having fun: And last but not least, your PowerPoint presentations will be more
fun to create and watch when you add mu ltimedia.
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Incorporating multimedia elements in your PowerPoint presentation also gives you a cutting
edge over your competitors' presentatio ns-or at least enables you to keep up. Make no
mistake. Multimedia presen tations are the wave of the future and pretty soon everyone will
be using them. So why not be o ne of the first?

What Do I Need to Run Multimedia?
Multimedia computer displays used to be the domain of highly technical professio nals,
including industrial modelers, engineers, and ani mators. Then Ind ustrial Light and Sound
made headlines for creating and an imating the scenes and critters for Steven Spielberg's
Jurassic Park while the actors filmed on blank sets. Now, all of a sudden, everyone's talking
about multimedia. Are you worried that while everyone else goes whizzing down the information superhighway, you'll be left in the dust? After all, running videos and creating sound
effects must be pretty complicated ....
Don' t worry abou t that. The Mac's multimedia features are easy to install and use. If you want
to create extremely complex interactive displays with hig h-end graphics, then yes, you would
need some sort of specialized tra ining. But anybody ca n record, digitize, and run a simple
QuickTime video in a PowerPoin t presentation.
Most Macs currently on the market have the compo nents already installed for using multimedia, or you can easily and inexpensively upgrade your computer. To play back mul timedia
productions, you need a machine with color capabilities, a 13-inch or larger color mo nitor,
and 5MB of RAM o r more. Creating multimedia presen tations requires a greater investment.
The Power PCs are currentl y your best bet, although the Quadra 630 is a good entry-level
choice. If you plan o n working with videos often, then you should at least go with th e Quadra
650 o r above.
To create multimedia presentatio ns, you sho uld look into the following:

+

Memory: You need at least 8MB of RAM. Many professionals are now advising
that new buyers should settle for no less than 16MB of RAM (this advice is not so
o utrageous con sidering that it takes 8MB of RAM to run Microsoft Office alone).

+

Hard drive: You need at least 200MB of free d isk space. We' re talking free disk
space, as in how m uch d isk space you have left after installing your applications.
You also need a hard d ri ve that can access and transfer data fast eno ugh to create
and run multimedia.

+

System 6.8 or higher: To create and run mu ltimedia presentations, System 6.8 is
adequate, but you should rea lly upgrade to System 7.5, which offers better support
for video and sound .

+

Video card: Most current Macintosh models come with a video card built in.
However, depending on your needs, you may need to upgrade. Mass Micro offers
a 24-bit NuBus video card for less than $100, and o ther video cards are available
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fro m va rio us ma n ufacturers. If you want to create QuickTime videos, you also need
more video equip ment and hardware.

+

Video m emory ( VRAM) : Most Macs are coming o ut of the facto ries with at least
1MB of VRAM. Th is lets your computer support 16-bit color (32,000 colo rs), which
is necessary for viewing QuickTime videos. Alas, the video memory is not expandable, and if you want more VRAM, you have to get a new video card fo r your
processor d irect slo t.

+

Colo r ca pa bility: You need support for at least 16-bit colo r fo r viewing videos and
24-bit color (16 million colors!) for image processing. If you need to upgrade your
colo r ca pabilities, you can purchase a new video card. Unless you frequently work
with pho tographic images, 16-bit color should be adequate. QuickTime video runs
only with 16-bit color.

+

13-inch o r la rger color m o nitor: To work with d igitized video o r animated
images, you need a reasonably sized monitor. In additio n to th e d isplay moni tors
mentio ned in Ch apter 26, Nanao USA announced a new lo wer-cost line of d isplay
monitors slated to be dist ributed by the spring of 1995 .

+

Storage: Multimedi a presentations take up a lot of disk space. Even if you compress
them , th ey generall y are too big for a normal floppy disk. SyQuest removable hard
d rives are popular, and they let you save files onto cartridges that hold 44MB to
270MB of info rma tio n . You can purch ase them th rough various distributo rs. A
270MB SyQuest drive sells fo r about $600. The cartridges cost between $65 and
$120, depending o n the amount of disk storage space.
Ma ny people also use the Berno ulli drives. The Bernoulli 230 d rive sells for about
$499. The cartridges cost around $100. Although SyQuest d rives are mo re common
than Bern oulli d rives, Bernoulli often offers a better price. Some people also prefer
Berno ulli beca use the d rives are all made by the o riginal manufacturer; whereas,
SyQuest allows an array of com panies to make the d rives and slap the SyQuest label
o n them.

+

CD-ROM d rive: CD-ROM d rives store up to 600MB of informatio n, which gives
you access to large collection s of info rmation and images that are ava ilable on CDROM d iscs. Alas, CD-ROM discs are read-only, meaning that you can't save files
onto them. Many recent Mac and Power PC models come with CD-ROM drives
already buil t in. If not, you can have o ne added fo r less than $300.

+

Audio Equip m en t : All Macs come with a mono speaker, which lets you play back
sound. Recent models, beginning with the Mac LC and !lsi, also incl ude digitizing
hardware to en able you to record sound, altho ugh you m ay have to purchase a
microphone.

The Quad ras and Power PCs are constructed so th at you can easily get inside of the hard drive
and insta ll man y hardware upgrades yourself, as shown in the diagram in Figure 27.2. While
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building up your multimedia system, you should also consider purchasing digitized image and
sound recording devices. These devices give you a greater range of options when you use
sounds and images in your Power Point presentatio ns.
lVIdeo In Slotl
lDRAM SIMM Slot

I

~

0

DRAM

DODD DODD
030 Compalible expansion slot
Communications slot

Figure 27.2 Diagram of a Quadra 630 's innards.

How Does PowerPoint Fit In
with Multimedia?
PowerPoint was created primarily as a slide presentation program, w hich limits its mul timedia
capabilities. However, you can design a series of frames that are shown in a particular seq uence
and then insert QuickTime video clips or sound clips on particular slides. Altho ugh you can
build in a certain degree of con trol and interact ivity for your presentations, PowerPoint was
not intended to offer a full-fledged professional multimedia authoring environ ment.
Common multimedia development environments include presentation, interactive presentation, authoring, animation, three-dimensional modeling, and video editing software. Here's
just a brief look at what's out there if you need more multimedia capability than PowerPoint
can give you:

+

Presentation programs: Presentation progra ms, such as PowerPoint and Persuasion, suppo rt sound and QuickTime video but are oth erwise limited in their
mu ltimedia capabilities. Alas! PowerPoint on the PC does let you lin k different
slides and presentations togeth er, thereby allowing a degree of control and
interactivity that is not yet ava ilable on the Mac. But keep o n the wa tch for these
capabilities when a new PowerPoint release comes o ut.
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+

Interactive presentation programs: Interactive presentation pro&rrams, such as
Gold Disk's Astound, enable you to add buttons so that viewers can choose different paths and interact with you presentation . Interactive presentation programs
also enable you to create animated charts and graphs from within the application.

+

Authoring programs: Authoring programs, such as Macromedia's Director, let
you develop complex interactions between your presentation and the viewer by
enabling you to write scripts. Creating scripts involves using a low-level programming language that tells the program what you want it to do. Authoring programs
enable you to create almost any type of production imaginable.

+

Animation programs: Animation programs enable you to create objects and make
them move or change shapes. Animation sequences generall y involve simple
drawings rather than video images, which enable them to play more easily and
take up less disk space than QuickTime video clips. This makes animation a good
choice for adding motion to displays. Unfortunately, unlike QuickTime, which
also supports sound, synchronizing animated images and sound effects is a highly
difficult process. Now some animation programs allow you to save sequences in a
QuickTime video format, which enables you to import and run an imation clips on
PowerPoint slides.

+

Three-dimensional (3-D) modeling programs: These programs are used by
architects and engineers to create precise three-dimensional blue prints. Threedimensional modeling programs make the planning process easier, and they enable
viewers to anticipate potential problems. Limited animation features are also
included in many 3-0 modeling programs to enable users to view the model from
different angles a nd perspectives. Most animation and 3-0 modeling programs
perform complex mathematical calculations, and therefore, they require computers
that include a floating point unit.

+

Video editing programs: QuickTime is a simple example of a video editing
program. With video editing programs, you can not only digitize videos and run
them on your computer, but you can cut, resequence, edit, and retouch frames, as
well. Adobe Premier is an example of a popular advanced digital video editing
software program.

In a way, presentation, an imation, and video editing software packages work along sim ilar
lines. All these programs enable you to create and sequence images in a series of frames.
Although PowerPoint's capabilities seem limited compared to the other types of software that
you just read about, don't think of it that way. Instead, look at PowerPoint as a highly useful
program that is easy to learn and that lets you begin exploring multimedia. With PowerPoint,
you can use QuickTime video and sound effects to jazz up your slide shows and to illustrate or
emphasize particular points.
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How Does a Quicklime Video Work?
QuickTime is a Macin tosh program that enables you to work with digitized video sequences
onscreen. It comes with your system software if you have System 6.0. 7 o r higher. With
QuJckTime, you can easily edit, manipulate, fo rmat, and save videos.
Back in the old days, you had to sto p your presentatio n and turn on the VCR if you wanted to
incorporate live footage into your presentations. Ordinary people couldn't run d igitized video
on their Macs because doing so requi red enormo us amo unts of memory and disk space, alo ng
with the ability t o synchro ni ze images and sounds.
Now you can easily use videos in your PowerPoint presentation s. With QuickTim e's compressors and timing features, along with the mo re powerful machines currently available to
consumers, almost anyo ne can own a computer that enables you to play a video.
Of course, Q uickTime does have its li mitations. QuickTime displays videos at 16 fps (fra mes
per second), which gives images a jerky quali ty. And your videos do n 't fill the entire screen,
like your presentation does. Instead, the QuickTime window fills only a portion of yo ur screen .
Needless to say, this can be annoying when addressing large audiences. Fortunately, new
technologies are changing this size limitation. Be on the lookout for new video cards that run
your videos at a faster fram e rate and a larger size. But for presentation purposes and sheer fu n,
QuickTime offers an effec tive medium.
Apple currently has a version of Qui ckTime that can run on Windows with the PCs, and
Microsoft currently has its own player applicatio n called Video for Windows, which h as
many of Qui ckTime's features.

What do you need to run a QuickTime video?
Purchasing video equipment can run in the thousands of dollars, but it doesn't have to. If you
plan on incorporating QuickTime videos into your PowerPoint presentations, you sho uld take
your needs into consideratio n. Does you r company have an audiovisual department that can
provide you wi th digitized videos? Your Macintosh probably has everything you need to run
videos that have already been digitized .
To play QuickTime videos, you m ust have the following item s:

+

A color-capable Macintosh (such as a Macintosh II, LC, SE/30, many PowerBooks,
Centris, Quad ra, and Power PC models)

+
+
+

System 6.0. 7 o r higher
Colo r QuickOraw
An applicatio n, such as PowerPoin t, that supports QuickTime videos
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Chances are that if you were able to install Microsoft Office 4.2 on your computer, you can
also run QuickTime video.
If video digitizing eq uipment is beyond your budget and you need footage, try CD-ROM. You
can order stock video clips on CD-ROM from companies like Four Palms Video, wh ich offers
an array of titles for $99.99 per CD; or the CD-ROM Warehouse, which distributes various
titles starting at $99 per CD. Other companies, such as Media-Pedia offer interesting video
footage ranging from $195-$495 per tape, but you still have to digitize the videos.

What do you need to create your own video?
If you must create your own videos, then you need to take more into consideratio n. Being able
to run videos is all fine and good, but that doesn't help you jazz up your presentations unless
you have relevant video footage ava ilable. After all, the main point of running videos in
PowerPo int is to personalize your presentations. In o rder to fully reap the benefits of running
QuickTime videos on your slides, you should begin recording and digitizing your own videos.
If all you need are a fev., good-quality video clips, and you have no ambition to be the next
r:ellini, then there's no need to spend large amoun ts o f money. If you will be using video only
fo r PowerPoint presentations, then high-end video equipment sh o uldn't be necessary. If, on
the other hand, you need h igher-qual ity videos so that you can use t hem for other purposes,
then you may have to spend more.
One of the best products I have run across is QuickCam. All you need to do is purchase
Connectix's QuickCam, hook it up, and start making videos. It's th at simple. And it costs
on ly $1 10!

The Incredible QulckCam
The QuickCam is only a little bigger than a golf ball. It captures grayscale images at 16 fps,
and you can take still pictures with it, too. {Rumor has it that Connectix is working on a color
QuickCaml) It comes with a cable so that you can hook It up to your printer or modem port,
and it comes with utilities for grabbing frames and recording videos. You can use the
QuickCam with any Mac that supports QuickTime video.
QuickCam·s images are of reasonable quality, too. Your only limitations are the fixed focus
lens {which you can actually adjust, but you have to take the camera apart) and the fact that
QuickCam needs to be attached to your computer. Nonetheless, using QuickCam is a fun,
easy, and inexpensive way to begin making digitized videos. Your QuickCam can be portable
if you use it with a PowerBook (not a Duo)-no presenter should be without a PowerBook.
When it comes to setting up your computer for creating videos, you will spend the most
money on purchasing your video source and your video digitizing board. QuickCam saves
you money by capturing images and digitizing them, too.
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lf you need greater flexibility, colo r output, o r a higher standard of quality than the QuickCam
can provide, then yo u will need a video recording device, a video source, video digitizing
board, sound digitizer, compatible software applicatio ns, and S-video cables. If you will be
doing a lo t of video work to go with your PowerPoint presentation s, and you haven 't purchased a com puter yet, we wou ld high ly recommend the Quadra 660AV o r the 840AV. Bot h
of them offer 16-bit audio and 16-bit video capture and fast ha rd d rive performance.

To create digital QuickTime movies from a video, you wiJI need the following items:

+

Video source: The video source reco rds the initial movie. You can use a VCR or
laser disc player. You can also use a camcorder as a video source. When choosing
a videota pe, use the Super VHS (SVHS) or Hi-8 tape formats. They offer S-video
output, which is com patible with digitizing formats. If you don't already have a
video so urce, try the Sony EV-C100 Hi-8 recordi ng and playback deck, wh ich costs
less than $500 and offers a high level of quality.

+

Video digitizing boa rd: A video digitizing board is insta lled externally, and it
converts the video signal to a digital image. Altho ugh the best digitizing boards can
cost over $3,000, the MacV ision Video Digitizer 4.1 offers an entry level price at
$199 and caphtres high-quality gray-scale images. The midrange SuperMac Spigot II
is a po pular system that offers the ability to produce decent quality videos for $750.
However, SuperSpigot IT's v id eo~ do fall sh o rt of the full-resolution image quality
offered by Radius's Video Vision. Many of the video digitizing boards also com e
with their own software fo r capturing and editing videos. (Keep in mind that a
recording video digitizing board is not the same thi ng as a video card. To play o nly
videos, you need just a video card.)

+

Sound digitizer: If yo u wan t to record sound, you sho uld purchase a video d igitizer that includes a sound digitizer. Rad ius's Video Visio n lets you record so und as
well as video and costs $1,999. Video Vision is a complete video system with an
array of features, including full-screen displays. As a less expen sive choice, you m ay
want to look into Sigma Design's MovieMovie fo r $349.

+

Compatible applications: You need an applicati o n that is compatible with
QuickTime and your digitizing board.

+

Cables: If you use the wrong kind of cable, no thing will happen. You can' t go
wrong if you use S-video cables.

What Kind of Quicklime Videos
Should You Make?
After you have everything you need to create your own QuickTime videos, your possibilities
will be endless. For example, you can create stock footage that everyone in your organ ization
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can use for various purposes as well as footage that relates to a particular conference you are
attending. You can even start a useful QuickTime fi le by saving your footage onto SyQuest
cartridges, labeli ng them, and saving the cartridges by category.
Below are some ideas on how to incorporate QuickTime videos into your presentations:

+

Film the front lobby: All employees like to fee l that their office is an important
place or that the conference they are attending is important. Stand in the lobby of
your presentation site in the morning or during lunch while everyone is rushing
around. You are guaranteed to obtain video footage that conveys a flattering sense
of bustling impo rtance. You can also show how busy your own company is with
this type of footage.

+

Sh ow people worki ng: You can either use footage of people working to give
audiences an idea of h o~ your o rganization works or show how your idea or
product has helped others work more effectively.

+

Tell a story: You can use before and after scenarios to dem onstrate d rastic improvements or to in ject a sense of humor by exaggerating the "before" situation.

+

Evoke previo us successes: Use footage of your o rganization 's president accepting
an award, a testimonial fro m someone your organization has helped in the past, or
a festive, cheering crowd as proof of the effectiveness of the prod ucts, services, or
ideas that you are presenting.

+

Tie in you r a udience's goals w ith your goals: Show footage of your host's
chairman giving a talk about future goals and explain how you can help the
audience meet these goals.

Eventually, you will assemble a library of stock footage that you can tailor to your presentation
needs. Video cameras are easy to use, so have fun and be creative.

•

Caution: Digitizing video is an easy process, but it can also be a lengthy one.
Allow a full day for digitizing your video footage. You won't have to hang
around and digitize all day, but your computer will.

•

'

How can you make your videos better?
A well-organized QuickTime video library with a wide assortment of videos to suit every
occasion is a valuable presentation tool. You don't have to have amazing film skills or highend equipment to create footage of a decent qua lity. There are plenty of video recording
devices on the market that are designed so that anyone can use them . But you should plan
carefully and wo rk on your camera skil ls.
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To ensure that you will always have just the right film footage for your PowerPoint presentation, do the following:

•

+

Purchase a SyQuest or Bernoulli drive a nd cartridges: I mentioned SyQuest
and Bernoulli earlier in the chapter, and I'm mentioning them again because
QuickTime videos take up a lot of disk space. They don't fit on regular disks, and
you can't fit many of them on your hard drive, either. To make good videos, you
have to have enough storage space.

+

Capture more footage than you need : Start recording before the action begins
and keep recording after the activity that you wan t to record has ended. You can
always edit out unwanted footage, but you can't add footage that doesn' t exlst. You
should also record plenty of on-the- job scenes from different departments of you r
organization as well as footage from industry conferences.

+

Record plenty of transition clips: Record transition clips, such as qu ick cuts of
generic office scenes, with appropriate music or background noises. If you are ever
in a situation where you need to piece different footage together, these clips will
help ensure smoother transitions between o ne segment and the next.

+

Edit carefully: Check for li ttle problems like dropouts, frame glitches, and stutters,
which can make your videos look unprofessional.

+

Keep your footage organ ized: Your videos will be entirely useless unless you can
find them when you n eed them. Thi nk of the types of images that you use the
most frequently, divide these images up by category, and reserve a SyQuest or
Bernoulli cartridge for each category. When you digitize and edit a video segment,
give it a filename that will jog your memory and save it immediately on to the
appropriate cartridge.

+

In case of emergency, search the Internet: If you have In ternet access and you
need a type of image that you can't get you r hands on, try asking around. You will
find many sites that offer all kinds of QuickTime footage.

Caution: When using shareware images, beware of possible legal liabilities

e

pertaining to plagiarism, copyright, and unauthorized use of images.
Legalities remain somewhat fuzzy on the Internet, so simply ask for
permission to use the image. It is unlikely that anyone will say "no. "

'

'

How do you compress a video?
When working with QuickTime videos, you will notice that QuickTime offers several options
for compression. Videos must be compressed so that you can store and run them more easily.
When videos are compressed, they are stored as algorithms, or numerical sequences, which tell
the compu ter how to render the images.
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QuickTime's compression options are as follows:

+

Photo JPEG: Image sizes are reduced dramatically but maintain a high level of
detail. This format is ideal for compressing photographic images.

+

Graphics: This option can be used for compressing images from single frames but
should not be used for video.

+

Animation: Use this compressor when formatting sequences created in animation
programs to be inserted on a PowerPoint slide as a QuickTime video.

+

Video: The video option works well with digitized video and will probably be the
option that you use most often.

+

Cinepak: The Cinepak compressor works well for compressing video sequences
while maintaining a high level of image quality, but it is often slow.

+

None: This means exactly what it sounds like. When you select this option, your
digitized video will not compress. This lets you access videos faster and run them at
faster frame speed rates. But uncompressed files also take up more disk space.

You can experiment with different compression options to see which one works best for you.

How Do You Add a Quicklime Video
to Your Presentation?
What is so wonderful about PowerPoint is that as intimidating as the words digitized video may
sound, you can insert a QuickTime video into your presentation as easily as you can insert any
other object.
To insert a QuickTime video into a presentation, do the following:
1. Choose the Insert Movie command from the Insert menu. A dialog box appears,

which displays a list of available videos (see Figure 27 .3) when you select the folder
that has them.
2. Select the video that you want in your presentation and click the Insert button. An
icon representing the video appears on you r slide, as shown in Figure 27.4.
PowerPoint's default for videos is to play when you click the icon with the mouse, but you can
set the video to play automatically after the slide transition. You can stop playing a video by
clicking your mouse or by moving to the next slide.
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Figure 27.3 The Insert Movie dialog box.

The video icon.

Figure 27.4 An icon representing a QuickTime video.

To play a QuickTime video, do t he following:
1. Click the icon representing the video you have inserted.

2. Choose Play Settings from the Tools menu. A dialog box appears, as shown in
Figure 27.5.
3. In the Start Play area, select the When Click on Object option to start you r video
manually by clicking the icon. Select the When Transition Starts option to start
your video when the transition to that slide begins. Select the When Transition
Ends option to begin running the video after the specified number of seconds
following the transition elapses. To activate this option, you must enter the
number of seconds.
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You can create self-running kiosk displays with QuickTime videos by doing the following: use
the Play Settings options, run the entire show with the Rehearse Timings feature in the Slide
Sorter view, and then select the Run Continuously Until Esc box in the Slide Show dialog box
from th e View menu.
You can also make mino r changes to your QuickTime video clips by following these steps:
l. Switch to the Slide view.

2. Go to the slide with th e video icon and select the video icon with your pointer.
3. Choose the Movie command from the Ed it m enu.
4. Select the Show Contro ller o ptio n.
You should now have a basic overview of working with Qui ckTime video cli ps in your
PowerPo in t presentations.

How Do You Add Sound Effects
to Your Video?
Suddenly an ambulance siren blares and a vague feeling of fear fills the room. Everyone finall y
relaxes when the next slide appears and informs the aud ience that your hospital was able to
save mo re lives last year thanks to the audience's generous contributions.
After focusing mostly o n the visual, I must point out that sound effects can also make considerable impact on your prese ntations. All Macin toshes come with the ability to play and record
sounds at 8 bits, so you don't have to buy all the expensive hardware required fo r working
with video. All you have to buy is an inexpensive microphone that can be hooked into your
Mac. However, 16-bit sound is optima l, so you may wa nt to purchase a new sound card if your
Mac supports it.
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Macintosh also offers a compressio n program for sound fi les called Macintosh Audio Compression and Expansion (MACE) so that your sounds don't take up as much disk space.
Unfortunately, the sounds somet imes lose some of their quality after being compressed
and decompressed.
To obtain sound effects, you can use the beeps and sounds that you already have in your
Control Panel (see Figure 27.6), record new sounds with the Object command fro m the Insert
menu, or try one of the CD-ROM collections that is available. These collections have everything from backgro und and crowd noises to entire songs. The CD-ROM Warehouse distributes
a large selectio n of titles.

Sound
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Figure 27.6
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Control Panel sounds.

What Is CD-ROM?
CD-ROM techno logy can also help jazz up your PowerPoin t presen tations. You can make use
of the large collecti on s of clip art, photos, sounds, textures, and backgrounds collections
available o n CD-ROM. Having th ese collection s makes it easier fo r you to have the appropriate
image o r background right at your fin gertips. For an initial investment, you can also impress
clien ts by sending them your presentation on a shiny new CD-ROM disc.
Right now, many people view CD-ROM as little more than an enormous storage space fo r
storing clip art. Well, in a way it is, and I li ke it tha t way. CD-ROM d iscs look like the compact
discs that you put in your stereo and play music with . They hold u p to 600MB of files, an
eno rmous amo un t of info rmation. But you can't easily store anything on them because CDROM discs are currently read-o nly-which is why so many people view this medium as
fri volous.
However, CD-ROM offers a new medium for communicating informati on that doesn't take
nearly as much space as paper. Altho ugh the techn ology is relatively new, you can alread y find
just about everything o n CD-ROM, fro m samplers of different software packages to interactive
gam es to encyclopedias and more. CO-ROMs are also wonderfu l for storing images because
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man y graphic files are too large for sto ring more than a few on a floppy disk. And you actually
can create PowerPoint presentatio ns that take up huge amounts of hard disk space and
distribute them to clients o n CD-ROM discs.
But you had best make sure that it is wo rth the investment before producing CD-ROM presentatio ns. Various companies, including 3M, Optical Media In ternatio nal, and Sony Electronic
Publishing can transfer your files onto CD-ROM discs. Prices generally range around Sl ,SOO for
creating a master and $1.50 to $30.00 per CD after that, dependi ng o n the quantity.
Soon you will even be able to create and record your own CD-ROM discs. The technology is
already ava ilable, except that the high-end CD recording devices ($4,000) and the low-end
products are still full of glitches. In a recent MacWeek review, the currently available CD-ROM
recording systems were unable to maintain a constant data stream, which resulted in buffer
underrun erro rs. However, Elektroson USA offers a system called Gear for Macintosh fo r $995,
and !nea t Systems Softvvare USA, Inc. offers the Easy CD Pro for $1,495. These systems are
affordable if you are seri ous about distributing presentations on CD-ROM, and th eir affordability is quite an achievement. However, I recomm end that you wait for further developments
for a few months before making a pu rchase.
Many Mac and Power PC models currentl y come with a built-in CD-ROM drive. Most computers at least offer the abili ty fo r adding one. When purchasing a CD-ROM drive, you should
make sure that the drive comes with everything you need to begin using it. To add an external
drive, you should have driver software, an SCSI cable, and a power cord . You also may need a
terminator. To add an internal dri ve, all you need is the d river software.
You don't n eed to buy anything too fancy if you're on a budget, but you should make sure
that your drive has the following features:

+
+
+
+
+
+

Eject button
Emergency eject hole
SO-pin SCSI connectors
Push-butto n SCSI-ID selector
Auxiliary outlet
External fuse

You also may want to check and see if the drive has RCA jacks so that you can hook up an
amplifier o r speakers.
A recent article in MacUser magazine highly recommended the Chinon CDA-535, which costs
$370, and the Apple CD 300e Plus, which lists at about $369. Also highly rated were the DGR
Tornado, MacConnection MDS Chi non 535, and the MacProduct Magic.
This chapter discusses what's available in multimedia, and how Q uickTime videos, sound
effects, and CD-ROM can play a role in creating your PowerPoint presentations. Although
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PowerPoint's multimedia applications are limited, it offers a user-friendly environment for
experimenting and exploring multimedia's potential.
If you have worked your way through the PowerPoint chapters, you should have a basic

knowledge of presentation skills and how to use PowerPoint's features. The last PowerPoint
chapter will give you some tips on how to put all this information to good use by improving
your presentation skills.
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Presentation Skills
You have mastered PowerPo int, created a sample presentatio n or two, reviewed and rehearsed
your talk, and gone over your slide show over and over aga in. You have a thorough knowledge
of your subject, and you have even figured out what all those knobs and doohickeys on your
newly purchased presentation eq uipment are actually for. And now it's ti me for the real thing.
No matter how much you know, it never hurts to keep improving your presentation skills.
This chapter gives you tips o n im proving these ski lls by covering the fo llowing topics:
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Get Your Points Across
People give presentations for many purposes. But in a way, all presentations are sales, and the
product you are selling is yourself. Yo u must grab your audience's attention, earn the trust of
the people as a credible information source, and convince them that your info rmation is
relevant and worthwhile.
This requires tailoring you r talk to your audience's needs without straying too far from the
main points of your slide show. To get you r points across, you need to communicate effectively. Elemen ts of communicating with people include being prepared, projecting confidence,
developing a speaki ng style, and establishing a rapport with your audience.
When speaking in front of audiences, projecting confidence is half the battle. The first step
in feeling good about your talk is to prepare, prepare, and prepare again. Make sure that you
know your topic inside and out. Rehea rse your talk with the equipment you will be usLng. Find
out everything you can about t he room in which you' ll be giving your talk. Anticipate potential trouble spots and figure o ut how you would address them.
Also consider how you want to interact with your aud ience a nd prepare your presentation
accordingly. Deliver your presentation in front of fri ends and colleagues and get feedback from
them. If you adm ire a particular individual's speaking style, ask that person for pointers. You
should also take body language into account when ascending the podium. After all, our first
impressions of people are generally the most lasting.

Prepare, Prepare, Prepare
You can never prepare too much fo r an upcoming talk. Presentatio n environments are always
fraught with numerous factors t hat you have little con trol over. Poor acoustics, lighting
problems, technical difficulties, inappropriately placed elect rica l o utlets, and even ho pelessly
unreceptive audiences can pose unavoidable haza rds to the presenter.
Therefore, you must take charge of factors you can contro l. Spending the time req uired to run
through your presen tation thoro ughly, learning your subj ect matter, figuring out how to use
your equipment, and anticipating possible problems ca n pay off.
You can take th e following steps to feel better prepared for your talk:

+

Research your topic: Make sure that you know a ll angles of yo ur topic. After all,
most presentation situations require you to answer at least a few questions from
the audience. And aud iences can ask tough questions. The more you know, the
more informed your answers will be. Research ing your topic also enables you to be
prepared if some unanticipated event requires you to change the entire direction of
your ta lk. To research your talk, read related books and trade magazines, talk with
colleagues who are knowledgeable about the topic at hand, and scan literature
from your o rganization-even brochures from your competitors, if applicable.
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+

Fam iliarize yo urself with your equipment: Make sure that you are thoroughl y
acquainted with the equipment you will be using d uring your talk. (For mo re
information o n presentation equipment, see Chapter 26.) Don 't in stall any new
softwa re and hardwa re just before a talk-if you're not comfortable wi th the
technical stuff, you' ll be a nervous wreck. (Macworlrl and MacWeek m agazines both
feature prod uct reviews that are helpful to Mac users.)

+

Reh earse: Rehearse your presen ta tio n with th e eq uipme nt you will be using, if
possible. Positio n yo urself as fa r away from you r pro jectio n screen as th e last
member of your audi ence will be. Can you read all the text and see all the
graphics withou t h aving to strain your eyes? If yo u can't, then you should make
ad justments.
Consider th e time that has been allo tted to you. Can you run th rough your slide
sho w without fee ling rushed? Have you left sufficien t ti me fo r members of the
audience to ask q uestions? Or does the pace of your ta lk seem to drag at certain
points?
Rehearse in fro n t of colleagues or friends if possible. They can offer the fresh
perspective that only people who haven't been looking at that darned slide show
for weeks o n end are capable of. Their inpu t also helps you add ress potential
problem s before they become real problems.
Power Point's Rehea rse Tim ings fea tu re times your talk by letting you run a slide
show that displays a tim er in the corn er of you r screen (see Figure 28.1). You move
fo rward in yo ur presentation by clickin g the po inter o n the slide after yo u have
fin ished discussing it. When you are finished, you can set th e ti mings so that your
slide show runs auto matically. The ti m ings fo r each slide are displayed undernea th
the slides in the Slide Sorter view. (For more o n Rehearse Timings, see Cha pter 25.)

1[
Figure 28.1

0 :00:17

11

PowerPoint's Rehearse Timings feature lets you ti me how long it takes to discuss each
frame.

Ad just your pace to the medium you are using as well as the to pic at hand. Although the presentatio n rule of thumb is two to three minutes per frame, this rule
is not set in stone. Sometimes people get bored if th ey look at a slide that lo ng.
Spending SO to 60 seconds per frame can be adequate fo r 3Smm slide shows, which
use little text. Transparency o verhead displays, o n the o ther hand, can ta ke several
min utes to d iscuss because they tend to use more text per frame and encourage a
greater level o f audience participatio n.
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Scope the presentation site: Set aside time to visit yo ur presentation site, if
possible. Yo u need to know how many people are coming, wh at the distan ce is
from you r projectio n screen to the back of the room, where the fron t row of your
audience will be, where you will be expected to set up your equipment, and wh ere
the electric o utlets are.
If you can't bri ng your own equipment, make sure that the presentatio n site has
what you need. just to be sure, you sh ould always arrive armed with extension
cords, extra bulbs, and connecting devices. If you are displaying slides o r using
LCD panels or projecto rs, you should also bring opaque fa brics fo r blocking out
light. (For more info rm ation o n requiremen ts for presentation display media, see
Chapter 26.) Ambient light can completely win yo ur presentation.
It is also safer to have extra sets of everything: disks, videotapes, notes, audience
hando uts, and o ther ma terials that you may need. And don't be stingy about
purchasing a poin ting device. You can even use a pencil if you have to, but never
use your fi nger.

+

Anticipate potentia l trouble spots: This is th e time to look at your slide show
with a ruthless eye and tea r it apart. If something ma kes you feel fu nny about your
presentation, pinpoint what that something is and correct it. If your colleagues
questio n you about a fact that doesn 't add up or the inclusion of a particular
illustration, so will people in your audien ce-only they may not be as con structive.
While addressing po tential presentation issues, consider the following: Does the
equipme nt run th e way it should? Do the graphics m ake an impact while projecting an accurate image of your organizatio n? Has all the information mentio ned
been fact-checked and updated? What could go wro ng and what can you do to
prevent o r correct the problem?

After going through a ll these steps, if anything goes wrong, you can at least rest assured that
you took all the necessary precautions.

Project Confidence with Body Language
Body language plays a great part in projecting con fidence. A competent, self-assured demeano r
can cover up even the most intense cases of stage fright. After all, many of the world's most
famous movie and stage personali ties have been afflicted with pre-performance jitters. But you
would never know it by looking at them.
With everything else o n your mind, body lan guage is probably the last thing you wa nt to
think about. But first impressions do count. And if you seem relaxed, your audience will be
more receptive to your message. The following simple tips ca n help you p roject far mo re
confidence than you rea lly feel:
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•

Stand up straight: Okay, so that's what your mother says. But all those fashion
magazines aren't lying when they say that standing up straight makes you look ten
pounds thinner and a couple of inches taller. Besides, slouching is for 13-year-old
girls who feel funny about being taller than all the boys. Competent professionals
with something important to say stand up straight and command respect.

•

Make every gesture count: As a rule of thumb, every element in your presentation
should serve to communicate information better. This rule also applies to your
gestures. Some physical movemen t is necessary to assure your audience that you
are alive. But tapping feet, excessive hand movements, and nervous pacing can
distract your aud ience. You have made every frame count, so make every gesture
coun t, too. For example, you can walk across the stage to make eye contact with
people on that side of the room, or you can extend a pointer toward the screen to
emphasize an important bulleted point.
Caution: Avoid crossi ng your arms. This stance alienates audiences because

•
'

•

it makes you appear defensive .

•

Face your audience: This point seems like overstating the obvious. However, you
would be surprised at how many people conduct a large portion of their talks with
their backs turned to the audience. Unless the room is totally dark, your audience
should be able to see your face. Take th is into consideration when setting up your
presentation display equipment. To avoid the necessity of turning your back to the
audience to run your show, consider purchasing a remote control device.

•

Make eye contact: Eye contact is important. Looking into people's eyes conveys
confidence and even a level of power. It also makes people feel important, as if
they have been singled out for special attention. Mankind has kn own that for ages.
The ancient Egyptians acknowledged the power of eye contact when they created
human figures who stare at you even in profile (see Figure 28.2).

•

Dress comfortably: Obviously, I'm not telling you to wear sweatpants. But the
morning of your big presentation is not the time to experiment with a new look.
Stick to tried but true, reasonably conservative clothing that looks attractive and
doesn't have to be fussed with . You don't want to worry about that ripped lining
edging out of your jacket sleeve or about slipping and fa lling in the designer shoes
you're wearing.

•

Take deep breaths: No, this isn't the Marlon Branda Method Acting School of
Presentatio ns. Taking deep breaths makes you feel better because it gives you more
oxygen and forces you to relax your muscles. Try it; it really works. If possible, get a
little exercise before dashing off to the presentation site, too.
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Her eyes follow you wherever you go.

Think of good results: After telling you to worry about everything in the last
section, I'm now going to tell you the opposite. There's nothing you can do at this
point, so you may as well think positive. Put yourself in a good mood. What do
you want the outcome of your talk to be? Think about how landing another sale
could get you that promotion or how it would boost your department's morale if
the big brass adopt your proposal.

If you follow this advice, you will come across as poised and confident, like the presenter

shown in Figure 28.3.

Figure 28.3 A poised and confident presenter.
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Develop a Speaking Style
As you continue giving talks, you will begin to develop a distinctive speaking style. Your
speaking style helps create a framework arou nd which you will learn how to interact effectively with your audience. Your speaking style ties in closely with your writing style. To be
convincing, you should develop your script in a way that is compatible with how you speak.
Developing a speaking style isn' t as difficul t as it sounds. You already h ave a speaking style,
which you use every day to communicate with the people around you. Maki ng your particular
style work for you in presentation situations is a n atural process that comes with ti me. However, you can make a concerted effort toward effective speaking by taking notes and getting
feedback from others. You should also keep contributing factors in mind, such as your personali ty, the types of presentation s you generally give, and the media you use.

Working with your personality
Your speaking style is a reflection of your personality, so work with it instead of fighting it.
Eve ry personali ty has its good and bad points in terms of giving presentations. The n ame of
the game is to make both the good and bad points work to your advantage.
For example, if a shy person tries to project effusive friendliness and interact with the audience
o n a high level, he won 't come across naturally. An introvert's speaking style may not be as
entertaining as an extrovert's, but it can still have attractive qualities. A straightforwa rd style,
quiet competence, and the ability to listen are generally appreciated by audiences.
You should take the following fa ctors into consideration during the process of incorporating
your personality into your presen tation style:
•

Are you extroverted or introverted ? Extroverted people have an easier time with
speaking in front of other people and rolling with the punches. But they often talk
too m uch or have difficulty sticking to the point. Introverted people find public
speaking difficult, but they tend to choose their words more carefully and stay
focused on the topics at han d. Extroverted people should develop a speaking style
that allows interactivity and flexibility. Introverted people should do mo re for mal
presentations and have audience participation through questions at the end of the
talk.

•

What is your energy level? Some people h ave enormous amounts of energy, while
others are more sedate. For those of you with high energy levels, your dynamic
presence is ideal for generating excitement about products and ideas. You should
keep this in mind as an angle fro m which to begin developing your talks. Use a
forceful, animated speaking style, but don 't be overbearing. If you have a more
low-key personality, then you are best suited fo r building a sense of trust with
people. Win audiences over wi th a relaxed, easy-going style.

679

Part IV

+

PowerPoint 4

How quick-witted are you? This aspect of your personality has little to do wi th
your native level of intelligence and more with how well you respond to someone's
throwing you a curveball. Your memory plays a major part in this. The more
familiar you are with your topic, the more p repared you are to handle unforeseen
situations. People who are quick-witted in this way have a degree of flexibility that
allows them greater spontaneity when giving their presentations.
Most of us, however, are chained to our notes. If that's the case with you, don't
worry. A well-orga nized binder full of notes makes it look like you put considerable
effort into preparing you r talk. Your audience appreciates this. PowerPoint helps
you create easy-to-reference speaker's notes (see Chapte r 25).

Taking notes
Keep a presentation diary for a while and take notes. Make a checklist and ask yourself the
following questions: What parts of your presentation did you feel good about? Why did you
feel good about them? What parts did you not feel so good about? Why didn't you feel good
about them?
Was the audience attentive and responsive, or did they seem to drift off? What questions did
people ask? Did your presentation achieve the results you had hoped for? If you could do the
presentation over again, would you do it differently? If so, how? What parts of your talk would
you keep the same and why?
Notes from one presentation alone may not prove ill uminating. However, a collection of notes
will reveal patterns. Some phrases or gestures will consistently net the desired results; however,
you may want to change your approach for other parts of your talk. Your notes can help you
create better scripts and deliver them more effectively. You should also ask friends and colleagues for feedback. They may notice things that you have missed.

Modu lating your voice
You shouldn't have to take elocution lessons to give your talks. However, there are basic
guidelines for speaking before an audience. It's important that yo ur voice projects clearly so
that people can hear you and that your voice sounds pleasant enough that people will wnnt to
hear you.
To modulate your voice, use th e following guidelines:

+

Use your diaphragm: First, put your hand on your stomach and say, "1-Ia!" (You
do this, of course, before standi ng in front of the audien ce!) The muscle that makes
your stomach move is called your diaphragm. To project your voice more clearly
without straining your vocal chords, you should use th is muscle to push out your
voice. This technique may seem silly at first- just wait until your co-workers hear
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you going aro und the office saying, "Ha, ha, ha!"-but it does work. Theater and
singing professio nals ca ll this technique "speaking fro m your diaphragm. "

+

Keep a low pitc h: By pitch, I am referring to to nal q uality, not volume. Highpitched voices sound shrill and squeaky when the voice is raised or amplified; lowpitched voices sound deep and resonant. Before giving your talk, practice speaking
in a lower vocal register.

+

Pace your speech: All people have their own little speech glitches, such as rushing
words out too fast; speaking in a mo notone; filling in pauses with like, urn, and
y'know; and a multitude of other verbal sins. Yet what sounds like a minor problem
during th e o rdinary course of talking to people is m agnified several times over
when you give a presentation. Tape record yourself and wo rk o n any negative
speech patterns. Pace your ta lk so that you speak in a calm, steady, well-modulated
manner.

+

Mind your Ps, Bs, a nd Ts: Hard consonants that require pushing out a sharp puff
of air sound like explosio ns when amplified by using a microph o ne. Practice
sounding out these consonants more gently.

By using these tips, you can comm unicate more effectively by eliminating distracting elem ents
from your speaking voice.

Build a Rapport with Your Audience
Audiences need to be convinced that wha t you have to say will somehow ben efit them. It is
easier to get a handle o n what your audience mem bers wan t to hear if you build up a rapport
with them. You can do this by using hu mor, emphasizing th ings you all have in common,
addressing concerns they have, and being responsive to their needs.
Listed below are some tips o n bu ilding up a rapport with your aud ience:

+

Break the ice: Begin your presentation with a joke o r, in small groups, ask the
people to introduce themselves. You ca n also begin with a sho rt question-andanswer sessio n an d as k yo ur audience m embers point blank what they are hoping
to get o ut of your talk. This info rmatio n helps you address your audience's expectations during your talk.

+

Encourage parti cipatio n: Even the most rigid scripts have som e roo m for parti cipatio n. For instance, if you are dem on strating how your company can save your
audience members some money, Jet them add up the savings themselves. Give
them th e figures and place the answers on a sepa rate slide that you display later,
as shown in Figu re 28 .4. Getting people excited by involving them in financial
calculatio ns is an effective techn iq ue th at is often used by sa les professionals.
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Show this slide first.

Figure 28.4

Show this slide after the
audience gets the answer.

Encouraging audience participation with slides.

+

Incorporate relevan t material: Even if you use the same presentation frames over
and over again, you should always personalize the talking part. Research the
compan y, organization, profession, o r other group that your audience members are
a part of. You can then use yoUI research to directly relate the facts on your slides
to their immediate concerns.

+

Arrive early: Arrive at the presentation site early, if possible. Arriving early may
give you a chance to introduce yourself and chat with some of the people you will
be presenting to. Once people know who you are, they are more receptive Lo you.
You also may find out information that can be useful in your talk.

+

Follow up: Making contacts never hurts. When appropriate, a follow-up can build
a rapport with the people you spoke to. For example, you can send the audience
members a card that thanks them for coming and offers to provide them with
more information.

After you have established a rapport with your audience, you are well on your way to having a
successful presentation.

Fielding questions
Fielding questions can be fun and highly productive in terms of learning about your audience.
But how do you keep this part of your presentation from becoming a free-for-all? You want to
answer questions as tho roughly as possible, but you also want to make sure that as many
people as possible get their turn. You also want to end your presentation on a high note and
make sure that the audience reta ins your message.
The following tips can help you field questions more efficiently:

+

Set a procedure: Before yo u even begin yo ur talk, you should inform the audience
members of how they should bring up questions and how you will address them.

682

Presentation Skills

Chapter 28

For example, will you have a question and answer session following your talk?
Or will you set aside time between sections of you r presentation? You should also
inform the audience of the order you will use for answering questions.

+

Refer people to literature: When question-and-answer sessions yield more raised
hands than allotted time, literature can be extremely useful. Whenever possible,
give people a brief response, refer them to the literature, make a general announcement that others with the same question can refer to the literature, and then
move on.

+

Stick to the point: Don't digress and don't let questioners in the audience digress
either. Briefly answer the question and tell them that you would be happy to talk
more afterwards (when possible).

+

Admit what you don' t know: Never try to fudge knowledge that you don't have.
If someone throws you a curveball, admit that you don't know the answer. You can
then either ask if anyone in the audience can answer the question, or you can offer
to take down the person's number, track down the answer to the question, and call
him back later.

After you get the kn ack of fielding questions and running question-and-answer sessions, you
can en joy having these opportunities to interact with your aud ience.

Dealing with interruptions
Sooner or later, every speaker winds up with an audience that includes people who keep
interrupting. Or sometimes the interruptions consist of factors beyond anyone's control, such
as noisy construction going on outside or members of the audien ce getting called out for
phone calls and other office emergencies. Nonetheless, interruptions disturb the flow of your
presentation, make it difficult for people to concentrate on your message, and take away your
control of the situation.
Sometimes there isn't much you can do. However, the following tips can help you cope with
annoying interru ptions:

+

Stay calm: Audien ces generally want to feel that the sp ea ker is in control of the
environment. If possible, stay cal m, ignore the inte rruptions, and proceed as you
normally would.

+

Crack a joke: Chances are the other people in the room feel as awkwa rd as you do.
Making a joke about the interruption helps break the tension and allows you to
continue your talk. For example, you could respond to the sound of a pneumatic
drill by saying, ''Oops, someone's Lazy-Boy wen t on the fritz again."

+

Enlist your audien ce's h elp: The audience members want to hear what you have
to say, or they woul.dn't be there. People will generally help you if you ask them
to. If the interruption is caused by background noise, ask if anyone has any
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suggestions. If the interruptions are caused by a person, however, try asking
someone in the audience to "help" that person so that you can proceed as scheduled. After you acknowledge the situation, chances are fairly high that people in
the audience will tell the interrupter to be quiet.

+

Use diversionary tactics: If the interruptions are caused by a person in the audience, cheerfully inform the person that you will have a question-and-answer
session and that she will be the first person you will call on. If the person keeps
interrupting, you can use an old teacher's trick: give the interrupter some responsibility. Ask her to help with some part of your presentation, such as passing out
handouts.

+

Reschedule: If the interruptions persist and the situation is beyond anyone's
control, tactfully inquire about whether you can reschedule your presentation. You
don' t have to soun d angry. You can simply say, "Perh aps this isn't a good time for
you folks. I would be happy to come back later."

Sometimes, none of these tactics work. But you can still handle yourself gracefully. If anything, the way you handle an uncomfortable situation will make people remember you.
The skills needed to become a good presenter are considerably different from the skills required to create good presentations. Although some peo ple are better with audien ces than
others, anyone can make a solid effort. After reading this chapter, you should be on your way
toward interacting with your audience effectively and developing a distinctive speaking style.
After reading the Power Point section of this book, I hope you have more confidence in developing your own presentations and in getting up in front of a group of people and making
the presentations. Good luck in your presentation future!
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Informa tio n exchange includes communicating
with the outside world (or at least the world
outside your own Macintosh) with Microsoft Mail
and sharing information between the various
applications included in Microsoft Office.
Microsoft Mail isn't really part of Office-you have
to buy it separately- but it is included in this book
because many companies use it in preference to
other mail programs. Besides, aJI the applications
in Office are Mail aware and are designed to
integrate smoothly v.rith Mail functions .
In the new world of System 7.5 and Office, many
of the functions of different applications are
blurring into each other. You can construct a table
of numbers in Word 6, for example; and you can
apply such editing functions as fonts, text styles,
and hyphenation to the cells in a spreadsheet in
Excel 5. But you still probably have text in Word,
numbers in Excel, and presentation graphics in
PowerPoint. That's why you need to be able to
exchange information between the three Office
partners. As you will see in Part V, some of these
ways are simply better than others because Office
is still a work in progress. Surviving data exchange
is a fair way to characterize this section .

Chapter 29

Using Microsoft
Mail
On th e Windows side, Microsoft Mail is included with Office. Because Microsoft writes
network server software used by the Windows installation, this is a pretty natura l state of
affairs. On the Macintosh, however, you are supposed to buy Mail server software separately
from Office, with a license for a certain number of Mail client statio ns. Altho ugh, techn ically,
Mail is not part of Microsoft Office for the Mac, it's popular enough that you should run
through the following helpful hints and observations:

Part V
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Network Matters
Microsoft Mail is different from the other programs in this book in that it is not your responsibility to install Mail and set it up, unless by chance you are your company's network administra tor. The network administra to r is supposed to do the following for you:

+
+

Select the hardware for connecting a group of Macintoshes to the network server.

+

Make sure that all the Macs are properly set up for AppleTalk (Microsoft Mail on
the Mac uses AppleTalk as its customary network protocol).

+
+

Assign each network user an account number, user name, and password.

Establish hardware/software gateways, if different networks are supposed to communicate with each other.

Install Microsoft Mail client software on each Mac.

In oth er words, the typical situation for Microsoft Mail users is that th ey simply arrive at the
office, and som eone else has done 95 percent of the installation and setup dirty work. That
sounds fair enough! Click the Office Manager icon (see Figure 29.1) and make sure that you see
Microsoft Mail as an option. If not, go see your administrator.

Agure 29.1.

Look in the Office Manager to see whether your administrator has set you up properly.
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Networks and Mai l
just so that you know what's happening- in other words, to explain why Mail works the way
it does-try to thi n k of the Mail system in terms of a traditional office paper mail scheme.
Imagine a big rectangular array of flat mailboxes, each with a user name, th at can hold letters
and memos and magazines and so forth . Usually you see one of these things in a hallway at a
big company, and there's usually a junior employee in charge of it. You have you r desk, and
you have a slot in the mailbox. In this plan, you also have Bob the Mailma n, who actually
brings your mail to you, puts it on your desk, and collects mail from other people.
ln the network world, the Mac represents your desk; a second Mac, which is being used as a
network server, represen ts the big mailbox; and the Mail software takes the place of Bob the
Mailman. When you send a message to someone in Microsoft Mail, the message gets picked
up by the software and is sent as a fi le to th e server Mac. When you check your mail, you are
using the software to look on the server and see whether there are any files addressed to you.
It's all quite simple really-the only confusion is caused by the inevitable air of mystery
surrounding networks, which always seem to be high-tech, wirehead things with mystery
problems. The dreaded phrase, "The network is down," for example, usually means only that
the server has been taken offline fo r a while so that someone can change the software or fix a
hard drive or solve some other problem that you routinely encounter on your own Mac. When
the server Mac needs to be fixed, the network administ rator stops th e nen-vork so that people
aren't sending mail out to a d isconnected server (some software isn't soph isticated enough to
realize it's sending mail to a computer that's turned off!).

Your own Mai l settings
To use Mail, you need to have your administrator tell you your user name-actually it's your
Mac's user name-on the system (mary_brown? MBROvVN? mbrown3?) and your password. If
your are part of a network that uses mo re than one AppleTalk zone, t hen you need to know
your zone (Sales? Marketing? Accounting?). You also need to know the network name of the
Mac that is your Mail server. With any luck, the system administrator will h ave handed you a
blurred photocopy sheet full of network jargon that contains this information.
Now select Chooser from the Apple menu. Look around in the upper left-hand box with icons
of printers and so forth until you find the icon for Microsoft Mail. Click the icon to select
Mail. If Chooser shows you a list of zones, then you aie in a m ultiple-zone system, so you have
to find your own zone (sounds sort of Zen, doesn't it?) and select it. Finally, in the list at the
upper right of the Chooser screen, you need to select your own Mail server. Even if you are on
a one-zone, one-server system, you have to make these selections. Now click the Setup button.
At this point, you are presented with two further choices: one that is quite harmless and one
that is quite tricky. First, you can choose to sign into Mail automatically upon startup-the
harmless choice. This option, of course, makes your startup take considerably longer, but if
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you want to make sure that you never miss a message, th is practice is a good idea. Second, you
can choose to have your password entered by the system instead of typing it in each time-the
tricky choice.
Caution: Never have your password entered automatically. First, after a

e
'

week, you 'll forget the password yourself. Second, this choice means that
all people who sit down at your computer not only can read all your mail,
but they can also send mail as you! If that prospect doesn't scare you,
you've never had a real job.

•

'

Having selected whether you want to sign into Mail auto matically and having selected the
Password Must Be Typed option (trust me on this one), click the OK button to close the
Chooser window.

Signing in
If you sign on to Mail automatically on startup, you see th e Mail 3.1 sign-in dialog box, just
as a result of turning on your Mac. If you h aven't signed on automatically on startup, pick
Microsoft Mail from the Apple menu or from the Office Manage r menu . Enter your name and
password and click OK. Like most other Mail systems, when you type your password, all you
see is a set of bullets entered in the password space onscreen. These bullets keep anyone
standing near you from read ing your password in the interest of merry mischief.

You are now greeted with the Mail Summary window. The Summary window has the following items:
•

A list of incoming messages. To read a message, simply select it and click the Read
button at the bottom of the window.

•

Buttons for deleting the message, prin ting it (thus defeating some of the purpose of
email), forwarding it to another user name in the Mail system, or moving it to
another folder o n your hard drive.

•

The Reply button, the most commonly used button. Click the Reply button and
the response you write is automatically sent back to the person who sent you the
message in the first place, with the heading Re: (original message title). Then that
person answers, giving a message called Re: Re: (origi nal message title). And so on
and so on....

•

The Note icon to the left of th e window. Use this icon so that you don't end up
with Re: Re: Re: as the title of everything. Clicking the Note icon starts a new
message from scratch.
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When you click the Note icon, you get a window with a blank area for typing, an Address
icon, and an Enclosure icon. Type anything you like, keeping in mind at all times the rules of
email etiquette. Then click the Address icon, and you are presented with a list of names that
you can reach on your network. Some fancier installations have gateways to the outside that
can handle Internet addresses for people on other networks-this feature will be more common in the future, but it's not typical just yet. So, normally, you will be selecting a name of a
co-worker in your company or within your own workgroup.

Email Etiquette
When you communicate through email, remember that no one can see your face or hear your
voice. The tiny words on a tiny screen have to convey your thoughts accurately. Follow these
simple rules to make your email experiences more successful.

+

Tone down your messages. Because there's no way to convey tone througl:l facial or
vocal expression in email messages, everything you write seems a bit sterner. An
angry message, for example, looks really murderGJus onscreen.

+
+

Remember that CAPITAL LETIERS LOOK LIKE YOU 'RE SHOUTING.
Make sure that your full name and your phone number are included in the message.
You may be assigned a network name, such as BradE, and the reoipient has to figure
out which Brad sent the message.

+

Don't send anything in an email message that you wouldn't mind explaining at a
meeting. Officially, these communications are secure, but there are reams of
corporate horrGJr stoties about email mes-sages ending up in the wrong hands.

+

Keep to the ~:Joint. People find themselves inundated with email In a busy office. If
you want to tell a story about your vacation, do it at lunch.

The Enclosure icon enables you to select any file on your Mac and send it along with the note.
This very important feature also turns out to be exceptionally robust (even Office 4.2.1 works
with Mail 3.1, which hasn't been updated for a few years because, after all, it works!). In the
Note window, you write a short message that explains the Word document. After clicking
Enclosure, you select the document that you want to send from a Finder-like list and click
Done. Then with all other applications closed except Mail, click the Send button and send your
file on its way. Even on networks that have been experiencing problems, sending files with
Mail as the only application running at the time usually works.
Alternatively, because Microsoft Mail installs itself in the menus of your other applications,
you can call it from the File menu inside Word 6. After all, when you save a file to a hard drive
or send it to a printer; you're just sending bytes down a wire. The same thing happens when
you send a file out on the network. Should be no problem, right? Umm . .. maybe and maybe
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not. Using Mail from Word 6 usually allows a message to be sent properly, but sometimes
Word 6 itself crashes the Mac that is doing the sending. In the worst cases, the messaging Mac
that crashes in the middle of a Mail session then confuses the Mail server to the point where
mailbox services are interrupted (meaning, tn effect, a network crash).
Caution: Although it takes a few more steps to save your files , close out of

•

Word and run Mail separately. Taking this precaution is a more reliable
way to send files .

'

Mailbox Management

•

'

It is not hard to work with the ma in Summary window that you see when you sign in to Mail.

Reading messages, replyin g, and making up your own messages are straightforward Mac-style
tasks.
When you are looking at the Summary window in Mail, you will notice that you have an item
called Mail on the main menu bar at the top of the screen. This m enu option gives you choices
for the following tasks:

+
+
+
+

Changing your password

+
+

Assigning personal g roups

Opening your mailbox (~-G)
Closing your mailbox (and signing off, too, as ~-Q)
Editing the set of addresses that appears in the scrolling address list when you click
the Address icon in Note m ode
Managing your m essages in folders

The last function, managing your messages, is critical. In the next few paragraphs, you will
learn how to save you r messages in the appropriate places with the New Folder command
(~-N) from the File menu. You can choose to save the messages to a new file or to an existing
file with the Save Messages command.
Consider for a minute what happens when your office gets Microsoft Mail up and running. At
first, you get a few messages per day, an d you keep them in your Inbox. As you start to get
more messages, you realize that you have to delete some of them just so that you don't lose
them in the messages that you want to keep. Finally, you have so many messages that one
fo lder isn't enough.
This, by the way, is absolu tely guaranteed to happen. Studies of email use show that after
people get comfo rtable with it, they send 20 m essages a day. Someone is receiving all those
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messages. After a yea r, you will h ave literally tho usands of messages- your Mail files will
o utn um ber, by file count anyway, every other category of fil e o n your hard d rive.
So it's time to thi nk about a folder structure that helps you keep im porta nt informati o n but
discard jun k. What you want to do is simple. First, using the New Folder com mand under the
File menu in the Finder, you sho uld set up folders fo r your main activities and drag them
into the Microsoft Mail folder. For example, you might have a folder fo r Meetings, Personal,
Policies, and Travel. For these main-level fo lders, you should have som ewhere between five
and ten topics (there's a tradeoff here between detail an d speed). Then in side these ma in- level
folders, you can create Month fo lders-6/95, 7/95, and so on-by using the New Folders
com ma nd again . Now you have a place to put all the messages you need to keep. It's really the
equivalent of having a file cabinet where drawers correspo nd to main-level top ics and folders
in a d rawer correspond to months.
Now, when you o pen your Mailbox fo lder in the Summary windo w, you can Sh ift-select a
g ro up of files on a similar topic. Then you choose the Save Messages To New File command
from the Mail men u. Type in a name that descri bes th e contents of the fil es. Be sure to include
the date of the mail messages in the filename. For exam ple, if your mail m essages are about
the Omah a meeting, and they came in the week of May 2, 1995, you can name the file
"OmahaMtg-5/2/95-msgs." Click OK to create this new m ini folcler.
You can let these gro uped m essages pile up fo r a while, and then every few weeks, you can
"file" all yo ur little mi nifolders in to o ne of the month folders inside the approp ri ate topic. j ust
d rag the fo lders in the classic Macintosh style. This orga nizational technique means that you
will usually be performing very efficient searches for older informatio n . Al though Find File lets
you search for files by elate, you're better off having files and fo lders with names th at con tain
dates so that you can do the searching yourse lf. You can drag all the little grou ped fil es out of
your Mailbox and into a nice safe place where you can fi nd them again in seconds. This
system really works!

Grouping
One last convenient item in the Mail menu is Personal Groups. When you select this option ,
you are prom pted to make up a group name, and you are then give n a list of the names that
you can reach o n your network to select for membership in the group.
After you select the set of n ames and click the Save button, you will see that a new name has
been added to yo ur address list-the name that you assigned to the group. When you need
to send o ut a memo to all th e group's people at once, you just add ress it to the group. The
members see it as individual mail addressed to them. Because it's no more work to assign a
gro up than to address m ail to everyone individ ually, it's worth setting up groups even if you
use them only once or twice a week.
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Returned mail
Sometimes your mail comes back with a cute little "Returned" sticker. Because addressing
inside a network is done by selecting valid names from an address list, returned mail almost
never happens with mall addressed to someone on your own network. But when you deal with
outside mail addresses, the most common causes of returned mail are as follows:

+

You type an address for someone on another server, and you have some tiny detail
of the address wrong (the name is Stan_Voronych rather than StanVoronych) .

+

The gateway to the other network's server wasn't connected or wasn't working at
the time you sent the mail.

+

The server for the other network was temporarily disconnected. If your own server
was down, you couldn't have sent the message in the first place, so it's "the other
guy's fault."

For addressing problems, the only fix-up that always works is to call the other person on the
phone to validate the exact address. With server and gateway problems, you just have to keep
trying to send the mail. After the third failure, send your network administrator a copy of the
message, including the address, as mail inside your own system, and let the administrator
puzzle it out.
Now you know about how to create mail, send it, and store it. The next chapter tells you how
to integrate all the Microsoft programs.
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The big argument for using Microsoft Office, as opposed to smaller integrated programs, is that
Office gives you tight integration among big-time, competitive, full-featured, stand-alone
applications. All sorts of connections are possible, but this chapter will review the most useful
intra-application connections inside Office, which include the following:
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A Few Words About Linking
In principle, there are four different ways to do data exchange inside the applications of
Microsoft Office. Two of them use the Macintosh's own exchange facilities that are built into
the operating system. The other two use Microsoft's object linking and embedding technique
(OLE). You should understand that these methods are not equivalent in terms of functionality,
nor are they equivalent in their "likelihood of success."

Paste versus Paste Link
Using the Paste command is a straightforward Mac technique-you already know all about it.
The Paste Link command may also be familiar to you if you have been using earlier versions of
the Office applications. One big difference between the Paste and Paste Link commands is that
Paste simply inserts information into a file, while Paste Link maintains the link to the originating document. The content of an item that has been inserted with the Paste Link command is
updated from the originating document every time the receiving document is opened, saved,
or closed.
Perhaps the biggest difference between Paste and Paste Link is that the underlying software
technology for Paste Link, which is OLE2, isn't particularly well debugged for use with System
7.5, at least not through Office 4.2.1. In the mildest kind of Paste Link crash, the Word 6
document that receives the data locks up, and you have to restart your Mac by turning it off
and on again. This technique is not recommended beca use it leaves incorrectly closed files on
your hard drive. These files can, in turn, lead to all sorts of weird behavior. In the worst kind
of Paste Link crash, Word 6 no longer recognizes the file type of the Word document, so you
can't recover it, and Excel can't read the original Excel file any more.
Not a pretty picture-and these crashes are madden ingly unpredictable. For this reason, make
sure that you send in your registration so that you get updates of all the Office applications.
Word is the principle crash offender, and somewhere around version 6.2.1, Microsoft will
finally be providing a more stable product. If it's any consolation, the Windows version of
Word 6 has a comparable set of problems.

Embedding and Publishing
Nothing would be more thrilling in a chapter on using Office applications together than
presenting a section on object embedding. An embedded object (for example, a chunk of Excel
worksheet in a Word page) is a "live" document-when you click in the embedded worksheet,
you're effectively back in Excel. This is what OLE is all about. After nearly four months of
testing object linking, I regret to report that in Office 4.2.1, it doesn't work acceptably. Even
with a minimal installation of System 7.5 and all non-Microsoft extensions turned off, crashes
are sufficiently frequent that object embedding is not a good choice for day-to-day work.
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The Mac System's own Publish and Subscribe, in contrast, has proved itself exceptionally
robust. Probably because it's been around for a few years and is thus more or less bug-free and
because Microsoft's own programming efforts don't appear to conflict with it, Publishing from
one application and Subscribing in another is a reliable way to exchange data. It is better than
using the Paste Lin k command and far better than object embedding, at least in the current
state of Word 6 and its frie nds.

Special data exchange: Present It and Report It
One built-in Microsoft techniq ue, however, works very nicely. Word 6 has a special Presentit
macro that sends documents into PowerPoint, and PowerPoint returns the favor with a button
called Report It. I' ll give you details on this slick arrangement at the end of this chapter.

Excel Data into Word
The first tip you need is this: get Word 6.0. 1, the early 1995 update. The simple reason fo r this
recommendation is that the first version of Word 6 is prone to crash when you try to establish
Excel links!
Then you h ave a decisio n to make before you send data from Excel into Word:

+ Will the Excel data be changing frequently? If so, it's worth the effort (and performance hit) that results from live data links between documents.

+

Is t he Word document supposed to be a "snapshot" of conditions at a particular
time? In this case, you will just be creating confusion unless you do a one-time,
o ne-way data transfer.

Pasting
Using the Cut, Copy, and Paste commands is still the easiest way to transfer modest amounts
of data between applications. First make sure that both Excel and Word are open. You can use
Office Manager-the little icon to the left of the Help button on the Finder menu-to open the
applications. Then in an Excel worksheet, you can select the table of information that you
want (see Figure 30.1) and choose the Copy command from the Edit menu.
Now switch to Word, open the document in which you want to insert the Excel table, and put
your cursor in the proper place for the table. Choose the Paste Special command from the Edit
menu. The Paste Special dialog box appears (see Figure 30.2). In this dialog box, you can
choose to paste the Excel data into the Word document as regular text, paste the data as
formatted text (RTF), o r choose the Paste Link option to make a Jive link, whether you retain
the formatting or not.
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A little Excel table for export.
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Figure 30.2

The many kinds of Paste.

An RTF paste link gives you the table shown in Figure 30.3 in your Word document. When
you choose the Paste Li nk option rather than th e Paste option, the data in the Word document changes when you change the original data in th e Excel worksheet (th e update occurs
every time you open or save the Word document).
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Figure 30.3

The Excel table in Word.

If you do lo ts of re porting, here's a tip that ca n save you p len ty of grief. W he n you ma ke a
tab le in Excel th at you p ropose to use in Word, use t h e Inse rt Date comman d to put an active
date so mewh e re in t h e tab le. In t h is way, by just looking at th e tab le in th e Excel docume n t,
you ca n de termine which version number o f the table you are using beca use the last update is
clearly indica ted by th e date.

Publishing
Th e Paste Lin k optio n works t h rough Microsoft's own object li nking and embedd ing (OLE)
sc he me. Th is way of transferring information duplicates the serv ices that Apple already built
into th e Macintosh system long ago in its Publish and Subscribe features.
In principle, the Paste Lin k option and t he Publish and Subscribe feature sho uld work in
almost the same way to exchange data. In practice, h owever, using Publish and Subscribe is
significa ntly more sta ble than using ei ther linking or e mbedding. Furthermore, because the
rest of your Macintosh applications a lso use the Publish and Su bscribe method of transferring
info rma tio n betwee n application s, using th is method in Office doesn ' t req u ire an y training or
re-orien ta tio n. In th e first few editions of Office, using OLE2 li nks between docume nts was
fa irly troublesome, while usin g the Publish a n d Subscribe links ca used no problems at all.

699

Part V

Information Exchange

Microsoft, if history is any guide, can be counted on to fix its Mac OLE2 glitches, but without
any sense of urgency.
To transfer informatio n by using Publish and Subscribe, follow th ese steps:
1. Select an area in your Excel spreadsheet that you want to paste into a Word

document.
2. Choose Create Publisher fro m th e Publish optio ns o n the Edit menu. A dialog box
similar to the one sho wn in Figure 30.4 appears. Give the selection its own name in
the Name of New Edition text box. This actio n creates a file within a file and
defines your selection as a "publishable" editio n of data. Click the Publish button.
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Figure 30.4 Publish, a nice safe choice.

3. Switch to Word, open the document, and place the cursor in the place that you
want the Excel table to go. From the Edit m enu, choose Subscribe. The dialog box
similar to the o ne shown in Figure 30.5 appears. Highlight the name of the new file
that you've created and click the Subscribe button. The text is auto m atically
inserted into the Word file. (If you never have do ne Publish and Subscribe before,
you m ay want to review this technique in the Apple Guide.)
When you make the connection between your Word and Excel documents in this way, the
files are mutually updated every time they open, close, o r save. In this type of linkage, you
sho uldn't try to edit the table that appears in Word because Excel has been defined as the
data source. If you want to have editable Excel data in Word, simply perform a simple Paste
function (not Paste Link).
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Excel and PowerPoint
Because PowerPoint was originally designed as a stand-alone application, it h as its own
facilities for maintaining tables of data and creating charts. But the business reality is that
most companies in the Office milieu use Excel as the main collection point for data because
Excel has such well-defined links to externa l databases. So you probably have your data in
Excel along with va rious lovingly hand-crafted and fine-tuned charts, as well.
But Excel charts are dull, while PowerPoint charts provide a nice set of attractive stock backgrounds and shadings so that your presentations look professional. It doesn 't make sense to
redo all this work in PowerPoint, so you need to transfer your Excel charts to PowerPoint by
following these steps:
1. In your Excel worksheet, double-click the chart that you want to import into
PowerPoint (see Figure 30.6). You need to see the gray cross-hatched border around
the chart to know tha t you have activated it.

2. Open PowerPoint (if you haven't already), choose Blank Presentation, and doubleclick one of the Auto Layouts in the New Slide dialog box that has room for a chart.
A screen like the one in Figu re 30.7 appears.
3. Go back to Excel and choose Copy from the Edit men u, which copies the selected
chart to the Clipboard. Now switch to PowerPoint and choose Paste Special from
the Ed it menu. The Paste Special dialog box appears. The dialog box has, in fact,
anticipated the Excel chart import as a likely action (see Figure 30.8).
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Power Point knows that you want to use Excel charts.

4. After clicking the OK button in the Paste Special dialog box, your chart is pasted
into the PowerPoint slide as a resizable ob ject (see Figure 30.9). You can also
modify chart properties, if necessary, by using the Formatting toolbar, and you can
add text and a title to the slide .
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The Excel chart pasted into a PowerPoint slide.
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WordArt in PowerPoint
There are several ways to use Word in connection with PowerPoint. PowerPoint can accept
Word text when you use the Paste command or when you use the Paste Link command, which
updates itself. If you have already written a Word report o n some topic, you can cannibalize
most of it to make a sna ppy presentation in PowerPoint. You may also have developed some
zingy special effects (company logos, spedal headings, or titles) for your Word documents
by using WordArt. Rather than create these effects again, you can place them directl y
in PowerPoint.
Simply follow these steps to transfer a WordArt graphic from Word to PowerPoint:
1. Open the word document that contains the WordArt graphic you want to use.

2. The WordArt appears in your Word document surrounded by the little sizing
handles that accompany graphics (see Figure 30.10) . Select it with a single click
and choose the Copy command from the Edit menu.

Figure 30.10 WordArt as a sizable object in a Word document.
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3. Switch to PowerPoint and paste the WordArt graphic where you want it to go in a
PowerPoint slide (see Figure 30. 11). If you use the Paste Link command, changes
will be updated in PowerPoint when you make them back in the Word document. However, Word 6 still seems to have some problems with the Paste Link
command, so using the plain Paste command is probably much safer from a crashproofing standpoint.
So far this section has concentrated on importing WordArt to PowerPoint from a Word
document because it's very likely that you have done most of your WordArt experimentation
in Word. By this time, you may already have a repertoire of flashy o r interesting WordArt
graphics in your Word documents.
But what if you have never used WordArt, and you want to insert a graphic into a PowerPoint
slide? In this situation, put your cursor at the position in the slide where you want the graphic
to go. Then choose the Object command from the Insert menu. From the Object Type list in
the Create New tab, select a WordArt option, and in the dialog box that appears, create you r
own WordArt from scratch (see Figure 30.12) . WordArt, like Microsoft Graph and Equation
Editor, is actually an independent stand-alo ne "helper" application that can be call ed up from
any application in Office.

Figure 30.1.1 WordArt in a PowerPoint slide .
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Figure 30.12 Create your own WordArt in this dialog box.

Word Outlines in PowerPoint
PowerPoint can also accept Word outlines. At the simplest level, you simply copy an outline
document from Word an d paste it into a blank PowerPoint slide. You can also expand the
individual points of the outline and make them into individual slides with the Cut and Paste
commands. There's a lot to be said for this ready-made approach to outlines from the standpoint of logical clarity, as opposed to picking a template from the prepared choices in
PowerPoint and then making up the slides from scratch.
But Microsoft has installed a special pipeline between Word and PowerPoint, one that
preserves outline structure. There are a few variations on this trick, but they all involve
the Presentlt macro on the Word end of the pipeline and the Report It button on the
PowerPoint end.
To make this technique work, by the way, you need to h ave installed the complete version of
Word 6 and the complete version of PowerPoint 4. The macros that make this outline tran sfer
possible are obscurely located in the Wizards folders, so if you do a minimum installation of
eitl1er application, you won't get th is feature. By the way, not only is this installation information not explained in any detail in the Microsoft documentation, but information about this
kind of file transfer between applications is amazingly skimpy everywhere. Present It doesn't
even appear as an item in the index of the Word manual.
First, make an outline in Word 6 by typing some h eadings in Outline view (see Figure 30.13)
and using the arrow buttons to arrange the text by outline level.
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Figure 30.13 A simple Word outline for export.

Now there are two choices. In the first one, you go into the Finder and double-click the
Present It icon to open a Present It window. You then cut and paste the outline into this
window (see Figure 30.14) and save the file. When you switch to PowerPoint, choose the Open
command from the File menu. In the Open dialog box, one of the options now available is
to import an outline saved in this way. You just open the file, and the outline structure
is preserved.
The second choice is to activate the Presentlt macro from the Macro command in the Tools
menu (see Figure 30.15). When you run this macro with an outline document open (actually,
you can do it with any sort of Word document), the macro performs the file format conversion, switches to the PowerPoint application, and opens the new outline file in PowerPoint in
an untitled window (see Figure 30.16).
What if you have developed an outline in PowerPoint that you would like to transfer to a
Word document for further elaboration (see Figure 30.17)? An outline in PowerPoint (remember that PowerPoint has an Outline view just like Word) can be exported to Word with a mere
click of the Report It button, the button to the left of the Zoom Control on the Standard
toolbar. A single click on this button fires up a PowerPoint macro that delivers the outline into
Word (see Figure 30.18). If you switch to Word's Outline view, you see that the level structure
of the outline has made the journey intact.
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Figure 30.16 ...thi s window opens in Power Point.
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Figure 30.17 An outline in a PowerPoint slide.
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Figure 30.18 The PowerPoint outline arrives in Word.
The nice thing abou t Microsoft Office is that you have to make elaborate creations, such as
tables, outlines, and g raphics, on ly once in the originating document. Because the Office
applicatio ns are li nked togeth er in different ways, you then can import these creations into
Wo rd, Excel, or PowerPoint with just a few steps-a much easier technique than generating
your creation fro m scratch all over again. Take the time to experiment with these links in the
Office suite. The time you invest in lea rning how to transfer these creations will be time saved
over and over again in the future.

710

Speed, the subject of Part VI, is exactly
what Office doesn 't have. The simplest
way to understand the often poky
behavior of Office applica tions is by
thinking about the Macintosh interface
itself. Every time you click the mouse
som ewhere o nscreen, the application that
is running at the time has to look through
its list of possible actio ns. If the list of
actions (corresponding to the number of
features) is gigantic, this is going to take
lots of time. And the Office applications
are the ve ry definition of giga ntic.
So Part VI offers some tips fo r getting
some speed back into operating the
applications in Office. There are more
Word tips than other kinds because Word
is the worst offender-Excel is not much
slower than its earlier versions, and
PowerPoint 4 is actually fas ter than
PowerPoint 3. Besides, there's no thing
more annoying than waiting and wa iting
for Word to load when you just want to
type a four-line memo. Surviving Office
largely means getting Word to perform
adequately, so you should implement
every bit of this hard-won advice.
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Word 6 Speed Tips
Get the upg r ade!

If you are still using the United States version of Word 6.0, update to Word 6.0.1, the
fastest version of Word for the Mac. You can get it at no cost by calli ng (800) 315-5081. If
you don't have the United States version of Word (and you almost certainly don't if you
bought Word outside of the United States), consult the introduction to the Word User's
Guide to find the phone number of your Microsoft subsidiary and call the subsidiary.
If you run Word on a Power Macintosh, use the PowerPC-compatible version of Word.
To get the Power PC version of Word, call Microsoft at (800) 426-9400 or (206) 936-8661.
To find out more about your copy of Word, with Word launched, choose About Microsoft
Word from the Apple menu. Look at the top of the About Microsoft Word dialog box to
discover your Word version number. If you are running the PowerPC version of Word, the
dialog box describes it as being for Power Macintosh.
When a new upgrade of Word comes out, contact Microsoft to find out what speed and
performance boosts you can expect from the newer version, and don't buy anything if you
don't think it will be worthwhile.
Eliminate exten sions

Turning off your extensions is the standard remedy for any Macintosh problem. It is
particularly recommended by Microsoft tech support people because they know that Word
has a long list of incompatibilities with popular Mac extensions.
To see if you have a problem with extensions, shut off your Mac and then restart it while
holding down the Shift key. You see an Exte ns i ons Off notice while your Mac reboots.
After the Mac restarts, launch Word and see if it runs faster. If turning off the extensio ns
didn't help speed up Word, don't worry about it. just restart your Mac again and things
will be back to normal.
If, on the other hand, turning off extensions did help get you more speed, you have to
figure out which extension is slowing down Word and then figure out what to do about
th e problem. Usually, a minimal insta llation (see Chapter 2) takes care of this problem so
that you don't have this headache.
A llocat e more RA M for Word

If enough RAM is available, but you plan on using a lot of graphics in Wo rd documents,
give Word at least six megabytes of RAM. If enough RAM is available, and you don't
anticipate using many graph ics in Word documents, give Word only four megabytes of
RAM.
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To allocate more RAM, make sure that Word is closed, select it with a single click, and pick
the Get In fo command from the Finder's FiJe menu. In the Microsoft Word Info d ialog
box, select the Preferred size option and reset it for a bigger allocation. Allocating more
RAM is worth do ing any time you will be having a long session in Word because it greatly
reduces the time it takes to run Word.
Turn on your P ower Mac 's v irtual memory

Power Macintosh users should turn on virtual memory in the Memory control panel to get
more speed for running Word. Turning on virtual memory ensures that when you launch
the PowerPC version of Word, o nly a portion of Word copies into RAM, which saves a lot
of application loading time. Without virtual memory o n, the entire Word application (a
bit over 4MB) must copy into RAM.
To make matters even worse, th e Microsoft Office "shared libraries"-which take up
another megabyte o r so of RAM-must load, as well . If you then launch another Microsoft
program (such as Excel), the shared Microsoft Office li braries in the System folder must
load again for the other program.
Double-click the Memory optio n in the Contro l Panels folder to bring up the Memo ry
control panel. When you turn on the Virtual Memory option, you auto matically get a text
box where you can choose how much disk space to allocate as a substitute for RAM. Leave
it set at 32MB as a good ch oice.
Set up a RAM disk

Another trick from the Memory contro l panel for getting Word to run faste r is to set up
a RAM disk. In a RAM disk, you allocate an area of RAM and load a program into it. Then
the program loads in to this RAM memory at startup and never bothers with disk access,
at least for the application itself, wh ile it runs. It's worth trying this experiment on your
system .
Check your RAM to see if you have enough for a Word RAM disk by choosing About This
Macintosh from the Apple menu in the Finder. Figure Vl.l shows a system that has 16MB
of RAM, so there's plenty of room to give Word a 6MB partition.
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Discovering how much RAM you have to spare.
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In the Memory control panel, click on the RAM Disk option and set the slider to 6MB or
a bit more-it's hard to stop on 6M B exactly. The RAM Disk Size box should read about
6016K. Restart your Mac to make these changes take place. Now when your Mac starts up,
you should see a RAM disk icon on the desktop. You can treat it just like a high-speed disk
drive.
Click the RAM disk icon and drag Word 6 into this drive. Now when you restart, Word
automatically loads into this area of RAM. There won't be any swapping of Word parts
from disk into RAM while Word is running; therefore, Word should run much faster for
you.
This approach obviously doesn't do much for you if you're trying to run Office on a 4MB
Centris (actually, you can pretty much forget about Office altogether on really modest
hardware), but if you have a shiny new Power Mac with 16MB of RAM, this approach is
your best bet.
Change bitmap memory allocation

If you don't import bitmapped graphics, such as TIFF images (EPS and PICT images are not
considered bitmaps), into Word documents, you may speed up Word by setting its bitmap
memory allocation to 512K. To change this allocation, you need to make the change in
the Advanced Settings dialog box. To make this dialog box available on a menu, choose
Customize from the Tools menu and click the Menu card. From the Categories list, select
Tools, and from the Comma nds list, select ToolsAdvancedSettings. Click the Add button
and then click the Close button. The Advanced Settings command now appears on the
Tools menu.
In the Advanced Settings dialog box, select Microsoft Word from the Categories list. In the
Option box at the bottom of the dialog box, delete any text that may be in the box and in
its place type BitMapMemory. In the Setting box, type 512 (see Figure VI.2). Click the Set
button and then click the OK button.
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Use Word for a while to see if the change m akes Wo rd run faster. If changing this setting
makes Word run slower, then put the setting back to the way it was before. If you must
put the bitmap mem ory allocatio n back the way it was, open the Advanced Settings dialog
box, select Microsoft Word from the Categories menu, select BitMapMemory=512 from
the Options list, click the Delete button, and then click the OK butto n.
Change cache size allocation

If you frequently use Wo rd with documen ts over 64K in size (25 pages or so witho ut
graphics), you may experience a speed boost by upping Word's cache size allocation from
its defa ult 64K to a m ore genero us 128K. To change the cache size setting, open the
Advanced Settings dialog box (see "Ch ange bitmap memo ry allocation"). In the Adva nced
Settings dialog box, select Microsoft Word fro m the Categories list. In the Optio n box at
the bottom of the dialog box, delete any text that may be in the box and in its place type
Cach e Size. In the Setting box, type 128 (see Figu re VJ.3). Click the Set butto n and then
click the OK butto n. (If your Macintosh has more than 4MB of RAM, you can experiment
with setting the cache size to more than 128K.) Click the Set button and then the OK
button.
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Changing t he cache size allocatio n.

Use Wo rd for a while to see if the change makes Word run faster. If changing this setting
makes Word run slower, then put the setting back to 64K. The poin t here is that your
other software, the amount of memory you use, and the kinds and sizes of files you use all
affect Wo rd's performan ce. The o nly way to o ptimize is by performing these experiments
to see what happens to Word's speed. Really, you do n't have much to lose-you may have
to take two minutes to reset some defaults, but these two minutes can save you two
minutes every time you open a file!
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Increase your disk cache

Poke around in your Memory co ntrol panel and try a few Disk Cach e settings. Increase
the disk cache a bit and see if the change makes any difference. It may not, but some users
have re po rted finding "magic" settings for their systems simpl y by experimenting w ith
this setting.
Change your monitor settings

Let's say that you ' re trying to knock out a docume nt t h at wi ll be printed on a standard
black-a nd-white printer. Looking at your m o nito r, you m ay be just as h appy seeing black
text on a white backgroun d, with little monoch rome icon s, as you would be seeing the
sa m e thing with color icon s. In the Monitors contro l pa ne l, every additional simplificatio n counts. The Black & White optio n is faster tha n the 16 colo rs option, which is faster
than the 256 colors option, w hi ch is much faster th an the o the r colo r options. The speed
is directly re lated t o the amount of info rmation slos hed o ut of video RAM at each screen
re fresh; therefore, the Black & White option is notably faster than the colo r options.
Rebuild the desktop

As the weeks roll by, you may noti ce that it takes you r Mac lo nger to start and longer to
load Word. When this happ en s, it's tim e to rebu ild your desktop, w hich is a good activi ty
n ot only for speed but a lso fo r c rash proofing.
To rebuild your desktop, shut down your Mac and then resta rt \•Vh ile ho ldi ng down the
Optio n a nd :l:f: keys. You w ill get a warning box asking wh ether you really want to rebu ild
the desktop. Click the OK b utton. If you have a big h a rd drive, the rebuilding process may
take a minute or two.

Excel 5 Speed Tips
Purchase a disk-utility package

If you discover that Excel is too slow fo r you, especia ll y a t starting up, loading files, a nd
saving files, you should get a th ird-party disk-opt imizing utili ty. Excel 5 is a big program,
and its files a re also larger tha n the older Excel 4 fi les, so you need a ll t he d isk speed you
can ge t. The Speed Disk utili ty from the Norton Utilities package (see Figure VI.4) looks for
disk fragmenta tion (fi les a nd parts of files stored a ll over the place on th e disk instead of
physically together) and moves files around to a storage configuration that allows for
faster access.
Excel 5 seem s to be particularly sen sitive to thi s fragm entatio n problem. Eve n wh e n Speed
Disk promises only a slight imp rovem e n t in speed, actua l loadi n g tim es for files speed up
by nearly a factor o f two. If you don't want to b uy a wh o le di sk-utili ty package, but you
have an o nline account (with Amer ica Onli ne, Prodigy, o r Co m p uServe), you ca n find
shareware disk optimization programs that can give you the same kind of speed increase.
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Excel 5 needs t he best hard drive performance you can get.

In v est in a faster M ac

Every few years App le increases the speed of SCSI bus data transfers (besides upgrading the
central processor), so you get better hard drive perfo rmance with one of the newer, faste r
Macs. The disadvantage o f a newer Mac is that, as of 1995, a faster Mac means a Power
Mac. In principle this should be nothing but good news. It's not. Microsoft's in-house
compiler techn ology does not seem to be getting as much speed improvemen t in Power
Mac applications ve rsus 680x0 as any other vendor. But the Power Mac is a great platfo rm,
and nearly every other vendor has learned to take advantage of it. Ho pefully, soonerrather than later-Microsoft will, too.
Get a n a ccelerator

In the meantime, if you have a middle-of-the-road 68030 system from a few years ago, you
actually get more cost-effective acceleration fro m a 68040 plug-in accelerator card than
fro m upgrading to a whole new system. Unfo rtu nately, the Power Mac version of Excel 5,
at least in its first version, has wo rse problems with mystery bugs than the 680x0 version,
so accelerating may be less frustrating than switching to fu ll Power.
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Turn off Balloon Help

Make sure that you have Balloon Help turned off. Balloon Help h as pretty much been
guaranteed to contain no useful info rmation whatsoever, at least for users with more
than one day's Mac practice. When you shut down this unnecessary function, Excel can
concentrate on direct interaction with the workspace itself.
Remove unnecessary too/bars

You have the option of putting lots of toolbars onscreen (see Figure VLS). If you're not
actually using one right now, however, close it. Do not leave extra toolbars floating
around because this practice seriously slows down screen updates.
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Figure VI.S Clean up your worksheet display.

Limit the number of worksheets in your workbooks

In the Options dialog box from the Tools menu (see Figure VL6), you can find the default
number of worksheets per workbook. The defa ult has been set by Microsoft to 16, probably on the assumption that people are using Excel to make up monthly budgets for a
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whole year and are producing summary sheets, as well. The reali ty is that you can easily
add new sheets to a smaller workbook with the Move o r Copy Sheet command fro m the
Edit m enu. If you set the v.rorkbook default to 3 o r 4 sheets, Excel opens much faster.
There's no reason to lug around a bunch of blank worksheets in every workbook.
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Figure Vl.6 Reset the default number of worksheets per workbook.

Don 't link your worksheets

Links are great, but they are relatively expensive in terms of performance. If you design
individual worksheets that contain the same information as fou r or five linked worksheets,
you get faster recalculation. Links between workbooks are even more of a performance
drag than intra-workbook links. Links are a great software feature for the systems of the
futu re, but their performance suffers on the modest systems of today.
Turn on virtual m e mory

Microsoft customer support says that turn ing on virtual memory in the Memory control
panel is Tip #1 to in crease the performance speed of Excel. With virtual memory on, only
3MB of code n eeds to be loaded at startup rather than the whole program. However, this
advice needs to be explained a bit.
If you have a Power Mac with less than 24MB of RAM, you have to use virtua l memory

just to get Excel to run at all. If you have 24MB o r more of RAM (which you should have
because o ther important RISC applications also need lots of memory), however, and you
turn off virtual memory, you pay a penalty in startup time, but the application runs faster
after it's opened.
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On 680x0 systems, Excel itself is sm aller. You will have much better results if you just
accept the Will of Mr. Gates and buy m o re memory (at least 12MB). Virtual memory just
loads slower in 680x0 systems, so using it extensively is just about the o pposite of a speed
tip. On the o ther hand, virtual memory at least makes Excel 5 a possibility for PowerBook
owners- you pro bably don't have a 16MB of RAM PowerBook, but you can run Excel 5 at
a leisurely pace if virtual memory is active.
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Appendix

Installing
Microsoft Office
The current shipping version of Microsoft Office 4.2 arrives on 29 disks-30, act ually, if you
include the PowerPoint Viewer. Although this is the biggest Macintosh software product, it's
just a country cousin of Office for Windows, which, in its Professional Edition, includes the
FoxPro database, as well. Microsoft Mail, as noted in Chapter 29, is a separate option-you
buy a Mail server license and then get client software either with the license or as a separate
purchase. In this chapter, you will lea rn about the insta llatio n o ptions for the fo llowing:

Microsoft Office 4.2

Survival Guide

Getting Going in the First Place
Microsoft Office is big. One reason for reviewing the options is to decide which parts of Office
you need and which parts you ca n li ve witho ut. Although, as Microsoft points out, the Office
suite of today actua lly uses a slightly smaller percen t of the hard disk space o n a current highend Mac than the analogous softvvare of a few years ago, everyone else's software has bloated
to outrageous size, too, so there's not a particularly notable surplus of hard drive space on the
desktops of America. That is, maybe you have an extra 12MB (!) that you do n' t mind devoting
just to PowerPo int clip art, but maybe you don't. Yo u'll learn how to customize Office so that
rather than having the all-purpose solutio n to every software problem fo und in Corpo rate
America, you can have the nice, compact solutio n to your problems.
In Chapter 2, you lea rned about doing the Minimum installatio n. The ensuing hundreds of
pages sho uld not have changed your minds. If you are startin g a new installatio n of Microsoft
Office, try it this way first:
1. Double-click the Memory control panel in the Contro l Panels folder of your System
fo lder. If you're using System 7.5, The Memo ry co ntrol panel should look like the

one in figure A.l. In each individ ual setting, click to make the setting match th ose
in the figure. Don't second-guess o n this advice-the settings are a hot tip right
from Microsoft suppo rt! Set the Cache Size to 96K, turn off Modem Memory
Manager, turn off Virtua l Memory, and turn off RAM Disk.
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Figure A.1 Memory settings for Office installation.
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2. Restart your Mac wh ile you hold down the Shift key. This technique starts the Mac
with your extensions turned off. You don't need them for the installation, and
there's an excellent chance that one or more of them will conflict with Microsoft's
setup procedure anyway.
3. Insert Install Disk 1. You should see the contents shown in'Figu re A.2.
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Install Disk 1- what's inside.

4. Double-click the Microsoft Office Setup icon.
S. When you see th e screen in Figure A.3, everythin g is proceeding according to plan.
Click OK to get to the "serial number" screen.
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Figure A.3

The second Office installation screen.
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6. Write down your serial number (see Figure A.4), right now, on the inside page of
each one of the manuals provided with your Office software. This redundancy can
prove to be a great help to you later on, when you can find only o ne manual, and
you have to call customer support.
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Figure A.4 Copy your serial number into several places.

7. Office starts a new folder for your software (see Figure A.S).
8. Click the Setup button to continue from th e last screen . Now you h ave to make
the big choice: the mode of installation. Ch oose th e Minimum o ption (see Figure
A.6)-you'll be glad you did. Anything else that you wa nt can be added later.
9. Now all you have to do is keep track of your disks and insert them as o rdered. The
Minimum installa tio n uses only abo ut a third of all the Office disks. As you insert
the disks, you are asked o ne or two mo re questio ns, depending on your Office
version number, like the one in Figure A.7, but your job now is mostly diskswapping.
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In Office 4.2, the software can't yet sense the CPU type.

Installing Updated Versions of Word
Microsoft is issuing updates to Office softwa re every few mo nths. If you are a registered user
(you are a registered user, aren 't you?), you will be notified of these updates. If you are updating Word 6 to Word 6.0. 1, you should not install only the new Wo rd softwa re. You sho uld
install the entire new Office set that Microsoft will send you. ln the new world of Office,
which depends heavily on sh ared libraries, all sorts of stran ge problem s can occur if you try to
stick a new applicatio n in to the Office suite. All sorts of bits of code have to be chan ged, not
just the applicatio n itself, and installing a single new application by itself doesn't make these
ch anges.

Understanding the Official Microsoft
View of Thi ngs
Microsoft- partly as a way of dealing with the absolute firestorm of criticism abou t Office's
size and partly as a way of m itigating the shock and dismay of its first users-has published a
little guide to Office installatio n sizes. From this information , you can see why you sho uld pick
Minimum as the installation choice:

+
+
+

Minimum installation o n a 68K Mac takes 17MB of hard d rive space.
Typical installatio n on a 68K Mac takes 30MB of hard drive space.
Complete installation o n a 68K Mac takes 62MB of hard drive space.
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The Power Macintosh installatio ns are somewhat large r. These statistics refer to Office 4.2, in
which only Excel 5 has been coded for the Power PC RISC chip (Wo rd and PowerPoint run in
emulatio n mode as 68K applications). When the Power versions of the other applications ship,
more disk space still will be req uired-RJSC appl ications are always larger than their conventional CPU counterparts. Th e Power Macs require the fo llowi ng amount of space:

+
+
+

Minimum installatio n on a Power Mac takes 24MB of ha rd dri ve space.
Typical installatio n on a Power Mac takes 37MB o f hard drive space.
Complete installatio n on a Power Mac takes 76MB of hard d rive space.

Taking a Guided Survival Tour
Yo u now will get th e details of installing Office, o ptio n by o ption. If you fo llowed the advice
about extensio ns and memory and Mi ni m um installation , yo ur installation shou ld have been
successful. If it wasn 't, you'll have to call Microsoft Customer Support beca use the advice in
this book is actually based on Microsoft's best guess about how to get Office installed.
It's time to look at all the Office componen ts and see which o nes you may need to add. However, the Minimum installatio n of Office is so feature-packed that you can easily spend six
months working with it befo re you feel that anythi ng may be missing.

Installing Excel
Excel S.Oa, bless its little computat iona l heart, is the most trouble-free application in Office,
and despite its size, it really doesn't have terrible speed problems. Start the installatio n aga in
with Install Disk 1 and fo llow the steps in the preceding section up to step 8. At this point,
click the butto n fo r Complete/Custo m installatio n . The first screen you see looks like the one
in Figure A.8. The main poin t to remember abo ut the Custom installatio n is th is: if a check box
has an X in it, that software is going to be installed.
If you are just updating or ch an ging one application, make su re th at no o ther boxes are
checked. For example, if you are making changes to your Excel installatio n, click in the boxes
of the other applications so that the installat ion doesn' t waste your time installing the complete software set.
When you click the little triangle next to th e Microsoft Excel check box, the list expands to
show you the differe n t Excel componen ts (see Figu re A.9).
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Basic Excel options.

The first thing you should notice is that some options cost you a lot of space. Excel by itself
(this figure shmvs the Power Mac installation, although most numbers are comparable for a
68K) takes almost 12MB of hard drive space, and th ere's nothing you can do about this. This
is why the Power Mac version of Excel calls for virtual memory, even on a Mac with 16MB
of RAM .
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Excel Help
The full Help suite and the Data Access suite together cost about 13MB of RAM, so it's worth
checking out the options (click the appropriate little triangle) to see what you get . The Help
options (see Figure A. l O) are interesting and ask the question, "Are you a programmer or not?"
If you aren't going to do any Visual Basic programming, you don't need Visual Basic Help.
Similarly, if you aren 't going to try to do macros in th e old Excel style, you don' t need the
Excel 4.0 Macros Help. Readers who are inclined to irony might note th at the 4.0 Macros Help
in this giant program is bigger than the application Excel 4.0 itself.
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Figure A.10 Excel's Help options.
Microsoft Excel Help is worth having, especially if you want to use the built-in functions, so
you sho uld leave that box checked. The examples and demos, however, are usefu l mostly if
you've never used Excel before and aren't particularly educational if you alread y know your
way around.

Data Access
The Data Access optio ns dea l with whether you will be using Excel o n a n ehvork and whether
you will be getting data into Excel fro m a remo te database (see Figure A. ll). The database may
use the q uery language SQL, o r, alternatively, it may be a database in Microsoft's own FoxPro.
But if you are using a stand-alo ne Mac, you don 't need any of these option s. And if you are
using your Mac o n a sophisticated data network, your system adm inistrato r will come around
and tell you which options to use.
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Add-ins
The add-in options are a sort of strange mixed bag (see Figure A.l2). The Analysis ToolPak adds
a separate set of statistics functions that are already present in another form anyway, so you
don't really need to install this option. Excel's excellent Solver, on the other hand, is well
worth adding because it does the most realistic what-if models you can construct.
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Figure A.12 Add-ins (or leftovers).
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The Report Manager is a brilliant and effi cient application for those who generate lots of
reports. Slide Show, by contrast, is a curious feature for adding to Excel in Office because if you
are generating a presentation in Office, it will probably be a series of graphs in PowerPoint.
The slide shows that you can gen erate in PowerPoint are m uch classier and more colorful than
those that Excel itself gen erates. So don 't waste the space with Excel's own Slide Show option.

Installing Word
Word is a rather different installation proposition from Excel-the application itself is actually
rather compact, but it offers a huge assortment of add itional features (see Figure A.13).
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Word options to install.

Accessories
Merrily clicking triangles, you can start with Accessories (see Figure A. 14). If you're going to
be using WordArt, you n eed the WordArt fonts for best effect. Voice Annotation and Movies,
however, are only going to be needed if you want to make multimed ia documents. In both
cases, adding voice or animation to documents can turn a 5,000 character text piece into a
3MB fi le-too big for email- in no time at all.
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Proofing Tools
Once again, Microsoft's capacity to ama ze provides a few surprises (see Figure A.lS). First, you
see a Hyphenation Ch ecker that's a bigger application than most Spelling Checkers. Un less
you know that you will be writing text that is fu lly justified, you will not use this option, so
turn it off because it takes up too much space. You also see a Grammar Checker, although
neither this one nor any other one has appeared to entirely positive reviews. The day a
Grammar Checker can correctly distinguish the correct use of it's from its is probably the
day you should load this piece of software.

Converters and Filters
If you are going to work only in Microsoft Word 6, you don't need the converters and filters
(see Figure A.l6). On the other hand, if you deal with word processing fi les from other applications, it's worth the disk space to have the whole set of converters insta lled. The converters are
not invoked unless you are actually doing a conversion, so there's no speed penalty, and it's a
nuisance to go through the installation again just to translate the occasional file. There's also a
separate utility from Microsoft to translate Word 6 files back down to Word 5.1-it's ava ilable
to registered users fro m Microsoft's Customer Support.
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Online Help
Unless you wi ll be writing bits of auto mated text-processing in Visual Basic, you don't need
that part of the Help options (see Figure A.l7). The examples and demos are also not very
relevant, unless this is your first time using Microsoft Word. (Actually, if your first exposure
to Word is Wo rd 6, I would like to apologize on behalf of Mr. Bill Gates. Word 6 certainly has
plenty of nifty features, but sometimes it feels like a Greyhound bus nego tiating a small
parking lot.)
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Figure A.17 Almost 8MB of Online Help.

Wizards, Templates, and Letters
Click the triangle to inspect Word's Wizards and related materia l (see Figure A. l 8). This
unassum ing set of o ptions contains one of the most space-efficient choices in the Office
su ite-the li ttle Letters file. Microsoft did a very good job of formatting a collection of standard letters, and the fi le is only 200K o r so. By all means, load this material into your Word
folder. Both Letters and Templates affect the speed of Word o nly when the files are actually
accessed, so you should definitely check both options. Wizards, o n the other hand, actually
affect the speed at which Word run s, so if you don't need the tips that the Wizards provide,
turn them off.
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Figure A.18 Big Wizards and little details.

Installing PowerPoint
PowerPoin t is the epitome of an installation dilemma-the application itself is reasonably
compact, but to make it work with minimum effort o n your own part, you are well advised to
load all sorts of other files in the options (see Figure A.l9}. Basically, Microsoft has supplied
PowerPoint with all sorts of ready-made componen ts for assembling an impressive presentation, so you may as well use them.
One item at th is level that deserves attentio n is the Genigraphics d river option. Most graph ics
service bureaus that m ake slides accept this format, so if you plan to get you r PowerPoin t
effo rts onto 3Smm slides (as opposed to a computer presentatio n) you will probably need this
optio n.

Accessories and Converters
If you propose to do any serio us work with PowerPoint {that is, presentations in which there
is actual money riding on the outcome), you should check all these options (see Figure A.20).
They allow you to ca nnibalize the best parts of presentations from other sources, bring in text
from anywhere, and assem ble organiza tional charts in a twi nkling.
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Figure A.1.9 The PowerPoint environment.
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Help
Similarly, although we have been dismissing template files and even d ifferent kinds of help
as a waste of disk space, th e Help files for PowerPoint are a different matter (see Figure A.21 ).
Most people do more wo rd processing and spreadsheet wo rk than presentations, so they are
less likely to remember the details of PowerPoint from o ne sessio n to the next. So load the
w hole shootin' match if you propose to use PowerPo int.
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Figure A.21 PowerPoint Help is actually helpful.

Templates and Clip Art
Here we have a contrast. A ll the templates are useful (see Figure A.22), and, in fact, the listing
contains o ne of Microsoft's rare flashes of humo r. On the other hand, th e gigantic fi les of
PowerPoint Clip Art (see Figure A.23) are not only somewhat cliched, but th ey al so repeat
some aspects of WorclArt, and after this version of PowerPoint has been on the market fo r at
least a year, they will have lost their power to impress. The templates are great, but you sho uld
probably im port your own clip art .
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Figure A.22 Essential PowerPoint templates.
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Installing Microsoft Office Manager
Most of the Office Manager material (see Figure A.24) is loaded when you perform a Minimum
installation. Office Manager is necessary fo r almost every function of the individual applications in Office. Do n't worry about t h is option.
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Figure A.24 Office, automatically.

Installing Shared Applications
Shared applications (see Figure A.25) ca n be called from an y other application (Word, Excel,
o r Power Point). If you don't work with math, you probably don't need the Equati on Editor.
Although Graph is a gigantic applicatio n (compared to stand-a lone graphing applications),
you need it unless your PowerPoint presentatio ns can im port Pier graphs from elsewhere.
Cue Cards are automatically loaded if you have already selected C ue Card s in other places
(fo r example, Cue Cards in remo te database access).
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Figure A.25 Options for shared applications.

Installing Tools
Figures A.26 and A.27 show the options in the Tools menu. The inescapa ble fact is that you
need everything you s·e e here. Many of these items have already been loaded with a Minimum
installation, but if you are doin g a Custom insta ll modificatio n, you may as well check them
all. Office is happiest, most of th e time, with its own TrueType fonts, fo r example.
Microsoft Office '!,2 Setup
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Figure A.26 Necessary tools.
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Equally necessary fonts and converters.

Doing It
If you have reviewed all the Custom options and have checked all the boxes you think you
will need, then you should click the Install button. As the installation grinds away, you are
trea ted to va rious info rm ative background screens (see Figure A.28) to keep you awake as you
shuffle disks in and out of your Mac's floppy drive.
If you change your m ind about installation compo nents, you can go back at any time andreinsta ll. It's relatively safe to pull components o ut of the applicatio n fo lders and the Microsoft
Office folder, but it's not worth the hassle to remove any folder that says Microsoft fro m
anywhere in the System folder. If you decide you need th e space you devoted to Word Help,
you ca n delete it from the Word 6 folder. But you can get into very strange waters if you begin
tweaking the Preferences fil e i n the System, fo r example. Leave well enough alone.
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Symbols
«»(chevrons), for m letters, 244
" (prime q uo tation marks), 74
" (smart quotes), 75
-(em d ashes), 76
S (do llar sign), absolute cell
references, 277
... (elllpses), PowerPo int commands, 559
~-S hift-Esc key command, 2 4
~-S hi ft- K key command, 29
_ (undersco re), naming worksheet
cells, 414
- (tilde), 76
3-D charts, 375-380
line charts, 3 79
pie charts, 374
surface charts, 34 7
3Smm slides (PowerPoi nt),
645-646

A
A.P. R. (an nualized percentage
rate) worksheets, 403
absolute cell referen ces
(wo rksheets), 277
accelerators, 718
Accounting number fo rmat
(worksheets), 296
active applicatio ns, 41
Add Scenario dialog box, 493
add-in utilities (Excel), 732
add ing d rop-down menus to
Wo rd, 224
Advanced Filter utili ty (Excel
d atabases), 434-44 1
Align dialog box (Wo rd
graphics), 208
alignment
graphics (Wo rd), 207-208
paragraphs (Wo rd), 149-150
tab stops, 1 55
tables, 175
text (PowerPoint), 582
Wo rd, 109-110
workshee ts
cells, 297-298
text, 289
Alki Software, 101
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alloca ting
memo ry, 34
mem ory caches, 7 16
RAM for Word, 713
a nalysis of variance (ANOVA)
ut ili ty, 522
anchor poin ts
PowerPoint text, 579
Wo rd graphics, 208
ANOVA (analysis of va ria nce)
utility, 522-525
Apple menu commands
Chooser, 261
Find File, 8
Key Caps, 79
Stickles, 12
a ppli ca tio ns
active status, 41
d ata exchange, 696-710
finding with Find File utili ty,
LO, 41
locking, 18-19
Applications menu icon, 41
Arabic n umerals (Word document
page nu mbering), 11 6
Arc tool (Drawin g toolbar), 601
area charts, 34 7, 368-372
<~rea percent charts, 371-372
a rgumen ts (functio ns)
PMT function, 399-401
tracing, 417
a rrows (Auditing toolbar),
hiding, 41 7
ASCII characters, 89
aspect ra tios (PowerPo int), 553
att ach ing
cell notes to Excel, 418
global tem plates to ex isting
Word, 70
templates to existing Word, 69
audiling Excel, 414-423
Auditing com mand (Tools
men u), 420
Auditing toolbar, 337,415-421
AutoCaption uti lity (Wo rd),
189-190
AutoConten t Wizard, 537, 550,
572-578
AutoCorrect command (Tools
menu), 75
AutoCorrect dia log box, 91
Aut·oCorrect uti lity, 91-94
Auto Fillutility (Excel), 307-311
Auto rilter utility (Excel), 432-434
Auto Fit utili ty (Excel), 286
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Auto Format command (Format
menu), 356
Auto Fo rmat dialog box, 363
Auto Fo rmat utility (Excel),
302-305
Autolayouts u tility (PowerPoint),
543, 590
automa ting
data replacement in fo recasting worksheets, 487-492
hyphenatio n in Word, 77
slide shows, 623-626
autosave (Wo rd), 48-49
AutoShapes tool (Drawing
toolbar), 603
AutoSum function (Excel), 276
AutoText d ialog box, 94
AutoText utility (Word), 93-96
AVERAGE function (Excel),
386-389
axes
Excel charts, 352
li ne charts, 367

B
background o bjects (slide
shows), 598
background prin ting (Word
documents), 260-261
backups (Wo rd documents), 47-49
Ba lloon Help
d isabling, 7 L9
PowerPoint Help system , 564
bending text in Word, 146
bit maps (mem o ry allocatio n), 715
black and white print previews
(Excel charts), 356
black-and-white prin touts
(PowerPo int slide shows), 634
bo ld text (PowerPoin t), 581
Bookm ark menu, 463
bookma rks (He lp system),
462-464
borders
PowerPoint, 579
tables, 167
Word, 210-218
worksheet cells, 300
Borders and Sh ading command
(Fo rmat menu), 211
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Index

Borders toolbar, 211
bottom borders (Word documents), 213-2 14
boxed borders (Word
documents), 215
Break com mand (Inse rt
me nu), 106
breaki ng Word documents into
smaller files, 47
Build com mand (Tools
menu), 623
Build dialog box, 623
built-in styles (Word), 121
Bullet dialog box, 583
Bu llet On/Off tool (slide show
outli nes), 539-54 1
BulletDefault command (Fo rma t
menu), 158
bullets
list fo rmats, 157
PowerPoin l, 582
slide show tex t builds, 622
Word, 74
business
fo recasting software, 4 70-4 77,
484-492
pivot tables, 504-51 7
trendline worksheets, 480-484
buttons
macros, ..J 64-468
toolbars, 226-229

c
caches (memory), alloca ting, 7 16
Calendar Wiza rd, 44
Caption d ia log box, 189
ca ptio ns
PowerPoin l, 579
Wo rd, 188- 190
Captions command (Insert
menu), 189
ca rds (dialog boxes), 65
categories (pivo t tables), 505-506
CO-ROMs, 670-672
Cell Heigh t a nd Width command
(Table menu), 169
Cell No te dialog box, 336
cells
Exce l worksheets
alignme nt, 297-298
borders, 300

custom fi lis, 31 1-3 13
da ta entry, 273-275
editing, 293
filli ng ranges, 307-31 1
fonts, 298-299
formatting, 286-288,
295-302
formulas, 422-423
h iding, 302
high lighting, 307
naming, 314, 411-414
notes, 335, 418
patterns, 300
precedents, 416
reference tracing, 4 16
references, 277
macros, editing, 455
tables
ad justing widths, 168
alignm en t, 175
copying, 176
cutting, 176
ed iting, 176
merging, 174
selecting, 168
spli tting, 174
Word, 166
centering
paragraphs in Word, 149
text in PowerPoin t, 582
Cha nge Case comma nd (Format
menu), 89, 141
Change Case dia log box, 141
cha nging, see modifying
chapter numbering (Word),
134- 135
characters
ASC II, 89
Word, 66
formats, 138-143
no n printi ng, 80-8 1
special, 78-79
styles, 119, 123
Chart Type command (Format
menu), 352
Chart Type dialog box, 354
Chari Wiza rd, 344-350
charts (Excel), 344-350
3-D charts, 375-380
3-D line charts, 379
3-D pie charts, 374
3-D surface charts, 347
area charts, 347, 368-372
area percent cha rts, 37 1-372
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black-and-white print previews, 356
copying, 364
da ta legends, 349
doughnu t ch arts, 347, 356
ex po rting to PowerPo int, 701
fonts, 350
formats, saving, 363-364
formatting, 350-362
line charts, 356-362
colors, 366
emphasizing data, 367
grid li nes, 365
modifying, 364-368
scali ng axes, 367
pie ch arts, 353, 372-375
pivot tables, 515-5 17
PowerPoin t, 544
previewing, 348
radar charts, 347
reformatting, 358
spell -checking, 362
switchi ng types, 352-356
XY scatter ch arts, 347
chevrons(«»), fo rm letters, 244
Choose Scheme dia log box, 595
Chooser (Apple me n u), 26 1
clea n install (System 7.5), 29
Clip Art Ga llery (PowerPoint),
544, 606-607, 739
ClipArt folder (Word), 203-204
Clipboard
conten ts, 86
PowerPoin t, 580
closing
PowerPoin t presentation
programs, 552
Wo rd documents, 5 1
color monitors, 644
color pri nters, 636-640
color printing (PowerPoint),
636-640
color schemes (slide shows),
595-596
colors
Excel, 293
lin e cha rts, 366
PowerPoint
graphs, 609
presenta tion programs,
640-642
sli de shows, 593-597
Colors and Lines dia log box
(PowerPoint), 604
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columns
3-0 charts, 376
tables, 167
adding, 170
adjusting widths, 168
deleting, 169
selecting, 168
snaking, 176-1 77
spacing, 175
worksheets
AutoFit utili ty, 286
formatting, 286-288
Columns com mand (Format
menu), 176
Columns dialog box, 176
commands
Apple menu
Chooser, 261
Find File, 8
Key Caps, 79
Stickies, 12
Data menu
Form, 429
Group and Outline, 437
Subtotals, 437
deleting from drop-down
menus, 223
Edit menu
AutoText, 94
Copy, 85
Cut,85
Find, 88, 617
Paste, 85, 696
Paste Link, 696
Paste Special Formats, 364
Replace, 90-91, 617
Undo, 84
fields (Word), 71
File menu
Document Layout, 68, 107
Find File, 326
New, 43
Open, 45
Page Setup, 109, 258, 553
Print Preview, I 10, 254
Put Away, 45
Quit, 51
Save All, 46
Save As, 46
Templates, 69
Format menu
AutoFormat, 302, 356
Borders and Shadi ng, 211
Bullet Defaul t, 158
Change Case, 89, 141
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Chart Type, 352
Columns, 176
Drop Cap, 144
Head ing Numbering, 134
NumberDefault, 158
Presentation Template, 544
Slide Color Scheme, 595
Style, 123
Insert menu
Break, 106
Captions, 189
Cross-reference, 19 1
Date and Time, 96
Footnote, 63
Frame, 178
Index and Tables, 183
Object, 78
Page Numbers, ll 3
Symbol, 78
Trendline, 472
inserting in drop-down meus,
222-223
Note menu, 13
Power Po int
documen ts, 559-562
Help system, 564-567
Rehearse Timings, 625
Sets menu, I S
shortcut keys, 62
Table menu
Cell Height and Width, 169
Formula, 171
Headings, 175
Insert Columns, 170
Insert Rows, 169
Merge Cells, 174
Sort, 172
Sort Text, 163
Spli t Cells, 174
Table AutoFormat, 218
tables, 170
Tools menu
Auditing, 420
AutoCorrect, 75, 91-93
Bu ild, 623
Customjze, 62
Envelopes and Labels, 261
Goal Seek, 495
Grammar, 103
Hyphenation, 77
Language, 101
Macro, 232
Options, 292
Scenarios, 492
Solver, 498
Spelli ng, 102
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Spelling Checker, 362
Thesaurus, 99
Transition, 621
Word Count, 98
View menu
Header and Footer, 110
Master, 597
Master Documen t, 132
Notes Pages, 618-619
Outline, 127, 539
Ru ler, 60
Toolbars, 58
Word document templates, 68
see also key commands; macros
compressing QuickTime videos,
666-667
concordance files (i ndexes),
196-197
conflicts, 25
email programs, 26
Extensions Manager, 15
screen savers, 25
troubleshooting, 26-30
Contents command (PowerPoint
Help system), 564
control panels
Extension Manager, 14-16
MacTCP Internet gateway, 10
memory, 21
PC Exchange, 19-20
Window Shades, 16-18
Control-Tab key command, 65
converters
PowerPoint, 737
Word, 54-SS, 734
converting
Excel documents
to PowerPoint, 701-703
to Word, 697-700
graphics to Word, 203-204
macros to Excel menu
commands, 450, 452-455
PC fi les to Macin tosh
format, 19
PowerPoint presentation
programs to 35mm slides,
645-646
video to QuickTime
movies, 664
Word
ou tlines to PowerPoint,
706-710
to HTML, 56
to PowerPoint, 697
to/from other formats,
52-56
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Index

Copy command (Edit menu), 85
copying
color schemes to other
slides, 596
Excel
charts, 364
worksheets to other
workbooks, 332-334
files from Find File results, 332
remote database information
into Excel worksheets, 440
table cells, 176
tex t (PowerPoint), 580-58 1
toolba r buttons to ot he r
toolbars, 459
corruption (no n-Word files), 53
COUNT function (Excel), 382-386
crashes, 24-26
Create Data Source
dialog box, 241
Crea te Labels dialog box, 250
Cross-reference dialog box, 19 1
cross-references
indexes, 196
Word, 191 -1 92
Cue Cards com mand (Powe rPoin t
Help system), 566
Custom Button dialog box, 227
custom dictionaries (Spelli ng
Checker utility), 100
custom ex tension sets, 15
custom fills (Excel), 311 -313
custom in stallation
(System 7.5), 28
Custom number format
(Excel), 296
Customize command
(Tools menu), 62
Customize Toolba rs
dialog box, 562
custom izing
AutoCorrect utility, 92-93
AutoTex t utili ty, 94-95
bullet form ats (Word document lists), 158-1 59
drop-down menus (Word),
222-224
endnotes, 186
footnotes, 186
for m letters, 245-246
Help system , 462-464
key com mands, 220-222
line charts, 360
num ber fo rmats (Word
documen t lists), 159-160

PowerPoin t presentation
program printouts, 633-636
Spelli ng Checker utility, 100
styles, 126
subdocuments (Word master
docu men ts), 133-134
tab stops, I 53-154
toolbars, 58, 225-230, 458-460,
561-562
Cut command (Edit menu), 85

D
DAL (Data Access La nguage), 440
dashes (Word docume nts), 75 -77
Data Access system (Excel), 73 1
data analysis
Excel, 503-529
pivot tables, 509-S l 2
Data Analysis utility (Excel),
s 18-52 1
data documen ts (form letters),
238-242
data e n t ry

Excel, 273-275, 307, 383
fo recasting worksheets,
487-492
Power Po int
gra phs, 608
presen tation program
o utlines, 577-5 78
data exchange (Microsoft Office
applica tions), 696-710
data legends (charts), 349
Data menu commands
Form, 429
Group and Outline, 437
Subtotals, 437
databases (Excel), 426
Advanced Filter utility,
434-441
AutoFilter utility, 432-434
fields, 426
filtering, 432-437
reco rds, 4 26
defin ing, 427
find ing, 429
restoring, 43 1
rela tional, 426
remote connections, 440-44 1
setup, 427-428
sort! ng, 43 1-432
viewing, 429
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Date and Time command (Insert
menu), 96
Date and Time dialog box, 96
Date number format (Excel), 297
da te/time, updating, 96-97
decima l places (Excel
worksheets), 293
defaults (Excel workbooks), 293
Define Bookmark dialog box, 463
defining database records, 427
de leting
AutoCorrect entri es, 93
borders from Word, 216
bullets from Word document
lists, 157
columns from tables, 169
commands from drop-down
menus, 223
drop-down menus fro m
Word, 224
endnotes/footnotes from Word
documents, 187
exte nsions, 14
key commands, 222
macros, 233-234
numbers from Word document
lists, 157
page numbers (Wo rd documents), 115-1 16
rows fro m tables, 169
section breaks (Word documents), 68
spikes (Word documents), 88
styles (Word docume nts),
126-1 27
tab stops, 155-156
text (Word documents), 83-84
toolbar buttons, 229
too lbars, 230
De mote tool (slide show outlines),
539-541
Desc riptive Sta tistics util ity
(Excel), 519
designing Excel worksheets,
290-292
desktop, 41
cleaning with Window Shade
co ntrol panel, 16
rebuilding, 71 7
de tecting corruption in non-Word
fi les, 53
dialog boxes
Add Scenario, 493
Advanced Filter, 436
Align (Word graphics), 208
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AutoCaption, 190
AutoCorrect, 91
AutoFormat, 363
AutoText, 94
Build,623
Bullet, 583
Caption, 189
ca rds, 65
Cell Note, 336
Change Case, 141
Chart Type, 354
Choose Scheme, 595
Colors and Lines (PowerPoint), 604
Columns, 176
Create Data Source, 24 1
Create Labels, 250
Cross-reference, 191
Custom Button, 227
Customize Toolba rs, 562
Da te and Time, 96
Defi ne Bookmark, 463
Document Layout, 107
Drop Cap, 144
Field Options, 193
Find, 88
Find File, 8
Font, 140-142,581
Footnote and Endnote, 186
Format Axis, 352
Formu la, 171
Frame, 179
Get Info, 19
Grammar, 103
Heading Numberin g, 134
Hyphenation, 77
Items Found, 9
key commands, 65
Language, 101
Macro, 447
Mail Merge Helper, 25 1
Mark Index Ent ry, 195
Merge, 249
Modify Bulleted List, 158
:\lfodify Heading Numbering, 134
Modify Numbered List, 159
Modify Style, 124
navigation, 64-66
New, 43
New Presentation, 573
Note Options, 63
Open, 44-45, 203
Organizer, 235
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Page Number Format, 115
Page Numbers, 113
Page Setup, 109, 554
Play Settings, 669
Print, 255
Print (PowerPoint), 555
Print Options, 635
Reapply Style, 124
Record Macro, 232
Replace, 90, 6 17
Save, 46
Slide Color Scheme, 593
Slide Setup, 553
Slide Show, 624
Snap to Grid, 209
Sort, 173, 432
Sort Text, 163
Spelli ng, 102-103, 616
Subtota l, 438
Summary In fo (Excel
workbooks), 325
Symbol, 78
Table of Contents
Options, 183
labs, 65
Templates (PowerPoint), 589
Thesaurus, 99
Toolbar, 225
Transition, 621
Trendline, 474
triangles, 65
WordArt, 147
dictionaries (Spelling Checker
utili ty), 100
d isk caches, increasing, 7 17
disks
ejecting, 45
fi les, opening, 44
displayi ng
document outlines
(Word), 129
headers/footers in Wo rd
documents, Ill
index entries, 197
key com mands for Word, 62
non printing characters in
Word, 80
PowerPoint presentation
programs
as overh ead transparencies,
646-647
from mo nitors, 642-645
on LCDs, 649-651
on video, 647-649
shortcut menus, 64
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slide shows as overhead
transparencies, 646-647
loolbars (Word), 58
docking Word toolbars, 58
Document Layout command (File
menu), 68, 107
Document Layout dialog box, 107
docume nting worksheet
changes, 396
documents
non-Word, 52-53
Word
adding text, 74-8 1
align ing paragraphs,
149-150
attaching templat es, 69
AutoCaplion utility,
189-190
AutoCorrect utili ty, 91-93
autosave, 48-49
AutoText utility, 93-96
background printing,
260-261
backups, 48-49
borders, 210-2 18
breaking into smaller
files, 47
bullets, 74
captions, 188-190
chapter numbering,
134-1 35
characteristic information, 98
characters, 66
closing, 51
converting Excel
worksheets to, 697-700
converting to HTML, 56
converting to PowerPoi nt, 697
converti ng to/from other
forma ts, 52-56
cross-references, 191-192
customizing drop-down
menus, 222-224
customizing key commands, 220-222
dashes, 75-77
deleti ng text, 83-84
d rop caps, 143-144
editing commands, 85
endnotes, 185-188
fast saves, 4 7
fields, 70
fi nding text, 88-89
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first page headers, 11 2
fon t subst itutions, 256
footers, 11 0- 11 3
footnotes, 185-188
form letters, 238-249
formatting paragraphs,
147-149
fract ional width
printing, 256
frames, 177- 179
full saves, 48
Grammar Checke r utility,
99-l04
headers, II 0-113
hidden tex t, 142-143
hiding windows, 41
horizonta l borders, 211-214
hypertext links, 192-194
hyphens, 75-77
indexes, 194-198
Infor ma ti on profiles, 97-98
inserting page totals, 117
kerning text, 143
key com mands, 62
line spadng, 151
lists, 156-164
macros, 230-236
margins, 106- 108
moving formatting, 85
moving text, 84-88
naming, 46
non printing characters,
80-81
num bering contents,
188-190
numbering pages, 11 3-1 18
numbering schemes, 116
numbers, 74
orientation (printing), 67,
108-109
outlines, 127-131
overla pping contents,
179-180
overlapping header/footer
text, 112
page brea ks, 8 1
page setup, 106-1 18
paragraphs, 66
partial printing, 256-257
password protection, 49-5 I
previewing printouts,
254-255
prin ting, 255-260
printing pnge ranges,
256-257

printing to disk, 258-259
quotation marks, 74-75
read-only, 49-50
read-write, 49
replacing text, 90-91
reversed text, 145
rulers, 60-61
saving, 46-48
saving in Word 5, 54
scaling for printing, 258
section breaks, 106
sections, 67-68
selecting text, 82-83
spacing paragraphs,
150-15 1
spacing text, 143
special characters, 78-79
spell-checking, 91-93
Spelling Checker utility,
99- 104
spiking, 86-92
starting page numbers, 115
status bar, 59-60
symbols, 78-79
tab stops, 152-156
table of contents, 180-185
tables, 166-176, 217-218
templates, 41-43, 68-70
text insertion point,
moving, 81-82
text styles, 118-127
toolba rs, 225-230
undoing changes, 84
vertical alignment, 109-1 10
views, 61 -62
windows, 41
wizards, 43-44
word counts, 47, 98
WordArt utility, 146-147
wrapping text around
graphics/paragraphs,
177-179
zooming, 178
Word 5, sharing files
wi th Word 6, 54
see nlso files
pollar sign ($),absol ute cel l
references, 277
double-clicking (mouse), 40
doughnut charts, 347, 356
d rag-and-drop operation
graphics, 209
text, 85
Draw+ toolbar, 560
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d rawing layers (Word
grap hi cs), 200
Drawing toolbar, 205, 560,
600-606
Excel, 305-307
versus borders and shading,
210-211
Drawing+ toolbar, 604
Drop Cap dialog box, 144
drop caps (Word documents),
143- I 44
drop-down menus, 63
keyboard navigation, 64
PowerPoint, 535
Word, 222-224
dye sublimation printers, 638

E
Easy Open extension, 20
Edit menu commands
AutoText, 94
Copy, 85
Cut, 85
Find, 88, 617
Paste, 85, 696
Paste Link, 696
Paste Special Formats, 364
Replace, 90-91, 6 17
Undo, 84
editing
endnotes/footnotes
(Word), 188
macros, 448, 455
slide show formats, 597
table cells, 176
text (PowerPoint), 579
worksheet cells, 293
effective interest rntes (loan
worksheets), 403
ejecting floppy disks, 45
Electronic Chalk utility
(PowerPoint), 563
Ellipse tool (Drawi ng toolbar), 601
elli pses (...), PowerPoint commands, 559
em dashes(-), 76
emai l (electronic mail), 26,
691-694
embedding, 146, 696-697
endnotes (Word documents),
185-188

Microsoft Office 4.2

enlarging text (PowerPoint), 582
envelopes
form letters, 251-252
printing, 261-263
Envelopes and Labels command
(Tools menu), 261
EPS (Encapsulated PostScript fi les),
258-259
Equation Editor (Word), 78
equations (PowerPoint
graphs), 609
error messages (Excel), 420-421
errors
Word, AutoCorrecting, 91-93
see also conflicts
examples (Word document
templates), 68
Excel
add-in utilities, 732
ANOVA utility, 522-525
Auditing toolbar, 415-421
business trendline worksheets,
480-484
charts, 344-350
3-D charts, 375-380
3-D line charts, 379
3-0 pie cha rts, 374
3-D surface ch arts, 347
area charts, 347, 368-372
area percent charts,
371-372
black-and-white print
previews, 356
copying, 364
data legends, 349
doughnut charts, 347, 356
exporting to PowerPoint, 701
fonts, 350
formats, 363-364
formatting, 350-362
line charts, 356-368
pie charts, 353, 372-375
previewing, 348
radar charts, 34 7
reformatti ng, 358
spell-checking, 362
switching types, 352-356
XY scatter charts, 347
Data Access system, 731
Data Analysis utility, 518-521
databases, 426
Advanced Filter utility,
434-441
AutoFilter utility, 432-434
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fi ltering, 432-437
remote connections,
440-441
setup, 427-428
sorting, 431-432
viewing, 429
Descriptive Statistics
util ity, 519
FORECAST fu nction, 479-480
forecasting worksheets,
470-477, 484-492
Goal Seek util ity, 495-497
Help system, 731
histograms, 525-526
installation, 729-733
LlNEST functi on, 480
opening screen, 272
o ptimizi ng, 717-721
Regression utili ty, 526-528
Scenario Manager utili ty,
492-495
Solver add-in utility, 497-502
toolbars, 456-462
TREND function, 477-480
workbooks, 324-325
default settings, 293
finding, 326-:n2
locking, 341
passwords, 341
Summary Info dialog
box,325
worksheet default
limits, 719
worksheets
absolute cell references, 277
auditing, 414-423
Autof ill utility, 307-311
Autoformat utility, 302-305
AVERAGE function,
386-389
cell notes, 335, 418
cell precedents, 416
cell reference tracing, 416
cells, alignment, 297-298
cells, borders, 300
cells, editing, 293
cells, filling ranges, 307-311
cells, fonts, 298-299
cells, formatting, 286,
295-302
cells, fo rmulas, 422-423
cell s, hiding, 302
cells, highlighting, 307
cells, naming, 314,411-414
cells, patterns, 300
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cells, selecting ranges, 316
colors, 293
converting to PowerPoint,
701-703
converti ng to Word,
697-700
copying, 332-334
copying data from remote
databases, 440
COUNT function, 382-386
custom fills, 311-313
data analysis, 503-529
data entry, 273-275, 383
decimal places, 293
design, 290-292
documen ti ng changes, 396
Drawing toolbar, 305-307
error messages, 420-42 1
fill handles, 308
financial fu nctions,
409·411
financing calculations,
404-405
fonts, 288-289
Format Painter utility,
317-3 18
forma ts, 275-280, 286-292
form ulas, 422-423
functions, 275-278,
382-391
gridlines, h iding, 291 -295
guides, hiding, 319
headlines, 29 1
home-loan calculations,
405-408
IF function, 392-394
IPMT (interest paymen ts)
fun ction, 406
key commands, 319
lin king, 338-340
loans, 398-408
locki ng, 300, 341
macros, 444-455
mathematica l functions, 392
MAX function, 389
MIN fu nction, 389
moving, 332
navigating, 273-275,
314-315
NOW function, 396
nu mbers, fo rmatting,
290,296
passwords, 300
pivot tables, 504-51 7
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PMT (payment) function,
398-408
PPMT (pri ncipal payments)
function, 406
previewing, 280
printing, 280
protected, 300
RAND function, 390
relative cell references, 277
saving, 274
setup, 273-274
styles, 318
subtota ling, 437-440
text alignment, 289-290
text boxes, 334-338
toolbars, hiding, 319
tracking, 334-338
viewing, 293
exponential trendli nes (business
trend line worksheets), 484
extended keyboards, 83
Extension Ma nager, 14-16
extensions, 14
custom sets, 15
Easy Open, 20
suppressing, 25, 713
System 7.5 confl icts, 24-25
external hard drives, installing
System 7.5 with MS Office, 30

F
F3 function key, 87
fast saves (Word documents), 47
Field Options dialog box, 193
fields
databases, 426
headers/footers, locking, 111
Word, 70
File menu commands
Document Layout, 68, 107
Fin d File, 326
New, 43
Open, 45
Page Setup, 109, 258, 553
Print Preview, 110, 254
Put Away, 45
Quit, 51
Save All , 46
Save As, 46
Templates, 69
filenames, 324
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files
copying from Find File
results, 332
finding with Find File utili ty,
8-10

locking, 18-19
opening, 44-45
PC, converting to Macintosh
format, 19
Word, memory capacities, 47
see also documents
fill handles (Excel documen ts), 308
Fill O n/Off tool (Drawing
toolbar), 603
fil ls (PowcrPoint), 603-604
filtering
Excel databases, 432-437
form letters, 246-247
filters (Word), 734
financial forecasting worksheets,
470-502
financial fun ctions (Excel
worksheets), 409-411
financing calculations (Excel
worksheets), 404-405
Find command (Edit menu),
88,617
Find dia log box, 88
Find File utility, 8-10, 326
Finder application, 41
finding
applications with Find File
util ity, LO
database records, 429
Excel workbooks, 326-332
text
PowerPoint presenta tion
programs, 617-6 18
Word documents, 88-89
first page headers (Word documents), 112
floating toolbars, 58, 459
floppy disks, see disks
folders
creating, 46
email, 693
Font dialog box, 140- 142, 581
Font menu, 139
fonts
charts, 350
Excel, 288-289
text (PowerPoint), 580-582
viewing in Key Caps, 79
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Word documents, substi tuting, 256
worksheet cells, 298-299
see also styles
footers (Word documents),
110-113
foot lamberts, 644
Footnote and Endnote
dialog box, 186
Footnote command (Insert
menu), 63
footnotes (Word documents),
185-188
FORECAST fu nction, 479-480
forecasting worksheets (Excel)
ANOVA uti lity, 522-525
automating data replacement,
487-492
correlations, 472
descriptive statistics, 518-521
graphing, 471-480
histograms, 525-526
Regression utility, 526-528
Solver reports, 501
t-tests, 528-529
trendlines, 4 71-480
foreign languages
special characters, 79
spell-checking, 101
Form command (Data menu), 429
form letters
envelopes, 25 1-252
records, sorting, 247
Word, 238-249, 736
Format Axis dialog box, 352
Format menu commands
AutoFormat, 302, 356
Borders and Shading, 211
BulletDefault, 158
Change Case, 89, 141
Chart Type, 352
Columns, 176
Drop Cap, 144
Heading Numberi ng, 134
NumberDefaul t, 158
Presentation Template, 544
Slide Color Scheme, 595
Style, 123
Format Painter uti lity (Excel),
317-3 18
fo rmats
characters (Word), 138- 14 ·1
endnotes/footnotes, 188
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Excel
charts, 350-364
d ocuments, 275-292
indexes, 198
multilevel lists, 161-163
numbers (worksheets), 296
PMT function, 401
slide shows, editing, 597
text (PowerPoint), 580-582
Word
characte rs, 66
document o utlines, 130
lists, 156-163
moving, 85
paragraphs, 66, 147-149
sections, 6 7-68
tables, 217
templates, 68-70
undoing, 84
worksheet cells, 295-302
Formatting toolbar, 57,
138-139, 560
Formula command (Table
menu), 171
Formula dialog box, 171
formu las (Excel worksheets), 275,
422-423
Forward Delete key, 83
Fraction number format (Excel
worksheets), 297
frac t ional width printing (Word
documents), 256
Frame co mma nd (Insert
menu), 178
Frame dialog box, 179
frames (Word documents),
177-179
Free Rotate tool (Drawing
too lbar), 602
freeform graphics (Word), 206
Freeform too l (Drawing
toolbar), 602
FTP (File Transfer Protocol) sites
Microsoft hints and tips, 10
Word converters, 55-56
fu ll saves (Word documents), 48
fun ction keys
extended keyboard, 83
F3, 87
Function Wizard, 276, 385
function s
AVERAGt::, 386-389
COUNT, 382-386
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Excel, 277-278, 382-391
financia l, 409-4 11
FORECAST, 479-480
fo rmulas, 171
IF, 392-394
Ll:'.JEST, 480
mathematical, 392
MAX, 389
MIN, 389
NOW, 396
PMT, 398-408
RAND, 390
TREND, 477-480
fv (future value) argument, PMT
functi on, 399

G
generating
indexes, 197
table of conten ts, 183-184
Genigraphics Driver,
insta llatio n, 642
Genigraphics Inc., 64 1
Ge t Info dialog box, 19
global templates (Wo rd documents), 70
Goal Seek utility, 495-497
GoToButton fi eld (Word
hypertext links), 193-194
Grammar Checker utility, 99-104
Grammar dialog box, 103
graphics
anchors, 208
creating, 204-206
freeform, 206
grids, 209
locking, 209
PowerPoint presentation
programs, 543-544, 585-612
sizing, 201
tex t layers, 201
Word
alignment, 207-208
converting to, 203-204
drawing layers, 200-202
embedd ing into document
text, 146
importing, 202-204
moving, 207-209
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numbering, 188-190
pasting, 203
wrapping text around,
177-179
WordArt, exporting to
PowerPoint, 704-705
Graphicslink, installation, 642
graphing forecasti ng worksheets,
471-480
graphs (PowerPoint), 544-545,
607-611
greeked paragraphs (Word
documents), 212
gridlines
Excel worksheets, hiding,
291-295
line charts, 365
grids
PowerJ>oint, 558
Word graphics, 209
G roup and Outli ne command
(Data menu), 437
grouping objects in PowerPoint,
605-606
guides
Excel worksheet, hid ing, 319
PowerPoint presentation
programs, 558

H
handouts (slide shows), 632
hanging indents, 148
hard drives (externa l), installing
System 7.5 with MS Office, 30
Header and Footer command
(View menu), 110
headers (Word documents),
110-113
Heading Numberi ng command
(Format menu), 134
Headi ng Numbering
dialog box, 134
headings (Word document
outlines), 129
Headings com mand (Table
menu), 175
headlines (Excel worksheets) , 291
heig ht (table rows), adjusting, 168
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Help system
bookmarks, 462-464
Excel, 73 L
finan cial funct io ns, 410
PowerPoint, 564-567
Word, 56
hiding
Auditing tool bar arrows from
worksheets, 417
gridlines in Excel, 291-295
guides (Excel worksheets), 3 19
no nprinti ng characters in
Word, 80
PowerPoint toolbar
buttons, 56 1
rulers, 60
slides in Powe rPoint slide
shows, 620, 626-627
text (Word documents),
142-143
toolbars, 58,319, 719
windows, 16, 41
histograms (Excel worksheets),
525-526
hom e-loan calculations (Excel
worksheets), 405-408
ho rizonta l alignmen t (parag raphs), 150
horizontal bo rders (Word
documents), 211-2 14
1-ITML (HyperText Markup
Language), converting Word
documents to, 56
hypertext links (Word
documen ts), 192-1 94
Hyphenation com mand (Tools
m enu), 77
Hyphenation dialog box, 77
hyphens, 75-77

icons
Applicatio ns menu, 4 1
C hart Wizard, 346
do uble-clicking, 40
IF function, 392-394
lmageDirect Inc., 641
importing
graphics into Wo rd, 202-204
Sticky notes, 13

indenting
list formats in Word, 161
paragraphs in Word, 147-149
Index and Tables command
(Insert menu), 183
Index command (PowerPoint
Help system), 565
indexes (Word), 194- 198
Informa ti on profiles (Word),
97-98
Insert Columns command (Table
menu), 170
Insert menu commands
Break, 106
Captions, 189
C ross- reference, 191
Date and Time, 96
Footnote, 63
Frame, 178
Index and Tables, 183
Object, 78
Page Num bers, 113
Symbol, 78
Trend lin e, 4 72
Insert Rows command (Table
menu), 169
in serting
captions into Word documents, 189
Clip Art in PowerPoint, 607
columns in tables, 170
commands in d rop-clown
meus, 222-223
endnotes in Word documents,
185-187
footnotes in Word documents,
185- 187
graphs into PowerPoint, 608
MergeFields in for m
letters, 244
numbers into Excel
worksheets, 273-275
page numbers in Word
documents, 11 3-114
page totals in Word documents, 117
rows in tables, 169-170
sectio n breaks in Word
documents, 67
spaces above tables, 173
spikes in Word documents,
87-88
text in Excel worksheets,
273-275
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insertion points
tables, 170
Word document text, 8 1-82
inside bo rders (Word documents),
212-213
installation
Excel, 729-733
Genigraphics Driver, 642
Graphicslink, 642
MS Office, 724-726
ex te rnal drives with
minimal System 7.5,
30-31
minimu m, 3 1-33
Office Manager, 741
PowerPoint, 737-740
System 7.5, 26-3 1
utiliti es, 742
Word, 733-737
Word converte rs, 55
Word upgrades, 728
Inte rc hange Format, see RTF
converter
Internet MacTCP gateway, 10-12
inverted text, 145
IPYIT (interest payments)
functio n, 406
ita licizin g text in PowerPoint, 581
Items Found dialog box, 9

J-K
justify ing
pa ragraphs in Word, 149
text in PowerPoint, 582
worksheet cells, 297
Keep Lines Togeth er paragrap h
fo rm at, 16 1
kerning text, 143
Key Caps command (Apple
men u), 79
key commands
):(-Shi ft-Esc, 24
):(-Shi ft-K, 29
AutoText uti litv, 96
character for mats (\Nord),
139-140
Control-Tab, 65
customizing, 220-222
deleting, 222
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dialog boxes, 65
doubling, 221
Excel, 319
printing assignments, 220
selecting worksheet cell
ranges, 3 16
tables, 170
Wo rd, 62
see also macros
keyboard
extended, 83
Forward Delete key, 83
navigating drop-down
menus, 64
keyboard shortcuts, see key
comma nds

L
labels
captions, 190
Excel chart axes, 352
fo rm letters, 249-251
printing, 263-266
Landscape o rien tation, printing
Wo rd documents, 108
Language com mand (Tools
menu), 10 1
Language dialog box, 101
laser printers, 638
layering objects in
PowerPo int, 605
LCDs {Liquid Crystal Displays)
displaying PowerPoint,
649-651
panels, 650
projecto rs, 650
leaders (tab sto ps), 155
legends (Excel charts), 349
line charts
axes, scaling, 367
charts. 356-362
colors, 366
emphasizing data, 367
gridlines, 365
modifying, 364-368
Line On/Off too l (Drawing
toolbar), 603
line spacing (Wo rd
documents), 151
Line tool (Drawing too lbar), 601
lines (PowerPoint), 603-604
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LIN EST fu nction, 480
lin king Excel worksheets, 338-340
liq uid in kjet printers, 639
lists (Word), 157-164
loans {Excel worksheet calcu latio ns), 398-408
locking
applicatio ns, 18-19
Excel wo rkbooks/worksheets,
300,341
files, 18-19
header/footer fields, 111
Word, 49-50
fie lds, 70
graphics, 209
lockup, 24-26

M
MACE (Macintosh Audio
Compression and
Expansion), 670
Macintosh Quadra 630, 660
Macintosh-to-television con nections, 649
Macro command (Tools
menu), 232
Macro dialog box, 447
Macro Record toolbar, 233
MacroButton field (Word
h ypertext links), 194
macros, 231
butto ns, 464-468
cells, editi ng, 455
converti ng to Excel menu
com mands, 450-455
editing, 448
Excel, 444-455
naming, 445
Presentlt, 706
recording, 445
relative references, 453
versus AutoText, 94
Visual Basic toolbar, 448
Word documents, 230-236
MacTCP Interne t gateway, L0-12
Mail prog ram , 689-694
Mail Merge Helper d ialog box, 251
Mail Merge toolbar, 244
m ain document (form lette rs),
238-246
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margi ns (Word d ocuments),
106-108
Mark Index En try dialog box, 195
marking
index entries in Word, 195
text in a table of con tents,
181 -183
Master command (View
men u), 597
maste r d ocumen ts (Word), 61,
131- 134
mathematical fu nctions (Excel
worksheets), 392
mathematica l o peratio ns (tables),
171-1 72
YIAX function, 389
memory
allocating, 34
bitmap allocation, 715
caches, 716
control panel, 21-22
RAM status, 715
virtual, 33-35, 714, 720
Word files, 47
menu bar (PowerPo int), 559-560
Menu Editor, 452
menus, 63-64
Merge Cells com mand (Table
menu), 174
Merge dia log box, 249
MergeFields (form letters), 238
merging
cells, 174
e nve lopes with form letters,
251 -252
form letters, 248-249
labels with form letters,
249-25 1
tables, 174
Microsoft
ftp sites, 10
phone n umbers, 713
WWW sites, 11
Microsoft Mail, see Mail
mimimum installation {System
7.5), 30-35
MIN function, 389
minimum insta llation (YIS
Office), 31-33
Modify Bulleted List
d ialog box, 158
Mod ify Head ing Numberi ng
dialog box, 134
Modi fy Num bered List
d ialog box, 159
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Modify Style dialog box, 124
modify ing
area charts, 368-372
graphics in Word, 206
li ne charts, 364-368
pie charts, 372-375
styles, 123
tab stops, 153
toolbar buttons, 228-229
moni tors
color, 644
di splaying PowerPoint, 642
video walls, 644
moving
formatting in Word, 85
graphics (Word), 207-209
headers/footers, 11 2
headings in Word document
o utlines, 129
insertion points, 8 1-82
macros, 235-236
·styles, 126-127
tab stops, 155
text (Word), 84-88, 207
toolbar buttons, 226-228
toolbars (PowerPoi nt), 562
worksheets to other workbooks, 332
MS (Microsoft) Office
installation, 30-31, 724-726
insta llation options, 728
minim um installation, 31-33
multidimensiona l data (pivot
tables}, 504-505
multilevel lists, formatting,
161 -1 63
multimedia (PowerPo int), 656-66 1

N
naming
cells (Excel worksheets),
411-414
macros, 445
Word, 46
navigating
dialog boxes, 64-66
drop-down menus with
keyboard, 64
Excel, 273-275, 314-315
PowerPoint, 535-536, 556-559
tables, 170
text insertion point, 8 1

network Mail issues, 688-692
New command (File menu}, 43
New dia log box, 43
New Presentation dialog box, 573
nonpri nting characters (Word
documen ts), 80-81, 89
normal view (Word), 61
Note menu commands, 13
Note Options dialog box, 63
Notes Pages command (View
menu}, 618-619
Notes Pages view (PowerPoint),
563, 618
NOW function, 396
nper (number of periods)
argumen t, PMT fun ction, 399
Number Default command
(Format menu), 158
numbering Word documents
conten ts, 188-1 90
outlines, 130-131
pages, 11 3-118
numbering schemes (Word), 11 6
numbers
Excel
formats, 290, 296
inserti ng, 273-275
list forma ts, 157
Word, 74

0
Object command (Insert
me nu), 78
Office Manager, installation, 74 1
o ne-input tables, fo recasti ng
worksheets, 488-489
online help (Word), 736
onscreen gu ides (Excel),
hiding, 319
Open comm and (File menu), 45
Open dialog box, 44-45, 203
opening
fi les, 44-45
floppy disk files, 44
non-Word files via Word, 52
PowerPoint, 552
Word 5 documents, 54
optimizing
Excel, 717-721
Word, 713-717
Options command (Tools
menu), 292
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organi za tion charts (PowerPoi n t),
611-612
Organ izer dialog box, 235
orientatio n
1..Vord, 67, 108-109
worksheet cells, 297
Outline view
PowerPoint, 563, 570-572
slide shows, 539
Wo rd, 61
outlines
formats, 130
headings, 129
numbering, 130-131
PowerPoint, 540-54 1,
572-578, 633
printing, 131
selective viewing, 129-130
text, 129
Word, 127-131, 706-710
Outlining toolbar, 127, 560,
570-572
overlapping Word docu ment
contents, 179-180

p
page breaks
tables,l73-174
Word documents, 81
page layout view (Word), 61
Page Number Format
dialog box, 115
Page Num bers command (I nsert
menu), 113
Page Numbers dialog box, 113
page setup
PowerPoint sli de shows,
553-554
Word, 106-11 8
Page Setup command (Fi le menu),
109,258,553
Page Setup dialog box, 109, 554
page totals (Word documents),
inserting, 117
pages (Word documen ts},
numbering, 113-1 18
paragraphs (Word documents),
66, 119, 123
align men t, 149-150
box borders, 215
formats, 147-149
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greeked, 212
indenting, 147-149
solid background
borders, 216
spacing, 150-151
styles, 123
wrapping text around,
177-179
partial printing (Word documents), 256-257
password protected Word
documents, 50-Sl
passwords
Excel
workbooks, 34 L
worksheets, 300
Mail, 690
Word, 49-50
Paste command (Edit menu),
85,696
Paste Link command
(Edi t menu), 696
Paste Special Formats command
(Edit menu), 364
pasting
Excel worksheets in to Word,
697-699
graphics into Word, 203
text (PowerPoint), 580
patterns (worksheet cells), 300
payment calculations (Excel
worksheets), 398-408
PC Exchange control panel, 19-20
PC files, converting to Macintosh
format, 19
Percentage number format
(worksheets), 297
Pick a Look Wizard, 537, 550,
586-588
pie charts, 353, 372-375
pivot tables (Excel), 504-517
PivotTable Wiza rd, 506
Play Settings dialog box, 669
playing QuickTime videos, 668
PMT (payment) function , 398-408
pop-up menus, 63
Portrait orientation, printing
Word documents, 108
PostScript files, 258-260
Powerl'oint
AutoConten t Wizard, 572-578
charts, 544
Clip Art Ga llery, 544,
606-607, 739
Clipboard, 580
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comm ands, 559-562
converters, 737
converting Excel to, 701 -703
converting Word to, 697,
706-710
Drawing toolbar, 600-606
drop-down menus, 535
graphs, 544, 607-611
Help system, 564-567
installation, 737-740
menu bar, 559-560
mul timedia features, 657-658
multimedia presentation
programs, 660-661
navigating, 535-536, 556-559
organization charts, 611-612
presentation programs,
534-535
adding QuickTime videos,
667-669
aspect ratios, 553
audience rapport, 68 1-684
Auto l.ayouts uti li ty, 543,
590-591
closing, 552
color printing, 636-640
colors, 640-642
converti ng to 35mm slides,
645-646
conveying points, 674
creating, 550-551
creating with Pick a Look
Wiza rd, 586-588
displaying as overhead
transparencies, 646-64 7
displaying from monitors,
642-645
displaying on LCDs,
649-651
displaying on video,
647-649
Electron ic Chalk
utility, 563
fi lis, 603-604
graphics, 543-544, 585-612
grids, 558
grouping/ungrouping
objects, 605-606
guides, 558
interruptions, 683-684
launching, 572-578
lines, 603-604
Notes Pages view, 618
open ing, 552
Out line view, 570-572
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personal poise, 676-678
preparation, 674-676
printing, 554-555, 630-633
Q&A sessions, 682-683
rehearsing, 620
rul ers, 558
saving, 545, 552
saving as PostScript
files, 635
selecting di splay fo rmats,
651 -653
setup, 536-537
Slide Master view, 598-599
speaker's notes, 618-61 9
speech development,
679-681
stacking objects, 605
status areas, 558-559
templates, 543, 550,
589-590
text, 5 78-583
view ing, 535-5::16
views, 562-563
slide shows
adding slides, 542-543
AutoLayouts utility,
590-591
automating, 623-626
background objects, 598
black-and-white
prin touts, 634
colors, 593-597
converting to 35rnm slides,
645-646
creating, 537-539
designing slides, 592-593
displaying as overhead
transparencies, 646-647
displaying on LCDs,
649-651
displaying on video,
647-649
editing forma ts, 597
graphs, 545
hiding slides, 626-627
outlines, 540-541
page setup, 553-554
printed handouts, 632
printing, 554-555
pri nting slides, 631
scaling for printing, 634
setup, 553
Slide Master view, 597-599
Slide Sorter view, 620
slide transitions, 621 -623
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templates, 544-545,
589-590
text, 5 78-583
text builds, 622-623
timed, 624
viewing, 546-547
zooming, 55 7
Spelling Checker utility,
6 16-6 17
status bar, 558, 567
templates, 739
title bar, 558
toolbars, 560-562
utilities, 738
video slides, 648
WordArt utility, 6 12
PPMT (principal payments)
func tio n, 406
precedents (cells), 41 6
presen tatio n progra ms
(PowerPoint), 534-535
aspect ratios, 553
audience rapport, 681-684
Auto Layouts utility, 543,
590-591
auto mating, 623-626
Clip Art, inserti ng, 607
closi ng, 552
color printing, 636-640
colors, 640-642
converting to 35mm slides,
645-646
conveying poin ts, 674
creating, 550-55 1
creating with Pick a Look
Wizard, 586-588
display methods, 642-651
Electron ic Cha lk utili ty, 563
fi lis, 603-604
graphics, 543-544, 585-612
graphs, 607-61 1
grids, 558
guides, 558
interruptions, 683-684
launching, 572-578
lines, 603-604
Notes Pages view, 6 18
objects, 605-606
open ing, 552
organization charts, 61 1-612
Outline view, 570-572
page setup, 553-554
personal poise, 676-678
preparation, 674-676
printing, 554-555, 630-633

Q&A sessions, 682-683
QuickTime videos, adding,
667-669
re hearsing, 620
rulers, 558
savi ng, 545, 552
saving as PostScript files, 635
se lecti ng display formats,
651-653
setu p, 536-537
Slide Master vi ew, 598-599
Slide Sorter view, 620
speaker's notes, 618-619
speech development, 679-681
spell-checking, 616-617
status areas, 558-559
templa tes, 543, 550, 589-590
text, 578-583
timed, 624
viewi ng, 535-536
views, 562-563
see nlso slide shows
Presen tation Template com mand
(Format menu), 544
Presen tlt macro, 706
previewing
chart formats, 350
Excel
charts, 348, 356
workbook search
results, 329
worksheets, 280
fo rm letters, 24 7
Word docu ments, 254-255
prime quotation marks ("}, 74
Print dialog box, 255
Print dialog box (PowerPoin t), 555
Print Options dialog box
(PowerPoint ), 635
print preview (Word}, 62
Prin t Prev iew co mmand (File
menu), 11 0, 254
prin ters, 636-640
printing
envelopes, 261-263
Excel, 280
form letters, 248-249
h idden slides (PowerPoint), 634
key command assignmen ts, 220
labels, 263-266
PostScript code, 259-260
PowerPoint presentation
programs, 554-555, 630-633
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Word, 255-260
documen t outlines, 131
styles, 120
to disk, 258-259
tfoubleshooti ng, 266
programs, see appl ications
Promote tool (slide show outlines), 539-54 1
proportional fonts, 143
protected worksheets, 300
Publish and Subscribe ut ility
(exporting Excel to Word),
699-700
Put Away command
(Fi le menu), 45
pv (principa l value) argumen t,
PMT function, 399

Q
Q uadra 630, 660
Quick Preview comma nd
(PowerPoint Help system), 565
quick saves (Word documents}, 47
Q uickCam, 663
Qu ickTime videos, 662-669
Qu it command (File menu), 5 1
quitting Word, Sl-52
quotation marks (Word docume nts), 74- 75

R
radar charts, 347
RAM (ra ndom access me mory), 46
all ocating fo r Word, 713
disks, 714-715
status, 7 14
RA:"m function, 390
ranges
form ulas, 171
worksheet cells
custom fills, 31 I
filling, 307-31 1
formatt ing, 317
selecti ng, 3 16
rate a rgumen t, PMT fun ction, 399
Read Me Help file (Word), 56
read-on ly Word documents, 49-50
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read-wri te Wo rd docum en ts, 49
Reapply Style d ialog box, 124
rebuild ing desktop, 71 7
Record Macro dialog box, 232
recording
·
macros, 232-233, 445
QuickTim e videos, 666
records
databases, 426-431
form letters, 24 7
Rectangle tool (Drawing
toolba r), 601
Redo con trols (Standard
toolbar), 84
reducing text in PowerPoi n t, 582
references (Excel worksheet
cells), 277
reformatting Excel charts, 358
Regression util ity (Excel), 526-528
Rehearse Timings command, 625
rein stalling System 7.5, 26-30
relational databases, 426
relative cell references (Excel
worksheets), 277
relative references (m acros), 453
remote database connections,
440-441
re moving character formats from
Word documents, l38
renam ing
drop-down menus, 224
toolbars, 229-230
repeatin g table rows after page
breaks, 174
Replace command (Edit menu),
90-91, 617
Replace dialog box, 90, 617
replacing text
in PowerPo int presenta tion
programs, 61 7-618
in Word documents, 90-91
restoring
database records, 431
toolba rs, 230
returned email, 694
reversed text, 145
reverting to normal text in
PowerPoint, 582
Rich Text Format (RTF) converter,
53-54
Roman numerals (Word docume nt page numbering), 11 6
rota ting text in Word
documents, 146
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rows
Excel worksheets, forma tting,
286-288
tables, 167
adding, 169-170
adjusti ng height, 168
deleting, 169
repeating after page
breaks, 174
selecting, 168
RTF (Rich Text Format) converter,
53-54
Ruler command (View menu), 60
rulers
PowerPoin t, 558
Word, 60-61

5
sales data forecasts (busin ess
trendline worksheets), 481-484
Save All command (File menu), 46
Save As command (File men u), 46
Save dialog box, 46
Save Set command
(Sets menu), 15
saving
email messages, 693
Excel
chart formats, 363-364
worksheets, 274
non-Word, 53
PowerPoint presentation
programs, 545, 552, 635
Word documents, 46-48, 54
scaling
line c hart axes, 367
slide shows for printing, 634
Word documents for
printing, 258
Scenario Ma nager utjlity, 492-495
scree n savers (MS Office
conflicts), 25
Search command (PowerPoin t
Help system), 565
search strings (Word document
text), 88
search-and-replace operatio n
(Word document text), 90-91
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searching
database reco rds, 429
Excel workbooks, 326-332
Word document text, 88-89
section breaks (Word
docume nts), 106
sections (Word documents), 67-68
Selection tool (Drawing
toolbar), 600
sending email messages, 691
Sets menu com mands, 15
setup
Excel
databases, 427-428
worksheets, 273-274
Gram mar Checker utility, 103
margins
numerica l, 106
visual, 108
master documents (\\'ord), 132
pivot tables, 507-509
PowerPoint, 536-537
RAM d isks, 71 4-715
slide shows, 553
Spelling Checker utility,
100-101
shading
tables, 217
text, 145
Sh adow On/Off tool (Drawing
toolbar), 603
sha ri ng
macros, 234-236
Word 5 documen ts with
Word 6, 54
shortcut menus, 64
signing on to Mail, 690-693
sizing
graphics in Word, 201
slide show graphs, 545
skipping bullets/numbers in Word
document lists, 157
Slide Color Sche me command
(Format menu), 595
Slide Color Scheme
dialog box, 593
Slide Master view (PowerPoi nt),
597-599
Slide Setup dialog box, 553
Slide Sh ow dialog box, 624
Slide Show view (PowerPoin t), 563
slide shows (PowerPoint), 537-539
AutoLayouts uti li ty, 590-591
automating, 623-626
background objects, 598
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black-and-white printouts, 63
color schemes, 595-596
colors, 593-597
converting to 35mm slides,
645-646
creating with Pick a Look
Wizard, 586-595
display methods, 642-651
formats, editing, 597
graphs, 545
outlines, 539-541
page setup, 553-554
printed handouts, 632
printing, 554-555
setup, 553
Slide Master view, 597-599
Slide Sorter view, 620
slides
adding, 539, 542-543
a rranging, 620
designing, 592-593
hidden, printing, 634
hid ing, 626-627
printing, 631
sca ling for printing, 634
transitions, 621-623
templates, 544-545, 589-590
text, 578-583
text builds, 622-623
timed, 624
viewing, 546-547
zooming, 557
see also presentation programs
Sl ide Sorter view (PowerPoint)
presentation programs, 563
slide shows, 620
Slide view (PowerPoint), 563
smart quotes("), 75
snaking colu mns (tables), 176-177
Snap to Grid dia log box, 209
solid background borders (Word
documents), 216
Solver add-in utility, 497-502
Sort command (Table menu), 172
Sort dia log box, 173, 432
Sort Text command
(Table menu), I 63
Sort Text dialog box, 163
sorting
Excel databases, 431-432
form letter records, 24 7
lists (Wo rd), 163-164
table contents, 172- 173
sound digitizers, 664

sound effects (QuickTime
videos), 669
spacing
paragraphs in Word, 150-151
table columns, 175
text in Word, 143
spacing formats (lists), 160
speaker's notes (PowerPoint),
618-619, 631
special characters (Word documen ts), 78-79
spell-checking
Excel charts, 362
PowerPoint presentation
programs, 616-617
Word documents, 91-93
Spelling Checker utility, 362
PowerPoint, 616-617
Word, 99-104
Spelling dialog box, 102-103, 616
spiking Word documents, 86-92
Split Cells command (Table
menu), 174
splitting
cells, 174
tables, 174
spreadsheets, see worksheets
stacking objects in
PowerPoint, 605
Standard toolbar, 560
formatti ng Excel, 286-292
Redo controls, 84
Undo controls, 84
Word, 57
starting
master documents, 132-133
tables, 166
Word, 40-42
starting page numbers (Word
documents), 115
startup, suppressing
extensions, 25
statistics, worksheet calculations,
519-528
status bar
PowerPoint, 558, 567
Word, 59-60
Stickies utility, 12-14
storing email messages, 693
Style command (Format
menu), 123
styles
applying, 123
built-in, 121
customizing, 126
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deleting, 126-127
Excel, 318
modifying, 123
moving, 126-12 7
PowerPoint, 580-582
printing, 120
querying, 120
table of contents text, 18 I
Word, 68, 118-127
subclocuments (Word master
documen ts), 133- 1.34
substituting fon ts in Word, 256
Subto tal dialog box, 438
subtotaling (Excel worksheets),
437-440
Subtotals com mand
(Data menu), 437
SUM function, 276
Summary Info dialog box (Excel
workbooks), 325
suppressing extensions at startup,
25, 713
switching
Excel chart types, 352-356
pivot table contents, 513
Symbol command (Insert
menu), 78
Symbol dialog box, 78
symbols
tab stops, I 54
Word documents, 78-79
System 7.5
crashes, 24-26
exten sion conflicts, 24-25
installation, 30-31
MS Office conflicts, 24
reinstalli ng, 26-30
system accelerators, 718
system failure, 24-26
system startup, suppressing
extensions, 25

T
t-tests (forecasting worksheets),
528-529
tab stops, 153-155, 174
tab-delimited text files (form
letters), 239
Table menu com mands
Cell Height and Width, 169
Formula, 171
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Headings, 175
Insert Columns, 170
Insert Rows, 169
Merge Cells, 174
Sort, 172
Sort Text, 163
Spli t Cells, 174
Table AutoFormat, 218
table o f conte nts (Word), 180- 185
Table of Contents Options dialog
box, 183
tables
alignment, 175
borders, 167
cells, 166
adjusti ng widths, 168
alignment, 175
copying, 176
cutting, 176
editing, 1 76
merging, 174
splitting, 174
cha rting, 344-350
columns, 167
adding, 170
adj usting widths, 168
deleting, 169
snaking, 176-177
spacing, L75
commands, 170
conten ts
selecting, 168
sorting, 172-173
inserting spaces above, 173
insertion point, L70
mathematica l opera tions,
171-172
merging, 174
navigating, 170
page breaks, 173-174
rows, 167
adding, 169-170
ad justing height, 168
deleti ng, 169
repeating after page
breaks, 174
splitting, 174
starti ng, 166
tab stops, 174
Word, 166-176
borders/shading, 217-218
num beri ng, 188-190
TC fields (table of contents text),
182- 183
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Technical Support command
(PowcrPo int Help system), 566
television-to-Madntosh connections, 649
templates
macros, 234
PowerPoint, 543, 739
presentation programs, 550,
589-590
slide shows, 544-545, 589-590
versus AutoText, 94
Word, 41-43, 68-70, 736
see also wizards
Templates command
(Fi le menu), 69
Templates dia log box
(PowerPoint), 589
text
Excel
alignmen t, 289
inserting, 273-275
size form ats, 287
PowerPoint, 579
anchor poin ts, 579
borders, 579
bullets, 582
captions, 579
copying, 580
cutting, 580
data entry, 578-579
ed it-ing, 579
fi nd ing, 617-618
fon ts, 580-582
for matting, 580
pasti ng from Clipboard, 580
replacing, 617-618
selecting, 5 79
WordArt manipulation, 612
wrapping, 579
Word
bullets, 74
character formats, 138-141
deleting, 83-84
drop caps, 143-144
find ing, 88-89
hidden, L42-143
h)•phens/ dashes, 75-77
ignoring during spellchecking, 10 1
insertio n point, moving,
81-82
kern ing, 143
moving, 84-88
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movi ng between drawing
layers, 207
numbers, 74
Outl ine View, 129
overlapping header/footer
text, 11 2
proportional fon ts, 143
q uotation marks, 74-75
replacing, 90-91
reversed, 145
selecting, 82-83
shadi ng, 145
spaci ng, 143
styles, 118- L27
table of contents, marking,
181- 183
WordArt man ipu lations,
146-1 47
wrapping around graphi cs/
paragraphs, 177-179
tex t boxes (Exce l), 334-338
text builds (PowerPoint slide
shows), 622-623
text layers (graphics), 201
Text Style comma nd
(Note menu), 13
Tex t tool (Drawing toolbar), 601
Thermal wax printers, 639
Thesaurus dialog box, 99
Thesaurus util ity, 99
tilde (- ), 76
time-conden sed pivot tables, 514
timed slide shows, 624
Tip of the Day command
(PowerPoint Help system), 565
titl e ba r (PowerPoint), 558
Toolbar dialog box, 225
toolbars
Audi ting, 337, 4 15-421
AutoText uti lity, 96
Borders, 21 1
buttons
copying to other
toolbars, 459
deleting, 229
modify ing, 228-229
moving, 226-228
creating, 225-226, 46 L-462
customizing, 225-230, 458-460
deleting, 230
Draw+, 560
Drawing, 205, 2 L0-2 11 ,
305-307, 560, 600-606
Drawing+, 604
Excel, 319, 456-462
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floating, 459
Formatting, 138-139, 560
hiding, 719
Macro Record, 233
Mail Merge, 244
Master Document, 132
Outlining, 127,560,570-572
PowerPoint, 560-562
renaming, 229-230
restoring, 230
Standard, 560
Visual Basic (macros), 448
Word, 56-59
Toolbars command
(View menu), 58
Tools menu commands
Auditing, 420
AutoCorrect, 75, 91-93
Build, 623
Custom ize, 62
Envelopes and Labels, 261
Goal Seek, 495
Grammar, 103
Hyphenation, 77
Language, 101
Macro, 232
Optio ns, 292
Sce narios, 492
Solver, 498
Spelling, 102
Spelling Checker, 362
Thesau rus, 99
Transition, 621
Word Count, 98
see also utilities
tools, see utilities
ToolTips command (PowerPoin t
Help system}, 567
top borders (Word documents),
213-214
tracking worksheets with text
boxes, 334-338
Transitio n com mand (Tools
menu), 621
Transition dialog box, 621
transitions (PowerPoint slide
shows), 621-623
transparent overheads
(PowerPoint), 646-647
TREND function, 477-480
Trendline command (Insert
menu), 472
Trendline dialog box, 474
trendlincs (forecasting
works heets), 471-480

triangles (d ialog boxes), 65
tro ubleshooting
MS Office conflicts, 26-30
page breaks in tables, 1 73
system failu re, 24-26
Wo rd document printing, 266
Tufte, Dr. Edward, 364
twisting text in Word
docu ments, 146
two-input tables (forecasting
worksheets), 491
type argument (PMT
function), 399

u
underlining text in
PowerPoint, 581
underscore U, naming worksheet
cell s, 414
Undo command (Edit menu), 84
Undo co ntrols (Standard
toolbar), 84
undoi ng Word documen t
changes, 84
ungro uping objects in
PowerPoint, 605-606
updating
elate/ time, 96-97
table of contents, 185
upgrad ing Word, 713, 728
utilities
Advanced Filter, 434-441
ANOVA (analysis of variance),
522-525
AutoCaptio n, 189-190
Au toCorrect, 91-93
AutoFill, 307-311
AutoFilter, 432-434
AutoFit, 286
AutoFormat, 302-305
Autol..ayoub, 590-591
AutoText, 93-96
Data Analysis, 518-521
Descriptive Statistics, 519
Electro nic C ha lk, 563
Find File, 8-10
Format Painter, 3 17-3 18
Goa l Seek, 495-497
Grammar C hecker, 99-104
insta llation, 742
PowerPoi nt, 738
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Publish and Subscribe, 699- 700
Regression, 526-528
Scenario Manager, 492-495
Solver add-in, 497-502
Spelling Checker, 362
PowerPoint, 616-6 17
Word, 99-104
Stickies, 12-14
Thesaurus, 99
Word Art
PowerPoint, 612
Word, 146- 147

v
vertical a lignme n t (Word
documents), 109-110
vertical borders (Word documents), 214
video
converting to QuickTime
movies, 664
displaying PowerPo int
presen tation programs,
647-649
QuickTime, 665-669
video digitizing boards, 664
video walls, 644
Vi ew menu commands
Header and Footer, 110
Master Document, 132
Notes Pages, 618-619
Outline, 127, 539
Ruler, 60
Toolbars, 58
view ing
Excel
databases, 429
worksheets, 293
fonts in Key Caps, 79
PowerPoi nt, 535-536
slide shows, 546-547
views
PowerPoint presentation
programs, 562-563
Word documents, 61-62
virtual memory, 33-35, 7 14, 720
Visua l Basic toolbar (macros), 448
Vis11nl Display o(QttCIIttitarive
111 (ormo tion, 364
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w
widths (table cells/columns),
ad justing, 168
Window Shade control panel,
16-18
windows (Word documents),
16,41

wizards
AutoContent, 537, 550,
572-578
Calendar, 44
Chart, 344-350
Function, 276, 385
Pick a Look, 537, 550, 586-588
PivotTable, 506
Word, 43-44, 736
see also templ ates
Word
allocating RAM, 713
ClipArt fo lder, 203-204
converters, 54-55, 734
documents
adding text, 74-81
aligning paragraphs,
149-1.50
attad1ing templates, 69
AutoCaptio n utility,
189-190
AutoCorrect utility, 91-93
autosave, 48-49
AutoText utili ty, 93-96
backgro und printing,
260-261
backups, 48-49
borders, 210-218
breaking into smaller
files, 47
bullets, 74
captions, 188-190
chapter numbering,
134-135
characteristic in formation, 98
characters, 66
closing, 51
converting Exce l to,
697-700
converting to 1-ITML, 56
converting to PowerPoin t, 697
converting to/from ot he r
forma ts, 52-56
cross-references, 19 1-192

customizing drop-down
menus, 222-224
custom izing key commands, 220-222
dashes, 75-77
deleting text, 83-84
drop caps, 143-144
editing com mands, 85
endnotes, 185-1 88
fast saves, 47
fields, 70
findin g text, 88-89
first page headers, 112
font substitutio ns, 256
footers, 110-113
footnotes, 185-188
form letters, 238-249
formatting paragraphs,
147-149
fractio nal width
printing, 256
frames, 177-1 79
full saves, 48
Grammar Checker utility,
99- 104
headers, 110-11 3
hidden text, 142-143
hiding wi ndows, 41
horizontal borders, 211-214
hypertext links, 192- L94
hyphens, 75-77
indexes, 194-198
Info rmation profiles, 97-98
inserting page to tals, 11 7
kerning text, 143
key commands, 62
line spacing, 151
lists, 156-163, 163-1 64
macros, 230-236
margins, 106-1.08
moving fo rmatting, 85
m oving text, 84-88
naming, 46
nonprinting characters,
80-8 L

numbering contents,
188-190
numbering pages, 113-118
numbering sch emes, 11 6
numbers, 74
o rientation (printing), 67,
108-109
outline head ings, 129
o utlines, 127-131
overlappi ng contents,
179-180
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overlapping header/footer
text, 1 12
page breaks, 81
page setup, 106-118
pa ragraphs, 66
passwords, 49-51
previewing printouts,
254-255
printing, 255-260
printing page ra nges,
256-257
printing to d isk, 258-259
quotatio n marks, 74-75
read-o nly, 49-50
read-write, 49
replacing text, 90-91
reversed text, 145
rulers, 60-61
saving, 46-48
saving in Word 5
forma t, 54
sca ling for printing, 258
sectio n breaks, 106
sections, 67-68
selecting text, 82-83
spacing paragraphs,
150-151
spacing text, 143
special characters, 78-79
spell-checki ng, 91-93
Spelling Checker utility,
99-104
spiking, 86-92
sta rting page numbers, 115
status bar, 59-60
symbols, 78-79
tab stops, 152-156
table of contents, 180-185
tables, 166-176, 217-218
templates, 41, 43, 68-70
text insertion point, 81-82
text styles, 118-127
toolbars, 225-230
undoing changes, 84
vertical alig nment, 109-1 10
views, 61-62
windows, 41
wizards, 43-44
word counts, 47, 98
WordArt utility, 146-147
wrapping text around
graphics/pa ragraphs,
177-179
zoom ing, 178
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Equation Editor, 78
file sizes, 4 7
filters, 734
form letters, 736
graphics, 201-209
installation, 733-737
launching, 40-42
master documents, 131-134
online help, 736
optimizing, 713-7 17
outlines, converti ng to
PowerPoint, 706-710
qui tt ing, 51-52
Read Me Help file, 56
RTF converter, 53-54
templates, 736
Thesaurus utility, 99
toolbars, 56-59
upgrading, 713, 728
wizards, 736
WordArt graphics, exporti ng to
PowerPoint, 704-705
WWW site, 56
WordS documents, sharing with
Word 6, 54
Word Count command (Tools
menu), 98
word counts (Word
documents), 98
WordArt graphics, exporting to
PowerPoint, 704-705
vVordArt dialog box, 147
WordArt utili ty
PowerPoint, 6 12
Word, 146-147
workbooks (Excel), 326-332
default settings, 293, 719
locking, 341
passwords, 34 1
Summary Info dialog
box,32S
worksheets (Excel)
auditing, 414-423
AutoFill util ity, 307-3 11
AutoFormat uti lity, 302-305
AVERAGE fun ction, 386-389
business trendlines, 480-484
cells
absolute references, 277
al ignment, 297-298
borders, 300
editi ng, 293
filling ranges, 307-31 1
fonts, 298-299
fo rmatting, 286, 295-302
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formu las, 422-423
hiding, 302
high ligh ting, 307
naming, 314, 411 -414
notes, 335, 418
patterns, 300
preceden ts, 4 16
reference tracing, 416
selecting ranges, 316
colors, 293
converting
to PowerPoint, 701-703
to Word, 697-700
copying, 332-334
copying data from remote
databases, 440
COUNT function, 382-386
custom fills, 311 -313
data analysis, 503-529
data entry, 273-275, 383
deci mal places, 293
default lim its, 719
design, 290-292
documenting changes, 396
Drawing toolbar, 305-307
error messages, 420-421
fill handles, 308
fina ncial fun ctions, 409-411
financi ng calculations,
404-405
fo n ts, 288-289
fo recasting, 470-477, 484 -492
Format Painter utility, 317-318
formats, 275-276, 278-280,
286-292
formulas, 422-423
func tions, 275-278, 382-391
gridlines, hiding, 291-295
headlines, 29 1
guides, h iding, 3 19
home-loan calculations,
405-408
IF function, 392-394
IPMT (interest payments)
function, 406
key commands, 319
linking, 338-340
loan payment calcu lations,
398-408
loans, 398-408
locking, 300, 341
macros, 444-455
mathematical fun ctions, 392
MAX funct ion, 389
MIN fun ction, 389

765

moving, 332
navigati ng, 273-275,3 14-315
NOW fu nction, 396
num bers, formatting, 290, 296
passwords, 300
pivot tables, 504-S 17
PMT (payment) fu nction,
398-408
PPMT (principal payments)
fun ction, 406
previewing, 280
printing, 280
protected, 300
RAND function, 390
relative cell references, 277
saving, 274
setup, 273-274
styles, 3 18
subtotaling, -B7-440
text alignment, 289-290
text boxes, 334-338
toolbars, hidi ng, 319
tracking, 334-338
viewing, 293
World Wide Web, see WWW
wrapping
worksheet cells, 297
text
around Word gra phics/
paragraphs, 177-179
PowerPoin t, 579
write reservation passwords
(Word), SO
WWW (World Wide Web) sites
Microsoft hints and tips, 11
Word, 56
WYSIWYG (what you see is what
you get), 640

X-Y-Z
XV scatter charts, 347
zooming
slide shows, 557
Word, 178
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Macworld and other publications for ten
years. His interest in spreadsheet
analytical methods has been amplified
by years of consulting in the volatile
biotechnology industry.

Microsoft®

Tonya Joy Engst has worked in a
variety of computer-related positions for
Cornell's Information Technologies
• department. She also worked at
Microsoft in the development of Word"
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Microsoft Office is one of the mo~t powerful office
suites on the market, but as it has become more
powerful, it has become more challenging to install
and master. And unfortunately, it has not been well
documented. Until now. With this comprehensive
guide, you can get productive immediately with all
the applications-Word, Excel , PowerPoint, and
Mail.
Written by experts, Microsoft Office 4.2 Survival
Guide for Macintosh shows you how to customize
Worcfl' to meet your needs, create powerful
·
spreadsheets on Excel(!> , make slides and
overheads on PowerPoinf'P, and effectively use
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